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I Introduction

In this part you can find some general notes about the concept of

VirtualLab Fusion and this manual.
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1 VirtualLab Fusion Packages

VirtualLab Fusion Standard can be extended with various packages:

• Grating Package: Grating Optical Setup, LLGA Results Generator, Fourier Modal Method / Rigorous

Coupled-Wave Analysis

• Diffractive Optics Package: Session Editors, IFTA Optimization, Beam Shaper Design

• Flat Lens Package: Functional Meta Lens, Functional Modulated Metasurface, Diffractive Lens, Holo-

graphic Optical Element

• Light Shaping Package: Light Shaping Optical Setup, Cells Array Design

• Laser Resonator Package: Laser Resonator Optical Setup, Session Editors

• AR/VR/XR Package: Light Guide Optical Setup, Custom Fourier Modal Method, Footprint and Grating

Analysis, Light Guide Grating Design, k-Layout Visualization, Layout Design Calculator

• Distributed Computing Package: Distributed Computing

• optiSLang Package: optiSLang Package .

2 VirtualLab Fusion and External Tools

VirtualLab Fusion is a powerful software with a focus on designing and analyzing optical systems. There are

many external programs with a different focus that extend VirtualLab Fusion’s functionality even further.

Some recommended programs:

• VirtualLab Fusion allows you to transform light into arbitrary desired output fields using either the IFTA

optimization (↪→Sec. 97) or the Cells Array Design (↪→Sec. 100). Polygonal or elliptical shapes can be

generated within VirtualLab Fusion. More complex patterns like logos can be generated as monochro-

matic images using raster graphics editors like Windows™ Paint or GIMP (free); and then be imported

into VirtualLab Fusion (↪→Sec. 120.1.3.1).

• VirtualLab Fusion offers many ways to extend its functionality by simply writing snippets in a powerful

source code editor (↪→Sec. 7.3). However, complex projects can be developed more easily using an

Integrated Development Environment (IDE), for example Visual Studio or Visual Studio Code.

• If your simulations run more than a few minutes and you want to continue with your work in the mean

time, we recommend the following procedure.

1. Set the execution priority of your current VirtualLab Fusion instance to something like Below Normal,

Low or Idle. This avoids that your PC reacts sluggishly due to heavy CPU usage but leads to slightly

longer simulation times. This can be done with theWindows™TaskManager or the Process Explorer

(free).

2. Start a new instance of VirtualLab Fusion where you can prepare new simulations.

• If you want to take screenshots of VirtualLab Fusion document windows for e. g. presentations, you can

use Greenshot (free) or SnagIt (the program with which all screenshots in this manual have been made).

• If you want to do advanced calculations on e. g. a data array (↪→Sec. 13), you can transfer the data to a

spreadsheet software (e. g. Excel or LibreOffice Calc (free)) and do your calculations there. The transfer

can be done by copying the data from a table to the Windows™ Clipboard or by exporting the data via

File > Export.

• VirtualLab Fusion can export data into various file formats (↪→Part XVI). We recommend the following

software to view or process this data.

https://www.gimp.org/
https://visualstudio.microsoft.com/ 
https://docs.microsoft.com/en-us/sysinternals/downloads/process-explorer
https://getgreenshot.org/
https://www.techsmith.com/screen-capture.html
https://products.office.com/en-US/excel
https://www.libreoffice.org/discover/calc/
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FILE FORMAT RECOMMENDED SOFTWARE

Text Files Notepad++ (free) and PSPad (free) can handle larger files than the Win-

dows™ Notepad and offer advanced editing options like column-wise selec-

tions. V can open very large text files (with a size of several GB) very fast by

opening just a view lines at once.

Videos Animations (↪→Sec. 20) can be exported to avi videos which can be edited

and converted to other file formats using for example avidemux (free).

CIF /GDSII With KLayout (free), CIF and GDSII files can be opened, edited, and con-

verted to e. g. OASIS and DXF format.

IGES /STL Many CAD formats can be viewed online with the Autodesk Viewer (free,

registration required).

IGES IGES files can be opened for example with the IGS Viewer (free).

STL STL files can be opened and converted with Meshlab (free).

XML XML files can be opened with any Internet browser.

3 How to Use this Manual

The following formattings are used in the manual.

EXAMPLE USED FOR …

File > Open An entry in the ribbon (↪→Sec. 4.2).

Close Other elements of the graphical user interface, for example an entry within an

edit dialog or document window.

Example.txt A file name or a source code example.

PE , PC , PV , or PE A parameter available for parameter extraction. See Sec. 43.5 for details.

Key A key to press.

https://notepad-plus-plus.org/
https://www.pspad.com/
https://fileviewer.com/
http://avidemux.sourceforge.net/
https://www.klayout.de/
https://viewer.autodesk.com
https://igsviewer.com/
http://www.meshlab.net/


II User Interface

This part explains the main window of VirtualLab Fusion and other com-

monly used controls.
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4 Structure of User Interface

Figure 1. General structure of the user interface of VirtualLab Fusion.

A VirtualLab Fusion window (↪→Fig. 1) consists of the following areas: the ribbon (↪→Sec. 4.2) with the Quick

Access Toolbar at the top, Docking Tabs (↪→Sec. 4.3) at the right and at the bottom and a status bar (↪→Sec. 4.4)

at the very bottom. The color scheme of these controls can be set in the Global Options Dialog (↪→Sec. 6.3).

The main area of the user interface is used for document windows. A document window is also denoted as

a view. Several types of documents are supported by VirtualLab Fusion, for example optical systems and

harmonic fields. Sec. 4.1 gives an overview of all available document types. Document windows can be closed

by double clicking on the icon in their top left corner.

Redrawing a document window can be very computationally intensive. Thus we strongly recommend

to switch off redrawing during resizing via the Windows™ Control Panel (Choose Display, then the

Appearance panel, press Effects and uncheck Show windows content while dragging). In this case, any

window is only drawn anew if you stop resizing it with the mouse.

Several user interface operations, such as the invocation of certain menu items, cause the appearance of modal

dialog boxes. In contrast to document windows, modal dialog boxes lock the whole program, that is, such a

dialog box has to be closed for other user interface elements to become accessible again. Use the Help button

in the respective dialog to get context sensitive help.



CHAPTER 4. STRUCTURE OF USER INTERFACE 31

In various dialogs and views context menus are supported, which are accessible by the right mouse button.

The menu items displayed within a context menu depend upon the position of the mouse pointer when opening

the menu.

4.1 Documents and Document Windows

VirtualLab Fusion provides an ever-growing variety of own document types. These documents are shown in

document windows for which the main part of the VirtualLab Fusion user interface is reserved. Furthermore,

VirtualLab Fusion can import and export many common file formats (↪→Sec. XVI).

The following tables list all document types of VirtualLab Fusion, their file extensions, the relation between doc-

ument types and document windows (sometimes different document types share the same document window

or a document type has more than one document window), and which of the following general features the

documents have.

• Result document means that the document somehow show data plotted against one or more coor-

dinates. The corresponding result windows have their own resizing mechanism (↪→Sec. 4.1.1) and a

document specific ribbon group in orange (instead of in dark red).

• Warn on Close means that a warning is shown if you try to close the corresponding document window

with unsaved changes. These windows show a “*” on the beginning of their window title if there are

unsaved changes.

• Automatic Saving means that the document is saved automatically after a certain time interval. You

can configure this in the Property Browser (↪→Sec. 4.3) of the document; by default the settings from the

Global Options dialog (↪→Sec. 6.17) are used. For this mechanism to work the document must have been

saved at least once before so that a file name is known.

Data Arrays and derived documents

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

(Numerical) Data Array (*.da)

↪→Sec. 13

Numerical Data Array View, ↪→Sec. 13.5 Result Document

Chromatic Fields Set (*.cfs) Chromatic Fields Set View, ↪→Sec. 14 Result Document

Light Field Object (*.lfo) View for field components and pulses,

↪→Sec. 15.

Result Document

Non-Equidistant Field Values

(*.nefv)

Ray Distribution View, ↪→Sec. 17 Result Document

Positions, Directions & Wave-

front Phase (*.ppd)

Ray Distribution View, ↪→Sec. 17 Result Document

Set of Data Arrays (*.soda) View for Set of Objects, ↪→Sec. 16 Result Document

Legacy result documents

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Harmonic Field (*.ca2)

↪→Sec. 12.1

Harmonic Field View, ↪→Sec. 12.2 Result Document

Harmonic Fields Set (*.hfs) Harmonic Fields Set View, ↪→Sec. 12.2 Result Document

Transmission (*.ca2) Data View, ↪→Sec. 12.2.2 Result Document
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Other result documents

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Animation (*.bms) Animation View, ↪→Sec. 20 Result Document

Ray Distribution 3D (*.rays)1 Ray Distribution View, ↪→Sec. 17 Result Document

Region (*.rgn) ↪→Sec. 21 Region View, ↪→Sec. 21.3 Result Document

Optical Setups and their variation

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Optical Setup (*.os, *.lpd) Two linked document windows: Optical Setup

View (↪→Sec. 43.1) and Optical Setup Editor

(↪→Sec. 43.2)

Warn on Close

Automatic Saving

Parameter Run (*.run) Parameter Run View, ↪→Sec. 44 Warn on Close

Automatic Saving

Parametric Optimization (*.opt) Optimization Document View, ↪→Sec. 102.1 Warn on Close

Automatic Saving

Other documents

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Calculators (*.calc) Various views, ↪→Part XV

C# / Visual Basic source code

(*.cs / *.vb)

Modules View, ↪→Sec. 7.2 Warn on Close

Geometry (*.3d) 3D View, ↪→Sec. 5.15

Session Editor (*.seditor) Wizard view Warn on Close2

Documents specific for the AR/VR/XR Package

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Footprint and Grating Analysis

(*.fga)

Footprint and Grating Analysis Wizard,

↪→Sec. 101.1

Warn on Close

k-Layout Visualization (*.calc) Visualization view, ↪→Sec. 111

Light Guide Grating Design

(*.lgDesign)

Light Guide Grating Design, ↪→Sec. 101.2 Warn on Close

LUT Results Generator

(*.lutGenerator)

LUT Results Generator, ↪→Sec. 46

1 Up to VirtualLab Fusion 2021.1, Non-Equidistant Field Values documents; Positions, Directions & Wavefront Phase documents; and

Ray Distributions 3D were all saved with the extension *.rays.
2 A session editor can generate child document views (e. g. Optical Setups). These child views stay linked to the session editor so

that clicking Refresh in the session editor updates these documents. This linkage can be removed if you close the session editor and

click on Keep Associated Documents in the resulting dialog. If you click Close Associated Documents both the session editor and the

child document views are closed.
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Documents specific for the Diffractive Optics Package

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

IFTA Optimization Document

(*.dp, *.aps)

IFTA Optimization Document, ↪→Sec. 97 Warn on Close

Documents specific for Grating Optical Setups

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Diffraction Orders Diagram Data

(*.dodd)

Diffraction Orders Diagram, ↪→Sec. 19 Result Document

Order Collection (*.oc) Order Collection View, ↪→Sec. 18 Result Document

Documents specific for Laser Resonator Optical Setups

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Iteration Document (*.iter) Iteration Document View, ↪→Sec. 44.6 Warn on Close

Documents specific for Light Shaping Optical Setups

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

Cells Array Design (*.gcd) Cells Array Design, ↪→Sec. 100 Warn on Close

LLGA Results Generator (*.llga) LLGA Results Generator, ↪→Sec. 45

Documents specific for the optiSLang Package

DOCUMENT TYPE DOCUMENT WINDOW FEATURES

optiSLang Optimization (*.oso) optiSLang Optimization View, ↪→Sec. 103

4.1.1 Resizing of Document Windows

Figure 2. Dialog for adjusting the window size of all currently open result windows.

The size of all document windows can be changed via the usual mechanisms provided byWindows™ (dragging

on the borders, using the minimize and maximize buttons). Furthermore there are several tools for this in the

Windows tab of the ribbon (↪→Sec. 4.2.4).

But for result windows (↪→Sec. 4.1), VirtualLab Fusion offers special ways to set the window size in pixels, which

can be helpful for doing screenshots for presentations:
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1. Define a window size in the Global Options dialog (↪→Sec. 6.7) which is used for newly created documents.

2. Via Windows > Change Size of Result Windows you can open a dialog (↪→Fig. 2) to adapt the window

size of all currently open result windows. This dialog allows you to choose between Set Window Size (in

which case you can define theWindow Size) andMinimize Windows. The latter can be useful if there are

many results windows open which you do not need in the moment.

3. Change the size via the Property Browser (if available for the specific document type).

4.1.2 View Settings

All documents but Module Files and IFTA Optimization Documents also store the current view settings of their

corresponding document window (window size, markers, color scale and alike) if saved to hard disc. For all

of these document types which have a View ribbon, you can copy the view settings from another document

window of the same type via the View > Copy View Settings button.

4.2 Ribbon

Figure 3. Controls within a ribbon.

The ribbon at the top of the main window is the main control for accessing the various features and document

types of VirtualLab Fusion. As shown in Fig. 3, it consists of the File menu (↪→Sec. 4.2.2) and six ribbon tabs

(see table below). Various document types add a ribbon tab group to the ribbon containing further ribbon tabs.

A ribbon tab has several ribbon groups each with several ribbon items, which can be buttons, menus, and the

like.

Furthermore there is a quick access toolbar (↪→Sec. 4.2.1) where you can place your most often used ribbon

items. And with the compact mode button in the lower right corner of the ribbon you can reduce the icon sizes

of the ribbon items and thus decrease the height of the ribbon.

When you press Alt or F10 , key tips are shown which allow you to access almost all ribbon items via keyboard.

The following six ribbon tabs are always available:
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RIBBON TAB DESCRIPTION

Start Allows you to create, load and save documents. Furthermore it contains var-

ious calculators and license information. ↪→Sec. 4.2.3

Sources Provides access to all Basic Source Models (↪→Sec. 51), Partially Coherent

Source Models (↪→Sec. 52), and Spectrum Generators (↪→Sec. 53).

Functions Contains the generators for transmissions (↪→Sec. 67.1) and region docu-

ments (↪→Sec. 21).

Catalogs All VirtualLab Fusion catalogs (↪→Part V).

Windows Allows you to configure the document windows and the main window as a

whole. ↪→Sec. 4.2.4

Help Provides access to help files like the manual and the programming refer-

ence, some pre-configured Focus Topic files and tools for troubleshooting.

↪→Sec. 4.2.5

The menu of the quick access toolbar and the context menu of the actual ribbon both have the following two

entries:

ITEM DESCRIPTION

Show (Quick Access Tool-

bar)

Below / Above the Ribbon

The quick access toolbar can be shown at two different locations: in the title

bar of the main window (“above the ribbon”) or in a separate row below the

ribbon. In the first case the space available for the quick access toolbar is

limited, and thus some ribbon items might not be shown in the quick access

toolbar itself but in its menu.

Minimize the Ribbon If this option is active, the ribbon groups are only shown if you click on the

caption of a ribbon tab. This option can also be toggled by double-clicking on

the caption of a ribbon tab.

4.2.1 Quick Access Toolbar

You can place ribbon groups and most of the ribbon items in the quick access toolbar by right-clicking on them

and then selecting Add to Quick Access Toolbar. Items in the quick access toolbar can be

• Removed from the quick access toolbar by right-clicking on them and then selecting Remove from Quick

Access Toolbar.

• Rearranged by clicking on the Rearrange Items in Quick Access Toolbar button . This button is only

enabled if there are two or more items in the quick access toolbar. ↪→Sec. 4.2.1.1
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4.2.1.1 Rearranging Items in the Quick Access Toolbar

Figure 4. The dialog for rearranging the items in the quick access toolbar. It contains a list of all available items at the left

and two arrow buttons in the top right corner.

The dialog shown in Fig. 4 allows you to rearrange the items in the quick access toolbar and to save and load

the complete configuration of the quick access toolbar. This dialog lists all items in the quick access toolbar,

even those which are currently invisible. You can select any entry of that list with the mouse and then move it

up or down, or delete it.

ITEM DESCRIPTION

Move Up Moves the currently selected item one step up.

Move Down Moves the currently selected item one step down.

Delete Item Removes the currently selected item from the quick access toolbar.

Add Separator Adds a separator to the bottom of the list which can be then be moved like all

other items.

Save Configuration Saves the current configuration of the items in the quick access toolbar to

disk.

Load Configuration Loads and applies a previously saved configuration. The file Autosaved.qat
in the Path for User Settings (↪→Sec. 6.17) contains the configuration valid the

last time VirtualLab Fusion was closed.
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4.2.2 File Menu

ITEM DESCRIPTION

New Creates an empty (General) Optical Setup (↪→Sec. 43). If you click on the

arrow, you can additionally create an IFTAOptimization document (↪→Sec. 97)

or a module (↪→Sec. 7.2).

Ctrl+L is the shortcut for a new Optical Setup and Ctrl+M is the shortcut

for a new C# module.

Open Opens one or more files in one of VirtualLab Fusion’s document formats

(↪→Sec. 4.1). Shortcut Ctrl+O

Import Imports text files, images, ZemaxOpticStudio® lens and beam files and old

VirtualLab Fusion formats. ↪→Part XVI

Global Options Opens a dialog for editing global options and parameters. ↪→Sec. 6.

Online Help Link to application scenarios and tutorials on www.lighttrans.com.

Exit Closes all open documents and exits VirtualLab Fusion. Shortcut Alt+F4

When any document is open the file menu additionally contains the following menu items:

ITEM DESCRIPTION

Save Saves the currently active document to the same file the document was

loaded from. For newly created documents it asks for a file name. Short-

cut Ctrl+S

Save As Asks for a file name and saves the document to this file. Shortcut

Ctrl+Shift+S

Incremental Save Allows you to quickly save a document under an automatically given file

name, for example to keep the current state for reference. If the document

has not been saved before, it is stored with a default name in the folder {Path
for User Settings (↪→Sec. 6.17)}\Autosaved Files. Otherwise the al-

ready given file name is used with a numeral suffix which is incremented by

one with each saving in order to not overwrite files. Shortcut Ctrl+Alt+S

For some document types, there is also an Export menu item, which allows the user to save the currently active

document in a non-standard file format.

Furthermore, the 20 most recently opened documents are listed at the right of the file menu. The first 10 of

these documents can also be opened with the shortcuts Ctrl+1 … Ctrl+0 . All entries of this list can be

deleted using the × button at the top right corner of the recent files list.

4.2.3 Start Ribbon Tab

ITEM DESCRIPTION

New Creates an empty (General) Optical Setup (↪→Sec. 43). If you click on the

arrow, you can additionally create an IFTAOptimization document (↪→Sec. 97)

or a module (↪→Sec. 7.2).

Open Opens one or more files in one of VirtualLab Fusion’s document formats

(↪→Sec. 4.1).

https://www.lighttrans.com
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Save Saves the currently active document to the same file the document was

loaded from. For newly created documents it asks for a file name.

Calculators This ribbon group contains a Calculators menu, ↪→Part XV.

Diffractive Optics >

“Gaussian → Top Hat”

Transmission Design

Opens the dialog described in Sec. 99.1 which allows you to easily design a

beam shaper transforming a (super-)Gaussian input field into another super-

Gaussian top hat.

Diffractive Optics >

Diffractive Beam Shaper

Helps you to setup the IFTA optimization document for beam shaping tasks.

↪→Sec. 99.2

Diffractive Optics > Re-

fractive Beam Shaper

Opens a Session Editor (↪→Sec. 47) which helps you to design a refractive

beam shaper. For details about the resulting documents see Sec. 43 (Optical

Setup) and Sec. 102 (Parametric Optimization Document).

Diffractive Optics >

Beam Splitter Design

This section contains various Session Editors (↪→Sec. 47) which help you to

design a beam splitter. For details about the resulting documents see Sec. 43

(Optical Setup) and Sec. 97 (IFTA Optimization Document).

Diffractive Optics > Dif-

fuser Design

This section contains various Session Editors (↪→Sec. 47) which help you

to design a diffuser. For details about the resulting documents see Sec. 43

(Optical Setup) and Sec. 97 (IFTA Optimization Document).

Gratings The ribbon item General Grating Optical Setup provides a preconfigured Op-

tical Setup which is described in Sec. 43.11.1. Furthermore there are several

ribbon items creating Optical Setups preconfigured with various grating types.

Gratings > LLGA Re-

sults Generator

After clicking on this ribbon item you must first specify a XML file containing

data for a set of gratings. After the XML file has been successfully read, a

LLGA Results Generator (↪→Sec. 45) is opened containing the imported data.

Laser Resonators >

Laser Resonator Session

Editor

Opens a Session Editor (↪→Sec. 47) to setup a Laser Resonator Optical Setup

(↪→Sec. 43.11.2).

Laser Resonators >

Laser Resonator Optical

Setup

Opens an empty Laser Resonator Optical Setup (↪→Sec. 43.11.2).

Light Guides > Light

Guide Optical Setup

Opens an Optical Setup which contains a default Light Guide component

(↪→Sec. 57.2).

Light Guides > k-

Layout Visualization

Opens a new k-Layout Visualization calculator (↪→Sec. 111).

Light Guides > Layout

Design

Opens a new Layout Design calculator (↪→Sec. 113).

Light Guides > Grating

Design

Opens a new Light Guide Grating Design (↪→Sec. 101.2) for a Light Guide

Optical Setup.

Light Shaping > Light

Shaping Optical Setup

with . . . Cells

Opens a preconfigured Optical Setup using either a Grating Cells Array

(↪→Sec. 40.1.1), a Prism Cells Array (↪→Sec. 40.1.2), or a Mirror Cells Array

(↪→Sec. 40.1.2) as light shaping element.

Light Shaping > Light

Shaping Optical Setup

Opens an empty Light Shaping Optical Setup (↪→Sec. 43.11.4).
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4.2.4 Windows Ribbon Tab

ITEM DESCRIPTION

Close All Closes all currently open document windows.

Close All But Current Closes all currently open document windows which are not active.

Close All Result Win-

dows

Closes all currently open result windows. Sec. 4.1 lists which document types

are shown in result windows.

Cascade All document windows are cascaded.

Tile Horizontally All document windows are tiled horizontally.

Tile Vertically All document windows are tiled vertically.

Arrange Icons All minimized document windows are arranged.

Change Size of Result

Windows

Allows you to set the size of all open result windows (or to minimize them).

↪→Sec. 4.1.1

{Active Document Win-

dow Selection}

A drop-down list to select one of the currently open documents as the active

document.

Rename Document Changes the title of the currently active document window (Shortcut: F2 ).

Duplicate Document Duplicates the currently active document window. When you click on the

arrow, you have the additional choice to copy only the actual document, not

the view settings. In this way you can get rid of misconfigured or unwanted

view settings. Examples are a diagram which shows nothing because the

view range is wrong or when you get documents from colleagues but want

to use your default windows size and color table configured in the Global

Options dialog (↪→Sec. 6).

Reset Docking Tabs Resets all docking tabs (↪→Sec. 4.3) to their default position and size.

Show / Hide Right

Docking Tab

Shows the right docking tab if it is hidden – and vice versa. Shortcut: F4 .

Show Status Bar Toggles the visibility of the status bar (↪→Sec. 4.4).
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4.2.5 Help Ribbon Tab

ITEM DESCRIPTION

Content Opens the help system and shows the table of contents.

Index Opens the help system and shows the index.

Programming Refer-

ence

Opens the VirtualLab Fusion programming reference documenting useful

commands for programming.

Assistant This ribbon group offers context sensitive help for the currently active docu-

ment view.

Focus Topics this ribbon group contains links to Focus Topic Files which demonstrate how

certain tasks can be done in VirtualLab Fusion. They are grouped into several

categories and updated dynamically, so that new focus topics appear in this

menu as soon as they are available.

The Show Sample Files button determines whether VirtualLab Fusion sample

files are opened when you click on a focus topic item. Else only the corre-

sponding web page is opened in your browser.

Diagnosis & CleanUp Opens a dialog with three options:

• Clean up the RAM from unused VirtualLab Fusion data.

• Check the external components used by VirtualLab Fusion.

• Write a support mail (see next item).

Mail Support Informa-

tion

Prepares a mail to our support and shows it in your mail program. It contains

some information we need to solve your issue.

First Steps A dialog helping you getting started with VirtualLab Fusion.

What’s New A dialog explaining what is new in the current version.

Tips and Tricks Link to tips and tricks which ease using our software.

About VirtualLab Shows a dialog with license, version, contact, and legal information.

License Information Opens the dialog for viewing and managing your VirtualLab Fusion license.

↪→Sec. 10

Update Information Opens a web link which shows whether updates are available. More infor-

mation can be found in the administrator’s manual.

Trial Configuration O .

Allows you to select the additional packages for VirtualLab Fusion (↪→Sec. 1).

https://www.lighttrans.com/index.php?id=1799
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4.3 Docking Tabs

Figure 5. Controls within a docked tab control.

The user interface of VirtualLab Fusion contains five special tab pages:

TAB DESCRIPTION

Parameter Overview Tree O O S

Provides quick access to most parameters of a Optical Setup. ↪→Sec. 43.7

Property Browser Allows you to view and manipulate properties of the currently active docu-

ment. Depending on the document type, the property browser will be divided

into several panels.

VirtualLab Fusion Ex-

plorer

Offers a convenient way to toggle between the distinct open windows.

↪→Sec. 4.3.1

Distributed Computing Allows you to configure server and clients for distributed computing. ↪→Sec. 8

Messages Shows error, warning and status messages. It has its own context menu

which allows the user to Cut (Ctrl+X ), Copy (Ctrl+C ), Paste (Ctrl+V )
certain messages as well as to Select All (Ctrl+A ) content and to Clear all
text. If you hold the Ctrl -key while scrolling with the mouse wheel, the font
size of this control changes.

Detector Results Shows detector results in a tabular form whereas the latest entry is shown at

the top of the table. Via its context menu you can

• Copy Selected Detector Results to the clipboard for easy import to

spread sheet programs and text files.

• Specify to Show Physical Units. If you disable this option all detec-

tor results are converted to their respective base unit and no units are

shown anymore. For example, “1 nm” will then be shown as “1e-9” and

“180°” will be shown as “3.1416”. This simplifies using copied values in

external programs.

• Usually the columns are automatically resized to show as much content

as possible. But you can resize them to your likings by moving the

mouse between two column headers. The cursor then switches to a

double arrowwith a bar and you can click and drag to change the column

width. (The same is possible for the row heights.) If you switch to Fixed

Column Widths, the current column widths remain even if this table is

resized or new detector results are calculated (which else triggers a new

automatic resizing).

• Clear Detector Results, i. e. clear the entire table.
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By default, the Parameter Overview Tree, the Property Browser and the VirtualLab Fusion Explorer tab pages

are placed in a tab control which is docked at the right of the main window. The Messages and the Detector

Results tab pages are placed in a tab control which is docked at the bottom of the main window. These two

tabs are marked with a if new data is written into them while another tab in the tab control they are placed in

is visible.

The tab controls can be resized by dragging their borders. They also can be moved around by clicking onto

their title bar and dragging them while keeping the left mouse button pressed. Usually such a moved tab control

becomes a floating tab which is independent from the main window. But if you move a tab control onto a guide

it becomes a docked tab control again which changes its position and size with the main window. A tab

control can be docked at the left, at the right or at the bottom of the main window; besides any other docked

tab control or inside any other tab control.

In the same way you can move a single tab page by clicking onto the tab and dragging it while keeping the left

mouse button pressed. If you do not move a tab page into an already existing tab control it becomes its own

tab control. Docked tab pages can be set into an auto hidemode which means that only its tab is shown unless

you move the mouse onto the tab. This mode can be toggled with the pin at the right of its title bar.

By clicking onto the ribbon item Windows > Reset Docking Tabs all four tabs become docking tabs again and

are set to their default position and size. By clicking Windows > Toggle Visibility of Property Browser (shortcut

F4 ) you can always make the Property Browser visible, which means that it becomes the active tab of its tab
control and that the auto hide is turned off if applicable. If the Property Browser is visible and you use this

ribbon item, the tab control is set to auto hide mode if it is docked and another tab in its tab control becomes

the active tab.

4.3.1 VirtualLab Explorer

Figure 6. The VirtualLab Fusion Explorer with some sample documents, among others a Regular Beam Splitter Session

Editor with associated documents.

The VirtualLab Explorer (↪→Fig. 6) displays all currently open document windows under a central node named

VirtualLab Session. For a better overview, session editors (↪→Sec. 47) and documents generated by them are

grouped under one node. The currently active document is marked red.

If you right-click with the mouse on a document window (= leaf node), this document is selected (but not

activated) and a context menu with the following options opens.
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ITEM DESCRIPTION

Rename Opens a dialog where you can change the caption of the selected document

window (but not its number).

Minimize Minimizes the selected document window to the lower left corner of the doc-

ument area.

Bring to Front Brings the selected document window to the front (which means that it is no

longer obscured by other document windows) andmakes it the active window.

If a document window was minimized it is reverted to normal size.

The same can be done by double-clicking on a tree node with the left mouse

button.

Close Closes the selected document window. This can also be done with Shift +

Del .

4.4 Status Bar

The bottom most part of the main window is reserved for the status bar. On the left it displays the number

of CPU cores currently used for multi-core calculations. Furthermore it shows whether the Parameter Run

(↪→Sec. 44) itself runs parallel (also for Parameter Run) or only the simulation of each Optical Setup (not for

Parameter Run). The multi-core configuration of VirtualLab Fusion can be changed in the Global options dialog

(↪→Sec. 6.15).

On the right of the status bar there are two gauges monitoring the current computer performance. The left one

indicates the current CPU usage of VirtualLab Fusion (blue) and of all other processes (black). The right one

shows the current usage of the physical memory. Memory used by other processes than the current instance of

VirtualLab Fusion is indicated black. The memory used by the current instance of VirtualLab Fusion is marked

green. If more than 95% of the total physical memory are used, only one red bar is shown. You can switch these

gauges on or off by right clicking on them and then either checking or unchecking Use Monitoring, respectively.

Note on CPU usage

Hyperthreading is a technique on most modern CPUs to faster switch between two threads when one is

waiting for data. In this case, the operating system sees two logical cores for each physical core. Thus

it is completely normal that fully parallelized algorithms use “only” all physical cores which results in a

CPU usage of “only” 50%.

4.5 Notifications and Notify Icon

If you work in other programs while long lasting simulations run in VirtualLab Fusion, you will miss when these

simulations are finished. To solve this problem, VirtualLab Fusion uses Windows™ notifications, shown as

popups in the bottom right of the main screen. Notifications need a notify icon in the right part of the task bar

(the notification area).

How the notifications look and behave and how long they are shown depends on the used Windows version.

For example in Windows 10 notifications play a sound and they are stored in the Action Center so that you can

read them later.

https://en.wikipedia.org/wiki/Hyper-threading
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Figure 7. The three types of notifications used by VirtualLab Fusion.

VirtualLab Fusion offers three types of notifications (↪→Fig. 7):

TYPE DESCRIPTION

Info Shown if a simulation was completed successfully. This applies to Optical Se-

tups, Parameter Runs, Parametric Optimizations, and Iteration Documents.

Warning Shown if a simulation is halted because the free RAM would fall short the

Guaranteed Amount of Remaining Physical Memory (↪→Sec. 6.14) if the sim-

ulation continued.

Error Shown if an Optical Setup aborts its simulation due to errors. The other doc-

ument types mentioned above always complete successfully – they just skip

the current simulation if errors occur.

By double-clicking on the icon you can activate the corresponding VirtualLab Fusion main window, i. e. bring it

to the front, “un-minimize” it, and give it the focus. The latter means that you can use for example the ribbon

shortcuts with Alt +…
The notify icon has a context menu with some useful shortcuts:

ITEM DESCRIPTION

Activate Main Window Activates the corresponding VirtualLab Fusion main window, i. e. brings it to

the front, “un-minimizes” it, and gives it the focus.

Global Options Opens the Global Options dialog (↪→Sec. 6).

Help > Content Opens the online help system and shows the table of contents.

Help > Index Opens the online help system and shows the index.

Help > Programming

Reference

Opens the VirtualLab Fusion programming reference documenting useful

commands for programming.

Help > About

VirtualLab

Shows a dialog with license, version, contact, and legal information.

Exit VirtualLab Closes all open documents and exits VirtualLab Fusion.

Notifications and the notify icon can be switched off via the Global Options dialog (↪→Sec. 6.3).

5 Common Controls

5.1 Control for Input of Values with Units

Text boxes for entering numerical values with units (in short: value text boxes) appear in numerous dialogs of

VirtualLab Fusion, Fig. 8 shows an example.

Figure 8. Sample control for entering a wavelength.
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Depending on the application of the control, the control is set to a certain measured quantity. If you enter a

value without unit, the default unit (with no prefixes) of this physical property is used to interpret this value. If

the interpreted value is less than 1 or greater or equal than 1000 then VirtualLab Fusion usually uses a unit

with prefix to bring the value into that range. For example an entered length of “1234” is interpreted as 1234

meters and shown as “1.234 km”, but of course you can enter “1.234 km” as well.

The following table lists all measured properties and the corresponding units supported by VirtualLab Fusion.

If two or more units are supported, the default unit is marked bold. Note that for the measured quantity “length”,

the default unit can be set by the user in the Global Options dialog (↪→Sec. 6.5).

There are also units which you can use for entering values but which are never used by VirtualLab Fusion for

output. They are marked gray in the table.

Note for Developers

Usually values are stored internally in the default unit. For example a variable with a pressure value

always contains the value in pascals, even if it was entered in kilopascals. The only exceptions to this

rule are:

• Angle (°): Values are stored in radians.

• Energy (eV): Values are stored in joules.

• Length: Values are always stored in meters, even if another default unit is set in the Global Options.

• Percentage: The actual values are stored (50 % → 0.5).

PHYSICAL PROPERTY UNITS

No Unit –

Absorption Coefficient “m−¹” (or “1/m”)

Angle (°) “◦” (or “deg”), “π” (“pi”, “Pi”, or “PI”), “rad”, “mrad”

Angle (rad°) “◦” (or “deg”), “π” (“pi”, “Pi”, or “PI”), “rad”, “mrad”

Arbitrary Unit “A.U.”

Area per Energy “m²/J”

(Area per Energy)² “m⁴/J²”

Electric Field Strength “µV/m”, “mV/m”, “V/m”, “kV/m”, “MV/m”

(Electric Field Strength)² “(µV/m)²”, “(mV/m)²”, “(V/m)²”, “(kV/m)²”, “(MV/m)²”

Energy (eV) “meV”, “eV”, “keV”, “MeV”, “GeV”, “nJ”, “µJ”, “mJ”, “J”, “kJ”, “MJ”

Energy (J) “meV”, “eV”, “keV”, “MeV”, “GeV”, “nJ”, “µJ”, “mJ”, “J”, “kJ”, “MJ”

Energy per Area “J/m²”

Energy per Volume “J/m³”

Illuminance “lx” (or “lm/m²”)

Information (Decimal) “B”, “kB”, “MB”, “GB”, “TB”, “PB”, “EB”, “kiB”, “MiB”, “GiB”, “TiB”,

“PiB”, “EiB”

Information (Binary) “B”, “kB”, “MB”, “GB”, “TB”, “PB”, “EB”, “kiB”, “MiB”, “GiB”, “TiB”,

“PiB”, “EiB”

k-Domain Electric Field Strength “µVm”, “mVm”, “Vm”, “kVm”, “MVm”

(k-Domain Electric Field Strength)² “(µVm)²”, “(mVm)²”, “(Vm)²”, “(kVm)²”, “(MVm)²”

k-Domain Magnetic Field Strength “µAm”, “mAm”, “Am”, “kAm”, “MAm”

https://en.wikipedia.org/wiki/Binary_prefix
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(k-Domain Magnetic Field Strength)² “(µAm)²”, “(mAm)²”, “(Am)²”, “(kAm)²”, “(MAm)²”

Length “fm”, “pm”, “nm”, “µm”, “mm”, “cm”, “dm”, “m”, “km”

“in” (or “inches”, or “inch”, or “ ” ”), “mil” (1/1000 inch), “ft” (or “foot”,

or “feet”, or “ ’ ”), “yd” (or “yard”, or “yards”), “mile” (or “miles”)

Line Density “cycles/mm”

Logarithmic Level “dB”

Luminance “cd/m²” (or “lm/sr/m²”)

Luminous Energy “(lm s)”

Luminous Energy Density “(lm s)/m³”

Luminous Flux “lm”

Luminous Intensity “cd” (or “lm/sr”)

Magnetic Field Strength “µA/m”, “mA/m”, “A/m”, “kA/m”, “MA/m”

(Magnetic Field Strength)² “(µA/m)²”, “(mA/m)²”, “(A/m)²”, “(kA/m)²”, “(MA/m)²”

Percentage “%”

Per Volume “1/m³”, “1/dm³”, “1/cm³”, “1/mm³”, “1/µm³”, “1/ft³”, “1/in³”

Power “pW”, “nW”, “µW”, “mW”, “W”, “kW”, “MW”, “GW”

Power per Area “µW/m²”, “mW/m²”, “W/m²”, “mW/mm²”, “W/mm²”, “W/µm²”

(Power per Area)² “(µW/m²)²”, “(mW/m²)²”, “(W/m²)²”, “(mW/mm²)²”, “(W/mm²)²”,

“(W/µm²)²”

Power per Solid Angle “µW/sr”, “mW/sr”, “W/sr”

Power per Solid Angle and per Area “µW/sr/m²”, “mW/sr/m²”, “W/sr/m²”, “mW/sr/mm²”, “W/sr/mm²”,

“W/sr/µm²”

Power per Volume “W/m³”

Pressure “Pa”, “hPa”, “kPa”, “MPa”, “GPa”, “mbar”, “bar”, “atm”

Spectral Radiant Energy “J/m”

Spectral Radiant Energy Density “J/m⁴”

Spectral Radiant Flux “W/m”

Spectral Radiant Intensity “W/(msr)”

Temperature (°C) “K”, “°C”, “°F”

Temperature (K) “K”, “°C”, “°F”

Temporal Frequency “mHz”, “Hz”, “kHz”, “MHz”, “GHz”, “THz”, “PHz”

Time “as”, “fs”, “ps”, “ns”, “µs”, “ms”, “s”, “min”, “h”

Volume per Energy “m³/J”

(Volume per Energy)² “m⁶/J²”

Wave Number “m−¹” (or “1/m”)
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Some units contain characters which cannot be entered easily with every keyboard. Thus in addition

to the replacements given in the table above, you can replace “µ” by “u” and superscript digits like “²”

by “^2” when entering a unit. The narrow no-break space used for separating multiplied units can be

omitted.

By default, values are displayed with the Number of Digits specified in the Display of Numbers subcategory of

the Global Options dialog (↪→Sec. 6.5), but this can be changed via the context menu (see below).

Furthermore, a small indicator may be used in order to show whether a text box doesn’t display all available

digits. This indicator has to be activated in the Global Options dialog. The appearance of this indicator is

depicted in Fig. 9. If the mouse is moved over the indicator, a tooltip shows the number in full precision.

Figure 9. The hidden digits indicator of a value text box.

If you enter invalid data into a value text box, its text is marked red and the dialog containing this control is

locked (this means OK button, Next button, etc. are disabled). If you move the mouse over the control a tool

tip with the error message is displayed.

This control can also be used for the input of integer values with no unit. In this case a spinner can be used in

addition to the actual text box.

The context menu of this control has the following entries.



CHAPTER 5. COMMON CONTROLS 48

ITEM DESCRIPTION

{Unit Selection} If the control is set to a measured quantity with more than one unit, there is a

combo box with all available units (even those which are usually used only for

input). You can select any of these units and the current value is then shown

with this unit.

Precision Defines how many digits are shown. You can switch between Full (10 digits)

and the Default set in the Global Options dialog (↪→Sec. 6.5).

Left Aligned Text Shows the text in the text box left-aligned, which can be helpful in case not

all digits can be shown at once.

Insert Infinity In some cases, this control allows you to enter infinite values, where “inf” and

“-inf” correspond to Positive and Negative infinity, respectively. For conve-

nience these strings can also be entered via the context menu.

Undo Allows you to undo the last text change.

Copy Text Copies the text as shown in the text box into the Windows™ clipboard, for

example “1.23 nm” or “180°”. Shortcut: Ctrl+C .

Copy Value Copies the actual value represented by the text box to the Windows™ clip-

board, including also the non-shown digits. For example “1.234567e-9” if the

text box shows “1.23 nm” (with 3 digits) or “3.1415926535897931” if the text

box shows “180°”. Shortcut: Ctrl+Shift+C .

Paste Pastes the content from the Windows™ clipboard into the text box if possible.

If the value was copied from another text box, it might change the unit. For

example if you paste the value “1.23” into a text box showing percentages, it

becomes “123 %”. Shortcut: Ctrl+V .

Select All Selects the complete content of the text box. Shortcut: Ctrl+A .

5.2 Control for Input of Complex Values

Figure 10. Example of a control to enter a complex value with physical units.

Left: Real and imaginary part of a complex number can be entered. Right: Amplitude and phase of a complex number

can be entered.

This control consists of two controls to enter a value with a unit as described in Sec. 5.1, and two buttons. If

the -button is pressed real and imaginary part, respectively, can be entered. In contrast, if the -button is

pressed amplitude and phase can be entered.

5.3 Control for Input of Two-Dimensional Vectors

Figure 11. Example of a control to enter a two-dimensional vector.

This control consists of two controls to enter a physical value (↪→Sec. 5.1), one for the x-direction and one for

the y-direction. If you double click into one of these controls, the value from the other control is copied into this

control. If the control is used to enter value ranges instead of a point, a × is shown between the two controls.
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5.4 Control for Input of Double Arrays

This control can be used to enter a one- or two-dimensional array of values with double precision.

Figure 12. Control to enter a two-dimensional array of values with double precision.

Example for a text file for data import:

# Comment Line
1; 2; 3
3; 2; 1
5; 6; 7

The following settings can be made for an array of values:
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ITEM DESCRIPTION

Number of Entries The number of entries in the array.

Make Entries Available for

Parameter Extraction

If you check this option, each entry of the array can be varied via Param-

eter Extraction (↪→Sec. 43.5) and thus used e. g. in the Parameter Run

(↪→Sec. 44). If the array contains more than 100 entries, a warning is shown

that this might slow down the tables where the parameters to vary are con-

figured.

Minimum Values /

Maximum Values

IfMake Entries Available for Parameter Extraction is checked, you can preset

the minimum and maximum value for each entry here. In e. g. the Parameter

Run you can later diminish the specified range, but not extend it (↪→Sec. 44.2).

Table of entries In the table you can specify the actual value of each entry.

Reset Table After you have changed theNumber of Entries youmust reset the table, which

means that the size of the table is adjusted and all cells are filled up with the

default value of “1”.

Export / Import > Import

Text File

You can import the values of the array from a .txt or .csv file. The file must

have the format given in the marginal.

Export / Import > Export to

Text File

You can export the values of the array into a .txt or .csv file.

Export / Import > Import

Data Array

You can import the values from any open one- or two-dimensional data array.

If the data array contains more than one subset, you can choose which subset

to import. If the subset to import is complex-valued, only the real value is

imported.

Export / Import > Export

Data Array

You can export the values configured within the dialog into a data array. As a

result of this operation the generated data array is shown as document within

VirtualLab Fusion.

5.5 Control for Defining a Single Direction

In many cases where a direction vector in R3 has to be defined, a special control (seeFig. 13) can be used

which is introduced here.

Figure 13. Control for defining a direction vector.

Since there are several kinds of direction definition conventions (↪→Sec. 139.2), the appearance of the control

can vary strongly. The only common controls always available are
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ITEM DESCRIPTION

Definition Type The convention to use for defining the direction vector (↪→Sec. 139.2) can be

selected here.

Direction The normalized direction vector which corresponds to the entered direction

data.

Validity An indicator which shows whether or not the entered data are consistent

↪→Sec. 5.10.

All other controls are convention-specific and will be described in the following sections Sec. 5.5.1 to Sec. 5.5.6.

5.5.1 Direction Vector

See also Sec. 139.2.7 for more details on this convention.

ITEM DESCRIPTION

X/Y/Z The components of a (not necessarily normalized) direction vector.

5.5.2 Spherical Angles

See also Sec. 139.2.1.1 for more details on this convention.

ITEM DESCRIPTION

Reference Axis The coordinate system’s base vector which is to be inclined by Theta and Phi.

Theta Spherical angle θ, measured from the reference axis in a plane constructed by

rotating the x-z-, y-x-, or z-y-plane (depending on the choice of the Reference

Axis) by the other sphere angle φ.

Phi Spherical angle φ, representing a rotation about the reference axis. It is mea-

sured in the plane perpendicular to the reference axis, between the y-, z- or

x-axis (depending on the choice of the Reference Axis) and the line of nodes.

The latter is identical to the axis the reference axis is rotated about by the

inclination angle θ.

5.5.3 Direction Angles

See also Sec. 139.2.2.1 for more details on this convention.

ITEM DESCRIPTION

Rho The angle between the direction to be defined and the x-axis. This angle’s

cosine is identical to the x-component of the normed direction vector.

Sigma The angle between the direction to be defined and the y-axis. This angle’s

cosine is identical to the y-component of the normed direction vector.

Tau The angle between the direction to be defined and the z-axis. This angle’s

cosine is identical to the z-component of the normed direction vector.

Direction inside negative

X/Y/Z half space

This check box indicates whether or not the x/y/z-component of the direction

to be defined is negative.
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5.5.4 Cartesian Angles

See also Sec. 139.2.3.1 for more details on this convention.

ITEM DESCRIPTION

Reference Axis The coordinate system’s base vector which is to be inclined by Alpha and

Beta.

Alpha The angle between the reference axis and the projection of the direction to be

defined onto the x-z- or x-y-plane (depending on the choice of the Reference

Axis).

Beta The angle between the reference axis and the projection of the direction to be

defined onto the y-z- or x-z-plane (depending on the choice of the Reference

Axis).

5.5.5 Sequence of Axis Rotations

See also Sec. 139.2.4.1 for more details on this convention.

ITEM DESCRIPTION

Reference Axis The coordinate system’s base vector which is to be rotated by the rotation

sequence.

X/Y/Z-Axis Rotation Angle of rotation about the x-/y-/z-axis.

Changes the sequence of rotation by lifting the current angle one position up.

Changes the sequence of rotation by lowering the current angle one position

down.

Flips the sequence of rotation.

Adds a new rotation.

Deletes the currently selected rotation.

5.5.6 Rotation Matrix

See also Sec. 139.2.6.1 for more details on this convention.

ITEM DESCRIPTION

Reference Axis The coordinate system’s base vector which is to be rotated by the rotation

matrix.

Matrix Entries The nine entries of the rotation matrix can bee set here.

> Copy Copies the complete matrix to clipboard (as a string).

> Paste Tries to paste a matrix from clipboard. It may have the format ”s11; s12; s13;

s21; s22; s23; s31; s32; s33” with s11 to s33 being strings for each of the

nine matrix elements.

> Normalize Normalizes the matrix.

> Set to Identity Sets the matrix to the identity matrix.

> Transpose Transposes the current matrix.
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5.6 Control for Defining a Solid’s Orientation

In many cases where a solid’s orientation in R3 has to be defined, a special control can be used which is

introduced here.

Since there are several kinds of orientation angle conventions (↪→Sec. 139.2), the appearance of the control

can vary strongly. The only common controls always available are

ITEM DESCRIPTION

Orientation Definition

Type

The convention to use for defining the orientation (↪→Sec. 139.2) can be se-

lected here.

Pressing this button will calculate and show the rotation matrix which repre-

sents the currently entered orientation.

All other controls are convention-specific and will be described in the following sections Sec. 5.6.1 to Sec. 5.6.6.

5.6.1 Spherical Angles

See also Sec. 139.2.1.2 for more details on this convention.

Figure 14. Control for determining an orientation via spherical angles and a rotation about the z-axis.

ITEM DESCRIPTION

Theta (Spherical) Spherical angle θ, measured from the z-axis in a plane constructed by rotating

the x-z-plane by the other sphere angle φ.

Phi (Spherical) Spherical angle φ, representing a rotation about the z-axis. It is measured in

the x-y-plane between the y-axis and the line of nodes. The latter is identical

to the axis the whole coordinate system is rotated about by the inclination

angle θ.

Z-Axis Rotation Angle Angle ζ of a rotation about the z-axis.

Swap Order Using this button, the sequence of inclining the z-axis via θ and φ on the one

hand and of rotating about the z-axis on the other hand can be flipped. If Z-

Axis Direction Definition is above Rotation About Z-Axis, the z-axis inclination

is done first, followed by the z’-axis rotation. If the sequence is the other way

round, The z-axis rotation is done first, followed by the inclination in reference

to the new rotated coordinate system.

5.6.2 Direction Angles

See also Sec. 139.2.2.2 for more details on this convention.
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Figure 15. Control for determining an orientation via direction angles and a rotation about the z-axis.

ITEM DESCRIPTION

Rho The angle between the new z’-axis and the old x-axis. This angle’s cosine is

identical to the x component of the normed z’-vector.

Sigma The angle between the new z’-axis and the old y-axis. This angle’s cosine is

identical to the y component of the normed z’-vector.

Tau The angle between the new z’-axis and the old z-axis. This angle’s cosine is

identical to the z component of the normed z’-vector.

Z-Axis inside negative

X/Y/Z half space

This check box indicates whether or not the x/y/z-component of the new

z’-vector is negative.

Z-Axis Rotation Angle Angle ζ of a rotation about the z-axis.

Swap Order Using this button, the sequence of inclining the z-axis (via ρ, σ, and τ) and

of rotating about the z-axis can be flipped. If Z-Axis Direction Definition is

above Rotation About Z-Axis, the z-axis inclination is done first, followed by

the z’-axis rotation. If the sequence is the other way round, The z-axis rota-

tion is done first, followed by the inclination in reference to the new rotated

coordinate system.

5.6.3 Cartesian Angles

See also Sec. 139.2.3.2 for more details on this convention.

Figure 16. Control for determining an orientation via Cartesian angles and a rotation about the z-axis.
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ITEM DESCRIPTION

Alpha The angle between the old z-axis and the projection of the new z’-axis onto

the x-z-plane.

Beta The angle between the projection of the new z’-axis onto the y-z-plane and

the old z-axis.

Z-Axis Rotation Angle Angle ζ of a rotation about the z-axis.

Swap Order Using this button, the sequence of inclining the z-axis via α and β on the one

hand and of rotating about the z-axis on the other hand can be flipped. If Z-

Axis Direction Definition is above Rotation About Z-Axis, the z-axis inclination

is done first, followed by the z’-axis rotation. If the sequence is the other way

round, The z-axis rotation is done first, followed by the inclination in reference

to the new rotated coordinate system.

5.6.4 Euler Angles

See also Sec. 139.2.5 for more details on this convention.

Figure 17. Control for determining an orientation via Euler angles.

ITEM DESCRIPTION

Psi (Euler) The angle of rotation about the z-axis.

Theta (Euler) The angle of rotation about the new x’-axis, resulting from the former rotation.

Phi (Euler) The angle of rotation about the new z’-axis, resulting from the former rotation.

5.6.5 Sequence of Axis Rotations

See also Sec. 139.2.4.2 for more details on this convention.

Figure 18. Control for determining an orientation via a sequence of rotations about coordinate axes.
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ITEM DESCRIPTION

Fix Axes If checked, the sequence of rotations refer to fix axes. Otherwise, the non-first

rotations are about axes resulting from former rotations.

X/Y/Z-Axis Rotation Angle of rotation about the fix x-/y-/z-axis.

X’/X”/Y’/Y”/Z’/Z”-Axis Ro-

tation

Angle of rotation about the current x’/x”/y’/y”/z’/z”-axis, resulting from former

rotations.

Changes the sequence of rotation by lifting the current angle one position up.

Changes the sequence of rotation by lowering the current angle one position

down.

Flips the sequence of rotation.

Adds a new rotation.

Deletes the currently selected rotation.

5.6.6 Rotation Matrix

See also Sec. 139.2.6.2 for more details on this convention.

ITEM DESCRIPTION

Matrix Entries The nine entries of the rotation matrix can bee set here.

> Copy Copies the complete matrix to clipboard (as a string).

> Paste Tries to paste a matrix from clipboard. It may have the format ”s11; s12; s13;

s21; s22; s23; s31; s32; s33” with s11 to s33 being strings for each of the

nine matrix elements.

> Normalize Normalizes the matrix.

> Set to Identity Sets the matrix to the identity matrix.

> Transpose Transposes the current matrix.

5.7 Button to Set a Document

This button (↪→Fig. 19) is labeled with Set. When you click on it a menu opens which allows you to set a

result document (↪→Sec. 4.1) in various ways. Depending on the context not all entries might be available.

Furthermore there might be constraints on which kind of document you can set, for example only equidistant

two-dimensional data arrays with length coordinates.

Figure 19. The button to set a document.
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MENU ENTRY DESCRIPTION

Load Loads a data array from file. If the loaded document does not match the

constraints, it is shown as separate document but not set. So you can adapt

it via the Manipulations ribbon tab.

Import O

Imports a data array from a bitmap or text file by means of the import wiz-

ard described in Sec. 121.2. If the imported data array does not match the

constraints, it is shown as separate document but not set.

Select from Documents Allows you to select an already open document with matching properties.

Reset Removes the currently set document.

5.8 Tables

Initially a table cell is always in display mode. If you want to change the content of a cell you can switch to the

edit mode by double clicking on a cell or by pressing F2 when a cell is marked. It is also possible to simply

start typing the new content. While in edit mode, a double click or Ctrl+A marks the whole content of a cell.

Quite often the content of a table cell is a physical value. Then the edit mode behaves similar to the control for

input of physical values (↪→Sec. 5.1). In particular values entered without a unit automatically get the default

unit. But in contrast to this control, table cells usually not mark invalid values red but just restore the original

value when you leave the edit mode. Furthermore in edit mode always all digits of a number are shown so that

there is no loss of precision when editing a value.

In display mode a table has a context menu which allows you to copy the content of the currently selected cells

to the Windows™ clipboard so that they can be used in external programs like spreadsheet programs (Copy

Selection). Often you can also Paste data into the table.

5.9 Control for Input of Data Pairs

This control (↪→Fig. 20) is used for the input of a sample of paired values.

Figure 20. Example of control for input of data pairs.

5.9.1 Adding new data

There are three modes for the input of new data which are related to the following controls:
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ITEM DESCRIPTION

Set Data Array Allows you to load a one-dimensional, real-valued data array with matching

properties into the table. If you click on this button you can load the data array

from a file or from an already open document. ↪→Sec. 5.7.

Add Datum Clicking this button will open a dialog that allows the user to input a new pair

of values.

New Data Set Clicking this button will open a dialog that allows the user to define the whole

range of the first column by input of a start value, an end value, and the total

number of values (see below). The second value is filled with a default value

initially and has to be set to the desired values as described in Sec. 5.9.2.

5.9.1.1 Configuration of a New Set of Equidistant Data

Equidistant distributed data can be configured via the dialog described here.

Figure 21. Dialog for the definition of equidistant intervals.

ITEM DESCRIPTION

From First (smallest) value for the first column.

To Last (largest) value for the first column.

Number of Steps Number of data pairs to enter.

5.9.2 Modifying data

If you want to change any value in the table, you have to select the desired cell (by one left click or via arrow

keys), then start to enter the new value. After editing just leave the cell.

5.9.3 Deleting data

If you want to delete one or more rows, select these rows and press Del . The complete table can be selected
by marking both column headers. If a single cell is selected, pressing Del deletes the content of that cell while

Shift+Del deletes the complete row.

In any case there will be a prompt for confirmation before deleting rows.

5.9.4 Exporting data

Marked cell contents can be copied to clipboard via Ctrl+C for further use e. g. in spreadsheet programs.

Show Data Array shows the data as separate data array document (↪→Sec. 13).

5.9.5 Interpolation method

Sometimes, the user can define the interpolation method to be used. In this case, also theUpper Limit is shown,

this is the maximum x-value for which the data is defined.
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VirtualLab Fusion tries to evaluate whether the entered data are equidistant or not and shows only the suitable

Interpolation Methods. Note that simply changing a x-value or adding data can change the data from equidistant

to non-equidistant or vice versa, thus changing the Interpolation Method. A warning is shown in that case.

The actual value of the upper limit depends on the selected interpolation. For non-equidistant data andConstant

Interval interpolation the Upper Limit can be set by the user. More information about interpolation method and

the upper limit can be found in Sec. 13.2.

5.10 Validity Indicator

Figure 22. The different states of the control used to indicate the validity of a whole control.

In various places, a small symbol indicates the validity state of the current control (↪→Fig. 22). The following

table explains the various validity states.

VALIDITY STATE DESCRIPTION

Consistency check is still in progress.

Everything is okay.

There are several issues which might yield unexpected or unwanted results. The

number of issues is shown as small red number.

In this state an additional -button is shown. If you click this button a separate dialog

explains all these warnings in detail.

There are several issues whichmust be fixed before you can proceed (close the dialog

with OK etc.).

In this state an additional -button is shown. If you click this button a separate dialog

explains all these errors in detail - and additional warnings if present.

In the dialog showing all warnings and errors you can double click on one explanation to copy it to theWindow™

Clipboard. So you can use it for support requests.

5.11 Color Mapping

The Color Mapping Color control used at various locations in VirtualLab Fusion defines the mapping of a double

value range to a color range and vice versa.

Figure 23. Control to set color mapping properties.
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ITEM DESCRIPTION

Vectorial Component Choose the vectorial component of the complex amplitude to be exported.

Note: This item is not always available.

Field Quantity Choose the field quantity of the complex amplitude to be imported or exported.

Adapt Min / Max Values to

Field Extrema

Adapt the color mapping to the min / max values of the specified complex

component in the given complex amplitude.

Note: This item is not always available.

Start [End] Value User defined min / max values of the field quantity to import/export can be

entered manually here.

Color buttons and color

bar

Start and end color of the palette can be modified by the Windows Color Pick

Dialog. The start and end colors correspond to the Start Value and End Value

of the field quantity.

Color from Wavelength If checked, the end color is determined from the wavelength in the same way

as for the Light View (Sec. 12.2.1). The whole color range is created as linear

brightness gradient from start color (black) to this end color.

Use Middle Color Enables use of an additional middle color. A middle color allows a three color

gradient between the Start Value and the End Value.

5.12 Control for Defining Used Orders

The table in this control (↪→Fig. 24) has two columns for 1D-periodic gratings (Direction andOrder Number) and

three columns for 2D-periodic gratings (Direction, Order Number X, and Order Number Y).

In theDirection column you can choose T (+/+) / T (-/-) for a transmission order andR (+/-) /R (-/+) for a reflection

order. The expression in brackets indicates the sign of the z-component of the k-vector of the incident and the

outgoing light (see also Sec. 43.9). Transmission orders have a blue background and reflection orders a red

one.

In the order number column(s) you can enter the desired order number. In the Function tab of the Functional

Grating (↪→Sec. 59.1) there is an additional Efficiency column.

Figure 24. Control for defining the used orders of a 2D-periodic grating.

Below the table there are buttons to configure the table.
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ITEM DESCRIPTION

Add Order /

Tools > Add Order

Adds a new row to the end of the table. The initial direction and order number

is taken from the currently selected row. For 1D-periodic gratings this order

number is then incremented by one to allow you to easily add a sequence of

consecutive orders.

Tools > Add Order Range Opens a dialog where you can enter a Minimum Order and a Maximum Or-

der and whether you Define Order Range for Reflection or for transmission.

For 2D-periodic gratings you can define a minimum / maximum for x- and y-

direction separately. When you close the dialog with OK, all orders within the

defined range (inclusive) are added to the end of the table; existing orders

are overwritten.

Remove Order /

Tools > Remove Current

Order

Removes the currently selected order. This can also be done with the Del
key.

Tools > Remove All Re-

flection / TransmissionOr-

ders

Removes all reflection / transmission orders currently present in the table.

Tools > Reset Resets the table so that it only shows the zeroth transmitting order.

Tools > Sort Sorts the table firstly so that transmission orders appear above of the reflec-

tion orders and then by order number(s). Sorting is also done when the dialog

containing this control is closed and re-opened.

Tools > Synchronize Effi-

ciencies

O E .

Allows you to set one Efficiency for all reflection or transmission orders (de-

pending on whether you Synchronize Orders for Reflection).

5.13 Control for Programmable and Databased Input

This control can be used to define either a list of value pairs (x; y) or a function f (x, y). If you select Pro-

grammable Input you have the following controls to program a snippet:

ITEM DESCRIPTION

Definition This group box allows you to program the actual snippet. Edit opens the

Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

The Databased Input for value pairs offers a simple table for entering a preconfigured number of value pairs.

Furthermore it has the following settings.
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ITEM DESCRIPTION

Set > Load Loads a data array from a .da file. The data array must contain only one

real-valued two-dimensional subset.

Set > Import Imports a data array from a bitmap or text file by means of the import wizard

described in Sec. 121.2. The imported data array must contain only one real-

valued two-dimensional subset.

Set > Select from Docu-

ments

Allows you to select an already open data array, which must contain only one

real-valued two-dimensional subset.

Show Shows the current data in a separate data array view (↪→Sec. 13.5).

Preview Table A preview table showing the current data.

5.14 Preview for Surface Media Sequences

Figure 25. Cross section of two lens pairs with the default color table “White and Mint”. Air is marked light green. Glasses

are marked by different shades of dark green. The third surface is currently selected and thus marked red.

Both the edit dialogs for a Lens System component (↪→Sec. 57.1) and for optical stacks (↪→Sec. 39) comprise

a preview of their respective sequence of surfaces and media. This preview either shows the x-z-plane for y =

0 or the y-z-plane for x = 0 in free aspect ratio. Fig. 25 shows a sample preview.

For surfaces the height profile in this plane is shown and for media the real refractive indices in this plane are

visualized by different colors depending on the used color table. Surfaces are marked with Color 2 of the color

table, the currently selected surface is marked with its Highlighting Color and a bit more thick. ↪→Sec. 11.2.4.2

Absorbing regions of a surface (↪→Sec. 35.1.1.1) and the media before and after them are not shown.

Via the context menu of the preview you can open an dialog (↪→Fig. 26) for defining both the shown plane and

the coloring.

Figure 26. The edit dialog to set up the view settings.
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ITEM DESCRIPTION

Show z-x-Plane /

Show z-y-Plane

This option allows you to choose whether you want to see a z-x-intersection

(Show z-x-plane) or a z-y-intersection (Show z-y-Plane).

This option is disabled for 1D-periodic stacks.

Color Table The color table used for the preview. You can select any color table from the

Customized Color Tables Menu (↪→Sec. 11.2.4.1).

Draw Media If you uncheck this option no media are drawn at all, but only the height pro-

files of the surfaces.

Preview Wavelength The wavelength used for the calculation of the refractive indices. If this dialog

is shown from within a grating component (↪→Sec. 64), the default preview

wavelength is the preview wavelength set directly in the grating component.

Minimum Shown Refrac-

tive Index

Defines the minimum refractive index. Refractive indices less or equal this

value use the start color of the color table.

Maximum Shown Refrac-

tive Index

Defines the maximum refractive index. Refractive indices greater or equal

this value use the end color of the color table.

5.15 3D View

The 3D view shows a geometry as seen with a virtual camera. The geometry can be any sequence of surfaces,

thus a single surface (↪→Sec. 35), a Real Component (↪→Part IX), an Optical Stack (↪→Sec. 39) or a complete

Optical Setup (↪→Sec. 43) where light sources, ideal components and detectors are indicated by a single plane

surface. For each surface the size, the height profile and the Surface Layout (↪→Sec. 40) are shown, but no

coatings or materials.

This technology is also the foundation for the 3D Ray Distribution View (↪→Sec. 17.1).

The 3D view window (↪→Fig. 27) can usually be displayed by a button.

Figure 27. 3D view of a surface with tool bar (top middle), view cube (top right), Global Coordinate System (bottom left),

simple scale (bottom right) and z-extension information (bottom).

The position and orientation of the virtual camera that captures the 3D scene can be controlled via mouse,
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keyboard, and touchscreen. By default the orientation of the virtual camera is as shown in Fig. 27. In the upper

part of the view there is a Tool Bar with 6 buttons which define the mouse mode, i. e. how the view behaves if

you left click into the view and move the mouse while keeping the left mouse button pressed.

ITEM DESCRIPTION

Magnifying Glass Always shows a magnifying glass zooming into the area around the current

mouse position. In this mode, a mouse click has no effect.

Zoom Window This button allows you to define a ZoomWindow. If you release the left mouse

button it is zoomed into this region.

Zoom As long as you keep the left mouse button pressed, moving the mouse up

zooms into the view and moving the mouse down zooms out.

Pan Allows you to move the shown object within the view.

Rotate Allows you to rotate the shown object.

Zoom Fit If this button is clicked, the object is zoomed and moved so that it is shown

completely and as large as possible. Afterwards no mouse mode is selected.

There is a View Cube in the upper left corner. If you click on a face, edge, or corner of this cube, the corre-

sponding orientation is used. Clicking on the “ring” and keeping the left mouse button pressed allows you to

rotate around the z-axis by moving the mouse.

In the lower left corner of the window there is a 3D icon that permanently shows the current axis directions of

the Global Coordinate System of the geometry.

For a single surface, information about the z-extension of the surface is shown on the bottom of this control.

ITEM DESCRIPTION

Left mouse button Behavior defined by the buttons described above.

Ctrl +Left mouse button Pan.

Shift +Left mouse but-

ton

Zoom in/out.

Mouse wheel Coarse zooming in/out.

Ctrl + + Zoom in.

Ctrl + - Zoom out.

→ , ↑ , ← , ↓ Rotate right, up, left and down by 2.5° each.

Ctrl + F Zoom scene to fit perfectly in the 3D view.

By right-clicking into the view a context menu with the following entries will open.
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ITEM DESCRIPTION

Select Elements to Show O O S

Opens a dialog where you can select which Optical Setup Elements shall be

shown. ↪→Sec. 5.15.1

View Settings Opens a dialog where you can adjust the view to your liking. You can preset

these settings for all future views in the Global Options dialog (↪→Sec. 6.3).

Show as Separate Doc-

ument

Shows the current geometry in a separate document window for comparing

or storing 3D views. The resulting document behaves nearly identically like a

“normal” 3D view, only that there instead of the menu item Show as Separate

Document, there is the ribbon item Windows > Duplicate Window.

Export to IGES Exports the 3D scene to a IGES file after you have specified a path and name

for it. Note that the scene is exported “as is”, for example the outer planes

are included in the file if they are visible within the scene. Furthermore, the

Accuracy Factor of the view settings (↪→Sec. 5.15.2.2) also influences the

data in the resulting file.

Export to STL Exports the 3D scene to a STL file after you have specified a path and name

for it. Note that the scene is exported “as is”, for example the outer planes

are included in the file if they are visible within the scene. Furthermore, the

Accuracy Factor of the view settings (↪→Sec. 5.15.2.2) also influences the

data in the resulting file.

5.15.1 Select Elements to Show

For the 3D visualization of systems VirtualLab Fusion enables the user to select the Optical Setup Elements

which shall be shown. Fig. 28 shows the edit dialog of the corresponding configuration tool.

Figure 28. The dialog to select the elements which shall be shown.

The upper part of the edit dialog (↪→Fig. 28) shows all elements which are available. The user can select

individually which component shall be shown or not.

The Selection Tools button offers the following four selection tools.

ITEM DESCRIPTION

Select All Selects all elements.

Unselect All Unselects all elements.

Unselect Detectors and Source Only Real and Ideal Components are selected.

Unselect Identity Operators and

Coordinate Breaks

Elements are unselected which have no optical functionality but only

aid in correctly setting up the Optical Setup.
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5.15.2 View Settings

Figure 29. The dialog to edit the view settings of the 3D view.

This dialog (↪→Fig. 29) offer various options to adjust the 3D view. In the lower left corner there are the following

controls.

ITEM DESCRIPTION

Reset All Resets all options to the values defined in the Global Options dialog

(↪→Sec. 6.3). In the Global Options dialog itself, you then can reset to the

initial defaults.

With this button you can load view settings saved with the button.

With this button you can save the current view settings. In this way you can

e. g. use different view settings for different application scenarios.

Validity A validity indicator (↪→Sec. 5.10) shows warnings if one feature disables an-

other feature. For example, rulers will not be shown if perspective distortion

is present because then the size of a surface changes with its distance from

the virtual camera.

The actual view settings are grouped on the several pages which are described in the following subsections.

(The page Rays is only used for the Ray Distribution View (↪→Sec. 17) and thus explained in Sec. 17.1.3.)

5.15.2.1 Color Scheme

Various options to adjust the color of the background and of the surfaces.
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ITEM DESCRIPTION

Color Scheme Primarily, this setting defines the brightness of the view background. But it

also influences the color of the view tools (↪→Sec. 5.15.2.5) and of the surfaces

when they are Uncolored.

You can select from Bright, Medium and Dark.

Background Color Gradi-

ent

If you select this option, the background is not shown with a solid color, but

has a gradient to a slightly more dark color.

Surface Colors There are two color schemes for the surfaces.

• Colored: The surfaces of a real component are all drawn with the same

color which alternates between yellow and orange between subsequent

components. Light sources are always drawn in green, ideal compo-

nents in light blue, and detectors in red, respectively. Consequently,

single surfaces or components are always drawn yellow.

• Uncolored: All surfaces are either drawn in dark gray (if Color Scheme

is either Bright or Medium) or in light gray (for the Dark Color Scheme).

Absorbing areas between the inner definition areas1 of periodic surfaces are

always drawn in dark gray.

Transparent Surfaces If checked, the surfaces are shown semi-transparent.

5.15.2.2 Geometry

Options to define which and how triangle meshes are generated for the display of the geometry.

ITEM DESCRIPTION

Show Envelopes Toggles the visibility of the envelopes, meshes linking the borders of two con-

secutive surfaces within a component. There are no envelopes if the medium

between the two surfaces is not solid. This feature has no effect for single

surfaces or components consisting only of a single surface.

If this option is checked, Color and Transparency of the envelopes can be set.

Show Surrounding Planes All surfaces shown in the 3D scene will be displayed with their defined (outer)

definition areas1 (drawn in black if they are absorbing – otherwise the same

colors as for surfaces are used). You can think of the apertures as infinitely

expanded in x- and y-direction, however, they are cut to a proper size in this

view.

Accuracy The accuracy factor for the sampling of the optical surface(s). The maximum

accuracy factor is 15.

Wireframe Mode By default filled triangles are shown. If you check this option, the borders of

the triangles are shown instead. In this way you can directly see the triangles

making up the displayed geometry.

z-Scaling O

The heights of the shown surface(s) are scaled by this factor, but for a single

surface the displayed z-Extension remains unchanged. If the z-Scaling is

not equal to 1, envelopes, coordinate systems, and labels will not be shown.

Then the Global Coordinate System shows the scaling factor.

1 See Sec. 35.1.1 for details on definition areas.
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5.15.2.3 Geometry Markers

Options to add additional markers to the shown geometry, i. e. they are moved and scaled together with the

geometry.

ITEM DESCRIPTION

Coordinate Systems If checked, a coordinate system will indicate the position and orientation of

each surface. You can scale them by the given factor.

Labels If checked, for surfaces the name of the surface is shown. Else the names

of the component(s) are shown next to their respective first surface. The font

colors resemble the color with which the corresponding component is shown.

Origin If checked, a ball symbol is drawn at the origin of the Internal Coordinate

System (↪→Sec. 43.8.1) of the displayed component or at the origin of the

Global Coordinate System of the displayed geometry.

Semi-transparent Back-

ground

O

If checked, the labels are placed in a semi-transparent box to distinguish them

more easily from the background.

Vary x-y-Position of La-

bels

O

By default, all labels are shown on top of the corresponding surface. So they

might overlap when you look along the z-axis and the surfaces are all similar in

size and orientation. So you can check this option to show them at different

lateral angles (in the coordinate system of the corresponding boundary). 4

labels for example will then be shown on the right, top, left, and, bottom,

respectively.

Font Size O

The font size used for the labels.

5.15.2.4 Perspective

Directly in the 3D view you can change the orientation of the virtual camera in an arbitrary way (↪→Sec. 5.15).

This page shows the quaternion describing this orientation. However, sometimes you want to have a well-

defined orientation, e. g. for screenshots. Then you can check Pre-Defined Camera Orientation and define the

direction of the z-axis and x-axis of the shown geometry relatively to your screen. Note that when you change

the direction of the z-axis, the available directions for the x-axis change, as z- and x-axis are perpendicular.

By default, the camera generates an orthographic projection. This means that two surfaces of the same physical

size are always shown with the same size on the screen, even if one is one centimeter away from the camera

and the other one meter. If you Use Perspective Distortion, surfaces farther away are shown smaller, as in

reality. But then rulers will not be shown.

5.15.2.5 View Tools

On this page you can change the visibility of Global Coordinate System, Tool Bar, and View Cube (↪→Fig. 27).

Furthermore you can show Rulers, either a Simple Scale in the lower right corner, or Full-Size rulers along the

left and bottom border. In the latter case a measurement tool becomes available in the toolbar of the 3D view:

. If this tool is active, first click anywhere in the 3D view starts drawing an arrow whose length is then shown.

Second click fixes the end point of the arrow, third click starts a new measurement and so on.
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5.16 Defining an ABCD Matrix

Simple optical elements can be described by so-called ABCD matrices e. g.
( 1

0
d
1
)
describes a free space

propagation of distance d, or
( 1
−1/ f

0
1
)
describes an infinitely extended thin lens with focal length f . A sys-

tem consisting of several optical elements is described by the product of their matrices (where the order of

multiplication depends on the order in which the elements are passed by the light):

Msystem = Mn−1 ×Mn−2 × · · · ×M0. (5.1)

In this equation M0 is the first of n elements passed through, Mn−1 is the last.

In VirtualLab Fusion ABCD matrices can be used via the Ideal Component “ABCD Matrix Setup” (↪→Sec. 73.1)

and in the ABCD Law Calculator (↪→Sec. 104).

In every case of application first the systems ABCD matrix has to be specified. This is done by the control

shown in Fig. 30.

Figure 30. Control for defining an ABCD matrix.

In this control several optical elements can be defined by ABCD matrices to describe an optical system. These

elements will be arranged in a list where the order corresponds to the order in which the light passes through

the elements. The properties of these elements (e. g. the focal length of a lens) have to be entered and then the

ABCD matrix of the element combination (this is Msystem in Eq. (5.1)) is calculated automatically. The upper

part of the control shows the list, where the top entry represents the first element which is entered by the light,

the bottom entry is the one where the light leaves the system. The buttons at the bottom of the control are used

to edit that list.

The meaning and the functions of the control’s buttons are the following:

ITEM DESCRIPTION

Insert Inserts a new element before the marked entry (↪→Sec. 5.16.1).

Append Appends a new element at the end of the table (↪→Sec. 5.16.1).

Edit Allows you to edit the marked element by opening the corresponding edit

dialog.

Delete Deletes the marked elements. The marking of more than one entry is possi-

ble.

You can reorder the elements by clicking on the Index cell of a certain row and dragging it to a new position.

Double clicking on a certain row opens the corresponding edit dialog. You can mark multiple consecutive rows

and delete them using the Del -key.

5.16.1 Inserting and Appending of Optical Elements

The element to be inserted or appended will be chosen by the dialog shown in Fig. 31, which will appear if the

corresponding button (↪→Fig. 30) is clicked.
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Figure 31. Dialog for selecting an optical element to be included in the ABCD matrix.

After selecting the desired element entry, followed by clicking Ok or, alternatively, just double clicking on the

elements name, another modal dialog will appear, where the parameters of that element have to be entered.

5.16.2 Editing the Parameters of the Optical Elements

The parameters of the elements will be entered after choosing one in the dialog shown in Fig. 31 or can be

changed if the button Edit in the control for creating an ABCD matrix system (Fig. 30) is pressed. Then a dialog

will appear, where the needed parameters have to be entered and the corresponding ABCD matrix for that

element (Mi, i = 0 . . . (n− 1), in Eq. (5.1)) will be calculated.

5.16.2.1 Editing a Free Space Propagation Element

Here the geometrical distance has to be entered. The dialog (see Fig. 32) shows the automatically calculated

ABCD matrix in its lower part.

Figure 32. Dialog for editing a free space element for ABCD matrix propagation simulation.

5.16.2.2 Editing a Plane Interface Element

Here the real parts of the refractive indices of the preceding and the subsequent medium have to be entered.

The dialog (↪→Fig. 33) shows the automatically calculated ABCD matrix in its lower part.
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Figure 33. Dialog for editing a plane interface element for ABCD matrix propagation simulation.

5.16.2.3 Editing a Spherical Interface Element

Here the radius of the curved surface as well as the real parts of the refractive indices of the preceding and the

subsequent medium have to be entered. A positive sign for the radius means that the center of curvature is on

the side of the subsequent medium. The dialog (↪→Fig. 34) shows the automatically calculated ABCD matrix in

its lower part.

Figure 34. Dialog for editing a spherical interface element for ABCD matrix propagation simulation.

5.16.2.4 Editing a Spherical Mirror

Here the Radius of Curvature of a spherical mirror has to be entered. A negative radius of curvature defines a

concave mirror and a positive radius defines a convex one.

The dialog (↪→Fig. 35) shows the automatically calculated ABCD matrix in its lower part.
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Figure 35. Dialog for editing a spherical mirror for ABCD matrix propagation simulation.

5.16.2.5 Editing a Thin Lens Element

Here the Focal Length of an infinitely extended thin lens has to be entered. A negative focal length defines a

concave lens and a positive focal length defines a convex one.

The dialog (↪→Fig. 36) shows the automatically calculated ABCD matrix in its lower part.

Figure 36. Dialog for editing a thin lens element for ABCD matrix propagation simulation.

5.16.2.6 Editing the Matrix of an Arbitrary or Composite Element

Here you can define an arbitrary matrix or an already known matrix of a more complex system, by entering the

elements A, B, C and D directly. This is done by the dialog shown in Fig. 37.

Figure 37. Dialog for editing an arbitrary matrix for ABCD matrix propagation simulation.
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6 Global Options Dialog

Figure 38. Global Options dialog.

Global program options can be edited by the dialog shown in Fig. 38.

The options are grouped in several categories and subcategories which are shown in the tree view at the left

of the dialog. The subcategories with their specific settings are explained in the following subsections. The

Default Settings usually can be altered in the corresponding specific edit dialogs and Property Browser tabs.

All settings but the file paths in the File Handling category can be reset, loaded, and saved with the following

controls:

ITEM DESCRIPTION

Reset All Resets all global program options to their initial values. Also the file path were

the Global Options are stores is reset.

Load Global Options With this button you can load another Global Options file saved with the

button. The 5 most recently used files are available in a shortlist.

Save Global Options With this button you can save a copy of the current Global Options to an-

other file path. In this way you can give your Global Options to colleagues or

LightTrans in case of support requests.

The currently used Global Options file is also given in the title of the dialog and in the lower left corner of the

main window.

Many of these Global Options influence the results of simulations, usually they represent a trade-off between

accuracy and computational effort. Thus, in extreme cases you may obtain completely wrong results or no

results at all because of too high computational effort. These settings are marked with S in the following sub-

sections. And if you changed such settings, a “Changed Simulation Results” is shown also in the lower left part

of the main window. Last but not least there you also see a short summary of the current multi-core settings

(↪→Sec. 6.15).
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6.1 Default Settings > Modeling Profile S

Figure 39. The dialog to configure the default profile settings.

In this category you can open a separate dialog (↪→Fig. 39) where you can edit some default settings for the

profile editor (↪→Sec. 43.4.1). This dialog has the following tabs.

6.1.1 Sources

Here you can set the default Wavelength which is used among others as default for the sources within an

Optical Setup, but also for the generators in the Sources and the Functions ribbon.

6.1.2 Components & Solvers

The settings on this tab page are explained in Sec. 43.4.2. They affect only real components (↪→Part IX).

6.1.3 Visualization & Detectors

The Evaluation & View sub-tab contains the following controls.

ITEM DESCRIPTION

Evaluated Field Compo-

nents

Here you can set which vectorial components of a field a detector evaluates

by default. You can choose between Ex, Ey, and / or Ez, whereas at least one

component must be selected.

This setting affects the Universal Detector (↪→Sec. 74.4), the Camera Detec-

tor (↪→Sec. 74.5.2), the PSF & MTF detector (↪→Sec. 74.5.3), and the Power

detector (↪→Sec. 74.6.4).

Color Table Here you can preset the Color Table used by the Universal Detector

(↪→Sec. 74.4), the Camera Detector (↪→Sec. 74.5.2), the PSF & MTF detector

(↪→Sec. 74.5.3), and the Raw Data Detector (↪→Sec. 74.5.5).

For more information about color tables please see Sec. 11.2.4.
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The controls on the Free Space Propagation sub-tab are explained in Sec. 43.4.2. They affect only detectors

(↪→Part XI).

6.1.4 Other Settings

ITEM DESCRIPTION

Default System Tempera-

ture

The temperature which is used as default for all Optical Setups. Furthermore,

it is used for all refractive index calculations which are independent of an

Optical Setup, e. g. in the Fresnel calculator.

Default Air Pressure The air pressure which is used as default for all Optical Setups. Furthermore,

it is used for all refractive index calculations which are independent of an

Optical Setup (e. g. in the Fresnel calculator) if air is involved as a surrounding

medium.

Changing Temperature

or Pressure Keeps the

Vacuum Wavelengths

Constant.

Changing the temperature of a medium will change its refractive index. A

changed pressure alters the refractive index of air too. A changed medium

wavelength will be the consequence. If this option is selected, the change of

all media wavelengths in the system’s light sources is accepted by the user.

Changing Temperature or

Pressure Keeps the Media

Wavelengths Constant.

Changing the temperature of a medium will change its refractive index. A

changed pressure alters the refractive index of air too. A changed medium

wavelength would be the consequence. If this option is selected on the other

hand, VirtualLab Fusion will keep the media wavelengths constant by adapt-

ing all vacuum wavelengths in all of the system’s light sources. Please note:

This option is mainly supposed to allow a result comparison to simulations in

ZemaxOpticStudio®.

Default Embedding Mate-

rial

Sets the material that is used as a default reference for relatively measured

real parts of the refractive indices (↪→Sec. 38.3). The individual controls are

explained in Sec. 34.3.

Process Logging Level The default logging level for optical simulations (↪→Sec. 43.2.4).

6.2 Default Settings > Coordinate Systems

This subcategory has the following settings:
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ITEM DESCRIPTION

Default Definition Type This option sets the default for defining an orientation for Optical Setup Ele-

ments as described in Sec. 43.8.2.3, Sec. 5.6 and Sec. 139.2.1.

Initial Axis Rotation A so called Sequence ofAxis Rotations (Sec. 139.2.4) provides no unambigu-

ous way for defining an orientation. Thus, even the orientation of a coordinate

system that is not rotated with respect to its reference coordinate system does

not have a unique representation as a sequence of axis rotations. That’s why

this global option allows to define the value of an axis rotation sequence rep-

resenting a non-rotation i.e. being in its initial state.

Use Component Coordi-

nate System for Stack Pre-

view

O G O S

(↪→S . 64)

If this option is not checked, the stack preview always shows the stack in its

own coordinate system. This means that the base block the stack is placed

on is always left. This can be confusing if you place a stack on the front side

of a component. So if you check this option, in this case the base block is

shown right and the coordinate system is adapted accordingly. ↪→Sec. 39.1.2

6.3 Default Settings > General View Settings

This subcategory has the following settings:

ITEM DESCRIPTION

Theme for Main Window With this option you can select a color scheme applied to the elements of

the main window (ribbon ↪→Sec. 4.2, docking tabs ↪→Sec. 4.3, and status bar

↪→Sec. 4.4).

Show Notify Icon and No-

tifications

You can set that the notifications and the notify icon (↪→Sec. 4.5) are shown

Always, If VirtualLab Inactive or Never. Inactive means that

• another application or Windows gets the focus by clicking into it with the

Mouse or e. g. via Alt + Tab .
• a dialog of VirtualLab Fusion gets opened or

• a docking tab of VirtualLab Fusion gets the focus if it is detached from

the main window.

Note that notifications can also by switched off via Windows. So check also

the Windows option if you cannot switch on the notifications with this option.

Display Duration of Tool

Tips

The display duration of most tool tips, especially the ones in the ribbon

(↪→Sec. 4.2). Several other tool tips with much text have their own longer

durations so that you can easily read them completely.

6.4 Default Settings > General View Settings > Font

You can set up the font which is used for all dialogs and document views except:

• Title bars

• The flowchart in the Optical Setup View (↪→Sec. 43.1).

• The source code editor (↪→Sec. 7.3.1) and the module view (↪→Sec. 7.2) which use a monospaced font.
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ITEM DESCRIPTION

Use Recommended Font If you click this option, the Global Font is set to “Segoe UI” and a font size

suitable for the DPI scaling set up in the Windows system configuration.

Configure Font Individu-

ally

If you click Change … you can choose any suitable font installed on your

system. You can also Adjust Font Sizemore precisely with the corresponding

text box. Note that with these settings dialogs and views in VirtualLab Fusion

may look ugly or even become unusable.

Font Size of Axis Labels The default font size for the axis labels in 1D and 2D diagrams.

Font Size of Diagram Ti-

tles

The default font size for the subset titles in 2D diagrams.
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6.5 Default Settings > General View Settings > Display of Numbers

This subcategory has the following settings:

ITEM DESCRIPTION

Number of Significant Dig-

its

Default number of significant digits for displaying floating point numbers. (Do

not confuse significant with total digits: 847.34 µm formatted using two sig-

nificant digits results in 850 µm.)

Use Special Number of

Digits for Color Legends

If checked, a special number of digits can be set which will be used for the

labels of color legends only. The expected precision of the color legend may

be less than that of all other numerical strings, so a smaller number of digits

may be defined here.

Use Indicator for Hidden

Digits in Text Boxes

If checked, a small indicator shows if a physical value box (↪→Sec. 5.1) or

a positioning control (↪→Sec. 43.8.2.4) doesn’t display all available digits. If

the mouse is moved over the indicator, a tooltip shows the number in full

precision.

Default Length Unit You can define a default length unit which is used in the following cases:

• Interpret length values which were entered by the user without a unit.

• Formatting of diagram axes. If they use the Engineering format, also

units may be used which differ by a factor of 1000n from the default

unit.

• Formatting of very large or very small values (including zero) for which

no other length unit can be used in a meaningful way.

• Export into text files. Usually just the plain number (in multiples of the

default unit) is exported and the used unit is noted separately. This

eases using the data in other programs which cannot handle measured

quantities.

Format of Complex Num-

bers

Complex numbers can be formatted in different ways:

• Real Part / Imaginary Part: {real part} + i{imaginary part}

• Amplitude / Phase: {amplitude} · exp({phase} · i)
• MATLAB, a more compact variant of the Real Part / Imaginary Part for-

mat: {real part}+{imaginary part}i

• PTF, a format used for the PTF export (↪→Sec. 120.2.4):

({real part}, {imaginary part})

This setting influences for example the appearance of Rayleigh coefficients

output by the Grating Order Analyzer (↪→Sec. 84) into the Detector Results

tab (↪→Sec. 4.3).

Format of Physical Values In principal, large or small physical values on axes can be displayed in three

different ways (↪→Fig. 40):

• Engineering: SI prefixes are used to make the actual numbers smaller.

• Scientific: Powers of ten are used to make the actual numbers smaller.

• Standard: The numbers are kept as they are.

For a specific document window you can always change this via its Property

Browser. However, you can set the default value here. In Automaticmode the

suitable default mode is determined automatically, depending among others

on the used unit (there are no k° [kilodegrees]).
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Figure 40. Example of the different formats of physical values. From left to right: Engineering, Scientific, Standard.

6.6 Default Settings > General View Settings > Source Code Editor

The settings in this sub-category apply to the source code editor (↪→Sec. 7.1).

ITEM DESCRIPTION

Theme for Source Code

Editor

With this option you can select the color scheme of the source code editor.

Autocomplete Braces and

Quotation Marks

When you enter an opening brace ( { [ or quotation mark " ', the source code

by default automatically inserts the corresponding closing character ' " ] } ). In

case you are used to adding the closing character manually, you can switch

off this behavior here. Note that changing this setting only becomes effective

for new module views.
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6.7 Default Settings > Document Windows

This subcategory has the following settings:

ITEM DESCRIPTION

Initial Window Size Allows you to define the initial window size in pixels for all newly created

Result Windows. (↪→Sec. 4.1.1)

Use Transparent Back-

ground for Copy to

Clipboard

If checked the gray background of the view is replaced by a transparent color

when Copy View to Clipboard operation (↪→Sec. 11.6) is executed. This set-

ting doesn’t affect Harmonic Fields and Harmonic Fields Set as these docu-

ments allow you to configure in detail what is how copied to the clipboard.

Show Legend Sets whether or not a color legend is visible per default.

Color System The color system (↪→Sec. 6.7.1) used for real color views of Chromatic Fields

Sets (↪→Sec. 14.2) and the Light View of harmonic fields (sets) (↪→Sec. 12.2.1).

Maximum Number of Ta-

ble Cells

Maximum number of table cells that are displayed in the Table panel of a Data

Array’s view. If this value would be exceeded, no table is shown unless the

user explicitly states to do so.

This setting also influences the automatic resizing of table cells in certain

tables: Only this number of cells is resized to the actual content, all other

cells use a good estimate. This can increase performance significantly.

MaximumNumber of Rays

that Allow Marker Snap-

ping

If the number of rays in a shown ray distribution exceeds this limit, no marker

snapping (↪→Sec. 11.3.2) will be available. The limit may be set to very high

values but then one possibly has to wait for a long time until snapping is

available.

Open Non-Numerical Data

Arrays in Expert Mode

If checked, any non-numerical data array (↪→Sec. 13.1) is opened with acti-

vated Expert Mode (↪→Sec. 24.1.4) by default. However, this is just an ini-

tialization setting. If the expert mode is disabled for a view before saving the

object to disk, it will be re-opened with disabled expert mode too.

Hide Phase Artifacts If checked, phase artifacts below the Initial Threshold are hidden by default.

↪→Sec. 11.8.

Initial Threshold This is the default artifacts threshold. For a single document it can be changed

in the view panel of the property browser. ↪→Sec. 11.8.

6.7.1 Color System

In order to display the color of mono- or polychromatic light approximately natural, the wavelength or the spec-

trum of a field has to be converted to RGB values in a defined way. This algorithm uses a color space (RGB

working space) which can be chosen in the Global Options dialog. The choice is valid for all real color views

created afterwards.
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Figure 41. Example for different color systems: Reflex at gold surface. Left: displayed with sRGB, right: LightTrans Color

System.

Real color views that already existed before will keep the color system of its creation point in time. If you want

to update an existing view with a new color system, you have to duplicate it via Windows > Duplicate Document

after changing this option.

The available non-common color system options are:

ITEM DESCRIPTION

Wide Gamut (Illuminant C) Common Wide Gamut system, but with Illuminant C as white point instead of

D50.

Kodak Pro Photo (Illumi-

nant C)

Common Pro Photo system, but with Illuminant C instead of D50.

From Monitor Uses the ColorProfile.FromScreen() method by Aurigma GraphicsMill to get

the color profile currently associated with the monitor.

XYZ Color system that identifies R, G, and B with the normalized chromaticities X,

Y, and Z respectively.

LightTrans Color System Color system that was developed by LightTrans in order to fulfill the special

needs of displaying light on a computer monitor as naturally as possible.

The specifications (chromaticities of R, G, B, and the white point) of all systems available in VirtualLab Fusion:

https://www.aurigma.com/
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COLOR SYSTEM RED GREEN BLUE WHITE

NTSC (0.66887, 0.33092)1 (0.210,0.710) (0.14,0.08) (0.31006,0.31616)

sRGB (0.640, 0.330) (0.300, 0.600) (0.150, 0.060) (0.3127, 0.3291)

CIE (0.7355, 0.2645) (0.2658, 0.7243) (0.1669, 0.0085) (0.3333, 0.3333)

SMPTE (0.630, 0.340) (0.310, 0.595) (0.155, 0.070) (0.3127, 0.3291)

P22 in KDS VS19 (0.625, 0.340) (0.285, 0.605) (0.150, 0.065) (0.281, 0.311)

Adobe RGB (0.640, 0.330) (0.210, 0.710) (0.15, 0.06) (0.3127, 0.3290)

Wide Gamut

(Illuminant C)

(0.73469, 0.26531)2 (0.11416, 0.82621)3 (0.15664, 0.01770)4 (0.31006, 0.31616)

Kodak Pro Photo

(Illuminant C)

(0.7347, 0.2653) (0.1596, 0.8404) (0.0366, 0.0001) (0.31006, 0.31616)

From Monitor5 (N/A) (N/A) (N/A) (N/A)

XYZ (1,0) (0,1) (0,0) (0.33333, 0.33333)

LightTrans Color

System

(0.73469, 0.26531)6 (0.15472,0.80586)7 (0.12412, 0.05780)8 (0.3127, 0.3291)9

6.8 Default Settings > Document Windows > 1D Views

This subcategory allows you to set the following parameters for diagram curves:

ITEM DESCRIPTION

Line Thickness The default line thickness for curves in x-y-diagrams.

Symbol Scaling Factor The default scaling factor for symbols of data points in x-y-diagrams.

Use Smoothed Graphics If checked, curves in x-y-diagrams will be smoothed per default. Usually,

this may improve the diagram. But if a stepped line is shown, deactivating

this property may yield a better result. Important: This smoothing is done on

pixel level. This pixel smoothing is not to be confused with the smoothing

interpolation methods described in Sec. 11.2.2!

Initial Color for Undefined

Values in 1D Views

The color to be used for visualizing undefined values in diagrams initially. It

can be changed for each individual view.

Opacity Opacity of the color to be used for visualizing undefined values in diagrams.

Marker Line Thickness The line thickness (in pixels) to be used for markers (↪→Sec. 11.3) in 1D dia-

grams.

1 Adapted to fit to 611 nm
2 Adapted to fit to 700 nm
3 Adapted to fit to 525 nm
4 Adapted to fit to 450 nm
5 The data of the currently used color profile are determined during runtime.
6 Corresponds to 700 nm
7 Corresponds to 530 nm
8 Corresponds to 470 nm
9 Corresponds to illuminant D65
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6.8.1 Default Settings > Document Windows > 1D Views > 1D Cartesian Diagram

ITEM DESCRIPTION

Line Color (Singlegraph

Mode)

The default color for curves in x-y-diagrams if not in Multigraph Mode.

Symbol Shape (Single-

graph Mode)

The default symbol shape for data points in x-y-diagrams if not in Multigraph

Mode.

Symbol Color (Single-

graph Mode)

The default symbol color for data points in x-y-diagrams if not in Multigraph

Mode.

Color of Left-Hand y-Axis

(Multigraph Mode)

The default axis color for the left-hand y-axis of 1D Data Arrays in Multigraph

Mode.

Color of Right-Hand y-

Axis (Multigraph Mode)

The default axis color for the right-hand y-axis of 1D DataArrays in Multigraph

Mode.

Symbol Shape (Multi-

graph Mode)

The default symbol shape for data points in x-y-diagrams. This default will be

used in Multigraph Mode as long as the different subsets can be distinguished

by different colors. If all colors have been used, the symbol will be changed

for the additional subset curves.

6.8.2 Default Settings > Document Windows > 1D Views > 1D Polar Diagram

ITEM DESCRIPTION

Line Color (Singlegraph

Mode)

The default color for curves in polar diagrams if not in Multigraph Mode.

Symbol Shape (Single-

graph Mode)

The default symbol shape for data points in polar diagrams if not in Multigraph

Mode.

Symbol Color (Single-

graph Mode)

The default symbol color for data points in polar diagrams if not in Multigraph

Mode.

Color of Primary Polar

Axis (Multigraph Mode)

The default axis color for the primary polar axis of 1D Data Arrays in Multi-

graph Mode.

Color of Secondary Polar

Axis (Multigraph Mode)

The default axis color for the secondary polar axis of 1D Data Arrays in Multi-

graph Mode.

Color of Tertiary Polar

Axis (Multigraph Mode)

The default axis color for the tertiary polar axis of 1D DataArrays in Multigraph

Mode.

Symbol Shape (Multi-

graph Mode)

The default symbol shape for data points in polar diagrams. This default will

be used in Multigraph Mode as long as the different subsets can be distin-

guished by different colors. If all colors have been used, the symbol will be

changed for the additional subset curves.

Initial View of Angular De-

pendency >Always Carte-

sian

If checked, diagrams with angular dependency will never be initialized as po-

lar.

Initial View of Angular De-

pendency > Always Polar

If checked, diagrams with angular dependency will always be initialized as

polar.
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Initial View of Angular De-

pendency > Polar for Spe-

cific Kinds of Data

If checked, diagrams with angular dependency will be initialized as polar if at

least one of the contained subsets is of one of the checked physical properties

in the list.

6.9 Default Settings > Document Windows > 2D Views

The button Manage Color Tables opens a dialog where you can choose which color tables are available and

create new ones (↪→Sec. 11.2.4.1).

Furthermore you can set the Default Color Tables with which the most false color views are initialized. That are

e. g. the data array view (↪→Sec. 13.5) and the medium preview (↪→Sec. 37.2).

For complex data, each field quantity (↪→Sec. 11.1) can be initialized with an individual color table.

Furthermore there are the following view options:

ITEM DESCRIPTION

Initial Color for Undefined

Values in 2D Views

The color to be used for visualizing undefined values in diagrams initially. It

can be changed for each individual view.

Marker Line Thickness The line thickness (in pixels) to be used for markers (↪→Sec. 11.3) in 2D dia-

grams.

For more information, especially about editing color tables, please see Sec. 11.2.4.

6.10 Default Settings > Document Windows > 3D Views

Allows you to preset the view settings of the 3D view (↪→Sec. 5.15). The sub-categories are the same as for

the actual view settings dialog and are thus described in Sec. 5.15.2.1 – Sec. 5.15.2.5.
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6.11 Default Settings > Document Windows > Legacy Documents

ITEM DESCRIPTION

Automatic Resampling in

Array - Array Operations

Determines whether fields are resampled automatically during addition, sub-

traction, multiplication, division, and convolution of fields. ↪→Sec. 22.1.1.

Use Embedding for Field

×Transmission Operators

This option determines whether or not to embed the result of a multiplication

of a field with a non-periodic transmission into a frame of zeros.

Disable Light View You can disable the automatic calculation of the light view. It is still possible

to start the calculation manually. ↪→Sec. 12.2.1

Use Embedding Frame for

Light View

With this option you can select whether or not fields shown in the Light View

(↪→Sec. 12.2.1) are embedded in a black frame.

Use Standard Scaling Ini-

tially

For performance reasons, the initial scaling mode (↪→Sec. 11.2.5) can be set

to standard scaling, i. e. for newly created fields no minimum and maximum

determination is done. It is still possible to switch to automatic scaling.

Show Polarization Sets whether or not polarization shall be visualized in the Data View per de-

fault.

Polarization Display Mode The display mode for polarization visualization, as described in Sec. 12.2.2.3.

Show Grid O P E .

Sets whether or not a grid shall be shown which visualizes the ellipse’s posi-

tions.

Show Arrows O P E .

Sets whether or not arrows shall indicate the direction of rotation for the el-

lipses.

Scaling O P E .

A scaling factor for the ellipses.

Polarization Plane What plane of polarization shall be visualized?
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6.12 Default Settings > Sampling Dialog S

This subcategory has the following settings:

ITEM DESCRIPTION

Sampling Points The number of sampling points in x- and y-direction, used if these values

cannot be determined automatically.

Sampling Distance Default sampling distance in x- and y-direction, used if these values cannot

be determined automatically.

Array Size Default array size in x- and y-direction for a newly created field, used if these

values cannot be determined automatically.

Oversampling Factor The default oversampling factor used for sources (↪→Part VIII), transmissions

(↪→Sec. 67) and propagation operators (↪→Part XIII). The suggested sampling

distance will be divided by this value.

Size of Embedding Frame

(Sampling Points)

A zeroized frame with the given width (in sampling points) is added to newly

generated light distributions, unless specified otherwise in the edit dialog of

the light source.

Field Size Factor The greater this factor the larger the generated field will be. A factor of 1

(default) means the field size VirtualLab Fusion uses normally as automatic

setting. Increasing this factor increases the field size. Vice versa, setting this

factor to values between 0 and 1 decreases field size.

Relative Edge Width Newly created harmonic fields or transmissions have a soft edge whose width

can be pre-defined by this value (relative to the smaller of the both values of

the aperture size).

If you have filled the text boxes for one direction, you can copy the values over to the other direction

by double clicking on the text boxes for the other direction. This behavior is also implemented in many

other dialogs.

Any two of the three parameter pairs labeled Sampling Points, Sampling Distance, and Array Size are editable

at the same time. Which parameters are editable can be chosen by the corresponding check boxes. The

unchecked third parameter pair is calculated as the array size is always equal to the product of the number of

sampling points and the sampling distance.

6.13 Performance

This subcategory has the following settings:

ITEM DESCRIPTION

FFT Algorithm Since VirtualLab Fusion 4.10 the Intel Math Kernel Library is included in

VirtualLab Fusion offering better performance for Fast Fourier Transform

(FFT) calculations. However, if you want to do your simulations with the pre-

viously used VirtualLab FFT library you can check this option.

Field Size Truncation Fac-

tor for Accelerated Sinc

Interpolation S

Determines the behavior of the Accelerated Sinc Interpolation operator,

which is also used for Automatic Resampling in Array - Array Operations.

↪→Sec. 13.2.2



CHAPTER 6. GLOBAL OPTIONS DIALOG 87

6.14 Performance > RAM Consumption

This subcategory has the following settings:

ITEM DESCRIPTION

Warn Before Exceeding

Specified Limits

VirtualLab Fusion allows to check certain performance constraints before a

data field is created. If such a constraint is violated it means that the resulting

data field might be too large for the computer’s RAM. In this case, the user is

asked to confirm that such a field should really be created because creating

too large fields can freeze your PC for quite a while.

With the Warn Before Exceeding Specified Limits check box, the user can

enable or disable this mechanism completely. The settings Maximum Num-

ber of Sampling Points per Field, Maximum Number of Field Set Members,

and Guaranteed Amount of Remaining Physical Memory allow to adjust the

performance constraints individually.

Maximum Number of

Modes

If this option is enabled and a field to be generated would have more than the

number of modes specified here, a warning is shown. In case a Harmonic

Fields Set is to be generated then you are asked whether this fields set shall

really be created.

Guaranteed Amount

of Remaining Physical

Memory

If this option is enabled, it is ensured that the specified amount of physical

memory is still free after the creation of a new field. If this would not be the

case, a warning dialog (↪→Fig. 42) is shown asking you to confirm that the

new field should really be created. In this dialog you can also disable further

Guaranteed Amount of Remaining Physical Memory warnings by checking

the Don’t warn again check box.

Note that this value is given in gibibytes.

Switch to less memory in-

tensive algorithms […] S

The Automatic Propagation Operator (↪→Sec. 93.2) can choose less memory

intensive (but also less accurate) propagation operators when the resulting

field would exceed a certain size. The Default Value for this field size is the

size of your physical memory minus 4 GiB reserved for the operating system

and VirtualLab Fusion. But you can also set aUser-Defined Value if you want.

But note that field sizes exceeding the physical memory can extremely slow

down your computer.

Additionally this parameter also influences the conversion from non-

equidistant field to equidistant field data, e. g. for detector outputs.

https://en.wikipedia.org/wiki/Binary_prefix
https://en.wikipedia.org/wiki/Binary_prefix
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Figure 42. The warning dialog shown if due to the creation of a new field the used physical memory would exceed the

warning level.

6.15 Performance > Multi-Core

This subcategory has the following settings:

ITEM DESCRIPTION

Use Multiple Cores You can enable multi-threading with this option. If enabled, parts of the

Fourier Modal Method used for grating simulation always use all cores that

are available on the system and cannot be controlled by the value of Number

of Cores To Use.

This setting also influences whether the math library used for the Fourier

Modal Method runs in a parallelized version or not. But for this setting to

take effect a restart is required.

Number of Cores To Use If you Use Multiple Cores, this number controls how many cores are used

for parallel processing for tasks (design, simulation, parameter run). But as

there can be parallelized tasks running within parallelized tasks or because of

tasks running in the background, VirtualLab Fusion can use more than the set

number of cores. You can increase this number if VirtualLab Fusion doesn’t

use all physical cores. You should decrease this number if VirtualLab Fusion

doesn’t respond anymore during calculations.

Number of Parallel Itera-

tions for Parameter Run

Loop

If you Use Multiple Cores, by default the Parameter Run (↪→Sec. 44) starts n
parallel simulations of the underlying Optical Setup (↪→Sec. 43) where n is the

Number of Cores To Use. Then however for example your RAM consumption

might get too high, so you can set a lower number instead. n = 1 means that
one simulation is done after each other, only the simulation of each Optical

Setup runs in parallel.

This option can be set globally here – or for each Parameter Run separately

via its Property Browser.

Optimize Performance for

Very Fast Iterations

There is a performance optimization for parallel execution of short lasting

iterations in VirtualLab Fusion. However, it turned out that this optimization

then slows down certain more long lasting simulations. Thus if you perform

e. g. a parallel Parameter Run with very many short simulations which are

unexpectedly slow, you can try to switch on this setting.
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6.16 Optional Dialogs

This subcategory has the following settings:

ITEM DESCRIPTION

Pop up Warning Mes-

sages

Warning messages are always printed in the Messages panel. If this option

is checked warning messages are additionally shown in a message box.

Pop up Error Messages Error messages are always printed in the Messages panel. If this option is

checked error messages are additionally shown in a message box.

Duplication State for Op-

erations on Data Arrays

These settings are used for manipulations of Numerical Data Arrays as de-

scribed in Sec. 24.3. If Operate on Calling Object is selected, the original

data will be manipulated. This will be not the case if Duplicate is chosen. Ask

Every Time means that a dialog will ask whether duplication is desired every

time a manipulation is called.

What to Do With the Data

in the Temporary Folder

After ZAR Unpacking

The unpacked contents of a Zemax ZAR archive will be deleted after clos-

ing VirtualLab Fusion. If Ask For Save is activated, the dialog described in

Sec. 124.4.5 will open every time a ZAR file has been imported, which allows

to save the unpacked archive contents before deleting. If Discard and Delete

on Program Closing is checked on the other hand, the temporary folder con-

taining the unpacked archive will be deleted without further notice.
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6.17 File Handling

ITEM DESCRIPTION

Full Import /

Simple and Limited Import

Normally import of ZemaxOpticStudio® Lens Files is done using the so-

called ZOS-API, i. e. direct access to an installed ZemaxOpticStudio®. If

ZemaxOpticStudio® is not installed or not licensed we fall back on a simple

and limited import instead, which directly reads the Lens Files. However, the

check whether ZemaxOpticStudio® is installed can take quite a while so you

can set to always use the simple and limited import without prior initialization

of the ZOS-API. Further details can be found in Sec. 124.4.

Path for ’ZemaxOpticStu-

dio®’ User Data

A path needed for import of ZemaxOpticStudio® lens files. The path can be

changed with the -button. If you want to access the path directly you can

click on the path label.

Path for User Settings Path where among others user-defined catalogs are saved. It can be changed

with the -button. If you want to access the path directly, e. g. for backup,

you can click on the path label.

Path for Temporary Files Path where temporary files are stored. The path can be changed with the

-button. If you want to access the path directly, e. g. for cleanup, you can

click on the path label.

Automatic Saving Whether certain documents will be saved automatically after the specified

time interval to avoid data loss. Only affects Optical Setups, Parameter Runs,

and Parametric Optimizations which have already been saved at least once.

This default can be overwritten via the Property Browser (↪→Sec. 4.3) of these

documents.

Use New File Format In one of the next versions, a new file format will replace the current one

(which is no longer supported by Microsoft). With checking this option you

can already test the new file format with your files. But keep in mind that this

feature still has β status and errors might occur.
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6.18 Classic Field Tracing

This subcategory has the following settings:

ITEM DESCRIPTION

Default Free Space Prop-

agation Method for Link-

ages

The entry Default Free Space Propagation Method for Linkages allows to

select a free space propagation method. The selected method is used as

default operator for any new linkage of an Optical Setup.

Enable Logging of Auto-

matic Propagation Opera-

tor in Message Window

If this option is checked, the logging of the Automatic Propagation Operator

to the Message Window is enabled during the processing of an Optical Setup

or a Parameter Run, otherwise this logging is suppressed.

Deviation Threshold S The default deviation threshold used for the Automatic Propagation operator

(↪→Sec. 93.2).

Power Portion for Field

Size Estimation

Some automation techniques estimate the field size (for example the Auto-

matic Propagation Operator described in Sec. 93.2). For these techniques,

the Power Portion for Field Size Estimation specifies how much of the energy

of the incoming field is present in the output field. This value must be below

100%. A higher value means both increased accuracy and computational

effort.

7 Programming

VirtualLab Fusion offers two ways of programming own functionality:

1. VirtualLab Fusion Modules provide an opportunity to automatize or provide arbitrary processes done

within VirtualLab Fusion, for example customized export routines. C# and Visual Basic syntax is sup-

ported. A module must contain a method “Run” in a class “VLModule” as this is the starting point for the

execution of a module. Newly generated modules contain such a method by default.

2. In Programmable Items you just return a value depending on certain input parameters. For example in

the Programmable Light Source (↪→Sec. 51.8) you define the complex field value in dependance on the

position (x; y). Other parameters like sampling and Jones vector are handled by VirtualLab Fusion and
thus there is no need to program it yourself. These so-called “snippets” are much simpler than VirtualLab

Fusion modules. Only C# syntax is supported for snippets.

For both modules and snippets, you can use all “public” functions and properties of the VirtualLabAPI.dll and

the VirtualLab.Programming.dll byWyrowski Photonics as well as of the .Net Framework of Microsoft Corp. The

VirtualLabAPI.dll contains the complete programming interface of VirtualLab Fusion which underlies continuous

changes. Modules and snippets using functionality from this DLL may require changes with a new version of

VirtualLab Fusion. In contrast, the VirtualLab.Programming.dll has been especially designed for the needs of

external users – all classes in this file are kept stable. Thus there is no need for code changes with a new

version of VirtualLab Fusion if you use only methods from this file.
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Keep in mind that in your code you must precede a class name with the “namespace” the class

is located in. This is needed to distinguish classes with the same name. For example VirtualLab-

API.Core.Numerics.MathFunctions.DivisionRemainder(a,b) calls the function DivisionRemainder in the

MathFunctions class located in the VirtualLabAPI.Core.Numerics namespace.

If you insert a line like using VirtualLabAPI.Core.Numerics; in the header of your module file, you can

use the class names of the specified namespace directly, e. g. MathFunctions.DivisionRemainder.

Some often required namespaces as for example System, System.Drawing, VirtualLabAPI.Core.Com-

mon, and VirtualLabAPI.Core.FieldRepresentations are always predefined.

The following documents and web sites give further information.

DOCUMENT DESCRIPTION

MSDN Library General introduction to C#

.Net Class Library Refer-

ence (MSDN)

All functions and properties of the .Net Framework 4.8 by Microsoft Corp. The

members of the often needed System.Math class can be found here.

Programming Reference

for VirtualLab Fusion

Description of public members of both the VirtualLab.Programming.dll and

the VirtualLabAPI.dll. The current version of the programming reference can

be accessed via > Programming Reference.

The Modules View is described in Sec. 7.2, the Source Code Editor for snippets is described in Sec. 7.3. Both

share the same control to enter the actual source code, ↪→Sec. 7.1

7.1 Source Code Editor Control

Figure 43. This screenshot shows some of the features of the control to enter source code. The numbers are explained

in the text.

The control itself (↪→Fig. 43) has the following features which support you in programming in a fast and conve-

nient way.

FEATURE DESCRIPTION

https://docs.microsoft.com/en-us/dotnet/csharp/tour-of-csharp/index
https://docs.microsoft.com/en-us/dotnet/api/?view=netframework-4.8
https://docs.microsoft.com/en-us/dotnet/api/?view=netframework-4.8
https://docs.microsoft.com/en-us/dotnet/api/system.math?view=netframework-4.8
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Line Numbers (1) This column shows the line numbers. Syntax errors are always given with the

line number where they occur. You can go to a specific line with the Go To

entry of the context menu. The line number column is also the place where

bookmarks (↪→Sec. 7.1.1) are shown. If you click on a line number the whole

line is selected.

Outlining (2) By clicking on any button in the outlining column, you can collapse the

corresponding code block (for example a complete method) to a small rect-

angle with a gray outline. If the cursor hovers above said rectangle, you see

a preview of the code block. You can expand a collapsed code block using

the button next to it.

Own code blocks can be defined by embracing them with #region <Name>
and #endregion. The context menu (and the ribbon of modules) offer func-
tionality to collapse / expand all code blocks.

Line Modificators (3) In this column, changed lines are marked yellow (green if they have been

saved).

Syntax Highlighting To maintain readability, strings, numbers, keywords, identifiers and so on all

have their own color. In theGlobal Options dialog (↪→Sec. 6.3) you can choose

among many predefined color themes. Obvious syntax errors are marked

with a red zigzag line (4).

XML Comments (5) Methods, class variables and so on should be commented with XML com-

ments. They are then shown in the Syntax Tooltips (8) if you use them some-

where else. If you enter /// directly above the variable or method, a XML

comment skeleton is generated automatically.

Code Completion If you start entering e. g. a variable name and then press Ctrl + Space , it
is completed automatically if the letters you have already entered identify the

wanted name uniquely. If this is not the case, a menu (6) opens where you

can select the desired name with the arrow keys or Page Up and Page Down
and use it with Enter . If you type further letters the selection is narrowed

down. In the bottom of that menu you can activate filters so that for example

only methods are shown.

Code Snippets (7) In the Code Completion menu (5) there are also some code snippets, marked

by .

Example: The for snippet is expanded to for (int i = 0; i < length;
i++) { }. After this snippet has been expanded, all occurrences of the vari-
able i are highlighted. If you now change that variable name, all three oc-

currences are changed at the same time. If you press Tab , you jump to the
variable length which you can also change. If you press Enter you leave

the snippet.

Syntax Tooltips (8) If you are entering the name of a method and then an open round bracket

(which means that you start entering the parameters of the method), a Syntax

Tooltip is shown. It shows the XML comment (5) of the method itself and of the

currently entered parameter. Syntax Tooltips are also shown if you navigate

in the Code Completion menu (6) or if you move the mouse over a variable

or method name.
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Horizontal Split If you click on the button marked with 9 in Fig. 43 and drag your mouse, you

can create and move a gray splitter bar separating two views of the source

code editor. In this way you can work on two parts of the source code at the

same time. If you want to remove the split view, simply drag the splitter bar

to very top of the editor.

Scrollbar Annotations (10) Different colors in the scrollbar mark for example saved changes (yellow

squares), unsaved changes (green squares), syntax errors (red squares),

bookmarks (black squares), occurrences of the current search string (orange

squares), and the current line (dark blue line).

Smart Indentation If you finish a code block (by entering a semicolon or a closing curly bracket

in C#), all lines in the block are aligned automatically so that child code blocks

are indented with respect to the parent code block. If you start a new line with

Enter , it is also indented automatically.

Brace Matching If you place the cursor directly behind a opening / closing bracket, the match-

ing closing / opening bracket is marked by a frame.

Autocomplete Braces and

Quotation Marks

When you enter an opening brace ( { [ or quotation mark " ', the corresponding

closing character ' " ] } ) is inserted automatically. You can switch off this

feature in the Global Options dialog (↪→Sec. 6.6).

Useful keyboard and mouse commands

• You can change the font size in this control via the mouse wheel while pressing the Ctrl key.

• When you press the Ctrl key and move the mouse over the name of a variable or method defined

in the current module, you can click it to jump to the position where this element was declared.

• The control supports selection of rectangular code blocks (= a certain column range in consecutive

lines). You create such a selection by navigating to the desired start point and then expand the

selection via Alt+Shift+←/→/↑/↓ or holding Alt while creating the selection with the mouse.

Such a block selection also allows you to write in consecutive lines at once.

7.1.1 Context Menu

The context menu of the Source Code Editor Control has the following entries.

ITEM DESCRIPTION

Undo Undoes the last edit(s). Shortcut Ctrl+Z .

Redo Redoes the last undone action(s). Shortcut Ctrl+Y .

Cut Copies the current selection to the Windows™ Clipboard and then deletes it.

Shortcut Ctrl+X .

Copy Copies the current selection to the Windows™ Clipboard. Shortcut Ctrl+C .

Paste Pastes the current (text) content of the Windows™ Clipboard to the cursor

position. Shortcut Ctrl+V .

Select All Selects the whole source code. Shortcut Ctrl+A
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Find All occurrences of the word the cursor is currently placed on are marked or-

ange. Furthermore, a resizable pop-up in the bottom right corner openswhere

you can change the search string and the search options. For example if there

is an active selection, you can switch here whether to search in the Current

Document or in the Selection Only. Shortcut Ctrl+F .

Replace Behaves very similar to the Find functionality. In fact the same pop-up is used,

it just shows an additional line with the Replace With string. You can toggle

this pop-up between Find and Replace mode using the arrow in its top left

corner. Shortcut Ctrl+H .

Go To Allows you to jump to a certain line by entering its line number. Shortcut

Ctrl+G .

Collapse All /

Expand All

The source code editor supports outlining, i. e. code blocks like a method

can be collapsed to a single line to gain a better overview of the source code.

CollapseAll collapses all such blocks and ExpandAll expands all such blocks.

Comment Lines Comment Linesmarks all currently selected lines with a comment symbol, so

that they are not part of the actual source code. Shortcut Ctrl+Shift+C

Uncomment Lines Removes all comment symbols from the beginning of the currently selected

lines. Shortcut Ctrl+Shift+U

Bookmarks This sub-menu provides support for bookmarks allowing you to jump between

regions of your source code. Bookmarked lines are indicated by a blue rect-

angle in the line number column. Toogle Bookmark creates a bookmark in the

current line if there is no bookmark present. Otherwise, the already existing

bookmark is removed. With Next Bookmark and Previous Bookmark you can

jump to the next and previous bookmark in your source code, respectively.

Clear All Bookmarks deletes all bookmarks.

Print Opens a dialog specifying which region of the source code is to be printed with

which printer. Clicking OK in this dialog starts the printing process. Shortcut

Ctrl+P .

7.2 Module View

Figure 44. Example of a VirtualLab Fusion module document.
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In Fig. 44 the view of a newly created C# module is shown as an example of the general view of VirtualLab

Fusion modules. It comprises the following three parts (from top to bottom).

ITEM DESCRIPTION

{Source Code Editor} ↪→Sec. 7.1

{Error Panel} Displays possible compiling errors and warnings, including the line in which

they occurred and an error code by which you can find further information

online. When you double-click on a message the cursor in the source code

editor jumps to the corresponding line. With the yellow buttons on top of this

panel you can filter to see either only warnings or only errors.

{Status Bar} The left part gives general status messages, which are also logged into the

Messages tab (↪→Sec. 4.3). The right part shows the current position of the

cursor, counted in lines (Ln) and characters (Ch).

The size of the module view can be changed freely by mouse drag, as well as the size of the error panel and

its columns.

7.2.1 Advanced Settings

The Module View can be also used to specify additional external reference DLLs. Fig. 45 shows the tab page

that can be used to specify external references for modules.

Figure 45. The Advanced Settings tab of a module.

The definition of external references is described in more detail in Sec. 7.3.4.

7.2.2 File Menu

If you click Save or Save As in the File menu the correct file extension (.cs for C# and .vb for Visual Basic)

is set automatically. Print opens a dialog specifying which region of the source code is to be printed with

which printer. Clicking OK in this dialog starts the printing process.

The shortcut Ctrl+M can be used to create a new C# module.

https://docs.microsoft.com/en-us/dotnet/csharp/language-reference/compiler-messages/
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7.2.3 Ribbon Items

ITEM DESCRIPTION

Run Compiles and then executes the correct source code (Shortcut F5 ). If you
click this button it turns into a Stop button (Shortcut Shift+F5 ) to stop the
execution of the code.

Compile Compiles the implemented source code and shows the resulting compiler

errors and warnings both in the errors panel and in the messages panel of

the main window. Shortcut F6 .

Select All Selects the whole source code. Shortcut Ctrl+A

Cut Copies the current selection to the Windows™ Clipboard and then deletes it.

Shortcut Ctrl+X .

Copy Copies the current selection to the Windows™ Clipboard. Shortcut Ctrl+C .

Paste Pastes the current (text) content of the Windows™ Clipboard to the cursor

position. Shortcut Ctrl+V .

Undo Undoes the last edit(s). Shortcut Ctrl+Z .

Redo Redoes the last undone action(s). Shortcut Ctrl+Shift+Y .

Find Opens a dialog where you can enter an arbitrary string. The Find Options

allow you to configure the behavior of this dialog in detail. By pressing the

Bookmark All button all matching lines in the source code are marked as

bookmark (see below). Shortcut Ctrl+F .

Replace Opens a dialog with which you can replace an arbitrary string by another

arbitrary string. The Find Options allow you to configure the behavior of this

dialog in detail. Shortcut Ctrl+H .

Comment Lines Comment Lines marks all currently selected lines with a comment symbol, so

that they are not part of the actual source code. Shortcut Ctrl+Shift+C

Uncomment Lines Removes all comment symbols from the beginning of the currently selected

lines. Shortcut Ctrl+Shift+U

Collapse All /

Expand All

The source code editor supports outlining, i. e. code blocks like a method

can be collapsed to a single line to gain a better overview of the source code.

CollapseAll collapses all such blocks and ExpandAll expands all such blocks.

Bookmarks This ribbon group provides support for bookmarks allowing you to jump be-

tween regions of your source code. Bookmarked lines are indicated by a blue

rectangle in the line number column. Toogle Bookmark creates a bookmark

in the current line if there is no bookmark present. Otherwise, the already ex-

isting bookmark is removed. With Next Bookmark and Previous Book-

mark you can jump to the next and previous bookmark in your source code,

respectively. Clear All Bookmarks deletes all bookmarks.

7.3 Source Code Editor for Snippets

This dialog (↪→Fig. 46) consists of various tabs which are explained in the following sections and the following

controls at its bottom:
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ITEM DESCRIPTION

Import Snippet Imports a snippet from a .snp-file. A dialog lets you select which parts of the

snippets are imported (all by default, with a Selection Tools button you can

Select All or Unselect All). In this way you can for example keep your source

code unchanged while importing the global parameters.

Export Snippet Exports a snippet into a .snp-file. This file can then be used to import the

snippet or parts of it into another programmable item.

Check Consistency Checks whether the implemented snippet is in correct C# syntax. Compiler

errors and warnings are shown in the validity indicator (↪→Sec. 5.10) right to

the Check Consistency button. Clicking the -button displays further infor-

mation including the exact location of the error or warning.

Shortcut: F6 , or Shift + F6 if you want to see the errors or warnings imme-

diately.

7.3.1 Source Code Tab

Figure 46. The Source Code Tab for snippets.

The Source Code tab of the Source Code Editor (↪→Fig. 46) shows two panels.

The left panel contains the source code. Some regions of the source code are made read-only to ensure that

it is suitable for the intended purpose. You can only edit the following regions:

• Additional using directives: Allows you to define additional namespaces containing classes you need.

See also the box in Sec. 7.

• Main method: The actual snippet function that must be implemented (Example: In case of a pro-

grammable optical surface this method has to return a height value in dependency of the position (x; y)).

• Snippet body: Additional methods, properties or variables can be specified here. They can be used for

example to store some intermediate results between consecutive executions of the main method.

https://msdn.microsoft.com/en-us/library/hh147285(VS.88).aspx
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You can use functionality from the .NET framework and from the classes documented in the VirtualLab Pro-

gramming Reference which you can find in the help menu of the ribbon. The code must be entered in C#

syntax.

The features of the actual source code editor are explained in Sec. 7.1.

The right panel contains a list of global parameters. By double clicking on them you can insert them at the

cursor position in the source code.

7.3.2 Global Parameters Tab

Most snippets have predefined global parameters, for example x and y where the function is evaluated. The
Global Parameters tab allows you to define further global parameters. These parameters can then be changed

by the end users without using the Source Code Editor (↪→Sec. 7.4).

Figure 47. The table to edit the Global Parameters.

This tab has the following controls (↪→Fig. 47).

ITEM DESCRIPTION

{Table} A table with all Global Parameters, see below.

Add Adds a new variable with the initial type Double Value to the bottom of the

table.

Remove Removes the currently selected variable from the table after inquiring whether

you really want to do so.

(Move Up) Moves the currently selected variable up by one row.

(Move Down) Moves the currently selected variable down by one row.

The table with the Global Parameters has the following columns:

https://msdn.microsoft.com/en-us/library/hh147285(VS.88).aspx
https://msdn.microsoft.com/en-us/library/hh147285(VS.88).aspx
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COLUMN DESCRIPTION

Variable Name A variable name must be unique and a valid C# identifier – which mainly

means that it must not contain spaces and special characters like ‘/’ and that

it must not start with a number.

To make the names shown in the control for end users (↪→Sec. 7.4) more

legible, you can add the special character ‘ᴗ’ which will there be replaced by

a space and a double underscore which will be replaced by a hyphen. So for

example the variable “Sub__SamplingFMM” becomes “Sub-Sampling FMM” for
the end user.

Type The type of the parameter. Can be either double (= a floating point num-

ber), integer, complex, string, or several types of vectors, double arrays, data

arrays, regions, and catalog entries.

Edit Opens an edit dialog where you can edit the Variable Name and the value of

the parameter. See below.

Opens a simple text editor where you can enter the help text shown in the

Parameters group box of programmable items. This editor optionally allows

you to specify HTML formatting.

Description Shows the current value of the parameter and additional information.

Figure 48. Edit dialog for a general parameter of type Double Vector 2D.

The edit dialog for a general parameter has the following entries (Fig. 48 shows an example).
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ITEM DESCRIPTION

Variable Name The unique name of the variable which must be a valid C# identifier (see note

in Sec. 7.3.2).

ᴗ Allows you to enter the special character ‘ᴗ’ which will be replaced by a space

in the control for end users (↪→Sec. 7.4).

Physical Quantity O , , .

Allows you to choose any of the physical quantities listed in Sec. 5.1. Note

that in the source code tab (↪→Sec. 7.3.1) all variables are always given in

their respective base unit (e. g. meters for a length and radians for an angle).

Value A control to define the actual value of the parameter. Depends on the type of

the parameter:

• Double Value PV : ↪→Sec. 5.1

• Double Array 1D PE and Double Array 2D PE : ↪→Sec. 5.4

• Boolean PC : A drop-down list to select between True and False.

• Integer Value PV : A spinner where invalid input is marked red and ex-

plained with a tooltip.

• Complex PV : ↪→Sec. 5.2

• Integer Vector 2D PV and Double Vector 2D PV : ↪→Sec. 5.3

• Double Vector 3D PV : Three controls for entering a physical value

(↪→Sec. 5.1), one for x-, y-, and z-dimension, respectively.

• String PC : A text box

• Data Array 1D, Data Array 2D, Data Array Gridless, Region 1D PE and

Region 2D PE : A Set button (↪→Sec. 5.7) to load the document from a

file or to use an already open document as well as a button to Show the

currently set document in a separate window.

• Boundary Response PE , Material PE , Medium PE , Stack PE , Surface PE :

↪→Sec. 34.1

Minimum Value /

Maximum Value

O ,

These values are used to restrict the allowed input values in the Parameters

group box of programmable items and in the Parameter Run. For vectors,

each component of the vector gets this value range constraint.

7.3.3 Snippet Help Tab

On the Snippet Help tab you enter a help text and additional helpful information concerning the whole snippet.

This information is then available for the end user via the Help-button at the bottom of the Parameters tab

of the programmable item (↪→Sec. 7.4).



CHAPTER 7. PROGRAMMING 102

Figure 49. The Snippet Help tab of the Source Code Editor.

It has the following controls (↪→Fig. 49).
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ITEM DESCRIPTION

Title Control to enter the title of the snippet.

Author Control to enter the author(s) of the snippet.

Version Control to enter the version of the snippet, e. g. “1.1a”.

Last Modified Allows you to enter the date the snippet was last modified. You can either

enter the date directly in your local date format or use the control to choose

the date visually.

Interpret Text as HTML If checked, the text inside the {Help Text Box} is interpreted as be-

ing HTML. So, HTML tags can be used for formatting (For exam-

ple you can use <b>…<b/> to make some text bold and <i>…<i/> to

make it italic.). If not checked, such tags will be ignored but line

breaks will occur in the result just as entered in the defining text box.

Please note: The state of this option will apply to the help texts of global

parameters (↪→Sec. 7.3.2) as well.

License A license can be specified here to be applied to the source code. Pressing the

tools buttons allows to select from a couple of predefined licenses. IfUser

Defined is chosen, a license can be entered freely. The license description

will appear in the Preview and Snippet help view below the text entered in the

{Help Text Box}.

{Help Text Box} Control to enter a description of the snippet. Scrolling with the mouse wheel

while holding the Ctrl key changes the font size of this control.

Load Image Loads an image from disk which will be part of the snippet help and which

serves for illustrating relations, variable meanings etc.

Delete Image Deletes a previously inserted image.

Scale Factor Scales an inserted image.

Preview The help of the snippet as the end user will see it.

7.3.4 Advanced Settings Tab

Figure 50. The Advanced Settings tab of the source code editor. As one of the given External References is invalid

(marked red), the Validity control shows an error. The text box Number of Resulting Physical Values (for Optimization)

is only visible for Programmable Items returning a list of DetectorResultObject.
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This tab (↪→Fig. 50) allows you to load External References, i. e. managed DLLs whose classes you want to

use. “Managed” refers to a special type of DLLs created with the .Net framework. This tab has the following

controls:

ITEM DESCRIPTION

List of References The list of already defined external references.

Add (Absolute) Opens a file open dialog where you can select a new managed DLL to be

added to the list.

Add (Relative) Adds a new managed DLL to the list. The reference DLL can be specified

by a relative path. The set up is done within an additional dialog, which is

described below. If the specified DLL cannot be found the corresponding row

in the List of References is marked red and the validity control shows an error

(↪→Fig. 50).

Remove Removes the selected DLL from the List of References.

Edit Editing of the path of the selected DLL.

By clicking on the Add (Relative) button a dialog is shown which can be used to specify a relative path to a

managed DLL.

Fig. 51 shows the edit dialog for relatively linked references.

Figure 51. Dialog for specifying relative links to referenced DLLs.

The user can enter the relative path directly within the text box at the bottom of the dialog. Additionally the

list box at the top of the dialog can be used which assists the user in specifying the correct syntax for the

relative links. By double clicking on an item within the list the selected directory key is added to the name of

the reference DLL. The following relative directories are available

ITEM DESCRIPTION

$AppDir$ The directory from which VirtualLab Fusion is started (typically the installation

directory).

$ModuleDir$ The directory where the module is stored. This option is only available in the

Module View. ↪→Sec. 7.2.

7.4 Programmable Items for End Users

Programmable items usually have two distinct user groups: The developer which can use the source code

editor described in Sec. 7.3 and the end user who just wants to change the parameters. The former can also

be LightTrans or your local distributor.

The controls for the end user are in a Parameters group box (↪→Fig. 52) directly in the edit dialog of the pro-

grammable item itself, thus he needs not to enter the source code editor.
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Figure 52. Example for the Parameters group box of a programmable item. The scrollbar indicates that there are more

parameters to be set than can be shown at once.

Each global parameter (↪→Sec. 7.3.2) of the snippet defining the programmable item has its own type-depending

control(s) to change the value:

TYPE OF PARAMETER CONTROL(S)

Double Value PV ↪→Sec. 5.1

Double Array 1D PE /

Double Array 2D PE

↪→Sec. 5.4

Boolean A checkbox

Integer Value PV A spinner where invalid input is marked red and explained with a tooltip.

Complex ↪→Sec. 5.2

Integer Vector 2D PV /

Double Vector 2D PV

↪→Sec. 5.3

Double Vector 3D PV Three controls for entering a physical value (↪→Sec. 5.1), one for x-, y-, and

z-dimension, respectively.

String A text box

Boundary Response PE /

Material PE / Medium PE /

Stack PE / Surface PE

↪→Sec. 34.1

Data Array 1D / Data Array

2D / Data Array Gridless /

Region 1D / Region 2D

A Set button (↪→Sec. 5.7) to load the document from a file or to use an already

open document as well as a button to Show the currently set document in a

separate window.

Furthermore there are two buttons at the bottom of this control.

ITEM DESCRIPTION

As Separate Window Allows you to show all parameters in a separate resizable window for a better

overview.

Help Displays help information for the whole snippet and / or the individual param-

eters (if provided by the developer).

Note that this group box is not visible if the snippet contains neither global parameters nor help information.
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8 Distributed Computing

VirtualLab Fusion can be used to perform parameter run evaluations using Distributed Computing. To enable

this technique the user needs to start a server directly in VirtualLab Fusion and configure the calculation network

(meaning the calculation clients that shall be used for the simulations).

Fig. 53 show the control panel for the configuration of the distributed computing server inside VirtualLab Fusion.

Figure 53. The network for distributed computing can be configured directly in VirtualLab Fusion. The user can start a

server and configure the client network.

By pushing the Start Server button a new server will start in the running VirtualLab Fusion instance. It should

be noticed that per machine only one server can be started, because the communication between server and

clients is done via network and for that the different ports will be used.

For the communication between server and clients (and the server support tool) the following ports should be

accessible:

• 23001 [TCP & UDP]

• 23002 [TCP & UDP]

• 23003 [TCP & UDP]

After the server is started the caption of the Start Server button will be changed to Stop Server. In addition,

several additional buttons and controls get visible or active.

Fig. 54 show the user interface after the server was started.
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Figure 54. After starting the server inside VirtualLab Fusion the user can modify the calculation network using the avail-

able controls.

If the server is running three different regions will be available for modification and investigation of the calculation

network.

• Server Tools - In this section of the user interface the user can stop the server, adapt the calculation

network, start a file watcher and specify some setting of the server. A detailed explanation of the server

tools can be found in Sec. 8.1.

• Clients - Below the server tool section a table listing all connected clients is displayed. Within this table

the user can investigate the current status of all clients per remote machine. Details on the client list can

be found in Sec. 8.2.

• Logging - On the bottom of the control panel for distributed computing the user can find a text box, in which

the communication within the calculation network is logged. Here it will be shown when a new calculation

is given to the server, a calculation is distributed to a client within the network and also when a simulation

is finished and the results are returned from the calculation client to the server. Below the logging window

there is a button to clear the logging information. In addition, the user has the option to disable the logging

checking the box Disable Logging below the logging window. It is recommended to deactivate the logging

for a large number calculations, because the logging would slow down the performance of the server.

8.1 Server Tools

In the user interface section Server Tools several tools are available to start/stop or modify the server and the

connected calculation network. The following tools can be accessed here:
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ITEM DESCRIPTION

Start Server If no server is actually running you have the option to start the server. Please

note that you can only start one server per machine. In case a server is

already running, VirtualLab Fusion offers the option to attach to the running

server. In this case it is possible to use an existing calculation network. The

calculation network can only bemodified within the VirtualLab Fusion instance

which started the server.

Stop Server If a server was started, the Start Server button is changed to a Stop Server

button. If you click on the Stop Server button, VirtualLab Fusion will ask for a

confirmation that you really like to stop the server. If you confirm your choice,

the server and all connected clients will be closed.

Configure Server By clicking on the configuration wheel next to the Stop Server button a dia-

log is opened in which you can specify some processing parameters for the

running server. The settings you can do here are explained in the Sec. 8.1.1.

Add Clients on Remote

Machine

The server supports to start clients on remote machines. There for a server

support tool needs to run in the machines on which you like to enable the start

of clients. In Sec. 8.1.2 the work flow how to add clients on a remote machine

in a user-friendly way is explained.

Start File Watcher In addition to the parameter run, we also offer the option to feed new simu-

lation tasks to the distributed computing network via hard disc. Therefor you

simply need to use the Start File Watcher tool. Here the user can select a

folder which is checked regular by VirtualLab Fusion. This option can be use-

ful if you are working with external programs (like python) and like to benefit

from the automatic distribution of calculations. In case a new os file is stored

in the folder watched by VirtualLab Fusion, the task is distributed in the cal-

culation network and as soon as the results are present they are available in

a sub folder as XML file.

8.1.1 Server Options

By clicking on Server Options a dialog is shown in which several options can be configured.

Fig. 55 show the dialog to configure the server options.

Figure 55. The dialog to configure the server options.

In general VirtualLab Fusion support to restart a client automatically after a specified number of calculations

was done on the client, or if the RAM usage of one client is above a user defined threshold. It is recommended

to keep the options as they are set by default. In case you are facing some irregular behavior of the clients

these options could be adapted to solve the irregularity.
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8.1.2 Add Clients on Remote Machine

VirtualLab Fusion supports to add clients to a running distributed computing server directly from the server side.

This can be done by clicking on the Add Clients on Remote Machine button. Fig. 56 shows the dialog to add

clients on remote machines.

Figure 56. The dialog which can be used to select the host machine on which the clients shall be started

On the top of the dialog you find a table which list all available host machines on which the server can start

clients. To enable a host machine to start clients automatically, the server support tool has to run on the host

machine. The server support tool is a special executable which can be found in the installation directory of

VirtualLab Fusion. Simply start the file VirtualLab.DistributedComputing.ServerSupportService.exe and keep it

open.

In the server support tool you will find a logging box which displays the information when a server requested to

start a user defined number of clients.

In the table each host machine is represented by one line in the table. The following columns are available

within the table:

ITEM DESCRIPTION

Select The first column can be used to select whether you like to start one or more

clients on the host machine. If you select a host machine within the table you

can specify how many clients shall be started on the host machine.

Host Machine The host machine name is used to identify the host machine.

Running Clients In the column Running Clients you can see how many clients are already run-

ning on the corresponding host machine. This information includes all clients

that are connected to all running VirtualLab Fusion server in your network.

Add Clients If you select a host machine within the table, the cell entry for specifying the

number of clients to start will become active. The number of clients per remote

machine which is reasonable depends on the host machine (and its current

usage) as well on the simulation tasks you like to distribute.

CPU The table provides the information of the current CPU usage of the host ma-

chine. This information is updated frequently.

RAM The table provides the information of the current RAM usage of the host ma-

chine. This information is updated frequently.

On the bottom of the dialog two buttons are located to save and load the settings for the configuration of

the calculation network. By clicking on the save button a text file is generated, which contains all necessary

information given in the table above. When loading a previously stored configuration file, the information will

be read again from the text file and all matching information will be synchronized with the table settings. In
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case the information within the text file does not match the found host machines, per mismatch a warning is

displayed. Only the matching information will be used for synchronization.

8.2 Clients

In the section Clients a list of all connected clients to the current server is shown. Fig. 57 shows the table for a

sample situation where 17 calculation clients are connected on 5 different host machines.

Figure 57. The Clients control contains a list of all connected clients in the current calculation network.

In the table each host machine is represented by one line. Per host machine multiple clients could be running,

which is displayed in the corresponding table entry. The table provides the following information.

ITEM DESCRIPTION

Status The status column is used to mark that status of each host machine by an

intuitive color. The used colors have the following meaning:

• Green: No connected client on the corresponding host machine is per-

forming a calculation task.

• Yellow: Some (but not all) connected clients on the corresponding host

machine are performing a calculation task.

• Red: All connected clients on the corresponding host machine are per-

forming a calculation task.

• Gray: The clients on the corresponding host machine are set to in active

(which means they are connected but are not used for distribution of

calculation tasks)

Host Machine In this column the name of the host machine is plotted.

Clients In the Clients column, the user can check how many clients are connected for

the corresponding host machine. In addition you can also find the information

how many of the connected clients are currently performing a calculation job

provided by the server.

CPU For monitoring purposes it is important to see the current CPU usage of the

host machine. This information is given here.

RAM For monitoring purposes it is important to see the current RAM usage of the

host machine. This information is given here.
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Active In the Active column you can check whether a host machine is active or not.

By default themachines are all set to active, but there could be situation where

the user might decide to don’t use a specific host machine (e. g. if this ma-

chine is needed for some other calculations). In this case one could remove

all clients from the corresponding host machine, or set them to inactive. If the

user set the clients on the host machine to be inactive and the clients are cur-

rently already doing some calculations, the calculations will be finished and

there will be no newly distributed calculation tasks to the clients of the host

machine. The inactive status is also visible via the Status column within the

client list (color is set to gray).

Disconnect In the last column a button is available to disconnect all clients on the corre-

sponding host machine. By clicking the Disconnect button the user is asked

for confirmation whether he really likes to close all connected clients on the se-

lected host machine. In case of confirmation the clients are closed and if there

would be running calculation tasks the calculation would be re-distributed to

the other clients within your calculation network.

It is a very typical situation, that there are more calculation tasks provided to the distributed computing network

than there are available clients. In case all clients are already occupied and a new calculation task if given to

the server for distributed computing, this simulation will be added to the calculation queue. As soon as a client

is ready with the calculation task assigned to it the next task from the queue is automatically assigned to this

client. Below the table listing all client information you can find the Number optical setups in queue.

9 Command Line Arguments

VirtualLab Fusion can be controlled not only via the graphical user interface but also via command line argu-

ments. Multiple such commands can then be collected in a batch file.

The ribbon item File > Export > Create Batch Mode Files asks for a folder and creates there a sample batch

file from the current Optical Setup which calculates the results for the current simulation engine. Furthermore

a sample XML file is created containing the original values of all variable parameters of the Optical Setup.

Restrictions on the passed arguments

Note that as batch files use another code page than Windows™ programs, paths in the batch file con-

taining non-ASCII characters are passed to VirtualLab Fusion incorrectly. Thus the result and logging

files might be stored in a wrong folder or the Optical Setup might not be simulated at all. Thus the paths

should only contain the standard Latin characters a-z and A-Z, numbers, spaces and the special char-

acters !#$%&'()+,-.;=@^_‘{ }~ .

Furthermore the letter combination \" yields unexpected results. Thus path arguments must not end with

\ .
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Hints

• The commands are case insensitive. For example you can use -performOs, -PerformOs, or
-performOS.

• In the parameters you can use any environment variable like %TEMP% (= path to the temp folder) or
%VirtualLab_AppDir% (= path to the VirtualLab.exe from which the last export to batch mode or

to optiSLang was executed).

• All commands described below can be used only exclusively. Only file names, -startUpModule,
and -globalOptions can be used together.

The available commands are listed below. (The arguments in curly brackets are user-defined parameters, the

arguments in square brackets indicate optional arguments.)

virtuallab.exe {1} [{2} [{3} …]]
Opens the specified files in VirtualLab Fusion. VirtualLab Fusion documents (↪→Sec. 4.1) are opened as docu-

ment windows. For files which can be imported (↪→Part XVI) the corresponding import dialog is opened. After

you close this dialog, the dialog for the next importable file is opened, if specified.

virtuallab.exe {1} [{2} [{3} …]] -convert {4}

This command allows you to save a bunch of files in the most recent file format and file extension.

The specified files ({1}, {2}, …) are opened and saved to the specified output directory {4}. You can also specify

directories, then all files in this directory and its subdirectories are converted. Duplicate file names are made

unique by adding ”.bak” and maybe a number.

Old VirtualLab files (↪→Sec. 130) are imported using default options. Errors are logged to an errors.log file in
the output directory.

With this command VirtualLab Fusion is started in the “batch mode” where no VirtualLab Fusion windows are

opened.

virtuallab.exe -performOS {1} {2} [-parameters {3}] [-engine {4}] [-subfolder] [-noLogfile]
This command allows you to simulate an arbitrary Optical Setup (↪→Sec. 43); its results are then saved au-

tomatically. With this command VirtualLab Fusion is started in the “batch mode” where no VirtualLab Fusion

windows are opened.



CHAPTER 9. COMMAND LINE ARGUMENTS 113

ARGUMENT(S) DESCRIPTION

-performOS {1} {2} The mandatory argument -performOS must be followed by the path and file
name of the Optical Setup to be simulated ({1}) and the folder where all output

is stored ({2}).

Results are written into a results.xml file. Complex documents which

cannot be saved into this XML file are stored as separate documents, the

results.xml file then contains only a reference to that file.
If warnings or errors occur during the simulation, they are written into a

ProcessingInfo.log file (unless -noLogFile is specified). If Pop up Error

Messages or Pop up Warning Messages is activated in the Global Options

dialog (↪→Sec. 6.16), the corresponding messages are also shown in a mes-

sage box.

-performLPD is a synonym for this command.

-parameters {3} With this optional argument you can specify a XML file with parameter val-

ues. These values are then used for the simulation instead of the original

parameter values. You can use File > Export > Create Batch Mode Files

to create a sample XML file named parameters.xml with the correct format
(↪→Sec. 124.1).

-engine {4} With this optional argument you can specify the simulation engine to be used.

“0” refers to Classic Field Tracing, “1” to General Profile, “2” to Ray Results

Profile, and “4” to System: 3D visualization (↪→Sec. (a)). Other numbers refer

to the index of the analyzer to be used for the simulation. If this parameter is

not specified, “2” for Ray Results Profile is used. For Laser Resonator Optical

Setups always the Eigenmode Analyzer is used.

-subfolder If this optional parameter is specified, a subfolder in the output folder {2} is
generated where the result and logging files are stored. In this way consecu-

tive calls of the virtuallab.exe do not overwrite already calculated results.
The name of the subfolder is <Name of simulation engine> (<Date and
Time>).

-noLogfile If this optional parameter is specified, a ProcessingInfo.log file is not cre-
ated and thus errors and warnings get lost. This avoids problems occurring

when hundreds of consecutive iterations are started via batch mode.

virtuallab.exe -performModule {1}

With this command a module (↪→Sec. 7) instead of an Optical Setup can be processed in “batch mode” with-

out VirtualLab Fusion windows. Compiler warnings and errors as well as text messages are written to a

ProcessingInfo.log file in the same folder as the module. Note that showing results in the VirtualLab Fu-

sion User Interface does not work in the batch mode, so you have to save them to your hard drive.

The parameter {1} is the path and file name of the module.

-run is a synonym for this command.

virtuallab.exe -startupModule {1}

Loads, compiles and executes an arbitrary module (↪→Sec. 7) during startup of VirtualLab Fusion. Afterwards

execution of VirtualLab Fusion continues normally. This allows you among others to ensure that certain Global
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Options are set during start up, program a timer to remind you every 30 minutes that you need a break or open

VirtualLab Fusion files you always need.

The parameter {1} is the path and file name of the module executed during startup.

virtuallab.exe -globalOptions {1}

Specifies the Global Options file (↪→Sec. 6) to be loaded. So you can setup two VirtualLab links on your desktop

each using their own Global Options; e. g. one with many digits for numbers and big result windows for setting

up systems and the other one with only three digits and default window size for screenshots.

10 License Information Dialog

The licenses of VirtualLab Fusion can be managed using an integrated dialog, which can be found at the

Start > License Information ribbon item (↪→Fig. 58). Fig. 59 shows the dialog that displays the current license

information that is stored in the USB dongle.

Figure 58. The License and Update ribbon items of VirtualLab Fusion.

Figure 59. The dongle dialog to manage the licensing of VirtualLab Fusion.

The current license status is displayed in the upper section of the dialog. Depending on the license model, the

License Duration can be

• “Unlimited” or

• an expiration date until which the package can be used .

Also shown is the last quarter the update service is valid for, the number of users for each package and the

internal Dongle ID.

In the following we explain how licenses can be added or renewed.

After you have bought additional licenses we will ask you to send us your current license file. This file is obtained

by pressing the button Save License Information (↪→Fig. 60).
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Figure 60. Press the button “Save License Information”.

Then a file dialog will be opened, where you can choose the destination for saving the license file (↪→Fig. 61).

The resulting file has the extension “c2v” and has to be sent by email or ftp to LightTrans.

Figure 61. File dialog for saving the “c2v”.

You will receive the modified license file from us. In order to activate the new licenses, the file has to be opened

by pressing the Apply License Update button (↪→Fig. 62) in the license information panel.
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Figure 62. Press the button “Apply License Update”.

Thereby another file dialog is shown (↪→Fig. 63) and you have to select the received “v2c” file. After this step

the license on the USB key is updated and the new license conditions are active for VirtualLab Fusion.

Figure 63. File dialog for applying the “v2c”.



III Result Documents

In VirtualLab Fusion there are several document types which show data

plotted against one or more coordinates. This part explains theseResult

Documents.
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All Result Documents (but Animations) have a View ribbon. Sec. 11 explains most of the entries in that ribbon.

The x-axis of all these views points to the right and the y-axis to the top. As a result, if the data represents

a light field, its z-axis is directed out of the monitor. Thus you see light always as it would look like through a

transparent screen, as least if the light propagates in positive z-direction, ↪→Sec. 131.3.

11 Basic Concepts

11.1 Field Quantity

Availability

Only for complex-valued data

Accessible:

• Ribbon: View > Field Quantity ribbon group

• Property browser: View > Field Quantity

• Context menu: Field Quantity

Often complex-valued data are to be shown, but only real-valued data can be shown in an intuitive way. The

Field Quantity of a view determines which real-valued data are extracted from the complex-valued data. The

following choices are available:

ITEM DESCRIPTION

Real part Real part a of a complex number z = a + ib

Imaginary part Imaginary part b of a complex number z = a + ib

Amplitude Amplitude A of a complex number z = A exp[iφ]

Phase Phase φ of a complex number z = A exp[iφ]

Squared Amplitude Squared amplitude A2 of a complex number z = A exp[iφ]

Summed Squared Am-

plitudes

O H F H F S

Sum of the Squared Amplitudes of multiple vectorial components

(↪→Sec. 12.2.2.2). If you select this option, there is an additional com-

bobox in the property browser and the context menu, respectively, where

you can select which vectorial components are to be combined: Ex and Ey,

Ez and Ex, Ez and Ey, as well as all vectorial components, respectively. In

the ribbon this can be done via the launcher button of the Field Quantity

group.

The current field quantity is also displayed in the center of the status bar of each harmonic field data view.

11.2 Value Scaling

There are several features which influence the scaling of the values.
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11.2.1 Interpolated View

Availability

Only for harmonic fields, harmonic fields sets and 2D chromatic fields sets.

Accessible:

• Ribbon: View > Interpolated View

• Property browser: View > Interpolated View

• Context menu: Interpolated View

You can apply an interpolation on the view without manipulating the underlying data.

• If view interpolation is deactivated, this corresponds to the nearest neighbor interpolation

(↪→Sec. 13.2.2). The shown value of each screen pixel is determined according to the value of the

nearest corresponding data point.

• If view interpolation is activated, the output is smoothed using the following interpolation methods

(↪→Sec. 131.4):

– Cubic 4 point for two-dimensional data,

– Cubic 6 point for one-dimensional data.

11.2.2 View Interpolation Modes

Availability

Only for 1D or gridded 2D data array based documents except for 2D chromatic fields sets.

Accessible:

• Ribbon: View > Value Scaling > No Interpolation / Pixelated View / Interpolated View / (Real-

Valued) Smoothing

• Property browser: View > View Interpolation > No Interpolation / Pixelated View / Interpolated

View / Real-Valued Smoothing

• Context menu: View Interpolation > No Interpolation / Pixelated View / Interpolated View / (Real-

Valued) Smoothing

The views of data-array based documents (↪→Sec. 13) can be smoothed without changing the contained data.

The following options are available:

• No Interpolation: 1D

Only the values at the data point coordinates will be drawn.

• Pixelated View: The value of the nearest neighbor (in equidistant case) or of the neighbor with the nearest

lower coordinate (in non-equidistant case) will be shown. This will result in some kind of ”stepped” curve

(1D) or pixelated diagram.

• Interpolated View: -

The interpolation which is stored at the displayed object will be used for smoothing the view.

• (Real-Valued) Smoothing: - -

A cubic 6 point interpolation (in equidistant case) or a linear interpolation (in non-equidistant case) is ap-

plied for smoothing the shown data. In case of complex-valued data the interpolation will be applied to



CHAPTER 11. BASIC CONCEPTS 120

the currently shown field quantity (amplitude, phase, real part, imaginary part, squared amplitude) only,

i.e. the smoothing works real-valued.

11.2.3 Triangle Interpolation

Availability

Only for dot diagrams

Accessible:

• Ribbon: View > Show Triangles

• Property browser: View > Show Triangles

Using Show Triangles you can obtain a smooth data representation out of dot diagram. In this mode, the View

tab of the property browser has an additional option to Show Triangles Borders. The effect of these two options

is illustrated in Fig. 64.

Figure 64. The left window shows the normal dot diagram. The right window shows the same data with Show Triangles

and Show Triangles Borders.

11.2.4 Color Tables

Availability

For documents based on 2D data arrays, Jones Matrix Transmissions, Harmonic Fields, and Harmonic

Fields Sets

Accessible:

• Ribbon: View > Value Scaling group

• Property Browser: View > Color Table

• Context menu: Color Table

For two-dimensional views, several color tables are available. The principle of the mapping of colors to data

values in the range [xmin, xmax], is shown in Fig. 65.
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Figure 65. Principle of color mapping via color table. a) Mapping of one value x, b) Mapping of the whole range
[xmin, xmax]

Via the View ribbon, the Property Browser or the context menu you can choose from a list of color tables.

The tables can be managed via View > Manage Color Tables or the Global Options dialog (↪→Sec. 6.9). The

corresponding dialog is described in Sec. 11.2.4.1.

You can edit the current table via the ribbon item Start > Edit Color Table or via context menu item Color Table

> Edit Color Table.... In this case the dialog described in Sec. 11.2.4.2 opens.

For the view of two-dimensional Numerical DataArrays or some viewmodes of objects that contain DataArrays,

a distinct color table per field quantity (↪→Sec. 11.1) can be set.

11.2.4.1 Managing Color Tables

Figure 66. Dialog for managing the color tables.

On the left-hand side of this dialog (↪→Fig. 66) you have two lists of color tables: Predefined Color Tables pro-

vided by Wyrowski Photonics and User-Defined Color Tables. On the right-hand side you have the Customized

Color Tables Menu. This is the menu shown among others in the View ribbon, the Property Browser, and the

context menu. You can add a color table to this menu from any of the lists on the left-hand side using the
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corresponding button or by double-clicking. Conversely, you can move an entry from the customized menu

back to the “stock” with the button or by double-clicking.

The entries in the Customized Color Table Menu can be sorted with the and the button, respectively.

Entries which are used as default for certain field quantities (↪→Sec. 6.9) are underlined.

The currently selected color table can be edited with the button. Then the dialog described in Sec. 11.2.4.2

opens. Each color table has to have a unique name.

The User-Defined Color Tables section has the following additional buttons:

BUTTON DESCRIPTION

Imports a previously exported color table from a file. If the name of the im-

ported color table is already used, a “ (1)” is appended to its name.

Exports a color table to a file.

Deletes the currently selected user-defined color table.

11.2.4.2 Editing a Color Table

Each color table can be edited via the dialog shown in Fig. 67.

Figure 67. Edit dialog for a color table.

ITEM DESCRIPTION

Inverts the color sequence.

Moves the selected color up.

Moves the selected color down.

Inserts a new color to the sequence.

Removes the selected color from the sequence.

Allows to edit the selected color.

Interpolate Colors If checked, a linear interpolation is applied to the color sequence, so a smooth

color profile is mapped to continuous data values. Otherwise, discrete colors

are mapped.
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Mapping Function The type of the function that maps colors to data values can be selected here.

• Linear Function: The color index clin for a given value v and normalized
to the range [0 . . . 1], is calculated via clin = (v−min)/(max−min).
The values min and max define the data value range to be shown in

the view (min <= v <= max).
• Exponential Function: At first, the linear color index clin is calcu-

lated from value v according to the formula given for the Linear

Function. At second, the color index cexp is calculated via cexp =

(eclin ·p − 1) / (ep − 1). The parameter p is the Function Parameter

which has to be defined separately.

• Logarithmic Function: At first, the linear color index clin is calcu-

lated from value v according to the formula given for the Linear

Function. At second, the color index clog is calculated via clog =

ln (clin (ep − 1) + 1) /p. The parameter p is the Function Parameter

which has to be defined separately.

• Power Function: At first, the linear color index clin is calculated from

value v according to the formula given for the Linear Function. At sec-

ond, the color index cpow is calculated via cpow = cp
lin. The parameter p

is the Function Parameter which has to be defined separately.

Function Parameter All available types of mapping functions, except from Linear Function, allow

to specify one parameter p which can be set here. It influences the slope of

the selected mapping function and has to lie within the interval ]0 . . . 100].

Unique Name The unique name of the color table. This is the name under which it is stored

in the list of user-defined color tables (↪→Sec. 11.2.4.1). If you close the dialog

and there is already a user-defined color table with the same name, you can

choose whether to change the name or to overwrite the old color table.

Marker Color 1 First color to be used for selection markers like rectangular / elliptic marker

or line marker.

Transparent The Color 1 may be transparent. So transparency can be switched on and

off here.

Marker Color 2 Second color to be used for selection markers like rectangular / elliptic marker

or line marker.

Highlighting Color Sometimes some parts of a marker have to be highlighted. The color to be

used for this can be set here.

Suggest Marker Colors Pressing this button will suggest some colors which can be used as marker

colors.

Preview When you edit the color table of a document window, there is a Preview but-

ton. If you click it, the current color table is directly applied to the document

window (but Cancel still reverts it back to the original color table).
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Note on marker colors

For Jones Matrix Transmissions, Harmonic Fields, and Harmonic Fields Sets, Marker Color 2 is used

to draw the markers. For drawing polarization ellipses (↪→Sec. 12.2.2.3), marker color 1 and 2 are used

(depending on their direction of rotation). The polarization grid is drawn with the Highlighting Color.

11.2.4.3 Display of Undefined Values

In some cases, a data point of a Data Array, Chromatic Fields Set etc. does not contain a defined numerical

value. This may be e. g. a result of a division by zero.

Since this kind of value can not be mapped onto a color via a color table, it will be marked by an independently

defined color. This may look like shown in Fig. 68.

Figure 68. Example for the color indicator of undefined values.

The color which indicates undefined values can be set via property browser (↪→Sec. 13.5.1.2 and Sec. 13.5.1.3).

The Global Options dialog allows to define the default colors to be used for 1D views and 2D views (↪→Sec. 6.8

and Sec. 6.9).

11.2.5 Scaling Mode

Availability

Accessible:

• Ribbon: View > Scaling Mode ribbon menu

• Property browser: View > Scaling Mode (for Harmonic Fields and Harmonic Fields Sets)

View > Auto Scaling of Data (for data array based documents)

• Context menu: Scaling Mode (for Harmonic Fields and Harmonic Fields Sets)

The upper and the lower limit of the chosen color palette (↪→Sec. 11.2.4) are mapped to the minimum and

maximum value of the currently visible field quantity (↪→Sec. 11.1). There are three possibilities of how the

minimum and maximum values are determined:
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ITEM DESCRIPTION

Automatic Scaling The minimum and maximum values are calculated from the field.

Standard scaling O H F H F S

This mode depends on the selected field quantity (↪→Sec. 11.1). For real and

imaginary part the value range [-1, 1] is used. The standard value range for

amplitude and intensity is [0, 1], and for phase it is [−π, π].

User-Defined Scaling TheDisplayed Data Range can be specified within the View panel of the prop-

erty browser.

There is also the possibility to use User-Defined Scaling in a way that a marked rectangular / elliptical or one-

dimensional range is scaled optimally:

ITEM DESCRIPTION

Selection Based Scal-

ing

The minimum and maximum values of the view are set to the value range

within the current rectangle / elliptical or range selection (↪→Sec. 11.3.4).

In one-dimensional views, the value range determines the range of the y-axis. In two-dimensional views, the

value range is displayed besides the color scale on the right hand side.

11.2.6 Brightness

Availability

For the two-dimensional views showing real colors

Accessible:

• Ribbon: see below

• Property browser: View > Brightness Factor

For documents showing real colors a brightness factor can be used to make darker regions visible. A factor of

1.0 refers to the brightest image where the colors are not yet distorted due to overexposure.

You can enter the brightness factor directly in the View tab of the ribbon or the property browser. Or you use

the controls shown in Fig. 69. The left bulb decreases the brightness by 0.1, while the left bulb increases it by

the same amount.

Figure 69. The controls for adjusting the brightness in the View tab of the ribbon

However, the eye is a logarithmic “detector” (Weber-Fechner law). Thus you often need quite large brightness

factors to see the desired dark regions. To compensate this, there is an exponential trackbar below the bulbs.

With it you can set the brightness to powers of
5
√

10.
The minimum brightness is 0.1 and the maximum brightness is 1000.
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11.3 Markers and Selections

Availability

…for Selection Mode

Accessible:

• Ribbon: View > Selection Mode ribbon menu

• Property browser: View > Selection Mode (for data array based documents)

• Context menu: Selection Mode

Within a diagram view, a portion of the displayed data can be selected for further evaluations and operations,

e. g. the Selection Based Scaling (↪→Sec. 11.2.5) or the Normalize with Respect to Selection (↪→Sec. 22.9).

Fig. 70 shows a selection example for a 1D data array, Fig. 71 an example for the 2D view of a 2D data array.

Figure 70. Example for the point marker (Magenta) and the range marker (Red) in a 1D Numerical Data Array view.

Figure 71. Example for the point marker, the line marker, and the elliptic / rectangular marker in a 2D Numerical Data Ar-

ray view.

Each kind of marker can be drawn into a view with the mouse if the corresponding Selection Mode is selected.

There are four modes for 2D views:
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• Rectangle or Ellipse Marker1

• Line Marker

• Point Marker

• No Marker

And there are three modes for 1D views:

• Range Marker

• Point Marker

• No Marker

If the corresponding mouse mode is selected, then the markers can be configured with the mouse as follows:

MARKER MANIPULATION POSSIBILITIES

Point Marker • Set the point marker at a certain position by left-clicking there.

• Move the point marker either via arrow keys or by dragging with the

mouse.

Line Marker • Set the line marker by left-clicking on the desired start position, keeping

the left mouse button pressed while moving to the desired end position.

The end position of the resulting line marker is marked with an arrow

head. Restricted line angles can be achieved holding Ctrl pressed

while dragging.

• Change either the start or the end position by dragging with the mouse.

Restricted line angles can be achieved holding Ctrl pressed while

dragging.

• Move the line marker either via arrow keys or by dragging the line center

(marked by a circle) with the mouse.

• Create a maximized default line marker by double-clicking on the view.

Range Marker • Set the range marker by left-clicking on the desired position of one bor-

der, keeping the left mouse button pressed while moving to the desired

opposite border.

• Change any of the borders by dragging with the mouse.

• Move the range marker either via arrow keys or by dragging the range

center (marked by a half-circle).

• Create a maximized range marker by double-clicking on the view.

Rectangle Marker • Set the rectangle marker by left-clicking on the desired position of one

corner, keeping the left mouse button pressed while moving to the de-

sired opposite corner.

• Change any of the borders by dragging with the mouse.

• Change any of the corners by dragging with the mouse.

• Move the rectangle marker either via arrow keys or by dragging the

center of the rectangle (marked by a circle) with the mouse.

• Create a maximized rectangle marker by double-clicking on the view.

Note that the Selection Mode is the same for all document windows. If you change it for a one- / two-dimensional

document, you change it for all other one- / two-dimensional documents as well.

1 The ellipse marker is only available for gridded data array based documents. You can switch between elliptic marker and and rectan-

gular marker with the Selections > Elliptic Selection entry of the Property browser.
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For Harmonic Fields and Harmonic Fields Sets, the markers are drawn red or black, the latter for rainbow or

reverse rainbow color scale. For 1D data array based documents the point marker is drawn magenta and the

range marker is drawn red. For 2D data array based documents the colors of the markers can be set in the

edit dialog of the currently used Color Table (↪→Sec. 11.2.4.2).

If a line marker is visible, the current cross section defined by the marker is shown below the 2D data.

After you have defined a marker (↪→Sec. 11.3) it stays visible in the view until you turn it off. This can be done

as follows.

Availability

…for Marker Visibility

Accessible:

• Ribbon: View > Show … Marker

• Property browser:

– For Harmonic Fields and Harmonic Fields Sets: View > Display Selection Marker, View >

Display Profile Line, and Point Manipulation > Display Marker, respectively

– For data array based documents: View | Selections > Show Rectangle or Ellipse Marker,

View | Selections > Display Range Marker, View | Selections > Display Line Marker, and

View | Selections > Display Point Marker, respectively

• Context menu: Marker Visibility

11.3.1 Setting Exact Marker Coordinates

In the Property Browser you can set the exact coordinates either in point or in physical coordinates. This can

be done at different locations for data array based documents or for Harmonic Fields and Harmonic Fields Sets

which are summarized in the following table.

MARKER DATA ARRAY BASED DOCUMENTS HARMONIC FIELDS (SETS)

Point Marker Property Browser: Selections > Selection (Point) Property Browser: Point Manipula-

tion > Clicked Position

Line Marker Property Browser: Selections > Selection (Line) Property Browser: View > Profile

Line

Range Marker Property Browser: Selections > Selection

(Range). The button opens the dialog de-

scribed in Sec. 11.3.1.1.

Ribbon: View > Selection Tools > Edit Range

Marker Coordinates (↪→Sec. 11.3.1.1)

Property Browser: View > Selection

(Range)

Ribbon: View > Selection Tools

> Edit Range Marker Coordinates

(↪→Sec. 11.3.1.1)

Region Marker Property Browser: Selections > Selection (Re-

gion). The button opens the dialog described

in Sec. 11.3.1.2.

Ribbon: View > Selection Tools > Edit Rectangu-

lar Marker Coordinates (↪→Sec. 11.3.1.2)

Property Browser: View > Selection

(Region)

Ribbon: View > Selection Tools

> Edit Rectangular Marker Coordi-

nates (↪→Sec. 11.3.1.2)

In the Property Browser of data array based documents you can set Selections > Coordinate Snapping Selec-

tion to false. Then the markers no longer “snap” to the sampling points. Consequently, you then can enter the

marker coordinates only in physical coordinates, not in point coordinates.
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For gridless 2D data arrays and ray tracing results, coordinate snapping is never active for the rectangle

marker and always active for the line and the point marker. Thus in the Property Browser this option

is not shown. Furthermore, you cannot change the coordinates of the line and the point marker in the

Property Browser, and elliptic selections are not available.

11.3.1.1 Edit Range Marker Coordinates

By clicking View > Selection Tools > Edit Range Marker Coordinates an edit dialog for editing the range marker

coordinates opens.

Figure 72. Dialog for editing the coordinates of a range marker in the view of a Numerical Data Array or Data Array based

document.

Available options:

ITEM DESCRIPTION

Position / Size Mode If selected, the input values will be one coordinate and size of the range.

Start / End Mode If selected, the input values will be the left coordinate and the right coordinate

of the range.

Position to Enter A P / S M .

The coordinate which is to be set can be specified here.

Left / Right The left or right border coordinate.

Center↔ The center coordinate.

Width The width spanned by the range.

The coordinates are de-

scending.

A note which indicates that the coordinates to be edited are descending co-

ordinates.

11.3.1.2 Edit Rectangular Marker Coordinates

By clicking the ribbon item View > Selection Tools > Edit Rectangular Marker Coordinates an edit dialog for

editing the rectangular marker coordinates opens.
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Figure 73. Dialog for editing the coordinates of a rectangular or elliptic marker in the view of a Numerical Data Array or

Data Array based document.

Available options:

ITEM DESCRIPTION

Position / Size Mode If selected, the input values will be one pair of coordinates and width and

height of the rectangle.

Corner Mode If selected, the input values will be the bottom-left-coordinates and the top-

right-coordinates of the rectangle.

Position to Enter A P / S M .

The pair of coordinates which are to be set can be specified here.

Left / Right The left or right border coordinate.

Bottom / Top The bottom or top coordinate.

Center↔ / Center l The horizontal center or vertical center coordinate.

Width / Height The width or height.

Keep Aspect Ratio If selected, changing the width or height will adapt the corresponding size in

order to keep the aspect ratio constant.

11.3.2 Point Information

If a point marker is visible, the Selections tab of the Property Browser (it is named Point Manipulation for

Harmonic Fields and Harmonic Fields Sets) shows the data at the selected location as shown in Fig. 74.
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Figure 74. Example for using the point marker. In the left, there is a field with activated point marker. The corresponding

values at this position are displayed in the property browser (right).

For complex data, real and imaginary part, amplitude, squared amplitude, and phase are shown. For Light

View (↪→Sec. 12.2.1) and real color display (↪→Sec. 14.2) the RGB values at the current position are shown.

For data array based documents, you can also retrieve interpolated values between adjacent data points if

Selections > Coordinate Snapping Selection in the Property Browser is set to ’false’. Usually the interpolation

method (↪→Sec. 13.2) of the data array is used. If Selections > Use Own Interpolation Method is set to ’false’

instead, nearest neighbor interpolation (or constant interval interpolation, in case of non-equidistant data) will

be used.

For data array based documents there is another, faster access to a point’s value however. One has to hover

the mouse cursor above the point of interest holding the Shift button pressed. A tooltip-kind-of label will

appear then, showing the coordinates currently hovered above as well as the data value(s) at this position as

shown in Fig. 75.
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Figure 75. If the mouse cursor is moved over the view of a data array based document, a tooltip-like label shows value

and coordinates.

11.3.3 Point Manipulation

For Harmonic Fields and Harmonic Fields Sets, single point data may be manipulated via the property browser

tab named Point Manipulation, shown in Fig. 74 (right-hand side). The new value just has to be entered there.

In case of data array based documents, the workflow is different. The values on the Selections tab of the

Property Browser are read-only, but single point values can be edited in the Value at (x, y) tab of the document

view itself as described in ↪→Sec. 13.5.3.

11.3.4 Selection Tools

Within the View > Selection Tools menu there are various selection tools which ease setting up a selection:
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ITEM DESCRIPTION

Select All Sets a rectangle or range marker which includes the whole data.

Center Range / Rectangu-

lar Selection

The center of the selection is set to e. g. (0m; 0m) if both axes have the

physical quantity Length.

Edit RangeMarker Coordi-

nates

Opens a dialog for editing the coordinates of the marker (↪→Sec. 11.3.1.1).

Edit Rectangular Marker

Coordinates

Opens a dialog for editing the coordinates of the marker (↪→Sec. 11.3.1.2).

Detect Rectangular /

Range Selection

Detects a selection containing a given power portion (↪→Sec. 11.3.4.1).

Retrieve Marker Coordi-

nates

for Data Array Based Docu-

ments

Copies the physical coordinates of all markers from another document win-

dow. If a marker to copy does not fully fit into the coordinate ranges of the

axes, it is truncated accordingly. But if it lies completely out of the data, it is not

copied. Note that coordinate snapping (↪→Sec. 11.3.1) and different physical

units might cause the copied markers to be not at the expected location.

Retrieve Rectangular

Marker Coordinates

for Harmonic Fields (Sets)

Copies the physical coordinates of the rectangular (or range) marker from

another document window. If the marker to copy does not fully fit into the

coordinate ranges of the axes, it is truncated accordingly.

The exact coordinates of a selection can also be edited using the Property Browser (↪→Sec. 11.3.2).

11.3.4.1 Detect Rectangular / Range Selection

By using either the ribbon item View > Selection Tools > Detect Rectangular Selection or View > Selection

Tools > Detect Range Selection, the selection within a view can be set to the smallest possible selection which

contains a given portion of the amplitudes sum or the squared amplitudes sum of the whole data. Which of the

two ribbon items is available depends on the dimensionality of the data in the current document.

Figure 76. Dialog for detecting selections (for a Numerical Data Array).

The dialog shown in Fig. 76 allows you to set the following parameters for this operation.
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ITEM DESCRIPTION

Use on Amplitudes /

Use on Squared Ampli-

tudes

Allows you to set whether the amplitudes sum or the squared amplitudes

sum is evaluated. This choice is only available for certain document types

(see below).

Portion of (Squared) Am-

plitudes Sum in Selection

Portion of the (squared) amplitudes sum of the whole data to be contained in

the selection.

Center of Selection You can choose between three options:

• Automatic: No specific center point is used. The algorithm just tries to

minimize the resulting selection.

• Barycenter of Field Values: The selection will be centered around the

barycenter of the field values (= the power center for Harmonic Fields

and Harmonic Fields Sets).

• Window Center: The resulting selection will be in the center of the win-

dow.

Enforce Quadratic Selec-

tion

O

If checked, the number of contained sampling points in x- and y-direction is

equal and odd (which maintains an eventual symmetry better).

Depending on from where this selection tool is executed the names and visibility of the controls men-

tioned above differs. For example Harmonic Fields and Harmonic Fields Sets always contain electric

field strength data. In this case it is more intuitive to use a certain portion of the power of the whole field,

which is proportional to the squared amplitudes sum. Thus:

• For a Harmonic Field you always determine a portion of the power.

• For a Jones Matrix Transmission you always determine a portion of the squared values sum.

• For a complex-valued Numerical Data Array or data array based document you can choose

whether you want to determine a portion of the amplitudes sum or of the squared amplitudes

sum (as described above).

• For a real-valued data array based document you always determine a portion of the values sum.

• For a real-valued Numerical Data Array you can choose whether you want to determine a portion

of the values sum or of the squared values sum.

11.4 Zoom

Availability

Accessible:

• Ribbon: View > Zoom In, View > Zoom Out, View > Show All, View > Zoom Into

Selection, View > Data Restricted Zoom

• Property Browser: see below

• Context menu: Zoom

• Shortcuts: Ctrl++ (numpad) to zoom in, Ctrl+- (numpad) to zoom out, and Ctrl+0 (numpad)
to show all.
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Four operations are available to change the zoom factor:

ITEM DESCRIPTION

Zoom In Increase zoom factor by factor
√

2.

Zoom Out Decrease zoom factor by factor
√

2.

Show All Show the whole field. This is the default for newly created fields.

Zoom Into Selection Set the visible area equal to the current range / rectangle selection.

Center to Origin A H F , H

F S J M T

Centers the view to the coordinate origin (0, 0) in case of 2D data, 0 in case of

1D data, no matter whether or not the origin lies within the coordinate range

of the sampled data. If it lies outside, Data Restricted Zoom is deactivated

automatically.

Data Restricted Zoom A H F , H

F S J M T

Toggles the Data Restricted Zoom state, see Sec. 11.4.1.

Inside the View panel of the Property Browser, you can set the visible view area using the following options:

• Coordinate Range: Allows to set the coordinate range of 1D diagrams directly.

• x-Axis Range / y-Axis Range: Allows to set the coordinate ranges of 2D diagrams directly.

• Zoom Factor: Allows to set the zoom factor, given in Zoom Factor Unit/s. That means that a zoom factor

of z corresponds to z screen pixels covering the physical value range given in Zoom Factor Unit/s.

• Data Restricted Zoom: A H F , H F

S J M T

Toggles the Data Restricted Zoom state, see Sec. 11.4.1.

• Show Rectangle/Markers for Whole Extension: If Data Restricted Zoom is deactivated, this option allows

to toggle the visibility of a rectangular/range marker which shows the domain covered by the actual given

data.

Furthermore, you can use the mouse wheel to zoom in or out by a factor
√

2 at the position of the mouse cursor.

11.4.1 Data Restricted Zoom

With a few exceptions, most of the diagram views provide the feature of toggling the Data Restricted Zoom

state. If activated (the default), the maximum view area for a diagram is the range covered by the underlying

data. So, if the complete domain with defined data is shown, no more zoom out is possible. However, if the

Data Restricted Zoom is deactivated, the user may zoom out (nearly) unlimited. An example is shown in Fig. 77.
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Figure 77. Example for unrestricted zoom out. The actual domain of the underlying data is marked by the magenta rect-

angle (which can be switched off via Property Browser).

Such a view beyond the limits of the data domain provides some benefits: For example, comparing of diagrams

with different domains of definition is much easier. Furthermore, sometimes there is a need to see how the data

are extrapolated outside the actual coordinate range.

11.5 Aspect Ratio

Availability

Accessible:

• Ribbon: View > Aspect Ratio ribbon menu

• Property browser: View > Aspect Ratio (for harmonic fields and harmonic fields sets)

View > True To Scale (for data array based documents)

• Context menu: Aspect Ratio

In views showing two-dimensional data, VirtualLab Fusion supports three ways how the aspect ratio between

the two axes is determined.

ITEM DESCRIPTION

True To Physical Scale The data is displayed on the screen so that the same physical extent on the

x- and y-axis corresponds to the same number of pixels on the screen. That

means the data is displayed as it would be visible within an experiment, with

true to scale representation.

True To Pixel Scale O

Each sampling point of the data is mapped to a pixel square on the screen.

If the vertical and horizontal sampling distances are not equal, the same dis-

tance on the screen in x- and y-direction corresponds to different physical

extents.

Free Aspect Ratio The aspect ratio is chosen for optimal fitting of the data into the document

window. Thus, resizing the document window changes the aspect ratio. The

same distance on the screen in x- and y-direction may correspond to different

physical extents as well as to a different number of sampling points.
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11.6 Copy View to Clipboard

Availability

Accessible:

• Ribbon: View > Copy View to Clipboard

• Context menu: Copy to Clipboard (for harmonic fields and harmonic fields sets)

• Shortcut: Ctrl+C

Copies the current view to the Windows™ clipboard.

For data array based documents the view is copied as shown. In the Global Options dialog (↪→Sec. 6.7) you

can set whether the gray background of the view is copied or transparency is used instead.

For harmonic fields and harmonic fields set you can configure the generated graphics using the dialog described

in the following section.

11.6.1 Copy View to Clipboard (Dialog for Harmonic Fields and Harmonic Fields Sets)

Several options are available for copying a field view to the clipboard, which can be set by using the dialog

shown in Fig. 78. There are several groups of controls within this dialog, which are described in the following.

Figure 78. Dialog to adjust settings for copying a harmonic field view to clipboard.

The controls of the group View to be Copied determine which parts of the harmonic fields view are to be copied

to the clipboard.

ITEM DESCRIPTION

Both 1D and 2D View Copy two-dimensional view and one-dimensional profile line view.

2D View Copy only two-dimensional view.

1D View Copy one-dimensional view.

The following Options group controls which features of the view are included when copying to the clipboard.
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ITEM DESCRIPTION

Copy Axes Determines whether the labels at the corners of the two-dimensional view are

copied.

Copy Selection Marker Determines whether the lines representing the rectangle / range marker

(↪→Sec. 11.3) are copied.

Copy Profile Line Determines whether the red arrow representing the line marker (↪→Sec. 11.3)

in the two-dimensional view is copied.

Copy Point Manipulation

Cross

Determines whether the cross hair representing the point marker

(↪→Sec. 11.3) is copied.

Copy Color Scale Determines whether the legend on the right hand side of the two-dimensional

view is copied.

Copy Grid Lines Determines whether grid lines are copied in the one-dimensional view.

Color of Labels and Axes Edit color of axis lines and labels of one and two-dimensional view.

Color of Grid Lines Color of optional grid lines in one-dimensional view.

A field view can be copied to the clipboard in two different ways: as windows meta file and as bitmap. Since

windows meta file export corresponds to a vector graphics, the graphics is highly resolved. However, for some

target programs, the result of the clipboard import of meta files can look erroneous due to incompatibilities. In

such cases, exporting the view via a bitmap object in the clipboard can give better results.

When using windows meta file clipboard export, the background is always transparent.

ITEM DESCRIPTION

Convert to Bitmap Bitmap mode of clipboard copying.

Bitmap Size Size of the generated bitmap in pixels.

Preserve Aspect Ratio of

View

If checked, the bitmap size in X and Y direction are coupled for ensuring that

the aspect ratio of the view is maintained.

Background Color Background Color to be used in the bitmap.

11.7 Graphics Add-Ons

Availability

Only for data array based documents.

Accessible:

• Ribbon: View > Configure All

All data array (based) views may show additional information, called ”graphics add-ons” or simply ”add-ons”,

which overlay the actual data. These add-ons may e.g. be regions, point clouds, polarization ellipses etc. If

there are more than one add-on, all are layered in an order which can be user-specified.

The ribbon button Graphics Add-ons > Configure All calls the dialog shown in Fig. 79 which allows to con-

figure all contained graphics add-ons.
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Figure 79. Dialog for configuring the graphics add-ons of a view.

ITEM DESCRIPTION

Index The layer index. Index #1 corresponds to the bottom layer which is drawn

above the data first. The row with the highest index will be the upmost layer

which is drawn at last.

Up/Down Moves the add-on up or down in the layer order.

Name Name of the add-on.

Subsets Shows for which subsets the add-on is available.

Visible Allows to show or hide the add-on.

Appearance Opens another dialog for editing the individual view settings for the add-on.

See Sec. 11.7.1-Sec. 11.7.3.

11.7.1 Configuration of Common Graphics Add-ons

Figure 80. Dialog for configuring the view settings of common graphics add-ons like regions or meshes.

ITEM DESCRIPTION

Draw Border If checked, a border will be drawn.

Border Color If Draw Border is selected, this sets the color of the border line.

Border Width If Draw Border is selected, this sets the width of the border line.

Draw Filling If checked, the shown areas will be filled.

Filling Color If Draw Filling is selected, this sets the color of the filling.

Filling Opacity If Draw Filling is selected, this sets the opacity of the filling: 0% means full

transparency, 100% will create completely non-transparent fillings.
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11.7.2 Configuration of Point Cloud Add-Ons

Figure 81. Dialog for configuring the view settings of point cloud add-ons.

ITEM DESCRIPTION

Dot Size The size of the points.

Color The color of the points.

11.7.3 Configuration of Polarization Ellipse Add-Ons

Figure 82. Dialog for configuring the view settings of polarization ellipses.
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ITEM DESCRIPTION

Line Width The thickness of the drawn lines.

Draw Arrows If chosen, the Direction of Rotation will be indicated by small arrows.

Different Colors If chosen, the Direction of Rotation will be indicated by different colors.

Clockwise Color If Different Colors is selected, this sets the color for clockwise ellipses.

Counterclockwise Color IfDifferent Colors is selected, this sets the color for counterclockwise ellipses.

Minimum Cell Size

(Screen Pixels)

Size on the screen which shall be occupied by the ellipses at least. If the

zoom factor is high enough, the ellipses of each single sampling point are

shown and may be even larger than this minimum size. Please see the note

below for more information.

Extraction via Nearest

Neighbor / Average

If an extraction is necessary because more than one sampling point is cov-

ered by Minimum Cell Size (Screen Pixels), this parameter determines the

extraction strategy. Either only the point with the position nearest to the el-

lipse’s center is used alone or the Jones vectors of all points covered by the

cell are averaged. Please see the note below for more information.

Draw Grid If chosen, a grid indicates the areas each ellipse is calculated from.

Grid Color If Draw Grid is selected, this sets the color of the grid.

Note on the extraction (calculation) of the shown polarization ellipses:

It is only possible to see every single polarization ellipse in the data if the zoom factor is high enough. Only if the

display of a single sampling point occupies a minimum number of screen pixels, there is enough space to draw

the ellipse which corresponds to this sampling point. This case can be seen in Fig. 83, on the left-hand side.

The (cell) size which shall be used to draw an ellipse at least can be set in the view settings dialog: Minimum

Cell Size (Screen Pixels).

In many cases the minimum screen area to draw an ellipse will cover more than one single sampling point.

This is shown in Fig. 83, on the right-hand side. There are two possibilities for determining the contributions of

the sampling points to each ellipse: Either the average Jones vector of all covered points is used to calculate

the ellipse or only that sampling point is used which is located nearest to the ellipse’s center position. These

alternatives can be chosen in the view settings dialog by selecting either Extraction via Average or Extraction

via Nearest Neighbor.

Figure 83. The display of the polarization ellipses depends on the zoom factor. Left-hand side: The zoom is large enough

to show each single ellipse for each sampling point. Right-hand side: For a smaller zoom factor, the ellipse is extracted

(either via averaging or by nearest neighbor selection) from the points covered by the minimum ellipse cell size.
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11.8 Suppressing Numerical Phase Artifacts

Availability

Only available for Harmonic Fields, Harmonic Fields Sets, Numerical Data Arrays or Data Arrays with

the physical meaning Electric Field or Electromagnetic Field (↪→Sec. 24.1.4). This feature applies only

if either the phase is shown as field quantity (↪→Sec. 11.1) or if polarization ellipses (↪→Sec. 12.2.2.3,

↪→Sec. (c)) are visible.

Accessible:

• Ribbon: View > Hide Phase Artifacts

• Property browser: View > Hide Phase Artifacts

• Context menu: Hide Phase Artifacts

11.8.1 Numerical Artifacts in Phase View of Diagrams

Some calculations produce numerical inaccuracies in the real and imaginary part of complex numbers. The

phase φ of a complex number may be sensitive to such inaccuracies due to its dependence on both of these

parts. In VirtualLab Fusion the phase is defined as follows:

φ =



arctan
(
Im
Re

)
: Re > 0

arctan
(
Im
Re

)
+ π : Re < 0 and Im > 0

arctan
(
Im
Re

)
− π : Re < 0 and Im ≤ 0

+π
2 : Re = 0 and Im > 0

−π
2 : Re = 0 and Im < 0

0 : Re = 0 and Im = 0

Normally there is no visible effect on a diagram view of these data because of the very small magnitude of

numerical inaccuracies, but there are two cases where artifacts in the phase values may appear:

1. If both the real and the imaginary part are nearly zero (i. e. the amplitude is nearly zero too), these

inaccuracies have consequences for the phase (due to the fraction (Im/Re) in the arctangent), though
not for the amplitude

(
Re2 + Im2 ≈ 0

)
. So despite the vanishing amplitude the phase has randomly

distributed values.

2. If the real part is less than zero but the imaginary part is nearly zero (−ε < Im < +ε), the amplitude is

not affected
(
Re2 + Im2 ≈ Re2

)
, but the phase is (see case no. 2 and no. 3 in the definition of φ above).

Thus the phase jumps accidentally between π and −π.

An artifacts threshold t can be set in the View panel of the property browser.

This parameter t has the following meanings:
1. A phase value in a diagram is displayed as zero if its amplitude value A satisfies A < t · Amax, where

Amax is the maximum amplitude value in the data.

2. The phase value is displayed as −π in the display if its imaginary part value Im satisfies t ·Re < Im < 0.
If Hide Phase Artifacts is activated for a diagram view, both conditions will be tested and the view will hide these

kinds of artifacts. The data of the field document itself will remain unchanged.

11.8.2 Numerical Artifacts in Polarization Ellipses

If the amplitude for both of the vectorial components used for calculating a polarization ellipse is nearly zero,

numerical artifacts have a strong effect on that ellipse.
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So these artifacts can be suppressed as well: Polarization ellipses are calculated only if the amplitudes of both

of the respective vectorial components are below t · Amax, where Amax is the maximum amplitude over the

complete data of both vectorial components.

In case of ellipses shown in a Harmonic Field view or a Harmonic Fields Set view (↪→Sec. 12.2.2.3), the threshold

t can be set dynamically via property browser.
If polarization ellipses shall be calculated by an EM detector (↪→Sec. 74.4.5.1) or as a manipulation for an

already existing electric or electromagnetic field (↪→Sec. 32.3), then the threshold has to be specified in the

respective dialog.

11.8.3 Default Settings for Suppression of Numerical Phase Artifacts

In the Global Options dialog (↪→Sec. 6.11), one can set whether phase artifacts are hidden by default and set a

default threshold t as well.

12 Harmonic Fields and Harmonic Fields Sets

12.1 Harmonic Field Data

For locally polarized harmonic fields the two electric field components Ex and Ey are stored, from which all other

field components can be reconstructed. For globally polarized fields, only the scalar field U(x, y) (↪→Sec. 131.1)
is stored.

The field data are stored as field values on an equidistantly sampled grid. The number of sampling points

in x- and y-direction, Nx and Ny can be chosen freely in the x- and y-direction respectively. For storing two-

dimensional fields both Nx and Ny are greater than 1. One-dimensional fields are typically stored with Ny = 1.
More technical notes can be found in Sec. 131.

The Data tab of the property browser (Current Data for harmonic fields sets) allows you to view and alter these

settings, among others:



CHAPTER 12. HARMONIC FIELDS AND HARMONIC FIELDS SETS 144

ITEM DESCRIPTION

Complex Amplitude Type Shows whether the field is locally or globally polarized and whether it is in

spatial or spectral domain.

Embedding Material The material of the homogeneous medium in which the field is defined.

Jones Vector O

Allows you to change the Jones vector. ↪→Fig. 84

Wavelength With this parameter you can change the wavelength of the field.

Is Complex Shows whether the imaginary part is stored as explained above.

Array Size Allows you to change the overall size of field. The number of sampling points

and the actual data remains unchanged.

Sampling Distance Allows you to change the distance between consecutive sampling points. The

number of sampling points and the actual data remains unchanged.

Sampling Points Shows the number of sampling points. To change it, use the interpolation

manipulation described in Sec. 22.8.1.

Has Spherical Phase Ra-

dius

An analytical stored spherical phase factor allows to not fully sample a spher-

ical phase and thus reduce the number of required sampling points. With this

property you can remove or set this analytical factor. The overall phase is not

changed by this as long as the sampling is sufficiently fine.

Spherical Phase Factor With this setting you can change the analytically stored spherical phase factor.

The overall phase is not changed by this as long as the sampling is sufficiently

fine.

This tab is only available in the data view of harmonic fields or harmonic fields sets.

Figure 84. How to edit the Jones vector via the property browser. The controls of the resulting dialog are the same as for

setting the Jones vector of a newly generated field, ↪→Sec. 48.3.

12.1.1 Spherical Phase Radius

Sampling of a large spherical phase (e. g. a lens with short focal length) would require a very small sampling

distance and thus many sampling points for correctly sampling the spherical phase in the border areas of the

field. Therefore, VirtualLab Fusion can handle the spherical phase radius as a separate factor multiplied to the

sampled aberrations of the spherical phase. This means that the sampling distance has to be chosen only for

accurate sampling of the aberrations.

Many of the internal operations of VirtualLab Fusion, as for example the homogeneous medium propagation

operators (↪→Sec. 93), take into account the stored spherical phase radius.

In harmonic fields sets, a separate spherical phase radius is stored for each harmonic field. Thus, spherical

phase radius functions are not available in the light view of harmonic fields sets.

For newly created harmonic fields, VirtualLab Fusion detects and stores the spherical phase radius automati-

cally.
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If you want to change this stored value, you can use several entries in the Manipulations > Phase Manipu-

lations ribbon item:

• Set Analytical Parameter: Sets the analytical spherical phase radius to a new value. The corresponding

dialog is explained in Sec. 22.5.2.

• Remove Analytical Parameter: Removes the analytical spherical phase radius.

These manipulations do not change the resulting phase, at least as long as the sampling distance is fine enough

for the new aberrations (phase minus analytical spherical phase radius).

The property browser (↪→Sec. 4) offers similar functionality: In theData panel (for harmonic fields) or theCurrent

Data panel (for harmonic fields sets), you can set Has Spherical Phase Radius to false or true. Setting to false

corresponds to removing the spherical phase radius. Furthermore you can set the Spherical Phase Radius.

If you want not only to remove the stored value, but also the spherical phase information present in the sam-

pled phase data, you can use the entry Manipulations > Phase Manipulations > Remove Sampled Spherical

Phase. Manipulations > Sampling Manipulations > Resample According to Spherical Phase allows to re-

sample a field so that the spherical phase radius can be removed without resulting undersampling. Detectors

> Spherical Phase Radius detects the optimal value of the spherical phase radius.

How the spherical phase radius is determined from sampled data is describe in Sec. 137.6.

12.2 View for Harmonic Fields and Harmonic Fields Sets

The view of both Harmonic Fields and Harmonic Fields Sets is divided into two tab pages: the Light View

(↪→Sec. 12.2.1) which displays the field as the eye or a camera would see it, and the Data View (↪→Sec. 12.2.2)

which shows directly the data.

These documents allow you to use markers and selections (↪→Sec. 11.3), zoom into the view (↪→Sec. 11.4),

change its aspect ratio (↪→Sec. 11.5), copy the view to clipboard (↪→Sec. 11.6).

Furthermore, View > Copy View Settings allows you to copy the view settings (value scaling, markers and

so on) from another matching document window.

If a line marker (↪→Sec. 11.3) is shown for two-dimensional fields, also a one-dimensional cross section is shown

in one common view window (↪→Fig. 85).

Figure 85. Harmonic Field View with Profile Line.
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A Harmonic Fields Set usually contains more than one harmonic field. Its light view shows the incoherent

superposition of all member harmonic fields.

12.2.1 Light View

Figure 86. Example of a two-dimensional light view.

The light view shows the light distribution close to reality. This means that the complex amplitude visible in the

data view is

• embedded in a zeroized field (if Use Embedding Frame for Light View is switched on in the Global Options

dialog, ↪→Sec. 6.11),

• interpolated with cubic 8 point interpolation to smooth the data, and

• set to summed squared amplitudes as field quantity (Sec. 11.1).

For two-dimensional light views, you can switch between two modes in the ribbon:

ITEM DESCRIPTION

Visual Perception The (non-linear) perception of the human eye is simulated. For single har-

monic fields the color is directly calculated from the wavelength. This means,

that infrared (> 830 nm) and ultraviolet fields (< 360 nm) are not visible in

this mode. For harmonic fields sets, the resulting color at a certain position is

calculated from the wavelengths of the single harmonic fields, weighted ac-

cording to their amplitude at this position. This display uses the Bitmap class

provided by Aurigma for appropriate colors.

Linear Intensity Detec-

tion

The data is shown as you would see it with a linear detector. You can choose

the color table (↪→Sec. 11.2.4) for this mode.

In the visual perception mode, most view settings are not available. However, you can set the brightness as

described in Sec. 11.2.6. In the linear detection mode, you can set the color table (↪→Sec. 11.2.4) and the

scaling mode (↪→Sec. 11.2.5). Furthermore, View > Show Legend allows you to switch off the legend for the

two-dimensional view.

The calculation of the light view of a newly created harmonic field can be very time consuming, especially for

harmonic fields sets. During this calculation, the following screen appears:

http://www.aurigma.com
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Figure 87. Light View during calculation.

At this stage, you can continue working as the light view calculation is done in the background. However, if you

want to save CPU power for more important calculations, you can press Cancel. Then on the light view tab the

following text is shown:

Figure 88. Light View if calculation has been aborted or not yet started because it was disabled in the Global Options.

As you can see, it’s possible to Restart the light view calculation. If you want the light view to be disabled by

default, you can do so in the global options dialog (Sec. 6.11). Then the light view tab of a newly created field

document looks similar to Fig. 88, i. e. it’s possible to start the light view calculation manually. Furthermore, the

light view tab looks similar to Fig. 88 if the calculation is aborted due to lack of RAM.

12.2.2 Data View

The data view shows directly the data arrays (↪→Sec. 131). It allows you to set the shown field quantity

(↪→Sec. 11.1), show polarization information (↪→Sec. 12.2.2.3), and adjust the value scaling (↪→Sec. 11.2). Fur-

thermore, View > Show Legend allows you to switch off the legend for the two-dimensional view. Additional

features for the data view are described in the following subsections.
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12.2.2.1 Harmonic Field Selection

Availability

For Harmonic Fields Sets

Accessible:

• Ribbon: View > Harmonic Field Selection ribbon group (see below)

• Property browser: Document > Current Member

In the ribbon you can go through all harmonic fields within a Harmonic Fields Set with the control shown in

Fig. 89, either by using the arrow buttons or by entering the index of the harmonic field directly.

Figure 89. The controls to select an harmonic field in the ribbon.

12.2.2.2 Vectorial Component

Availability

Accessible:

• Ribbon: View > E-Field ribbon group

• Property browser: View > Vectorial Component

• Context menu: Vectorial Component

If the field quantity (↪→Sec. 11.1) is not set to Summed Squared Amplitudes, one of the three vectorial compo-

nents Ex, Ey, or Ez can be selected for being displayed within the data view.

In VirtualLab Fusion Ez is calculated according to

Ez(x, y) =
[
F -1

(
− 1

kz

(
kx · [F Ex(x, y)](kx, ky) + ky · [F Ey(x, y)](kx, ky)

))]
(x, y) . (12.1)

where F denotes a Fourier transform and F -1an inverse Fourier transform.

12.2.2.3 Polarization

Availability

Accessible:

• Ribbon: View > Polarization ribbon group

• Property browser: View > Show Polarization

• Context menu: Polarization

In the data view, it’s possible to display the polarization of harmonic fields or fields sets in three different modes.
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MODE DESCRIPTION

Ellipses Ellipses are drawn over the data view as shown in Fig. 91. This display mode

shows the complete polarization ellipses, but only with coarse sampling.

Angles of Ellipses Shows the angles of the major axis of the ellipses to the x-axis with finer

sampling.

Eccentricities of El-

lipses

Shows the (numerical) eccentricity e of the ellipses with finer sampling.

For all these modes you can specify the plane for which you want to see the polarization via a combobox. If

you select the currently selected polarization display mode again, you switch off the polarization view – which

can also be done in the property browser via View > Show Polarization group > Show.

You can open a dialog with specific polarization view settings (↪→Fig. 90), either via the context menu (Polar-

ization > View Settings) or the launcher button of the View > Polarization ribbon group.

Figure 90. Dialog for changing the polarization view settings.

Figure 91. Example of a data view with polarization ellipses.

This dialog has the following items:
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ITEM DESCRIPTION

Show Polarization Toggles the display of any Polarization Display Mode on or off.

Polarization Display Mode As described above, there are three polarization display modes: Polarization

Ellipses, Angles of Ellipses, and Eccentricities of Ellipses.

Show Grid Displays a grid between the Polarization Ellipses.

Show Arrows Displays arrows which indicate the rotational direction of the electrical field

vector Exy vector in the Polarization Plane.

Scaling Factor to scale up and scale down the polarization ellipses. The standard

value is 1.0, the minimum value is 0.5.

Polarization Plane The plane for which the polarization is displayed.

Default values for these settings can be defined in the Harmonic Field View tab of the Global Options dialog

(↪→Sec. 6).

The display of the polarization is influenced by the phase artifacts setting (↪→Sec. 11.8).

12.2.2.4 Norm and Power

The View panel of the property browser of harmonic fields and harmonic fields sets has the section Norm and

Power. This section contains the following entries:

ITEM DESCRIPTION

Norm in Selection Shows the norm N within the current selection for the displayed vectorial

component (↪→Sec. 12.2.2.2). See Sec. 75.4.7 for details on the calculation

of the norm N. Furthermore the ratio between Norm in Selection and Norm of

Whole Component is shown in percent. This entry is only shown if a selection

is visible (↪→Sec. 11.3.4).

Norm of Whole Compo-

nent.

Shows the norm N of the displayed vectorial component as defined in

Sec. 75.4.7.

Power in Selection (Com-

ponent)

This value is calculated from the Norm in Selection and Eq. (12.2). Further-

more the ratio between Power in Selection (Component) and Power in Whole

Component is shown in percent. This entry is only shown if a selection is

visible.

Power in Selection (Field) Sum of Power in Selection (Component) for both Ex- and Ey-component. Fur-

thermore the ratio between Power in Selection (Field) and Power in Whole

Field is shown in percent. This entry is only shown if a selection is visible.

Power in Whole Compo-

nent

This value is calculated from the Norm of Whole Component and Eq. (12.2).

Power in Whole Field Sum of Power in Whole Component for both Ex- and Ey-component.

The power properties are not shown for harmonic fields and harmonic fields sets in spectral domain.

From a given norm N of a certain region the power P is calculated as

P = n
ε0

2
cδxδyN (12.2)

with δx is the sampling distance in x-direction and δy is the sampling distance in y-direction. For one-dimensional
fields the sampling distance in the unmodulated direction is assumed to be 1 meter. n is the refractive index

derived from the Embedding Medium of the field, ε0 is the dielectric constant and c is the vacuum speed of light.



CHAPTER 13. DATA ARRAYS 151

13 Data Arrays

Data Arrays are designed as containers for any data that represent mappings from any N-dimensional real

space RN (more specific from a domain X ⊂ RN) to any M-dimensional complex space CM (more specific to

a co-domain Y ⊂ CM). An example is shown in Fig. 92 for N = 2 and M = 3.

Figure 92. Example for mapping R2 → C3.

The components x1, x2, . . . , xN of the variable x ∈ X are usually called “coordinates”, while y ∈ Y is named

“dependent variable” or simply “data”. Each set of all values of a certain dimension Yi = yi(x1, x2, . . . , xN)(1 ≤
i ≤ M) is called “Data Array Subset” or “Data Subset”.

Although not all data structures in VirtualLab Fusion are based on Data Arrays at the moment, we plan to

introduce them systematically and successively as standard data container.

The most important types of data arrays are gridded 1D and 2D data as illustrated in Fig. 93 and Fig. 94. They

show equidistantly sampled data, which is no restricting condition for Data Arrays in general.
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Figure 93. Example for equidistant 1D Data Array.
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Figure 94. Example for equidistant 2D Data Array.

For small N as in the figures Fig. 93 (N = 1) and Fig. 94 (N = 2), the notations for the variables usually

differ slightly: For 1D data the coordinate is called x and the data variable is y, while for 2D data usually the

coordinates are marked by x and y, whereas the dependent variable is called z.
In some cases, two-dimensional data are not distributed on a grid but completely irregular (↪→Fig. 95). We

call this type Gridless Data Array. Gridless Data Arrays may contain several subsets, same as gridded (i. e.

equidistant and non equidistant) ones. No interpolation is available for this kind of array.

Figure 95. Example for a Gridless Data Array.

The view for data arrays is explained in Sec. 13.5.

13.1 Types of Data Arrays

In many cases, there is no specific physical meaning associated with a Data Array. Although coordinates and

subset values got physical units (↪→Sec. 5.1, ↪→Sec. 24.4, ↪→Sec. 24.5.1), the object itself is not interpreted as

having a physical meaning in any case.

Nonetheless, in some cases such a specific meaning is given to a Data Array. An Electric Field object is such

a Data Array with a specific interpretation. Whether or not there is a physical meaning given to a data array is

indicated by its caption, as shown in Fig. 96. All general, i.e. non-specific, Data Arrays are called Numerical

Data Arrays and got a gray caption. All other Data Array objects have a different, type specific caption color.
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Figure 96. Example for two different types of Data Arrays. Left: Numerical Data Array. Right: Electric Field.

The most important difference in handling between Numerical Data Arrays and more specific Data Arrays is

the availability of manipulations (↪→Sec. 24). The handling of specific Data Arrays is restricted to features and

properties which make sense for the given physical meaning type.

13.2 Interpolation Methods

Distinct interpolation methods are available for equidistant and non-equidistant data arrays. For two-

dimensional data arrays, the described rules are applied separately to x- and y-direction, respectively.

The interpolation methods for non-equidistant data are given in Sec. 13.2.1, the interpolation methods for

equidistantly sampled data in Sec. 13.2.2.

13.2.1 Interpolation Methods for Non-Equidistant Data

If the data array does not contain equidistantly sampled data, there are two different non-equidistant interpola-

tion methods available: Constant Interval interpolation and Linear interpolation.

In case of complex data, a Real Part / Imaginary Part linear interpolation is distinguished from an Amplitude /

Phase linear interpolation. This is due to the fact that, generally, a linear interpolation on real part and imaginary

part doesn’t result in a linear interpolation in amplitude and phase and vice versa.

The principle of the non-equidistant interpolation methods is shown in Fig. 97.
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Figure 97. The two non-equidistant interpolation methods. In case of Constant Interval interpolation (upper part a)), each

data point at coordinate xi defines a constant value for the interval [xi, xi+1[. The value x∗ marks the upper limit of the last
coordinate interval.

The coordinate extent (colored in light green) is identical to that coordinate range where interpolation is possible. Values

outside the coordinate extent (i.e. lying in the range colored in pale violet) are accessible via extrapolation (Sec. 13.3). In

this example, a Constant with Value extrapolation is shown, using a constant value of ye. Please note that ye is used for
the linear interpolation in the interval [xN , x∗[ as well (lower part b)).

13.2.2 Interpolation Methods for Equidistant Data

From the interpolation methods explained in detail in Sec. 131.4, for performance reasons only the following

can be used for the view of data arrays:

• Nearest Neighbor Interpolation

• Linear (Amplitude/Phase): Only for complex-valued data.1

• Linear (Real/Imaginary Part)

• Cubic 4 Point

• Cubic 6 Point

• Cubic 8 Point

• Truncated Sinc

The appropriate interpolation method has to be chosen according to the physical meaning of the data which

1 Generally, a linear interpolation on real part and imaginary part doesn’t result in a linear interpolation in amplitude and phase and vice

versa.
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shall be interpolated, and according to the acceptable computational effort. It can be changed for example with

the manipulation explained in Sec. 24.4.

13.3 Extrapolation

In certain circumstances, it is possible that a Data Array has to deliver values outside its coordinate range (aka.

coordinate extent).

The following extrapolation modes are available (for equidistant as well as non-equidistant data):

• Equal to the Nearest Border Data Point: A constant extrapolation of the outmost data points is done.

• Zero: All outlying points are considered to be of value 0.

• Constant with Value: All outlying points are considered to be of a value to be specified by the user.

• Periodically Continued: The whole data of the array are periodically continued, using a period of the

array’s ’coordinate extent’.

13.4 Import of Data Arrays

For a variety of equidistantly sampled data an import into VirtualLab Fusion is possible. This data will be

converted into a DataArray which can be used for many different purposes then. This kind of import is described

in Sec. 121.2.

13.5 Data Array View

There are three types of Data Arrays, each having a different view.

TYPE DESCRIPTION

Data Array 1D Data are distributed over one-dimensional coordinates. From this data, inter-

polation methods can create a continuous function.

Data Array 2D Data are distributed over a two-dimensional grid. From this data, interpolation

methods can create a continuous function.

Gridless Data Array The data are given at arbitrary positions in a two-dimensional plane. Either

the data are shown non-interpolated which results in a dot diagram. If mesh

data are available, a linear interpolation inside themesh triangles can be used

as well.

The document window of a Data Array consists of three panels: the Diagram panel (↪→Sec. 13.5.1), the Table

panel (↪→Sec. 13.5.2), and the Value at (x,y) (↪→Sec. 13.5.3) panel. The latter is not available for Gridless Data

Arrays.

13.5.1 Diagram Panel

The Diagram panel contains a diagram that visualizes the contained data. There are different views for Data

Arrays 1D, Data Arrays 2D, and Gridless Data Arrays, respectively, see Fig. 98 to Fig. 101.

These views allow you to

• specify which subset is to be shown (↪→Sec. 13.5.1.1)

• set the shown field quantity (↪→Sec. 11.1)

• switch between interpolated and non-interpolated view (↪→Sec. 11.2.1)

• set the scaling mode (↪→Sec. 11.2.5)

• use markers and selections (↪→Sec. 11.3)

• zoom into the view (↪→Sec. 11.4)
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• change its aspect ratio (↪→Sec. 11.5) and

• copy the view to clipboard (↪→Sec. 11.6) .

In case of Data Arrays with more than one subset, the ribbon button View > Equalize Scaling switches the

scaling mode for the current Field Quantity to User-Defined Scaling (↪→Sec. 11.2.5) and copies the value range

of the currently shown subset to all other subsets.

Furthermore the appearance of the diagrams can be adjusted in the following ways via the View tab of the

Property Browser.

ITEM DESCRIPTION

Font Size of Axis Labels The size of the axis labels and tick labels in points.

Font Size of Title The size of the title in points.

Format The format for the label and the tick values of the respective axis can be

specified here as Engineering where a prefix in front of the unit is used, or as

Scientific where an exponential description is used, or as Standard where SI

units and thus no prefixes are used.

For the settings which are specific for 1D Data Arrays see Sec. 13.5.1.2, for 2D Data Arrays see Sec. 13.5.1.3

and for Gridless Data Arrays see Sec. 13.5.1.4.

Figure 98. Example for a Cartesian diagram view of a 1D data array.

Figure 99. Example for a polar diagram view of a 1D data array.
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Figure 100. Example for the diagram view of a 2D data array in 2D mode, including a profile line (↪→Sec. (b)).

Figure 101. Example for the diagram view of a gridless data array.

13.5.1.1 Subset Selection

Availability

For data arrays with more than one subset and disabled Multigraph Mode (in case of 1D data)

Accessible:

• Ribbon: View > Subset Selection group (see below)

• Property browser: View > Subset Index

• Context menu: Data Subset Index

• Shortcuts: Page Up and Page Down

In the ribbon you can go through all subsets of a data array with the control shown in Fig. 102, either by using
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the arrow buttons or by entering the subset index directly. Below this control the description of the current

subset is given.

Figure 102. The controls to select a specific subset in the ribbon.

13.5.1.2 Specific View Features for 1D Data Arrays

(a) Cartesian 1D Diagram in Singlegraph Mode

The ribbon item View > Multigraph Mode allows to switch between the display of one single subset and

multiple subsets ↪→Sec. (b) if more than one subset is given.

View > Axes Options > Descending Coordinates (x-Axis) allows to show an inverted coordinate axis.

The item View > Axes Options > Transposed View will swap the directions of the independent (x-) and the

dependent (y-)axis.

The ribbon item View > Axes Options > Logarithmic Scaling (x-axis) toggles between a logarithmic and a

linear scaling of the coordinate axis if the complete coordinate range is positive.

View > Axes Options > Logarithmic Scaling (y-axis) is a switch between a logarithmic and a linear scaling

of the y-axis if the values to be displayed are completely positive.

The following specific parameters can be set via the View tab of the Property Browser:

ITEM DESCRIPTION

General > Show Polar Dia-

gram

O .

Switches between a polar diagram view (↪→Sec. (c)) and a Cartesian diagram

view.

General > Transposed

View

If True, the vertical axis and the horizontal axis of the diagram will be trans-

posed. The independent variable will then be shown in the vertical direction.

General > Legend Visible O .

The visibility of the legend for the color which visualizes undefined values can

be set here.

Lines and Symbols > Line

Color

Color of line which connects the displayed data points. If set to Transparent,

the line will not be shown.

Lines and Symbols > Line

Thickness

Thickness of line which connects the displayed data points. Has to be a pos-

itive integer.

Lines and Symbols >

Symbol Color

O S S N S .

Color of the symbols which mark the data points.

Lines and Symbols >

Symbol Scaling Factor

O S S N S .

The size of the symbols (except Small Dot) can be scaled using this factor.

Lines and Symbols >

Symbol Shape

Shape of the symbols which mark the data points. If set to No Symbol, sym-

bols will be switched off.

Lines and Symbols > Use

Smoothed Graphics

If activated, the graphics will be smoothed. Usually, this may improve the

diagram. But if a stepped line is shown, deactivating this property may yield

a better result. Important: This smoothing is done on pixel level. This pixel

smoothing is not to be confused with the smoothing interpolation methods

described in Sec. 11.2.2!
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Lines and Symbols >

Alignment of Undefined

Color Legend

O .

Allows to set the position of the legend for the color which visualizes undefined

values within the diagram.

Lines and Symbols >

Color for Undefined Value

O .

Color to be used for visualizing undefined values.

Lines and Symbols >

Opacity for Undefined

Value

O .

The opacity of the visualization of undefined values can be set here.

Multigraph Options >

Multigraph Mode

O .

Via the Multigraph Mode it is possible to switch between the display of one

single subset and multiple subsets. ↪→Sec. (b)

X-Axis > Descending Co-

ordinates

If selected, the diagram will be shown with descending coordinates. Other-

wise the coordinates will be ascending.

X-Axis > Logarithmic

Scaling

If set to True, the x-axis scaling will be logarithmic instead of linear.

X-Axis > Minimum Num-

ber of Ticks

A guiding value for the automatic tick labeling of the x-axis can be set here.

The axis will have at least the number of ticks which is set by this value.

Y-Axis > Description If Is Description User Defined is set to True, a user-defined axis label can

be set here. Otherwise the currently shown subset’s description is displayed

here.

Y-Axis > Is Description

User Defined

If True, a user defined label can be set instead of showing a label based on

the respective subset description.

Y-Axis > Logarithmic

Scaling

If set to True, the y-axis scaling will be logarithmic instead of linear.

Y-Axis > Minimum Num-

ber of y-Axis Ticks

A guiding value for the automatic tick labeling of the y-axis can be set here.

The axis will have at least the number of ticks which is set by this value.

Y-Axis > Read Labels

from Inside

The orientation of the y-axis labels can be specified here.

(b) Cartesian 1D Diagram in Multigraph Mode

Availability

For data arrays with more than one subset

Accessible:

• Ribbon: View > Multigraph Mode

• Property browser: View > Multigraph Options > Multigraph Mode

TheMultigraph Mode allows to display more than one subset at once in the diagram of a 1D DataArray. Fig. 103

shows an example.
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Figure 103. Example for the Multigraph Mode.

Figure 104. Dialog for configuring the Multigraph Mode.

Via View > Subset Settings, the Multigraph Mode can be configured. The dialog shown in Fig. 104 provides

the following settings:
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ITEM DESCRIPTION

Graphs > Subset # The index of the subset represented by that table row.

This column is read-only.

Graphs > Description The description of the subset.

This column is read-only. (Sec. 24.5.1 shows how to edit the description.)

Graphs > Physical Prop-

erty

The physical property of the subset.

This column is read-only. (Sec. 24.5.1 shows how to edit the physical prop-

erty.)

Graphs > Ordinate This option allows to choose whether the curve shall be associated to the

Left-Hand y-axis, the Right-Hand y-axis or shall be <Not Displayed> at all.

Important: All subsets to be displayed with respect to the same axis has to

have the same physical property! Furthermore, there has to be one subset

for the left-hand y-axis at least.

If the button is pressed, the synchronization of the ordinate is enforced for

all subsets.

Graphs > Color This allows to select a color for the curve which represents the subset. Ini-

tially, it is identical to the color of the associated y-axis in order to depict the

association.

If the button is pressed, the synchronization of the color is enforced for all

subsets.

Graphs > Symbol A symbol for displaying the data points can be selected here.

If the button is pressed, the synchronization of the symbol is enforced for

all subsets.

Graphs > Dash Pattern This allows to select a dash pattern for the curve which represents the subset.

If the button is pressed, the synchronization of the dash pattern is enforced

for all subsets.

Ordinates > Left ⁄ Right

Axis > Rename?

If this button is pressed, a user-defined Description can be set for the respec-

tive ordinate.

Legend > Visible The visibility of the graphs legend can be set here.

Legend > Alignment A .

The position of the legend inside the diagram can be set.

Legend > Opacity A .

The legend’s opacity in the range between 0 and 100%.

The ribbon item View > Show Legend allows to toggle the visibility of the multigraph legend. In case of

undefined values in the diagram, the visibility of the legend for the color which visualizes undefined values is

toggled as well.

View > Axes Options > Descending Coordinates (x-Axis) allows to show an inverted coordinate axis.

The item View > Axes Options > Transposed View will swap the directions of the independent (x-) and the

dependent (y-)axis if no right-hand axis is used.

The ribbon item View > Axes Options > Logarithmic Scaling (x-axis) toggles between a logarithmic and a

linear scaling of the coordinate axis if the complete coordinate range is positive.

View > Axes Options > Logarithmic Scaling (Left / Right y-axis) is a switch between a logarithmic and a

linear scaling of the left-hand (or right-hand) y-axis if the values to be displayed are completely positive.

In multigraph mode, there are several specific settings accessible via the View tab of the Property Browser:
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ITEM DESCRIPTION

General > Show Polar Dia-

gram

O .

Switches between a polar diagram view (↪→Sec. (d)) and a Cartesian diagram

view.

General > Transposed

View

O - - .

If True, the vertical axis and the horizontal axis of the diagram will be trans-

posed. The independent variable will then be shown in the vertical direction.

General > Legend Visible The visibility of the multigraph legend can be toggled here. Furthermore, in

case of undefined values in the diagram, the visibility of the legend for the

color which visualizes undefined values is toggled as well.

Lines and Symbols > Line

Thickness

Thickness of the lines which connect the displayed data points of one subset.

Has to be a positive integer.

Lines and Symbols >

Symbol Scaling Factor

O S S N S .

The size of the symbols (except Small Dot) can be scaled using this factor.

Lines and Symbols > Use

Smoothed Graphics

If activated, the graphics will be smoothed. Usually, this may improve the

diagram. But if a stepped line is shown, deactivating this property may yield

a better result. Important: This smoothing is done on pixel level. This pixel

smoothing is not to be confused with the smoothing interpolation methods

described in Sec. 11.2.2!

Lines and Symbols >

Alignment of Undefined

Color Legend

O .

Allows to set the position of the legend for the color which visualizes undefined

values within the diagram.

Lines and Symbols >

Color for Undefined Value

O .

Color to be used for visualizing undefined values.

Lines and Symbols >

Opacity for Undefined

Value

O .

The opacity of the visualization of undefined values can be set here.

Multigraph Options >

Multigraph Mode

O .

Via theMultigraphMode it is possible to switch between the display of multiple

subsets and one single subset. ↪→Sec. (a)

Multigraph Options > Leg-

end Alignment

O .

Allows to set the alignment of the multigraph legend.

Multigraph Options >

Opacity

O .

The multigraph legend’s opacity in the range between 0 and 100%.

X-Axis > Descending Co-

ordinates

If selected, the diagram will be shown with descending coordinates. Other-

wise the coordinates will be ascending.

X-Axis > Logarithmic

Scaling

If set to True, the x-axis scaling will be logarithmic instead of linear.

X-Axis > Minimum Num-

ber of Ticks

A guiding value for the automatic tick labeling of the x-axis can be set here.

The axis will have at least the number of ticks which is set by this value.

Y-Axis Left / Right-Hand >

Description

If Is Description User Defined is set to True, a user-defined axis label can

be set here. Otherwise the currently shown subset’s description is displayed

here.
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Y-Axis Left / Right-Hand >

Is Description User De-

fined

If True, a user defined label can be set instead of showing a label based on

the respective subset description.

Y-Axis Left / Right-Hand>

Color

The color of the left-hand or right-hand y-axis.

Y-Axis Left / Right-Hand >

Logarithmic Scaling

If set to True, the y-axis scaling will be logarithmic instead of linear.

Y-Axis Left / Right-Hand >

Minimum Number of

y-Axis Ticks

A guiding value for the automatic tick labeling of the y-axes can be set here.

The axes will have at least the number of ticks which is set by this value.

Important: Changing the value for one axis, that of the other y-axis will be

changed as well.

Y-Axis Left / Right-Hand >

Read Labels from Inside

The orientation of the axis labels can be specified here.

(c) Polar Diagram in Singlegraph Mode

Availability

For data arrays with angular dependency

Accessible:

• Ribbon: View > Axes Options > Polar Diagram

• Property browser: View > General > Show Polar Diagram

The ribbon item View > Axes Options > Polar Diagram allows to switch between the display of a polar

diagram and a Cartesian diagram in case an angular dependency is shown.

View > Axes Options > Logarithmic Scaling (Radial Axis) toggles between a logarithmic and a linear scaling

of the radial axis if the values to be displayed are completely positive.

The following specific parameters can be set via the View tab of the Property Browser:

ITEM DESCRIPTION

General > Show Polar Dia-

gram

Switches between a Cartesian diagram view (↪→Sec. (a)) and a polar diagram

view.

General > Orientation of

Half Circle

The orientation of the half circle (Top, Bottom, Left, Right) can be set here.

General > Legend Visible O .

The visibility of the legend for the color which visualizes undefined values can

be set here.

Azimuthal Axis > Number

of Grid Lines/Quadrant

How many angular tick lines shall be visible per quadrant?

Azimuthal Axis > Orienta-

tion of Angular Labels

The orientation (Horizontal, Radial, Tangential) of the angular labels can be

set here.

Azimuthal Axis > Show

Angles in Radian

If True, the angular labels are shown in radian, otherwise in degrees.
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Lines and Symbols > Line

Color

Color of line which connects the displayed data points. If set to Transparent,

the line will not be shown.

Lines and Symbols > Line

Thickness

Thickness of line which connects the displayed data points. Has to be a pos-

itive integer.

Lines and Symbols >

Symbol Color

O S S N S .

Color of the symbols which mark the data points.

Lines and Symbols >

Symbol Scaling Factor

O S S N S .

The size of the symbols (except Small Dot) can be scaled using this factor.

Lines and Symbols >

Symbol Shape

Shape of the symbols which mark the data points. If set to No Symbol, sym-

bols will be switched off.

Lines and Symbols > Use

Smoothed Graphics

If activated, the graphics will be smoothed. Usually, this may improve the

diagram. But if a stepped line is shown, deactivating this property may yield

a better result. Important: This smoothing is done on pixel level. This pixel

smoothing is not to be confused with the smoothing interpolation methods

described in Sec. 11.2.2!

Lines and Symbols >

Alignment of Undefined

Color Legend

O .

The position / alignment of the legend for the color to be used for visualizing

undefined values.

Lines and Symbols >

Color for Undefined Value

O .

Color to be used for visualizing undefined values.

Lines and Symbols >

Opacity for Undefined

Value

O .

The opacity of the visualization of undefined values can be set here.

Multigraph Options >

Multigraph Mode

O .

Via the Multigraph Mode it is possible to switch between the display of one

single subset and multiple subsets. ↪→Sec. (d)

Radial Axis > Description If Is Description User Defined is set to True, a user-defined axis label can

be set here. Otherwise the currently shown subset’s description is displayed

here.

Radial Axis > Is Descrip-

tion User Defined

If True, a user defined label can be set instead of showing a label based on

the respective subset description.

Radial Axis > Logarithmic

Scaling

If set to True, the radial axis scaling will be logarithmic instead of linear.

Radial Axis > Minimum

Number of Radial Axis

Ticks

A guiding value for the automatic tick labeling of the radial axis can be set

here. The axis will have at least the number of ticks which is set by this value.

(d) Polar Diagram in Multigraph Mode
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Availability

For data arrays with angular dependency and more than one subset

Accessible:

• Ribbon: View > Multigraph Mode

• Ribbon: View > Axes Options > Polar Diagram

• Property browser: View > Multigraph Options > Multigraph Mode

• Property browser: View > General > Show Polar Diagram

TheMultigraph Mode allows to display more than one subset at once in the diagram of a 1D DataArray. Fig. 105

shows an example.

Figure 105. Example for the Multigraph Mode of a polar diagram.

Figure 106. Dialog for configuring the Multigraph Mode for a polar diagram.

Via View > Subset Settings, the Multigraph Mode can be configured. The dialog shown in Fig. 106 provides

the following settings:



CHAPTER 13. DATA ARRAYS 166

ITEM DESCRIPTION

Graphs > Subset # The index of the subset represented by that table row.

This column is read-only.

Graphs > Description The description of the subset.

This column is read-only. (Sec. 24.5.1 shows how to edit the description.)

Graphs > Physical Prop-

erty

The physical property of the subset.

This column is read-only. (Sec. 24.5.1 shows how to edit the physical prop-

erty.)

Graphs > Ordinate This option allows to choose whether the curve shall be associated to the

Primary, the Secondary, or the Tertiary radial axis or whether the subset shall

be <Not Displayed> at all.

Important: All subsets to be displayed with respect to the same axis has to

have the same physical property! Furthermore, there has to be one subset

for the primary radial axis at least. If the tertiary axis is supposed to be used,

at least one subset has to be associated with the secondary axis, additionally.

If the button is pressed, the synchronization of the ordinate is enforced for

all subsets.

Graphs > Color This allows to select a color for the curve which represents the subset. Initially,

it is identical to the color of the associated radial axis in order to depict the

association.

If the button is pressed, the synchronization of the color is enforced for all

subsets.

Graphs > Symbol A symbol for displaying the data points can be selected here.

If the button is pressed, the synchronization of the symbol is enforced for

all subsets.

Graphs > Dash Pattern This allows to select a dash pattern for the curve which represents the subset.

If the button is pressed, the synchronization of the dash pattern is enforced

for all subsets.

Ordinates > Primary / Sec-

ondary / Tertiary Axis >

Rename?

If this button is pressed, a user-defined Description can be set for the respec-

tive ordinate.

Legend > Visible The visibility of the graphs legend can be set here.

Legend > Alignment A .

The position of the legend inside the diagram can be set.

Legend > Opacity A .

The legend’s opacity in the range between 0 and 100%.

The ribbon item View > Show Legend allows to toggle the visibility of the multigraph legend. In case of

undefined values in the diagram, the visibility of legend for the color which visualizes undefined values is toggled

as well.

The ribbon item View > Axes Options > Polar Diagram allows to switch between the display of a polar

diagram and a Cartesian diagram in case an angular dependency is shown.

View > Axes Options > Logarithmic Scaling (Primary / Secondary / Tertiary Radial Axis) toggles between

a logarithmic and a linear scaling of a certain radial axis if the values to be displayed are completely positive

(and if the respective axis is in use, of course).
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In multigraph mode, there are several specific settings accessible via the View tab of the Property Browser:

ITEM DESCRIPTION

General > Show Polar Dia-

gram

Switches between a Cartesian diagram view (↪→Sec. (b)) and a polar diagram

view.

General > Orientation of

Half Circle

The orientation of the half circle (Top, Bottom, Left, Right) can be set here.

General > Legend Visible The visibility of the multigraph legend can be toggled here. Furthermore, in

case of undefined values in the diagram, the visibility of the legend for the

color which visualizes undefined values is toggled as well.

Azimuthal Axis > Number

of Grid Lines/Quadrant

How many angular tick lines shall be visible per quadrant?

Azimuthal Axis > Orienta-

tion of Angular Labels

The orientation (Horizontal, Radial, Tangential) of the angular labels can be

set here.

Azimuthal Axis > Show

Angles in Radian

If True, the angular labels are shown in radian, otherwise in degrees.

Lines and Symbols > Line

Thickness

Thickness of line which connects the displayed data points. Has to be a pos-

itive integer.

Lines and Symbols >

Symbol Scaling Factor

O S S N S .

The size of the symbols (except Small Dot) can be scaled using this factor.

Lines and Symbols > Use

Smoothed Graphics

If activated, the graphics will be smoothed. Usually, this may improve the

diagram. But if a stepped line is shown, deactivating this property may yield

a better result. Important: This smoothing is done on pixel level. This pixel

smoothing is not to be confused with the smoothing interpolation methods

described in Sec. 11.2.2!

Lines and Symbols >

Alignment of Undefined

Color Legend

O .

The position / alignment of the legend for the color to be used for visualizing

undefined values.

Lines and Symbols >

Color for Undefined Value

O .

Color to be used for visualizing undefined values.

Lines and Symbols >

Opacity for Undefined

Value

O .

The opacity of the visualization of undefined values can be set here.

Multigraph Options >

Multigraph Mode

O .

Via theMultigraphMode it is possible to switch between the display of multiple

subsets and one single subset. ↪→Sec. (c)

Multigraph Options > Leg-

end Alignment

O .

Allows to set the alignment of the multigraph legend.

Multigraph Options >

Opacity

O .

The multigraph legend’s opacity in the range between 0 and 100%.

Radial Axis (Primary / Sec-

ondary / Tertiary) > De-

scription

If Is Description User Defined is set to True, a user-defined axis label can

be set here. Otherwise the currently shown subset’s description is displayed

here.
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Radial Axis (Primary / Sec-

ondary / Tertiary) > Is De-

scription User Defined

If True, a user defined label can be set instead of showing a label based on

the respective subset description.

Radial Axis (Primary / Sec-

ondary / Tertiary) > Color

The color of the respective radial axis.

Radial Axis (Primary / Sec-

ondary / Tertiary) > Loga-

rithmic Scaling

If set to True, the respective radial axis scaling will be logarithmic instead of

linear.

Radial Axis (Primary / Sec-

ondary / Tertiary) > Min-

imum Number of Radial

Axis Ticks

A guiding value for the automatic tick labeling of the radial axes can be set

here. The axes will have at least the number of ticks which is set by this value.

Important: Changing the value for one axis, that of the other radial axes will

be changed as well.

13.5.1.3 Specific View Features for 2D Data Arrays

The features described in this section are available for 2D Data Arrays only.

ITEM DESCRIPTION

Color Table ↪→Sec. 11.2.4

Color for Undefined Val-

ues

The color to be used for visualizing undefined values. (Can be set via Property

Browser only.)

3D Mode ↪→Sec. (a)

Show Legend Allows to switch off the color legend.

Show 1D Profile Shows or hides the 1D profile which shows a section along the line marker

below the 2D diagram. ↪→Sec. (b)

(a) 3D Mode

Availability

Accessible:

• Ribbon: View > Diagram in 3D Mode

• Property browser: View > 3D Mode

Visualization of a 2D data array can be done either in 2D mode (as shown in Fig. 100) or in 3D mode (as in

Fig. 107).
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Figure 107. Example for the diagram view of a 2D data array in 3D mode.

The 3D mode offers some specific mouse interactions:

MOUSE (+ KEYBOARD)

ACTION

VIEW OPERATION

Left button + move Free rotation

X / Y / Z key + left button +

move

Constrained rotation

Shift + left button +move Translation

Ctrl + left button + move

up/down

Zoom

You can adjust the view in the property browser (View > 3D Options group):

ITEM DESCRIPTION

Camera Direction Sets the perspective (i.e. the direction) of the view.

Camera Distance Parame-

ter

Decimal number that describes the camera distance in an arbitrary unit. It

affects the spatial distortion of the view and has to be larger than 1.0.

Camera Rotation Angle

X/Y/Z

Via these angles the direction of the view can be set in an alternative way to

Camera Direction

Draw Contours O C T , . .

’ .

If set to True, contour lines are drawn at the borders between two different

colors.

Font Size Factor A value for rescaling the labels inside the 3D view.

Show Data While Interact-

ing

If set to True, the diagram will be visible during mouse interaction.

Show Mesh If set to True, a mesh grid will be displayed instead of colors.
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Zone Method The type of drawing the zones. Possible values are Contours, which looks

nice but is slow, and Cells, which doesn’t look as nice, but is faster.

Zoom Factor Factor that determines the zoom of the view.

(b) Profile Lines O L M .

If a line marker is visible in the 2D diagram, by default the data along the selected line is shown as a profile line

in a 1D diagram below the 2D diagram. This 1D diagram shares many of the features of a normal 1D diagram

(↪→Sec. 13.5.1.2).

Please note that the starting coordinate of the 1D diagram corresponds to the line coordinates in the 2D diagram

only if the line is oriented exactly vertically or horizontally (which can easily be achieved holding Ctrl pressed

while dragging the mouse). In case of a sloping line, no reasonable starting coordinate can be extracted, so

the 1D diagram will start at the value 0.

If point marker and rectangle or ellipse marker intersect with the profile line, they are also shown there. Vice

versa, if the point marker is moved within the profile line, this change is also shown in the 2D diagram.

The separator line between 1D diagram and 2D diagram can be dragged with the mouse to change the relative

sizes of these diagrams. This can also be done via the Property browser (View > General > Height of 1D

Profile). Or you can disable the profile completely there (View > Selection (Line) > Show 1D Profile).

(c) Polarization Ellipses

Availability

Available only for Electric Fields or Electromagnetic Fields

Accessible:

• Ribbon: View > Show xy-/yz-/zx-Ellipses

The ribbon menu item View > Graphics Add-ons > Show xy-/yz-/zx-Ellipses is only available if a vectorial

component of an electric field is currently shown and if the graphics add-on for visualizing polarization ellipses

is available for the corresponding subset. It allows to toggle the visibility of the ellipses for this vectorial field

component.

The corresponding configuration button allows to configure the view settings of the currently shown polarization

ellipses via the dialog described in Sec. 11.7.3.



CHAPTER 13. DATA ARRAYS 171

13.5.1.4 Specific View Features for Gridless Data Arrays

ITEM DESCRIPTION

Color Table Allows to set the color table to use. ↪→Sec. 11.2.4

Dot Size N ’D P W V ’.

The size of the dots. Can be set either via the ribbon item View > Dot Size

or the View tab of the property browser.

Background Color Usually the dots do not fill the whole diagram region so the background can

be seen. By clicking on View > Background Color, either a predefined color

can be chosen or a new color can be defined via More Colors. The entry

Background Color in the View tab of the property browser has more prede-

fined colors. There you can also directly enter the name or the RGB values

(separated by comma and space) of the desired color.

Show Triangles A .

If checked, the triangles of the mesh are shown as described in Sec. 11.2.3.

Pupils Rendering A ’D P W V ’.

Allows to configure the view settings for the pupils shown as described below

in Sec. (a).

(a) Configuration of a Distribution of Pupils With Values

Figure 108. Dialog for configuring a Distribution of Pupils With Values.

ITEM DESCRIPTION

Color Table The color table used for mapping the pupil’s values to colors

Filling Opacity Opacity of the filling colors. 0% means complete transparency, 100% means

no transparency at all.

Draw Border If checked, the pupil’s borders are drawn.

Border Color V D B .

The color of the borders.

Border Width V D B .

The line width of the borders.

13.5.2 Table Panel

The Table panel provides a table showing the data points for each coordinate or pair of coordinates.



CHAPTER 13. DATA ARRAYS 172

There is an upper limit for the number of table cells that are displayed. If this threshold which can be set via

the Global Options dialog (↪→Sec. 6.7) is exceeded, no table will be displayed for performance reasons. The

display of the table can be enforced despite the bad performance by pushing the button Show Table Anyway,

which will be visible in this case.

Figure 109. Example for the table view of a 1D data array.

Figure 110. Example for the table view of a 2D data array.

The context menu in the table panel contains the following entries:

ITEM DESCRIPTION

Edit Selected Data Point... Opens a dialog for editing the value(s) of the data point which is associated

with the currently selected cell(s) (↪→Sec. 24.16).

Mark Selected Range in

Diagram

O - .

If a range of rows is selected within the table, this menu item will mark the

corresponding coordinate range in the diagram.

Mark Selected Point in Di-

agram

O - .

If a single row is selected within the table, this menu item will mark the corre-

sponding coordinate in the diagram.

Copy Selection This will copy the content of the selected table cells to the clipboard.

The View panel of the property browser has the following entries for the table panel:
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ITEM DESCRIPTION

Field Quantity O S T

C P F .

The field quantity (↪→Sec. 11.1) to show in the table.

Show Two Complex Parts O .

If True, the table shows both complex parts for each data point. Otherwise,

only one field quantity is shown at a time.

Amplitude Phase Mode O S T

C P T .

Here can be set whether the table shall show amplitude and phase (True) or

real and imaginary part (False).

Number of Digits The number of significant digits to be shown for the entries in the table.

Show Units With this option you can show the entries in the table without physical units.

In this way copied entries can be more easily processed in external programs

like e. g. spreadsheet software.

13.5.3 Value at (x,y) Panel

If the value (or the values of more than one subset) at one certain position has (have) to be identified, this can

be done via this Value at (x,y) panel. Here, simply the coordinates have to be entered, than the value(s) is (are)

displayed as shown in Fig. 111 for 1D and Fig. 112 for 2D data. If a point marker (↪→Sec. 11.3) is visible in the

View Panel, its position will be filled in here automatically.

Figure 111. Example for the view for a value at a position (x, y) of a 1D data array.

Figure 112. Example for the view for a value at a position (x, y) of a 2D data array.

ITEM DESCRIPTION

First Coordinate First coordinate to get the value(s) for.
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Second Coordinate O - .

Second coordinate to get the value(s) for.

Show Amplitude and

Phase of Complex Values

If checked, complex data will be displayed as amplitude and phase instead

of real part and imaginary part.

Use Own Interpolation

Method

O S (F T -

).

If checked, the interpolation method of the data array will be used in order

to calculate the value(s) at a position that lies between adjacent data points.

Otherwise, nearest neighbor interpolation (or constant interval interpolation,

in case of non equidistant data) will be used.

Edit Data Point Opens a dialog for editing the value(s) of the currently shown data point

(↪→Sec. 24.16).

14 Chromatic Fields Set View

The Chromatic Fields Set View can display the squared amplitude distribution of one- or two-dimensional fields.

This view is also used as preview in the Light Sources Catalog, in particular the same context menu is used

there. However the preview uses a special toolbar is show which is described in Sec. 14.4.

There are two settings which strongly influence the available view settings: the wavelengths mode (↪→Sec. 14.1)

and the color mode (↪→Sec. 14.2).

Interpolated view (↪→Sec. 11.2.1), markers and selections (↪→Sec. 11.3), zoom (↪→Sec. 11.4), aspect ratio

(↪→Sec. 11.5), and Copy View To Clipboard (↪→Sec. 11.6) are available independently from these modes.

14.1 Wavelength Selection

Availability

Accessible:

• Ribbon: View > Wavelength Selection group

• Property browser: View > Summation Mode and View > Wavelength Index

• Context menu: Wavelengths Mode andWavelength Index

There are twoWavelength Modes available:

MODE DESCRIPTION

Summed Wavelengths Adds the values of all wavelengths to one field.

Single Wavelengths

Mode

Only one wavelength is shown at a time. In the ribbon you can go through

all wavelengths of a Chromatic Fields Set with the control shown in Fig. 113,

either by using the arrow buttons or by entering the wavelength index directly.

Below this control the currently selected wavelength is given.

Figure 113. The controls to select a wavelength index in the ribbon.
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14.2 Color Mode

Availability

Only for two-dimensional Chromatic Fields Sets

Accessible:

• Ribbon: View > Color Mode menu

• Property browser: View > Color Mode

• Context menu: Color Mode

There are two Color Modes available:

MODE DESCRIPTION

False Color The squared amplitudes are shown as data arrays. Thus this mode has the

same view functionality as for Numerical Data Arrays (↪→Sec. 13.5). Adds the

values of all wavelengths to one field.

Real Color O C

F S (360 – 830 ).

Considers the field as an intensity distribution (which, in general, can be poly-

chromatic) and displays it as the human eye would perceive it. This mode

allows you to adjust its brightness (↪→Sec. 11.2.6). Consequently, if a point

marker is shown the Selections tab of the property browser not only shows the

squared amplitude at its current position, but also the red-green-blue values.

14.3 Maximum Lightness

Availability

Only for two-dimensional Chromatic Fields Sets in Single Wavelength and Real Color mode

Accessible:

• Ribbon: View > Maximum Lightness

• Property browser: View > Maximum Lightness

• Context menu: Maximum Lightness

If a chromatic fields set is displayed in Single Wavelength and Real Colormode, there are two lightness modes

available: The Maximum Lightness may be switched ON or OFF.

ITEM DESCRIPTION

Maximum Lightness O S W R C .

Toggles the usage of the Maximum Lightness mode. If the button is pressed,

all single wavelength views will be scaled to maximum lightness indepen-

dently. If it is not pressed, no maximum scaling is done which allows to com-

pare all single wavelengths views with each other.

As an example, a chromatic fields set is shown in Fig. 114 (in Summed Wavelengths mode) and in Fig. 115 (in

Single Wavelengths mode with and without Maximum Lightness activated).
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Figure 114. Real Color view of a chromatic fields set with five different wavelengths in Summed Wavelengths mode.

Figure 115. All single wavelengths views of the chromatic fields set shown in Fig. 114. Left hand side: Deactivated Max-

imum Lightness allows comparison of the different wavelengths. Right hand side: Activated Maximum Lightness scales

every wavelength view to its maximum which allows a better examination of faint regions.

14.4 Toolbar (For the Preview in the Light Sources Catalog)

ITEM DESCRIPTION

Color Mode Switches the color mode, ↪→Sec. 14.2.

Wavelength Mode Switches the wavelengths mode, ↪→Sec. 14.1.

Previous Wavelength In-

dex

O S W M .

Show the field with the next smaller wavelength.

Wavelength Index O S W .

Show the field with the wavelength corresponding to the specified index.

Next Wavelength Index O S W .

Show the field with the next larger wavelength.

Separate Chromatic

Fields Set

Shows the preview as separate Chromatic Fields Set which you can save or

convert to a Numerical Data Array.
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15 Pulse and Field Component

For the display of pulses (↪→Sec. 74.6.5), spectra (↪→Sec. 53) and the results of the Extraction Tools (↪→Sec. 23.2)

a special document type Light Field Object is available which plots complex-valued field data versus wave-

length, frequency, or time. The following 6 display variants are possible.

DISPLAY VARIANT DESCRIPTION

Field Component At One

Point

Plots field data versus an index or the wavelength. This results in a one-

dimensional diagram.

Pulse Component At One

Point

Plots field data versus wavelength, frequency, or time. This results in a one-

dimensional diagram, Fig. 116 shows an example. Carrier wavelength, carrier

angular frequency, or time shift are stored as additional information.

Field Component At Line Plots field data along a line versus an index. This results in a two-dimensional

diagram.

Pulse Component At Line Plots field data along a line versus wavelength, frequency, or time. This

results in a two-dimensional diagram, Fig. 117 shows an example. Carrier

wavelength, carrier angular frequency, or time shift are stored as additional

information.

Field Component Contains multiple subsets each storing two-dimensional field data at a certain

index. This results in a two-dimensional diagram.

Pulse Component Contains multiple subsets each storing two-dimensional field data at a certain

wavelength, frequency, or time. This results in a two-dimensional diagram,

Fig. 118 shows an example. Carrier wavelength, carrier angular frequency,

or time shift are stored as additional information.

All these document windows consist of three tab pages. Carrier wavelength, carrier angular frequency, or time

shift are shown in an expandable information box (↪→Fig. 116 – Fig. 118). Despite this the view is essentially

the same as for Numerical Data Arrays (↪→Sec. 13.5).

Figure 116. Example for a 1D diagram showing a Gaussian pulse.
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Figure 117. Example for a 2D pulse component view.

Figure 118. Example for a pulse component view.

16 Set of Objects

Sometimes it is useful to group various objects of the same type together. For example a detector might yield

several data arrays with different sampling. Besides the settings inherited from the underlying objects this view

allows to switch between the contained objects.

Currently only a set of data arrays is supported. Note that for your convenience, a set of data arrays with only

one data array is converted automatically to a single numerical data array.
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Availability

…of the controls to switch between the data arrays:

Accessible:

• Ribbon: View > Data Array Selection ribbon group

• Property browser: View > Data Array Index

In the very top of the document view (↪→Fig. 119), there is a double label. The left part indicates the name of

the object, the right part the name of the current subset. The gray area between the two labels can be used to

change their relative sizes by dragging with the mouse.

Figure 119. Example for the double label of a Set of 2D Data Arrays. Here the Electric Field subset for Iteration Step of 1

is shown.

The view settings for data arrays are explained in Sec. 13.5.

16.1 The View Area and Switching Between Objects

Different objects may own different definition areas. Usually, the view area is restricted to this definition area.

So, switching between objects with differing definition areas may lead to ”jumping” view ranges if the definition

areas overlap only partial or not at all.

If, however, the option Data Restricted Zoom is deactivated (↪→Sec. 11.4.1), the zoom factor is not limited

anymore and jumping view areas are avoided.

An additional feature leads to a more convenient switching behavior even if Data Restricted Zoom is kept

activated: If the option called Unified Max Extension is checked, one unified definition area is calculated from

all single definition areas of the contained objects.

Availability

…of the Unified Max Extension feature:

Accessible:

• Ribbon: View > Zoom & Aspect Ratio ribbon group > Unified Max Extension

17 Ray Distribution View

The view for Ray Distributions consists of two tab pages: the 3D View tab draws the rays directly in the three-

dimensional system view (↪→Sec. 17.1) and the 2D View tab draws the rays intersecting with a certain plane

(↪→Sec. 17.2).

The latter tab shows either Field Properties or Ray Properties which influences the available view settings.

Which of these modes is available depends on how the Ray Distribution has been generated:
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GENERATION VIA... 3D VIEW 2D VIEW

(FIELD PROPERTIES)

2D VIEW

(RAY PROPERTIES)

General Profile

(↪→Sec. 43.4)

8 4 4

Ray Results Profile (↪→Sec. 43.4) 8 8 4

Ray Tracing System Analyzer

(↪→Sec. 43.4.5)

4 8 4

17.1 3D View

Figure 120. Ray Distribution for a focusing lens showing the 3D View tab page.

Into the 3D view the surfaces of an optical setup can be drawn together with rays passing through them. This

view is essentially the same as the standard 3D view (↪→Sec. 5.15), except for the following differences:

• The context menu has the additional options Select Tracing Sequence (↪→Sec. 17.1.1) and Filter Blocked

Rays (↪→Sec. 17.1.2).

• The view settings dialog has the additional page Rays with which you can define the layout of the rays.

↪→Sec. 17.1.3

• If you export the view to the IGES format via the context menu, the rays are also exported into this file.

• The document window has a property browser and a View ribbon tab.

In the View ribbon you can

• specify which subset is to be shown (↪→Sec. 17.3)

• adjust the colors of the rays (↪→Sec. 17.4) and

• copy the view to clipboard (↪→Sec. 11.6) .

Furthermore this ribbon tab has the following controls specific to the 3D View of Ray Distributions:
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ITEM DESCRIPTION

Stride For a better overview you can define a stride n which means that only every

nth ray is drawn.

Ray Thickness With this option you can make the rays be drawn larger or smaller.

Settings Opens the view settings dialog. ↪→Sec. 5.15.2

{Predefined Camera

Orientations}

There are 6 predefined camera orientations available: View orthogonal to

xy-Plane and xy-Plane (Rear) (anti-parallel and parallel to the z-Axis, respec-

tively), view orthogonal to zx-Plane and zx-Plane (Rear) (anti-parallel and

parallel to the y-Axis, respectively), view orthogonal to zy-Plane and zy-Plane

(Rear) (parallel and anti-parallel to the x-Axis, respectively).

Filter Blocked Rays Filters all rays blocked by a certain aperture. ↪→Sec. 17.1.2

Most of these options can also be set via the View tab of the property browser.

17.1.1 Select Tracing Sequence

If a complex optical system is shown in the Ray Distribution 3D view, it may be hard to keep track of all ray paths.

Thus this tool, available via the context menu of the view, allows you to define the shown tracing sequence by

switching off ray paths.

Figure 121. The dialog to select the shown tracing sequence.

The upper part of its edit dialog (↪→Fig. 121) shows all ray paths in execution order. A ray path either runs

• between two Optical Setup Elements,

• between two surfaces of a real component, or

• through one surface of a real component.

The Selection Tools button allows you to either Select All ray paths or to Unselect All.

17.1.2 Filter Blocked Rays

With this tool you can define that all rays blocked at the aperture of a certain surface are not shown at all. This

can make the relevant ray paths more clear.

In the edit dialog of this tool you can select whether you want to apply that filter and if so, which boundary

defines the blocking aperture. Fig. 122 shows an example.
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Figure 122. In the left view all rays are shown. In the right view all rays not passing the selected aperture (marked by the

red arrows) are not shown.

17.1.3 Rays Page

Figure 123. The Rays page of the View Settings dialog.

With this page (↪→Fig. 123) of the View Settings dialog (↪→Sec. 5.15.2) you can define how the rays are visual-

ized.
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ITEM DESCRIPTION

Show Rays If this options is unchecked, you see only the pure Optical Setup without any

rays.

Ray Thickness With this option you can make the rays be drawn larger or smaller.

Stride For a better overview you can define a stride n which means that only every

nth ray is drawn.

Single Color If you select this option, all rays are drawn with the same color. If you click on

the -button you can either choose a predefined color or define your own.

Wavelength With this option, all rays are colored as the human eye would perceive the

corresponding wavelength. Invisible wavelengths are drawn black.

Color Table With this option, the different wavelengths are drawn with different colors de-

fined by the selected color table.

Colorize Boundary Tran-

sition Rays in Different

Color

With this option you can define that rays within a boundary operator are em-

phasized by a different color. Such rays can occur if e. g. a programmable

boundary operator considers the Goos-Hänchen shift.

17.2 2D View

Figure 124. 2D View tab page of the Ray Distribution view with visible Boundary Index control.

The 2D View of a Raytracing Result view (↪→Fig. 124) is based on gridless data arrays. It allows you to

• specify which mode is to be shown (↪→Sec. 17.3)

• set the scaling mode (↪→Sec. 11.2.5)

• adjust the colors of the rays (↪→Sec. 17.4)

• use markers and selections (↪→Sec. 11.3)

• zoom into the view (↪→Sec. 11.4)

• change its aspect ratio (↪→Sec. 11.5) and
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• copy the view to clipboard (↪→Sec. 11.6) .

Furthermore this view has the following features specific to the 2D View of Ray Distributions:

ITEM DESCRIPTION

Field Properties /

Ray Properties

O R D G -

P (↪→S . 43.4)

With this ribbon menu you can define whether the field properties

(↪→Sec. 17.2.1) or the ray properties (↪→Sec. 17.2.2) shall be displayed. If

this ribbon item is not visible only ray properties are available. This option

can also be set via the property browser (View > Show Field Quantities).

Dot Size Allows you to adjust the size of the dots. Can be set either via the ribbon item

View > Dot Size or the View tab of the property browser.

Background Color Usually the dots do not fill the whole diagram region and thus you see its

background color. If you click on View > Background Color, you can either

choose a predefined color or define your own using More Colors. The entry

Background Color in the View tab of the property browser has more prede-

fined colors. There you can also directly enter the name or the RGB values

(separated by comma and space) of the desired color.

Show Triangles Switches the triangle interpolation (↪→Sec. 11.2.3) on and off.

This feature is not available if the ray property Direction is shown. If the ray

property Position is shown, only the triangles borders are shown. For further

information about ray properties see Sec. 17.2.2.

If the Ray Distribution was obtained with the Raytracing System Analyzer (↪→Sec. 43.4.5), the view contains

an additional control to select the Boundary Index (↪→Fig. 124). Using this control you can visualize the ray

distribution at various boundaries.

If a point marker is visible, the Ray Selection tab of the property browser shows both the field and the ray

properties of the currently selected ray.

17.2.1 Field Properties

If the 2D view of a raytracing result is in the Field Properties mode, you can select the Field Component (Ex,

Ey, and so on; ↪→Sec. 17.2.1.1) and the Field Quantity (↪→Sec. 11.1).

In the View tab of the property browser you can define whether to Apply Energy Conservation. The energy

conservation is based on the size of the triangles spanned by the rays which usually does not work if you are

in the focus.

17.2.1.1 Field Component

Availability

Accessible:

• Ribbon: View > Field Component ribbon group

• Property browser: View > Field Component

• Context menu: Edit View Settings (↪→Sec. 17.2.3)

The field component can be either Ex, Ey, Ez Hx, Hy, or Hz. The formulas for calculating the distinct field

components are given in Sec. 131.
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17.2.2 Ray Quantities

Availability

Accessible:

• Ribbon: View > Ray Quantity ribbon group

• Property browser: View > Quantity

• Context menu: Edit View Settings (↪→Sec. 17.2.3)

If it is in the Ray Properties mode, the 2D view of a Ray Distribution can visualize one of the following ray

quantities.

RAY QUANTITY DESCRIPTION

Position Plots the rays at their actual positions in the shown x-y-plane. If there is more

than onemode given and the coloringmode is set toColor by Table, the colors

indicate the respective mode index of each ray.

Direction The direction of a ray can be described by the direction vector s which has

an absolute value of 1. If you select this ray quantity, you can change the

Direction Visualization Mode in the View tab of the property browser. This

option allows you to plot the rays either into the sx-sy-plane, or to color the

rays according to the sx-, sy-, or sz-component while plotting them into the

x-y-plane.

Optical Path Length The rays are plotted at their actual positions in the shown x-y-plane and col-

ored according to their optical path length.

Absorption The rays are plotted at their actual positions in the shown x-y-plane and col-

ored according to the absorption.
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17.2.3 View Settings Dialog

Figure 125. The dialog to edit the view settings of a Ray Distribution.

This dialog (↪→Fig. 125) allows you to set the most important view parameters at once. It can be opened via

the context menu of the view.

ITEM DESCRIPTION

Visualization of O G P , -

Allows you to determine whether you want to see any of the Field Properties

or any of the Ray Properties.

Field Component O F P

The field component (↪→Sec. 17.2.1.1) to show.

Field Quantity O F P

The field quantity (↪→Sec. 11.1) to show.

Apply energy conserva-

tion

O F P

The energy conservation is based on the size of the triangles spanned by the

rays which usually does not work if you are in the focus. Thus you can switch

it off in this case.

Ray Quantity O R P

The ray quantity (↪→Sec. 17.2.2) to show.
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Direction Visualization

Mode

O D R Q

The direction of a ray can be described by the direction vector s. This option
allows you to plot the rays either into the sx-sy-plane, or to color the rays

according to the sx-, sy-, or sz-component while plotting them into the x-y-

plane.

Add Wavefront Response

to Optical Path Length

O O P L R Q

Ideal components and light sourcesmight add a wavefront response indepen-

dent from the actual optical path length. By checking this option the wavefront

response is added to the shown optical path length.

Show Triangles N R Q D (S , S )

If checked the triangle interpolation (↪→Sec. 11.2.3) is applied.

Show Borders of Trian-

gles

O S T

Draws the borders of the triangles used for the triangle interpolation.

Dot Size N S T

Allows you to adjust the size of the dots representing the rays.

Single Color N A , O P L , D -

( S ( , ), S ( , ), S ( , ))

If you select this option, all rays are drawn with the selected color.

Wavelength N A , O P L , D -

( S ( , ), S ( , ), S ( , ))

With this option, all rays are colored as the human eye would perceive the

corresponding wavelength. Invisible wavelengths are drawn black.

Color Tables With this option, the different rays are drawn with different colors defined by

the selected color table. For complex data, this can be set per field quantity.

Please note that the shown colors do not map onto any quantity of some

physical meaning in some cases: If ray positions or directions in the sx-sy-

plane are shown, the color indicates the mode index of each ray (in case

there is more than one mode).

Opacity O F P

If the default opacity of 1 is lowered, the rays become more and more trans-

parent and thus also rays “below” the topmost rays become more and more

visible.

Background Color Usually the dots do not fill the whole diagram region and thus you see its back-

ground color. If you click on this button, you can either choose a predefined

color or define your own.

17.3 Mode Selection

Availability

For Ray Distributions with more than one subset

Accessible:

• Ribbon: View > Subset Selection group

• Property browser: View > Subset Selection group
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A Ray Distribution can have multiple wavelengths and incoherent modes. For each combination of wavelength

and incoherent modes there can be multiple coherent modes. In the view ribbon there is the control shown

in Fig. 126 with which you can set Wavelength #, Incoherent Mode # and Coherent Mode #, either by using

the arrow buttons or by entering the index directly. If you check the corresponding check box all modes of the

respective type are shown.

The same can be done with the View > Subset Selection group of the property browser. It also shows the

currently selected wavelength, not only the wavelength index.

Figure 126. The controls to select specific mode(s) in the ribbon. The second wavelength out of three possible wave-

lengths is selected. There is only one incoherent mode so the corresponding arrow buttons are disabled. All coherent

modes for the currently selected wavelength and for the currently selected incoherent mode are shown.

17.4 Coloring Rays

Availability

Accessible:

• Ribbon: View > Color by Wavelength, View > Color by Table, View > Single Color

• Property browser: View > Color Mode

• Context menu (3D View): View Settings > Rays (↪→Sec. 17.1.3)

• Context menu (2D View): Edit View Settings (↪→Sec. 17.2.3)

You can color rays in the following ways:

MODE DESCRIPTION

Color by Wavelength With this option, all rays are colored as the human eye would perceive the

corresponding wavelength. Invisible wavelengths are drawn black.

Color by Table With this option, the different rays are drawn with different colors defined by

the selected color table and the shown quantity.

If the shown quantity is the position or the direction in the sx-sy-plane or if the

3D view is shown, each distinct wavelength or incoherent mode gets its own

color from the selected color table.

Single Color If you select this option, all rays are drawn with the selected color.

18 Order Collection View

AnOrder Collection document contains the coordinates, efficiencies and Rayleigh coefficients of all (transmitted

or reflected) diffraction orders of a grating. What exactly is shown depends on the settings on the Data to Show

tab of the Property Browser. There you have the following settings:
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ITEM DESCRIPTION

Coordinate Type The coordinates versus which the individual orders are plotted: either the

order numbers, the spherical angles θ and φ, the Cartesian angles α and β,

the wave vector components kx and ky, or the position (x; y). In the latter

case you can set a Distance for which the positions are calculated.

Data to Show Allows to set whether the efficiencies or certain Rayleigh coefficients (Ex, Ey,

Ez, TE, TM) of the orders are shown.

Strategy With this option you can restrict the shown orders. The following three strate-

gies are available:

• All: No restrictions apply

• Above Efficiency Threshold: Only (propagating) orders above the

given Efficiency Threshold are shown.

• Order Range: All orders in the range between Minimum Order (inclu-

sive) and Maximum Order (inclusive) are shown.

If angles or positions are used as coordinates, evanescent orders are never shown, regardless of the

selection strategy.

Figure 127. Efficiencies of a grating invariant in y-direction for conical incidence, plotted versus Cartesian angles.

The selected data is shown in a Gridless Data Array and shares most of its features (↪→Sec. 13.5). Fig. 127

shows an example.

In contrast to Gridless Data Arrays, the Order Collection view has the following additional features:

• You can convert the complete data into an equidistant data array, plotted versus order numbers. This can

be done via the ribbon item Manipulations > Create Equidistant Data Array or by pressing F3 .

• In the table always the order numbers are shown, even if the coordinates are spherical coordinates for

example.

• If you extract 1D data along a selected line (↪→Sec. 24.14.1), the order numbers are added as labels to

the resulting data array.
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• If you select a certain order with the Point Marker (↪→Sec. 11.3), all coordinates and all data (efficiency

and Rayleigh coefficients) are shown in the Selections tab of the Property Browser.

19 Diffraction Orders Diagrams

The diffraction orders diagram serves for visualizing angles and efficiencies of diffraction orders in a plane as

shown in Fig. 128.

You can zoom in or zoom out the diagram with the mouse wheel or with the following ribbon buttons to be found

in View.

ITEM DESCRIPTION

Zoom In Increase zoom factor by factor
√

2.

Zoom Out Decrease zoom factor by factor
√

2.

Show All Show all data. This is the default for newly created diagrams.

The displayed value range can be adjusted more precisely via the Property Browser: For polar diagrams you

can change theMaximum of the value-axis via the property browser. For bar and line diagrams you can change

Minimum andMaximum of both x- and y-axis. If you change Auto Scale to True, the y-axis is reset to its default

values.

The context menu of the diagram allows to select the data to be shown:

ITEM DESCRIPTION

Choose Diffractive Orders

to Show

This will open a configuration dialog explained in Sec. 19.1.

Figure 128. Example for a Diffraction Orders Diagram.

The Table panel (↪→Fig. 129) shows the diffraction order values in a tabular form. The Order column shows the

type and index of the diffraction order (“T” marks the transmitted orders, “R” the reflected orders, and “I” the

incident wave). The second and the third column show the angle and the efficiency of each order respectively.
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The context menu of the table allows to copy the currently selected data:

ITEM DESCRIPTION

Copy Selection to Clip-

board

Copies the selected data to the clipboard so that they can be used in external

programs like spreadsheet programs.

Figure 129. The table panel of a Diffraction Orders Diagram.

19.1 Select Diffraction Orders to Show

For a better overview, you can reduce the number of orders shown in a Diffraction Orders Diagrams. For the

selection of the orders to be shown, this dialog can be used (↪→Fig. 130).

Figure 130. The Dialog for selecting the diffraction orders to show.

You can select the Type of Orders you want to see and restrict the angular range to be shown.

Additionally, either a Stride can be set (a stride of n means that only every nth order is shown) or single orders
can be selected via the checkboxes in the table rows. Furthermore, you can Select All data points or Select

None.
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20 Animation View

An animation is a sequence of raster graphics images which can be shown smoothly one after another. A single

image is also referred to as frame.

Figure 131. Example of an Animation View.

Fig. 131 shows the animation view which contains the following controls:

ITEM DESCRIPTION

/ Allows you to run the animation in forward / reverse order. IfRepeatAnimation

is set in the Animation Options dialog (↪→Sec. 20.3), the animation will be

started again automatically if the end is reached.

Pauses a running animation.

/ With these buttons you can jump to the first and the last frame of the anima-

tion, respectively.

The button corresponding to the currently active “action” (pause / play forwards / play backwards) is disabled.

There is also the possibility to go through the animation using the scrollbar. In the bottom-right corner you can

see the index of the current frame and the overall number of frames.

An animation can be exported into various file formats (↪→Sec. 123).

20.1 Ribbon Items

The following ribbon items are available on the Animation ribbon tab:
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ITEM DESCRIPTION

Copy Frame Copies the current frame into the Windows™ clipboard (as an image).

Cut Frame Moves the current frame into the Windows™ clipboard (as an image).

Paste Frame Pastes an image from the clipboard into the animation. The image can be

inserted (Paste > Insert Frame) before the currently selected frame or ap-

pended (Paste > Append) to the end of the animation. In both cases the

number of frames will increase by one.

If the size of the pasted image does not match the size of those images al-

ready in the animation, a resizing is done which maintains the aspect ratio of

the pasted image.

Delete Frame Deletes the current frame.

Swap Frames Swaps two frames. The source frame and the destination frame can be cho-

sen in a separate dialog.

Stitch Animations Stitches two animations, i. e. places them either side by side or one below

the other. ↪→Sec. 20.2

Animation Options Opens the animation options. ↪→Sec. 20.3

All of these items but Stitch Animations are also accessible via the context menu of the animation view.

20.2 Stitch Animations

Using the ribbon item Animation > Stitch Animations stitches two animations, i. e. places them either side

by side (= “horizontally”) or one below the other (= “vertically”). The animations to stitch must have the same

number of frames.

Figure 132. The dialog with the options for stitching animations.

This tool is applied on one animation. Then a dialog (↪→Fig. 132) opens where you can set the second animation

and other options.

ITEM DESCRIPTION

Select Second Animation Allows you to select the second animation from any other already opened

animation.

Stitch Orientation If you select Horizontally the two animations are placed side by side. If the

two animations do not have the same height in pixels, the animation with the

smaller height is resized accordingly.

If you select Vertically the two animations are placed one below the other. If

the two animations do not have the same width in pixels, the animation with

the smaller width is resized accordingly.

Space Between Anima-

tions

You can add up to 1000 pixels of black space between the two animations to

separate them more clearly.
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Note that you can apply this tool recursively to stitch more than two animations. Fig. 133 shows an example.

Figure 133. Four stitched animations: First the two upper and the two lower animations, respectively, were stitched hor-

izontally with a Space Between Animations of 40 pixels. Then the two resulting animations were stitched vertically with a

Space Between Animations of 20 pixels.

The upper part shows the phase of the near field of the grating, the lower the phase of the Rayleigh coefficients. Left:

transmission, right: reflection.

20.3 Animation Options

Using the ribbon item Animation > Animation Options or the context menu the dialog shown in Fig. 134 can

be opened.

Figure 134. Dialog to adjust the settings for the Animation View.

The following settings are available:
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ITEM DESCRIPTION

Properties The bitmap size, the used color format, and the number of frames are shown.

Frames per Second /

Frame Duration /

Whole Duration

Allows you to enter the animation speed.

Repeat Animation If checked a running animation will automatically be started again if it reaches

the last frame.

Free Aspect Ratio If checked the animation will be stretched to use the complete available

space. Otherwise the aspect ratio of the animation will be maintained and

unused parts of the view are colored black.

21 Regions

Region documents simply store the information whether a certain position belongs to (lies inside) a certain re-

gion or not. Such a region document can be used as Evaluation Region in the Diffractive Optics Merit Functions

detector (↪→Sec. 74.6.2) or as Optimization Region in the IFTA Optimization document (↪→Sec. 97).

A region can be generated in the following ways:

METHOD DESCRIPTION

Create a new region docu-

ment

Create a new rectangular, elliptical, polynomial, sampled or composed

2D region (↪→Sec. 21.1), or an interval, sampled or composed 1D region

(↪→Sec. 21.2).

Create signal region doc-

ument from selection

Manipulations > Selection Related Operations > Create Signal Region

from Selection creates a sampled region which has the same sampling pa-

rameters as the current harmonic field or Jones matrix transmission docu-

ment. The current range or rectangle marker defines the actual signal region,

independent from the values in the original document.

Convert to sampled re-

gion document

A harmonic field or a Jones matrix transmission can be converted to a sam-

pled region document using Manipulations > Create Sampled Region.

In this case you are asked for a relative threshold and all values having a

squared amplitude larger than the maximum squared amplitude times this

value are regarded as being ’inside’ the region.

21.1 Generating a 2D Region

Via Functions > Region (2D) 2D regions can be generated. The dialog is shown in Fig. 135.
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Figure 135. Dialog for generation of a two-dimensional region document.

The following general parameters are used for the specification of each 2D region, independent from its re-

spective type:

ITEM DESCRIPTION

Region Type The type of the region to be created. This can be Rectangular Region, Ellip-

tic Region, Simple Polygon Region, Sampled Region, or Composed Region.

These types are described below (↪→Sec. 21.1.1 to Sec. 21.1.5.

Spectral Domain Determines whether or not the region is intended for using in the spectral or

spatial domain.

Region Name A user defined name for the region to be created.

Extrapolation Mode: Val-

ues Outside Domain are

This setting defines how to handle points which lie outside the domain of the

actual region. The following options can be set:

• All ’Outside Region’: All outlying points do not belong to the region.

• All ’Inside Region’: All outlying points do belong to the region, despite

lying outside the domain.

• Periodically Continued: The whole domain of the region is continued

periodically in every direction.

• Equal to the Nearest Border Data Point: A constant extrapolation of the

outmost data points is done. Meaning, if the nearest border point be-

longs to the region, the considered outlying point belongs to the region

too.

21.1.1 Generating a Rectangular Region

The specific parameters for creating a rectangular region are listed in the following table:
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ITEM DESCRIPTION

Center X / Y PV These values specify the center point of the rectangle.

Width / Height PV The extension of the rectangle.

Keep Aspect Ratio If checked, a change in width or height will change the other extension value

in a way keeping the ratio of the sides, resp.

Rotation Angle PV An angle for rotating the rectangle around its Center.

21.1.2 Generating an Elliptic Region

The specific parameters for creating an elliptic region are listed in the following table:

ITEM DESCRIPTION

Center X / Y PV These values specify the center point of the ellipse.

Half Axis X / Y PV The half axes of the ellipse in each dimension.

Keep Aspect Ratio If checked, a change in one of the half axes will change the other half axis in

a way keeping the ratio of the sides, resp.

Rotation Angle PV An angle for rotating the ellipse around its Center.

21.1.3 Generating a Simple Polygon Region

A simple polygon is a polygon without intersecting edges. Such polygons, containing an arbitrary number of

points, can be defined here.

The specific parameters for creating a simple polygon region are listed in the following table:

ITEM DESCRIPTION

Polygon Vertices table In this table the Name, x-Coordinate PV , and y-Coordinate PV of each vertex

can be edited.

Append New Opens a dialog for specifying a new polygon vertex and appends it to the list.

Insert New Opens a dialog for specifying a new polygon vertex and inserts it into the list,

above the currently selected row.

Remove Removes the currently selected polygon vertex.

Move Up / Down Moves the currently selected row up or down, resp.

Transform > Scale (Keep

Center)

Allows to scale the whole polygon by means of a (to be entered) factor. The

center of the polygon’s axis aligned bounding box will be kept constant.

Transform > Rotate

(Around Center)

Allows to rotate the whole polygon by means of a (to be entered) angle. The

rotation will be done around the center of the polygon’s axis aligned bounding

box.

Transform > Shift (Trans-

late)

Allows to shift / translate the complete polygon by means of a (to be entered)

vector.

Please note: The order of the vertices is important for each polygon with more than three vertex points.

21.1.4 Generating a Sampled 2D Region

A sampled region is defined by a finite number of sampling points on a grid, each point defining its area being

either inside of outside the actual region.
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The specific parameters for creating a sampled region are listed in the following table:

ITEM DESCRIPTION

Sampled Region Data The sampled region data can be set or shown here. This region data has to

be defined via a real-valued Numerical DataArray (2D) with one single subset

(↪→Sec. 13). All values unequal zero will be interpreted as being ’inside’ the

region.

21.1.5 Generating a Composed 2D Region

A composed region is built by one or more subregions PE . The combination is defined by a composition mode

which corresponds to one of several logical operations. These operations and their meanings are shown in the

following list:

OPERATOR REGION COMPOSITION

Intersection (AND) A given point is inside the actual region if and only if it lies in each of the

subregions respectively.

Union (OR) A given point is inside the actual region if and only if it lies in one of the

subregions at least.

Antivalence (XOR) A given point is inside the actual region if and only if it lies in an odd number

of subregions.

Difference A given point is inside the actual region if it lies only in the first subregion in

the table but in none of the other subregions.

Since composed regions may be used as subregions as well, a combination of several different compo-

sition modes is possible.

The specific parameters for creating a composed region are listed in the following table:

ITEM DESCRIPTION

Subregions table The unique index (#), the region Type, as well as the Name of each subregion

are shown here.

Edit Subregion Opens a dialog for editing the currently selected subregion.

New Subregion Opens a dialog for creating a new subregion which will be appended to the

table entries.

Delete Subregion Deletes the currently selected subregion.

Move Up / Down Moves the currently selected subregion one row up or down resp. This is

needed in case of the Composition Mode ’Difference’ only.

Composition Mode The mode for combining the subregions. See the list above.

The edit dialog for creating or changing subregions provides the following additional options: provides a new

default region for each of the region types, allows to select an open region document or to load a region

document from hard disc, allows to save the current region, and will show the current region as new

document.
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21.2 Generating a 1D Region

Via Functions > Region (1D) 1D regions can be generated. The dialog is shown in Fig. 136.

Figure 136. Dialog for generation of a one-dimensional region document.

The following general parameters are used for the specification of each 1D region, independent from its re-

spective type:

ITEM DESCRIPTION

Region Type The type of the region to be created. This can be Interval Region, Sam-

pled Region, or Composed Region. These types are described below

(↪→Sec. 21.2.1 to Sec. 21.2.3.

Spectral Domain Determines whether or not the region is intended for using in the spectral or

spatial domain.

Region Name A user defined name for the region to be created.

Extrapolation Mode: Val-

ues Outside Domain are

This setting defines how to handle points which lie outside the domain of the

actual region. The following options can be set:

• All ’Outside Region’: All outlying points do not belong to the region.

• All ’Inside Region’: All outlying points do belong to the region, despite

lying outside the domain.

• Periodically Continued: The whole domain of the region is continued

periodically in every direction.

• Equal to the Nearest Border Data Point: A constant extrapolation of

the outmost data points is done. Meaning, if the point with the small-

est coordinate inside the domain belongs to the region, all points with

smaller coordinates belong to the region too. The same applies for the

point with the largest coordinate in the domain and all points with larger

coordinates as well.
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21.2.1 Generating an Interval Region

The specific parameters for creating an interval region are listed in the following table:

ITEM DESCRIPTION

Center X PV This value specifies the center point of the interval.

Width PV The extension of the interval.

21.2.2 Generating a Sampled 1D Region

A sampled region is defined by a finite number of sampling points, each point defining its interval being either

inside of outside the actual region.

The specific parameters for creating a sampled region are listed in the following table:

ITEM DESCRIPTION

Sampled Region Data The sampled region data can be set or shown here. This region data has to

be defined via a real-valued Numerical DataArray (1D) with one single subset

(↪→Sec. 13). All values unequal zero will be interpreted as being ’inside’ the

region.

21.2.3 Generating a Composed 1D Region

A composed region is built by one or more subregions PE . The combination is defined by a composition mode

which corresponds to one of several logical operations. These operations and their meanings are shown in the

following list:

OPERATOR REGION COMPOSITION

Intersection (AND) A given point is inside the actual region if and only if it lies in each of the

subregions respectively.

Union (OR) A given point is inside the actual region if and only if it lies in one of the

subregions at least.

Antivalence (XOR) A given point is inside the actual region if and only if it lies in an odd number

of subregions.

Difference A given point is inside the actual region if it lies only in the first subregion in

the table but in none of the other subregions.

Since composed regions may be used as subregions as well, a combination of several different compo-

sition modes is possible.

The specific parameters for creating a composed region are listed in the following table:
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ITEM DESCRIPTION

Subregions table The unique index (#), the region Type, as well as the Name of each subregion

are shown here.

Edit Subregion Opens a dialog for editing the currently selected subregion.

New Subregion Opens a dialog for creating a new subregion which will be appended to the

table entries.

Delete Subregion Deletes the currently selected subregion.

Move Up / Down Moves the currently selected subregion one row up or down resp. This is

needed in case of the Composition Mode ’Difference’ only.

Composition Mode The mode for combining the subregions. See the list above.

The edit dialog for creating or changing subregions provides the following additional options: provides a new

default region for each of the region types, allows to select an open region document or to load a region

document from hard disc, allows to save the current region, and will show the current region as new

document.

21.3 Region View

The region view visualizes region documents (↪→Sec. 21). The user can see what points lie inside or outside

the actual regions respectively.

The views provide options for zooming as described in Sec. 11.4 and for copying the view to the clipboard as

described in Sec. 11.6. For two-dimensional regions, the aspect ratio behavior can be specified (↪→Sec. 11.5).

Markers as described in Sec. 11.3 can be used in views for sampled regions only.

For 2D regions, a smoothing option can be (de)activated via property browser.

Furthermore, the view settings of different region views can be copied among regions of the same dimension-

ality.



IV Manipulations:
Processing Data

In VirtualLab Fusion there are several document types which store one-

or two-dimensional data.

Their Manipulations ribbon tab contains several operations to modify

this (mostly) sampled data which are described in this part of the man-

ual. Furthermore it contains Conversions (↪→Sec. 30) to convert one

document type into another.
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22 Manipulations of Complex Amplitude Documents

Complex Amplitude Documents, namely Harmonic Fields and Jones Matrix Transmissions, have the manipula-

tions available which are described in the following subsections. The ribbon groupManipulations > Conversions

is explained in Sec. 30.1, the ribbon group Manipulations > Fourier Transformation (Space) in Sec. 31.1.

22.1 Array - Array Operations

Via the ribbon menu Manipulations > Array - Array Operations several operations for two array operands

are available:

• The four basic operations Addition, Subtraction, Multiplication, and Division as well as the convolution of

two fields, all of which are explained in Sec. 22.1.1.

• Inserting of one array into another, ↪→Sec. 22.1.2.

22.1.1 Arithmetic Operations

There are four basic arithmetic operations for arrays: addition, subtraction, multiplication, and division. Fur-

thermore there is the convolution of two Complex Amplitude Documents U1 and U2, calculated by

U1 ? U2 = F -1[(F U1) · (F U2)]. (22.1)

The first operand is always the currently selected Complex Amplitude Document; the second operand can be

selected from any open Complex Amplitude Document.

These operations can also be invoked by using the corresponding keys: + , - , * , / , and # , respectively. In this
case the currently selected document is taken as the second operand while the previously selected Complex

Amplitude Document is taken as first operand.

In case that the two arrays of an arithmetic array-array operation have not the same sampling distance or the

same array size, at least one of the fields or transmissions has to be resampled before the calculation, because

the underlying operation works pointwise.

The following table shows which parameter has to be adjusted in what case for each operation. The second

and the third column show how the sampling distance ∆new and the array size Snew of the resulting array are

determined by the sampling parameters of the operands (indices 1 and 2). Before starting the calculation, the

array(s) that has got sampling parameters different from that of the result field will be resampled.

Important: The sampling parameters for the directions x and y are checked and adjusted independently!

Operation ∆new Snew

Addition ∆new = min(∆1, ∆2) Snew = max(S1, S2)

Subtraction ∆new = min(∆1, ∆2) Snew = max(S1, S2)

Multiplication ∆new = min(∆1, ∆2) Snew = min(S1, S2)

Division ∆new = min(∆1, ∆2) Snew = min(S1, S2)

Convolution ∆new = min(∆1, ∆2) Snew = max(S1, S2)

If a Transmission has to be resampled, the user can choose one out of two possible types of interpolation. For

this reason a dialog will appear, shown in Fig. 137.
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Figure 137. Dialog for determining the interpolation type for resampling of a transmission.

The options are:

ITEM DESCRIPTION

continuous If chosen, the transmission will be interpolated using the Cubic 8 Point Inter-

polation (↪→Sec. 13.2.2).

pixelated If chosen, the transmission will be interpolated using the Nearest Neighbor

Interpolation (↪→Sec. 13.2.2).

Different types of Complex Amplitude Documents (Harmonic Field vs. Transmission) cannot be used as

operands in every possible combination; Sec. 135.1 gives a summary of all combinable types and their re-

sult for all operations.

22.1.2 Insert Array

Inserts a selected array into the current array at a certain position whereas the corresponding data of the

current array will be overwritten. This operation is done in pixel coordinates, the position (0; 0) corresponds
to the bottom left corner. The dialog is shown in Fig. 138. The array size of the original Complex Amplitude

Document is not changed, which means that the inserted array might be cut off.

Figure 138. Dialog for inserting an array.

ITEM DESCRIPTION

Array to insert The array to be inserted into the currently active array.

Insert Position

(Pixel Coordinates)

Position, where the bottom left corner of the inserted array shall be located.

Can be negative.

22.2 Operations with Constant

Via the ribbon menu Manipulations > Operations with Constant several operations with one field operand

are available, which are described in the following.
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ITEM DESCRIPTION

Set to Constant Set field to the given constant value.

Addition Add the given constant value to all field positions.

Multiplication Multiply the given constant value to all field positions.

Division Divide all field positions by the given constant.

Raise to Power Raise all field positions to the power of the given constant value.

For setting the constant values to operate with, the dialog shown in Fig. 139 appears. Here you can enter a

complex number by specifying either real part and imaginary part or amplitude and phase.

Figure 139. Dialog for operation with one field operand.

If you choose the mode Operate Complex, the two double numbers to enter are treated as the parts of one

complex number, either in Real / Imaginary or in Amplitude / Phase Representation. Then the operations are

done as a complex addition, multiplication or raise-to-power for each sampling point. If Operate Separately is

chosen, the first entry operates only on the real part / amplitude of the field and the second number only on

the imaginary part / phase, depending on the choice of Representation. In the following table you can see how

these operations work and what the respective meanings of c1 and c2 are. The original complex value of a

sampling point (z = a + ib ≡ A exp[iφ]) is changed by the operation with the constants c1 and c2 to the result

shown in the two last columns.

OPERATION REPRESENTATION RESULT OF OPERATION

Operate Complex Operate Separately

Add Constant Real / Imaginary (a + ib) + (c1 + ic2) (a + c1) + i(b + c2)

Amplitude / Phase A exp[iφ] + c1 exp[ic̃2] (A + c1) exp [i(φ + c̃2)]

Multiply Constant Real / Imaginary (a + ib) · (c1 + ic2) (a · c1) + i(b · c2)

Amplitude / Phase A exp[iφ] · c1 exp[ic̃2] (A · c1) exp [i(φ · c2)]

Divide by Constant Real / Imaginary (a + ib) : (c1 + ic2) (a : c1) + i(b : c2)

Amplitude / Phase A exp[iφ] : (c1 exp[ic̃2]) (A : c1) exp [i(φ : c2)]

Raise to the Power of Real / Imaginary (a + ib)c1+ic2 (ac1) + i (bc2)

Constant Amplitude / Phase (A exp[iφ])c1 exp[ic̃2] (Ac1) exp [iφc2 ]

c̃2 indicates that this value is an angle, i. e. you can enter it with the unit ’rad’, ’pi’, or ’
◦’ (↪→Sec. 5.1).

22.3 Field Quantity Operations

For real-valued data, the ribbon menu Manipulations > Field Quantity Operations contains only the option

to convert it to a complex-valued one.



CHAPTER 22. MANIPULATIONS OF COMPLEX AMPLITUDE DOCUMENTS 206

For complex-valued data, this ribbon menu provides several transformations with respect to field quantities.

Field quantities are explained in Sec. 11.1.

ITEM DESCRIPTION

Extract This submenu contains entries for all field quantities. The entry Imaginary

Part constructs a field, where the real part is set to zero and the imaginary

part is copied from the current field. Phase creates a field with the same

phase as the current field, whereby the amplitude is set to one. All remaining

submenu entries copy the corresponding field quantity to the real part of the

resulting field, whereby the imaginary part of the resulting field is equal to

zero.

Move The submenu entries are labeled according to which field quantity of the re-

sulting field is filled from which field quantity of the current field. For example,

Phase to Real Part copies the phase of the current field to the real part of the

resulting field, whereby the imaginary part of the resulting field is set to zero.

Swap The corresponding submenu entry allows to swap real part and imaginary

part.

22.4 Amplitude / Real Part Manipulations

The ribbon menu Manipulations > Amplitude / Real Part Manipulations lets you perform the following oper-

ations with respect to amplitudes:

ITEM DESCRIPTION

Normalize Normalize the current field by dividing the field at all positions by the globally

maximal amplitude.

Normalize According to

Range Selection /

Normalize According to

Rectangular Selection

Normalizes the current array by dividing it (at all sampling points) by the max-

imum amplitude within the current selection.

Clip Clips the current field to a given maximum amplitude. At all positions, where

the amplitude is above this maximum value, the amplitude is set to the maxi-

mum value preserving the original phase. At all remaining positions the field

is not changed. The scaling mode (↪→Sec. 11.2.5) of the newly generated

field is set to Automatic Scaling.

Lift Positive Searches for the minimum value of the real part of the field and subtracts

that value from all field positions. For a real-valued field this corresponds to

adding the minimum value which ensures a non-negative field.

Simulate Sinc Modulation

Due to Pixelation

Analytical simulation of the pixelation effect of a transmission in the far field

for a plane wave illumination. This function is to be applied on a harmonic

field already being in the far field. ↪→Sec. 138.1.2

Compensate SincModula-

tion Due to Pixelation

Analytical compensation of the pixelation effect of a transmission in the far

field for a plane wave illumination. This function can be used to make a com-

pensation of the sinc-effect for the desired output field (far field) before starting

a transmission design. ↪→Sec. 138.1.2
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22.5 Phase Manipulations

The ribbon menu Manipulations > Phase Manipulations contains several operations for manipulating the

phase of the current field.

ITEM DESCRIPTION

Conjugate Performs a transformation in which each complex number z = a + ib is re-

placed by z? = a− ib.

Unwrap Phase This operation tries to generate a real valued data array which contains the

unwrapped smooth phase of the current field, i. e. to remove 2π jumps. Dur-

ing unwrapping, a simple line by line phase unwrapping algorithm is used.

However, for two-dimensional fields unwrapping is neither unique nor always

possible. For example, fields containing phase dislocations (↪→Sec. 67.8.2)

are generally unwrappable. A precondition for successful unwrapping is a

sufficient sampling of the phase information. If the current complex amplitude

contains information about a dominating spherical phase (↪→Sec. 12.1.1), this

information is taken into account during the unwrapping process.

Remove Phase Disloca-

tions in Rectangular Se-

lection

Phase dislocations (↪→Sec. 67.8.2) are searched and tried to be removed in

the current selection. For removing a certain phase dislocation with charge

c (↪→Sec. 67.8.2), a transmission of a phase dislocation with charge −c is

multiplied to the array at the same position. This operation is repeated for all

phase dislocations which were found within the current selection.

Modify Phase The operations which can be done via the appearing dialog are described

below (↪→Sec. 22.5.1).

Set Analytical Parameter Sets the analytical spherical phase radius to a new value. This manipulation

does not change the resulting phase, at least as long as the sampling dis-

tance is fine enough for the new aberrations (phase minus analytical spheri-

cal phase radius). The corresponding dialog is explained in Sec. 22.5.2, the

concept of the spherical phase radius in Sec. 12.1.1.

RemoveAnalytical Param-

eter

Removes the analytical spherical phase radius. This manipulation does not

change the resulting phase, at least as long as the sampling distance is fine

enough for complete phase information. This can be ensured by using Ma-

nipulations > Sampling Manipulations > Resample According to Spherical

Phase first.

The concept of the spherical phase radius is explained in Sec. 12.1.1.

Remove Sampled

Spherical Phase

If a spherical phase radius is set, the corresponding spherical phase will be

subtracted. For that purpose, the array will be divided by an appropriate

spherical phase function (see Eqs. (41.25)-(41.26)).

22.5.1 Modify Phase

Some phase modifying operations can be done via the dialog shown in Fig. 140.
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Figure 140. Dialog for phase manipulation operations.

The options are:

ITEM DESCRIPTION

Constant Replace or superimpose given constant phase.

Lens Transmission Replace or superimpose lens transmission with the given focal length (see

also Sec. 67.5.2).

Spherical Phase Replace or superimpose spherical phase with given radius (see also

Sec. 41.3.7). If you set the spherical phase radius to a value greater than

105 m, the harmonic field is set to have no spherical phase radius.

Random Replace phase by random phase. The additional parameters correspond

to those of the random phase transmission generator as described in

Sec. 67.7.2.

Replace Phase If selected, the current phase is replaced by the newly created phase.

Superimpose Phase If selected, the newly created phase is superimposed to the current field by

multiplying the corresponding complex transmission function.

22.5.2 Set Spherical Phase Radius

Figure 141. Dialog for setting the spherical phase radius.

The dialog for changing the analytical spherical phase radius of a harmonic field (↪→Fig. 141) has the following

entries:

ITEM DESCRIPTION

Detect Spherical Phase

Radius

If this check box is checked, VirtualLab Fusion tries to detect a dominating

spherical phase radius in the field.

Spherical Phase Radius If the check box Detect Spherical Phase Radius is unchecked, you can set

the radius to a specific value. If you set the spherical phase radius to a value

greater than 105 m, the harmonic field is set to have no spherical phase radius.
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Further details about the detection of a spherical phase factor can be found in Sec. 137.6.

22.6 Lateral Displacement

The ribbon menu Manipulations > Lateral Displacement allows you to do some transformations with regard

to the x- and y-coordinates of the array.

ITEM DESCRIPTION

Mirror Horizontally Applies transformation u(x, y) → u(−x, y), that is the field is mirrored hori-

zontally by a mirror that corresponds to the y-axis.

Mirror Vertically Applies transformation u(x, y) → u(x,−y), that is the field is mirrored verti-

cally by a mirror that corresponds to the x-axis.

Rotate in x-y-Plane Rotates the field by the given angle (↪→Sec. 22.6.1).

Shift Shifts content of the current field by a given number of sampling points.

Transpose Applies transformation u(x, y) → u(y, x), that is the field is mirrored by a

mirror that corresponds to a diagonal in the x-y-plane.

22.6.1 Rotation in x-y-plane

Figure 142. Settings for Rotation in x-y-Plane.

The dialog shown in Fig. 142 allows you to enter settings for the rotation of complex amplitudes in the x-y-plane.

ITEM DESCRIPTION

Rotation Angle Angle by which the field is to be rotated around the z-axis.

Sampling Points Number of sampling points after rotation. The sampling distance of the origi-

nal field is retained.

Interpolation Method Interpolation method to be used (↪→Sec. 13.2.2)

Suggest Sampling Suggest number of sampling points which is necessary for preserving field

information depending on the entered rotation angle

22.7 Array Size Manipulations

The ribbon menu Manipulations > Array Size Manipulations provides the following operations that change

the size of an one- or two-dimensional array:
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ITEM DESCRIPTION

Embed / Extract (Pixel Di-

mensions)

Changes the number of sampling points. If the number of sampling points

is increased then the array is embedded, that means the newly created sur-

rounding sampling points are filled with zero values. Otherwise, i. e. if the

number of sampling points is decreased then the new array is extracted. Em-

bedding as well as extracting is done centered.

Embed / Extract (Physical

Dimensions)

This option works like Embed / Extract (Pixel Dimensions), but the size of the

new array is defined in physical units.

Embed in Double Sized

Array (Center)

This operation corresponds to using Embed / Extract (Pixel Dimensions) with

embedding to the double array size. The original array will be centered in the

result array. The new sampling points are set to zero.

Embed in Double Sized

Array (Corner)

This operation corresponds to using Embed / Extract (Pixel Dimensions) with

embedding to the double array size. But the original array will be the bottom

left quadrant in the resulting array. The new sampling points are set to zero.

Make Hermitian This operation corresponds to Embed in Double Sized Array (Corner), but

in addition the upper right quadrant is filled by the complex conjugate of the

original array in order to ensure that the result is Hermitian (↪→Sec. 67.7.2).

Replicate Twice Fill the resulting array by 2 (one-dimensional case) or 2× 2 (two-dimensional
case) replications of the original array. This operation is equivalent to use

Replicate Periodically with the double array size and a shift of (0, 0).

Replicate Periodically This operation is typically used for increasing the number of sampling points

to the given array size. The newly created array is filled by periodically repli-

cating the contents of the current one (↪→Sec. 22.7.1).

Extract Range Selec-

tion /

Extract Rectangular Se-

lection

Creates a new array which contains the selected portion of the current array.

Extract Profile Line Extracts the one-dimensional cross-section defined by the line marker

(↪→Sec. 11.3) to a separate one-dimensional harmonic field (↪→Sec. 22.7.2).

22.7.1 Replicate Periodically

Figure 143. Dialog for periodic replication.

A new array is created, filled by periodically replicating the contents of the current array. In the dialog (↪→Fig. 143)

the following parameters have to be entered:
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ITEM DESCRIPTION

Sampling Points Size of the new array (in number of sampling points).

Shift This value indicates which point of the current array is set at the lower left

corner of the replicated one. So the value has to lie inside the source array.

22.7.2 Extract Profile Line

The one-dimensional cross section marked by a Profile Line in a two-dimensional array can be extracted using

Manipulations > Array Size Manipulations > Extract Profile Line.

Figure 144. Dialog for extraction of a profile.

The dialog shown in Fig. 144 is used to define the extraction. The following parameters can be entered:

ITEM DESCRIPTION

Interpolation The type of interpolation that shall be used to find the equidistant sampling

points of the resulting array if the points on the line in the initial array are not

equidistant.

Coordinates Determines whether the Start and End coordinates shall be given in physical

units or as the indices of sampling points.

Start Starting point of the line to extract. Initially the start coordinates of the profile

line are filled in here.

End End point of the line to extract. Initially the end coordinates of the profile line

are filled in here.

Number of Sampling

Points

The number of sampling points the resulting array shall contain.

Remove Spherical Phase

Factor

If checked and a Spherical Phase Factor is given for the array, it will be re-

moved from the phase of the resulting array.

Recent Parameters Restores the values which were stored for the last call of this operation, i. e.

if the dialog was last closed using OK. With this option you can easily extract

the same profile line from various harmonic fields. If these recent values do

not fit in the current array, this button is disabled and a warning is shown.
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22.8 Sampling Manipulations

The ribbon menu Manipulations > Sampling Manipulations provides the following operations that change

the sampling distance:

ITEM DESCRIPTION

Interpolate Using this manipulation (↪→Sec. 22.8.1), the sampling parameters of an array

can be changed, whereby the originally stored physical information shall be

preserved. This operation can also be executed by clicking directly on the

upper part of the Manipulations > Sampling Manipulations menu.

Oversample Twice (Ze-

roized)

The number of sampling points is doubled by splitting each sampling point

into 2 × 2 new points of half the original sampling distance. The new point

with the same physical position contains the old complex value, the remaining

sampling points are filled with zero.

Oversample Twice

(Sinc FFT Interpolation)

This is equivalent to use Interpolate with the interpolation method Sinc

(Fourier Transformation)-interpolation, half the original sampling distance,

and a zero point of (0, 0).

Oversample Twice

(Nearest Neighbor Inter-

polation)

The number of sampling points is doubled by splitting each sampling point into

2× 2 new points of half the original sampling distance. All new points contain

the value of the original sampling point. In this way propagation methods

consider the original data as pixelated data.

Oversample 3× (Near-

est Neighbor Interpola-

tion)

The number of sampling points is tripled by splitting each sampling point into

3 × 3 new points of one third the original sampling distance, containing the

value of the original sampling point. In this way propagationmethods consider

the original data as pixelated data.

Resample According to

Spherical Phase

If a spherical phase radius is set, this option resamples the array in a way

that the corresponding spherical phase will be sampled correctly (according

to the Whittaker Shannon theorem, see [Goo68]). In the Optical Setup, this

can be done with the ideal component Ideal Components > Manipulators >

Sample Spherical Phase Radius.

22.8.1 Interpolation

This operation is available via Manipulations > Sampling Manipulations > Interpolate.

Its edit dialog (↪→Fig. 145) has the following settings:

ITEM DESCRIPTION

Interpolation Method The used interpolation method. ↪→Sec. 13.2.2

Sampling Points The number of sampling points the new array shall contain.

Sampling Distance The sampling distance of the new array.

Array Size The array size of the new array.

Copy from... By pressing this button a dialog will appear where another harmonic field can

be selected to copy the sampling parameters from.

Zero Point Zero point of the resulting field relative to the zero point of the original array.

Document Parameters Fills the controls according to the sampling parameters of the currently se-

lected array.
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Figure 145. Dialog for adjusting the interpolation settings.

22.8.2 Field Size and Sampling Manipulation in the Optical Setup

Figure 146. The Field Size and Sampling Manipulation dialog.

As you can see in Fig. 146, the Field Size and Sampling Manipulation dialog has four group boxes: Preparation

of Field Position Before Operator Application, Change Field Size, Change Field Sampling, and Settings.

Within the region Preparation of Field Position Before Operator Application the user can specify how the incident

field position of the Field Size And Sampling operator shall be defined. The has three different options:

• Keep Lateral Position and Orientation of Field

• Bring Field into Operator Plane but Keep Lateral Position of Field

• Bring Field into Operator Plane and Center to Optical Axis of Operator

The meaning of each option is explained within a sketch accessible by clicking on the info label in more detail.
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The Change Field Size box has the following entries:

ITEM DESCRIPTION

Scale Field Size PV The size of the output field is n times larger than of the incoming field. n is a

vector to allow different scaling for x- and y-direction.

Set Field Size PV You can directly set the field size in physical coordinates.

Calculate Field Size from

Sampling Points PV

The field size is calculated from the specified number of sampling points (x-

and y-direction) and the sampling distance of the incoming field.

Optimize Field Size (Accu-

racy Factor) PV

The field size is calculated automatically according to the power portion spec-

ified in the Global Options dialog (↪→Sec. 6.12). The given accuracy factor

enlarges the field by the given factor.

The Change Field Sampling box has the following entries:

ITEM DESCRIPTION

Scale Sampling Distance

by Oversampling Factor PV

The sampling distance in the output field is n times smaller than in the incom-

ing field. n is a vector to allow different sampling for x- and y-direction.

Set Sampling Distance PV You can directly set the sampling distance for both x- and y-direction.

Optimize Sampling Dis-

tance (Accuracy Factor) PV

The sampling distance is calculated automatically. With the accuracy factor

you can reduce the sampling distance by the given factor. In this case the

InterpolationMethod is fixed toAccelerated Sinc Interpolation (↪→Sec. 13.2.2).

The Settings box has the following entries:

ITEM DESCRIPTION

Interpolation Method The used interpolation method. ↪→Sec. 13.2.2.

Keep Analytic Parameter

Recalculate Analytic Pa-

rameter

Specify whether analytic parameters like the spherical phase radius are taken

from the incoming field or calculated anew.

The remaining controls of this dialog are explained in Sec. 66.

22.9 Selection Related Operations

All operations in the ribbon menu Manipulations > Selection Related Operations affect the selected area of

the array only. These are:
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ITEM DESCRIPTION

Fill Range Selection /

Fill Rectangular Selection

Sets the sampling points within the selection to a user-defined complex value

c. Keep in mind that for globally polarized fields the new Ex values within the

selection are Jx · c and the new Ey values are Jy · c, with J being the Jones

vector.

Clear Range Selection /

Clear Rectangular Selec-

tion

Sets the sampling points within the selection to zero.

Clear Inverse of Range

Selection /

Clear Inverse of Rectan-

gular Selection

Sets the sampling points outside the selection to zero.

Extract Range Selec-

tion /

Extract Rectangular Se-

lection

Creates a new array which contains the selected portion of the current array.

Extract Profile Line Extracts the one-dimensional cross-section defined by the line marker

(↪→Sec. 11.3) to a separate one-dimensional harmonic field (↪→Sec. 22.7.2).

Normalize According to

Range Selection /

Normalize According to

Rectangular Selection

Normalizes the current array by dividing it (at all sampling points) by the max-

imum amplitude within the current selection.

Remove Phase Disloca-

tions in Rectangular Se-

lection

Phase dislocations (↪→Sec. 67.8.2) are searched and tried to be removed in

the current selection. For removing a certain phase dislocation with charge

c (↪→Sec. 67.8.2), a transmission of a phase dislocation with charge −c is

multiplied to the array at the same position. This operation is repeated for all

phase dislocations which were found within the current selection.

Create Signal Region from

Selection

This item creates a region document (↪→Sec. 21). The result will be a sampled

region which has the same sampling parameters as the current harmonic field

or Jones matrix transmission document. The selected range or rectangle

marker will define the actual signal region, independent of the values inside

the original selection.

22.10 Polarization Change

All operations in the ribbon menu Manipulations > Polarization Change affect somehow the Jones Vector J
of a globally polarized field (↪→Sec. 131.1).

ITEM DESCRIPTION

Convert to Locally Polar-

ized Field

Converts the current globally polarized field to the more general type of a

locally polarized one corresponding to

Ex(x, y) = JxU(x, y) (22.2)

Ey(x, y) = JyU(x, y) . (22.3)
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Split into Globally Polar-

ized Fields

Splits a locally polarized field into two globally polarized fields which corre-

spond to the Ex and the Ey component of the original field. The new Jones

vectors are (1, 0)T and (0, 1)T. This option can be used to reducememory and

time consumption if you have a locally polarized field with negligible Ey field

(e. g. after geometric optics propagation with Fresnel effects considered).

Change Jones Vector Opens a dialog (↪→Fig. 147) which allows you to set the Jones Vector. The

controls of this dialog are the same as for setting the Jones vector of a newly

generated field, ↪→Sec. 48.3. This operation can also be done via the (Cur-

rent) Data tab of the property browser (↪→Fig. 148).

General A general Jones Matrix Multiplication (↪→Sec. 22.10.1). Its edit dialog is ex-

plained in Sec. 22.10.1.1.

Linear Polarization A Jones Matrix Multiplication (↪→Sec. 22.10.1) describing a linear polarization.

Its edit dialog is explained in Sec. 22.10.1.2.

Phase Shift A Jones Matrix Multiplication (↪→Sec. 22.10.1) describing a phase shift. Its

edit dialog is described in Sec. 22.10.1.3.

Retardation A Jones Matrix Multiplication (↪→Sec. 22.10.1) describing a retardation. Its

edit dialog is described in Sec. 22.10.1.4.

Rotation A Jones Matrix Multiplication (↪→Sec. 22.10.1) describing a rotation. Its edit

dialog is described in Sec. 22.10.1.5.

Application on Harmonic Fields Sets

For a Harmonic Fields Sets these manipulations are applied separately on each member field. The

resulting fields are then combined into a new Harmonic Fields Sets (two for Split into Globally Polarized

Fields).

Note that a Harmonic Fields set can contain both globally and locally polarized fields. In this case both

Convert to [Pure] Locally Polarized Field and Split into [Pure] Globally Polarized Fields are available.

Figure 147. Dialog used to edit the Jones vector.
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Figure 148. How to edit the Jones vector via the property browser.

22.10.1 Jones Matrix Multiplication

Some optical elements and devices influence the polarization state of light. Mathematically this process can

be described by a change of the electric field vector by a matrix, called Jones matrix J

E out
xy = J · E in

xy. (22.4)

For globally polarized fields, this means a change of the Jones vector:

Jout = J · Jin. (22.5)

Since Transmissions contain their own Jones matrix J (T), the effect of a Jones Matrix Multiplication can be

“added” to the transmission by applying former to the latter, which corresponds to the mathematical operation

J (T)
out = J ·J (T)

in
. (22.6)

For your convenience, the four important cases of Linear Polarization, Phase Shift, Retardation, and Ro-

tation are implemented as separate manipulations in VirtualLab Fusion (described in the following sections

Sec. 22.10.1.2 to Sec. 22.10.1.5). That means, the user does not have to enter the Jones matrix but only one

single parameter describing the appropriate physical effect. For other cases a General Jones matrix can be

defined (↪→Sec. 22.10.1.1).

22.10.1.1 General

For the multiplication of an arbitrary Jones matrix this manipulation is used.

Figure 149. Controls for defining the parameters of an arbitrary Jones matrix multiplication.

The following parameters are available for a General Jones Matrix Multiplication (↪→Fig. 149):

ITEM DESCRIPTION

Jones Matrix Matrix with four complex entries.

Representation Representation of the complex values in the Jones matrix.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.
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22.10.1.2 Linear Polarization

A linear polarizer is a kind of optical filter that will pass only that part of Exy which oscillates in a certain direction.

If this direction is given by an angle α, the corresponding Jones matrix is given by

J =

 cos2 α sin α cos α

sin α cos α sin2 α

 . (22.7)

Figure 150. Controls for defining the parameters of a linearly polarizing Jones matrix multiplication.

The following parameters are available for a Linear Polarization function (↪→Fig. 150):

ITEM DESCRIPTION

Polarization Angle The angle of the plane of polarization of the filtered, linearly polarized light.

Type Here you can select one of the two special cases Along x Direction, which

corresponds to a polarization angle of α = 0°, which means that the compo-

nent Ey is set to 0, or Along y Direction, which corresponds to a polarization

angle of α = 90°, which means that the component Ex is set to 0. The case of

an arbitrary polarization angle is called General.

Jones Matrix The resulting Jones matrix that describes the linear polarization.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

22.10.1.3 Phase Shift

A Phase Shift adds a phase difference φ to both Ex and Ey. The appropriate Jones matrix is

J =

exp(iφ) 0

0 exp(iφ)

 . (22.8)

Figure 151. Controls for defining the parameters of a Phase Shift.

The following parameters are available for a Phase Shift function (↪→Fig. 151):
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ITEM DESCRIPTION

Phase Shift The phase shift φ for both Ex and Ey.

Jones Matrix The resulting Jones matrix that describes the phase shift.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

22.10.1.4 Retardation

Retarders as e. g. quarter-wave plates or half-wave plates “retard” Ey against Ex by a phase difference φ.

Thereby linearly polarized light can be transformed into circularly polarized and vice versa, for example. The

appropriate Jones matrix is

J =

1 0

0 exp(−iφ)

 . (22.9)

Figure 152. Controls for defining the parameters of a Jones matrix retardation.

The following parameters are available for a Retardation function (↪→Fig. 152):

ITEM DESCRIPTION

Phase Delay The phase shift Ey shall get.

Type Here you can select one of the two important special cases Quarter-Wave

Retarder, which corresponds to a phase delay of π/2, used for transforming
linearly polarized light to circularly polarized and vice versa, or Quarter-Wave

Retarder, which corresponds to a phase delay of π, used for transforming

right-circularly polarized light into left-circularly and vice versa. The case of

an arbitrary phase delay is called General.

Jones Matrix The resulting Jones matrix that describes the retardation.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

22.10.1.5 Rotation

The angle of rotation θ of the plane of polarization determines the Jones matrix as follows

J =

cos θ − sin θ

sin θ cos θ

 . (22.10)



CHAPTER 22. MANIPULATIONS OF COMPLEX AMPLITUDE DOCUMENTS 220

Figure 153. Controls for defining the parameters of a Jones matrix rotation.

The following parameters are available for a phase rotation function (↪→Fig. 153):

ITEM DESCRIPTION

Rotation Angle The angle by which the plane of polarization shall be rotated.

Jones Matrix The resulting Jones matrix that describes the rotation of the plane of polar-

ization.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

22.11 Miscellaneous

The ribbon menu Manipulations > Miscellaneous contains various special manipulations e. g. to introduce

discrete value levels.

22.11.1 Resample to Angular Coordinates

This manipulation converts a given Harmonic Field into a Data Array with angular coordinates. To this end for

a spatial field first a Fourier transform is done.

to Angular Coordinates.pdf to Angular Coordinates.png to Angular Coordinates.eps

Figure 154. Options for resampling a harmonic field to angular coordinates.

The edit dialog (↪→Fig. 154) for this manipulation has the following settings.

ITEM DESCRIPTION

Vectorial Components Allows you to select any combination of Ex, Ey and Ez.

Coordinate Type Whether you want to use Cartesian Angles or Spherical Angles.

Oversampling Factors By default a good automatic sampling is used. However you can create more

sampling points for Alpha and Beta or Phi and Theta, respectively, by increas-

ing the oversampling factors.

22.11.2 Hard Quantization

The menu item Manipulations > Quantization > Hard Quantization opens a dialog which allows you to enter

the numbers q and Q of amplitude and phase levels, respectively.

The quantization is performed independently for amplitude and phase. For each position (x, y) the original field
value u(x, y) = A exp[iφ] is replaced by A′ exp[iφ′], where

A′ =


A if q = 0

Amax if q = 1
Amax
q−1 · b(q− 1) A

Amax
e otherwise

(22.11)
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(where b·e denotes the rounding-to-nearest-integer operation) and

φ′ =

φ if Q = 0
2π
Q · b

Q(φ+π)
2π e − π otherwise

(22.12)

Amax is the maximum amplitude within the input field. Compared to the definition of the phase quantization

operator Πquant,Q used during IFTA optimization (↪→Sec. 97), which corresponds to the case of q = 1, the
definition given in this section allows simultaneous amplitude and phase quantization. Furthermore, the special

cases for q = 0 and Q = 0 have been included for maintaining the original amplitude and phase, respectively.
In cases of q = 1 the amplitude is set to one. If Q = 1, the resulting field has a zero phase.

22.11.3 Soft Quantization

The menu item Manipulations > Quantization > Soft Quantization opens a dialog which allows you to enter

the numbers q and Q of amplitude and phase levels, respectively. Furthermore a projection strength λ can be

entered.

The quantization is performed independently for amplitude and phase. For each position (x, y) the original field
value u(x, y) = A exp[iφ] is replaced by A′ exp[iφ′]. The amplitude A′ is obtained by

A′ =



A if q = 0

Amax if q = 1∧ C1 = true

Amax
q−1 · b(q− 1) A

Amax
e if q > 1∧ C2 = true

A otherwise

(22.13)

with the Boolean terms

C1 =

(
| A
Amax

− 1| ≥ 0.5λ

)
, (22.14)

C2 =

(∣∣∣∣ A
Amax

− 1
q− 1

· b(q− 1)
A

Amax
e
∣∣∣∣ ≥ λ

2(q− 1)

)
. (22.15)

The phase φ′ is calculated from

φ′ =

φ if Q = 0∨ C3 = true

2π
Q · b

Q(φ+π)
2π e − π otherwise

(22.16)

with the Boolean term

C3 =

(
Q > 0∧

∣∣∣∣φ− 2π

Q
· bQ/(2π)φe

∣∣∣∣ > λπ/Q
)

. (22.17)

Amax is the maximum amplitude within the complex amplitude field.

Compared to the definition of the phase quantization operator Πλ
softquant,Q used during IFTA optimization

(↪→Sec. 97), which corresponds to the case of q = 1, the definition given in this section allows for simulta-

neous amplitude and phase quantization. Furthermore, the special cases for q = 0 and Q = 0 have been

included for maintaining the original amplitude and phase, respectively. If Q = 1, the resulting field has a zero
phase.

22.11.4 Floyd-Steinberg Quantization

The menu item Manipulations > Quantization > Floyd-Steinberg Quantization opens a dialog which allows you

to enter the numbers q and Q of amplitude and phase levels, respectively.

The result of the Floyd-Steinberg quantization contains only field values from the set

M(q,Q) = {A exp[iφ] : A ∈ Mq ∧ exp[iφ] ∈ MQ}, (22.18)
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where the sets Mq and MQ are given by

Mq =

{
jAmax

q− 1
: j = 0 . . . q− 1

}
(22.19)

and

MQ =

{
exp

[
−iπ

(
−1 +

2π j
Q

)]
: j = 0, 1, . . . , Q− 1

}
. (22.20)

Amax is the maximum amplitude within the complex amplitude field.

In contrast to the quantization types described in the previous two sections, the Floyd-Steinberg quantization

is not a pointwise operation. That is, the quantization result at a position (x, y) does not depend only on the

field value u(x, y) but also on the field values on neighboring positions. The basic idea of the Floyd-Steinberg
quantization is to distribute the error, which wasmade by the quantization at a certain position, to the neighboring

positions.

During the application of the Floyd-Steinberg quantization an iteration through all field positions is performed

row by row, whereby within each row positions are considered consecutively from left to right. At a considered

position (x, y) firstly a hard quantization is performed (↪→Sec. 22.11.2). After that the quantization error is

calculated from the difference between u(x, y) and the obtained quantization value.
This difference is spread using the weighting factors shown in Fig. 155 to four neighboring positions, which are

considered in following iterations.

Figure 155. Weighting factors for distribution of quantization errors to neighboring positions during Floyd-Steinberg quan-

tization.

22.12 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

22.13 Fourier Transform

For a detailed discussion of Fourier transforms ↪→Sec. 31.

23 Manipulations of Harmonic Fields Sets

Harmonic Fields Sets support the following manipulations.
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ITEM DESCRIPTION

Indexwise Addition The current and the last active Harmonic Fields Set can be summed in-

dexwise. That means simply to add their member harmonic fields with the

same index respectively. So the fields of the result set are calculated by

unew,i = u1,i + u2,i. If one of the initial fields sets has more members than the

other one, the surplus fields are just appended. This operation can also be

done with the + key.

Remove Sampled

Spherical Phases

If a spherical phase radius is set for any member field, the corresponding

spherical phase will be subtracted. For that purpose, the member field will be

divided by an appropriate spherical phase function (see Eqs. (41.25)-(41.26)).

Sampling Manipula-

tions

Provides operations that change the sampling distance of all member fields.

↪→Sec. 23.1.

Extraction Tools These tools can be used to extract partial information from a Harmonic Fields

Set. ↪→Sec. 23.2

Polarization Change Either converts all member fields to globally or locally polarized ones or ap-

plies a Jones Matrix Multiplication on each member field. (↪→Sec. 22.10)

The ribbon group Manipulations > Member Harmonic Fields is explained in Sec. 23.3, the ribbon group Manip-

ulations > Conversions in Sec. 30.2, and the ribbon group Manipulations > Fourier Transformation (Space) in

Sec. 31.1.

23.1 Sampling Manipulations

The ribbon menu Manipulations > Sampling Manipulations provides the following operations that change

the sampling distance of all member fields:

ITEM DESCRIPTION

Oversample Twice

(Sinc FFT Interpolation)

Uses the interpolation method Sinc (Fourier Transformation) (↪→Sec. 13.2.2)

to halve the original sampling distance of each member field.

Resample According to

Spherical Phase

If a spherical phase radius is set for a member field, this option resamples

the field in a way that the corresponding spherical phase will be sampled

correctly (according to the Whittaker Shannon theorem, see [Goo68]). In the

Optical Setup, this can be done with the ideal component Ideal Components

> Manipulators > Sample Spherical Phase Radius.

23.2 Extraction Tools

The following tools can be used to extract partial information from a Harmonic Fields Set.
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ITEM DESCRIPTION

Point Profile Extraction Extracts the complex value on a user-defined position and plots this value

versus the index or the wavelength of each Harmonic Fields Set member.

↪→Sec. 23.2.1

Line Profile Extraction Extracts the complex values along a user-defined line and plots these values

versus the index or the wavelength of each Harmonic Fields Set member.

↪→Sec. 23.2.2

Rectangle Extraction Converts the Harmonic Fields Set into a Field Vector Component (member

fields versus field index) or into a Pulse Component (member fields versus

wavelength). ↪→Sec. 23.2.3

23.2.1 Point Profile Extraction

The Point Profile Extraction extracts the complex value on a user-defined position and plots this value versus

the index or the wavelength of each Harmonic Fields Set member.

Fig. 156 shows the edit dialog of the Point Profile Extraction tool.

Figure 156. Edit dialog for the Point Profile Extraction tool.

The following parameters can be specified by the user:

ITEM DESCRIPTION

Detect At (x,y) The position from which the data shall be extracted. Initially, the current cross

position is set. The button Copy From can be used to copy the cross position

from a present Harmonic Fields Set in VirtualLab Fusion.

Vectorial Component The vectorial component (Ex Component, Ey Component, or Ez Component)

to be evaluated by the evaluation tool.

Evaluate Field Data over

Field Index

Defines whether the complex value shall be shown in dependency on the

index in the Harmonic Fields Set.

Evaluate Field Data over

Wavelength

Defines whether the complex value shall be shown in dependency on the

wavelength of each Harmonic Field. This option is only available if each

wavelength in the Harmonic Fields Set is unique.

The resulting diagram contains the complex value in dependence on the user-defined independent variable

(index or wavelength). This diagram supports to switch between the different field quantities. More details can

be found in Sec. 15.

Fig. 157 shows a sample output of the Point Profile Extraction.
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Figure 157. Sample result of a Point Profile Extraction.

23.2.2 Line Profile Extraction

The Line Profile Extraction extracts the complex values along a user-defined line and plots these values versus

the index or the wavelength of each Harmonic Fields Set member.

Fig. 158 shows the edit dialog of the Line Profile Extraction tool.

Figure 158. Edit dialog for the Line Profile Extraction tool.

The following parameters can be configured in the edit dialog.
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ITEM DESCRIPTION

Start At (x,y) The start position of the line to be extracted. Initially, the start position of

the current profile line is set. The button Copy From can be used to copy

the starting point of the line from a present Harmonic Fields Set in VirtualLab

Fusion.

End At (x,y) The end position of the line to be extracted. Initially, the end position of the

current profile line is set. The button Copy From can be used to copy the end

point of the line from a present Harmonic Fields Set in VirtualLab Fusion.

Vectorial Component The vectorial component (Ex Component, Ey Component, or Ez Component)

to be evaluated by the evaluation tool.

Evaluate Field Data over

Field Index

Defines whether the complex value shall be shown in dependency on the

index in the Harmonic Fields Set.

Evaluate Field Data over

Wavelength

Defines whether the complex value shall be shown in dependency on the

wavelength of each Harmonic Field. This option is only available if each

wavelength in the Harmonic Fields Set is unique.

The resulting diagram contains the complex value in dependence on the user defined independent variable

(index or wavelength). This diagram supports to switch between the different field quantities. More details can

be found in Sec. 15.

23.2.3 Rectangle Extraction

The Rectangle Extraction converts the Harmonic Fields Set into a Field Vector Component (member fields

versus field index) or into a Pulse Component (member fields versus wavelength).

Fig. 159 shows the edit dialog of the Rectangle Extraction tool.

Figure 159. Edit dialog for the Rectangle Extraction tool.

The following parameters can be configured in the edit dialog.
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ITEM DESCRIPTION

Center Point The user can specify the center point of the rectangle which should be eval-

uated.

Size The size of the rectangle which should be extracted. The button Copy From

can be used to copy the Center Point and the Size of the rectangle from a

present Harmonic Fields Set in VirtualLab Fusion.

Resolution The user can select whether he like to specify the resolution or the sampling

points of the rectangle which should be generated by the tool.

Sampling Points The user can select whether he like to specify the resolution or the sampling

points of the rectangle which should be generated by the tool.

Vectorial Component The vectorial component (Ex Component, Ey Component, or Ez Component)

to be evaluated by the evaluation tool.

Evaluate Field Data over

Field Index

Defines whether the complex value shall be shown in dependency on the

index in the Harmonic Fields Set.

Evaluate Field Data over

Wavelength

Defines whether the complex value shall be shown in dependency on the

wavelength of each Harmonic Field. This option is only available if each

wavelength in the Harmonic Fields Set is unique.

The resulting document (↪→Sec. 15) contains the complex values in dependence on the user defined indepen-

dent variable (index or wavelength). It supports to switch between the different field quantities.

23.3 Accessing the Members of a Harmonic Fields Set

The ribbon group Manipulations > Member Harmonic Fields contains the following items to access the member

fields of the current Harmonic Fields Set.

ITEM DESCRIPTION

Append Field Appends either the selected Harmonic Field or all members of the selected

Harmonic Fields Set to the current Harmonic Fields Set as last element(s).

Note that parameters must be suitable as mentioned below. The dialog is

shown in Fig. 160.

Insert Field Inserts either the selected Harmonic Field or all members of the selected

Harmonic Fields Set to the current Harmonic Fields Set at the given Index.

Note that parameters must be suitable as mentioned below. The dialog is

shown in Fig. 161.

Replace Field Replaces the member field at the given Index in the Harmonic Fields Set by

a different one. Note that parameters must be suitable as mentioned below.

The dialog is shown in Fig. 162.

Delete Field Deletes the member field at the specified Index of Harmonic Field. The dialog

is shown in Fig. 163.

Extract Field Displays the member field with the specified Index of Harmonic Field as sep-

arate document. The dialog is shown in Fig. 164.

All members of a Harmonic Fields Set must

• be all either in spatial or in spectral domain (↪→Sec. 31.1),

• all propagate in either positive or negative z-direction (↪→Sec. 131.3), and
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• be all either one or two-dimensional.

The embedding material of the harmonic fields set is determined from the very first member field added to a

harmonic fields set.

Figure 160. Dialog for appending a field.

Figure 161. Dialog for inserting a field.

Figure 162. Dialog for replacing a field.

Figure 163. Dialog for deleting a field.

Figure 164. Dialog for extracting a field.

23.4 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

23.5 Fourier Transform

For a detailed discussion of Fourier transforms ↪→Sec. 31.

24 Manipulations of Data Arrays

24.1 Manipulations for Different Types of Data Arrays

There are very different kinds of manipulations for the different types of Data Arrays available. The most im-

portant distinctions which can be made regarding Data Arrays are with reference to:

• the dimensions of the coordinates (usually 1D vs. 2D),
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• complex-valued data vs. real-valued data,

• the regularity of the value distribution (equidistant vs. non-equidistant [but gridded] vs. non-gridded [i.e.

”gridless”]),

• the physical meaning of the object (e.g. Numerical Data Array vs. Electric Field vs. Magnetic Field, etc.).

For more details about these properties please see Sec. 13.

24.1.1 Distinction of 1D vs. 2D

Whether or not a specific manipulation is available for 1D or 2D data is indicated in each of the sections which

describe the manipulations and conversions.

24.1.2 Distinction of Complex-Valued Data vs. Real-Valued Data

Whether or not a specific manipulation is available for complex-valued or real-valued data is indicated in each

of the sections which describe the manipulations and conversions.

24.1.3 Regularity of Value Distribution

Whether or not a specific manipulation is available for equidistant or non-equidistant (but gridded) data is indi-

cated in each of the sections which describe the manipulations and conversions.

For gridless data only a few operations are available: Manipulations > Selection Related Operations >

Extract 1D Data Along Selected Line (↪→Sec. 24.12) and Manipulations > Lateral Displacement >

Transpose (↪→Sec. 24.11).

24.1.4 Distinction With Respect to the Physical Meaning of a Data Array / Using the Expert Mode

Numerical Data Arrays are predestined objects for arbitrary manipulations because they lack any fixed physical

meaning but are mere data containers (↪→Sec. 13.1). So one does not have to care whether a desired operation

makes sense in a physical way and if it will be possible.

On the other hand, Data Arrays with a specific physical meaning provide only those manipulations which make

sense in the specific physical context.

Consequentially, the full spectrum of manipulations and conversions are available for Numerical Data Arrays

only.

If you want to manipulate a physical object in a kind not directly available to the given type of object anyway,

there are two ways to achieve that:

• Either the object is converted to a Numerical Data Array first (↪→Sec. 30.1.1),

• or the Expert Mode is activated first: Manipulations > Expert. This will enable all operations.

24.2 Handling of Subsets

Many manipulations can be done either for theCurrent Subset or for All Subsets. In this case the corresponding

ribbon item is kind of a menu with said two entries. However, if you click directly on the ribbon item, this

manipulation is invoked directly for the current subset.

24.3 Manipulate a Data Copy or the Original Data?

For each single manipulation of a Numerical Data Array object one can decide whether or not this operation

shall create a new object and leave the source object unchanged. This decision is requested via the dialog

shown in Fig. 165.
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Figure 165. Dialog asking whether or not a Numerical Data Array manipulation shall operate on a duplicate.

The dialog will appear every time a manipulation is called, unless Don’t ask again for any manipulation of 1D/2D

Numerical Data Arrays. has been checked eventually. In this case, the last choice will be remembered and

used for any manipulation of a Numerical Data Array of the same dimension (either 1D or 2D).

If a stored duplication setting has to be changed, this can be done via the Global Options Dialog as described

in Sec. 6.16.

24.4 Editing the Coordinate and Interpolation Settings

The ribbon itemManipulations > Coordinate and Interpolation Settings allows to edit the coordinate range(s),

to change the meaning of the coordinates, and to switch between the interpolation methods as well. These

settings can be done via the dialog shown in Fig. 166.

Figure 166. Dialog for changing the coordinate and interpolation settings of an equidistantly sampled, two-dimensional

Numerical Data Array.

ITEM DESCRIPTION

Description The caption of the coordinate axis, i. e. the name or meaning of the coordi-

nate.

Physical Property The physical property (e. g. Length) of the coordinates. An overview of all

supported physical properties and the corresponding units is given in Sec. 5.1.

Interpolation Method The type of interpolation which is used if a value between adjacent sampling

points has to be interpolated. The available interpolation methods are ex-

plained in Sec. 13.2.
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Dimensions The dimensions along the axis can be determined either via Sampling Dis-

tance, Array Size, or Coordinate Extent.

Sampling Distance For equidistantly sampled data, the distance ∆x or ∆y between two adjacent
coordinates. Important: Changing this value will not result in a resampled

Numerical Data Array. This can be done by the resampling operation though,

described in Sec. 24.13.1.

Array Size The distance between the coordinates of the first and the last data point.

Coordinate Extent A I M N N -

.

The distance between the lower boundary of the nearest neighbor interval

of the first data point and the upper boundary of the interval of the last data

point.

Positioning The position of the axis can be determined either via entering a Start Coor-

dinate or by defining that the axis range shall be centered. This can be done

referring to the exact center (Center Around Zero) or to the coordinate of the

data point which has the next higher coordinate to the exact center (Center

Around Zero Node).

Center Around Zero If chosen, the coordinate range will be centered around 0.

Center Around Zero Node For an odd number of sampling points, this will be the same as Center Around

Zero. If chosen for an even number N of sampling points, the coordinate

range will be set in the following way: That sampling point whose (zero

based!) index equals N/2 will get the coordinate 0.

Start Coordinate The coordinate of the first sampling point.

Equals minimum bound-

ary of first interval

A P S D

I M N N .

If checked, the start coordinate refers to the lower boundary of the nearest

neighbor interval of the first data point instead of the coordinate of the first

data point itself.

Upper Boundary of Last

Interval

A - .

This value defines the upper boundary coordinate of the last interval

(↪→Sec. 13.2.1).

Extrapolation Mode In certain circumstances, it is possible that a Data Array has to deliver values

outside its genuine coordinate range. The following options can be set for

Extrapolation Mode: Outside Values are:

• Equal to the Nearest Border Data Point: A constant extrapolation of the

outmost data points is done.

• Zero: All outlying points are considered to be of value 0.

• Constant with Value: All outlying points are considered to be of a value

to be specified.

• Periodically Continued: The whole data of the data array are periodically

continued, using a period of the array’s ’coordinate extent’.
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This button allows to copy settings from another Numerical Data Array as

described in ↪→Sec. 24.4.1.

24.4.1 Copy of Coordinate and Interpolation Settings

If the coordinate and interpolation parameters of one Numerical Data Array shall be copied to another one, this

can be done by using the button .

Figure 167. Dialog for copying the coordinate and interpolation settings of another Numerical Data Array.

ITEM DESCRIPTION

Data Array to Copy from The Numerical Data Array to be copied from can be chosen here.

Settings to Copy Which of the parameters shall be copied are to be specified.

24.5 Editing Subsets

The list of subsets of a Numerical Data Array can be edited as well as some of the subsets’ parameters them-

selves.

24.5.1 Change Subset Parameters

Some subset specific parameters can be edited via the dialog shown in Fig. 168.

Figure 168. Dialog for editing the subset specific parameters.

ITEM DESCRIPTION

Description The name or meaning of the respective subset.

Physical Property The kind of physical quantity of the respective subset’s data.
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24.5.2 Append Subset(s) from Another Data Array

At first, another Numerical Data Array (the source array) has to be selected for copying the subsets from. This

may be the object to be manipulated (the target array) itself. Then, the subsets to be copied and appended can

be chosen in the dialog shown in Fig. 169.

Figure 169. Dialog for selecting the subsets to be appended.

ITEM DESCRIPTION

Subsets for Appending The subsets to be appended can be chosen here by name.

Selection Tools > Select

All

This tool will mark all subsets as selected at once.

Selection Tools > Unse-

lect All

This tool will mark all subsets as not selected at once.

If the coordinates of the data points in the source array are not identical to that in the target array, the user may

choose between two options as described in Sec. 24.6.2.

24.5.3 Delete Subset(s)

The subsets to be removed can be chosen in the dialog shown in Fig. 170.

Figure 170. Dialog for selecting the subsets to be removed.

ITEM DESCRIPTION

Subsets for Removing The subsets to be removed can be chosen here by name.

Selection Tools > Select

All but Current

This tool will mark all subsets as selected, except the currently shown.

Selection Tools > Unse-

lect All

This tool will mark all subsets as not selected at once.

24.5.4 Extract Subset(s)

The subsets to be extracted can be chosen in a similar dialog as shown in Fig. 170.
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ITEM DESCRIPTION

Subsets for Extracting The subsets to be extracted can be chosen here by name.

Selection Tools > Select

All but Current

This tool will mark all subsets as selected, except the currently shown.

Selection Tools > Unse-

lect All

This tool will mark all subsets as not selected at once.

24.5.5 Sum all Subsets

This operation will calculate the sum of all contained subsets. If the data are complex, the user can choose

whether to do a complex addition or to do a real-valued addition of one of the field quantities.

24.6 Array-Array Operations

Via the ribbon menu Manipulations > Array - Array Operations several operations for two array operands

are available:

ITEM DESCRIPTION

Addition Calculates the sum of two Numerical Data Arrays.

Subtraction Calculates the difference of two Numerical Data Arrays.

Multiplication Calculates the product of two Numerical Data Arrays.

Division Calculates the quotient of two Numerical Data Arrays.

Convolution Calculates the convolution A1 ? A2 = F -1[(F A1) · (F A2)] of two Numerical

Data Arrays A1 and A2.

The operations Addition, Subtraction, Multiplication, and Division can also be invoked by using the correspond-

ing keys: + , - , * , and / , respectively. In this case the currently selected document is taken as the second

operand while the previously selected Numerical Data Array is taken as first operand.

24.6.1 Handling Multiple Subsets

Numerical Data Arrays may contain more than one subset. Table 24.3 shows the behavior of the array-array

operations for all possible cases of subset numbers.

No. of subsets m

in 1st operand

No. of subsets n in 2nd operand

n = 1 n > 1

m = 1 s1 ◦ s2 User query

m > 1 User query
n = m: s1 ◦ s2

n 6= m: Error

Table 24.3: Array-Array Operation modes depending on the respective numbers of subsets.

The expression s1 ◦ s2 means that the desired operation simply will be done on the corresponding subsets of

the Data Arrays A1 and A2. User query stands for a dialog which asks the user how to proceed (Fig. 171).
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Figure 171. Dialog which asks the user how to operate if one of the operands contains more than one subset.

The user may decide whether the single subset of the operand A1 shall be processed with all N subsets of the

other operand A2

(
s1 ◦ s(1)2 , s1 ◦ s(2)2 , . . . , s1 ◦ s(N)

2

)
or just with the currently visible subset i of the operand

with more than one subset
(

s1 ◦ s(i)2

)
. The array-array operations are undefined if both of the operating arrays

contain a different number of subsets (n 6= m, n > 1, m > 1).

24.6.2 Handling Differing Coordinate Grids

If the coordinate grids of the two operands are not identical, there’s no straightforward determination of the

resulting coordinate grid. The dialog shown in Fig. 172 helps to make a decision.

Figure 172. Dialog which informs about coordinate related differences between the operands. It allows to choose be-

tween two options as well.



CHAPTER 24. MANIPULATIONS OF DATA ARRAYS 236

ITEM DESCRIPTION

Difference What parameter is different?

Operand #1 The parameter values of operand #1.

Operand #2 The parameter values of operand #2.

Severity Indicates whether the difference is critical or non-critical.

Calculate Common Coor-

dinates

The set of coordinates of the resulting array will be a union of the coordinate

sets of both of the original arrays. The data of both of the operands will be

interpolated to this new grid. Usually, this merge mode will lead to a non-

equidistant coordinate grid.

Keep the Coordinates of

Operand #1

A A -A ↪→S . 24.6.

The set of coordinates of the resulting array will be identical to that of operand

#1. In order to get the values from operand #2 for executing the operation,

interpolation will be used.

Keep the Coordinates of

Operand #2

A A -A ↪→S . 24.6.

The set of coordinates of the resulting array will be identical to that of operand

#2. In order to get the values from operand #1 for executing the operation,

interpolation will be used.

Keep the Coordinates of

the Target Data Array

A A S ↪→S . 24.5.2.

The set of coordinates of the resulting array will be identical to that of the

target array (which is modified by the operation). In order to get the values

from the source array for executing the operation, interpolation will be used.

24.7 Operations with Constant

Via the ribbon menu Manipulations > Operations with Constant several operations with one field operand

are available. In case of operating on a Numerical Data Array containing more than one subset, it is possible to

do each of these operations either on a single subset (i.e. the currently shown subset) or on all of the subsets.

ITEM DESCRIPTION

Set to Constant Sets all data points to the given constant value.

Add Constant Adds the given constant value to all data points.

Multiply Constant Multiplies the given constant value to all data points.

Divide by Constant Divides all data points by the given constant.

Raise to Power of Con-

stant

Raises all data points to the power of the given constant value.

For setting the constant values to operate with, the dialog shown in Fig. 173 is used.
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Figure 173. Dialog for operation with one field operand.

If you choose the mode Operate Complex, the two double numbers to enter are treated as the parts of one

complex number, either in Real / Imaginary or in Amplitude / Phase Representation. Then the operations

are done as a complex addition, multiplication or raise-to-power for each data point. If Operate Separately is

chosen, the first entry operates only on the real part / amplitude of the field and the second number only on

the imaginary part / phase, depending on the choice of Representation. In the following table you can see how

these operations work and what the respective meanings of c1 and c2 are. The original complex value of a data

point (z = a + ib ≡ A exp[iφ]) is changed by the operation with the constants c1 and c2 to the result shown in

the two last columns.

OPERATION REPRESENTATION RESULT OF OPERATION

Mode: Operate Complex Mode: Operate Separately

Add Constant Real / Imaginary (a + ib) + (c1 + ic2) (a + c1) + i(b + c2)

Amplitude / Phase A exp[iφ] + c1 exp[ic̃2] (A + c1) exp [i(φ + c̃2)]

Multiply Constant Real / Imaginary (a + ib) · (c1 + ic2) (a · c1) + i(b · c2)

Amplitude / Phase A exp[iφ] · c1 exp[ic̃2] (A · c1) exp [i(φ · c2)]

Divide by Constant Real / Imaginary (a + ib) : (c1 + ic2) (a : c1) + i(b : c2)

Amplitude / Phase A exp[iφ] : (c1 exp[ic̃2]) (A : c1) exp [i(φ : c2)]

Raise to the Power of Constant Real / Imaginary (a + ib)c1+ic2 (ac1) + i (bc2)

Amplitude / Phase (A exp[iφ])c1 exp[ic̃2] (Ac1) exp [iφc2 ]

c̃2 indicates that this value is an angle, i. e. you can enter it with the unit ’rad’, ’pi’, or ’
◦’ (see Sec. 5.1 for details).

24.8 Field Quantity Operations

For real-valued data arrays, the ribbon menu Manipulations > Field Quantity Operations contains only the

option to convert it to a complex-valued one.

For complex-valued data arrays, this ribbon menu provides several transformations with respect to field quan-

tities. Field quantities are explained in Sec. 11.1.
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ITEM DESCRIPTION

Extract The chosen field quantity will be extracted as real value and stored into the

resulting object.

Move The entries in this submenu are labeled according to which field quantity of the

resultant is filled from which field quantity of the source object. For example,

Manipulations > Field Quantity Operations > Phase to Real Part copies

the phase of the current Numerical Data Array to the real part of the resultant

one, whereby the imaginary part of the resultant object is set to zero.

Swap The entry in this submenu allows you to swap real part and imaginary part.

24.9 Value Scaling

The ribbon menu Manipulations > Value Scaling allows you to perform the following operations with respect

to the data values (the amplitudes in case of complex-valued data):

ITEM DESCRIPTION

Scale to Given Range In a separate dialog you are asked for the new minimum and maximum of

the values in the array. Normalize for example corresponds to setting the

minimum to zero and the maximum to one.

Normalize Normalize the current array by dividing the array at all positions by the maxi-

mum value / amplitude.

Normalize According to

Range Selection /

Normalize According to

Rectangular / Elliptical Se-

lection

Normalizes the current array by dividing it (at all data points!) by themaximum

value/amplitude within the current selection.

Clip Values Clips the current array to a given maximum value / amplitude. At all positions,

where the value/amplitude is above this maximum value, the value / amplitude

is set to the maximum value (preserving the original phase for complex valued

data). At all remaining positions the array is not changed. The scaling mode

of the view (↪→Sec. 11.2.5) of the newly generated array is set to Automatic

Scaling.

Lift Positive Searches for the minimum value (of the real part) of the array and subtracts

that value at all array positions. For a real-valued array this corresponds to

adding the minimum value which ensures a non-negative array.

Delete Numerical Phase

Artifacts

Removes the numerical artifacts described in Sec. 11.8.1 permanently, which

mainly means that amplitudes having less than t times the maximum ampli-

tude are set to zero. In a dialog you can enter this relative threshold t.

24.10 Phase Manipulations

T - N D A .

The ribbon menu Manipulations > Phase Manipulations contains several operations for manipulating the

phase of the current array.
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ITEM DESCRIPTION

Conjugate Performs a transformation in which each complex data value z = a + ib is

replaced by z? = a− ib.

Unwrap Phase This operation tries to generate an array which contains the unwrapped phase

of the current array, i. e. to remove 2π jumps. During unwrapping, a sim-

ple line by line phase unwrapping algorithm is used. However, for two-

dimensional arrays unwrapping is neither unique nor always possible. For

example, arrays containing phase dislocations (↪→Sec. 67.8.2) are generally

unwrappable. A precondition for successful unwrapping is a sufficient sam-

pling of the phase information.

Remove Phase Disloca-

tions in Rectangular / El-

liptical Selection

Phase dislocations (↪→Sec. 67.8.2) are searched and tried to be removed

inside the currently marked selection. For removing a certain phase dislo-

cation with charge c (↪→Sec. 67.8.2), a transmission of a phase dislocation

with charge −c is multiplied to the array at the same position. This opera-

tion is repeated for all phase dislocations which were found within the current

selection.

Modify Phase The operations which can be done are described in Sec. 22.5.1.

24.11 Lateral Displacement

The ribbon menu Manipulations > Lateral Displacement allows you to do some transformations with regard

to the x- and y-coordinates of the array.

ITEM DESCRIPTION

Mirror Horizontally Applies the transformation u(x, y) → u(−x, y), so the array is mirrored hori-
zontally by a mirror that corresponds to the y-axis.

Mirror Vertically T - N D

A .

Applies the transformation u(x, y)→ u(x,−y), so the array is mirrored verti-
cally by a mirror that corresponds to the x-axis.

Rotate in x-y-Plane T - , -

N D A .

Rotates the array by the given angle (↪→Sec. 22.6.1).

Sampled Shift T N

D A .

Shifts the data of the current array by a given number of data points.

Transpose T - N D

A .

Applies the transformation u(x, y) → u(y, x), so the array is mirrored by a

mirror that corresponds to a diagonal in the x-y-plane.

24.12 Array Size Manipulations

The ribbon menu Manipulations > Array Size Manipulations provides the following operations that change

the size of an one- or two-dimensional array:
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ITEM DESCRIPTION

Change Array Size (Pixel

Dimensions)

A N D A .

Changes the number of data points. If the number is increased then the newly

created surrounding data points are filled according to the extrapolation set-

tings of the array (↪→Sec. 24.4). Otherwise, i. e. if the number of data points

is decreased then the new array is extracted. Both operations are done cen-

tered.

Change Array Size (Physi-

cal Dimensions)

A N D A .

This option works like Change Array Size (Pixel Dimensions), but the size of

the new array is defined in physical units.

Double Size (Center) A N D A .

This operation corresponds to using Change Array Size (Pixel Dimensions)

with embedding to the double array size. The original array will be centered

in the result array. The new data points are set according to the extrapolation

settings of the array (↪→Sec. 24.4).

Double Size (Corner) A N D A .

This operation corresponds to using Change Array Size (Pixel Dimensions)

with embedding to the double array size. But the original array will be the bot-

tom left quadrant in the resulting array. The new data points are set according

to the extrapolation settings of the array (↪→Sec. 24.4).

Make Hermitian A N D A .

At first, the array size will be doubled and the original data shifted to the lower

left quadrant of the new array (just like Double Size (Corner) does). In addi-

tion, the upper right quadrant is filled by the complex conjugate of the original

array in order to ensure that the result is Hermitian (↪→Sec. 67.7.2). The upper

left and lower right quadrant are filled with zero values.

Replicate Twice Fill the resulting array by 2 (one-dimensional case) or 2× 2 (two-dimensional
case) replications of the original array. This operation is equivalent to use

Replicate Periodically with the double array size and a shift of (0, 0).

Replicate Periodically This operation creates a new array which is filled by periodically replicating

the contents of the current one (↪→Sec. 24.12.1).

Extract Range Selec-

tion /

Extract Rectangular / El-

liptical Selection

Creates a new array which contains the selected portion of the current array.

Extract Equidistant 1D

Data Along Selected Line

T - N D

A .

Extracts a one-dimensional cross-section defined by the line marker

(↪→Sec. 11.3) to a separate one-dimensional harmonic field (↪→Sec. 24.14.1).

24.12.1 Replicate Periodically

With this manipulation you can replicate a data array periodically along the x- and / or y-direction. This can be

useful if the data array shows something which is periodic or invariant in at least one direction. Fig. 174 shows

an example.
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Figure 174. The Wyrowski Photonics logo replicated periodically using the settings shown in Fig. 175.

Figure 175. Dialog for replicating a Numerical Data Array periodically.

The dialog shown in Fig. 175 has the following options.

ITEM DESCRIPTION

Replication Factor X Specifies how often the data is replicated in x-direction. Can be an arbitrary

value larger than or equal to 1 if the x-axis is sampled equidistantly. Otherwise

you are restricted to integer values, which is also stated by an -icon having

a tooltip.

Replication Factor Y O -

Specifies how often the data is replicated in y-direction. Can be an arbitrary

value larger than or equal to 1 if the y-axis is sampled equidistantly. Otherwise

you are restricted to integer values, which is also stated by an -icon having

a tooltip.

Keep Original Array Cen-

tered

O

If you check this option, the original data array is placed in the center of the

resulting data array. Otherwise (and for data arrays being non-equidistant

in at least one direction) it is placed in the bottom-left corner in case of two-

dimensional data arrays and on the left side in case of one-dimensional data

arrays.
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24.13 Sampling Manipulations

T N D A .

The ribbon menu Manipulations > Sampling Manipulations provides the following operations that change

the sampling distance:

ITEM DESCRIPTION

Equidistant Resam-

pling

Using this manipulation (↪→Sec. 24.13.1), the sampling parameters of an array

can be changed, whereby the originally stored physical information shall be

preserved. This operation can also be executed by clicking directly on the

upper part of the Manipulations > Sampling Manipulations menu.

Oversample Twice (Ze-

roized)

The number of data points is doubled by splitting each data point into 2 ×
2 new points of half the original sampling distance. The new point with the

same physical position contains the old complex value, the remaining data

points are filled with zero.

Oversample Twice

(Sinc FFT Interpolation)

This is equivalent to use Interpolate with the interpolation method Sinc

(Fourier Transformation)-interpolation, half the original sampling distance,

and a zero point of (0, 0).

Oversample Twice

(Nearest Neighbor Inter-

polation)

The number of data points is doubled by splitting each data point into 2 × 2

new points of half the original sampling distance. All new points contain the

value of the original data point.

Oversample 3× (Near-

est Neighbor Interpola-

tion)

The number of data points is tripled by splitting each data point into 3 × 3

new points of one third the original sampling distance, containing the value of

the original data point.

24.13.1 Equidistant Resampling

Equidistant Numerical DataArrays can be resampled using an interpolationmethod. This operation’s parameter

are specified via the dialog shown in Fig. 176.

Figure 176. Dialog for resampling an equidistant Numerical Data Array.
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ITEM DESCRIPTION

Sampling Points The new number of sampling points.

Sampling Distance The new distance between the coordinates of two adjacent sampling points.

Array Size A F C E .

The resulting new array size, defined as the distance between the coordinates

of the last data point and the first data point (see Fig. 177).

Coordinate Extent A F C E .

The resulting new coordinate extent, defined as the complete range covered

by all sampling points including the whole sampling distances around first and

last coordinate. So this range is one sampling distance greater than Array

Size (see Fig. 177). Relevant only if input and output data array contain the

Nearest Neighbor Interpolation method.

Fix Array Size A N

N I .

If activated, the array size (instead of the coordinate extent) will be kept con-

stant (see Fig. 177).

Fix Coordinate Extent A N

N I .

If activated, the coordinate extent (instead of the array size) will be kept con-

stant (see Fig. 177).

Interpolation Method The type of interpolation that is used to calculate the sampling points of the

result. A method different from that contained in the input data array can be

selected here. Which method will be stored with the output depends on the

selected state of the option Keep Interpolation Method of the Numerical Data

Array Unchanged.

Keep Interpolation

Method of the Numeri-

cal Data Array Unchanged

If Interpolation Method differs from the Numerical Data Arrays inherent inter-

polation method, this box allows to decide whether or not the used method

shall be adopted by the resulting Data Array.

Figure 177. Difference between array size and coordinate extent for data arrays with nearest neighbor interpolation

method.

24.14 Selection Related Operations

All operations in the ribbon menu Manipulations > Selection Related Operations affect the selected area of

the array only. These are:
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ITEM DESCRIPTION

Fill Range Selection /

Fill Rectangular / Elliptical

Selection

Sets the sampling points within the selection to a user-defined value c.

Clear Range Selection /

Clear Rectangular / Ellipti-

cal Selection

Sets the sampling points within the selection to zero.

Clear Inverse of Range

Selection /

Clear Inverse of Rectan-

gular / Elliptical Selection

Sets the sampling points outside the selection to zero.

Extract Range Selec-

tion /

Extract Rectangular / El-

liptical Selection

Creates a new data array which contains only the selected portion of the

current data array.

Extract Equidistant 1D

Data Along Selected Line

T - N D

A .

Extracts the one-dimensional cross-section defined by the line marker

(↪→Sec. 11.3) to a separate one-dimensional data array. ↪→Sec. 24.14.1

Extract 1D Data Along

Selected Line

T G D A .

Extracts all data points lying exactly on the line marker (↪→Sec. 11.3) to a

separate one-dimensional, non-equidistant data array.

Extract Subset Data at

One Point

This operation extracts the value(s) a data array has at a certain position.

↪→Sec. 24.14.2

Extract Cross Profile at

Point

O - .

Out of the current position of the point marker, two one-dimensional cross

sections are extracted: one along the x-position of the marker and one along

the y-position of the marker. The two cross sections are shown as separate

data arrays.

Normalize According to

Range Selection /

Normalize According to

Rectangular / Elliptical Se-

lection

Normalizes the current array by dividing it (at all sampling points!) by the

maximum amplitude within the current selection.

Remove Phase Disloca-

tions in Rectangular / El-

liptical Selection

T - , -

N D A .

Phase dislocations (↪→Sec. 67.8.2) are searched and tried to be removed in

the current selection. For removing a certain phase dislocation with charge c
(↪→Sec. 67.8.2), a phase dislocation with charge −c is multiplied to the array
at the same position. This operation is repeated for all phase dislocations

which were found within the current selection.
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24.14.1 Extraction of 1D Data Along Line

T - N D A .

Via Manipulations > Selection Related Operations > Extract Equidistant 1D Data Along Selected Line

or via Manipulations > Array Size Manipulations > Extract Equidistant 1D Data Along Selected Line, an

equidistantly sampled 1D Numerical Data Array can be extracted out of a 2D Numerical Data Array. This will be

done along a previously defined line marker (↪→Sec. 11.3). The dialog shown in Fig. 178 allows you to define

more extraction parameters.

Figure 178. Dialog for defining the parameters for extracting an equidistantly sampled 1D Numerical Data Array out of a

2D Numerical Data Array.

The following parameters can be set, largely to define the new coordinate axis:

ITEM DESCRIPTION

No. of Data Points to Ex-

tract

The number of equidistantly distributed data points in the resulting 1D Nu-

merical Data Array.

Method of Source Array If chosen, the extraction method uses the interpolation method of the 2D

source array for getting each data point’s value.

Nearest Neighbor / Con-

stant Interval

If chosen, the extraction method uses nearest neighbor interpolation (con-

stant interval interpolation in case of nonequidistant data) for getting each

data point’s value.

New Axis Description The description of the target Numerical Data Array’s coordinate can be set

here.

New Axis Physical Prop-

erty of Axis

The physical property of the target Numerical Data Array’s coordinate can be

set here.

New Interpolation Method The interpolation method of the 1D target array can be set here.
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New Coordinate Position-

ing

The mode for calculating the coordinates in the 1D target array has to be

defined here.

• Center Around Zerowill calculate the new coordinates in a way that zero

will be exactly in the center.

• Center Around Zero Node is the same in case of an odd number of

resulting data points, but in case of an even number, the data point at

the left of the exact center of the coordinate range will get the coordinate

zero.

• The mode Start Coordinate allows you to define the value of the start /

the lowest coordinate.

New Coordinate Position-

ing > Equals minimum

boundary of first interval

If the mode Start Coordinate is chosen, the target interpolation method is set

to Nearest Neighbor, and this option is set, the given coordinate will refer to

the minimum boundary of the first data point. If not set, it refers to the center

of the first nearest neighbor interval.

24.14.2 Extraction of 1D Data at One Point

This operation extracts the value(s) a data array has at a certain position. The position is specified by the point

marker (↪→Sec. 11.3).

If the data array contains only one subset, the value at the given position is simply logged into the Messages

tab (↪→Sec. 4.3). In this case always the interpolation method of the source array is used to get the value if the

marker is placed between data points.

Figure 179. Dialog for defining the parameters for extracting an equidistantly sampled 1D Numerical Data Array from the

data at one point.

If the data array contains more than one subset, the data within each subset at the given position becomes one

data point in the resulting one-dimensional data array. In this case the dialog shown in Fig. 179 opens where

the following parameters can be set, largely to define the new coordinate axis:

ITEM DESCRIPTION
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Method of Source Array If chosen, the extraction method uses the interpolation method of the 2D

source array for getting each data point’s value.

Nearest Neighbor / Con-

stant Interval

If chosen, the extraction method uses nearest neighbor interpolation (con-

stant interval interpolation in case of nonequidistant data) for getting each

data point’s value.

New Axis Description The description of the target Numerical Data Array’s coordinate can be set

here.

New Axis Physical Prop-

erty of Axis

The physical property of the target Numerical Data Array’s coordinate can be

set here.

New Interpolation Method The interpolation method of the 1D target array can be set here.

New Data Description The data description of the resulting array.

New Coordinate Position-

ing

The mode for calculating the coordinates in the 1D target array has to be

defined here.

• Center Around Zerowill calculate the new coordinates in a way that zero

will be exactly in the center.

• Center Around Zero Node is the same in case of an odd number of

resulting data points, but in case of an even number, the data point at

the left of the exact center of the coordinate range will get the coordinate

zero.

• The mode Start Coordinate allows you to define the value of the start /

the lowest coordinate.

New Coordinate Position-

ing > Equals minimum

boundary of first interval

If the mode Start Coordinate is chosen, the target interpolation method is set

to Nearest Neighbor, and this option is set, the given coordinate will refer to

the minimum boundary of the first data point. If not set, it refers to the center

of the first nearest neighbor interval.

New Coordinate Position-

ing > New Sampling Dis-

tance

The sampling distance of the new coordinate axis.

24.15 Miscellaneous

The ribbon menu Manipulations > Miscellaneous contains various special manipulations e. g. to smooth

data or to introduce discrete value levels.

24.15.1 Savitzky-Golay Filter

The Savitzky-Golay filter is a commonly used filter to remove noise from measured data while retaining in-

formation like the position of the extrema as good as possible. It is a special moving window filter where a

window of given size k is moved over the data and the data point in the center is then replaced by the value of
a polynomial of order n fitted to the data in the window. The implementation in VirtualLab Fusion supports both

one- and two-dimensional data.
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ITEM DESCRIPTION

Window Size The window size k. If it is even, internally 1 is added to ensure that there is
always a data point in the center of the window. For two-dimensional data the

same window size is used for x- and y-direction.

Order The order n of the polynomials to fit. For k = 0 you obtain a moving average
filter. If n ≥ k− 1 the fitted polynomial reproduces exactly the data points in

the window and thus no smoothing is done.

24.15.2 Temporal Sampling of Real Part

T N D A .

This operation considers the input being static data which will be transformed into time dependent data. The

input will be treated either as being the complex amplitude of a harmonic electric field or just as numerical data

without electromagnetic meaning.

The calculation is done for different time indices within one period and the resulting sampled values are stored

within a numerical data array with a number of subsets, one for each point of time.

The following options are available:

ITEM DESCRIPTION

Sampling Count of T Number of equidistant points of time n within the temporal period T = 2π/ω0.

The real part will be extracted at t = 1
n T, 2

n T, . . . , T.

Treat the Data as Electric

Field

If true, the input will be considered being the complex amplitude of a

harmonic electric field E(r) and the result will be calculated to E(r, t) =

2Re (E(r)exp(−iω0t)). Physical unities and interpolation method will be

taken into account in this case.

If false, the input will be considered being just numerical data fc(r) and the

result will be calculated to g(r, t) = Re ( fc(r)exp(−iω0t)).

With harmonic field data, this operation can be used to get the field components of the electric or the magnetic

field at different points of time.

After conversion of the result into an animation (via Manipulations > Create Animation), one can visualize

the temporal field sampling in a movie.

Note, this operation is available only with data arrays with one subset. However, you can always extract a

subset from a data array with multiple subsets via Manipulations > Change Subset Parameters > Remove

Subset(s) (↪→Sec. 24.5.3).

24.15.3 Quantization

The quantization of a Numerical Data Array means to introduce discrete value levels for real-valued data as

well as discrete amplitude and phase levels for complex-valued data. The following entries are available at

Manipulations > Miscellaneous > Quantization:

ITEM DESCRIPTION

Hard Quantization This calls the Hard Quantization algorithm described in Sec. 22.11.2.

Soft Quantization This calls the Soft Quantization algorithm described in Sec. 22.11.3.

Floyd-Steinberg Quanti-

zation

This calls the Floyd-Steinberg Quantization algorithm described in

Sec. 22.11.4.
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24.16 Editing Single Data Points

It is possible to edit the value of a single data point in a Numerical Data Array. In order to open the dialog shown

in Fig. 180, either the context menu in the Table panel (↪→Sec. 13.5.2) or the Edit Data Point button in the Value

at (x,y) panel (↪→Sec. 13.5.3) has to be used.

Figure 180. Dialog for editing the value(s) of a single data point.

For complex data, the representation of the complex values (Real / Imaginary Part vs. Amplitude / Phase) can

be chosen. Each table row contains the value of one subset for the data point to be edited.

24.17 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

24.18 Fourier Transform

For a detailed discussion of Fourier transforms ↪→Sec. 31.

24.19 Graphics Add-on

For a detailed discussion of graphics add-ons ↪→Sec. 32.

24.20 Expert Mode

O .

Usually, only a few manipulations are available for data arrays with a fixed physical meaning (↪→Sec. 24.1.4).

In case more manipulations are needed, activating the Expert Mode allows to access a lot more operations

on the contained sampled data.

25 Manipulation of Chromatic Fields Sets

25.1 Selection Related Operations

ITEM DESCRIPTION

Extract Equidistant 1D

Data Along Selected Line

O - C F S -

This operation works as described in Sec. 24.14.1 with the difference that it

is not possible to change the interpolation settings for the extraction. Can be

accessed via Manipulations > Array Size Manipulations and via Manipu-

lations > Selection Related Operations.
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25.2 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

25.3 Graphics Add-on

For a detailed discussion of graphics add-ons ↪→Sec. 32.

25.4 Expert Mode

Usually, only a few manipulations are available for chromatic fields sets. In case more manipulations are

needed, activating the Expert Mode allows to access a lot more operations on the contained sampled data.

26 Manipulations of Pulse and Field Components

26.1 Array Size Manipulations

ITEM DESCRIPTION

Change Array Size (Pixel

Dimensions)

A .

Changes the number of data points. If the number of data points is increased

then the array is embedded, that means the newly created surrounding data

points are filled with zero values. Otherwise, i. e. if the number of data points

is decreased then the new array is extracted. Embedding as well as extract-

ing is done centered. Can be accessed via Manipulations > Array Size

Manipulations.

A pulse in time domain is usually sampled equidistantly and thus this opera-

tion can be used to increase the sampling within the frequency domain. See

Sec. 31.2 for the conversion from frequency to time domain and vice versa.

26.2 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

26.3 Fourier Transform

For a detailed discussion of Fourier transforms ↪→Sec. 31.

26.4 Graphics Add-on

For a detailed discussion of graphics add-ons ↪→Sec. 32.

27 Manipulation of Order Collections

27.1 Selection Related Operations

ITEM DESCRIPTION

Extract 1D Data Along

Selected Line

Extracts all data points of the currently shown Gridless Data Array which lie

exactly on the line marker (↪→Sec. 11.3) to a separate one-dimensional, non-

equidistant data array. The order numbers are added as labels to the resulting

data array.

Can be accessed via Manipulations > Selection Related Operations.
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27.2 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

28 Manipulations of Regions

28.1 Edit Region

The edit of an existing region can be done using the dialogs which will open via Manipulations > Edit Region

and which are described in Sec. 21.

28.2 Selection Related Operations

A .

All operations in the ribbon menu Manipulations > Selection Related Operations affect the selected area of

the region. These are:

ITEM DESCRIPTION

Fill Selection Sets the data points within the selection to being ’inside’ the actual region.

Clear Selection Sets the data points within the selection to being ’outside’ the actual region.

Clear Inverse Selection Sets the data points outside the selection to being ’outside’ the actual region.

Extract Selection Creates a new region object which contains only the selected portion of the

current region.

28.3 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

29 Manipulation of Sets of Data Arrays

29.1 Selection Related Operations

ITEM DESCRIPTION

Extract 1D Data Along

Selected Line

O G D A

Extracts all data points of the currently shown Gridless Data Array which lie

exactly on the line marker (↪→Sec. 11.3) to a separate one-dimensional, non-

equidistant data array.

Can be accessed via Manipulations > Selection Related Operations.

29.2 Conversions

For a detailed discussion of all possible conversions ↪→Sec. 30.

29.3 Graphics Add-on

For a detailed discussion of graphics add-ons ↪→Sec. 32.

30 Conversions

Conversions are manipulations whose result is of another document type than the input document.
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30.1 Conversions for Complex Amplitude Documents

Complex Amplitude Documents, namely Harmonic Fields and Jones Matrix Transmissions, allow the following

conversions, which can be found in the ribbon group Manipulations > Conversions.

ITEM DESCRIPTION

Create Numerical Data

Array

Converts the document to a Numerical Data Array. ↪→Sec. 30.1.1, Shortcut:

F3

Create Harmonic Field O J M T

Converts the document to a Harmonic Field.

Create Transmission O H F

Converts the document to a Jones Matrix Transmission.

Create Sampled Region Converts the document to a sampled region (↪→Sec. 21). You are asked for a

relative threshold and all values having a squared amplitude larger than the

maximum squared amplitude times this value are regarded as being ’inside’

the region.

Create Harmonic Fields

Set

O H F

Converts the harmonic field to a harmonic fields set with one member field.

Then you can add further member fields as required (↪→Sec. 23.3).

Convert to Spectral Co-

ordinates /

Convert to Spatial Coordi-

nates

Converts the coordinate axes from Length to Wave Number and vice versa

according to the formulas given at the end of Sec. 135.5.1.1.

As a stored analytical spherical phase is not allowed for spectral fields, you

are asked whether you want to sample or remove that spherical phase factor

prior to converting to spectral coordinates.

Dimension Separation The operations in this menu convert between one- and two-dimensional

fields. ↪→Sec. 30.3.5

To convert globally polarized fields into locally polarized ones and vice versa useManipulations > Polarization

Change (↪→Sec. 22.10).

30.1.1 Conversion to Numerical Data Arrays

If a Harmonic Field, a Transmission, or a Harmonic Fields Set is to be converted to a Numerical Data Array

then the dialog shown in Fig. 181 is used to determine the conversion parameters. For Harmonic Fields Set all

member fields are interpolated to a common sampling using the “Sinc Interpolation (Fourier Transform)”. The

common sampling is derived from the largest field size and the smallest sampling distance of all member fields.
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Figure 181. Dialog for the parameters needed for converting a Harmonic Field or a Transmission into a Numerical Data

Array.

ITEM DESCRIPTION

Component For locally polarized Harmonic Fields, here can be chosen whether the vec-

torial component Ex or Ey or both of them are to be converted to a subset

in the new Numerical Data Array. For globally polarized fields, as well as for

Transmissions, this choice is not provided.

Complex Conversion If checked, the whole complex information will be converted to a complex

Numerical Data Array. If not, a Field Quantity has to be chosen which will be

extracted into a real valued Data Array.

Field Quantity For a non-complex conversion, here the field quantity has to be selected that

shall be extracted for the Numerical Data Array.

Interpolation Method for X

Direction

The interpolation method for the X direction in the Numerical Data Array to be

created is set here.

Interpolation Method for Y

Direction

Despite the synchronization of the interpolationmethods for X andY direction,

the interpolation method for the latter is given here for the sake of complete-

ness.

30.2 Conversions for Harmonic Fields Sets

The ribbon group Manipulations > Conversions of Harmonic Fields Sets has the following entries.

ITEM DESCRIPTION

Create Numerical Data

Array

Converts the document to a Numerical Data Array. ↪→Sec. 30.1.1, Shortcut:

F3

Create Animation Converts the document to anAnimation. Then, eachmember of the Harmonic

Fields Set becomes one frame in the animation.

It works in the same way as the corresponding Combined Output

(↪→Sec. 44.5.1.3).

30.3 Conversions for Data Arrays

The ribbon group Manipulations > Conversions of Data Arrays has the following entries.
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ITEM DESCRIPTION

Create Animation VirtualLab Fusion allows you to convert the subsets of a two-dimensional Data

Array into the frames of an animation. ↪→Sec. 30.3.1

Create Numerical Data

Array

Sometimes a Data Array document is not a Numerical Data Array but has

a physical meaning, for example if you apply the Electric Field detector

(↪→Sec. 75.3.1) on a Harmonic Field. Then the caption of the document dif-

fers (↪→Fig. 182). This manipulation can be used to convert such a document

to a Numerical Data Array. Shortcut: F3

Create Harmonic Field Converts the data array to a Harmonic Field. ↪→Sec. 30.3.2, Shortcut: F3

Dimension Reduction

> Extract All Rows

O - .

Each data row becomes one subset of a one-dimensional data array.

Dimension Reduction

> Extract All Columns

O - .

Each data column becomes one subset of a one-dimensional data array.

Dimension Reduction

> Extract Cross Profile

at Point

O - .

Out of the current position of the point marker, two one-dimensional cross

sections are extracted: one along the x-position of the marker and one along

the y-position of the marker. The two cross sections are shown as separate

data arrays.

Create 2D Data Array O - .

Creates a two-dimensional data array out of the subsets of a one-dimensional

data array. ↪→Sec. 30.3.3

Extrude to 2D Data Ar-

ray

O - .

Creates a two-dimensional data array via extruding a one-dimensional data

array. The result will contain the same number of subsets as the original.

↪→Sec. 30.3.4

Dimension Separation The operations in this menu convert between one- and two-dimensional

fields. ↪→Sec. 30.3.5

Figure 182. Sample captions for a Data Array with physical meaning (top and center) and for a Numerical Data Array

(bottom).

30.3.1 Create Animation from Numerical Data Arrays

O - .

This conversion creates one bitmap from each subset of the currently used data array or set of data arrays.

This bitmap contains the data as shown in the diagram panel (↪→Sec. 13.5.1), it does not contain the axes, the

legend and other additional information. Especially the following settings from the current configuration of the

diagram panel influence the generated bitmaps:

• the color table (↪→Sec. 11.2.4)

• the field quantity (↪→Sec. 11.1)

• whether the view is interpolated (for gridded data arrays, ↪→Sec. 11.2.1)
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• the dot size in pixels (for gridless data arrays, ↪→Sec. 13.5.1.4)

• whether triangles are shown (for gridless data arrays, ↪→Sec. 11.2.3) .

Figure 183. The settings for the conversion to an animation.

There is an edit dialog for this conversion where you can set the bitmap size and the data scaling (↪→Fig. 183).

It has the following controls.

ITEM DESCRIPTION

Aspect Ratio The aspect ratio of the resulting animation is determined in different ways:

• True to Physical Scale: The aspect ratio is determined from the ratio of

the x-axis range of the data array to its y-axis range. This option is not

available if the two coordinate axes have different physical properties.

• User-Defined: If you choose this option you can define a suitable aspect

ratio. For example you can use 16 : 9 to ensure that the animation (and

a video possibly generated out of it via File > Export) looks nicely on

matching monitors or projectors. For gridded data arrays the default

user-defined aspect ratio is calculated from the number of data points

in the data array.

• Free: You can setWidth and Height of the single bitmaps as you want.

Width /Height The width and height of the resulting bitmaps. If the Aspect Ratio is not Free

and you change one dimension, then the other dimension is always changed

automatically.

Scale Frames to • Common Value Range: The global minimum and maximum value of all

subsets is used to scale the color table. As a result you can see in which

subsets there are smaller values then in others.

• Individual Value Range: The color table for each frame is adapted to

the minimum and maximum value of the individual data. As a result all

subsets use all colors of the color table.

If True To Physical Scale is set in the View ribbon of the data array, then True to Physical Scale is set as default.

Otherwise User-Defined is the default.

For sets of data arrays the overall extension, i. e. the union of the ranges of all included data arrays, is shown

in the resulting animation. Subsets from data arrays which have a smaller extension are filled up with black

pixels accordingly.

30.3.2 Conversion of Numerical Data Arrays to Harmonic Fields

The data of a Data Array can be used for creating a new Harmonic Field of course. This can be done via

Manipulations > Create Harmonic Field.

Since some of the parameters have to be specified additionally, the conversion dialog shown in Fig. 184 will

open.
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Figure 184. Dialog for the parameters needed for creating a Harmonic Field from a Numerical Data Array.

ITEM DESCRIPTION

Polarization Mode The resulting field can be Globally Polarized or Locally Polarized.

Subset for U In case of a Globally Polarized resulting field, the Data Array’s subset to be

used as lateral field distribution U can be chosen here.

Subset for Ex/Ey In case of a Locally Polarized resulting field, the Data Array’s subset to be

used as lateral field distribution of the component Ex/Ey can be chosen here.

Wavelength The wavelength of the Harmonic Field to be created.

Jones Vector J In case of a Globally Polarized resulting field, the currently set Jones vector

is shown here. It can be changed via the button Set Jones Vector.

Set Jones Vector The Jones vector for a Globally Polarized resulting field can be set via a dia-

log, that opens when this button is pressed.

ShowWarnings in Case of

Wrong Physical Units

VirtualLab Fusion will check the Numerical Data Array for valid physical units

for the stored data and its coordinates. Valid means: Electric field strength as

unit for the data and a length or reciprocal length for the coordinates. How-

ever, if this option is unchecked, no warnings will be displayed in case of

wrong units.

30.3.3 Create 2D Data Array from 1D

If it makes sense to order all subsets of a one-dimensional Numerical Data Array on another dimension, a

two-dimensional Numerical Data Array can be created from that data. For this, the new dimension has to be

defined using the dialog shown in Fig. 185. The subsets will be concatenated along this new dimension, then.
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Figure 185. Dialog for defining a new dimension for creating a 2D Numerical Data Array from 1D data.

The following parameters are necessary in order to define the second dimension:

ITEM DESCRIPTION

Direction of New Axis Determines whether the new dimension shall be in x or y.

Description The meaning of the new dimension. This will be the label for the new axis of

the resulting Numerical Data Array.

Physical Property The physical property of the new dimension’s coordinate.

Sampling Distance The distance of two adjacent 1D subsets on the new dimension.

First Coordinate The coordinate which corresponds to the first 1D subset on the new dimen-

sion.

30.3.4 Extrude 2D Data Array from 1D

Besides creating a 2D data array from a 1D data array by concatenating its subsets (↪→Sec. 30.3.3), there exists

another possibility of adding another dimension. The dialog shown in Fig. 186 can be used for extruding the

1D data along a new coordinate axis.

Figure 186. Dialog for defining an extrusion of 1D data for creating a 2D Numerical Data Array.

The following parameters are necessary in order to define the extrusion:
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ITEM DESCRIPTION

Direction of New Axis Determines whether the new dimension shall be in x or y.

Number of Points To what number of new data points shall the result be extruded (along the

Direction of New Axis)?

Description The meaning of the new dimension. This will be the label for the new axis of

the resulting Numerical Data Array.

Physical Property The physical property of the new dimension’s coordinate.

Sampling Distance The distance of two adjacent sampling points on the new dimension.

First Coordinate The coordinate which corresponds to the first data point on the new dimen-

sion.

30.3.5 Dimension Separation

The ribbon menu Manipulations > Dimension Separation offers the option to separate a two-dimensional

complex array or to recombine the parts of a previously separated array. A two-dimensional separable array

usep(x, y) fulfills the property
usep(x, y) = ux(x)uy(y), (30.1)

with the one-dimensional arrays ux and uy which are calculated from the (not necessarily separable) current

array u(x, y) by

ux(x) = fxu′x(x), (30.2)

uy(y) = fyu′y(y) (30.3)

with

u′x(x) =
Ny−1

∑
j=0

u(x, yj), (30.4)

u′y(y) =
Nx−1

∑
i=0

u(xi, y) (30.5)

and

fx =

√
f0

Nx

Ny
, (30.6)

fy =

√
f0

Ny

Nx
, (30.7)

where Nx and Ny denote the number of sampling points and f0 is calculated as

f0 =

Ny−1

∑
j=0

Nx−1

∑
i=0

u(xi, yj)ux(xi)uy(yj)

Ny−1

∑
j=0

Nx−1

∑
i=0
‖ux(xi)uy(yj)‖2

. (30.8)
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ITEM DESCRIPTION

Make Field Separable Works similar to Separate into x- and y-Direction (see below) with the excep-

tion that the output of this operation is the two-dimensional separable array

u(x, y) which is calculated according to Eq. (30.1).

Separate into x- and y-

Direction

Constructs two one-dimensional arrays ux and uy, with the goal that the array

usep(x, y) according to Eq. (30.1) differs as little as possible from the current

one. The error criterion is to minimize the squared amplitude sum of the dif-

ference between the original and the approximated array. The arrays ux and

uy are calculated by integrating the current array in Y or X direction, respec-

tively (see Eqs. (30.4)-(30.5)). Afterwards a rescaling factor is applied to ux

and uy, respectively (according to Eqs. (30.6)-(30.8)).

Combine 1D Fields Constructs a two-dimensional separable array according to Eq. (30.1) from

the two given one-dimensional arrays.

30.4 Conversion for Chromatic Fields Sets

ITEM DESCRIPTION

Create Numerical Data

Array

Extracts the underlying Data Array (↪→Sec. 13) and displays it as separate

document. Shortcut: F3

30.5 Conversions for Pulse and Field Components

ITEM DESCRIPTION

Create Animation O - , . .

P C F V C .

VirtualLab Fusion allows to convert the subsets of a Pulse and Field Com-

ponent document into the frames of an animation. The current view settings

Field Quantity and Color Table will be used for the conversion.

Create Numerical Data

Array

Extracts the underlying Data Array (↪→Sec. 13) and displays it as separate

document. Shortcut: F3

30.6 Conversion for Order Collections

ITEM DESCRIPTION

Convert to Equidistant

Data Array

Converts all information (coordinates, efficiencies, and Rayleigh coefficients)

into distinct subsets of an equidistant data array, plotted versus order num-

bers. Shortcut: F3

Extract Current Grating

Efficiencies

Extracts the currently visible grating efficiencies diagram into a gridless data

array (↪→Sec. 13) and displays it as separate document. Shortcut: Shift +

F3
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30.7 Conversion for Regions

ITEM DESCRIPTION

Convert to Sampled Re-

gion

O - .

Opens a dialog for sampling the current region (↪→Sec. 30.7.1).

Create Numerical Data

Array

O .

Extracts the underlying Data Array (↪→Sec. 13) and displays it as separate

document. Shortcut: F3

30.7.1 Conversion to Sampled Regions

Converting non-sampled into sampled regions require input of the sampling parameters. This has to be done

via the dialog shown in Fig. 187.

Figure 187. Dialog for defining the sampling parameters for converting a non-sampled region into a sampled one.

The sampling parameters are the following:

ITEM DESCRIPTION

Sampling Points The number of sampling points to be used in the respective dimension.

Sampling Distance The sampling distance to be used in the respective dimension.

Center Around Zero If checked, the result will be zero centered in the respective dimension. In

order to achieve this, the data will be embedded if necessary.

Array Size Information about the resulting array size.
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30.8 Conversions for Sets of Data Arrays

ITEM DESCRIPTION

Create Animation O D A 2D D A G

VirtualLab Fusion allows you to convert all subsets of a two-dimensional Set

of Data Arrays into the frames of an animation. In the resulting animation first

come the subsets of the first data array, then the subsets of the second data

array and so on. The edit dialog for this conversion is described in Sec. 30.3.1.

Convert to Single Data

Array

O D A 1D D A 2D

Converts the Set of DataArrays into a single data array containing all subsets.

If necessary, the data is resampled to a common grid. Shortcut: F3

Extract Current

Numerical Data Ar-

ray / Electromagnetic

Field /…

Extracts the currently visible Data Array (↪→Sec. 13) and displays it as sepa-

rate document. Shortcut: Shift + F3

31 Fourier Transforms

31.1 Fourier Transform (Space)

The Fourier transform hasmany applications in wave-optical simulations. Examples are the usage in free space

propagation operators (↪→Sec. 93) and the simulation of Fourier transforming optical setups (↪→Sec. 31.1.1).

It is available via various ribbon items in the ribbon group Manipulations > Fourier Transform (Space):

• Manipulations > Forward: x→ k,

• Manipulations > Backward: k→ x,

• Manipulations > Numerical FFT > Forward: x→ k, and

• Manipulations > Numerical FFT Backward: k→ x .

The numerical and the “normal” or physical Fourier transform differ in their scaling: The numerical variants

ensure that the summed norm of the field (↪→Sec. 75.4.7) is not changed by the transform. This leads to the

effect that if you embed the Fourier transform of a field in a zeroized frame and then perform the backward

transform, the power and maximum amplitude of the field has changed. This is circumvented if you use the

physical transforms.

The Fourier transform cannot handle fields having a stored analytical spherical phase. Thus in this case you are

asked whether you want to sample or remove that spherical phase factor prior to the actual Fourier transform.

The used equations are given in Sec. 135.5.1. The Fourier transform can also be done using a focusing lens

(↪→Sec. 31.1.1).
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31.1.1 Fourier Setups

Availability

Toolboxes: All

Accessible:

• Harmonic Field, Harmonic Fields Set, or Jones Matrix Transmission: Manipulations > 1f-Setup

and Manipulations > 2f-Setup

• Harmonic Field and Harmonic Fields Set: Propagations > 1f-Setup and Propagations >

2f-Setup

• Optical Setup: Ideal Components > Special Components > 1f-Setup and Ideal Components >

Special Components > 2f-Setup

A Fourier transform can be done experimentally with an (ideal) focusing lens. The principal setup is shown in

Fig. 188. It is mainly used for optical filtering problems like high-pass and low-pass filters. In the output plane,

the Fourier plane, a filter to truncate high or low frequencies can be placed.

A Far Field Propagation of a paraxial field can also be used to create experimentally the Fourier trans-

form.

Figure 188. Principal setup for a Fourier transform with a focusing lens. f is the “Focal Length” of the lens and d is the
“Distance to Lens”.

If the Distance to Lens d equals the Focal Length f , the setup is called 2f-Setup. In this case the phase in the
output plane vanishes. The other special case, if d is nearly zero, is called 1f-Setup.

Figure 189. Control for editing the 1f-setup function.

Both special cases are available as operators in VirtualLab Fusion. These two operators have nearly identical

dialogs (↪→Fig. 189) with the following parameters:
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ITEM DESCRIPTION

Distance to Lens The distance to the lens (d in Fig. 188) which is identical to the focal length.

This text box is only editable for the 1f-Setup operator.

Focal Length PV The focal length f of the lens.

Simulate Pixelation Ex-

actly

If this box is checked pixelation effects are considered. This is done by per-

forming a Sinc Modulation (↪→Sec. 138.1.2) to the output field, which is equal

to the functionality of Manipulations > Amplitude / Real Part Manipulations

> Simulate Sinc Modulation Due to Pixelation.

If these operators are used in the Optical Setup, the control shown in Fig. 189 is embedded in the general

dialog for Ideal Components which is described in Sec. 66.

31.2 Fourier Transform (Temporal)

31.2.1 Inverse Temporal Fourier Transform

The ribbon item Manipulations > Inverse Temporal Fourier Transform can be used to calculate the pulse

form of the underlying data field. This transformation is only possible if the active document contains a data field

which is defined in the frequency domain. In VirtualLab Fusion these fields can be functions of the frequencies

ν or the wavelengths λ. The resulting function in the time domain will be displayed in a new document.

The edit dialog of the Inverse Temporal Fourier Transform allows you to configure the exclusion of the time

shift within the inverse temporal Fourier Transform. Also the increase of the time window can be specified.

Additionally the user can define an accuracy factor which will influence the sampling in the time domain.

Figure 190. Dialog for the settings of the inverse temporal Fourier transform.

Fig. 190 shows the edit dialog of the Inverse Temporal Fourier Transform. The following parameters can be

specified:
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ITEM DESCRIPTION

Exclude Time Shift of You can exclude the time shift by the inverse temporal Fourier transform. The

position in time of the pulse can be evaluated with the Optical Path Length

Analyzer (↪→Sec. 82).

Extend Time Window by

Factor

For pulse evaluation VirtualLab Fusion implements a smart algorithm to ex-

tend the time window during the inverse temporal Fourier Transform. Therefor

the Optical Path Length Analyzer has to be used. The residuals of the fitted

linear phase function and the correct phase function can be used for the inter-

polation of the underlying data set. A larger time window can be realized by

increasing theOversampling Factor (Frequencies) of theOptical Path Length

Analyzer(↪→Sec. 82). The resulting residual function has to be set into the edit

dialog of the Inverse Temporal Fourier Transform. This can be done by click-

ing on the Set button in the dialog. The accuracy of the selected residual

function defines the time window extension factor. This factor is displayed

and cannot be edited directly by the user.

Oversampling Factor Uses n times the number of preset sampling points, where n is the given

Oversampling Factor.

31.2.2 Temporal Fourier Transform

By clicking on the ribbon item Manipulations > Temporal Fourier Transform a temporal Fourier transform of

the underlying data field is performed. This operation is only available for fields which are defined in the time

domain. The result of this operation is the field in the frequency domain. This field is displayed as function over

ν and also as function over λ.

31.2.3 Envelope to Real Function Converter

If the pulse is displayed in time domain, you can show the real field instead of the envelope using the ribbon

item Manipulations > Envelope to Real Function Converter.

32 Graphics Add-Ons

The manipulations in the category Graphic Add-Ons do not cause changes to the actual data but add some

more graphical information to the view of the currently active object instead.

32.1 Add Region

The ribbon button Manipulations > Add Region allows to select any open region object as source for a

region to be drawn to the currently active view.

In case there is more than one subset present in the current object, an additional dialog will ask for the subsets

to apply the add-on to.

32.2 Add Point Cloud

O - .

The ribbon button Manipulations > Add Region allows to select any open gridless data array or ray distri-

bution as source for a point cloud to be drawn to the currently active view.

In case there is more than one subset present in the current object, an additional dialog will ask for the subsets

to apply the add-on to.
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32.3 Add Polarization Ellipses

O .

The ribbon button Manipulations > Add Polarization Ellipses allows you to calculate polarization ellipses

for Electric or Electromagnetic Fields (↪→Sec. 13.1) either if none were calculated by the Universal Detector

(↪→Sec. 74.4) or if the ellipses shall be calculated anew for whatever reason.

The dialog shown in Fig. 191 will open in order to allow the specification of the calculation of the ellipses.

Figure 191. Dialog for the settings the parameters for calculating polarization ellipses for an existing electric or electro-

magnetic field.

The following parameters are to be specified:

ITEM DESCRIPTION

Field / Data Array O / .

The (sub)field for which the ellipses shall be calculated can be selected here.

Subsets Each Electric or Electromagnetic Field contains one or more subsets repre-

senting the contained vectorial component. This column lists all available

components with names.

Vectorial Component (Ex-

actly Two Needed)

In this column, exactly two vectorial components have to be selected to be

used for calculating the ellipses. Possible combinations are Ex/Ey, Ex/Ez,

Ey/Ez.

Accessible in View Shall the ellipses be available for the view of the respective component? If

so, the visibility of the ellipses can be toggled anyway.

Ignore Vanishing Jones

Vectors

If checked, no polarization ellipses will be calculated at positions where the

amplitudes of both of the Jones vector’s components are below a certain frac-

tion (given be Threshold) of the maximum field amplitude (see also Sec. 11.8).

Threshold O I V J V .

The threshold for identifying vanishing Jones vectors.

Configure Ellipses Pressing this button opens the dialog for configuring the appearance of the

polarization ellipses (↪→Sec. 11.7.3).

32.4 Edit List

Since more than one graphics add-on may be associated with a data array (or data array based object), there

is a list of it which can be edited via Manipulations > Edit List.
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The dialog shown in Fig. 192 allows this editing.

Figure 192. Dialog for editing the list of graphics add-ons.

ITEM DESCRIPTION

Index The layer index. Index #1 corresponds to the bottom layer which is drawn

above the data first. The row with the highest index will be the upmost layer

which is drawn at last.

Up/Down Moves the add-on up or down in the layer order.

Name Name of the add-on.

Subsets Shows for which subsets the add-on is available.

Delete Deletes the add-on in this row.



V Catalogs

The figure above shows the Catalogs ribbon tab. As you can see, cata-

logs are available for

• boundary responses (↪→Sec. 41)

• coatings (↪→Sec. 36)

• components (↪→Part IX)

• detectors (↪→Part XI)

• light sources (↪→Part VIII)

• materials (↪→Sec. 38)

• media (↪→Sec. 37)

• stacks (↪→Sec. 39) and

• surfaces (↪→Sec. 35) .

These catalogs are accessible via the dialog described in Sec. 33. It

serves for adding, viewing, editing, or removing of catalog entries, or for

the selection of an entry. Sec. 34 describes the controls which open that

dialog so that you can apply catalog entries where needed.
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33 Catalog Dialog

Figure 193. The main form for VirtualLab Fusion catalogs.

Fig. 193 shows the main form for catalogs. It contains the following controls:

ITEM DESCRIPTION

Definition Type There are three definition types

1. Templates: Catalog entries with either unspecified parameters or pa-

rameters with default values. These entries are read-only.

2. LightTrans Defined: The parameters are preset to represent a real

structure (e. g. the material “Gold”). These entries are read-only.

3. User Defined: The place where the user can store own entries. These

entries are saved in the path for user settings specified in the Global

Options dialog (Sec. 6.17).

Filter by… If you enter text in this text box, only catalog entries are shown whose name

contains this text. The filter is not case sensitive, i. e. “glass”, “Glass”, and

“GLASS” yield the same results. It is possible to search for multiple words

and word groups embraced by quotation marks.

{Tree View} Shows the categories and entries of the currently selected Definition Type.

Each catalog entry must be within at least one category. If you have opened

the catalog via a Load button, double-clicking on a catalog entry loads this

entry.
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{Preview} Shows a preview of the currently selected catalog entry. The corresponding

previews are as follows:

• Boundary Responses: ↪→Sec. 41.2

• Coatings: ↪→Sec. 36.3

• Components: 3D view as described in Sec. 5.15

• Detectors: a description of the detector

• Light Sources: a Chromatic Fields Set View (↪→Sec. 14) of the resulting

light

• Materials: ↪→Sec. 38.3

• Media: ↪→Sec. 37.2

• Stacks: a read-only version of the edit dialog (↪→Sec. 39.2)

• Surfaces: ↪→Sec. 35.3

/ View Shows the preview as separate resizable dialog. Not available for the detec-

tors catalog.

Edit Opens the edit dialog of the currently selected catalog entry. If you edit a

template or a LightTrans defined entry, you are asked to specify name and

categories for saving the entry as user defined entry (↪→Sec. 33.1). User

defined entries can be either overwritten or saved under a new name and or

category.

Remove Removes a user defined catalog entry.

Tools The following catalog tools are available:

• View, Edit, Remove (see above)

• Rename, Edit Categories (available for user defined catalog entries

only. ↪→Sec. 33.1)

• Export to Catalog File (↪→Sec. 33.2) / Import from Catalog File

(↪→Sec. 33.3)

• Import VirtualLab <4.5Materials / Coatings (available within thematerial

or coating catalog only. ↪→Sec. 33.4)

• Import ZemaxOpticStudio®Glass Catalog (available within thematerial

catalog only. ↪→Sec. 129)

• Import Macleod Coating Data (available within the coating catalog only.

↪→Sec. 128)

• Extract Material(s) from Medium/Coating into Catalog (available within

the medium or coating catalog only. ↪→Sec. 33.5)

• Reload from Hard Disc: If the saved catalogs have changed (e. g. by

another instance of VirtualLab Fusion), you can reload them with this

catalog tool. Also saving new entries sometimes requires a reload.

Show Preview For performance reasons you can disable the preview with this checkbox.

Keep View Range (If

Medium Changed)

O M S P -

.

If checked, changing the shown medium will not change the displayed view

range. In this case, the medium’s own default view range will be ignored and

the media views can be better compared.
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33.1 Specify Name and Categories

Figure 194. Dialog for specifying the name and the categories of a catalog entry.

The dialog shown in Fig. 194 opens if you want to save a new catalog entry, rename an existing catalog entry or

change its categories. It has the following entries, whereas some of them might be disabled due to the actual

purpose of the dialog.

ITEM DESCRIPTION

Name Shows the name of the catalog entry and allows you to enter a new name.

Each name must be unique for one type of building block (e. g. only one user

defined surface can have the name “Cylindrical Surface”.)

Check Checks whether the name is unique. This check is also done if you press Ok

– if the name is not unique, the dialog does not close.

Categories Shows a list of all categories the catalog entry is sorted into.

New Category Asks for the name of the new category and adds it to the list of Categories.

Two categories with the same name are merged.

Remove Category Removes the currently selected category from the list of Categories. At least

one category must be in this list.

33.2 Export to Catalog File

You can export selected entries from the User Defined catalog to a separate catalog file which can then be

imported (↪→Sec. 33.3) on other computers. This tool first opens a dialog (↪→Fig. 195) where you can select

which entries to export and give them other names if you like. But the names in the exported file must be

unique, otherwise they are marked red and the dialog becomes invalid. The dialog also offers two Selection

Tools to Select All or Unselect All entries.
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Figure 195. Dialog for exporting selected entries to another catalog file. Two selected entries have the same name and

thus the dialog cannot be closed with OK.

After closing this dialog with OK you can then specify path and name of the new catalog file.

33.3 Import from Catalog File

You can import selected entries from any catalog file (*.ctlg) into the User Defined catalog. This tool first opens

a dialog where you can specify path and name of the catalog file to be imported. In the subsequent dialog

(↪→Fig. 196) you can then select which entries to import and assign additional categories to them.

Figure 196. Dialog for importing selected entries from another catalog file.

This dialog has the following options.
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ITEM DESCRIPTION

{Table of Catalog Entries} This table has the following columns:

• Import: Allows you to select which entries of the file shall be imported.

Entries whose name is not unique, already present in the user defined

catalog, or empty cannot be imported. If such an entry is selected the

corresponding row is marked red. Otherwise, it is marked green and

“OK” is shown in the Status column.

• Name: Shows the name of the entry and allows you to change it.

• Status: Shows error messages for those entries that cannot be im-

ported. Entries that can be imported have the status “not selected”

(“OK” if marked for import).

Selection Tools Allows you to either Select All entries in the table or to Unselect All.

AddAdditional Categories All imported entries keep their original categories. But you can add additional

categories if you check this option.

{List of Categories} List of all additional categories where you can select one to delete it.

New Category Opens a separate dialog to define a new category.

Delete Category Deletes the currently selected category.

33.4 Import of Catalogs of Older VirtualLab Fusion Versions

Via the Catalog Tools of the catalog main form (↪→Sec. 33) you can Import VirtualLab <4.5 Materials / Coatings

(created with VirtualLab Fusion 4.2.1 or less) into the user defined materials / coatings catalog. The following

file types can be imported:

ITEM DESCRIPTION

*.mtr File containing a single material.

*.ctg File containing a single coating.

*.mct Materials catalog, created with or for a VirtualLab Fusion version before 4.5.

*.cct Coatings catalog, created with or for a VirtualLab Fusion version before 4.5.
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Figure 197. Import dialog for an old material catalog with some inconsistent entries.

This catalog tool first shows the standard Windows dialog for opening one or more files with matching file

extensions. The selected files are then imported with the dialog shown in Fig. 197. In the upper part of this

dialog there is a table with the following columns:

COLUMN DESCRIPTION

Import Allows you to select which entries of the file shall be imported. Entries whose

name is not unique, already present in the user defined catalog, or empty

cannot be imported. If such an entry is selected the corresponding row is

marked red. Otherwise, it is marked green and “OK” is shown in the Status

column.

Name Shows the name of the entry and allows you to change it.

State of Matter

(Only for materials)

Prior to VirtualLab Fusion 4.5, materials had no state of matter. Thus you can

set it in this column.

Status Shows error messages for those entries that cannot be imported. Entries that

can be imported have the status “not selected” (“OK” if marked for import).

By clicking on a column caption, you can sort by this column.

The Selection Tools allow you to either Select All entries in the table or to Unselect All.

The lower part of the catalog defines the categories into which all entries are stored. You can add a new

category with the -button and remove a category with the -button.

33.5 Extraction of Materials stored in Media or Coatings

Optical Media as well as thin film Coatings usually contain materials. If, for any reason, such a material is

not stored in the materials catalog yet, the tool Catalog Tools > Extract Material(s) from Medium/Coating into

Catalog allows to extract it. It will be stored into the user defined materials catalog.

The tool will examine the selected medium or coating which contains the desired material. Then the dialog
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shown in Fig. 197 will appear. Select the material(s) to extract here (for a detailed description see Sec. 33.4

please) and press OK. The chosen materials will be saved to the user defined materials catalog.

34 Application of Catalog Entries

The following sections describe the controls which are used to access and apply catalog entries in order to

build up superordinate building blocks or real components.

34.1 Load and Edit of Catalog Entries

The controls shown in Fig. 198 are e. g. used for the definition of optical surfaces, media, stacks, and / or

boundary operators of real components (↪→Part IX).

These controls are also used within table cells (for example in the table defining the surfaces within a Lens

System component). Then they are compactified as shown in Fig. 199 and shown only if the user enters that

row.

Furthermore there is a “one line version” as shown in Fig. 200.

Figure 198. Control for loading, editing and viewing optical surfaces (above) and media (below).

Figure 199. Control for loading, editing and viewing building blocks within a table.

Figure 200. One line version of the control for loading, editing and viewing building blocks

ITEM DESCRIPTION

Load Load an entry form the corresponding dialog. In the moment, this not possible

for boundary operators.

Edit Edit the current entry.

/ View Shows the currently set entry.

34.2 Application of Coatings

Optical surfaces may be coated in order to change their reflection and transmission behavior. So each edit

dialog for a surface allows to define such a coating via the coating panel, shown in Fig. 201.

Figure 201. The control for loading, viewing and removing of coatings.
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ITEM DESCRIPTION

Name Name of the currently set coating.

Load Load a coating from the coating catalog.

Edit Edit the currently set coating.

View Shows the currently set coating.

Remove Removes the coating.

Coating Orientation The orientation of the coating in relation to the surface it is applied to. There

are three orientation types:

• ⇹Automatic Decision: The orientation will be determined automatically,

depending on the states of matter in front of the surface and behind

the surface. If there is one solid material and one non-solid (i.e. fluid,

gaseous or vacuum) material involved, the solid material will serve as

substrate. If there is not exactly one solid material, an error is given.

• ↤ Front Side Application: The coating will be applied onto the front side

of the surface.

• ↦ Back Side Application: The coating will be applied onto the back side

of the surface.

34.3 Application of Materials

Each medium contains at least one material. So whenever a medium is to be specified, a material has to be

set. This is done via the control shown in Fig. 202.

Figure 202. The control for loading or defining and viewing of materials. Left side: Accessing a catalog material. Right

side: Defining a material with constant refractive index.

This control (↪→Fig. 202) allows you to either load amaterial from the catalog or to define amaterial with constant

refractive index directly. It contains the following controls:
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ITEM DESCRIPTION

Name Shows the name of the current material.

View Shows the view of the currently set material.

Catalog Material PE /

Defined by Constant Re-

fractive Index

If you set this combo box to Catalog Material, the materials catalog is shown

where you can select the material. The button opens the materials catalog

again. With the button you can edit the material.

In contrast, if you set the combo box to Defined by Constant Refractive Index

you can enter the real refractive index directly.

{Value} PV A D C R I .

The constant value of the real refractive index. It is defined absolutely (i. e.

referring to vacuum) and applies for a wavelength range of 10 pm…0.1m.

State of Matter Shows the state of matter of the current material. If the material is Defined

by Constant Refractive Index, you can change this entry. This information is

needed for the orientation of coatings on surfaces.



VI Building Blocks:
Media, Materials,
Surfaces, …

Complex optical components are built up from simple Building Blocks:

• Optical Surfaces (↪→Sec. 35)

• Coatings (↪→Sec. 36)

• Media (↪→Sec. 37)

• Materials (↪→Sec. 38)

• Stacks (↪→Sec. 39)

• Surface Layouts (↪→Sec. 40)

• Boundary Responses (↪→Sec. 41) and

• Surface Regions (↪→Sec. 42) .

Some types of Optical Building Blocks contain other Building Blocks

(e. g. a medium contains materials). In VirtualLab Fusion most Building

Block categories have their own catalog. The general catalog concept

is explained in Part V.
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35 Optical Surfaces

Optical Surfaces separate two optical media (↪→Sec. 37) and represent the borders of real optical components

(↪→Part IX). Every Optical Surface can be provided with an optical thin film coating (↪→Sec. 36). There is a

Surface Catalog, storing several predefined Optical Surfaces as well as a variety of templates of different

surface types.

Please note: If you save a coated Optical Surface to the catalog, the coating will not be saved.

The following (template) types of Optical Surfaces are available in VirtualLab Fusion.

ITEM DESCRIPTION

Anamorphic Asphere Sur-

face

A biconic surface with additional coefficients describing a deviation in radial

and azimuthal direction. ↪→Sec. 35.2.1

Aspherical Surface Allows you to define a rotational symmetric surface using asphere parame-

ters. ↪→Sec. 35.2.2

Combined Surface Allows you to combine the height profiles of two distinct surface. ↪→Sec. 35.2.3

Conical Surface A surface that can be described as a rotating conic section. ↪→Sec. 35.2.4

Cylindrical Surface Allows you to define a axially symmetric surface using asphere parameters.

↪→Sec. 35.2.5

Plane Surface Describes a plane surface which can be tilted around the x-axis and the y-

axis. ↪→Sec. 35.2.7

Polynomial Surface A conical surface which is modulated by a polynomial separable in x- and

y-direction. ↪→Sec. 35.2.8

Programmable Surface Allows you to enter the height profile as a formula. ↪→Sec. 35.2.9

Q-Type Asphere Surface An asphere described by the polynomials proposed in [For07]. ↪→Sec. 35.2.10

Sampled Surface Allows you to set an arbitrary height profile. ↪→Sec. 35.2.11.

Toroidal Asphere Surface An aspherical cross section rotated about the y-axis. ↪→Sec. 35.2.12

Transition Point List Sur-

face

This surface allows you to define arbitrary heights at arbitrary positions along

a line. ↪→Sec. 35.2.13

Zernike Standard Surface Defines an surface by Zernike polynomials Zi(ρ, φ) using polar coordinates

(ρ, φ). ↪→Sec. 35.2.14

Grating Surfaces ↪→Sec. 35.2.6. Rectangular gratings (↪→Sec. 35.2.6.1), sawtooth gratings

(↪→Sec. 35.2.6.2), sinusoidal gratings (↪→Sec. 35.2.6.3), and triangular grat-

ings (↪→Sec. 35.2.6.4) are available.
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35.1 Edit Dialog for Optical Surfaces

Figure 203. Edit dialog for an optical surface (here: plane surface)

The edit dialogs for all surface types (see for example Fig. 203) have the following controls in common:

ITEM DESCRIPTION

Definition Area ↪→Sec. 35.1.1.1.

View Shows a 3D view of the surface as described in Sec. 35.3.

Save Saves the surface to the catalog (↪→Sec. 33). Not visible if the edit dialog is

shown from within the surfaces catalog.

Tools ↪→Sec. 35.1.3.

Validity Indicator The parameters of a surface must fulfill some complex constraints. For ex-

ample the conical constant of a surface determines its maximum definition

area. If any of these constraints is breached, the green check mark on the

bottom of the surface dialog turns into a red diagonal cross . If you click

on the -button to the right, an info dialog is shown which lists all error mes-

sages. For constraints concerning the definition area and periodization, this

dialog offers a link to a visualization of the current (approximated) function

domain, the definition areas and the period of the surface (↪→Sec. 35.1.1).

Coating tab The controls on theCoating PE tab are explained in Sec. 34.2. Not visible if the

edit dialog is shown from within the Surfaces Catalog or from within a stack

(↪→Sec. 39).

Discretization tab ↪→Sec. 35.1.2

Scaling tab ↪→Sec. 35.1.2

Periodization tab ↪→Sec. 35.1.1.2
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35.1.1 Definition Area and Periodization

A surface can be set to be periodical. In the non-periodical case you can set up the (Inner) Definition Area PE of

the surface. This means that you define the Size and Shape of the definition area and how it behaves Outside

of the definition area. The corresponding control is described in more detail in Sec. 35.1.1.1.

The specified definition area should lie completely within the Approximated Function Domain (↪→Sec. 133.1.1)

which depends on the type and the parameters of the actual surface. If this constraint is breached, it is shown

as in the Validity indicator. It is ensured that a definition area exceeding the function domain yields still a

valid surface, but possibly with sharp “bends” or very large height values. For example the function domain of

a spherical surface is a circle with a radius equal to its radius of curvature. But for a toroidal surface only an

approximated function domain can be calculated numerically.

On the Periodization tab you can define whether to Use Periodization and if yes, what Period PV the surface has.

In this case the height profile as defined in the Structure tab is replicated periodically whereas only rectangular

“elementary cells” are supported. If the inner definition area is smaller than the period, the surface does not fill

the whole elementary cell.

The Outer Definition Area PE which can be also set up on the Periodization tab (↪→Sec. 35.1.1.2) defines the

overall size of the surface. Fig. 204 shows an example for a periodical surface.

The inner definition must not be larger than the period and the period must not be larger than the outer definition

area. This is also shown by the Validity indicator.

Figure 204. Definition of Inner and Outer Definition Area, Period and Approximated Function Domain using the example

of a periodical conical surface. Left: 3D view. Right: Section

Grating surfaces are always periodical and have an inner definition which is always equal to the period.
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35.1.1.1 Definition Area Control

Figure 205. Definition area control used for setup of definition areas of optical surfaces.

This control (↪→Fig. 205) lets you specify Size and Shape of the definition area of a surface and how it behaves

outside, i. e. the Effect on Field Outside of Definition Area.

ITEM DESCRIPTION

Shape PE You can choose whether the actual definition area of the control has a Rect-

angular or an Elliptical shape.

Size PV Specify x- and y-extension of the actual definition area. With a double-click

on either the x- or the y-extension box you can turn the definition area into a

circular or quadratic one, respectively.

Effect on Field Outside of

Definition Area

Outside of the definition area always a plane surface is added. This plane

surface either behaves as normal surface (i. e. Field Passes Plane Surface)

or as completely absorbing surface (i. e. Field is Absorbed).

Position of Surrounding

Absorbing Plane /

Position of Surrounding

Surface Plane

The value z-Position gives the position of the plane that surrounds the defini-

tion area and which either absorbs the field or lets it pass, depending on the

setting of Effect on Field Outside of Definition Area. A value of 0m is identical

to the surface’s location at the lateral position (0m; 0m). If the Specification

Mode is set to User Defined, you can set an arbitrary value. For the other

specification modes, the height is determined automatically, see below.

Specification Mode The mode to specify the Position of Surrounding Surface / Absorbing Plane.

This can be equal to one of the following positions, that are also shown in

Fig. 206:

• The maximum height value in the definition area (Area Maximum),

• the minimum height value in the definition area (Area Minimum),

• the maximum height value along the boundary of the definition area

(Boundary Maximum), or

• the minimum height value along the boundary of the definition area

(Boundary Minimum).
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Figure 206. The different specification modes for the position of that plane which surrounds the definition area of a sur-

face.

35.1.1.2 Periodization

Figure 207. The periodization tab of the edit dialog for surfaces.

This tab (↪→Fig. 207) allows you to specify the parameters for the periodization of optical surfaces.
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ITEM DESCRIPTION

Period PV Specify x- and y-extension of the period.

Shape You can choose whether the outer definition area of the control has a Rect-

angular or an Elliptical shape.

Size PV Specify x- and y-extension of the outer definition area.

Effect on Field Outside of

Definition Area

Outside of the definition area always a plane surface is added. This plane

surface either behaves as normal surface (i. e. Field Passes Plane Surface)

or as completely absorbing surface (i. e. Field is Absorbed).

Position of Surrounding

Absorbing Plane /

Position of Surrounding

Surface Plane

The value z-Position gives the position of the plane that surrounds the defini-

tion area and which either absorbs the field or lets it pass, depending on the

setting of Effect on Field Outside of Definition Area. A value of 0m is identical

to the surfaces location at the lateral position (0m; 0m). If the Specification

Mode is set to User Defined, you can set an arbitrary value. For the other

specification modes, the height is determined automatically, see below.

Specification Mode The mode to specify the Position of Surrounding/Surface Absorbing Plane.

This can be equal to one of the following positions, that are also shown in

Fig. 206:

• The maximum height value in the definition area (Area Maximum),

• the minimum height value in the definition area (Area Minimum),

• the maximum height value along the boundary of the definition area

(Boundary Maximum), or

• the minimum height value along the boundary of the definition area

(Boundary Minimum).

Edit Inner Definition Area This link is a shortcut to the Structure tab, where you can set the Inner Defi-

nition Area as described above in Sec. 35.1.1.1.

35.1.2 Height Discontinuities and Rescaling of Surfaces

VirtualLab Fusion allows to scale any surface in x-, y-, and z-direction, respectively. Furthermore, VirtualLab

Fusion offers three mathematical operations which introduce height discontinuities into the height profile of an

optical surface.

1. Pixelation introduces rectangular pixels. The height within one pixel remains constant. ↪→Sec. 35.1.2.1.

2. Height Quantization introduces a limited number of equidistant discrete height levels. The height at a

certain position is set to the nearest height level. ↪→Sec. 35.1.2.2.

3. Using Fresnel zones, the height profile is wrapped so that all height values lie within a certain interval.

↪→Sec. 35.1.2.3.

The following equation shows how and in which order these surface manipulations are applied.

h(x, y) = Q
(

ζR
(

h′
[
P
(

x
ξ

)
,P
(

y
η

)]))
(35.1)

h′(x, y) is the original height profile, e. g. that of a conical surface. h(x, y) is the height profile after applying the
aforementioned manipulations. ξ, η and ζ represent a Scaling in x-Direction, Scaling in y-Direction, and Scaling

in z-Direction, respectively. These settings can be found on the Scaling tab of a surface dialog (↪→Fig. 208).

Obviously, the Scaling in x-Direction and the Scaling in y-Direction effect the Approximated Function Domain

(↪→Sec. 35.1.1). The Scaling in z-Direction must not be zero, a negative Scaling in z-Direction means that the

height profile is inverted.
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P(a) refers to the pixelation operator (↪→Sec. 35.1.2.1), Q(h) to the quantization operator (↪→Sec. 35.1.2.2),

R(h) to the fresnelization operator (↪→Sec. 35.1.2.3).

Figure 208. The Scaling tab of the edit dialog for surfaces.

35.1.2.1 Pixelation

The pixelation function p(a) introduces discrete rectangular pixels in the height profile and is defined as

p(a) =

round
( a

∆a
)

∆a ; if Use Pixelation is set.

a ;else
. (35.2)

∆a represents the Pixel Size PV along the x- or y-axis. The pixel size is in general different along both axes.

Note, according to Eq. (35.1), the resulting pixelation effect (the size of a region for which the height is constant)

is influenced by the scaling parameters β (scaling in x-direction) and γ (scaling in y-direction).

Use Pixelation and the Pixel Size can be set on the Height Discontinuities tab of a surface dialog (↪→Fig. 209).

Figure 209. The pixelation settings for a surface which can be found on the Height Discontinuities tab of its edit dialog.

The Sampled Surface contains discrete, equidistantly sampled height values with sampling distances

δx and δy along the x- and y-axis, respectively. An additional interpolation method creates a continuous
surface profile from these sampling points. If a user selects Nearest Neighbor as Interpolation Method

in the sampled surface, rectangular pixels will always appear. Hence pixelation cannot be disabled then

and the pixel sizes are fixed to δx · δy.

35.1.2.2 Use Discrete Height Levels (Height Quantization)

The function q(h) introduces discrete height levels in an optical surface and is defined as

q(h) =



h if Use Discrete Height Levels (Height Quantization) is not set.

qmin if hmin ≤ h < qmin.

qmax if qmax < h ≤ hmax.

round
(

h−qmin
∆h

)
∆h + qmin else

. (35.3)

qmin and qmax are the minimum and the maximum height level of the discretized height profile, respectively. ∆h
is the height difference between two consecutive height levels and is defined as

∆h =
qmax − qmin

n− 1
. (35.4)
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hmin represents the minimum height of the original non-discretized surface and hmax its maximum height. n is

the Number of Discrete Height Levels between and including qmin and qmax. The function round(x) returns the
integer value closest to x.
VirtualLab Fusion offers three quantization modes differing in the choice of qmin and qmax.

QUANTIZATION MODE QMIN QMAX

Min-Max-Tread hmin hmax

Min-Max-Riser hmin +
hmax−hmin

2n = hmin + ∆h
2 hmax − hmax−hmin

2n = hmax − ∆h
2

User Defined Min- and Max-

Levels

User Defined User Defined

hmin ≤ qmin < qmax ≤ hmax

Mathematical details can be found in Sec. 133.1.2.2.

The quantization of a surface can be configured on the Height Discontinuities tab of its dialog. The correspond-

ing controls are shown in Fig. 210 and described below.

Figure 210. The controls which can be used to configure the quantization of a surface.

ITEM DESCRIPTION

Use Discrete Height Lev-

els (Height Quantization)

Switches the height quantization of a surface on and off.

Number of Discrete Height

Levels PV

The number n of discrete height levels. Must not exceed 4096.

Quantization Mode Allows you to select any of the three quantization modes explained in

Sec. 133.1.2.2 (Min-Max-Tread, Min-Max-Riser, or User Defined Min- and

Max-Levels).

Minimum /

Maximum

Allows you to set hq,min and hq,max, if in user defined mode. The dialog en-

sures that qmin < qmax. Note that according to Eq. (35.1), the allowed values
for qmin and qmax are influenced by the Scaling in z-Direction.

35.1.2.3 Fresnel Zones

Figure 211. The controls for configuring the Fresnel zones of a surface. They can be found on the Height Discontinuities

tab of a surface edit dialog.
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The following table describes the controls (↪→Fig. 211) which can be used to introduce Fresnel zones. A math-

ematical description and some explaining figures are given below.

ITEM DESCRIPTION

Use Fresnel Zones “Folds” the height profile so that the resulting surface contains so-called Fres-

nel zones.

Fresnel Height PV The difference between the maximum and the minimum height values in the

surface after Fresnel zones have been introduced.

Relative Position on z-

Axis

The size of the innermost Fresnel zone can be adjusted by the Relative Po-

sition on z-Axis.

If you Use Fresnel Zones the height profile is “folded” so that all height values lie in the interval −p · ht . . . (1−
p)ht. ht refers to the Fresnel Height and p refers to the Relative Position on z-Axis.
Thus, if the Relative Position on z-Axis is set to 0% the height values range from 0 to +ht. This is the recom-
mended setting for a height profile containing only positive height values (e. g. a conical surface with positive

radius of curvature).

Vice versa, aRelative Position on z-Axis of 100% is recommended for surfaces with only negative height values

as then the height values are in the range −ht . . . 0.
Any intermediate relative position is of course also feasible. Fig. 212 shows an example for the effect of the

relative position.

Figure 212. Cross section of a cylindrical surface with positive radius of curvature and Fresnel zones. The subfigures

illustrate the effect of different values for the Relative Position on z-Axis p.
Top: p = 0 %. Height values range from 0 to 2mm. Middle: p = 50 %. Height values range from -1 to 1mm. Bottom:

p = 99.99 %. Height values range from (nearly) -2 to (nearly) 0mm.

Note that the Scaling in z-Direction is applied after introducing the Fresnel zones. Thus the scaling in z-direction

does not influence the positions of the Fresnel “jumps” but the total profile height of a surface with Fresnel

“jumps” is the scaling factor α times the set Fresnel Height.

35.1.3 Surface Tools

The Tools-button opens a menu containing the following items:
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ITEM DESCRIPTION

View Surface Shows the surface in the dialog described in Sec. 35.3.

Save to Catalog Saves the surface to the catalog (↪→Sec. 33). Not visible if the edit dialog is

shown from within the surfaces catalog.

Import In the moment, this item is only available for the sampled surface

(↪→Sec. 35.2.11): Either GDSII, CIF, text or bitmap data can be imported

if a parameter summary file is provided in the XML format explained in

Sec. 127.4.

Export Exports the surface to various text and binary formats. ↪→Sec. 127.1.

35.2 Surface Types

In this section, the types of Optical Surfaces provided by VirtualLab Fusion are described. They can be ac-

cessed as templates in the Surface Catalog.

35.2.1 Anamorphic Asphere Surface

This surface is a biconic surface with additional coefficients describing a deviation in radial and azimuthal

direction.

Its height function is defined by

h(x, y) =
c2

x + c2
y

1 +
√

1− (1 + κx)c2
xx2 − (1 + κy)c2

yy2
+

n

∑
i=2

ar,i
(
(1− ap,i)x2 + (1 + ap,i)y2

)i
(35.5)

cx and cy are the curvatures in x- and y-direction, respectively, with

cx =
1

Rx
and cy =

1
Ry

. (35.6)

Rx and Ry are the radii of curvature of the surface and κx and κy the conical constants in x and y direction. ar,i
are the radial and ap,i the azimuthal coefficients of the surface.
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Figure 213. Dialog for defining an anamorphic asphere surface.

Fig. 213 shows the edit dialog where the specific parameters of the anamorphic asphere surface can be set.

ITEM DESCRIPTION

Radius of Curvature PV The radii of curvature Rx and Ry (↪→Eq. (35.6)) of the surface in meters.

Conical Constant PV The conical constants κx and κy. ↪→Eq. (35.5); see also Sec. 35.2.4

Maximum Order The maximum order 2n of the additional polynomial. ↪→Eq. (35.5)

{Coefficients Table} In this table you can specify the radial coefficient ar,i PV and the azimuthal co-

efficients ar,i PV of each order 2i. Its physical units are given in square brackets
in the column headers. ↪→Eq. (35.5)

Via the context menu of the table you can copy and paste the parameter list.

The remaining controls are explained in Sec. 35.1.

35.2.2 Aspherical Surface

The profile height h(x, y) of an aspherical surface is defined by an expression of the form

h(x, y) =
cr2

1 +
√

1− (1 + κ)c2r2︸ ︷︷ ︸
↪→Sec. 35.2.4

+a1r + a2r2 + a3r3 + . . . + anrn (35.7)

where the first part is the height function of a conical surface which is explained in detail in Sec. 35.2.4. r =√
x2 + y2; a1 . . . an are the additional asphere parameters.

Fig. 214 shows the edit dialog where the specific parameters of the aspherical surface can be set.
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Figure 214. Dialog for defining an aspherical surface.

ITEM DESCRIPTION

Radius of Curvature PV The radius of curvature R (↪→Sec. 35.2.4) of the surface in metric units.

Conical Constant PV The conical constant κ (↪→Sec. 35.2.4)

Number of Orders The number n of the additionalAspherical Parameters PV ai. The length of the

table for entering these parameters depends on this number.

Order The order i of the asphere parameter ai, that is specified by Parameter Value.

Its physical unit is given in square brackets: [unit].

Parameter Value Value of the asphere parameter ai (↪→Eq. (35.7)), whereas i is given byOrder.

Via the context menu of the table you can copy and paste the parameter list.

The remaining controls are explained in Sec. 35.1.

35.2.3 Combined Surface

A combined surface is the result of adding the profile heights of two sub-surfaces. As an example, sophisticated

optical surfaces can be achieved by combining an asphere with a sampled surface.

Fig. 215 shows the Edit dialog, where the specific parameters of the combined surface can be set.
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Figure 215. Dialog for defining a combined surface.

ITEM DESCRIPTION

Surface 1 / 2 PE The surfaces which shall be combined can be specified by standard catalog

access1 in VirtualLab Fusion. The user can also edit and view the selected

surfaces. For these surfaces, always Field Passes Plane Surface is selected

as Effect on Field Outside of Definition Area – an addition of an absorbing

and a transparent height profile is not well defined.

The remaining controls are explained in Sec. 35.1.

35.2.4 Conical Surface

Conical surfaces are a special kind of second order surfaces, that can be described as rotating conic sections.

They are also well known as hyperboloid, paraboloid, ellipsoid and sphere and are defined by

h(x, y) =
cr2

1 +
√

1− (1 + κ)c2r2
(35.8)

where c denotes the curvature, κ the conical constant and r =
√

x2 + y2 the lateral distance to the optical axis.

The value of the conical constant determines the type of the surface, i. e. κ < −1 gives a hyperboloid, κ = −1
a paraboloid, −1 < κ < 0 gives a prolate ellipsoid, κ = 0 a sphere and κ > 0 an oblate ellipsoid.
The curvature is connected to the radius of a sphere (R =

√
x2 + y2 + z2) or to the vertex radius of a paraboloid

(R = (x2 + y2)/(2z)) by c = 1/R. This radius is also called Radius of Curvature.
For an ellipsoid or a hyperboloid the parameters c and κ can be calculated from its semi axes a and b using the
relationships

1
c
= ± b2

a
and κ = − (a2 − b2)

a2 . (35.9)

The intersection points of the light and the surface are calculated analytically.

1 Part V explains the general catalog concept, its subsection Sec. 34.1 explains the control for loading, editing, and viewing catalog

entries.
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Fig. 216 shows the Edit dialog, where the required values to define a conical surface can be entered.

Figure 216. Dialog for defining a conical surface.

ITEM DESCRIPTION

Radius of Curvature PV The radius of curvature (in the vertex) r (↪→Eq. (35.8)) of the conical surface
in metric units.

Conical Constant PV The conical constant κ. ↪→Eq. (35.8).

The remaining controls are explained in Sec. 35.1.

35.2.5 Cylindrical Surface

The only difference between the Cylindrical and the Aspherical Surface is the symmetry. While the last one is

circular symmetric, the first one has one prime axis (axis of symmetry). So the surface is defined by Eq. (35.7)

too, but with the substitution r = |x cos(α)+ y sin(α)|, where α denotes the rotation angle of the axis of symmetry

relative to the y-axis (↪→Fig. 217). Please note that there is a refraction effect perpendicular to the axis of

symmetry only, i. e. parallel to the direction given by α.

Fig. 218 shows the edit dialog, where the specific parameters of the cylindrical surface can be set.
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Figure 217. Sketch of a cylindrical surface, rotated by an angle α.

Figure 218. Dialog for defining a cylindrical surface.
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ITEM DESCRIPTION

Radius of Curvature PV The radius of curvature r (↪→Eq. (35.7)) of the cylindrical surface in metric

units.

Conical Constant PV The conical constant κ. ↪→Eq. (35.7); see also Sec. 35.2.4

Number of Orders The number of orders, i. e. the number of the additional Aspherical Parame-

ters PV an. The length of the table for entering these parameters depends on

this number.

Order The order n of the asphere parameter an, that is specified byParameter Value.

Its physical unit is given in square brackets: [unit].

Parameter Value Value of the asphere parameter an (↪→Eq. (35.7)), whereas n is given by Or-

der.

Rotation Angle PV The angle (α in Fig. 217) between the axis of symmetry y’ and the y-axis. The

rotation is done in the x-y-plane and is defined as positive rotation about the

z-axis.

Via the context menu of the table you can copy and paste the parameter list.

The remaining controls are explained in Sec. 35.1.

35.2.6 Grating Surfaces

To simulate the optical behavior of gratings, it is possible to use different types of one-dimensional and period-

ically varying profiles. All of these have some basic values in common:

ITEM DESCRIPTION

Grating Period PV The period of the surface’s height profile in metric units.

Modulation Depth PV The amplitude of the height modulation. Please see also the “Note on quan-

tization” below.

Lateral Shift PV A shift of the surface in the direction of the modulation. Please pay attention:

Usually this lateral shift will also cause a change of the surface position on the

optical axis (which means a change in the distances to other surfaces too).

This is due to the definition of the object position as the intersection point of

the surface with the optical axis.

Rotation Angle PV Per default, the periodical modulation is defined along the x-axis. By using

this parameter, the modulation direction can be changed by rotation about the

z-axis.

Grating surfaces are always periodical and have an inner definition area which is always equal to the period.

The Period on the Periodization tab is always determined from the Grating Period and Rotation Angle.

The remaining controls are explained in Sec. 35.1.

As an example Fig. 219 shows the Edit dialog for a sinusoidal grating surface.
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Figure 219. Edit dialog for a sinusoidal grating surface showing the basic grating parameters.

35.2.6.1 Rectangular Grating Surface

A rectangular grating surface is shaped as shown in Fig. 220.

Figure 220. Shape of an unshifted rectangular modulated grating surface.

The user can either specify the Slit Width PV in meters or the Relative Slit Width PV as fraction of the period

(↪→Fig. 221). For the basic grating surface parameters see Sec. 35.2.6, for the general surface dialog see

Sec. 35.1.

Figure 221. Control for defining the rectangular grating surface parameters.

35.2.6.2 Sawtooth Grating Surface

The surface has a shape as shown in Fig. 222.
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Figure 222. Shape of an unshifted sawtooth grating surface.

For the basic grating surface parameters see Sec. 35.2.6, additionally the inclination of the plane surface

sections has to be specified (↪→Fig. 223).

Figure 223. Radio buttons for defining the inclination (orientation) of a sawtooth grating.

35.2.6.3 Sinusoidal Grating Surface

Such kinds of grating surfaces have a sinusoidal height profile (↪→Fig. 224).

Figure 224. Shape of an unshifted sinusoidal grating surface.

There are no further parameters needed to specify this surface, for the basic grating surface parameters see

Sec. 35.2.6, for the general surface dialog see Sec. 35.1.

35.2.6.4 Triangular Grating Surface

Figure 225. Controls for defining the specific settings for a triangular grating surface.

A Triangular Grating Surface can be defined by either the Projected Side Ratio PV = b/a or the angle Alpha

(↪→Fig. 225). The angle Beta is just given as information.

For the basic grating surface parameters see Sec. 35.2.6, for the general surface dialog see Sec. 35.1.
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35.2.7 Plane Surface

The profile height h(x, y) of a plane surface, which may be tilted with respect to the optical axis, is calculated
by

h(x, y) = mxx + myy, (35.10)

where x and y indicate the lateral position and mx and my represent the inclinations of the surface in the specific

directions.

The intersection points of the light and the surface are calculated using an analytical formula.

Fig. 226 shows the edit dialog, where the parameters for a plane surface can be entered.

Figure 226. Dialog for defining a plane surface.

ITEM DESCRIPTION

Alpha PV Angle of the plane surface, measured from the x-axis, representing a rotation

about the y-axis. my = tan Alpha. ↪→Eq. (35.10)

Beta PV Angle of the plane surface, measured from the y-axis, representing a rotation

about the x-axis. mx = tan Beta. ↪→Eq. (35.10)

The remaining controls are explained in Sec. 35.1.

35.2.8 Polynomial Surface

Defines a surface consisting of a rotationally symmetric conical base surface and an additional two-dimensional

polynomial. It is defined by the equation:

h(x, y) =
cr2

1 +
√

1− (1 + κ)c2r2︸ ︷︷ ︸
↪→Sec. 35.2.4

+
m

∑
i=0

n

∑
j=0

aijxiyj with r =
√

x2 + y2 (35.11)

where the first part is the height function of a conical surface which is explained in detail in Sec. 35.2.4.

Fig. 227 shows the edit dialog where the specific parameters of the polynomial surface can be set.
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Figure 227. The edit dialog for polynomial surfaces.

ITEM DESCRIPTION

Radius of Curvature PV The radius of curvature R (↪→Sec. 35.2.4) of the surface in metric units.

Conical Constant PV The conical constant κ (↪→Sec. 35.2.4).

Number of Orders The number m× n of the additional Polynomial Parameters PV aij. The length

of the table for entering these parameters depends on this number.

Use Absolute Values of

Coordinates

When you check this option, |x|i |y|j are used in Eq. (35.11).

Order The order (i, j) of the polynomial parameter aij, that is specified by Parameter

Value. Its physical unit is given in square brackets: [unit].

Parameter Value Value of the polynomial parameter aij (↪→Eq. (35.11)), whereas i and j are
given by Order.

Via the context menu of the table you can copy and paste the parameter list.

The remaining controls are explained in Sec. 35.1.
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35.2.9 Programmable Surface

Figure 228. Sample edit dialog for a programmable surface.

The programmable surface allows you to define your own surface. The Structure tab of its edit dialog

(↪→Fig. 228) contains the following controls:



CHAPTER 35. OPTICAL SURFACES 299

ITEM DESCRIPTION

Snippet for Height Profile Allows you to program a little code snippet defining the height (in meters)

at a certain position (x; y) (in meters). Edit opens the Source Code Editor

(↪→Sec. 7.3) to edit this snippet, and a validity indicator (↪→Sec. 5.10) shows

whether this snippet is consistent.

Numerical Gradient Cal-

culation

For visualization and some propagation operators, not just the height pro-

file but also its gradient is needed. If this option is selected, the gradient is

calculated numerically with a given Accuracy Factor.

User-Defined Gradient

Calculation

If this option is selected, you can program the gradient in dependency from

a certain position (x; y) (in meters). Edit opens the Source Code Editor

(↪→Sec. 7.3) to edit this snippet, and a validity indicator (↪→Sec. 5.10) shows

whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet(s). ↪→Sec. 7.4

The remaining controls are explained in Sec. 35.1. General information about programming in VirtualLab Fusion

can be found in Sec. 7.

35.2.10 Q-Type Asphere Surface

A Q-TypeAsphere Surface is the combination of a conical surface (↪→Sec. 35.2.4) and so-called Q-polynomials

proposed in [For07]. There are two sets of such polynomials: the Qcon describing strong deviations from a

conical surface and the Qbfs describing mild deviations from a spherical surface. The coefficients of these

polynomials give the deviation directly as a length.
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Figure 229. The edit dialog for a Q-Type Asphere Surface.

The edit dialog for this surface (↪→Fig. 229) has the following controls.

ITEM DESCRIPTION

Define Mild Asphere PE Defines whether the Qbfs for mild aspheres or the Qcon for strong aspheres

are used.

Unit Radius PV The polynomials are polynomials in ρ/ρmax with ρ =
√

x2 + y2 and ρmax being

the Unit Radius. Within the unit radius the z-extension of the surface is in the

range defined by the coefficients. Outside of the unit radius it can become

much larger.

Radius of Curvature PV The radius of curvature R (↪→Sec. 35.2.4) of the surface in metric units.

Conical Constant PV The conical constant κ (↪→Sec. 35.2.4). Always zero for mild aspheres which

describe the deviation from a sphere.

Number of Orders The number of monomials used, starting with the constant term. The length

of the table for entering these parameters depends on this number.

Order The order n of the Q-polynomial. Note that because of the convention

h(0m; 0m) = 0m, the first order has no effect for strong aspheres (but for

mild aspheres).

Coefficient PV Coefficient of the n-th monomial of the Q-polynomial in meters.
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The remaining controls are explained in Sec. 35.1.

35.2.11 Sampled Surface

A sampled surface is defined by a height profile h(x, y) that represents discrete sampling points. These sam-
pling points can be interpreted as rectangular pixels or they can be interpolated using different interpolation

methods.

Fig. 230 shows the Edit dialog, where the specifications for the chosen sampled surface can be set.

Figure 230. Dialog for defining a sampled surface.
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ITEM DESCRIPTION

Set Offers you three ways to set a data array describing the height profile (see

below). It is assumed that the height profile is centered around the optical

axis. The data array must contain only one real-valued, equidistantly sam-

pled subset where both the coordinates and the data have the unit length.

The definition area is set to the coordinate extent of the data and the interpo-

lation according to the interpolation of the data array. See also the chapter

about interpolation methods (↪→Sec. 131.4) for reference.

The settings on the Periodization tab are reset. If you set a one-dimensional

profile it is assumed to be unmodulated in the y-direction.

Set > Load Loads a data array from a .da file.

Set > Import Imports a data array from a bitmap or text file by means of the import wizard

described in Sec. 121.2.

Set > Select from Docu-

ments

Allows you to select an already open data array.

Set > Reset Resets the height profile to its default (a plane surface sampled with 5 × 5

sampling points).

Show Shows the currently set height profile as data array. The height in the center

(0m; 0m) is always zero as this is the way the height profile is interpreted by

VirtualLab Fusion.

Interpolation Method The four available interpolation methods determine how the height data is

interpreted.

• Nearest Neighbor: If the data represents a pixelated surface. On the

Height Discontinuities tab, Use Pixelation is always true and the Pixel

Size is equal to the sampling distance of the imported diagram.

• Linear: If the surface consists of areas with constant slope.

• Cubic 8 Point: If the data represents a smooth surface.

• Fresnel: This interpolation method avoids interpolation artifacts at

Fresnel jumps and is thus only to be used for a smooth surface which

contains Fresnel zones. If you select this interpolation method, Use

Fresnel Zones on the Height Discontinuities tab is always checked and

you can enter the Fresnel Height directly below the interpolation selec-

tion.

Import Either GDSII, text or bitmap data can be imported if a parameter summary

file is provided in the XML format explained in Sec. 127.4.

The remaining controls are explained in Sec. 35.1.

If the Interpolation Method is not set to Nearest Neighbor there is an additional surface tool (↪→Sec. 35.1.3) for

fitting a smooth surface to the given data. This tool is described in Sec. 35.2.11.1.

35.2.11.1 Fit Smooth Surface

VirtualLab Fusion allows you to fit a polynomial to a sampled height profile resulting in either a Cylindrical

Surface (↪→Sec. 35.2.5), Aspherical Surface (↪→Sec. 35.2.2), or Polynomial Surface (↪→Sec. 35.2.8). The dialog

shown in Fig. 231 allows you to set the options for this fit. The resulting surface is stored in the user-defined

surface catalog (↪→Sec. 33).
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Figure 231. The edit dialog for the fit smooth surface tool if the surface type is set to cylindrical surface.

For all surface types you can specify Radius of Curvature and Conical Constant as these parameters are

not handled by the fitting algorithm. However, if the number of fitted polynomial orders is sufficiently large a

reasonably good fit can be achieved, even if these parameters are the default values.

The Fitting Parameters allow you to set the minimum and the maximum orders taken into account for the

polynomial fit. Depending on the selected Surface Type, the actual layout of this group box varies. For the fit

of a cylindrical surface you can also preset the Rotation Angle.
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35.2.12 Toroidal Asphere Surface

This surface originates from an aspherical cross section rotated about the y-axis which results in a section of a

torus (↪→Fig. 232).

Figure 232. Principle of a Toroidal Asphere Surface.

Mathematically the cross section with the y-z-plane is described by the asphere formula:

hAsp(y) =
cy2

1 +
√

1− (1 + κ)c2y2︸ ︷︷ ︸
↪→Sec. 35.2.4

+a1y + a2y2 + a3y3 + . . . + anyn (35.12)

whereas c is the inverse Radius of Curvature and κ the Conical Constant.

This height profile is shifted by the Toroidal Radius rT in z-direction and then rotated about the y-axis. The

so-generated surface of revolution is shifted back by −rT in z-direction, so that h(0m; 0m) = 0m.
h(x, y) can be described by the following formulas and parameters:

h′Asp(y) = rT − hAsp(y) (35.13)

h′(x, y) =
√

h′ 2
Asp

(y)− x2 (35.14)

h(x, y) = rT − sgn(rT) · h′(x, y) (35.15)
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Figure 233. The edit dialog for a Toroidal Asphere Surface.

Its edit dialog (↪→Fig. 233) has the following parameters.

ITEM DESCRIPTION

Torus Radius The toroidal radius rT.

Radius of Curvature PV The radius of curvature R of the aspherical height profile hAsp(y).
↪→Sec. 35.2.4.

Conical Constant PV The conical constant κ of the aspherical height profile hAsp(y). ↪→Sec. 35.2.4

Number of Orders The number n of the additional Polynomial Orders ai. The length of the table

for entering these parameters depends on this number.

Order The order i of the asphere parameter ai. Its physical unit is given in square

brackets.

Parameter Value PV Value of the asphere parameter an (↪→Eq. (35.12)) with the Order n.

The remaining controls are explained in Sec. 35.1.
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35.2.13 Transition Point List Surface

Figure 234. Example for a Transition Point List Surface where the data points (marked by crosses) are distributed non-

equidistantly. Between the x-positions that give the height values, the Constant Interval interpolation method is used here.

Figure 235. The edit dialog for a transition point list surface.

The Transition Points List Surface is defined by one-dimensional data specifying the Height PV at certain x-

Positions PV . That data are not necessarily equidistant (see Fig. 234 for an example). If the x-positions are

varied in the parameter run, the data is always considered as non-equidistant.
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TheApproximated Function Domain (↪→Sec. 35.1.1) of a Transition Point List Surface corresponds to the range

of given values, possibly extrapolated by the current Interpolation Method. See also the chapter about interpo-

lation methods Sec. 13.2 for reference.

The dialog is shown in Fig. 235, while the control for the input of the data points is described in Sec. 5.9 in

detail.

There are two additional buttons specific for this surface:

ITEM DESCRIPTION

Invert Heights h(x) is replaced by −h(x).

Shift Positions Opens a dialog where you can enter a shift s. Each x-position x is then re-

placed by x + s.

Furthermore there is an additional surface tool, namelySet Period to Doubled Upper Limit. Before using this tool

you should check that your data fills the range −χ . . . + χ as in VirtualLab Fusion periods are always centered

around the position (0; 0). If this is not the case you might use Shift Positions prior to using this surface tool.
This tool is a short cut for doing the following steps:

1. Set the definition area in x-direction to twice the Upper Limit +χ.

2. Make the surface periodical and set the x-period to twice the Upper Limit.

3. Set the outer definition area in x-direction to six times the Upper Limit.

The remaining controls are explained in Sec. 35.1.

If you optimize the positions within the parametric optimization (↪→Sec. 102), there is a generalMinimum

Feature Size constraint. The value of this constraint becomes negative if the order of the transition points

changes. Thus you can use this constraint to enforce an unchanged order of the transition points.

Features in a periodic surface where one part of the feature is on the beginning of the period and one

part is on the end of the period are correctly considered as one feature.

35.2.14 Zernike & Seidel Surface

Zernike fringe, Zernike standard, and Seidel aberrations are often used to describe aberrations within an imag-

ing optical system. The corresponding formulas are given in Sec. 134.2.
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Figure 236. The edit dialog for a Zernike & Seidel Surface in Zernike Standard Aberrations mode.

The Structure tab of the Zernike & Seidel Surface (↪→Fig. 236) allows the following settings.

ITEM DESCRIPTION

Unit Radius Radius which refers to the value ρ = 1 in the Zernike polynomial.

Mode You can choose between Zernike Fringe Aberrations, Zernike Standard Aber-

rations, and Seidel Aberrations.

Polynomial Degree O Z S A

Allows you to set the maximum polynomial degree of the used Zernike terms,

and thus indirectly the number of coefficients.

{Coefficients Table} Allows you to enter the coefficients of the polynomial describing the aberra-

tions. Via the context menu of the table you can copy and paste the parameter

list.

Reset Tabular Resets all table entries to 0.

The remaining controls are explained in Sec. 35.1.
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35.3 Surface View

Figure 237. Sample surface view.

The surface view (↪→Fig. 237) contains the 3D view control described in Sec. 5.15. On the bottom of the view

the z-extension of the surface is shown. Furthermore the Minimum and Maximum Height of the surface are

given, whereas a height of zero means the height at the lateral position (0m; 0m).

36 Optical Coatings

For plenty of practical applications of optical systems it is important to have optical coatings on the setup’s

surfaces at one’s disposal. Usually, there are two kinds of effects intended that shall be caused by coatings,

which are suppression of reflection on the one hand and maximum reflectivity on the other. For these purposes,

a coating is built in the production process by one or more thin films of materials of defined thickness and index

of refraction. The necessary combination of the layer parameters is determined by the wavelength the desired

effect shall be maximized for. For further information please read [Her90], [Mac01], or [Ran96].

In order to give the user the possibility to work with correct values of reflectance and transmittance of coated

elements, there is the Building Block type Coating, which can be applied to most of the surfaces.

Inside the edit dialog of an Optical Surface, a coating can be selected from the catalog as described in Sec. 34.2.

While propagating through the system, any type of propagation operator will regard the coating when crossing

the surface – provided that the operator is able to consider Fresnel effects.

36.1 Types of Optical Coatings

VirtualLab Fusion provides two different kinds of coatings. The first type contains layers of homogeneous,

isotropic media only. Processing data which influence the layer thickness in dependence on some process

parameters (↪→Sec. 36.2.2) can be defined as well. The regarding template can be found in the coatings

catalog as ’Standard Coating’. The other type of coating may contain layers of homogeneous isotropic as well
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as anisotropic media. However, processing parameters cannot be specified here. The template for this kind of

coating can be found as ’Anisotropic Layer Stack’ in the catalog.

Standard Coating Anisotropic Layer Stack

Inhomogeneous Layer Media 8 8

Anisotropic Layer Media 8 4

Isotropic Layer Media 4 4

Processing Parameters 4 8

36.2 Defining and Editing Optical Coatings

If a new coating is to be created, the coating template (which is part of the Coatings Catalog) has to be provided

with a layer system of different media and thicknesses.

In case of Standard Coatings, the edit dialog consists of two panels, the Layer Definition Panel and the Process

Data Panel, both described in the following sections. While the layer definition is very similar for both types of

coatings, there is no process data definition for Anisotropic Layer Stacks.

Regardless of the type of coating, the following buttons can be found on the bottom of the dialog:

ITEM DESCRIPTION

Shows the coating view. ↪→Sec. 36.3

Saves the coating to the catalog. Not available if the coating is edited from

within the catalog.

In case of Standard Coatings, an import for Macleod Coating Data ↪→Sec. 128

is called by this button.

In case of Anisotropic Layer Stacks, a Standard Coating can be imported (i.e.

converted) by this button.

36.2.1 Layer Definition

The definition of coatings as stacks of thin layers is done via the edit dialogs shown in Fig. 238.
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Figure 238. Layer definition controls of the edit dialog for coatings. Left: The layer definition control for a Standard Coat-

ing. Right: The layer definition control for an Anisotropic Layer Stack.

There are two important differences in the definition of Standard Coatings on the one hand and Anisotropic

Layer Stacks on the other hand: Since a Standard Coating allows isotropic homogeneous media only, its

layer media can always be defined by a single material (↪→Sec. 38), respectively. Anisotropic Layer Stacks, in

contrast, need an Optical Medium (↪→Sec. 37) specification for each layer. The other difference is the need for

a definition of the anisotropic medium’s orientation in case of an Anisotropic Layer Stack.

All layer definition parameters are described in the following:
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ITEM DESCRIPTION

Index Index of the layer, counted from the substrate. That means: the higher the

index, the higher is the distance of the layer to the substrate’s surface.

Thickness PV Thickness of the layer. For a Standard Coating, this is the initial thickness

before applying any process parameters to the coating.

Distance Distance of the upper border of the layer to the substrate. This value can not

be changed and is calculated from all thicknesses of the layers with a smaller

index.

Material PE S C .

The material the layer consists of is to be set here. It can be loaded from a

catalog, edited or shown via the buttons , , and which appear inside

the table cell when the corresponding row is active.

Medium A L S .

The optical medium the layer consists of is to be set here. It can be loaded

from a catalog, edited or shown via the buttons , , and which appear

inside the table cell when the corresponding row is active.

Orientation A L S .

The orientation of an anisotropic layer medium. In case of uniaxial crystals,

only the direction of the optical axis is to be specified (↪→Sec. 5.5). For other

types of anisotropic media, a full orientation has to be defined (↪→Sec. 5.6).

The z-axis of the reference system points always away from the substrate.

The y-axis of the reference is identical to that of the surface’s coordinate sys-

tem.

Append Appends a new layer at the end of the table.

Insert Inserts a new layer before the selected one.

Delete Deletes the selected layers. Selecting more than one layer is possible. You

can also delete using the Del key.

Moves the currently selected layer(s) up.

Moves the currently selected layer(s) down.

Layer Tools > Append Re-

peated Layer Sequence

Allows you to append a (sub)sequence of the already defined layers, for sev-

eral times, if required. ↪→Sec. 36.2.1.1

Minimum Wavelength Minimum wavelength the coating can be used with. This value is equal to the

highest minimum wavelength of all layer materials.

Maximum Wavelength Maximum wavelength the coating can be used with. This value is equal to

the lowest maximum wavelength of all layer materials.

36.2.1.1 Repeated Appending of Layer Sequences

Especially high reflection coatings consist of many thin film layers. The stack is built of a replication of the same

elementary layer sequence, like for instance SiO2 – TiO2 – SiO2 – TiO2 – · · · – SiO2 – TiO2.

In order to make the definition of that kind of coatings easier, VirtualLab Fusion provides a tool for the replication

of layer sequences (Layer Tools > Append Repeated Layer Sequence). Its configuration dialog is shown in

Fig. 239.
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Figure 239. Configuration of the Append Repeated Layer Sequence tool.

ITEM DESCRIPTION

Index of First Layer Index of that layer, the sequence to append shall start with.

Index of Last Layer Index of that layer, the sequence to append shall end with.

No. of Replications Number of replications of the defined sequence to be appended to the current

stack.

36.2.2 Process Data

O S C

The properties of a real coating naturally depend on the conditions of the process it was produced in. First

of all, its thickness depends on the deposition parameters, like the flow direction of the material. Therefore

VirtualLab Fusion allows to specify some of these parameters in case of Standard Coatings. The modeling is

done according to the Hertz-Knudsen-Law (↪→Sec. 133.2).

Figure 240. Process data panel of the edit dialog of coatings.

The panel shown in Fig. 240 contains the parameters to adapt the simulated coating to its processing. They

are summarized in the following table.
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ITEM DESCRIPTION

Coating Thickness De-

pends on Normal Vector

of Substrate Surface

If checked, consider the normal vector of the surface, i. e. the surface of the

substrate, for the calculation of the coating thickness.

Coating Thickness De-

pends on Particle Source

Position

If checked, consider position of the particle source and direction of the particle

flow for the calculation of the coating thickness.

Source Position Position of the particle source relative to the intersection point of optical axis

and surface (point (0, 0, 0) in Fig. 241).

Flow Direction Main direction of the particle flow, i. e. direction with the highest flux density

(vector f in Fig. 241).

Figure 241. Sketch of the meaning of the processing parameters of coatings.

36.3 Coating View

The view for coatings is shown in Fig. 242 (Diagram tab) and Fig. 243 (Coefficients Calculator tab).

Please note: Even if the same view is used for Standard Coatings and Anisotropic Layer Stacks, the shown

values and the diagram are only of limited value in case of the latter. There are two reasons for this restriction:

At first, The incident wave is always assumed to lie in the x-z-plane. Secondly, only the main diagonal values

of the complete Fresnel matrix are used for the view. So, in case of Anisotropic Layer Stacks, the view should

only be used cautiously.
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Figure 242. Example for a coating view, showing the dependence of the transmittance on the wavelength for an angle of

incidence of 50◦ for TE and TM polarization.

Figure 243. Example for the coating coefficients calculator.

Besides the name of the coating and the categories it belongs to, the document always shows the wavelength

range, the coating data are defined for:

ITEM DESCRIPTION

Min. Wavelength The minimum vacuum wavelength the materials in the coating layers are de-

fined for.

Max. Wavelength The maximum vacuum wavelength the materials in the coating layers are

defined for.

The Diagram tab shows the wavelength or the angular dependency of the reflectance or the transmittance for
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TE and/or TM polarization. The diagram view can be configured via a configuration dialog (↪→Sec. 36.3.1) which

is called by the button Configure Diagram.

The Coefficient Calculator tab allows calculating reflectance and transmittance for a given wavelength and

angle of incidence:

ITEM DESCRIPTION

Vacuum Wavelength Wavelength to calculate reflectance R and transmittance T of this coating for.

Angle of Incidence Angle of incidence to calculate reflectance R and transmittance T of this coat-

ing for.

Reflectance Reflectance for the Vacuum Wavelength and the Angle of Incidence.

Transmittance Transmittance for the Vacuum Wavelength and the Angle of Incidence.

36.3.1 Configuration of the Coating View

The dialog for the coating diagram configuration is described in the following sections.

36.3.1.1 Parameter Selection Panel

Figure 244. The panel for the selection of the parameters to be drawn.

ITEM DESCRIPTION

Wavelength / Incidence

Angle

Choose whether the dependency on the wavelength or the angle of incidence

shall be drawn.

Constant Incidence Angle The incidence angle to show the diagram for, if dependency on Wavelength

is chosen.

Constant Wavelength The wavelength to show the diagram for, if dependency on Incidence Angle

is chosen.

Reflectance / Transmit-

tance

Choose whether the reflectance or the transmittance shall be shown.

Show TE Coefficient T -

0.
If selected, one curve for TE polarization is plotted.

Show TM Coefficient T -

0.
If selected, one curve for TM polarization is plotted.
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36.3.1.2 Materials Panel

Figure 245. The panel for the definition of the materials to be used for the calculation.

ITEM DESCRIPTION

First Material Set the material on the incidence side. ↪→Sec. 34.3

Second Material Set the material on the transmitting side. ↪→Sec. 34.3

Coating Orientation on

Substrate

Defines the orientation of the coating. ↪→Sec. 34.2

36.3.1.3 Axes Panel

Figure 246. The panel for the configuration of the axes.

ITEM DESCRIPTION

Scale Y-Range Automati-

cally.

If selected, the range for the y axis is calculated automatically.

Minimum If Automatic Detection is not chosen, the minimum of the y-axis range can be

set here.

Maximum If Automatic Detection is not chosen, the maximum of the y-axis range can

be set here.

36.3.1.4 Colors

The colors of the curves can be set via this control. Only the color of those curves can be set, which have been

selected in the Parameter Selection panel (↪→Sec. 36.3.1.1).
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Figure 247. The panel for the curve colors.

37 Optical Media

The structural information of an optical system can be understood as a sequence of different homogeneous or

inhomogeneous media, separated by optical surfaces (↪→Sec. 35). The first medium in the system is always

defined in connection with the light source.

VirtualLab Fusion supports different types of optical media: homogeneous, isotropic media (↪→Sec. 37.3.1) as

well as different kinds of inhomogeneous (but isotropic) or anisotropic (but homogeneous) media (Sec. 37.3.2

– Sec. 37.3.14). Homogeneous, isotropic media consist of exactly one material (↪→Sec. 38), while inhomoge-

neous, isotropic media usually are defined either by several, spatially distributed materials or by one material

and a function that gives the spatial variation of the refractive index. The anisotropic, homogeneous media

are defined either by two materials (uniaxial crystals), three materials (biaxial crystals) or by two wavelength

dependent tensors for permittivity and permeability (general anisotropic media).

The application of media is described in Sec. 34.1.

37.1 Common Controls for Editing Inhomogeneous Optical Media

All inhomogeneous optical media have their edit dialog divided into three tab pages. The Basic Parameters tab

is specific for the particular medium (↪→Sec. 37.3).

Figure 248. The edit dialog of optical media showing the scaling tab.

The Scaling tab (↪→Fig. 248) has the following controls.

ITEM DESCRIPTION

Scaling in x-Direction PV The scaling factor for x-direction as defined in Sec. 133.3.1.

Scaling in y-Direction PV The scaling factor for y-direction as defined in Sec. 133.3.1.

Scaling in z-Direction PV The scaling factor for z-direction as defined in Sec. 133.3.1.

These three factors must be larger than zero.
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Figure 249. The edit dialog of optical media showing the periodization tab.

The Periodization tab (↪→Fig. 249) has the following controls.

ITEM DESCRIPTION

Use Periodization If checked, a period for x-, y-, and / or z-direction can be set. If you do not

want periodization for a certain direction, you can set the period to infinity for

that direction.

Period in x-Direction PV The period Px as defined in Sec. 133.3.1.

Period in y-Direction PV The period Py as defined in Sec. 133.3.1.

Period in z-Direction PV The period Pz as defined in Sec. 133.3.1.

The aforementioned controls are disabled if a medium cannot be modulated in the corresponding direction.

For example a Sampled Medium (↪→Sec. 37.3.11) can never be modulated in z-direction and thus Scaling in z-

Direction and Period in z-Direction are disabled and cannot be changed by the user. Furthermore, if a medium

is always periodically, its period is calculated from the specific medium parameters and the scaling factors. In

this case, all periodization controls are disabled. This affects Pillar Medium (z-Independent) (↪→Sec. 37.3.9)

and the Volume Grating Medium (↪→Sec. 37.3.14).

Additionally the edit dialog has a -button to show the medium preview (↪→Sec. 37.2) and a -button to save

the medium to the medium catalog.

37.2 Medium View

Different types of media need different kinds of views. The next sections will describe these different views.

37.2.1 View for Inhomogeneous, Isotropic Media

This medium view (↪→Fig. 250) shows a cross section through the spatial distribution of the refractive index of

a medium.
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Figure 250. The view for inhomogeneous, isotropic media. This example shows a x-y-plane through a GRIN medium

(↪→Sec. 37.3.6).

Please note: Since optical media are inherently unlimited (spatial limits in modeled optical setups are always

defined by surfaces, ↪→Sec. 35), the view allows unlimited zoom and scrolling as well. That’s why the scroll

bars behave somewhat unusual: They always jump back to the center position after scrolling and they don’t

change their size during zooming as well.

37.2.1.1 Context Menu

ITEM DESCRIPTION

Aspect Ratio The aspect ratio of the diagram can be changed here (↪→Sec. 11.5).

Zoom These items allow to zoom in or out or into a marked rectangular selection

(↪→Sec. 11.4).

Selection Mode This option allows to define what happens if mouse clicking or drawing in the

diagram is done (↪→Sec. 11.3).

The rectangular marker can be used for defining a zoom window. The line

marker allows to define an arbitrary section plane (see Sec. 37.2.1.2 be-

low). The point marker is useful for reading medium data at a certain point

(↪→Sec. 37.2.1.4).

Marker Visibility A selection which markers ((↪→Sec. 11.3)) are to be visible can be done.

37.2.1.2 Panel ’Content’

The Content panel allows to specify what medium data are to be shown in the diagram.
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Figure 251. Panel for the configuration of the view content.

ITEM DESCRIPTION

Wavelength Wavelength to be used for calculating refractive index or absorption data.

Refractive Index n /

Absorption Coefficient α /

Absorption Index κ

Which quantity shall be shown?

Environment O R I .

Opens a small dialog for defining temperature and pressure for refractive in-

dex calculation.

Section Plane The plane to be intersected with the medium is to be selected here. Arbitrary

refers to the last plane which has been created via From Marker Line.

From Marker Line O L M . (T

, ↪→S . 37.2.1.1)

An arbitrary section plane can be created by pressing this button. The plane

is defined by the current marker line and the normal direction to the currently

visible plane. The new view range to be shown is determined by the length of

the line marker which will be used as horizontal and vertical extension resp.

View Range > Default

View

O S P A .

(Re-)Sets the visible view range to default values.

View Range > Multiple Pe-

riods

O .

Opens a dialog where the numbers of horizontal and vertical periods to be

shown can be defined. If Section Plane is set to Arbitrary, the view range will

be approximated.

View Range > Free Range

Definition

Opens a dialog (↪→Sec. 11.3.1.2) for direct editing of the view range to be

shown.

x-/y-/z-Position of Section

Plane

Allows to set the position for the section plane along its own normal direction.

If Section Plane is set to Arbitrary, the normal and the starting point for the

measurement is written to an informational label.

37.2.1.3 Panel ’Appearance’

The Appearance panel allows to specify the color scaling of the diagram.

Figure 252. The panel for the configuration of the color scaling.
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ITEM DESCRIPTION

Automatic Scaling If checked, the diagram’s value range will be adapted automatically to the

range of the currently selected quantity to be shown.

Minimum O A S .

The minimum of the selected quantity to be shown.

Maximum O A S .

The maximum of the selected quantity to be shown.

Color Table The color table (↪→Sec. 11.2.4) to be used can be chosen here.

37.2.1.4 Panel ’Value at (x,y,z)’

This panel allows reading all stored media information at one given position (x, y, z) in space.

Figure 253. Panel for reading.

ITEM DESCRIPTION

Position X/Y/Z The position (x, y, z) to read all quantities for.

Refractive Index n /

Absorption Coefficient α /

Absorption Index κ

The real valued refractive index n, the absorption coefficient α, and the ab-

sorption index κ for the position (x, y, z).

The reading position (x, y, z) can be selected by setting the point marker within the diagram. If the position is
defined via text-boxes, the marker will be visualized in the diagram. If the position happens to lie outside the

shown section plane, the user will be asked whether or not it should be projected onto the plane. Independently

from the user’s choice, the extracted quantities refer to the given position (x, y, z).

37.2.2 View for Anisotropic, Homogeneous Media

This medium view (↪→Fig. 254) shows the index ellipsoid which represent the dependency of the refractive index

on the wave direction through an anisotropic medium.
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Figure 254. The View for Homogeneous, Anisotropic Media.

The view contains the 3D view control described in Sec. 5.15. The display can be configured with the param-

eters described in the following sections.

37.2.2.1 Content

Figure 255. The panel for the configuration of the content of the view.

ITEM DESCRIPTION

Wavelength The vacuum wavelength to show the ellipsoid for.

Index Ellipsoid / Velocity

Ellipsoid

Either the refractive index ellipsoid or the velocity ellipsoid can be shown.

Optical Axis / Axes If selected, the single optical axis of a uniaxial crystal or the two optical axes

of a biaxial crystal are drawn. The circular ellipsoid section each of the axes

is perpendicular to is drawn and labeled (with the refractive index which cor-

responds to the effect of traveling parallel to the axis) as well.

WaveDirection &Eigen In-

dices

If selected, an arbitrary wave direction can be set via Set Direction. It will be

visualized in the ellipsoid in conjunction with the elliptical ellipsoid section the

direction is perpendicular to. The effective refractive Eigen indices are given

as well.

Set Direction In caseWave Direction & Eigen Indices are selected, the wave direction can

be set via a dialog (described in Sec. 5.5) opening when this button is pressed.
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If neither Optical Axes nor Wave Direction & Eigen Indices are shown, the ellipsoid’s principal semi-axes are

drawn and labeled.

37.2.2.2 Appearance

Figure 256. The panel for the configuration of the appearance of the view.

ITEM DESCRIPTION

Wireframe If selected, the ellipsoid will be drawn as wireframe.

Density ifWireframe has been selected, the density of the lines can be set here.

Digits The number of digits to be used for all labels inside the view.

37.2.3 View for Homogeneous, Isotropic Media

For homogeneous, isotropic media, the user can choose whether to visualize the homogeneity or the isotropy

of the medium.

Figure 257. The tabs for choosing between visualizing the homogeneity or the isotropy of the medium.

Using the control shown in Fig. 257, the user may select the view described in Sec. 37.2.1 or the one described

in Sec. 37.2.2.

37.3 Optical Media Types

In this section, the types of Optical Media provided by VirtualLab Fusion are described. They can be accessed

as templates in the Media Catalog.

37.3.1 Homogeneous Medium

Homogeneous media (which, for the sake of completeness, should be called ’homogeneous and isotropic me-

dia’) are media which are completely defined by a single Material PE . Thus their refractive index is independent

from the spatial position as well as from the wave direction through the medium. The control for setting this

material for the medium is described in Sec. 34.3. The remaining controls are explained in Sec. 37.1.

Figure 258. Dialog for setting up a homogeneous medium.
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37.3.2 Aperture Medium

The aperture medium consists of two different materials arranged in a way that the lateral cross section looks

like an aperture. That means the Outer Material envelops the elliptically or rectangularly shaped Inner Material.

For detailed information about materials please see Sec. 38.

The edit dialog of this type of media is shown in Fig. 259.

Figure 259. Dialog for the specification of an aperture medium.

ITEM DESCRIPTION

Inner Material PE Control which defines the material inside the aperture. ↪→Sec. 34.3

Outer Material PE Control which defines the material outside the aperture. ↪→Sec. 34.3

Shape Shape of the Inner Material in a cross section lateral to the optical axis.

Diameter PV Determines the diameter of the Inner Material in x- and y-direction.

The remaining controls are explained in Sec. 37.1.

37.3.3 Biaxial Crystal

Biaxial crystals are anisotropic media which are specified by three principal refractive indices.
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Figure 260. Dialog for the specification of a biaxial crystal.

The edit dialog for this kind of medium (shown in Fig. 260) needs the following parameters:

ITEM DESCRIPTION

Material of Principal Index

α/β/γ

The dispersion relations for the three principal indices α, β, and γ are repre-

sented by three materials. The control for setting a material is described in

Sec. 34.3.

37.3.4 Fiber Medium

Figure 261. Dialog for the specification of a fiber medium.

A fiber can be described as a round core (made of an arbitrary medium) which is surrounded by a cladding

(made of a homogeneous medium).

The edit dialog of this medium (↪→Fig. 261) has thus the following parameters.
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ITEM DESCRIPTION

Core Medium Here you can define the medium of the core using the control described in

Sec. 34.1.

Cladding Material Allows you to define the material of the homogeneous cladding medium. This

control is described in Sec. 34.3.

Core diameter The diameter of the core. If you enter different values for the x- and y-

direction, you can define an elliptical core. Double-clicking into one of the

two text boxes inserts the value from the other text box.

The remaining controls are explained in Sec. 37.1.

37.3.5 General Anisotropic Medium

If some anisotropic medium has to be described which cannot be considered being an uniaxial or biaxial crystal,

a General Anisotropic Medium can be defined. It is not based on different materials (describing dispersion

relations for different principal directions) but provides wavelength dependencies for the permittivity tensor and

permeability tensor instead.

Figure 262. Dialog for the specification of a general anisotropic medium.

The edit dialog for this kind of medium (shown in Fig. 262) works with the following parameters:

ITEM DESCRIPTION

Snippet for Permittivity /

Permeability Tensor

The wavelength dependency of the permittivity and permeability tensor has to

be programmed by code snippets, resp. Edit opens the Source Code Editor

(↪→Sec. 7.3) to edit this snippet, and a validity indicator (↪→Sec. 5.10) shows

whether this snippet is consistent.

Valid Vacuum Wavelength

Range

The wavelength range the defined tensors hold valid for is to be defined via

Minimum and Maximum here.

37.3.6 GRIN Medium

A GRIN medium is described by a base material and an analytical formula which alters the (complex-valued)

refractive index n0 of this base material.
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Figure 263. Dialog for editing a GRIN medium.

The edit dialog (↪→Fig. 263) has the following controls.
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ITEM DESCRIPTION

Base Material PE Defines the base material of the GRIN medium. For a detailed description of

the controls within this group box see Sec. 34.3.

Rotational Symmetry /

Cylindrical Symmetry

You can define a GRIN lens with either Rotational Symmetry (modulation

along the radius r =
√

x2 + y2) or with Cylindrical Symmetry (modulation

only along one direction). In the latter case you can additionally set the Ro-

tation Angle PV α. α = 0° refers to modulation in x-direction only and α = 90°

refers to modulation in y-direction only.

{Formula} This list box lets you choose the equation used for the calculation of the refrac-

tive index modulation. The available formulas are described in Sec. 133.3.2.

Each equation has different parameters and thus different input controls.

Maximum Order N O P S R P

The maximum order N of the polynomial.

{Table} PV F P L I P

Allows you the enter the parameters of the polynomial.

Invalidity Substitute PV The resulting refractive index is equal to the Invalidity Substitute in case the

actual formula yields zero or negative values (or roots of negative values in

case of Square Root of Polynomial).

Calculate g from GRIN

Lens Parameters

O A (s)
Opens a dialog where you can calculate the gradient constant g from the

so-called pitch P of a GRIN lens and its length z.

Decrease Δ PV /

Outside Value n1
PV

O P L I P

The decrease ∆ describes how much the refractive index is decreased till the

border b. Alternatively you can directly enter the refractive index n1 at and

outside of the border. The two values are related via n1 = n0
√

1− 2∆.

Border b PV O P L I P

The Power Law Index Profile is usually used to describe an optical fiber with

a GRIN profile. In this case, the border b is equal to the core radius of the

fiber.

Exponent p PV O P L I P

The (positive) exponent p of the equation is usually close to 2 for GRIN fibers

and infinity for step-index fibers.

The remaining controls are explained in Sec. 37.1.

37.3.7 Medium with Inclusions

In the base material of a Medium with Inclusions, spherical1 inclusions of another material are embedded.

These inclusions are placed at random positions in the elementary cell of the medium (↪→Sec. 133.3.1). Thus,

the Medium with Inclusions must always be periodical, which is ensured by its edit dialog. Both the positions

and the radii of the inclusions follow a uniform random distribution.

1 By using different scaling values for x, y and z (↪→Sec. 133.3.1), the spheres may be dilated or compressed to become ellipsoids.
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Figure 264. Dialog for editing a Medium with Inclusions.

The edit dialog (↪→Fig. 264) contains the following controls:

ITEM DESCRIPTION

Base Material PE Defines the material the inclusions are embedded within. For a detailed de-

scription of the controls within this group box see Sec. 34.3.

Material within Inclu-

sions PE

Defines the material the inclusions consist of. For a detailed description of

the controls within this group box see Sec. 34.3.

Diameter Range of Inclu-

sions

Allows to specify theMinimum Inclusion Diameter PV and theMaximum Inclu-

sion Diameter PV for the diameter random distribution. Both values may be

equal in case no size variation is needed.

Density of Inclusions PV The mean density ρ of the inclusions.

The number of inclusions N within the elementary cell is N = ρ · V, with V
being the volume of the elementary cell. Note that even if the medium is

Invariant in y-Direction, the media period in y-direction influences the volume

V and thus the number of inclusions.

A warning is shown in case

• the desired density is so low that less than 0.5 inclusions are to be

placed in the elementary cell.

• the desired density cannot be achieved due to a too high density or a

too small media period.

Invariant in y-Direction If this option is checked, the centers of all inclusions are placed at y = 0 so

the positions vary in the x-z-plane only.

Seed for Random Genera-

tor PV

A value which is needed for the generation of the random distribution of the

inclusions: With the same value and the same physical settings listed above

always the same refractive index distribution will be generated.
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Create Inclusions Pressing this button will start the generation of the inclusions. Please note:

Every parameter change (except for changed materials) requires a new cre-

ation in order to become effective!

The remaining controls are explained in Sec. 37.1.

37.3.8 Pillar Medium (General)

The Pillar Medium (General) is a periodical medium consisting of a base material with periodically distributed

pillars of another material (↪→Sec. 38). In contrast to the Pillar Medium (z-Independent) it supports parameter

variation, slanted pillars and round edges; but not elliptical pillars.

An arbitrary amount of pillars can be freely distributed, each with its own lateral extension. The pillars must be

well-separated. This means that refractive indices are determined only by the nearest pillar, if at all.

Figure 265. The parameters defining the geometry of a single (circular) pillar.
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Figure 266. Basic Parameters tab of the Pillar Medium (General).

The Basic Parameters tab (↪→Fig. 266) has the controls explained below. The other tab pages are explained in

Sec. 37.1.

ITEM DESCRIPTION

Embedding Material PE Allows the user to define the material outside the pillars by means of the

control described in Sec. 34.3.

Pillar Material PE Allows the user to define the material inside the pillars by means of the control

described in Sec. 34.3.

Pillar Geometry This tab page contains settings for the geometry of all pillars. They are ex-

plained in a separate table below.

Pillar Distribution The table on this tab page allows you to define x-Position, y-Position, and

Side Length / Diameter D of each pillar.

There are several Table Tools which help you to set up the table (for example

add or remove rows). They are explained in a separate table.

Furthermore this tab page contains the Import Diameter Data button which

allows you to import diameter values on an equidistant grid from a two-

dimensional data array or (via Import…) from a bitmap or text file by means

of the import wizard described in Sec. 121.2.

Validity Indicates problems with the current configuration of the medium by means of

the control explained in Sec. 5.10.
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On the Pillar Geometry sub-tab there are the following settings for the geometry of all pillars.

ITEM DESCRIPTION

Height PV The height H of all pillars.

Side Wall Slope Angle PV The angle α defining the slope of the side walls. As you can see in Fig. 265

an angle between 0° and 90° means that the side length / diameter of a pillar

becomes larger with increasing z, and an angle between 90° and 180° means
that the side length / diameter of a pillar becomes smaller with increasing z.

Shape PE A pillar can either have a Squared or Circular shape. In the former case you

define the side lengths of the pillars, in the latter the diameters.

Definition Mode of Side

Lengths / Diameters PE

O S W S A 90°, . .

.

As shown in Fig. 265 there are three possible heights where the side length

/ diameter D can be measured: at the Bottom, the Half Height, or the Top. In

case of perpendicular side walls all three values are the same.

Round Edges O C .

Allows you to define round edges at the top and the bottom, respectively, of

the side wall.

Rounding via Diameter

Percentage

O R E .

If this option is checked, the edge radii are defined relatively to the diameter

D of each pillar. Otherwise they are defined absolutely.

Edge Radius (Bottom) PV O R E .

The edge radius Rbottom. Note that this radius can also be negative to define

an overhanging pillar.

Edge Radius (Top) PV O R E .

The edge radius Rtop. Note that this radius can also be negative to define an

overhang.

The following table tools are available:
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TOOL DESCRIPTION

Add Pillar… Opens a separate dialog where you can enter Position and Side Length /

Diameter of a new pillar which is the added to the end of the table.

Remove Current Pillar Removes the currently selected pillar. The same can be done by pressing

the Del key while the table is has the input focus.

Reset Table Resets the table to its initial state (one pillar at position (0m; 0m) with a side

length / diameter of 100 nm).

Add Equidistant Pillars… Opens a separate dialog where you can enter the Number of Pillars and their

Center-to-Center Distance as well as their Side Length / Diameter.

If you check Overwrite Existing Data the table contains only these new pillars

after you close the dialog withOK. Otherwise the new pillars are simply added

to the table.

Set Common Side Length

/ Diameter…

Sets the side length / diameter of all already defined pillars to the same value.

Configure Parameter Vari-

ation…

Defines how the values in the table are made available for Parameter Extrac-

tion. ↪→Sec. 37.3.8.1

37.3.8.1 Parameter Variation

There are several ways how the positions and side lengths / diameters of the pillars can be made available for

Parameter Extraction (↪→Sec. 43.5).

• Original Values: The values defined in the table are directly made available for parameter extraction.

This means that for each pillar Position X, Position Y, and Side Length / Diameter can be varied e. g. in

the Parameter Run.

• Deviation of Original Values: For each pillar you can vary the deviation from the original values defined

in the table. For example you then can make the side length / diameter of the first pillar 5 nm smaller and

the side length / diameter of the first pillar 5 nm smaller.

• Scaling of all Values: The values of all pillars are multiplied with the same scaling factor, whereas there

is one Scaling Factor for Positions and one Scaling Factor for Side Lengths / Diameters.

The table tool Configure Parameter Variation… allows you to set this separately for the pillar positions and the

pillar side lengths / diameters.

To increase performance in case of very many pillars (> 1000), consider choosing Scaling of all Values instead

of the other two options, especially if Parameter Extraction is not needed for the positions or side lengths /

diameters. You can also exclude these parameters completely from Parameter Extraction via an Optical Setup

Tool (↪→Sec. 43.5).

37.3.9 Pillar Medium (z-Independent)

The Pillar Medium (z-Independent) is a periodical medium consisting of a base material with periodically dis-

tributed pillars of another material (↪→Sec. 38). In contrast to the Pillar Medium (General) it supports elliptical

pillars; but not parameter variation, slanted pillars and round edges.

The position and shape of the pillars are z-independent. That means that all x-y cross sections through the

medium are equal. The shape all pillars of the x-y cross section is either rectangular or elliptical. The pillars are

distributed periodically on the x-y cross section. They are grouped in equal rows (along x-direction), whereas

two consecutive rows can be x-shifted to each other, but every other row has the same x-shift (↪→Fig. 267).
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Figure 267. x-y cross section through a Pillar Medium (z-Independent) with all parameters that can be edited.

Via the edit dialog (↪→Fig. 268) the materials and the geometrical parameters of the medium can be adjusted.

ITEM DESCRIPTION

Base Material PE There the user can define the base material (↪→Fig. 268). It is loadable from

a material catalog (if Catalog Material is selected) or can be defined by a

constant refractive index (ifDefined by Constant Refractive Index is selected).

Pillar Material PE The pillar material (↪→Fig. 268) is adjustable in the same manner as the base

material.

Pillar Size and Shape The size and shape of pillars in the x-y cross section of the medium can be

defined there. The pillar cross sections can be of Elliptical or Rectangular

shape. The Diameter PV is adjustable in x- and y-direction.

Horizontal Pillar Dis-

tance PV

x-distance between two consecutive pillars within a row of pillars in the x-y

cross section ( ↪→Fig. 268)

Vertical Pillar Distance PV y-distance between two consecutive rows of pillars in the x-y cross section

(↪→Fig. 268)

Row Shift PV Via this parameter the x-shift between two consecutive rows of pillars

(↪→Fig. 268) can be adjusted. Any real value can be entered there, but it is

internally transformed to the smallest equivalent positive value (smaller than

the period in x-direction.

Period The size of a 2D periodical x-y-section through themedium can not be entered

directly but is calculated from the other geometrical parameters. Both values

(x and y) are updated after each parameter change.

The remaining controls are explained in Sec. 37.1.
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Figure 268. Dialog for the specification of a Pillar Medium (z-Independent).

37.3.10 Programmable Medium

The programmable medium allows you to define an arbitrary, complex-valued refractive index distribution

ñ(x, y, z) by writing its formula into a little code snippet. If the medium is set to periodic, you can use the

variables MediaPeriodX, MediaPeriodY, and MediaPeriodZ in your snippet.
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Figure 269. Sample edit dialog for the programmable medium.

The corresponding edit dialog (↪→Fig. 269) contains:

ITEM DESCRIPTION

Base Material PE ↪→Sec. 34.3

The refractive index of the Base Material is always added to the function de-

fined by the snippet if the snippet defines Index Modulation.It is also taken

into account for the optical path length calculated by the Optical Path Length

Analyzer (↪→Sec. 82).

Snippet defines… If you select Index Modulation the refractive index of the Base Material is

always added to the function defined by the snippet. Otherwise you directly

define the refractive index distribution ñ(x, y, z).

Definition This group box allows you to program the actual code snippet. Edit opens the

Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

General information about programming in VirtualLab Fusion can be found in Sec. 7. The remaining controls

are explained in Sec. 37.1.

37.3.11 Sampled Medium

This medium allows you to set a 1D or 2D data array (↪→Sec. 13) with a sampled refractive index profile.

The edit dialog of this optical medium is shown in Fig. 270.
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Figure 270. Dialog for the specification of a sampled medium.

The following options can be entered:

ITEM DESCRIPTION

Sampled data defines Defines whether the sampled refractive index profile is interpreted as Index

Modulation, i. e. it is added to the refractive index defined by the Base Mate-

rial. Or it can be interpreted as Index Distribution, i. e. the values in the data

array are directly the final refractive indices.

Base Material PE O  I M

The controls in this group box are explained in Sec. 34.3. They define the

complex refractive index added to the refractive index profile.

Set Offers you three ways to set a data array with the refractive index modula-

tion (see below). The data array must contain exactly one subset where the

coordinates have the unit length and the data have no unit.

Set > Load Loads a data array from a .da file.

Set > Import Imports a data array from a bitmap or text file by means of the import wizard

described in Sec. 121.2.

Set > Select from Docu-

ments

Allows you to select an already open data array.

Show Shows the currently set refractive index definition / modulation as separate

document.

{Interpretation of 1D Data} When you set 1D data, you can define whether the coordinates are interpreted

as being x- or y-values. When the data contain only positive values, the coor-

dinates can additionally be interpreted as ρ =
√

x2 + y2 yielding rotationally

symmetric refractive indices.
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Interpolation Method Lets you select the Interpolation Method Equidistant and/or the Interpolation

Method Non-equidistant, dependent on the data. ↪→Sec. 13.2

Extrapolation Lets you select how coordinates outside of the coordinate range of the given

data are interpreted (↪→Sec. 13.3).

In particular, you can select periodic extrapolation. This is in the very

most cases more suitable then choosing the normal medium periodization

(↪→Sec. 133.3.1) – where periods have to be entered by the user and are re-

stricted to be always centered around the coordinate origin which might yield

unexpected results.

The remaining controls are explained in Sec. 37.1.

37.3.12 Slanted Grating Medium

This kind of medium represents a periodic grating with ridges. A ridge has two flanks which both are slanted

with respect to the vertical by a certain angle. A coating with a single layer can be applied to the flanks, the

bottom, and the top of the grating.

Figure 271. Dialog for the specification of a Slanted Grating Medium.
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The edit dialog of this medium (↪→Fig. 271) has the following options:

ITEM DESCRIPTION

Grating Material PE The material of the grating ridges. Also used to fill the area in front of the

modulated region. The controls in this group box are explained in Sec. 34.3.

Groove Material PE The material of the grating grooves. Also used to fill the area behind the

modulated region. The controls in this group box are explained in Sec. 34.3.

Fill Factor PV The ratio of the grating ridges to the period in x-direction of the medium. If

the slant angles of the flanks differ, the width of the ridges changes with z. In
this case it makes a difference whether the fill factor Refers to … the bottom

(z = 0) or the top (z = z-Extension) of the grating.

z-Extension PV The extension of the ridges (without coating) in z-direction. Note that if a

Slanted Grating Medium is used within an Optical Stack (↪→Sec. 39), its z-

extension (with coating) determines the thickness of the stack layer where it

is placed in. Thus you cannot set the z-.Distance of the subsequent layer.

Slant Angle Left PV The angle to the vertical of the left flank. “Left” refers to the flank with the

smaller x-position.

6= / = If you click on the 6= button it turns into a = button which means that the two

slant angles are always the same, even during e. g. Parametric Optimization

(↪→Sec. 102). Clicking on this button again allows you to set different angles

again.

Slant Angle Right PV The angle to the vertical of the right flank. “Right” refers to the flank with the

larger x-position.

Apply Coating If you click this check box the dialog extends so that you can apply a coating

(consisting of a single material) on the grating.

Coating Material PE O A C .

The material in the coating layer. The controls in this group box are explained

in Sec. 34.3.

Coating Thickness PV O A C .

Allows you to set the thickness of the coating layer on the flanks, the bottom,

and the top of the grating (measured along x- and z-direction, respectively).

37.3.13 Uniaxial Crystal

Uniaxial crystals are anisotropic media which can be described by two different refractive indices.
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Figure 272. Dialog for the specification of a uniaxial crystal.

The edit dialog for this kind of medium (shown in Fig. 272) needs the following parameters:

ITEM DESCRIPTION

Material of Ordinary / Ex-

traordinary Refractive In-

dex

The dispersion relations for the two refractive indices are represented by two

materials. The control for setting a material is described in Sec. 34.3.

37.3.14 Volume Grating Medium

The volume grating medium is designed for analyzing interferograms recorded into a photosensitive Holo-

graphic Material PE . In VirtualLab Fusion the interferograms can be synthesized by the superposition of an

arbitrary number of plane waves. See Sec. 133.3.3 for the implemented formulas.

The angles of incidence and the wavelengths of the superposing plane waves can be freely defined by the user.

It is assumed that only waves of exactly the same wavelength will interfere with each other.
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Figure 273. The edit dialog for a volume grating medium.

The Basic Parameters tab of the edit dialog (↪→Fig. 273) comprises a control for specifying the Holographic

Materialwhich is explained in Sec. 34.3 and two sub-tab pages which are explained in the following subsections.

The remaining controls are explained in Sec. 37.1.

37.3.14.1 Interferogram

The main part of the Interferogram panel is a table showing relative power, direction and wavelength of all

superposing plane waves (Fig. 274). Both the vacuum wavelength and the medium wavelength, which refers

to the Holographic Material, are displayed.

You can specify whether the direction of these waves is defined in Vacuum or in the Holographic Material.

Furthermore, via Representation of Direction you can specify whether the angles are displayed as Cartesian

Angles,Wave Numbers, or Spatial Frequencies.
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Figure 274. The Interferogram tab for a volume grating medium.

The arrows in the table indicate whether the wave comes from positive or negative z-direction.

The Append button adds a new default wave, the Delete button deletes the currently selected plane wave. If

you double click on a plane wave or press Edit, the dialog explained in subsection (a) opens.

The Limit Period specifies the maximum possible period in x- and y-direction, as large periods heavily increase

the numerical effort for the Fourier Modal Method (↪→Sec. 96.3). On the downside, it introduces a quantization

of the specified angles. Mathematical details can be found in Sec. 133.3.3.

(a) Editing the Interfering Plane Waves

Figure 275. The dialog for setting up the interfering plane waves.

The dialog for editing one of the interfering plane waves (↪→Fig. 275) has the following options:



CHAPTER 37. OPTICAL MEDIA 344

ITEM DESCRIPTION

Weight PE Specifies the relative squared amplitude of the wave. See Eq. (133.14) for

details.

Wavelength PE The vacuum wavelength of the plane wave.

Direction PE The direction of the plane wave. You can choose whether you want to enter

Cartesian Angles, Wave Numbers, or Spatial Frequencies. Angles must be

in the range -90° … +90°. An angle out of this range would mean that the

wave comes from the positive half-space and propagates backwards. In this

case you have to switch off Positive z-Direction.

37.3.14.2 Index Modulation

Figure 276. The Index Modulation tab of the volume grating dialog.
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Figure 277. Example structure if direct refractive index modulation is used.

This panel specifies how the local electrical field density w(x, y, z) (↪→Eq. (133.13)) is converted into a change
of the refractive index. The volume grating medium offers three different modes therefor:

(a) Direct

In this case you just specify the desired Refractive Index Modulation PV ∆n and the Relative Refractive Index

Offset R. The refractive index n(x, y, z) at a certain position is then calculated via

n(x, y, z) = nholo +
(

w(x, y, z)
wmax

+
R− 1

2

)
· ∆n (37.1)

wmax can be an arbitrary value, as it cancels out in this case (see Eqs. (133.13)-(133.14)). nholo is the refractive
index of the Holographic Material.

For R = +100% the refractive index modulation is added to nholo, for R = −100% it is subtracted from nholo
and for intermediate values it is something in between. In particular the case R = 0 means that the refractive

indices range from nholo − ∆n
2 to nholo + ∆n

2 .

Figure 278. Example structure if asymptotic dose to refractive index modulation is used with slight over-exposure.
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(b) Simulate Exposition Process

In this case you simulate the real exposition process. This means you can set up the overall Power Density PV

P of all superposing waves, the Exposure Time PV texp and the Material Response.

Then, the overall energy density is calculated as follows:

wmax = P · texp (37.2)

On the left side of the panel you can choose between three equations how the Dose to Refractive Index Mod-

ulation is modeled:

MODEL EQUATION PARAMETERS

Linear n(x, y, z) = nholo + lw(x, y, z) + C l: Linear Factor
C: refractive index offset, see below

Quadratic n(x, y, z) = nholo + lw(x, y, z) + pw(x, y, z)2 + C l: Linear Factor
p: Squared Factor
C: refractive index offset, see below

Asymptotic n(x, y, z) = nholo + ∆n− ∆n
1+(w(x,y,z)/w0)

γ + C ∆n: Refractive Index Modulation
w0: Average Energy Density

γ: Modulation Exponent

C: refractive index offset, see below
↪→Fig. 279

Figure 279. The refractive indices n(w) if asymptotic dose to refractive index modulation is chosen. The blue curve has
the smallest modulation exponent and the red curve the largest.

The Relative Refractive Index Offset R allows you to define whether the refractive index modulation is added to

nholo (for R = +100%), subtracted from nholo (for R = −100%) or something in between. In particular the case

R = 0 means that the refractive indices range from nholo − ∆n
2 to nholo + ∆n

2 where ∆n is the overall refractive

index modulation. This is achieved by adding C = R−1
2 ∆n to the formulas given above.

(c) Photonic Crystals

In this case it is assumed that above a certain energy density wt the original Holographic Material is replaced

by a Second Material. In VirtualLab Fusion you enter the relative Threshold PV , i. e.
wt

wmax
.
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Figure 280. Example structure if refractive index modulation for photonic crystals is used.

38 Materials

38.1 Using Materials

Materials are used for defining Optical Media (↪→Sec. 37). They hold all relevant optical material data, as

described in the following.

38.1.1 Material Data

The complex refractive index n̂ of a material can be expressed as

n̂ = n + iκ , (38.1)

where n is the (real part of the complex) refractive index, and κ the absorption index. Here the absorption index

κ must not be mixed up with the absorption coefficient α which is stored in the Material and that is related to κ

by

α =
4πκ

λ0
= 2k0κ . (38.2)

In Eq. (38.2) λ0 represents the vacuum wavelength and k0 the wave number in vacuum. The absorption coef-

ficient α is introduced in Beer’s law, which is denoted as

I = I0 · e−α∆z , (38.3)

where I is the intensity after a propagation distance ∆z through an absorbing material.
The dependency of the two parameters n and α on the wavelength are stored in each Material and can be given

as sampled data or as one constant value. Additionally, the real refractive index n can be specified by some

parameters that are related to a certain selected dispersion formula.

38.2 Defining and Editing Materials

Materials can be created or edited from the dialog of the Materials Catalog (↪→Sec. 33). Additional the user can

modify a material where it is needed. The edit dialog is described in detail now. Besides the panels Refractive

Index, Absorption, and Additional Information described below, it contains the following controls:



CHAPTER 38. MATERIALS 348

ITEM DESCRIPTION

Usable Vacuum Wave-

length Range

The intersection of the wavelength ranges of the absorption coefficient, the

real refractive index and, if given, the reference material’s real refractive in-

dex.

Opens the view of the current material.

Saves the current material into the material catalog.

Tools > Reset All Data Discards all changes made in this dialog and resets to the previous state of

the material.

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further

information.

If both the real refractive indices and the absorption coefficients are defined via aProgrammable function,

they share the same set of Global Parameters.

38.2.1 Refractive Index Panel

Figure 281. The panel for the input of the real refractive index, dependent from wavelength.

The real refractive index dependency from wavelength is defined in the panel Refractive Index which is shown

in Fig. 281. It has the following controls:
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ITEM DESCRIPTION

Dispersion Formulas After choosing this option, the user can select one of the dispersion formulas

summarized in Sec. 133.4. Then the corresponding formula is shown to the

right. And the lower part of the refractive index panel shows a table where you

can enter the values PV of the parameters, scaled for the wavelength given in

micrometers.

Sampled Dispersion If you check this option, the lower part of the panel shows a table control

(↪→Sec. 5.9) where you can enter measured data, i. e. pairs of wavelengths

and the respective refractive indices. If VirtualLab Fusion needs a refractive

index for a wavelength value which lies between two of the stored ones, a

cubic 6-point interpolation is used for equidistant sampling, while linear inter-

polation is used for non-equidistant sampling.

Constant Choosing this option means that you define a Constant Refractive Index PV

for the whole Valid Wavelength Range.

Relative to Reference Ma-

terial

If checked, the real part of the refractive index is defined relatively to a refer-

ence material, i. e. as relation of the phase velocities

nrel
Material

= nabs
Material

/nabs
Reference

= c
Reference

/c
Material

.

It can be changed after pressing the Set button. Only materials with abso-

lutely defined refractive indices can serve for reference.

If this option is not set, the real part of the refractive index is considered to be

defined absolutely, i. e. as relation of the phase velocities

nabs
Material

= c
Vacuum

/c
Material

.

Wavelength Range The minimum and maximum wavelength for which the refractive index data

are valid. In case of Sampled Dispersion these values are determined auto-

matically from the sampled data.

38.2.2 Absorption Panel

If the absorption properties of a material are unknown, you can try to use it anyhow by setting the

absorption coefficient to α = 0 = constant.

The absorption coefficient dependency from wavelength is defined in the panel Absorption which is shown in

Fig. 282.
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Figure 282. The panel for the input of the absorption coefficient in Sampled mode.

There are three different quantities describing the absorption which can be entered in three different modes:

Mode Absorption Coefficient Internal Transmittance Absorption Index

Sampled 4 4 4

Constant 4 4 8

Programmable 4 8 8

The three quantities Absorption Coefficient, Absorption Index and Internal Transmittance are defined as α, κ

and I/I0 in the equations 38.1 to 38.3 respectively. The latter requires to enter some additional reference

Thickness.

The three modes for entering are the following:
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ITEM DESCRIPTION

Sampled Absorption If you check this option, the lower part of the panel shows a table control where

you can enter pairs of wavelengths and the respective absorption quantity.

For details see Sec. 5.9. If VirtualLab Fusion needs an absorption coefficient

for a wavelength value which lies between two of the stored ones, a cubic

6-point interpolation is used for equidistant sampling, while linear interpolation

is used for non-equidistant sampling.

Constant Choosing this option means to define a single Constant Absorption Co-

efficient PV or a Constant Internal Transmittance for the whole Wavelength

Range.

Programmable The Definition group box allows to program an arbitrary formula for the ab-

sorption coefficient α(λ) with a code snippet. Edit opens the Source Code

Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator (↪→Sec. 5.10)

shows whether this snippet is consistent. The Parameters PE group box is

explained in Sec. 7.4.

The following control is visible independently from these three modes:

ITEM DESCRIPTION

Wavelength Range The minimum and maximum wavelength for which the absorption coefficient

data are valid. In case of Sampled Absorption these values are determined

automatically from the sampled data.

38.2.3 Additional Information

In this panel the State of Matter for the material can be set.

Figure 283. The panel for the additional information.

ITEM DESCRIPTION

State of Matter The state of matter of this material can be Solid, Liquid, or Gas or Vacuum.

Origin of the Data The data source can be entered here (if unlocked ).

/ This button toggles the locked state of the textbox for Origin of the Data. The

box is locked by default.
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38.2.4 Temperature Data

Figure 284. The panel to specify the temperature data.

The parameters which determine the temperature dependence of the real part of the refractive index can be

defined here.

ITEM DESCRIPTION

Reference Temperature This is the temperature T0 (in °C) the refractive index measurement has been

done at.

D0 [1/K] The parameter D0 as used in Eq. (38.4).

D1 [1/K2] The parameter D1 as used in Eq. (38.4).

D2 [1/K3] The parameter D2 as used in Eq. (38.4).

E0 [1/K] The parameter E0 as used in Eq. (38.4).

E1 [1/K2] The parameter E1 as used in Eq. (38.4).

λλλ_TK The parameter λTK as used in Eq. (38.4).

The change of the real part of the refractive index which is caused by its temperature dependence is calculated

by

∆n(λ, T) =
n2(λ, T)− 1
2 · n(λ, T0)

·
(

D0 · ∆T + D1 · ∆T2 + D2 · ∆T3 +
E0 · ∆T + E1 · ∆T2

λ2 − λ2
TK

)
. (38.4)

The value n is the real valued refractive index of the material as measured at the reference temperature T0. If

the calculation shall be done for a temperature T and for a vacuum wavelength λ, the temperature difference

∆T = T − T0 has to be put into the equation. The refractive index as modified by the different temperature is

n(λ, T) = n(λ, T0) + ∆n(λ, T). (38.5)

All these relations can be found in [SCH08].

38.3 Material View

The material view consists of three pages, Diagram, Additional Information, and Calculator. Besides the name

of the material and the categories it belongs to, the dialog always shows the wavelength range the material’s

data are defined for:

ITEM DESCRIPTION

Min. Wavelength The minimum vacuum wavelength which the real refractive index as well as

the absorption data are known for.

Max. Wavelength The maximum vacuum wavelength which the real refractive index as well as

the absorption data are known for.
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38.3.1 Diagram

Figure 285. The Diagram tab of the Material View.

The Diagram tab shows the wavelength dependency of the real refractive index n and/or the dependency of

the absorption coefficient α or the absorption index κ. The diagram view can be configured via a configuration

dialog (↪→Sec. 38.3.1.1) which is called by the button Configure Diagram.

If Shift is pressed while the mouse is moved over the diagram, the values of the displayed curve(s) at the

cursor position are shown near the mouse cursor.

38.3.1.1 Configuring the Material Diagram

The dialog shown in Fig. 286 is used to configure the diagram of the wavelength dependent material data.

Figure 286. The Edit dialog for configuring the material’s diagram.

It contains the following controls:
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ITEM DESCRIPTION

Show Energy Depen-

dence Instead of Wave-

length Dependence

If chosen, the diagram will show the dependence of the optical data from the

photon energy E which is related to the vacuumwavelength λvac via E = h c
λvac

with h being Planck’s constant and c being the vacuum speed of light.

Show Refractive Index Shall the refractive indices be drawn in the diagram?

Relative T .

Show the real refractive index relative to the reference material.

Absolute T .

Show the absolute real refractive index.

Show Absorption Shall absorption data be drawn in the diagram?

Coefficient α If chosen, the wavelength dependency of the absorption coefficient is drawn

in the diagram.

Index κ If chosen, the wavelength dependency of the absorption index is drawn in the

diagram.

Use Intersection of Valid

Wavelength Ranges

If true, only the wavelength range that can be used during the simulation in

VirtualLab Fusion is displayed. Otherwise the conjunction of the wavelength

ranges of n and α/κ is displayed.

Line Color Sets the color of the drawn line.

Show Symbols for Data

Points

T

.

Shall symbols, marking the actual data points, be shown additionally to the

line?

Significant Digits Number of digits used for the axis labels.

Axes are Colored Like

Graphs

If checked, the diagram’s y-axes are colored like the corresponding curve.

Line Thickness The thickness the curves will be drawn with.

38.3.2 Additional Information

Figure 287. The Additional Information of the Material View.
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The Additional Information tab gives some important parameters of the material:

ITEM DESCRIPTION

State of Matter The state of matter of the material. This is important for the usage with optical

coatings (↪→Sec. 36).

Definition Range for Re-

fractive Index

The vacuum wavelength range for which the real refractive index n is known.

Definition Range for Ab-

sorption

The vacuum wavelength range for which the absorption coefficient α and the

absorption index κ are known.

Reference Material The name of the reference material, if the real part of the refractive index is

defined relatively.

Abbe Number The Abbe number νd and the Abbe number νe for a temperature of 20°C and

an air pressure of 101325Pa.

Origin of the Data The source of the material’s data.

38.3.3 Calculator

The calculator can be used in order to get refractive index and absorption information for a given vacuum

wavelength and at a given temperature.

Figure 288. The Calculator of the Material View.

The input and output parameters of the calculator are the following:



CHAPTER 39. OPTICAL STACKS 356

ITEM DESCRIPTION

Test Wavelength Wavelength to calculate n, α, κ and theRelative Transmittance of this material

for.

Test Temperature Temperature to calculate n of this material for.

Test Air Pressure T E

.

The air pressure to calculate n of this material for.

n Calculated refractive index of the material.

Absolute T .

If checked, the absolute real refractive index is calculated, otherwise the re-

fractive index relative to the material’s reference material will be given.

α Calculated absorption coefficient of the material.

κ Calculated absorption index of the material.

Thickness Thickness of the material to calculate the Relative Transmittance for.

Relative Transmittance for

a Thickness of …

Calculated relative transmittance of the material for the given Thickness.

38.4 Material Data Sources

A large variety of different materials are delivered with VirtualLab Fusion. This includes a number of glass types

as well as some other substances often used in optics. All materials can be found in the Materials Catalog.

The data for the refractive indices and absorption coefficients used in the Material Documents that are provided

by VirtualLab Fusion are taken from several publications.

WARNING: There may be errors in the data, e. g. due to measurement, publishing, or transcription.

So please verify these data, especially if you are considering to fabricate the optics designed with

VirtualLab Fusion.

The information for the glass catalogs CDGM_…, Corning, Dow_…, Heraeus, Hikari_…, Hoya_…, LZOS_…,

Ohara_…, Schott_…and Sumita_…were given by the manufacturers. The sources of the other catalogs are

listed in Sec. A.4.5.

39 Optical Stacks

On the boundaries of a solid (called base block), stacks of micro-structured surfaces and media can be applied.

Stacks are assumed to be periodically and they are orientated “outwards”, i. e. the solid is always at z = 0 and
the embedding medium starts at z = d, where d is the z-extension of the stack.
A stack can consist of an arbitrary number of so-called “stack segments”. Each segment consists of an optical

surface and a subsequent medium.

39.1 Usage Principle of Optical Stacks

Using a new optical stack needs two independent steps. At first, a new stack has to be built. Secondly, the stack

is attached to a plane optical surface which serves as boundary of a solid base block. These two steps don’t

have to be done separately in each case of use, e. g. it is possible to edit a stack already attached to an optical

surface. But in principle, the stack definition is independent from its application to a base block boundary, so

there exists a catalog of stacks, storing defined stacks that can be (re-)used any time.
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39.1.1 Defining an Optical Stack

Any stack consists of an alternating sequence of a number of indexed optical surfaces and optical media. These

are positioned on one single axis. This is identical to the z-axis of the stack’s own coordinate system. So the

positions of the single optical surfaces are determined by a distance value, measured on the stack’s z-axis. The

origin of the stack coordinate system is the point (0; 0) of the first surface, so this one has always a z-position
of zero. This convention is shown in Fig. 289.

Figure 289. Positioning of optical surfaces inside an optical stack.

39.1.2 Application of an Optical Stack

If a defined optical stack has to be attached to the boundary surface of a base block, the following considerations

are important.

A stack is attached to a base block in a way, that the first optical surface of the stack touches the block without

entering it. The medium of the base block fills possible gaps between the base block boundary and the first

stack surface. Furthermore, stacks are always orientated “outwards”. Fig. 290 shows these relationships.
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Figure 290. Positioning of an optical stack relative to the base block’s boundary.

1) Stack on the back side of a base block.

2) Stack on the front side of a base block.

For each side of the base block (front side and back side) there are two possible orientations for the stack. It

can be rotated by 180° about the z-axis or be used unrotated, respectively. These two orientations are shown

in Fig. 291 and Fig. 292.
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Figure 291. Orientation of an optical stack on the front side of a base block.

1) Unrotated.

2) Rotated about z-axis by 180°.

Figure 292. Orientation of an optical stack on the back side of a base block.

1) Unrotated.

2) Rotated about z-axis by 180°.
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39.2 Edit Dialog for Stacks

Figure 293. The edit dialog for stacks. Note that the base block is only shown in the upper part if Use Component Coordi-

nate System for Stack Preview is checked in the Global Options dialog (↪→Sec. 6.2). The Validity control shows a warning
because the period of the surface with Index 1 has actually a period of infinity in y-direction.

The edit dialog for stacks (↪→Fig. 293) comprises three parts: The upper part shows an intersection of the

surface media sequence of the stack (↪→Sec. 5.14). The middle part is a table listing the stack segments. The

topmost entry is closest to the solid, the bottommost entry is closest to the embedding medium. This table has

the following columns:

COLUMN DESCRIPTION

Index The index of the segment.

z-Distance PV Allows to enter the distance of the surface to the previous surface. It is mea-

sured in positive z-direction.

z-Position Display of the absolute z-position of the surface in the stack.

Surface PE Edit control for the surface in the segment (↪→Sec. 34.1).

Subsequent Medium PE Edit control for the medium in the segment (↪→Sec. 34.1).

Comment One can enter a descriptive comment for each segment.

The Index and the z-Position column are always read-only. Also, the z-Distance of the first segment and the

Subsequent Medium of the last segment are fixed.

The lower part of the edit dialog contains the following controls:
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ITEM DESCRIPTION

Validity This control (↪→Sec. 5.10) indicates whether the currently defined stack is

valid, i. e. whether it contains a least one surface and whether it has an ex-

tension greater zero.

Add Adds a new stack segment to the end of the table. The surface catalog is

opened automatically to define the surface of the segment.

Insert Inserts a new stack segment before the currently selected table row, indicated

by a triangle in the first column. The surface catalog is opened automatically

to define the surface of the segment.

Delete Deletes all currently selected table rows.

Period Defines the stack period.

The stack period can be either taken from a certain surface or medium within

the stack. If this reference is not periodical or has a period of infinity in one

direction, a period of 100 pm is assumed instead and a warning is shown in

the validity control. This way the calculation of an infinite number of orders is

avoided.

If the stack period is Independent from Surface/Media Period, the user can

set the Stack Period PV by oneself.

(View) Displays a preview of the stack.

(Save To Catalog) Saves the stack to the user-defined stack catalog.

Stack Tools Several tools are available to modify the stack in a user-friendly way. More

information can be found in Sec. 39.3.

When the stack is used from within a Light Guide (↪→Sec. 57.2), the edit dialog has an extra tab page Additional

Parameters. There you can define parameters you might need if you want to use you own custom Fourier

Modal Method (↪→Sec. 96.4), using the control described in Sec. 7.3.2.

39.3 Stack Tools

There are stack tools implemented in VirtualLab Fusion to give the user a comfortable way for configuring a

stack.

39.3.1 Insert Coating Tool

The Insert Coating Tool can be used to insert a coating (loaded from the Coating Catalog) on a user-specified

position. The coating is translated into a surface sequence. This surface sequence is inserted into the stack.

Note: The set up process data is ignored for the insert algorithm into the stack. Only the coating layers are

converted.

Figure 294. The edit dialog for configuring the Insert Coating Tool
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This tool can be found at Tools > Insert Coating. Fig. 294 shows its edit dialog which has the following settings:

ITEM DESCRIPTION

Insert Coating Behind

Stack Surface No.

Defines the index of the surface within the stack on which the coating shall

be set. Only visible if the stack contains at least one surface.

Coating To Insert The user can specify a coating which shall be translated into the stack.

Reverse Layer Sequence If this option is checked, the coating is inserted in the “wrong” order, i. e. the

last coating layer is inserted directly after the specified surface.

39.3.2 Insert Stack Tool

The Insert Stack Tool can be used to insert a stack (loaded from the Stack Catalog) on a user-specified position.

Figure 295. The edit dialog for configuring the Insert Stack Tool

This tool can be found at Tools > Insert Stack. Fig. 295 shows its edit dialog which has the following settings:

ITEM DESCRIPTION

Insert Stack Behind Stack

Surface No.

Defines the index of the surface within the stack after which the stack shall

be set. Only visible if the stack contains at least one surface.

Stack To Insert The user can select a stack from the catalog, which shall be added.

39.3.3 Reduce Definition Area to Stack Periods

Via the stack period you define the region of each surface (and medium) which is evaluated. However, if the

definition area (↪→Sec. 35.1.1) of a surface is much larger than the stack period, the z-extension of the surface

might be larger than expected leading to a seemingly too thick stack (↪→Fig. 296).

Thus the Reduce Definition Area to Stack Periods tool allows you to limit the definition area of all surfaces to

the stack period, whereas the following rules apply:

• For grating surfaces the inner definition area, and the outer definition area are adapted. Setting the period

would change the structure definition.

• For all other periodical surfaces the inner definition area, the period, and the outer definition area are

adapted.

• The definition areas are set to a rectangular shape.

• If the definition area (or period) of the surface was set by the user to a value smaller than the stack period,

it is kept unchanged. This check is done separately for x- and y-dimension.

• For stacks of 1D-periodic grating surfaces the definition area (or period) in y-direction is set to 10% of the

stack period. In this way a nice-looking stack preview is ensured.
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Figure 296. Left: A conical surface in a 2D stack having a definition area twice the size of the stack period. The max-

imum z-extension is reached outside of the stack period. Right: The same surface after the Reduce Definition Area to

Stack Periods tool has been applied.

39.3.4 Change External Name

When stacks are used within other controls (↪→Sec. 34.1), their (external) name is shown to easier identify them.

With this tool you can simply change this name, e. g. if you have changed the sinusoidal grating surface within

a stack to a triangular one.

40 Surface Layouts

On the surfaces of a solid, VirtualLab Fusion offers the possibility to specify surface layouts, which consist of

several regions on an Optical Surface (↪→Sec. 35) behaving differently than just a plain surface. Each type of

surface layout usually provides its own algorithm to propagate light through it, a so-called boundary operator.

A boundary operator can change the position, the direction and the complex value of the incident wave and

even generate new modes (e. g. multiple grating orders).

40.1 Cells Arrays

A Cells Array boundary operator consists of a set of cells. All cells have the same size. Every cell has a specific

optical function defined by a small set of parameters.

Two types of cells arrays are available:

1. Grating Cells Array ↪→Sec. 40.1.1

2. Prism Cells Array ↪→Sec. 40.1.2

Sec. 40.1.3 explains how a cells arrays can be configured.

40.1.1 Grating Cells Array

The Grating Cells Array (GCA) boundary operator consists of a set of grating cells arranged in an equidistant

grid. In every cell a grating function can be specified by the following parameters:

• Period

• Rotation Angle

• Lateral Shift

The boundary operator uses the local grating parameters to change the parameters of the incident wave. The

rotation angle and the period directly influence the direction of the incident wave. The lateral shift defines an

additional phase shift which shall be applied to the specific grating cell.

The way how the grating parameters of the individual cells can be configured is described in Sec. 40.1.3.

40.1.2 Prism Cells Array

The Prism Cells Array (PCA) consists of cells arranged in an equidistant grid. In each cell there is a slanted

plane surface defined by the following three parameters:
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PARAMETER DESCRIPTION

Tilt Angle The spherical angle θ (↪→Sec. 139.2.1) describing the tilt of the plane surface.

Rotation Angle The spherical angle φ (↪→Sec. 139.2.1) describing the rotation of the plane

surface in the x-y-plane.

Offset Height The height of the plane surface at the center of the cell (relative to the surface

the boundary operator is placed on). Introduces an additional phase shift.

If a Prism Cells Array is used in reflection it is referred to as Mirror Cells Array (MCA).

The way how the surface parameters of the individual cells can be configured is described in Sec. 40.1.3.

40.1.3 Configuring a Cells Array

Fig. 297 shows the edit dialog of the Prism Cells Array with the controls that all types of Cells Arrays have in

common.

Figure 297. The edit dialog of the Prism Cells Array boundary operator

The dialog enables the user to configure

ITEM DESCRIPTION

Number of Grating / Prism

Cells

The number of cells within the Cells Array can be specified. After changing

the number of cells within the boundary operator a Refresh button appears

and has to be clicked to trigger the resizing of the cell array.

Cell Size The user can specify the size of the cells in x- and y-dimension. All cells have

the same size.

In the middle part of the dialog the cells parameters of the boundary operator can be changed. The following

possibilities can be used to specify the cells parameters:
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ITEM DESCRIPTION

Set The set button can be used to set an open data array, which contains the

cells parameters in different subsets. This option can be very helpful to use

an already designed Cells Array function within a new boundary operator.

Get By clicking theGet button, the cells parameters of the CellsArray operator are

extracted into a data array. The extracted data array is displayed within the

VirtualLab Fusion main window and can be used for post processing steps

(like usage in another boundary operator, or graphical evaluation of the pa-

rameter distribution).

{Table} Additionally VirtualLab Fusion offers to directly edit the cells parameters within

the table at the bottom of the edit dialog.

If the mouse hovers over the Statistics icon a tooltip is shown which gives the minimum and maximum of

each parameter in the cells array and the corresponding locations. For grating cells also the minimum and

maximum period in x- and y-direction is given for reference.

By pressing the Table Tools button the user can select Vary Grating Cells /Vary Prism Cells. Fig. 298 shows

the dialog to configure this tool. The button allows you to export the cells data (↪→Sec. 126).

Figure 298. The dialog for the Vary Grating Cells table tool. The dialog for the Vary Prism Cells tool is the same but uses

different cells parameters.

The Vary Grating Parameters / Vary Prism Cells tool can be used to vary the parameters within the Cells Array

systematically. The user can specify whether he likes to set a parameter to a special value or whether he likes

to make a random distribution of a parameter in a user-defined value range. The user can edit the following

options for each available cells parameter:
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ITEM DESCRIPTION

Set The column Set can be used to select the parameters which shall be speci-

fied / varied. After selecting the Set option within the table the Value and the

Vary column will be enabled.

Value In this column the user can specify the value of the parameter which shall be

set. This column is only enabled if the Set option is selected.

Vary The option Vary can be used if the parameter shall be varied in a specific user

range. The variation will be randomly. The Vary option is only available if the

Set option is selected.

Minimum Defines the minimum of the value range if the parameter shall be varied. This

option is only available if the Vary option is set.

Maximum Defines the maximum of the value range if the parameter shall be varied. This

option is only available if the Vary option is set.

40.1.3.1 Order Configuration

TheOrder Configuration tab page allows the user to specify which orders of the grating cells shall be considered

during the simulation of the Grating Cells Arrays.

Fig. 299 shows the page to set up the order configuration for the simulation.

Figure 299. The orders to consider during the simulation can be specified within the Grating Cells Array edit dialog on the

Order Configuration tab page.

The design of a Grating Cells Array only uses the first order to generate the target pattern. The other

orders are not considered in the design but in the analysis of the system.

The user can specify the following parameters on the Order Configuration tab page:



CHAPTER 40. SURFACE LAYOUTS 367

ITEM DESCRIPTION

Minimum The user can specify the Minimum order to be considered during the simula-

tion of the Grating Cells Array.

Maximum The user can specify the Maximum order to be considered during the simu-

lation of the Grating Cells Array.

Method to evaluate

Rayleigh Coefficients

It is possible to specify different complex weights for the orders to consider.

VirtualLab Fusion offers three different ways to specify the order weighting.

The following possibilities are available: Constant Weight (↪→Sec. (a)), Sim-

ple Lookup Table for Coefficients (↪→Sec. (b)) or Rigorous Lookup Table for

Coefficients (↪→Sec. (c))

(a) Constant Coefficient

The user can select the Constant Coefficient method to evaluate the weights for each order. The weights of

all specified orders within the simulation are set to 1. This could be used for a first approximation of the GCA

function.

(b) Simple Lookup Table for Coefficients

The Simple Lookup Table for Coefficients option allows the user to configure the real valued weight for each

order. Fig. 300 shows the table to configure the amplitude weights for each order.

Figure 300. The Simple Lookup Table for Coefficients option enables the user to specify the amplitude weight for each

order

The table contains two columns. The following settings can be viewed / edited:

ITEM DESCRIPTION

Order This column shows the order for which the weight can be specified. It is not

editable. The orders to consider within the simulation are specified above

within the dialog.

Amplitude Weight PV In the Amplitude Weight column the user can enter the real valued amplitude

weight for the specific order.

Note: Changing the numbers of Orders To Consider will reset the table – all weights will be set to 1.

(c) Rigorous Lookup Table for Coefficients
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The evaluation of the efficiencies / Rayleigh coefficients requires VirtualLab Fusion Advanced which might not

be available on the computer where the cells array simulation is done. Therefor the user needs to trigger

the Local Linear Grating Approximation Analyzer (↪→Sec. 90) within the Light Shaping Optical Setup. This

analyzer uses the current configuration of the GCA boundary operator to generate a LLGA Results Generator

(↪→Sec. 45). This generator can then be used to calculate efficiencies / Rayleigh coefficients rigorously for each

wavelength, period, rotation angle, and incident direction occurring in your Light ShapingOptical Setup, possibly

on another computer. Finally the generator with the calculated results can be set into the Order Configuration

tab (↪→Fig. 301).

Figure 301. The Rigorous Lookup Table for Coefficients option enables the usage of rigorously calculated Rayleigh coeffi-

cients.

The user can modify the Rigorous Lookup Table for Coefficients by the following options:

ITEM DESCRIPTION

Set By clicking on the Set button an open LLGA Results Generator document can

be selected and set as the rigorous lookup table for the simulation.

Load The Load button can be used to load an XML file which is a possible output of

the LLGA Results Generator. The XML file contains all necessary information

for the lookup table.

Save The user can save the lookup table information to an XML file by clicking on

the Save button. This option is helpful to extract the lookup table information

for some post processing steps.

{Lookup Table Informa-

tion}

In the bottom part of the dialog some information about the lookup table is

shown. The user can see

• the number of wavelengths which are represented within the lookup

table

• the total number of results where at least one Rayleigh coefficient of

one order has been calculated.

• the minimum and maximum order of the specified lookup table

• the information whether the lookup table is valid for transmission or for

reflection

After specifying the Rigorous Lookup Table for Coefficients the simulation uses the lookup table data for the

evaluation of the considered orders. If no valid lookup table entry is found for a specific parameter set, the

simulation stops with an error message.
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40.2 Arbitrary Surface Layouts

Light guide components (↪→Sec. 57.2) can have surface layouts consisting of an arbitrary number of regions of

arbitrary shape filled with an idealized or real grating.1

Figure 302. The edit dialog for surface layouts.

These surface layouts can be edited with the dialog shown in Fig. 302, which contains the following controls:

1 In a General Optical Setup only three surface regions per surface layout are allowed.
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ITEM DESCRIPTION

{Layout Overview} A specially configured 3D view (↪→Sec. 17.1) which gives an overview of all

regions in the surface layout. The region currently selected in the table is

marked red.

{Overview Table} Table that provides an overview of all regions in the layout, including the

unique index (column #), Name of Region, Region Type, and Period.

Edit Allows to edit the currently selected surface region using the dialog described

in Sec. 42.1.

Add Adds a new surface region to the layout. The new region has to be defined

via the dialog described in Sec. 42.1 first.

Remove Removes the currently selected region from the layout. Shortcut: Del

Duplicate Duplicates the currently selected region.

Gridded Segmentation A .

This button opens a dialog which allows to segment the currently selected

region into several new regions by defining a segmentation grid. The dialog

is described in Sec. 40.2.1.

Edit Vertex Couplings A -

.

The coupling of vertices of two or more polygons can be edited using the

dialog described in Sec. 40.2.2.

Apply Absorption Outside

of Region on Surface

If checked, the parts of the surface which are not covered by grating regions

will absorb the light. If unchecked, the non-grating surface parts will trans-

mit and reflect the light depending on the optical properties of the involved

materials.
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40.2.1 Gridded Segmentation of Regions

Figure 303. Dialog for doing a gridded region segmentation.

Rectangular or polygonal grating regions may be decomposed into smaller regions by applying an equidistant

grid of n x m tiles to the original region, using the dialog shown in Fig. 303. The result will be n x m new

segments of the type ’simple polygon region’. The following parameters define the segmentation:
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ITEM DESCRIPTION

Number of Tiles The axis aligned bounding box of the original region will be segmented into n
x m tiles. These numbers of the x- and y-segments can be defined here.

Prefix for the Segment

Names

A prefix for the automatically generated names of the new regions can be

given here. The names of the new segments will be ”{prefix} #{index}”.

Segmentation Angle The segmentation doesn’t have to be axis aligned. A rotation angle which de-

termines the direction of horizontal and vertical segmentation can be defined

here instead.

Align With Sides O .

Since a rectangular region may be rotated itself, pushing this button will pre-

select the rotation angle of the segmentation in a way which results in a side

alignment. So the resulting rectangles after the segmentation will have the

same orientation as the original rectangle.

Preview This view shows the result of the segmentation process using the currently

set parameters. The new region indices are given within the view as well.

Smallest Region Index Since all region indices inside the edited surface layout (including the new

regions after segmentation) has to be unique, the new indices will never start

with #1. The smallest new region index is given here instead.

40.2.1.1 Segmentation of Regions with a Real Grating Structure

If a region is to be decomposed which contains a real grating structure, the parameters of the gratings of the new

segments may vary. That’s why there will be a Next > button at the bottom of the dialog which allows to select

grating parameters for variation after the tiles have been specified. After selecting the variation parameters,

the parameter values can be set for each of the new segments on the last page of the dialog.

40.2.2 Changing Polygon Vertex Couplings

The vertices of adjacent simple polygon regions may be coupled if they share the same coordinates. ’Coupling’

means that a change in the coordinates of the vertex in one polygon will change the coordinates of the coupled

vertex in the other polygon as well. This is shown in Fig. 304.

Figure 304. The principle of vertex coupling. The left picture shows the polygons before editing the coordinates of the

vertex in the red circle. The right picture shows how editing its coordinates change the shape of the left as well as that of

the right polygon at once.

Whenever the editing of the vertex of one polygon results in identical coordinates to that of another polygon,

the user will be asked whether to activate coupling.

If a coupling is not needed anymore, it can be changed by the dialog shown in Fig. 305.
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Figure 305. Dialog for decoupling one or more vertices from each other.

ITEM DESCRIPTION

Coupling # The index of the coupling that shall be edited.

Coordinates (x, y) The coordinates of the coupling to be currently edited.

Region The region the vertex in the column Vertex Name belongs to.

Vertex Name The name of the selected vertex.

Decouple Vertex When pressed, the selected vertex will be removed from the current coupling.

If there are no more than two vertices then the coupling will be completely

dissolved.

Dissolve Coupling When pressed, the current coupling will be completely dissolved, no matter

how many vertices are coupled at this coordinates.

41 Boundary Responses

A Boundary Response is described by a complex-valued function B = f (x, y, λ, n(λ)) which is applied to an
incoming field.

E out
xy (x, y) = BE in

xy(x, y) (41.1)

(x; y) is the lateral position, λ is the wavelength of the incoming field and n(λ) is the complex refractive index
of the homogeneous medium associated with the boundary response.
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41.1 Edit Dialog for Boundary Responses

Figure 306. The edit dialog for Boundary responses showing the Basic Parameters if Single Function with Aperture is

selected.

The edit dialogs for all boundary responses (↪→Fig. 306) have the following controls in common:

ITEM DESCRIPTION

Associated Medium The homogeneous medium associated with the boundary response. This is

from which refractive indices are being calculated if required by the function

B.

Parameters This box contains two tab pages. The Basic Parameters allows you to select

one out of three Construction Methods. Depending on the selected Construc-

tion Method this tab page changes, which is explained below in more detail.

The Physical Parameters tab is specific for the distinct types of boundary re-

sponses (↪→Sec. 41.3).

View Shows the boundary response view. ↪→Sec. 41.2

Save Saves the boundary response to the catalog. Not available if the boundary

response is edited from within the catalog.

The following Construction Methods are available:
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CONSTRUCTION

METHOD

DESCRIPTION

Single Function without

Aperture

N A Z F / S A

.

There are no specific controls for this construction method.

Single Function with

Aperture

The aperture is applied by multiplying the actual function value f by 1 inside
and by 0 outside the specified aperture. The edge of the aperture can be

defined smooth, then the values don’t “jump” from 1 to 0 but follow a Gaussian

function (decreasing to a value of 0.01) as shown in Fig. 307.

The controls to setup the aperture are explained in a separate table below.

In case of an Aperture boundary response, this option is named just Single

Function.

Periodic Function N Z F / S A -

.

In this case you can set the Period PV of the function.

Figure 307. Definition of the edge width of an aperture.

The following controls (↪→Fig. 306) are specific for the Single Function with Aperture construction method:

ITEM DESCRIPTION

Automatic Setting If checked, a reasonable size of the aperture for the boundary response is de-

termined automatically. This option is available for some boundary responses

only, e. g. exponentially decreasing ones.

Manual Setting If checked, the aperture size is to be entered by the user.

Shape The aperture may be Rectangularly or Elliptically shaped.

Diameter PV Size of the aperture.

Relative Edge Width The width of the aperture edge, defined relatively to the (smaller of the both

values of) diameter.

Absolute Edge Width The width of the aperture edge, defined in physical units. See Fig. 307.
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For an Aperture boundary response, a separate aperture cannot be set on the Basic Parameters tab. For a

Zernike Fringe / Seidel Aberrations boundary response, only circular apertures are allowed.

Figure 308. Tab page for setting the Basic Parameters of a boundary response with the construction method Periodic

Function

The following controls (↪→Fig. 308) are specific for the Single Function with Aperture construction method:

ITEM DESCRIPTION

Period PV If Periodic Function was chosen as Construction Method, here the length of

the period for the replication is set. The first value is used for replication in

x-direction, the second one for the y-direction.

Specific for grating boundary responses: For gratings, the Period will be

determined automatically from the Grating Period and the Rotation Angle,

both to be specified at the Physical Parameters panel.

41.2 Boundary Response View

Figure 309. The preview dialog for boundary responses

The view for boundary responses (↪→Fig. 309) shows the complex values of the function B within the specified

View Range. A data array view (↪→Sec. 13.5) is used to this end. In particular, the view has the same context

menu which allows you to change the shown field quantity (↪→Sec. 11.1) to e. g. imaginary part, change the

aspect ratio (↪→Sec. 11.5) or the color table (↪→Sec. 11.2.4).
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The following controls can be used to configure the data array view:

ITEM DESCRIPTION

View Range The extension of the shown region, which is centered around the position

(0m; 0m).

Show Complete Aperture If this option is checked, the View Range is set to the aperture size of the

boundary response. Obviously, this option is only enabled if the boundary

response uses the construction method Single Function with Aperture.

Wavelength If the boundary response depends on the wavelength, you can set the wave-

length used to calculate the preview here. If the boundary response does not

depend on the wavelength, an information label is shown instead.

Accuracy Factor The preview shows (A · 200; A · 200) sampling points, where A is the Accu-

racy Factor.

If pressed, the real part of the complex boundary response is shown in the

preview.

If pressed, the imaginary part of the complex boundary response is shown in

the preview.

If pressed, the amplitude of the complex boundary response is shown in the

preview.

If pressed, the phase of the complex boundary response is shown in the pre-

view.

If pressed, the squared amplitude of the complex boundary response is

shown in the preview.

Shows the diagram as separate data array document (↪→Sec. 13.5) which can

be saved for later use.

41.3 Types of Boundary Responses

41.3.1 Aperture

This boundary response allows to apply a rectangular or elliptical aperture on the incoming field. An aperture

function has the value 1 inside and 0 outside the defined Diameter. The edge of the “hole” can be defined

smooth, then the values don’t “jump” from 1 (inside the aperture) to 0 (outside the aperture). Instead they

follow a Gaussian function (starting at 1 and cut off at a value of 0.01) as shown in Fig. 310.
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Figure 310. Definition of the edge width of an aperture. The aperture is at the left part of the graph.

The panel to enter the parameters for the boundary response is shown in Fig. 311.

Figure 311. Physical Parameters for the Aperture boundary response.

The parameters are:

ITEM DESCRIPTION

Shape Possible options for the aperture shape are Rectangular and Elliptical.

Diameter PV Determines the diameter of the aperture in x- and y-direction.

Relative Edge Width The width of the aperture edge, defined relatively to the (smaller of the both

values of) Diameter.

Absolute Edge Width The width of the aperture edge, defined in physical units. ↪→Fig. 310.

The controls that all boundary responses have in common are described in Sec. 41.1.
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41.3.2 Grating Boundary Responses

Figure 312. Example for the Physical Parameters tab of a grating boundary response (here Sinusoidal Grating which has

no specific parameters).

There are four boundary responses which represent a periodic grating invariant in y-direction: Rectangular Grat-

ing (↪→Sec. 41.3.2.1), Sawtooth Grating (↪→Sec. 41.3.2.2), Sinusoidal Grating (↪→Sec. 41.3.2.3), and Triangular

Grating (↪→Sec. 41.3.2.4). Their Physical Parameters tab (↪→Fig. 312) always has the following parameters.

ITEM DESCRIPTION

ModulateAmplitude

/ Phase

Shall the amplitude or the phase be modulated?

Period PV The period P of the modulation.

Modulation Depth PV Range of the modulation D. Please see also ’Note on Phase quantization’ below.

Lateral Shift PV A shift of the zero point of the modulation ∆x in the direction of Rotation Angle.

Rotation Angle PV The direction of the modulation will be rotated by this angle θ about the z-axis.

Achromatic / Chro-

matic

In the case of phase modulation the user can choose here whether the transmis-

sion shall work in the same way for all wavelengths (Achromatic) or if the defined

Modulation Depth D0 shall be considered as defined for one reference wavelength

λ0 (Chromatic), so the modulation depth D applied with a field of wavelength λ is

calculated by D = D0λ0/λ.

Wavelength Reference wavelength λ0 for the modulation depth in Chromatic mode.

Quantize Amplitude

/ Phase

N .

If checked, the amplitude / phase is modulated discrete. Note that quantization is

done in the following way: If N is the number of Amplitude / Phase Levels and ∆h is
the step height, then the quantization levels will be 0, ∆h, . . . , (N − 1) · ∆h. Please
see also ’Note on Phase quantization’ below.

Amplitude / Phase

Levels

N .

The number of discrete height steps (if Quantize Amplitude / Phase is checked).
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Note on Phase quantization

In most cases, a quantized phase modulated grating would have a modulation depth equal to 2π, i. e.

the lowest level (= −π) and the highest level (= +π) would be the same. In order to preserve the

number of phase levels, the following phase levels φk are used:

φk =
dm
2
− k

dm
n

with k = 0, . . . , n− 1. (41.2)

where dm means the given modulation depth and n the number of phase levels. Therefore the total

phase modulation depth is just dtotalm = φ0 − φn−1 = dm · n−1
n , which corresponds to the total modulation

depth in a Structure Design (↪→Sec. 98). For your information, the total modulation range is given to the

right of the Modulation Depth in the dialog.

The controls that all boundary responses have in common are described in Sec. 41.1.

41.3.2.1 Rectangular Grating

The effect of a grating transmission with a rectangular phase or amplitude profile can be simulated by this

boundary response. The modulated value t(x′) is computed from the modulation depth D and the slit width w
by

t(x′) =

D, if ξ − w ≤ 0

0, if ξ − w > 0
(41.3)

for the case of amplitude modulation and by

t(x′) =

exp(iD/2), if ξ − w ≤ 0

exp(−iD/2), if ξ − w > 0
(41.4)

for modulation of the phase.

With ξ = x′ − Pb x′
P c. P is the grating period and x′ is the shifted and rotated position x′ = x cos θ + y sin θ− ∆x

(with the lateral position (x; y), the rotation angle θ, and the lateral shift ∆x).

Figure 313. Special Rectangular Grating Value for a Rectangular Grating boundary response.

ITEM DESCRIPTION

Slit Width PV The width w of the slits within the grating.

The Common Grating Values are explained in Sec. 41.3.2, the other tab pages in Sec. 41.1.

41.3.2.2 Sawtooth Grating

The effect of a sawtooth like phase or amplitude profile can be simulated with this boundary response. The

modulated value t(x′) is computed from the modulation depth D and the grating period P by

t(x′) =

Dξ/P, if Amplitude / Phase Increases with x

D(P− ξ)/P, if Amplitude / Phase Decreases with x
(41.5)
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for the case of amplitude modulation and by

t(x′) =

exp [iDξ/(2P)] , if Amplitude / Phase Increases with x

exp [iD(P− ξ)/(2P)] , if Amplitude / Phase Decreases with x
(41.6)

for modulation of the phase.

With ξ = x′ − Pb x′
P c. P is the grating period and x′ is the shifted and rotated position x′ = x cos θ + y sin θ− ∆x

(with the lateral position (x; y), the rotation angle θ, and the lateral shift ∆x).

Figure 314. Special Sawtooth Grating Value for a Sawtooth Grating boundary response.

ITEM DESCRIPTION

Amplitude / Phase

Decreases with x

If checked, the amplitude / phase of the unrotated grating transmission descends in

positive x-direction.

Amplitude / Phase

Increases with x

If checked, the amplitude / phase of the unrotated grating transmission ascends in

positive x-direction.

The Common Grating Values are explained in Sec. 41.3.2, the other tab pages in Sec. 41.1.

41.3.2.3 Sinusoidal Grating

The effect of a sinusoidal modulated phase or amplitude can be simulated with this boundary response. The

modulated value t(x′) is computed from modulation depth D, grating period P, and lateral shift ∆x by

t(x′) = D/2
(
sin
(
2π(x′ − ∆x)/P

)
+ 1
)

(41.7)

for the case of amplitude modulation and by

t(x′) = exp
[
iD/2 sin

(
2π(x′ − ∆x)/P

)]
(41.8)

for modulation of the phase.

x′ is calculated from the lateral position (x; y) and the rotation angle θ via x′ = x cos θ + y sin θ.

This grating boundary response has no specific parameters. The Common Grating Values are explained in

Sec. 41.3.2, the other tab pages in Sec. 41.1.

41.3.2.4 Triangular Grating

In a triangular phase or amplitude profile the modulation increases linearly along a certain part a of the grating
period P and then decreases linearly to the original value along b = P − a. The modulated value t(x′) is
computed from the modulation depth D, the period P and the triangle side ratio σ = b/a by

t(x′) =

Dξ(1 + σ)/P, if x′ < P/(1 + σ)

D(P− ξ)(1 + σ)/(σP), if x′ ≥ P/(1 + σ)
(41.9)

for the case of amplitude modulation and by

t(x′) =

exp [iDξ(1 + σ)/(2P)] , if x′ < P/(1 + σ)

exp [iD(P− ξ)(1 + σ)/(σ2P)] , if x′ ≥ P/(1 + σ)
(41.10)
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for modulation of the phase.

With ξ = x′ − Pb x′
P c. P is the grating period and x′ is the shifted and rotated position x′ = x cos θ + y sin θ− ∆x

(with the lateral position (x; y), the rotation angle θ, and the lateral shift ∆x).

Figure 315. Special Triangular Grating Value for a Triangular Grating boundary response.

ITEM DESCRIPTION

Triangle Side Ratio PV Ratio σ of the projections of the sides of the triangle on its baseline.

The Common Grating Values are explained in Sec. 41.3.2, the other tab pages in Sec. 41.1.

41.3.3 Ideal Lens

This boundary response applies the effect of a thin lens with the Focal Length PV f to the incoming field. One
has to distinguish between a paraxial and the more general non-paraxial application. The first case is given by

tpar(x, y) = exp
[
−ik

(
(x− x0)

2

2 fx
+

(y− y0)
2

2 fy

)]
(41.11)

while the non-paraxial relation is described by

t(x, y) = exp[ikr] (41.12)

with

r = −
√
(x− x0)2 + (y− y0)2 + f 2. (41.13)

The wave number k is defined by

k =
2πn

λ
. (41.14)

The Lateral Offset relative to the optical axis is represented by (x0, y0).

Figure 316. Physical Parameters for an Ideal Lens transmission.

These parameters have to be entered to the dialog shown in Fig. 316 and are listed in the following table:
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ITEM DESCRIPTION

Paraxial Lens Function If checked, the paraxial equation Eq. (41.11) is used, otherwise the non-

paraxial Eq. (41.12).

Focal Length PV Corresponds to f in Eq. (41.12) and to fx and fy in Eq. (41.11) respectively.

It represents the focal length of a real lens. It can differ in x- and y-direction

in the case of a Paraxial Lens Function, which represents different curvature

radii in a real lens.

Lateral Offset PV Corresponds to x0 and y0 in Eq. (41.11) and Eq. (41.13). It determines the

displacement of the radial symmetric function, perpendicular to the optical

axis.

Achromatic Function /

Chromatic Function

If the function is defined as achromatic, then the wavelength λ used in

Eq. (41.14) is always the wavelength of the incoming (member) field and thus

the effect of the ideal lens function is always the same.

In contrast, in chromatic mode, the Wavelength λ used in Eq. (41.14) is set

to a fixed value in the tab page. This is closer to the behavior of a real lens.

Wavelength The fixed wavelength used for Chromatic Functionmode. Only for this wave-

length the chromatic lens has exactly the entered Focal Length.

The controls that all boundary responses have in common are described in Sec. 41.1.

41.3.4 Linear Phase

By using a linear phase boundary response, a wave can be deflected by a certain angle.

The direction of the linear phase can be entered as Cartesian Angles, Spherical Angles,Wave Number Vector,

and Spatial Frequency.

The lateral transmission function is defined by:

t(x, y) = exp[i(kxx + kyy)]. (41.15)

Here you can find theWave Number Vector k = (kx, ky, kz)T, which has the length

k =
2π

λ
=
√

k2
x + k2

y + k2
z, (41.16)

The Cartesian Angles α and β (Alpha and Beta) are related to kx and ky by

tan α =
kx

kz
, (41.17)

tan β =
ky

kz
, (41.18)

(41.19)

whereas the Spherical Angles φ and θ (Phi and Theta) are related to the wave number coordinates kx and ky

by

kx = k cos φ sin θ, (41.20)

and

ky = k sin φ sin θ. (41.21)

In case of Spatial Frequency the given parameters u and v are related to kx and ky by

u = kx/(2π), (41.22)
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and

v = ky/(2π). (41.23)

Figure 317. Physical Parameters for a Linear Phase boundary response.

The following physical parameters are available for a Linear Phase boundary response (↪→Fig. 317):

ITEM DESCRIPTION

Cartesian Angles Defines the tilt angles α and β (Alpha PV and Beta PV ) of the linear phase. The

angle unit is degrees. For the definition see Eq. (41.17) and Eq. (41.18).

Spherical Angles Defines the tilt angles in spherical coordinates φ and θ (Phi and Theta). The

angle unit is degrees. For the definition see Eq. (41.20) and Eq. (41.21).

Wave Number Vector Defines the direction of the linear phase in terms of the components kx and ky

of the wave number vector k. For the physical meaning on it see Eq. (41.15).

Spatial Frequency Defines the direction of the plane wave in spatial frequencies u and v for x

and y-direction, in units of 1/m (see Eq. (41.22) and Eq. (41.23)).

Achromatic Function /

Chromatic Function

If the function is defined as achromatic, then the wavelength λ used in

Eq. (41.16) is always the wavelength of the incoming (member) field and thus

the deflection is always the same.

In contrast, in chromatic mode, theWavelength λ used in Eq. (41.16) is set to

a fixed value in the tab page. As you can see from Eq. (41.15), Eq. (41.22),

and Eq. (41.23), setting the wavelength has no effect if the linear phase is

defined by Wave Number Vector or Spatial Frequency. Thus, the group box

Wavelength Dependency is not visible in these cases.

Wavelength The wavelength the Cartesian Angles and the Spherical Angles refer to in

Chromatic Function mode.

The controls that all boundary responses have in common are described in Sec. 41.1.
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41.3.5 Programmable Function

Figure 318. Physical Parameters for a programmable boundary response.

The programmable function allows you to define your own boundary response. This means you write a little

code snippet defining the function B = f (x, y, λ, n(λ)). The Physical Parameters tab (↪→Fig. 318) contains:

ITEM DESCRIPTION

Definition This group box allows you to program the actual code snippet. Edit opens the

Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

General information about programming in VirtualLab Fusion can be found in Sec. 7. The controls that all

boundary responses have in common are described in Sec. 41.1.

41.3.6 Single Phase Dislocation

This boundary response can be used to simulate the effect of a special type of phase dislocations. Around

phase dislocations the phase distribution of a field has a shape like a spiral staircase (see example in Fig. 319).

A circle integral over the phase around a single phase dislocation results in a multiple of 2π.

The boundary response function B(x, y) of the generated type of phase dislocations is given by

B(x, y) = 1 · exp (i · cϕ) = 1 · exp
(
i · c arctan

y− y0

x− x0

)
, (41.24)

where c denotes the Charge of the phase dislocation and (x0, y0) marks its Position.
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Figure 319. Two examples of a single phase dislocation transmission with a charge c of -5 (left) and +5 (right).

Figure 320. Physical Parameters for a Single Phase Dislocation boundary response.

The following physical parameters are available for a Single Phase Dislocation boundary response (↪→Fig. 320):

ITEM DESCRIPTION

Position Corresponds to x0 and y0 in Eq. (41.24). It defines the lateral displacement

of the phase dislocation in physical coordinates with respect to the center of

the field.

Charge PV Determines the charge c of the phase dislocation (↪→Eq. (41.24)). It gives

the number of 2π jumps. Its sign specifies whether the phase increases or

decreases with angle ϕ (↪→Fig. 319).

The controls that all boundary responses have in common are described in Sec. 41.1.

41.3.7 Spherical Phase

A radially converging or diverging wave has a spherical phase, which can be simulated by using this boundary

response. It is defined by

t(x, y) = exp[ikr], (41.25)

with

r =
√
(x− x0)2 + (y− y0)2 + z2. (41.26)

and the wave number

k =
2πn

λ
(41.27)

n is the refractive index of the embedding medium.
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The Lateral Offset (x0, y0) relative to the optical axis as well as theDistance to Source Plane z has to be entered
in the Physical Parameters tab (↪→Fig. 321).

Figure 321. Physical Parameters for a Spherical Phase boundary response.

ITEM DESCRIPTION

Distance from Source

Plane PV

Corresponds to z in Eq. (41.26). A wave, propagating in positive z-direction,

would have the desired spherical phase if it is this distance (measured on the

optical axis) away from its (point) source.

Lateral Offset PV Corresponds to x0 and y0 in Eq. (41.26). It determines the displacement of

the radial symmetric transmission function, perpendicular to the optical axis.

Achromatic Function /

Chromatic Function

If the function is defined as achromatic, then the wavelength λ used in

Eq. (41.27) is always the wavelength of the incoming (member) field and thus

the effect of the spherical phase function is always the same.

In contrast, in chromatic mode, the Wavelength λ used in Eq. (41.27) is set

to a fixed value in the tab page.

Wavelength The fixed wavelength used for Chromatic Function mode. Only for

this wavelength a plane wave having a spherical phase as defined by

Eqs. (41.25)-(41.27) would be completely focused if propagated a distance

of −z.

41.3.8 Stop

This boundary response allows you to apply a rectangular or elliptical stop function on the incoming field. Such

a function has the value 0 inside and 1 outside the defined Diameter. The edge of the stop can be defined

smooth, then the values don’t “jump” from 1 (outside of the stop) to 0 (the blocking stop). Instead they follow a

Gaussian function (starting at 1 and cut off at a value of 0.01) as shown in Fig. 322.
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Figure 322. Definition of the edge width of a stop. The stop is at the right part of the graph.

The panel to enter the parameters for the boundary response is shown in Fig. 323.

Figure 323. Physical Parameters for the Stop boundary response.

The parameters are:

ITEM DESCRIPTION

Shape Possible options for the aperture shape are Rectangular and Elliptical.

Diameter PV Determines the diameter of the stop in x- and y-direction.

Relative Edge Width The width of the aperture edge, defined relatively to the (smaller of the both

values of) diameter.

Absolute Edge Width The width of the aperture edge, defined in physical units. ↪→Fig. 322.

The controls that all boundary responses have in common are described in Sec. 41.1.

41.3.9 Zernike & Seidel Aberrations

Zernike fringe, Zernike standard, and Seidel aberrations are often used to describe aberrations within an imag-

ing optical system. The corresponding formulas are given in Sec. 134.2.
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Figure 324. Parameters for a Zernike Standard Aberrations boundary response.

Figure 325. Parameters for a Seidel Aberrations boundary response.

The Physical Parameters tab (see Fig. 324 and Fig. 325) allows the following settings.

ITEM DESCRIPTION

Mode You can choose between Zernike Fringe Aberrations, Zernike Standard Aber-

rations, and Seidel Aberrations.

Polynomial Degree O Z S A

Allows you to set the maximum polynomial degree of the used Zernike terms,

and thus indirectly the number of coefficients.

{Coefficients Table} Allows you to enter the coefficients of the polynomial describing the aberra-

tions. They refer to wavelengths. For example a Zernike fringe tilt of 1 leads

to phase values in the range −1λ(= −2π) . . . + 1λ(= +2π).

Via the context menu of the table you can copy and paste the parameter list.

Maximum Radial Extent The radii r =
√

x2 + y2 are divided by this value. It is equal to half the Di-

ameter plus the Absolute Edge Width as set up in the Basic Parameters tab.

This parameter is sometimes also referred to as maximum radius, radius of

unit pupil, or radius of unit disc.

Reset Tabular Resets all table entries to 0.

41.3.10 Stored Function

By using the Stored Function it is possible to include an arbitrary sampled transmission function into an optical

system. Fig. 326 shows the dialog where the transmission and the other parameters can be set.
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Figure 326. Parameters of a stored function.

All parameters of the dialog are listed in the following table:

ITEM DESCRIPTION

Type of Transmission

Function

The chosen type determines which interpolation is used to retrieve function

values at a certain position andwhat scale errors can be simulated. AContin-

uous function uses Cubic 8 Point Interpolation, while Pixelated or Quantized

transmissions use Nearest Neighbor. Details on these interpolations can be

found in Sec. 13.2.2.

Furthermore a Phase-Only function allows to apply a linear scale factor on

the phase. A Regularly Quantized Phase-Only Transmission assumes 2n

equidistant phase levels with distances of 2π/2n. In this case one can as-

sume a binary mask fabrication process and apply an error to each mask.

Note that any Phase-Only option will not cause any amplitude modulation

that may be present to be ignored.

Set Sets the desired Jones Matrix Transmission. When you click on this button

you can do the following:

• Load a Jones Matrix Transmission from a .ca2 file. Note that the Jones

matrix of that transmission is ignored.

• Select from Documents allows you to select an already open Jones

Matrix Transmission.

• Reset the data to the default transmission.

Show Shows the Complex Amplitude containing the currently set transmission as

separate document.

Sampling Gives information about the number of sampling points, the sampling dis-

tance, and the diameter of the currently set transmission.

Pixelation Factor PV If these factors (Fx; Fy) are larger than one, every pixel in the original trans-

mission is replaced by Fx × Fy pixels with the same value. This ensures that

a pixelated transmission is really simulated as pixelated.
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Impose Linear Scale Error

by Scale Factor

Takes a specific scale error into account, the Linear Scale Factor PV . It is

considered by

Tnew(x, y) = exp(iφnew(x, y)) = exp(iφold(x, y) f ), (41.28)

whereby f denotes the Linear Scale Factor.

Impose Mask Scale Errors This option is available for Regularly Quantized Phase-Only Transmission

only and simulates separate single mask scale errors during a binary mask

fabrication process. To this end, a Mask Scale Factor PV can be applied to

each mask. The ideal phase modulation of the corresponding mask (π, π/2,
π/4, and so on) is multiplied with that factor. Via the context menu of the

table you can copy the scale factors.

Number of Binary Masks If Impose Mask Scale Errors is checked, it is assumed that the function has

been composed out of “binary masks”. Then to each binary masks a scale

error can be applied. This feature can only be used only for a Regularly

Quantized Phase-Only Transmission with 2n height levels. The integer n is

the Number of Binary Masks.

42 Surface Regions

Surface Regions are regions on a surface (↪→Sec. 35) which behave differently than just a plain surface. As

such they consist of the actual geometric region and the functionality to be applied in that region. In the moment

only surface regions with an idealized or real grating are implemented. These grating regions are described in

Sec. 42.1.

Multiple regions on a surface form a so-called Surface Layout (↪→Sec. 40).

42.1 Grating Regions

Grating Regions describe the effect of an idealized or real grating within a certain geometric region.

The edit dialog for grating regions has the following three tab pages:

TAB PAGE DESCRIPTION

Shape Describes the actual geometric region in which the grating is located.

↪→Sec. 42.1.1

Region Channels Allows you to define which propagation channels are used for this region.

The names of the channels refer to the sign the z-component of the direction

vector the incident and outgoing light has, respectively. Plus-Plus-Direction

for example refers to transmitted light going along the optical axis whileMinus-

Plus-Direction refers to reflected light going initially against the optical axis.

Note that this settings might be overwritten by the settings on the Channel

Configuration tab (↪→Sec. 43.9) of the parent component.

Grating Describes the idealized or real grating. ↪→Sec. 42.1.2

Additionally it has a validity indicator (↪→Sec. 5.10) in the bottom-left corner.
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42.1.1 Shape Tab

Figure 327. Shape tab of a grating region.

In the top of this tab (↪→Fig. 327) there are the following controls.

ITEM DESCRIPTION

Creates a new geometric region, which can be either a New Rectangular Re-

gion (↪→Sec. 21.1.1), New Elliptic Region (↪→Sec. 21.1.2), New Simple Poly-

gon Region (↪→Sec. 21.1.3), New Sampled Region (↪→Sec. 21.1.4), or New

Composed Region (↪→Sec. 21.1.5).

If you click on this button you can do the following:

• Load a region document (↪→Sec. 21) from a .rgn file.

• Select from Documents allows you to select an already open region

document.

Saves the current region definition as region document.

Displays the current region definition as separate region view (↪→Sec. 21.3).

Region Name You can give the region an arbitrary name which for example identifies this

region in the edit dialog of the parent surface layout.

Spectral Domain /

Region Type

These two controls provide useful information about the current region.

In the lower part there are controls specific to the current Region Type (see sections given above for details)

and a preview of the region.
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42.1.2 Grating Tab

Figure 328. Order Selection tab of a grating region.

On this tab (↪→Fig. 328) you first specify the general parameters of the grating.

ITEM DESCRIPTION

1D-Periodic (Lamellar) /

2D-Periodic

Determines the periodicity of the grating. Influences some controls on this

tab page and in the end also the computational effort.

Grating Period PV The period of the grating.

Orientation PV Rotates the whole grating around the z-axis and so determines into which

direction the grating orders go.

Furthermore this tab contains two sub-tabs. On the Order Selection tab (↪→Sec. 42.1.2.1) you define which or-

ders shall be used for the simulation. On the Efficiencies tab (↪→Sec. 42.1.2.2) you either specify the efficiencies

directly or via a snippet or you define a real grating whose efficiencies are used.
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42.1.2.1 Order Selection Tab

Figure 329. Order Selection tab of a grating region with a 2D-Periodic grating.

This tab page (↪→Fig. 329) has the following controls.

ITEM DESCRIPTION

Propagating Orders There are three ways how the orders specified by the user are taken into

account during the simulation of the optical setup.

• All Orders: All orders are taken into account, independent from the user

specification.

• Specified Orders: Only the orders specified by the user are taken into

account.

• All but Specified Orders: Only the orders not specified by the user are

taken into account.

From Front Side Table with all propagating orders if the grating is illuminated from the front

side, i. e. with light whose z-component of the direction vector has a positive

sign. ↪→Sec. 5.12

From Back Side Table with all propagating orders if the grating is illuminated from the back

side, i. e. with light whose z-component of the direction vector has a negative

sign. ↪→Sec. 5.12

42.1.2.2 Efficiencies Tab

This tab offers you three ways how the efficiencies of the distinct orders are determined:

• Constant: The efficiencies of an idealized grating are specified via a table. ↪→Sec. (a)

• Programmable: The efficiencies of an idealized grating are specified via a snippet in dependency from

e. g. direction or wavelength. ↪→Sec. (b)

• From Real Grating: The efficiencies are calculated from a real grating stack. In this case the Grating

Period and the period of the stack defining the real grating are synchronized so that they are always the

same. ↪→Sec. (c)

If you switch from a real grating to an idealized grating you are asked whether the Grating Period shall be the

period of the stack or the value you last entered as Grating Period.
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(a) Constant Efficiencies

Figure 330. The Efficiencies tab of a grating region if Constant efficiencies are specified.

For Constant Efficiencies there are the following controls.

ITEM DESCRIPTION

Overall Transmission /

Overall Reflection

For consistency the sum of all grating orders must not be larger than 100%.

With these controls you can divide this 100% between transmission and re-

flection. If then the sum of the efficiencies for either the transmitted or the re-

flected orders exceeds the specified limit, the validity indicator (↪→Sec. 5.10)

of the dialog indicates a warning.

From Front Side /

From Back Side

Table where you can enter efficiencies PV for all orders specified in the From

Front Side / From Back Side table of the Order Selection tab. If All Orders

or All but Specified Orders was set on this tab, then all entered efficiencies

are subtracted from the overall transmission / reflection efficiency and this

remaining efficiency is then distributed evenly among the unspecified orders.

Example

You have specified that the order “T+1” for the light coming from the front side has an efficiency of 50%

whereas the overall transmission is 80%. You have set to use All Orders and the orders “T-1”, “T0”, and

“T+1” are propagating ones. Thus the remaining 30% are distributed evenly among “T-1” and “T0” and

thus both orders have 15% efficiency.

(b) Programmable Efficiencies
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Figure 331. The Efficiencies tab of a grating region if Programmable efficiencies are specified. The snippet is valid and

some general parameters are available.

For Programmable Efficiencies you can program a snippet returning a list of order numbers and corresponding

efficiencies in dependency from e. g. wavelength, direction of the incident light and whether the light is reflected

or transmitted. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent. Below these two controls you can edit the values of the

global parameters of the snippet (↪→Sec. 7.4).

(c) Efficiencies From Real Gratings

The efficiencies can also be calculated from a real grating stack (↪→Sec. 39). The efficiencies of this stack

are then calculated rigorously with the Fourier Modal Method (FMM, ↪→Sec. 96.3) when the Grating Channel

Analyzer (↪→Sec. 91) is used. Alternatively you can load an already calculated lookup table with efficiencies

from file.

Note that in case of a 2D Grating only a one-dimensional section of the orders is used. I. e. only orders are

taken into account having an order number of zero in y-direction (of the unrotated grating).

Figure 332. The Efficiencies tab of a grating region if the efficiencies are calculated From Real Gratings.

For Efficiencies From Real Gratings there are the following controls.
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ITEM DESCRIPTION

Use Modulated Grating

Parameters within Region

Switches to a mode where not a well-defined grating is used but a grat-

ing where parameters vary over the region. This mode is explained in

Sec. 42.1.3.

{Actual Grating Stack} PE Control for loading a stack with a grating from catalog, for editing and viewing

it. ↪→Sec. 34.1

OnFront Side of Base Sur-

face

If checked it is assumed that the stack is placed on the front side of the base

surface. This means that in comparison to its normal orientation it is rotated

by 180° about the y-axis and thus points against the optical axis. Sec. 39.1.2

shows an example.

On Back Side of Base Sur-

face

If checked it is assumed that the stack is placed on the back side of the base

surface. This means that it is used in its normal orientation.

FMM Settings PE The FMM does not evaluate the real grating but an approximated structure

decomposed into layers and transition points. By clicking on the Configure

button you can adjust and preview this decomposition and set the number of

calculated orders. ↪→Sec. 96.3.1

Lookup Table Normally the lookup table with the efficiencies is filled by the LUT Result Gen-

erator (↪→Sec. 46). But the controls in this section allow you to Save a lookup

table into a file so that you can Load it into other grating regions. Or you can

Remove the lookup table to enforce a new calculation by the Grating Chan-

nel Analyzer (↪→Sec. 91) / LUT Result Generator. A label gives you some

additional information about the current lookup table – or informs you that

no lookup table is set. The button right to it shows all wavelengths and

directions for which the lookup table contains Rayleigh coefficients.

42.1.3 Modulated Grating Parameters

If Use Modulated Grating Parameters within Region is checked the parameters of the grating used within the

region are modulated. Currently we support the 1D or 2D variation for grating parameters (reason for this is the

usage of a 1D or 2D data array to store the Rayleigh matrices in dependency of the grating parameters which

are varied). In order to use a modulated grating within a region, two things need to be specified:

1. The function how the grating parameter is changed inside the region in dependency of the lateral position

(x; y).

2. The lookup tables which define the grating effect in dependency of the grating parameters. (note: the grat-

ing effect is defined by a complex 2 × 2 matrix (Rayleigh matrix) per grating parameter, so all polarization

effects are included, because we do not deal “only” with efficiencies.

The lookup tables should typically be filled by using the Footprint and Grating Analysis tool (↪→Sec. 101.1).

Fig. 333 shows the edit dialog for activated Use Modulated Grating Parameters within Region.
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Figure 333. The Efficiencies tab of a grating region if the efficiencies are calculated From Real Gratings with modulated

grating parameters.

The following options are available in this section of the region edit dialog:

ITEM DESCRIPTION

Grating Stack The grating stack which is associated with this region. In modulated param-

eter mode the grating stack cannot be edited and also won’t be used during

propagation, because all required information is given in the lookup tables.

The stack can only be displayed.

Grating Parameter Modu-

lation Function

In this group box several information about the configured modulation func-

tion is displayed (like number of parameters that are defined for the modu-

lation, name of the parameter(s) and type of modulation, e. g. sampled or

programmable. In addition the user can edit the grating parameter modula-

tion function by clicking on the Edit button (↪→Sec. 42.1.3.1). It is also possible

to display the parameter variation function in the region. This is triggered by

clicking on the View button (↪→Sec. (a)).

Lookup Table The effect of the modulated grating is defined by a special lookup table

concept. Here the Rayleigh matrices per grating parameter is stored. The

user can edit the lookup tables by clicking on the corresponding Edit button

(↪→Sec. 42.1.3.2).

42.1.3.1 Edit Grating Parameter Modulation Function

The grating parameter modulation function defines the dependency of the grating parameter(s) in dependency

of the lateral position in the grating region. Currently we support that one or two grating parameters can be

varied.

Fig. 334 shows the edit dialog of the grating parameter modulation function.
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Figure 334. The dialog to edit the grating parameter modulation function.

In the top part of the dialog the following options can be configured by the user:

ITEM DESCRIPTION

Define Grating Parameter

Function for Two Grating

Parameters

Currently we allow the definition for one or two grating parameters that are

varied. By checking this option the variation of two parameters is enabled. If

the option is unchecked only one parameter is available for modulation.

Settings for Grating Pa-

rameter #1

The user needs to specify several information for parameter #1 that shall be

used for parameter variation:

• The name of the parameter (string format)

• The physical property of the parameter (selection by a drop-down list)

• Minimum and maximum of the parameter

This information is used within the display of the grating parameter function

and within the parameter extraction in case of sampled function definition.

Settings for Grating Pa-

rameter #2

The user needs to specify several information for parameter #2 that shall be

used for parameter variation:

• The name of the parameter (string format)

• The physical property of the parameter (selection by drop-down list)

• Minimum and maximum of the parameter

This information is used within the display of the grating parameter function

and within the parameter extraction in case of sampled function definition.

VirtualLab Fusion provides two options for the specification of the grating parameter dependency from x-y-

coordinates:

1. Programmable Function: The user has to implement a snippet which returns an array of parameters in
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dependency of the position. If only one parameter is to be varied the length of the array is 1, otherwise it

is 2. The configuration of the snippet can be done by the standard input methods provided by VirtualLab

Fusion (↪→Sec. 7.3).

2. Sampled Data: A table is displayed where the coordinates of the data points and the corresponding

values are listed. This table can be edited by several tools, which can be accessed by clicking on the

corresponding buttons on the right side of the table:

ITEM DESCRIPTION

Edit Data Point By clicking this button a dialog will be displayed which contains the parame-

ters of the currently selected row. The user can modify the coordinate of the

data points as well as the value(s) at the coordinate.

Add Data Point To add a new data point, click this button. A dialog will be displayed where

you can enter the coordinate as well as the value(s) at the coordinate. Af-

ter pressing OK the data point will be added to the list and the table will be

updated.

Remove Data Point By clicking on the Remove Data Point button the currently selected data point

will be deleted from the list of coordinates. Afterward the table will be updated.

Load from Data Array In addition to the previously mentioned options it is also possible to load data

points from a gridless data array. This operation will delete all present data

points and add all data points from the selected data array. Note: this oper-

ation is essential if you like to transfer for example a programmable grating

parameter modulation function into a sampled one, or you like to increase or

decrease the resolution of the data points. This tool is especially helpful in

combination with the tool described in Sec. (b).

The information of the discrete data points has to be converted into a continuous function by interpolation. For

this purpose we offer here the interpolation by

• Spline interpolation

• Nearest neighbor interpolation (in non-equidistant case this is also known as Voronoi interpolation)

The interpolation method can be selected by checking the corresponding option on the bottom of the dialog.

(a) Show Grating Parameter Variation Function

On the bottom of the dialog shown in Fig. 334 the user can click on View to visualize the grating parameter

modulation function. A dialog is shown, in which the user can select the (varied) grating parameter to be

displayed. Below the drop-down list for selection of the parameter to show, a graph is displayed which visualizes

the grating parameter variation within the region. TheMinimum andMaximum value configured for the selected

grating parameter are used here also for visualization.

Fig. 335 shows the output of the grating parameter modulation function visualization tool (in this example the

parameter modulation function was defined by a snippet which represents a linear modulation in dependency

of the positions).
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Figure 335. Visualization of the grating parameter modulation for a linear parameter dependency.

(b) Show Grating Parameter Modulation Values As Data Array

Additionally to the visualization tool, the user can also extract the parameters for the grating parameter mod-

ulation function as data array. By clicking on the corresponding button at the bottom a dialog is shown which

offers several options for the extraction.

Fig. 336 shows the edit dialog which can be used to define the parameters for the sample selection for the

extraction into a data array.

Figure 336. The dialog to define the sample selection.

The following parameters can be configured for extraction:

ITEM DESCRIPTION

Use Samples of Present

Sampled Modulation

If this option is checked the original data points are used for extraction. This

option is only available if the modulation is defined by sampled data. It is re-

commended to use this option to transfer the parameters from onemodulation

function to another one.

Add Data Point If Use Samples of Present Sampled Modulation is false, the user can define

the number of sampling points manually. Then VirtualLab Fusion will use the

extension of the underlying region and perform an equidistant evaluation of

the grating parameter modulation function according to the number of data

points defined in the dialog.

Note on workflows: The extraction tool can be used to convert a Programmable Function into a sampled grating
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parameter modulation function. In addition it can be also applied to change the resolution of the sampled grating

parameter modulation function.

42.1.3.2 Edit Lookup Tables

In addition to the configuration of the grating parameter modulation function also the specification of the lookup

tables to use is necessary to enable the simulation of a region with modulated grating parameters. This is done

within the dialog displayed in Fig. 337.

The definition of the lookup tables for themodulated grating region is typically done automatically by the footprint

and grating analysis tool (↪→Sec. 101.1). In case you need to adapt the lookup table data manually the tools

described below can be used.

Figure 337. Edit dialog to configure the lookup tables for the modulated grating region.

The following information is displayed in the table inside the edit dialog of the lookup tables per entry:
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ITEM DESCRIPTION

Index The index of the lookup table entry within the configuration.

Direction The incident direction associated with the lookup table entry. The incident direction is

given in the grating coordinate system (including the rotation of the grating along z-direction

relative to the grating region).

Wavelength The wavelength for which the lookup table is defined.

Order The order information for which the lookup table entry is defined. In combination with the

sign of the incident direction we have a full 4-channel definition (including transmission and

reflection from front and behind). The order number in general is two-dimensional. In case

of 1D-periodic gratings the second value of the order index will be always zero.

Show The lookup table entry is stored as a data array (1D data array for variation of one grating

parameter and 2D data array for two parameters). By clicking on the Show button the

lookup table is displayed as data array in VirtualLab Fusion.

Set The lookup table entry is stored as data array (1D data array for variation of one grating

parameter and 2D data array for two parameters). It has to have four subsets, due to the

fact that for each grating parameter a complex 2 × 2 matrix (Rayleigh matrix) has to be

stored. The subsets represent the entries of the Rayleigh matrix (Rxx, Rxy, Ryx and Ryy).

By clicking the Set button, the user can select a data array from the VirtualLab Fusion

main window and define it as underlying data for the corresponding lookup table entry.

VirtualLab Fusion will check the validity of the data to be set.

Several additional tools are available to modify the lookup table data defined in the dialog. These tools can be

accessed by clicking on the corresponding buttons on the right side of the table:

ITEM DESCRIPTION

Add Lookup Table Entry By clicking on this button a dialog is shown, where the user can enter all

necessary information for one lookup table entry. The options available within

the edit dialog are described in Sec. (a).

Load from Hard Disc Additionally the user has the option to load the lookup table data (all entries)

from hard disc. Therefor a folder has to be selected where all lookup tables

to load are stored. The file names of the da-files within the folder encode all

necessary information. Usually these files will be created by the footprint and

grating analysis tool (↪→Sec. 101.1.2), where the calculated lookup table data

is automatically stored on hard disc.

Remove Lookup Table En-

try

By clicking on this button the selected lookup table entry will be removed from

the underlying data set.

Remove All To remove all lookup tables, press the Remove All button.

(a) Add Lookup Table Entry

Fig. 338 shows the edit dialog to add a new lookup table entry to the grating region with modulated grating

parameters.
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Figure 338. Edit dialog to add a new lookup table entry.

The user has to define the following parameters:

ITEM DESCRIPTION

Wavelength The wavelength for which the lookup table to add will be used.

Direction Normalized direction vector in the grating coordinate system. It is possible to

enter an arbitrary 3D vector and afterward perform normalization by pressing

on the update button ( ).

Is Transmission Boolean flag whether the lookup table entry is defined in transmission (true)

or reflection (false). The illumination from in front or behind is encoded in the

sign of sz.

Order Number The user needs to define the order number associated with the lookup table

entry.

Lookup Table Data The lookup table entry is stored as data array (1D data array for variation of

one grating parameter and 2D data array for two parameters). It has to have

four subsets, due to the fact that for each grating parameter a complex 2 × 2

matrix (Rayleigh matrix) has to be stored. The subsets represent the entries

of the Rayleigh matrix (Rxx, Rxy, Ryx and Ryy). By pressing on the Set button

a data array which fulfills these restrictions can be set.

After clicking the OK button, the entered data will be checked for validity (to ensure unique entries) and the

input will be added to the lookup tables of the grating region.



VII Optical Systems

In VirtualLab Fusion optical systems are defined using theOptical Setup

document (↪→Sec. 43). The parameters of an optical setup can be varied

using the Parameter Run (↪→Sec. 44). Session Editors (↪→Sec. 47) are

a special way how optical setups can be created.
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43 Optical Setup

In VirtualLab Fusion optical systems are defined using the Optical Setup document. It can contain different Op-

tical Setup Elements (light sources, components, detectors, and so on) which are linked to define an execution

sequence.

This document is represented by two document windows. The Optical Setup View (↪→Sec. 43.1) contains a

two-dimensional flowchart where the user can add, place and link the Optical Setup Elements. The Optical

Setup Editor window (↪→Sec. 43.2) allows to configure the linkages, start the simulation and change various

settings.

Closing one of both documents will close the other window automatically, so the associated Optical Setup is no

longer available.

A sample Optical Setup is shown in Fig. 339.

Figure 339. A sample Optical Setup.

43.1 Optical Setup View

The Optical Setup View (↪→Fig. 340) is one of the two document windows in VirtualLab Fusion which is used

for configuring an Optical Setup.

The window is divided into two areas. On the left side a tree view with all available types of Optical Setup Ele-

ments is displayed, sorted into categories (light sources, components, detectors, and so on). Which categories

and Optical Setup Elements are available depends on the type of the Optical Setup (↪→Sec. 43.11). Above the

tree there is a text box where you can enter a filter string. Only elements containing the given string or being in

a category matching the given string are shown. The matching is case insensitive. It is possible to search for

multiple words and word groups embraced by quotation marks.

The right side is used for showing the two-dimensional flowchart which visualizes the current optical setup.
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Figure 340. The Optical Setup View.

In order to add a new element to the Optical Setup, the user simply drags the Optical Setup Element from the

tree view on the left side and drops it onto the flowchart area on the right side. Alternatively, the user can double

click an item in the tree view. After doing this, the selected element’s symbol will be added to a default position

on the flowchart.

While adding an element to the Optical Setup, a unique index is assigned. Therefor the following rules are

used:

• The active light source always gets the index 0.

• There is always only one active light source at the same time. If there is more than one light source in an

Optical Setup, the non-active sources get indices of 500 and higher.

• All ideal and real components are enumerated with indices between 1 and 499.

• The indices of detectors start at 600 and are increased till 799.

• Indices higher than 799 are reserved for indexing analyzers in the Optical Setup.

After adding an Optical Setup Element, its properties can be edited by double clicking the associated symbol

in the Optical Setup View.

Figure 341. The button in the Optical Setup View to toggle to the Optical Setup Editor.

The following tools for the Optical Setup View are available in its bottom right corner:
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ITEM DESCRIPTION

Shows a resizable panel on the bottom of the form where you can enter ar-

bitrary notes, e. g. for documentation purposes. Clicking on this button again

hides this panel again. An orange background of this button indicates the

presence of notes.

The notes panel can have two modes: One (with gray background) shows

the text in a formatted, but read-only way. The other mode (with white back-

ground) allows you to edit the text and format it using HTML (andCSS) syntax.

For example you can use <b>…<b/> to make some text bold and <i>…<i/> to
make it italic. You can toggle between these two modes with the button.

In both modes you can change the displayed font size by pressing Ctrl and

scrolling with the mouse wheel.

Toggles the visibility of the info panel (↪→Fig. 340).

To toggle between the Optical Setup View window and the Optical Setup Editor window, the button in the upper

right corner of the Optical Setup View can be used. (↪→Fig. 341)

43.1.1 Customizing the Optical Setup View

For a good visualization elements in the flowchart area can be arranged by using drag and drop.

Important: The positions of the Optical Setup Element symbols in the flowchart have nothing to do with

the locations of the elements in the actual optical setup. This position is set via the edit dialog of each

element or by clicking the Positioning Control. Details about positioning can be found in Sec. 43.8.2.

The Positioning Control is available for all (real) Components, Ideal Components, and Detectors. Light Sources

and Analyzers don’t have a position to configure. For grating components illuminated by an ideal plane wave,

the position cannot be changed.

Furthermore, each Optical Setup Element has a Comment Control where you can enter an arbitrary comment

to describe the corresponding element. You can extend this control by clicking on the button and minimize

it again by clicking . To change the comment simply click on its text. A small T... next to the indicates that

the comment has been changed, i. e. that it is not the default comment.

The caption of each Optical Setup Element can be changed.

Sometimes (e. g. for presentations) it is helpful to hide the Positioning Controls and / or the Comment Controls.

This can be done via the context menu of the flowchart. This context menu contains the following items:
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ITEM DESCRIPTION

Show Comments This toggles the visibility of the Comment Controls.

Paste Optical Setup Ele-

ments

Allows to paste Optical Setup Elements from the Windows™ clipboard to the

current position of the mouse cursor. You can copy one or more Optical Setup

Elements to the Windows™ clipboard by selecting them and then using the

context menu entry Copy Selected Optical Setup Elements.

Improve Node Locations The locations of the flowchart nodes, i.e. the symbols of the Optical Setup

Element, are reset automatically.

Show Position Controls The visibility of the positioning controls can be set here.

Show Only z-Positions If checked, only the z-Positions of the elements are shown. This menu item is

a shortcut to the more detailed advanced option described in Sec. 43.8.2.4.

Advanced Position Con-

trol Settings

Opens a sub-menu for advanced configuring of the Positioning Controls. It is

described in Sec. 43.8.2.4.

You can change the zoom factor (i. e. the size of all symbols and fonts) by pressing and holding Ctrl and

scrolling via mouse wheel.

43.1.2 Mouse and Keyboard Interactions

The following list summarizes all actions that can be done with mouse and keyboard:

• Drag an item from the tree view to the flowchart: Adds a new element to the Optical Setup View.

• Drag an item in the flow chart: Moves the element in the flowchart (Does not affect its real position!).

• Click on an Optical Setup Element or linkage: Selects this element or linkage.

• Click on / : Extends / minimizes a comment.

• Click on an element caption: Makes the element caption editable.

• Click on a comment: Makes the comment editable.

• Double click on an Optical Setup Element: Opens the corresponding edit dialog.

• Double click on a linkage: Switches the linkage on or off. An off linkage is not executed during simulation

of the Optical Setup and is indicated by a dashed line.

• Double click on a Position Control: Opens a dialog to edit the position of the Optical Setup Element in the

optical setup (↪→Sec. 43.8.2.4).

• Click and drag: Selects multiple Optical Setup Elements and linkages.

• Ctrl+A : Selects all Optical Setup Elements and linkages.
• Del : Removes the currently selected Optical Setup Element(s) and linkage(s) from the optical setup. If

a removed element was connected with other Optical Setup Elements the according linkages are deleted

too.

• Ctrl+C : Copies the currently selected Optical Setup Elements to the clipboard, to paste them into the

same or another Optical Setup View.

• Ctrl+V : Pastes the Optical Setup Element(s) which are currently in the clipboard to the current mouse
position (to the upper left corner if the mouse is outside the flowchart).

• Ctrl+D : Opens a dialog to select a result window with a rectangular marker (↪→Sec. 11.3). For each

selected detector the size of this marker is then set as Window Size and its (central) position is set as

Center Position. ↪→Sec. 74.1.1

• Scrolling with the mouse wheel: Moves the currently visible region of the Optical Setup View up and down.

• Shift and scrolling with the mouse wheel: Moves the currently visible region of the Optical Setup View

left and right.
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• Ctrl and scrolling with the mouse wheel: Changes the zoom factor (i. e. the size of all symbols and

fonts).

• Click with the right mouse button on an Optical Setup Element: Copies this element to the clipboard

via a context menu. Some real and ideal components have in this context menu additional entries for

converting this component to another type (↪→Sec. 55).

Detectors have one entry to copy window size and position (↪→Sec. 74.1.1) from a result window with a

rectangle marker and one entry to copy certain settings from another detector (↪→Sec. 74.2).

• Click with the right mouse button on an unoccupied region of the flowchart: Opens a context menu to

configure the Optical Setup View and to paste elements from the clipboard to the current position.

“Click” or “double click” means always clicking with the left mouse button unless otherwise noted.

The following elements can be neither deleted nor copied:

• all elements but analyzers in a Grating Optical Setup

• the Eigenmode Analyzer

The symbol of each Optical Setup Element which is not a light source or analyzer has one gray input connector

triangle at its left side representing its input. Vice versa, each symbol of an Optical Setup Element which is

not a detector or analyzer has one gray output connector at its right side, representing its output. Linkages

always go from an output connector to an input connector triangle of another Optical Setup Element. Note that

all Optical Setup Elements but detectors can have only one incoming linkage. If you click and drag from one

connector triangle to another free connector triangle, you can create a new linkage. A selected linkage has two

green diamonds with which you can move the start or end of this linkage to another free connector triangle of

the same type (input or output triangle, respectively). Fig. 342 shows an example.

Figure 342. Figure a) shows how to create a new linkage by clicking on the (output) connector triangle of Stop #1 fol-

lowed by dragging the line to the left (input) connector triangle of the Stop #2 symbol.

Figure b) shows an activated linkage, indicated by two green diamonds. Clicking on one of these and dragging the lose

end of the line to another connector triangle allows to change the linkage.

43.2 Optical Setup Editor

The Optical Setup Editor is the window for configuring the linkages and other simulation settings. The most

essential parts of this window are the different tables for displaying the linkages between Optical Setup Ele-
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ments. The main navigation in the Optical Setup Editor is done by the four buttons at the top of the window. By

clicking the button Path, a table with all linkages is shown (↪→Sec. 43.2.1) which define the execution order of

the elements. All linkages which end at a detector can be listed by clicking the Detectors button (↪→Sec. 43.2.2).

The button Analyzers displays a list of all analyzers in the Optical Setup (↪→Sec. 43.2.3). There is an additional

Logging button (↪→Sec. 43.2.4), showing the single steps done during a simulation.

43.2.1 Path Table

The Path table in the Optical Setup Editor can be used for configuring the connections between Optical Setup

Elements except for connections to detectors. (This handling is done by the Detectors table ↪→Sec. 43.2.2.)

Every row in the Path table represents one connection in the Optical Setup. Fig. 343 shows a typical example

of the Path table.

Figure 343. The linkages between Optical Setup Elements are displayed in the Path table of the Optical Setup Editor.

The Path table is organized in three regions, differentiated by three different background colors. On the left

side, all necessary information of the start element of a linkage is available. The middle part of the table enables

the user to configure the end element of the linkages, while on the right side several linkage settings can be

done.

The following columns are available:
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REGION COLUMN DESCRIPTION

Start Element Index The index of the start element of the linkage.

Element

Name

The name of the start element of the linkage. By double clicking on this

cell, the settings of the selected Optical Setup Element can be edited.

Ref. Type The type of the reference output coordinate system where the linkage

starts. Typically (but not in every case), the transmission type T and the

reflection type R are available. Sources have the reference output CS

type “-” only. Several Ideal Components have specific reference output

coordinate systems. (↪→Part X.)

Medium PE The embedding medium behind the Optical Setup Element. It can be

changed via double clicking in the specific cell (↪→Sec. 37.3.1).

Target Element Index The index of the end element of the linkage.

Element

Name

The name of the end element of the linkage. By double clicking on this

cell the settings of the selected Optical Setup Element can be edited.

Linkage Propagation

Method

The propagation method used for propagating through the free space

between the start and the target element. If Classic Field Tracing is

used and the propagation method is not None, you can open the edit

dialog of the used propagation operator (↪→Sec. 93) by double clicking

on a cell in this column.

On/Off By toggling the entry in the On/Off column, the linkage is turned on/off.

If the linkage state is switched to off, it is not simulated when simulating

the Optical Setup.

Color The color of the arrow in the Optical Setup View. It can be changed by

double clicking on the Color cell.

Important: Every Optical Setup Element has only one referring input coordinate system. So, a specific

element can be set as end element of one single linkage only. Detectors are excluded from that rule,

their position are handled as “virtual”, so detectors can be end elements of more than one linkage (see

Sec. 43.2.2 for details).

In order to create a linkage, the start element has to be selected at first. This can be done by clicking in the

column Index in the region Start Element. VirtualLab Fusion shows a list of all Optical Setup Elements which are

available as start elements. After the user’s selection VirtualLab Fusion inserts all other available information

in the Start Element region automatically. To define the end element, the index of the end element has to be

chosen by clicking in the column Index in the region Target Element. If Start and Target Element are configured,

the link is created and drawn in the Optical Setup View.

Linkages can be deleted by selecting the corresponding row in the Path Table and pressing Del on the key-

board.

43.2.2 Detector Table

The Detectors table in the Optical Setup Editor is used for configuring the linkages from Optical Setup Elements

to detectors. Fig. 344 shows the Detectors table of a sample Optical Setup.
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Figure 344. The linkages between Optical Setup Elements and detectors are configured and listed in the Detectors table

of the Optical Setup Editor.

In VirtualLab Fusion, Detectors are regarded as kind of “virtual”. That means that the assignment of a detector

does not cause any loss of energy in the further Optical Setup simulation. Detectors can also be set as end

elements of more than one linkage. Thus they don’t have a defined absolute position (↪→Sec. 43.8).

Because Detectors can be configured as end elements of multiple linkages, the configuration of detector link-

ages is done in the Detectors table, containing the following columns:

REGION COLUMN DESCRIPTION

Detector Index The index of the detector of the linkage.

Element

Name

The name of the detector to be linked. By double clicking a cell in this

column, the settings of the selected detector can be edited.

Last Optical

Setup Element

Index The index of the start element of the linkage.

Element

Name

The name of the start element of the linkage. By double clicking a cell

in this column, the settings of the selected Optical Setup Element can

be edited.

Ref. Type The name of the reference output coordinate system where the linkage

starts. Typically (but not in every case), the transmission type T and the

reflection type R are available. Sources have the reference output CS

type “-” only. Several Ideal Components have specific reference output

coordinate systems. (↪→Part X.)

Medium The embedding medium which is behind the Optical Setup Element.

The medium cannot be changed in the Detectors table. This has to be

done in the Path table or the element’s edit dialog.

Linkage Sum Shall this linkage be simulated in summation mode? This mode is a

special feature of detectors. By enabling the summation mode, the de-

tector collects the input signals of all linkages where the summation is

activated. Then the detector function is applied to the coherent addition

of all incoming fields.
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Propagation

Method

The propagation method to use for simulating the linkage. If Classic

Field Tracing is used and the propagation method is not None, you can

open the edit dialog of the used propagation operator (↪→Sec. 93) by

double clicking on a cell in this column.

On/Off By toggling the entry in the On/Off column, the linkage is turned on/off.

If the linkage state is switched to off, it is not simulated when running

the Optical Setup.

Color The color of the arrow in the Optical Setup View. It can be changed by

double clicking on the Color cell.

Important: If a detector is added to the Optical Setup via the Optical Setup View, a new row, filled with

default values, is automatically inserted in the Detector Table. The user simply has to select the element

which shall be the start element for the linkage to the detector. If a linkage is established, a new row is

added to the detector section and can be configured for additional linkages to this detector.

Detector linkages can be deleted by selecting the corresponding row in the Detectors Table and press Del key

on the keyboard. If all linkages to a detector are erased, an empty row will be displayed in the table. It can be

used to set new linkages to the detector.

43.2.3 Analyzer Table

The Analyzers table contains a list of all analyzers in the current Optical Setup. Analyzers cannot be connected

with other Optical Setup Elements. They are used for analyzing parts of the system or the whole system. More

information about analyzers can be found in Part XII.

Fig. 345 shows the Analyzers table of a sample Optical Setup.

Figure 345. All analyzers included in the Optical Setup are listed in the Analyzers table.

The Analyzers table provides the following information:
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COLUMN DESCRIPTION

Index The index of the analyzer. Unlike the other tables in the Optical Setup Edi-

tor, the user cannot choose which analyzers shall be shown in the Analyzers

table; it always contains all analyzers in the Optical Setup.

Element Name The name of the analyzer. By double clicking on this cell, the selected ana-

lyzer can be edited.

Comment A short description of the function of the Analyzer. For detailed information

about available analyzers in VirtualLab Fusion please see Part XII.

The Analyzers table is mainly for information about but not for editing of the Optical Setup. The user has only

the possibility to edit the properties of the analyzer by double clicking in the Type column.

43.2.4 Process Logging

There is an additional Logging button in the top row of the Optical Setup Editor. It shows the single steps done

during simulating the optical setup and thus helps you to identify problems within your setup. Fig. 346 shows

an example.

Figure 346. Sample output of the process logging.

The actual logging panel has a context menu where you can

• Copy the currently selected text to the Windows™ Clipboard,

• Select All logging information,

• delete all logging information using the Clear Logging item or

• Set Tab Width in pixels according to your liking .

If you start a new simulation, the logging information is deleted so that the Logging only shows information

about the most recent simulation run.

The detail level of the logging can be set in the Other Settings > System tab of the Profile Editor dialog

(↪→Sec. (a)), in the Property Browser of the Optical Setup or in the side panel (see table below). The default

level for new Optical Setups can be set in the Global Options (↪→Sec. 6.1.4).

There is also a side panel with the following additional settings. Unless otherwise noted, the options are only

available if there is no simulation in progress.
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ITEM DESCRIPTION

Suspend Logging O .

If you check this option, logging is suspended which means that no new mes-

sages are added until you uncheck this option again. This allows you to read

and search the current messages undisturbedly.

Search O .

Searches for the given word or word group. The matching is case insensitive.

Clicking on🡲 marks the (next) occurrence of the entered word group.

Hide Time Stamps Each message in the logging starts with the exact time when this message

was created. While this allows performance analysis, it canmake reading and

comparing different loggingsmore complicated. Thus you can hide these time

stamps with this option.

{Logging Level} Defines how much details you want to see during logging – or whether you

want to completely disable logging.

43.3 Optical Setup Ribbon

The Profile Editing & Run group can be used to perform and configure the simulation of the active optical setup.

For the configuration of the simulation settings VirtualLab Fusion provides a variety of tools which are also

available in the Profile Editing & Run ribbon group.

The ribbon has the following main categories:

• Execution: In this section you can select the modeling profile you like to process. VirtualLab Fusion has

two build-in modeling profiles: Ray Results Profile and the General Profile. VirtualLab Fusion performs

in all modeling profiles physical optics simulation. The Ray Results Profile allow the access to results

the user knows from typical ray tracing software. There are several limitations of the Ray Results Profile,

which are explained in more detail in Sec. 43.4.3. In addition to the selection, which modeling profile shall

be used, the user can start a simulation by clicking on the Go! button. If a simulation is running the Go!

button will become a Stop button, which enables the cancellation of a running simulation.

• Settings: In the Settings section VirtualLab Fusion provides a set of tools to configure the underlying

optical setup. The center of the modeling configuration is the Profile Editor. It enable the configuration

of modeling and geometry parameters in a systematic and structured way. Detailed information on the

Profile Editor can be found in Sec. 43.4.1. Next to the profile editor VirtualLab Fusion also offers the

Parameter Overview, which enable the access of all numerical parameters of the underlying system in

table format (↪→Sec. 43.6.1). The last entry in the category Settings is the tool for parameter coupling.

This tool enables the user of VirtualLab Fusion to define parameter dependencies. A detailed explanation

of Parameter Coupling can be found it Sec. 43.10. By clicking on Use Parameter Coupling the parameter

coupling is activated. The parameter coupling can be edited by clicking on the gear symbol next to the

User Parameter Coupling button.

• Result Visualization: In this section the user needs to select the result visualization type. Depending on

the profile different type are available. If the user select the Ray Results Profile he can select whether to

use System: 3D or Detectors as result output. In case the user selects the General Profile can define to

use Detectors or the Modeling Analyzer as the result visualization output. The result visualization can be

configured alternatively in the Profile Editor. Details on the Result Visualization can be found in Sec. (a).

• Light Path Finder: VirtualLab Fusion provides several options to determine which paths the light will go
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through the configured optical setup. These path are determined by the Light Path Finder. A more detailed

discussion of the options of the Light Path Finder can be found in Sec. 43.3.1.

• Profile Editing Tools: In this section the user can find a variety of tools for a user-friendly configuration of

modeling parameters. The tools are described in more detail in Sec. 43.3.2.

• Parameter Variation: In the sectionParameter Variation the user triggers the generation ofNewParameter

Run documents, New Parametric Optimization documents or select to perform a system optimization us-

ing optiSlang. The starting point for all these parameter variation documents is always the active system.

You can find detailed information for the New Parameter Run in Sec. 44. For the Parametric Optimization

please check Sec. 102. The optimization using optiSlang is described in detail within Sec. 124.1.1.

• View: By clicking on the button View System in the section View the user can trigger VirtualLab Fusion to

generate a 3D view of the underlying optical setup within a dialog. This can be used for visualization and

as a check of the system geometry configuration.

Fig. 347 shows the Profile Editing & Run, which is visible if the active document is an optical setup.

Figure 347. The Profile Editing & Go! which enable the user to perform the simulation, select the modeling profile and it

parameters and enable a set of tools for a user-friendly configuration of system parameters.

43.3.1 Light Path Finder

One major tool to perform optical simulations is the Light Path Finder. It enables the evaluation of the paths that

light will go through the optical setup. In general we differ between two general configurations: Pre-Selected

and Manual Channel Configuration. In practice this means that for Pre-Selected configuration the surface

channels of the components are defined by VirtualLab Fusion directly and the user can not change the detailed

channel configuration. In case Manual channel configuration is selected, the user has the option to define at

each surface in each component, which channels should be active.

The section Light Path Finder in the Profile Editing & Go! enable the selection of the channel configuration and

the corresponding detail settings.

Fig. 348 shows section Light Path Finder in the Profile Editing & Go!.

Figure 348. The ribbon entries to select the channel configuration and to edit the detailed parameters within the section

Light Path Finder.

In the ribbon section the user can directly switch betweenPre-Selected Configuration andManual Configuration.

In addition he can click on the small gear button to open the edit dialog for the detailed specification of the Light

Path Finder.

Fig. 349 show edit dialog to configure the parameter of the Light Path Finder.
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Figure 349. The edit dialog to configure the parameters of the Light Path Finder.

The following settings can be done within the edit dialog of the Light Path Finder:

ITEM DESCRIPTION

Channel Configuration

Option

The user can select the channel configuration. The user can select between

Manual and Pre-Selected channel configuration. In case of Manual channel

configuration the user can specify several advanced options for the Light Path

Finder in the group Settings for Manual Channel Configuration.

Settings for Manual Chan-

nel Configuration

If the user selects Manual channel configuration, several advanced configu-

ration options can be configured. These settings are available in the section

Settings for Manual Channel Configuration. The detailed explanation of these

settings can be found below.

The following advanced configuration options for Manual channel configuration are available:

ITEM DESCRIPTION

Energy Threshold In Manual channel configuration the light path finder evaluated all paths

through the optical setup according to the manually configured channel con-

figuration. The Energy Threshold is used to define which path shall be

aborted. VirtualLab Fusion evaluates the energy which should be traced.

If it is below the specified threshold the path will not followed further.

Maximum Level Additionally to the Energy Threshold there is another criteria to stop a light

path if a certain level is reached. Each interaction with a surface will increase

the current level. If the level is larger the the Maximum Level the light path

will not be followed further.

Channel Resolution Accu-

racy

If light hits a surface, which contains surface regions, VirtualLab Fusion will

check which regions are hit. Therefore the user can define the Channel Res-

olution Accuracy. In case a surface region is not resolved by the light path

finder, you need to increase the Channel Resolution Accuracy.

Show Only Paths That Hit

a Detector in 3D View

To enable the user more insides of the light path finder result, the option Show

Only Paths That Hit a Detector in 3D View can be deactivated.

43.3.2 Profile Editing Tools

Within the ribbon section Profile Editing Tools VirtualLab Fusion provides several tools which enable a user-

friendly configuration of modeling and geometry parameters within the active optical setup.

Fig. 350 show the ribbon section Profile Editing Tools within Profile Editing & Go!.
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Figure 350. The ribbon section to access the Profile Editing Tools within the Profile Editing & Go!.

The following tools for the configuration and analysis of the parameters of the underlying optical setup are

available in this section



CHAPTER 43. OPTICAL SETUP 420

ITEM DESCRIPTION

Source to Component The tool Source to Component has two general functions: (1) Analysis of

the current settings for the propagation settings from source to components

and (2) Fast access to configure/synchronize the settings for the propagation

from source to components. If case the user configured the propagation to be

pointwise the caption of the button will be changed to Source to Component:

Pointwise and the corresponding icon is adapted to visualize the pointwise

setting. In case the optical system is configured to select the Fourier trans-

forms automatically for the propagation from the source to the components

the caption of the ribbon button will be changed to Source to Component:

Automatic and the icon is adapted to mark the automatic settings. There

might be also settings which are not pointwise and not automatic but some

intermediate setting. In Addition it is possible that the settings for different

components is different. In these cases the icon will be also adapted and the

caption will be Source to Component: State = N/A.

The ribbon button can be also be used to have a fast configuration to Point-

wise or Automatic by clicking on the corresponding drop down button on the

ribbon button. Fig. 351 shows the different possible states of the ribbon but-

ton.

Between Components This tool has the same functionality as Source to Component, but does not

analyze or configure the propagation from the source to the components, but

the propagation between components or inside components. The different

button states are the same: (1) Pointwise, (2) Automatic or State = N/A.

To Detectors This tool has the same functionality as Source to Component, but does not

analyze or configure the propagation from the source to the components, but

the propagation from the source to detector of from components to detectors.

The different button states are the same: (1) Pointwise, (2) Automatic or State

= N/A.

Paraxial Assumptions The tool Paraxial Assumptions can be used to set and analyze the current set-

tings of the system with respect to paraxial assumptions during propagation

and also paraxial assumptions for detector evaluations. A detailed explana-

tion can be found in Sec. 43.3.2.1.

Speed vs. Accuracy The editing tool Speed vs. Accuracy enables the user to analyze and config-

ure propagation parameters which will influence the accuracy and the sim-

ulation speed of your configuration. Detailed information can be found in

Sec. 43.3.2.2.

Pointwise vs. Integral In VirtualLab Fusion we differ typically between pointwise or integral modeling

steps. These settings can be configured in a user-friendly way on system level

by the tool Pointwise vs. Integral. The functionality and edit options of this

tool are explained in more detail in Sec. 43.3.2.3.

Fast Positioning In the category Fast Positioning VirtualLab Fusion provides two tools: (1)Op-

timize Detector Positions and (2) the Find Focus Position tool. The tools can

be used to perform an automatized adaption of detector positions by applying

several rule. The tool Optimize Detector Positions is described in Sec. 43.6.7

in more detail. In Sec. 43.6.6 you can find further information on the tool Find

Focus Position.
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Figure 351. The different states of the ribbon buttons to analyze the settings for propagation from source to components.

The propagation between components and to detector follow the same logic.

It shall be mentioned at this point, that the settings for free space propagation (and also geometry) can be

configured per component/detector. The Profile Editing Tools enables an alternative way for a fast configuration

and analysis of these parameters.

43.3.2.1 Profile Editing Tool: Paraxial Assumptions

With the profile editing tool Paraxial Assumptions the user gets a fast access to the parameters for paraxial

assumptions for field component evaluation within all Universal Detectors within your optical setup. In addition

to the option for synchronizing the settings for allUniversal Detectors, the edit dialog of theParaxialAssumptions

tool provides an analysis of the actual settings of these parameters for all Universal Detectors within the optical

setup.

Figure 352. The edit dialog of the profile editing tool Paraxial Assumptions.

Fig. 352 shows the edit dialog to configure and analyze the settings for Paraxial Assumptions. On the right

side of the dialog the user can make the definition of the parameters he likes to be configured by the Paraxial

Assumption profile editing tool. The group box on the left side is used to get an overview of the current parameter

configuration within the underlying system (which can be configured inside this tool). The user can see here

whether the setting is currently set to all (identified by the green bubble in the All column), none (identified by

the red bubble in the None column) or some elements (the yellow bubble in the Some column). Some means

that for different detectors different settings are currently configured.

The following parameters can be done by the Paraxial Assumptions tool:

ITEM DESCRIPTION

Apply Paraxial Approxi-

mation (Transversal Field

Components Only)

The Universal Detector allows to use paraxial approximations for the calcu-

lation of field components at its input. This will easy up the calculation of the

field components (Ez, Hx, Hy and Hz) because no additional Fourier trans-

forms will be use for their calculation, but simplified formulas. This will speed

up your simulation.

After the configuration of the desired parameters the Paraxial Assumptions tool can be applied by clicking on

the Apply button at the bottom of the dialog or by clicking on the OK button. By clicking on Apply the tool

is applied, the dialog will be kept open and the actual settings will be analyzed again and the corresponding

status is displayed on the right side of the dialog. By clicking on OK the dialog will be closed and the tool will

be applied.
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43.3.2.2 Profile Editing Tool: Speed vs. Accuracy

The configuration of several parameters which affect the accuracy and speed behavior of the free space propa-

gation the user can make several settings per component/detector. As an alternative he can also use the profile

editing tool Speed vs. Accuracy to define some selected parameter and trigger their setting for all components

and detectors at once.

The Speed vs. Accuracy tool has again two main sections: (1) on the right side the user can specify the

parameters for the tool before it is applied and (2) on the left side we provide the analysis of the actual settings

analyzed from the underlying system.

Figure 353. The edit dialog of the profile editing tool Speed vs. Accuracy.

The edit dialog of the tool is shown in Fig. 353 and provides the following parameters to configure:



CHAPTER 43. OPTICAL SETUP 423

ITEM DESCRIPTION

Accuracy Level Nyquist

Period Evaluation

For the conversion of gridless to gridded data format VirtualLab Fusion will

apply an automatic sampling algorithm which internally determines the band-

width of field. For the sampling estimation algorithm the user can configure

the Accuracy Level Nyquist Period Evaluation. Detailed information can be

found in Sec. 43.4.2.2. The analysis tool on the right side will show you the

current setting of the accuracy level for all components. If there is a non-

unique specification of the accuracy level we will show the information about

the range of the accuracy levels configured within your system.

Gridless Sampling Factor The number of gridless samples to used within the simulation can be con-

trolled by the Gridless Sampling Factor. The higher the factor the more

points will be used. Detailed information on gridless sampling can be found

in Sec. 43.4.2.3. The analysis tool in the right side shows again the range

of Gridless Sampling Factor values for all components and detectors within

your system. In case a unique setting is used for all elements the value for it

will be displayed.

Enforce Pointwise Fourier

Transform Beyond XXXX²

Sampling Values

To ensure that the numerical effort is not to high to perform an integral Fourier

transform, the user can activate the option Enforce Pointwise Fourier Trans-

form Beyond XXXX² Sampling Values. If the numerical effort during the

simulation for an integral Fourier transform is higher than the limit and the

user activated this option VirtualLab Fusion will automatically use a pointwise

Fourier transform instead of the integral one. For further details you can check

Sec. 43.4.2.1.

Limit Gridded Sampling to

Maximum of XXXX² Sam-

pling Values

For automatic sampling estimation VirtualLab Fusion can be configured to

use not more than xxxx² sampling points. This option can be used for the

activation and configuration of this option. Additional details can be found in

Sec. 43.4.2.2.

After the configuration of the desired parameters the Speed vs. Accuracy tool can be applied by clicking on the

Apply button at the bottom of the dialog or by clicking on the OK button. By clicking on Apply the tool is applied,

the dialog will be kept open and the actual settings will be analyzed again and the corresponding status is

displayed on the right side of the dialog. By clicking on OK the dialog will be closed and the tool will be applied.

43.3.2.3 Profile Editing Tool: Pointwise vs. Integral

The profile editing tool Pointwise vs. Integral can be used to configure the the Fourier transform selection for

all components/detectors within your optical setup simultaneous. These settings can be also done individually

per component or detector, but in case the user likes to define a synchronized configuration the Pointwise vs.

Integral can be used in a user-friendly way.

Fig. 354 shows the edit dialog of the Pointwise vs. Integral tool.
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Figure 354. The edit dialog of the profile editing tool Pointwise vs. Integral.

On the top of the dialog the user can select the selection mode for the Fourier transforms. The following

selection modes are available

ITEM DESCRIPTION

Individual In Individual mode the settings can be defined directly in the matrix on the

central part of the dialog. The user can select between Pointwise, Integral

and Automatic Selection for all combinations between source, components

and detectors.

All Pointwise If All Pointwise is selected as selection mode, the controls for the configu-

ration of the detailed Fourier transform are deactivated and set to be in all

combinations to Pointwise.

All Automatic If All Automatic is selected as selection mode, the controls for the configu-

ration of the detailed Fourier transform are deactivated and set to be in all

combinations to Automatic Selection.

All Integral If All Integral is selected as selection mode, the controls for the configuration

of the detailed Fourier transform are deactivated and set to be in all combi-

nations to Integral.

In case the user selected Individual selection mode the control in the center of the dialog are editable. The

configuration of the Fourier transforms can be done for

• From Source To Component

• From Source To Detector

• From Component To Component

• From Component To Detector

• Inside Component

For each of these scenarios the user can select between
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ITEM DESCRIPTION

Pointwise If the user select Pointwise only the pointwise Fourier transform (PFT) will be

used for forward and inverse Fourier transform. There will be no selection

between different Fourier transforms.

Integral In case the user defines Integral, VirtualLab Fusion will configure for the sce-

nario (source/component/detector) to use for Fourier selection only to use

fast Fourier transform (FFT) or semi-analytical Fourier transform (SFT). The

pointwise Fourier transform will be not be used as an option for the free space

propagation.

Automatic Selection By selecting Automatic Selection the free space propagation will be config-

ured to select freely between PFT, FFT or SFT. The selection is based on an

automatic algorithm based on mathematical decision criteria.

After the configuration of the desired parameters the Pointwise vs. Integral tool can be applied by clicking on

the Apply button at the bottom of the dialog or by clicking on the OK button. By clicking on Apply the tool is

applied and the dialog will be kept open. By clicking on OK the dialog will be closed and the tool will be applied.

43.4 Propagating Through an Optical Setup

VirtualLab Fusion enables the simulation of optical systems by physical optics. By default an optical system

comes with two modeling profiles: Ray Results Profile and General. The Ray Results Profile has several

limitations and can be used to generate typical results the user are used to if they use traditional ray tracing

software. The limitation of the Ray Result Profile are described in Sec. 43.4.3. Within the General Profile there

are no limitations regarding the specification of the freespace propagation parameters (especially the selection

of Fourier transform to be used). For the profile the user needs to select the result visualization to be used.

For the Ray Results Profile can select whether he like to evaluate the information as System: 3D output or as

Detectors output. For the System: 3D result the user can specify the sampling for gridless points as well as view

options for the 3D result visualization. Detailed information about its configuration can be found in Sec. 43.4.5.

In case of Detectors output within the Ray Results Profile the user need also to specify the sampling for gridless

data and some selected view properties for the detector outputs.

For the General Profile the user can select between Detectors output and Modeling Analyzer. In case of De-

tectors the visualization/evaluation options are configured directly in the detectors within the underlying optical

setup. The Modeling Analyzer offers the user the access to intermediate field information within the system

simulation. Detailed information about the Modeling Analyzer can be found in Sec. 43.4.6.

In general the parameters for propagation through the optical setup can be made via the edit dialogs of the

different elements (components, detector, ect.) within your optical system. Alternatively, we provide also an

options to edit the parameter in a more organized form via the Profile Editor. The graphical user interface of

the profile editor is described on Sec. 43.4.1

In addition to the innovative concept of modeling profiles we provide also the simulation of optical systems

by Classic Field Tracing which is the first version of our implementation to do physical optics. The Classic

Field Tracing is already working good for paraxial optical setups. In addition every Analyzer can be used as

Simulation Engine because Analyzers process Optical Setups in their own special way.
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Figure 355. Starting a simulation from the Optical Setup Editor. By selecting the Simulation Engine the user specifies

how the source field should be traced through the complete Optical Setup, or whether only a certain analyzer shall be

evaluated.

In the bottom-right corner of the Optical Setup Editor (↪→Fig. 355) you can choose which Simulation Engine is

to be used and start a new simulation.

ITEM DESCRIPTION

Simulation Engine The Simulation Engine (or Analyzer) to be used. The selected Simulation En-

gine also influences the available settings in the edit dialogs of Components

(↪→Sec. 54), Ideal Components (↪→Sec. 66), and Detectors (↪→Sec. 74.1).

Go! Starts the simulation of the Optical Setup. Shortcut F5 .
During a simulation the Go! button turns into a Stop button to stop the

simulation. Shortcut Shift+F5 .

For the modeling profiles there are several tools available which analyze the underlying configuration (on the

fly or on demand) and that can be used to realize a fast reconfiguration of the modeling settings. Detailed

information can be found in Sec. 43.3.

43.4.1 Profile Editor

The Profile Editor can be used to configure the optical setup in an alternative way. In former versions it was only

possible to edit most of the configuration parameter (structural parameters as well as modeling parameters)

via the edit dialogs of the sources/components/detectors within the optical setup. With the Profile Editor the

configuration of all important parameter is provided in a more structured way.

The dialog of the Profile Editor is separated in four main sections:

• Source: The Sources section of the dialog contain all parameters regarding the active light source. For a

detailed explanation please check Sec. 43.4.1.2.

• Components & Solvers: In the section Components & Solvers you may find all parameters for (real and

ideal) component that are connected to the active light source within the underlying system. Detailed

information can be found in Sec. 43.4.1.3.

• Visualization & Detectors: Under Visualization & Detectors you can find the parameters for detectors and

also for the visualization type that shall be used for evaluation. A detailed description of the parameters

to configured can be found in Sec. 43.4.1.4.

• Other Settings: Finally a collection of all other important parameters can be found under Other Settings.

These settings are explained in detail in Sec. 43.4.1.5.
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Fig. 356 shows the edit dialog of the Profile Editor.

Figure 356. Dialog of the Profile Editor.

For the configuration of parameters we use some standard techniques. These common techniques are ex-

plained in the next sections. Afterward the detailed configuration options for the different section of the Profile

Editor are explained in detail.

43.4.1.1 Profile Editor: Common User Controls

For the specification of parameters and their configuration options we support different standard techniques,

which shall be explained next. The following user interface concepts will be discussed in detail

• Parameter Overview Tables: Is a table which provides an overview of all numerical parameters of the

connected elements within the underlying optical system.

• Table Layout/Tree View: VirtualLab Fusion provides a innovative concept to show for selected parameters

(e. g. Fourier Transforms for Free Space Propagation. The configuration is done also via different types

of controls. Detailed information can be found in Sec. (b).

• Master-Client-Individual (MCI) Configuration: The configuration of parameters could be quite complex.

So VirtualLab Fusion supports the selection of a master configuration, which can be use to serve other

configuration that are configured as Client. A detailed discussion on the MCI concept can be found in

Sec. (c).

(a) Parameter Overview Tables

One universal user interface concept that is used within the Profile Editor are the Parameter Overview Tables.

Fig. 357 shows such a table for the configuration of parameters for Components and Solvers.
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Figure 357. A typical Parameter Overview Table used for the showing all parameters of the components in the underlying

optical system.

This tables display all numerical parameters of the sources/components/detectors and allow its modification

directly in the table. The table has the following columns:

ITEM DESCRIPTION

Object In this column you will find the name of the source/component/detector for

which the parameters are given. There are typically more than one parameter

per element, so the cells are merged together for a better graphical overview.

By double clicking in the cell within the Object column the edit dialog of the

element will be opened and the parameters can also entered in the edit dialog

instead of the Parameter Overview Table.

Category Due to the complexity of parameters within a single optical setup, the pa-

rameters are categorized. This categorization is done on one hierarchy level

only.

Parameter In the column Parameter the name of the parameter is listed. By that you can

identify the parameter you like to modify or investigate.

Value Finally the user can set the value of the numerical parameter within the Value

column. VirtualLab Fusion will automatically check whether the entered value

is valid. If the value is not valid the cell will be marked by red text color.

Due to the fact that such overview lists can be quite long, VirtualLab Fusion offers a user friendly way to apply

a filter on the table. By entering a string value into the Filter by ... text box a full text search in the table will be

applied on the table (full text search on all but not the entries in the Value column).

(b) Table Layout/Tree View

The Parameter Overview Tables enable the systematic display and modification of all numerical parameters

within the optical systems. For important parameter sets VirtualLab Fusion provides an alternative approach to
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configure them using the Table Layout/Tree View. Fig. 358 shows a sample for Table Layout/Tree View. Here

the Table Layout configuration is selected, which is the standard when you open the Profile Editor the first time.

Figure 358. A sample Table Layout. In this example the parameters for Sampling Gridded Data within the Free Space

Propagation parameters for Component are displayed

The Table Layout/Tree View contains a list of controls for specific settings. Each source(mode)/component/de-

tector comes with a set of parameters that can be configured within the corresponding control. The list of

controls can be visualized in a Table Layout or as a Tree View.

Within the Table Layout VirtualLab Fusion generates a table with the following columns

ITEM DESCRIPTION

Source/Component/De-

tector

In the first column you can find the name of the element (source/component

or detector) which provides the data set. By double clicking on the cell within

the first column the edit dialog of the element is opened and the user can

alternatively configure the parameters directly in the edit dialog. After closing

the edit dialog with Ok the parameters in the Profile Editor will be updated.

Settings In the column Settings VirtualLab Fusion will place the control that is used for

configuration the corresponding parameter set. This control is quite different

for different parameter sets and explained in the later paragraphs when we

discuss their concrete usage within the Profile Editor.

Alternatively to the Table Layout the user can switch to the Tree View mode. Fig. 359 shows a sample Tree

View in which also the buttons are marked to switch between the view modes.

Figure 359. A sample Tree View visualization. In this example the parameters for Sampling Gridded Data within the Free

Space Propagation parameters for Component are displayed
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In comparison to the Table Layout the controls are not arranged in a table, but the user can navigate through

the settings of different elements by selecting the element of interest in the tree view on the left side of the

component. If you double clicks on the entry within the tree on the left side, the edit dialog of the selected

element will be opened and the configuration of all parameters of the element can be done this dialog.

To get a better overview for a specific parameter VirtualLab Fusion supports also the filtering of parameters.

Therefore the user has to enter the filter string in the text box above the Table Layout/Tree View. After entering

the the filter string VirtualLab Fusion will check, which parameter matches with the filter. The graphical user

interface is adapted completely automatically. By that you can get a good overview of parameters in the system

which you like to check in detail.

Fig. 360 shows a the resulting user interface after applying the filter mechanism on a sample Table Layout view.

Figure 360. A sample Table Layout visualization after filtering. In this example the parameters for Fourier Transform se-

lection within the Free Space Propagation parameters for Component are displayed

(c) Master-Client-Individual (MCI) Configuration

VirtualLab Fusion supports the use of a so-called Master-Client-Individual (MCI) configuration. This enables

the user to select one parameter set (e.g. Sampling Gridless Data for Free Space Propagation parameters of

Components) to serve as Master. If a parameter set in the same group is defined as Client it will automatically

take over the parameter configuration of the Master. In each parameter set the user can select only one

Master. Alternatively to the master and client selection the user can also specify that the parameter set should

be configured Individually. In this case changing the Master will have no effect on the parameter set. In case

that no Master is selected all settings will be handled as Individual.

Fig. 361 shows a Table Layout view in which the MCI configuration is marked by a red rectangle.
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Figure 361. Table Layout view in which the selection of Master-Client-Individual (MCI) is marked.

43.4.1.2 Profile Editor: Sources

In the Sources section of the Profile Editor the user can find all important setting of the active source. On this

tab page three sub pages are available:

• Parameter Overview: Here the user can access the all numerical parameters of the active source in a

Parameter Overview Table. The user can filter the parameters he like to see. A detailed explanation of

the Parameter Overview Table can be found in Sec. (a).

• Position & Size: On this page of the Profile Editor we offer you a Table Layout/Tree View control, which

contains parameters for position and size of the active sources. The parameters which can be entered

here are explained below. In case a Multiple Source is active in the underlying system you will get an

entry per source within the Multiple Source.

• Power Management: Here the user can define the parameters which are used for the power management

of the source. The user can activate the Power Management and specify the power of the source that shall

be used for the configuration. If the Power Management is not activated VirtualLab Fusion will normalize

the amplitudes of the scattered fields of the active light source. In addition, the user has to specify the

type of the spectrum which is used.

Fig. 362 shows the Position & Size page for Sources within the Profile Editor.
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Figure 362. The Position & Size page for Sources. In this example the active light source is a Spherical Wave, so the

Table Layout/Tree View only contains one parameter set.

The control to configure the Position & Size parameters of a light source have the following parameters that

can be configured by the user

ITEM DESCRIPTION

Distance to Input Plane This value describes the distance between input plane and source plane

along the z-axis: distance = zInput Plane − zSource Plane.
For some of the sources this value is fixed to zero.

In the case of spherical and quadratic waves this value must not be zero and

the spherical phase radius is set to this value.

Lateral Offset This value describes the offset between the origins of the coordinates for the

source and the input plane.

Apply Lateral Offset to

Source Field

By default, the resulting input field is centered at the position (0m; 0m) in the

input plane. By checking this box, the field is shifted by the Lateral Offset

of the source plane (↪→Sec. 48.2.1.1). Note, the resulting numerical array

(sampled field) will still be centered at (0m; 0m), so additional zero-values

will be generated. An example is given in Fig. 458 and Fig. 459.

Shape You can choose whether the single modes have a Rectangular or an Elliptical

shape.

Field Size The size or diameter of the aperture. If the light source determines the aper-

ture size automatically, this control is disabled.

Relative Edge Width The width of the smoothing edges defined relatively to the lateral extension

of the mode. If the extension in x- and y-direction differ, the minimum of both

values is taken.

Absolute Edge Width The width of the smoothing edges in meters (↪→Fig. 454). If the light source

determines the aperture size automatically, this control is disabled.



CHAPTER 43. OPTICAL SETUP 433

The Position & Size parameters of light sources is discussed in Sec. 48.2.1.2 in more detail.

Fig. 363 show the parameter that can be configured on the tab page Power Management.

Figure 363. The Power Management page for Sources.

In the section Power Management the user can define the following parameters to configure the power of the

active source:

ITEM DESCRIPTION

Type of Spectrum For the power management is done by calculation of the initial power of the

source, calculating a corresponding scaling factor and then adding this scal-

ing factor automatically into the light source. For this calculation the user

need to specify whether the spectrum in use is Discrete or Continuous. This

information is then used to calculate the integrated power over all wavelength

emitted by the source.

Activate Power Manage-

ment

The user can activate or deactivate the power management. In case the

Power Management is not activated, VirtualLab Fusion will generate the

source fields with normalized amplitude (which is the same flow as done in

previous versions). If the Power Management option is checked, VirtualLab

Fusion will analyze the source field before simulation, calculate a scaling fac-

tor by measuring the power of the normalized output field of the source and

apply the evaluated scaling factor within the following simulation to the source

field. Within the process logging the information about the Power Manage-

ment evaluation can be checked by the user.

Source Modeling Power If the option Activate Power Management is selected, the user has to specify

the Source Modeling Power he like to be emited by the active source. This

value is used for calculation of the scaling factor mentioned before.

43.4.1.3 Profile Editor: Components & Solvers

In the section Components & Solvers all important parameters for ideal component and real components can

be accessed. This section has the following tab pages in which different parameters are accessible.

• Parameter Overview: On this tab page the user can access all numerical parameters of the connected

components within the underlying optical system. More information can be found in Sec. (a).

• Solver & Functions: Each real component has an associated solver and for each ideal component comes

with an associated function. On the tab page Solver & Functions you can access the parameters for these

solvers/functions. The numerical parameters of the solver/functions are communicated by a Parameter

Overview Table (details can found in Sec. (a)).

• Free Space Propagation: Next to the parameters for the solvers/functions it is important to define the

parameter to propagate to components through free space. These parameters are available in the page
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Free Space Propagation. Sec. (b) contains a detail explanation of control to configure the free space

propagation parameters.

• Channel Configuration: Within the section Channel Configuration the user gets an overview of the current

surface channel settings for all components within the system. Detailed information of the controls to

specify the Channel Configuration can be found in Sec. (c).

Fig. 364 shows the Component & Solver which is accessible in the Profile Editor.

Figure 364. The Component & Solver section of the Profile Editor.

(a) Parameter Overview

For the display of all numerical parameters of the components within the underlying system a Parameter

Overview Table is used. Detailed information on the common user interface of Parameter Overview Table

can be found in Sec. (a).

Fig. 365 shows Parameter Overview tab for components within the Profile Editor.
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Figure 365. The Parameter Overview of the Component & Solver section within the Profile Editor.

In general the table list all numerical parameters for the components of the underlying optical setup. But by

activating the check box Hide Modeling Parameters all modeling parameters are not included in the listing.

The modeling parameters are parameters of the solver/function and parameters of the free space propagation.

These parameters can be accessed in the section Solver & Functions and Free Space Propagation in the

Components & Solvers section.

(b) Free Space Propagation

Within this section of the Profile Editor the user can configure all parameters that are important to be used within

the free space propagation from source to component, from component to component or inside components

(in case that a component contains several surfaces).

Fig. 366 shows the control to configure the Free Space Propagation parameters for components.
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Figure 366. The section to configure the Free Space Propagation parameters for components within the Profile Editor.

For the communication of the Free Space Propagation parameters the parameters are displayed within several

Table Layout/Tree View are used. Detailed information on this common user interface can be found in Sec. (b).

The section within the dialog contains a tab page for

• Fourier Transform: The controls for specification are described in Sec. 43.4.2.1.

• Sampling Gridded Data: Details on the user controls for the configuration of gridded data can be found

in Sec. 43.4.2.2.

• Sampling Gridless Data: In Sec. 43.4.2.3 the controls for the configuration of gridless data are explain in

detail.

(c) Channel Configuration

In the section Channel Configuration the user can get an overview of the current surface channel settings. This

configuration is done via a compact table, which has the following entries:

ITEM DESCRIPTION

Name The name of the component (including the index of the component).

Surface The name of the surface within the component. If more than one surface is

present in one component, an additional line will be available to configure all

channels for the component at once to be active or inactive.

+/+ Defines whether the plus-plus channel is active/open.

+/- Defines whether the plus-minus channel is active/open.

-/- Defines whether the minus-minus channel is active/open.

-/+ Defines whether the minus-plus channel is active/open.
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Fig. 367 shows the control to configure the Channel Configuration for all components of the underlying optical

setup.

Figure 367. The section to configure the Channel Configuration for components within the Profile Editor.

The Channel Configuration is read-only if the Channel Configuration Option is set to Pre-Selected. In case of

Manual Channel Configuration the user can select freely which channels should be open or closed for automatic

analysis the light propagation through the optical setup.

43.4.1.4 Profile Editor: Visualization & Detectors

Within the section Visualization & Detectors the user can find all settings which are accessible for detectors

and general result visualization. This section has the following tab pages in which different parameters are

accessible.

• Result Visualization: On this tab page the user can select the result visualization type. Depending on

the selected result visualization different tab pages will be available within the section Visualization &

Detectors. A detailed information on the Result Visualization section can be found in Sec. (a).

• 3D View: This tab page is only available if the user selects System: 3D asResult Visualization. On this tab

page the user can configure the number of points that shall be used for processing and also pre-configure

the 3D system view. More information see in Sec. (b).

• Detector Setting: If the user selects Detectors as Result Visualization type he can use the controls within

this section to specify the parameters of the detectors within the optical setup. The configuration can be

done per detector. In Sec. (c) you can find a detailed description of the controls to define the parameters

for the detectors.

• Modeling Analysis: VirtualLab Fusion provides access of the intermediate fields during propagation

through the system. This can be done by selectingModeling Analyzer as Result Visualization. On the tab

pageModeling Analysis you configure the generation of the intermediate output. This tab is only available

if Modeling Analyzer is selected. More information can be found in Sec. (d).

• Parameter Overview: This tab page provides an overview of all numerical parameters for detectors.

Please check Sec. (e) for more information.

• Propagation to Detector: In this section the user can define the parameters that are used to propagate

the light to the detector. A detailed explanation of all user control that are available under Propagation to

Detector can be found in Sec. (f).

Fig. 368 shows the control to configure the Visualization & Detectors settings of the underlying optical setup.
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Figure 368. The section to configure the Visualization & Detectors settings within the Profile Editor.

On the next pages we will explain the settings for Visualization & Detectors more in detail.

(a) Result Visualization

On the tab page Result Visualization the user can select the result visualization type that shall be used for

system analysis. Fig. 369 show the content of the tab page Result Visualization.

Figure 369. The user interface to select the Result Visualization type.

Depending on the selected profile the available Result Visualization type will be enabled. For the Ray Results

profile VirtualLab Fusion supports the evaluation System: 3D or the Detector Output. The General Profile

allows the evaluation of Detector Output or the Modeling Analyzer.

The following parameters can be configured within the user interface of the Result Visualization:
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ITEM DESCRIPTION

System: 3D This visualization is currently only available for the Ray Results profile. By

selecting this output type, performing the simulation will generate a result

document which contain the 3D system information including ray information.

By activating this option the tab page 3D View will be available for further

configurations.

Detector Output Each detector will generate an output. The output can be in gridless and/or

gridded format. Within the Ray Results profile the output is restricted to be

gridless. The settings for the detectors can be adapted on the tab page De-

tector Settings.

Modeling Analyzer For the General profile the visualization typeModeling Analyzer can be used.

This allow the access to intermediate information during propagation through

the optical setup. Further configuration can be done on the tab pageModeling

Analysis.

(b) 3D View

If the user selected the System: 3D as Result Visualization type the tab page 3D View becomes visible. On

this tab page the user can configure all settings that are related to the System: 3D view output.

Fig. 370 shows all control which can be used to configure the parameter for System: 3D view output generation.

Figure 370. The user controls to configure the visualization type System: 3D.

The parameters to configure for 3D View parameters can be found in Sec. 43.4.5. The Result Visualization

type System: 3D are currently only available for the Ray Results profile.

(c) Detector Settings

If the user selects Detectors as Result Visualization type, the tab page Detector Settings will be available. The

user configure the detector output per detector. VirtualLab Fusion will use a set of Table Layout/Tree View
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controls are used to provide a systematic overview of all available parameters of the Universal Detectors within

the underlying system. Detailed information on this common user interface can be found in Sec. (b).

Fig. 371 shows the controls to configure the Detector Settings of the detectors within the underlying system.

Figure 371. The user can configure the parameters of the Universal Detectors within the underlying system in the section

Detector Settings.

The section within the Profile Editor contains a tab page for

• Field Quantities: The controls for the configuration of field values are described in Sec. 74.4.1. Within the

Ray Results profile this tab page will be now shown.

• Detector Window (x-Domain): The definition of the window size and the sampling of equidistant data can

be defined here. Detailed information can be found in Sec. 74.4.2.

• Detector Window (k-Domain): For the evaluation of field in k-domain the user can configure the size of

the detector window and the resolution for equidistant data on the tab page Detector Window (k-Domain).

Detailed information can be found in Sec. 74.4.3.

• Gridless Data: Additional to gridded output the detector supports also the evaluation of gridless output.

The parameters for the configuration of gridless data can be found in Sec. 74.4.3.

• Add-Ons: Adding, removing and the configuration of detector add-ons can be done in the section Add-

Ons. You can find a detailed description of the user interface to configure the detector Add-Ons in

Sec. 74.4.5.

(d) Modeling Analysis

When selecting theGeneral profile theResult Visualization type is available. This result visualization type allows

the evaluation of intermediate results during propagation which enable you to get a detailed understanding what

happens, when the light is propagated through the optical setup.
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Fig. 372 shows the user interface to configure theModeling Analyzer to analyze the process during propagation

through the optical setup.

Figure 372. The user controls to configure the parameters of the Modeling Analyzer within the section Detector Settings.

The control to specify the settings of the Modeling Analyzer are explained in Sec. 43.4.6.

(e) Parameter Overview

For the display of all numerical parameters of the detectors within the underlying system a Parameter Overview

Table is used. Detailed information on the common user interface of Parameter Overview Table can be found

in Sec. (a).

Fig. 373 shows the Parameter Overview tab for detectors within the Profile Editor.

Figure 373. The Parameter Overview of the Visualization & Detectors section within the Profile Editor.

In general the table list all numerical parameters for the detectors of the underlying optical setup. But by

activating the check box Hide Modeling Parameters all modeling parameters are not included in the listing. The

modeling parameters are parameters of the free space propagation to the detectors. These parameters can

be accessed in the section Propagation to Detector in the Visualization & Detectors main section.

(f) Propagation to Detector

Within this section of the Profile Editor the user can configure all parameters that are important to be used within

the free space propagation to detectors.
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Fig. 374 shows the control to configure the Propagation to Detector parameters.

Figure 374. The section to configure the Propagation to Detector within the Profile Editor.

For the communication of the Free Space Propagation parameters the parameters are displayed within several

Table Layout/Tree View. Detailed information on this common user interface can be found in Sec. (b). The

section within the dialog contains a tab page for

• Fourier Transform: The controls for specification are described in Sec. 43.4.2.1.

• Sampling Gridded Data: Details on the user controls for the configuration of gridded data can be found

in Sec. 43.4.2.2.

• Sampling Gridless Data: In Sec. 43.4.2.3 the controls for the configuration of gridless data are explain in

detail.

43.4.1.5 Profile Editor: Other Settings

In the sectionOther Settings a collection of parameters can be accessed which is valid for the complete system

and not only for selected sources/components or detectors. This section is separated in the following sub

sections:

• System: Here the user can enter some basic parameters like pressure and temperature which are pro-

vided as system parameters and used for system modeling. Detailed information on the System param-

eters can be found in Sec. (a).

• Free Space Parameters: On this tab page several global parameters are listed which are used for the

propagation through homogeneous medium. These parameters are defined on system level and ex-

plained in detail in Sec. (b).

• Light Path Finder: For the evaluation of the tracing sequence through the setup, VirtualLab Fusion pro-

vides several options for determining the light paths (which paths the light goes within the system). These
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parameters can be configured here. Detailed information on the Channel Configuration can be found in

Sec. (c).

In the following paragraphs the controls to define the Other Settings are explained in detail.

(a) System

Fig. 375 show the content of the tab page System in the section Other Settings.

Figure 375. The system parameters which can be configured within the section Other Parameters.

The user can specify the following parameters via the controls of the tab page

ITEM DESCRIPTION

Process Logging Level During the processing of an optical setup, VirtualLab Fusion provides several

logging information about the current step of the simulation. By selecting the

Process Logging Level the user can define to which detail level he like to see

this process information. The following levels are available: None, Normal

and Detailed.

Environment VirtualLab Fusion supports to define the Environment parameters for the sys-

tem modeling. Here the user has to define the Air Pressure and the System

Temperature. These parameters are used to evaluate the refractive index of

the media within the system when propagating through it.

(b) Free Space Parameters

In general the Free Space Parameters are configured per component/detector. There are several settings that

you can configure which are defined only once within the system. Fig. 376 show the content of the tab page

Free Space Parameters in the section Other Settings.

Figure 376. The Free Space Parameters which can be configured for the complete system within the section Other Pa-

rameters.

The following settings are available for the Free Space Parameters on system level
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ITEM DESCRIPTION

Wavefront Phase Han-

dling

The handling of wavefront phases is a major challenge within optical simula-

tion. Typically VirtualLab Fusion tries to handle the wavefront phase as smart

as possible when propagating through an optical setup. By selecting to Ex-

tract Wavefront Phase Information from 2PI Modulo Data it is configured that

VirtualLab Fusion tries to extract a smooth wavefront phase information af-

ter an integral Fourier transform. In this case the phase has to be typically

sampled in 2PI modulo and after the integral Fourier transform is performed

VirtualLab Fusion will apply smart unwrapping algorithms and interpolation

techniques to extract a smooth wavefront from the 2PI modulo data. The de-

fault of this option is Yes. Another parameter also available in this section

effect the result of a pointwise Fourier transformation. If the user defines to

Use Spherical Part of Wavefront Phase for Pointwise FT Only VirtualLab Fu-

sion will fit the spherical part before doing the PFT and use only this spherical

part for the Fourier transform. This option is by default false.

Automatic FFT/Semi-

Analytical Fourier Trans-

form Selection

For the decision whether FFT or SFT is used a numerical criteria is applied.

VirtualLab Fusion compares the numerical effort of the FFT and the SFT. In

case of FFT a given quadratic phase of the field needs to be sampled, be-

cause it can only be handled analytically in the SFT. By defining the Threshold

for Semi-Analytic Fourier Transform the user defines when to use FFT or SFT.

The higher this threshold is, the later VirtualLab Fusion will use SFT.

(c) Light Path Finder

Within the section Light Path Finder the user can define all parameters necessary for the evaluation of light

paths to be processed during the simulation. The parameters and the user interface to configure the parameters

for the Light Path Finder are explained within Sec. 43.3.1.

43.4.2 Free Space Propagation Parameters (Modeling Profiles)

The most important step for doing fast physical optics is the free space propagation, which is used to simulate

the light propagation from the output of one component (or source) to the input of another component (or

detector). Therefor, VirtualLab Fusion offers a variety of parameters that can be adapted by the user for the

free space propagation. These parameter can be specified per component and detector. The user can enter

the configuration settings by opening the edit dialog of the component or detector and go to the tab page Free

Space Propagation. Alternatively, it is possible to configure these parameter using the Profile Editor. The Profile

Editor enables the user to have an overview of setting of multiple components/detectors. Detailed information

on the Profile Editor can be found in Sec. 43.4.1.

The configuration of the free space propagation parameters is divided into three sections
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ITEM DESCRIPTION

Fourier Transforms Within this section the user can define several settings to select Fourier

transforms within the free space propagation. Detailed information see

Sec. 43.4.2.1.

Sampling Gridded Data Next to the selection of Fourier transforms the specification for handling of

gridded data is important. Therefore the section Sampling Gridded Data can

be used. More information can be found in Sec. 43.4.2.2.

Sampling Gridless Data Within our physical optics simulation approach we work also with gridless

data (e.g. to represent wavefront information). The settings for gridless data

can be configured in the section Sampling Gridless Data. A detailed expla-

nation of the controls to configure the Sampling Gridless Data can be found

in Sec. 43.4.2.3.

Fig. 377 shows the Free Space Propagation page of the edit dialog of a Universal Detector. Note: the graphical

user interface for the configuration of the Free Space Propagation parameters is everywhere the same (for

components/detectors and also in the edit dialogs or the Profile Editor).

Figure 377. Free Space Propagation page of the edit dialog of a detector / component.

Within the following section the detailed configuration options for the Free Space Propagation parameters are

explained.
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43.4.2.1 Fourier Transforms

To enable fast physical optics it is a key technology to switch between different domains. In standard optical

simulations we typically deal with x- and k-domain. This domain switching is very often done within the free

space propagation.

VirtualLab Fusion comes with three different Fourier transform algorithms to enable a fast solution depending

on the incident field:

• Fast Fourier Transform (FFT): The fast Fourier transform is rigorous. Lateral shift and linear phase are

handled analytically.

• Semi-Analytical Fourier Transform (SFT): The semi-analytical Fourier transform is also rigorous. In addi-

tion to lateral shift of the field and linear phase it can also handle quadratic phase terms analytically. This

method has numerical advantages if the quadratic phase term is significant.

• Pointwise Fourier Transform (PFT): The pointwise Fourier transform is an approximation. Here the smooth

phase of the field is evaluated and a pointwise transformation into the target domain is done. Mathemat-

ically this method is derived from the stationary phase. For the pointwise Fourier transform we check

initially for singular cases (plane wave and cylindrical wave) and perform regularization if a singular case

appears.

Fig. 378 show controls to define the parameters for the selection of Fourier Transforms within the Free Space

Propagation parameters.

Figure 378. The user interface to define the Fourier Transforms selection parameters.

The following parameters can be specified by the user

ITEM DESCRIPTION
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Type of Fourier Trans-

forms

VirtualLab Fusion supports the automatic selection of the Fourier transform to

use dependent on the input field for which the domain shall be changed. This

algorithm evaluates the pointwise transformation index (PTI) and first decides

whether to use pointwise Fourier transform or an integral Fourier transform

(SFT or FFT). If an integral Fourier transform is used the numerical effort for

SFT and FFT is compared and the most suitable method is used. Neverthe-

less, it is not untypical that the user already pre-select the types of Fourier

transforms which should be used for evaluation. If the user likes to enforce

the usage of pointwise Fourier transform for example, it is possible to select

only the PFT for the free space propagation. This makes the decision pro-

cess faster and also enable the user to have a concrete control of the effects

he likes to include in the simulation (e.g. diffraction). In the section Type

of Fourier Transform the user can select whether to use FFT, SFT and or

PFT for the usage within the free space propagation. This selection can be

done independently for the forward (x to k) and the inverse (k to x) Fourier

transform. In addition we differ between the selection for Source to Com-

ponent, Component to Component, Inside Components, Source to Detector

and Component to Detector. In dependency whether you edit a component

(single surface or multiple surfaces) or a detector, VirtualLab Fusion will offer

you a matrix, which enable a full flexibility to configure the modeling according

to your needs.

Automatic PFT Selection

Accuracy Level

As explained above VirtualLab Fusion evaluated how accurate the pointwise

Fourier transform is in case not only PFT is marked as an option for automatic

Fourier transform selection. The accuracy for this evaluation can be speci-

fied by the Automatic PFT Selection Accuracy Level. The higher the accuracy

the later VirtualLab Fusion will decide to use PFT. Internally, VirtualLab Fu-

sion calculate the pointwise transformation index (PTI), which is the relation

between the size of the function after pointwise Fourier transform and the

size of the function after an integral Fourier transform. The sizes for integral

Fourier transform are evaluated by 1D cuts. This ratio is gauged by theoret-

ical consideration with a factor ε. If the PTI is larger than 1 PFT is selected.

By selecting the Automatic PFT Selection Accuracy Level the threshold for

the PTI comparison will be changed. In the graphical user interface the user

can check the resulting threshold value where VirtualLab Fusion switches

between pointwise and integral Fourier transform in the box after Pointwise

Transformation Index (PTI) Threshold.

Enforce PFT Beyond xxx²

Sampling Points

VirtualLab Fusion provides also a fall-back solution to restrict the numerical

effort of integral Fourier transforms. Therefor the option Enforce PFT Beyond

xxx² Sampling Points is to be selected (by selecting Yes). If this option is

activated VirtualLab Fusion will check the numerical effort to perform the in-

tegral Fourier transform. If it is larger than the value specified by the user, the

integral Fourier transform is aborted and VirtualLab Fusion will use pointwise

Fourier transform instead. This information can be seen also in the progress

logging to make a transparent documentation of the decision making during

propagation through the system.
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PFT for Bijective Mapping

Only?

The pointwise Fourier transform is typically valid only in bijective cases, which

means that the mesh of gridless points in x-domain and in y-domain are well

sorted. Nevertheless, it can be also applied in non-bijective/surjective cases.

By activating the flag PFT for Bijective Mappping Only it is ensured that the

pointwise Fourier transform is not applied in surjective cases.

43.4.2.2 Sampling Gridded Data

If an integral Fourier transform is used VirtualLab Fusion typically needs to switch from gridless (or hybrid) data

format into gridded data format. For this operation the user has several new options to be configured in the

section Sampling Gridded Data.

Fig. 379 shows controls to define the parameters for the configuration of Sampling Gridded Data within the

Free Space Propagation parameters.

Figure 379. The user interface to define the parameter for Sampling Gridded Data.

The following configurations can be done in the user interface for Sampling Gridded Data:
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ITEM DESCRIPTION

Automatic Sampling/Man-

ual Sampling

In general the user can decide whether the sampling should be evaluated

automatically or a manual sampling configuration shall be used. Depending

on the selection different options are display, e.g. only for Manual Sampling

the user can define Sampling Values for Gridded Data directly.

Accuracy Level of Nyquist

Period Evaluation

In case of Automatic Sampling VirtualLab Fusion first evaluates the Nyquist

distance by a numerical algorithm. This algorithm extract 1D cuts from the

given field data and evaluates the bandwidth of the extracted cross sections

by performing a one-dimensional Fourier transform and measuring the size

in the counter domain. The size measurement is done by detecting a rectan-

gle which contains a certain power portion. The user can specify the power

portion indirectly by the specification of the Accuracy Level of Nyquist Period

Evaluation. This level can be selected between -4 and 4. The resulting power

portion is calculated from the accuracy factor and displayed in the box behind

Power Portion for Field Size Estimation.

Oversampling Factor with

Respect to Nyquist Period

After VirtualLab Fusion evaluated the Nyquist period for given field data the

sampling period for the conversion from gridless to gridded data can be ad-

ditionally scaled. This is done by the Oversampling Factor with Respect to

Nyquist Distance. A larger oversampling factor will result in a smaller grid for

the generation of gridded data.

Limit Gridded Sampling

to Maximum of Sampling

Points

For some modeling situations it might be meaningful to set a limit for the

number of gridded sampling points that shall be used for the conversion from

gridless to gridded data. If the user select the option to limit the sampling

numbers he can define the maximum number of pixels to be used. If the au-

tomatic algorithm for example result in 5000 x 5000 pixels and the limit option

is activated with a limit of 2000, VirtualLab Fusion will use only use 2000 x

2000 sampling point for the conversion. The sampling estimation is based on

numerical algorithms, so it could be some times quite helpful to enable this

option. Nevertheless, the user of VirtualLab Fusion shall be careful because

if the field is strongly undersampled it might cause follow up issues within the

subsequent processing of the system.

Sampling Values for Grid-

ded Data

If the user selects Manual Sampling, the option to configure the Sampling

Values for Gridded Data is activated in the graphical user interface. Here the

user can directly configure the number of pixels to be use in x and y direction.

43.4.2.3 Sampling Gridless Data

As already explained before VirtualLab Fusion typically needs to handle gridless and gridded data within the

simulation of an optical setup. In Sec. 43.4.2.2 the free parameters for Sampling Gridded Data were explained.

In the section Sampling Gridless Data of the Free Space Propagation parameters for the sampling for gridless

data can be configured.

Fig. 380 show controls to define the parameters for the configuration of Sampling Gridless Data.
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Figure 380. The user interface to define the parameter for Sampling Gridless Data.

The following options can be configured by the user in this section of the user interface:

ITEM DESCRIPTION

Initial Number of Gridless

Sampling Values

The user may enter an initial number for the gridless values to be used.

VirtualLab Fusion uses the specification of the shape of the source aperture

to generate a regular x-y mesh (in case of rectangular aperture) or a hexap-

olar mesh (in case of elliptical aperture). The initial number is used to define

the number of points in x/y direction for a regular grid or the density for a

hexapolar mesh.

Control Factor of Gridless

Sampling Values with Re-

spect to Initial Number

The evaluated density (of hexapolar mesh) or number of sampling points in

x/y direction (for a regular x-y grid) can be scaled with the Control Factor of

Gridless Sampling Values with Respect to Initial Number. The control factor

is multiplied on the density or the number of sampling points in x/y direction.

Resulting Number of Grid-

less Sampling Values

To estimate the numerical effort, VirtualLab Fusion calculates the resulting

number of points in dependency of the Initial Number of Gridless Sampling

Values and the Control Factor of Gridless Sampling Values with Respect to

Initial Number. The resulting number of gridless sampling values is logged

into the corresponding text box.

Enforce New Gridless

Data Sampling

In some situations it might be meaningful to restart the gridded sampling. This

can be done by activating the option Enforce New Gridless Sampling. In case

this flag is not checked and the operation sequence is completely pointwise

the initial gridless sampling (after the source) will be used for the complete

system. If the user selects to Enforce New Gridless Sampling VirtualLab Fu-

sion will resample the gridless data values according to the configuration at

the specific selection and a new pointwise sequence might start.

43.4.3 Restrictions of Ray Results Profile

In the current version VirtualLab Fusion comes with two build-in modeling profiles: (1) Ray Results Profile and

General Profile. In both profiles VirtualLab Fusion performs physical optic simulation to obtain the results at

detectors. For the Ray Results Profile several restriction are defined. This profile can be used to configure

results users are typically used when using conventional ray tracing software tools. The General Profile is not

restricted (beside the availability of the result visualization type System: 3D, which will be released in one of

the upcoming releases). It should be stated clearly, that you can generate the same results with the General

Profile as with the Ray Results Profile if you use the corresponding definition of modeling parameters.

The following restrictions are defined for the Ray Results Profile

• The Fourier transform selection for detector is fixed to be only pointwise (user interface is reduced to

information of used Fourier transforms only).

• The Fourier transform selection between and inside components is fixed to be only pointwise.
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• The result visualization type Modeling Analyzer is disabled.

• The Universal Detector is fixed to generate gridless data only, which contains only positions, directions

and wavefront phase.

• Within the Universal Detector the user can not define the Field Quantities to be displayed.

• The Universal Detector can not configured to provide the field in k-domain. So also the tab page Detector

Window (k-Domain) is not visible.

• The profile editing tool Between Components: ... is disabled.

• The profile editing tool To Detectors: ... is disabled.

• The profile editing tool Speed vs. Accuracy is disabled.

• The profile editing tool Pointwise vs. Integral is disabled.

To overcome these limitations we propose that you use the General Profile with the corresponding settings.d

43.4.4 Ray Results Profile: Detectors

O G L S O S .

In case the user selects the visualization type Detectors each detector will generate a detector result. Via the

editor of the visualization type the user can specify the parameters for the point selection and other global view

parameters. The edit dialog can be opened by clicking on the small gear symbol next to the Detectors ribbon

icon.

Fig. 381 shows the edit dialog of the Detectors visualization type for the Ray Results Profile.

Figure 381. Edit dialog of the Detectors visualization type for the Ray Results Profile.

Within the dialog the user can configure the following options
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ITEM DESCRIPTION

Sampling Positions The user needs to specify the number of samples that shall be used for the

result generation. Several modes of operations are provided for this config-

uration, which have different free parameters. The different modes and their

parameter are described in Sec. 43.4.4.1.

Unselect Points with

an Associated Energy

Smaller than

VirtualLab Fusion supports to apply a filter according to themaximum intensity

on the point selection. This filtering can be activated by checking the flag

Unselect Points with an Associated Energy Smaller than and definition of the

desired minimum percentage value.

Use Color Table for Differ-

ent Modes

If checked, a color table for the initial view of positions, wavefront phase and

directions can be specified. In case of positions and directions, the colors

refer to different modes instead of any field values. (This view option can be

changed after the output has been done as well.)

43.4.4.1 Point Selection

For the Ray Result Profile one of the most important parameters to specify is the number of samples/positions

to use in the pointwise processing sequence. This can be done by different modes of operations. In addition

this specification is also possible for gridless data at the Universal Detector.

Fig. 382 shows the panel that is used to select the selection mode of positions and the selection dependent

parameters.

Figure 382. Panel to define the sampling positions (mode of operation and parameters) for the gridless data.

Depending on the selection mode different distribution of position will be generated and are used to define the

distribution of a gridless data set. Fig. 383 shows some sample distributions for different modes of operations

with different (mode-dependent) parameters.

Figure 383. Left: x-y-Grid with 15 times 11 points. Middle: Hexapolar pattern with a Density of 6. Right: 100 points

placed at Random positions

For each mode there are different free parameters available that can be defined by the user. The following

modes are supported:

(a) x-y-Grid

The positions are placed on an equidistant grid.
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ITEM DESCRIPTION

Number of Sampling

Points PV

The number of points in x- and y-direction, respectively. It is ensured that the

numbers are odd so that there is always a ray is at the position (0m; 0m).

(b) Hexapolar

The positions are placed on rings so that the overall structure has the symmetry of a regular hexagon. The nth

ring contains 6·n points. There is one additional sample in the center.

ITEM DESCRIPTION

Density PV The number of rings.

(c) Random

The positions are placed uniformly at random positions.

ITEM DESCRIPTION

Number of Sampling

Points PV

The overall number of sampling points.

Use Seed of If you check this option the position of the samples remain the same between

consecutive simulations. You can change the seed value to obtain a different

random pattern.

Generate Mesh If you uncheck this option no mesh information will be generated. This will in-

crease the performance for the random point generation, because the mesh

is generated by a so called Delauney triangulation, which might be time con-

suming for large number of sampling points.

43.4.5 Ray Results Profile: 3D System

O G L S O S .

The evaluation of System: 3D output is only supported in the Ray Results Profile. By performing the Ray

Results Profile with selected output System: 3D a Ray Distribution 3D document (↪→Sec. 17.1) is generated,

which shows the complete optical system and how light propagates through it.

The user can edit the parameters to be used within this configuration by clicking on the small gear symbol next

to the System: 3D ribbon entry. The edit dialog is divided into two tab pages which are explained in the following

subsections.

Using the Copy From button you can copy the view settings from any open Ray Distribution 3D document to

the dialog.
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43.4.5.1 Ray Selection Tab

Figure 384. The edit dialog to edit the System: 3D output of the Ray Results Profile showing the Ray Selection tab.

This tab page (↪→Fig. 384) has the following options.

ITEM DESCRIPTION

Sampling Positions The user needs to specify the number of samples that shall be used for the

result generation. Several modes are provided for this configuration, which

have different free parameters. They are described in Sec. 43.4.4.1.

Unselect Points with

an Associated Energy

Smaller than

VirtualLab Fusion supports to apply a filter according to themaximum intensity

on the point selection. This filtering can be activated by checking the flag

Unselect Points with an Associated Energy Smaller than and definition of the

desired minimum percentage value.

43.4.5.2 View Settings Tab

This tab page is described in Sec. 5.15.2, the additional Rays page in Sec. 17.1.3.

43.4.6 General Profile: Modeling Analyzer

The Modeling Analyzer provides intermediate results of the light propagating through the Optical Setup using

physical optics simulation. This helps you to understand and optimize the system modeling. As during prop-

agation it is often switched between x- and k-domain using a Fourier Transform, the intermediate results are

stored in a Set of Data Arrays (↪→Sec. 16) which can contain results in both domains. The evaluation of the

Modeling Analyzer is only supported in the General Profile as result visualization type.



CHAPTER 43. OPTICAL SETUP 455

Figure 385. The edit dialog of the Modeling Analyzer.

The edit dialog of the Modeling Analyzer (↪→Fig. 385) has the same structure as the Universal Detector. The

following tab pages are available for configuration:
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ITEM DESCRIPTION

Field Quantities On this tab page the user can define the field quantities and domains that

shall be evaluated by the Modeling Analyzer. A detailed description of the

user interface can be found in Sec. 74.4.1. Please note that in comparison

to the Universal Detector, theModeling Analyzer will always calculate Ex and

Ey component in both domains, because they are provided within the system

modeling. The selection of the quantities that shall be shown is done via

Configure Field Data Visualization by Electromagnetic Field Quantity Add-On.

The dialog to configure the field quantities to show (and their domains) and the

available view options can be found in Sec. 74.4.5.1. The Modeling Analyzer

provide the field information at different locations through the system. So the

options for combination of modes is not provided here and the modes are

shown separately. The current implementation of theModeling Analyzer only

support the evaluation of Ex and Ey, so there is also not the option to use

paraxial assumption for field component calculation here.

Detector Window (x-

Domain)

On the tab page Detector Window (x-Domain) the user can specify the size

of the detector window which shall be used in x-domain. In addition he can

select how the field information should be sampled (in case equidistant sam-

pled data shall be generated). More information on the Detector Window can

be found in Sec. 74.4.2.

Detector Window (k-

Domain)

On the tab page Detector Window (k-Domain) the user can specify the size

of the detector window which shall be used in k-domain. In addition he can

select how the field information should be sampled (in case equidistant sam-

pled data shall be generated). More information on the Detector Window can

be found in Sec. 74.4.3.

Gridless Data The Modeling Analyzer can also be configured to generate the output data

in gridless format. Gridless format will be only provided if it is also available

within the simulation (e.g. before and after pointwise Fourier transforms).

Sec. 74.4.4 gives a detailed overview of the settings for gridless data. The

Modeling Analyzer does not allow to configure manual sampling for gridless

data, so you can access only the gridless data that is used within the engine

processing.

Add-Ons The edit dialog of the Modeling Analyzer also have a tab page to configure

add-ons. For the Modeling Analyzer no customized detector add-ons can be

specified. Only the standard add-on to show the Electromagnetic Field Quan-

tities is available. The edit options for the Electromagnetic Field Quantities

can be found in Sec. 74.4.5.1.

43.4.7 Classic Field Tracing

The Classic Field Tracing is our first implementation of to do physical optics. Its implementation is typically lim-

ited to paraxial simulations or typical Fourier optical configurations. For the propagation between components

(or to detectors) well-known and established diffraction integrals can be selected, which include for example

Spectrum of Plane Waves, Fresnel Integral or Far Field Integral. In comparison to Classic Field Tracing the

newly implemented way to do fast physical optics using our Modeling Profile technology is a generalization of

all these techniques for free space propagation.
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When applying the Classic Field Tracing engine the progress of the simulation can be tracked in the Optical

Setup Editor. When the simulation of a linkage in the Optical Setup starts, the symbol is displayed in the

very first column. When the simulation of the linkage is completed, the symbol is changed to .

The Optical Setup Editor also provide the special option to Re-Use Automatic Settings if Classic Field Tracing

is selected as simulation engine. Here some settings automatically calculated during a simulation with Classic

Field Tracing are written to a cache, for example the location of the Input Transface. For the next simulation

these settings are then not calculated anew but the value from the cache is used, which can speed up the

simulation. An example for such a setting is evaluation of the input transface (↪→Sec. 93.1) by the geometrical

optics component propagation (↪→Sec. 96.1).

The Re-Use checkbox indicates whether the cache is filled and can be reused. If the check box is disabled the

cache is empty. If the checkbox is enabled the user can select whether or not to use the cached settings by

checking or unchecking the box.

In case that more than one mode is simulated and for each mode the automatic parameters are determined

the Re-Use option stays disabled. This is because the size of the cache (only one parameter set is handled for

each operator). To overcome this limitation, the user can select that only one member of the fields set is used

to evaluate the automatic propagation parameters (↪→Sec. 43.4.7.1).

Figure 386. The user interface which is used to communicate the state of the cache (filled or empty. If the cache is filled,

the user can decide to re-use these settings from cache, which will speed up the simulation by classicEngine.

Fig. 386 shows the option to Re-Use Automatic Settings, which is only available if Classic Field Tracing is

selected as Simulation Engine.

43.4.7.1 Property Browser for Classic Field Tracing

O G O S .

Only for Classic Field Tracing, the following options are available in the Simulation Settings tab of the Property

Browser.

ITEM DESCRIPTION

Use Global Accuracy PE To use a globalAccuracy Factor for automatic operations in VirtualLab Fusion,

e. g. Automatic Propagation Operator, this option has to be set to True. Then

the specific accuracy factors of the operation in the Optical Setup are ignored

and the set global Accuracy Factor is used instead.

Accuracy Factor PV The Optical Setup wide accuracy factor can be defined here. The default

value is 1.0.
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Use Global Deviation

Threshold PE

If checked, the Deviation Threshold given here is used within each Automatic

Propagation Operator present in the Optical Setup.

Deviation Threshold PE Threshold value being used instead of values defined locally in the operators.

Optimize Field Before

Propagating PE

If set to True, VirtualLab Fusion tries to optimize the field before propagating it

between two subsequent Optical Setup Elements by truncating the field size

and by rotating the field according to a possibly given analytical linear phase

(i. e. a global direction vector). This option applies to the complete Optical

Setup. The only exception, where no optimization will be tried, is the free

space propagation behind a Field Size and Sampling Manipulation element.

The meaning of this option for the free space propagation algorithm is shown

in Fig. 387, where it is related to the first step.

Tilt Threshold PE If there is an analytically given linear phase at the field, the field will be rotated

according to this global direction vector during optimization only if the tilt angle

is above this threshold. If the value is set to zero, a rotation will be done by

the optimization algorithm for each direction vector which differs from (0, 0, 1).
The meaning of this option for the free space propagation algorithm is shown

in Fig. 387, where it is related to the last step.

Pilot Ray Direction from

Analytical Data Only PE

If this option is set to True, the calculation of the local pilot ray for the free

space propagation between two subsequent elements will use the analytically

stored linear phase direction of the field only. There will be no consideration

of the sampled phase values in this case. So the calculation time for this

special algorithm will be less, especially for large fields. On the other hand, a

possibly incorrect pilot ray may lead to inefficient working of the subsequent

algorithms with a bad overall performance. So use this option with caution.

The meaning of this option for the free space propagation algorithm is shown

in Fig. 388, where it is related to the second step.

Analysis for One Member

Only PE

During the simulation of Optical Setups with a polychromatic or partially co-

herent source, several automatic operations (e. g. Automatic PropagationOp-

erator) can be done by evaluating all sub-fields in the Harmonic Fields Set.

This is very time consuming. VirtualLab Fusion enables the user to configure

that these automatic operations are only done by evaluating one member of

the Harmonic Fields Set. To enable this simulation mode, the user has to set

this option to True.

Index of Analyzed Mem-

ber PE

When the user defines that the decisions of the automatic operations are done

only by evaluating one member of the Harmonic Fields Set, he also has to

define the index of the sub-field in the Harmonic Fields Set which shall be

used for the evaluation. This is done by setting the specific index here.
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Figure 387. Sub-algorithm for the free space propagation: Optimization of the field. (The colored steps refer to entries in

the table shown above.)

Figure 388. Sub-algorithm for the free space propagation: Pilot ray calculation. (The colored step refers to an entry in the

table shown above.)

43.5 Parameter Extraction

VirtualLab Fusion allows that almost all parameters of an Optical Setup can be extracted and read out or varied

externally.

• All parameters can be extracted to an XML file (↪→Sec. 124.1).

• Changeable parameters are those parameters which when changed in the XML file can be re-imported

into VirtualLab Fusion. This mainly affects Boolean and string variables of snippets.

• Variable parameters are those changeable parameters which in addition can be varied externally. This is

only possible for integer or real values. This mechanism is the foundation for the special batch mode

commands (↪→Sec. 9), the Modulated Grating Parameters (↪→Sec. 42.1.3), the Parameter Overview

(↪→Sec. 43.6.1), the Parameter Overview Tree (↪→Sec. 43.7), the Parameter Coupling (↪→Sec. 43.10), the

Parameter Run (↪→Sec. 44), the Light Guide Grating Design (↪→Sec. 101.2), the Parametric Optimization

(↪→Sec. 102), the optiSLang Bridge (↪→Sec. 103), and the export to optiSLang projects (↪→Sec. 124.1.1).

Variable parameters are marked in the manual with a PV symbol, changeable but not variable parameters

with a PC , and parameters which are only extractable with PE . Some properties marked by the PV symbol are

represented by more than one numerical parameter. In general, only properties which are visible and activated

in the corresponding edit dialog are extracted.
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Example 1

If an optical stack (↪→Sec. 39.2) is used for a General Grating in 1D-Periodic mode, you can edit its

Period PV in the corresponding edit dialog. This property is represented as “Period” in the parameter

run. In contrast, if you set the grating to 2D-Periodic mode, you can set two values for the Period PV ,

namely one for the x- and one for the y-direction. Thus two parameters “Period X” and “Period Y” are

available in the parameter run.

However, if the stack period is determined from a surface or media period, it cannot be changed by the

user. In this case, no “Period” parameter for the stack is available in the parameter run.

More complex properties can have their own sub-properties. They are marked with a PE symbol. Clicking

on this symbol leads to the corresponding manual section. In this section or subsections of it the available

sub-properties can be found.

Example 2

An optical stack can comprise several surfaces PE and subsequent media PE . For example the Conical

Constant PV of an Aspherical Surface PE within an Optical Stack PE of a grating component PE can be

varied in the parameter run.

Parameters can be extracted from the following objects:

• The Optical Setup itself: For example the system temperature and the air pressure (↪→Sec. (a)) or the

General Parameters of the Parameter Coupling snippet (↪→Sec. 43.10.1.2).

• The Optical Setup Elements

• The linkages between the Optical Setup Elements: parameters of the rotation operators and the actual

free space operators. Only for Classic Field Tracing. ↪→Sec. 93

However, extraction of 10’000s of objects can decrease performance of VirtualLab Fusion significantly. Thus

you can disable objects which can provide that many parameters via an Optical Setup Tool (↪→Sec. 43.6). These

objects are:

• A Surface Layout (↪→Sec. 40.2) of a Light Guide with many regions.

• Coatings with many layers.

• For a Pillar Medium (General) (↪→Sec. 37.3.8) with very many pillars, the pillar distribution parameters can

be excluded.

43.6 Tools

Besides the Profile Editing Tools (↪→Sec. 43.3.2) there are much more tools which help you to configure an

Optical Setup to your needs. Some of them are available in the ribbon tabs of the Optical Setup document,

while the full set of tools is accessible via the menu that opens by clicking the button Tools in the left bottom

corner of the Optical Setup Editor window. The following tools are available:

• Parameter Overview (↪→Sec. 43.6.1)

• Configure Parameter Extraction: allows you to exclude performance critical objects from Parameter Ex-

traction (↪→Sec. 43.5)

• Optical Setup Tools which help you defining the optical setup, especially the execution sequence of the

Optical Setup Elements (↪→Sec. 43.6.2)

• Component Tools operate on specific types of Optical Setup Elements (↪→Sec. 43.6.3)

• Catalog Support (↪→Sec. 43.6.4)

• Import/Export of elements (↪→Sec. 43.6.5)
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• Import Parameters from XML: Imports an XML having the format described in Sec. 124.1 and sets all

matching variable parameters (↪→Sec. 43.5) to the values in the XML file

• Find Focus Position (↪→Sec. 43.6.6)

• Optimize Detector Positions (↪→Sec. 43.6.7)

• Show Simulation Report (↪→Sec. 43.6.8)

• Create New Parameter Run (↪→Sec. 43.6.9)

• Create New Parametric Optimization (↪→Sec. 43.6.10)

• New Cells Array Design (↪→Sec. 100)

• Remove All Lookup Tables (↪→Sec. 43.6.11)

• Update Add-ons in Detectors (↪→Sec. 43.6.12)

43.6.1 Parameter Overview

Availability

Toolboxes: All

Accessible:

• Main window: Optical Setup > Parameter Overview

• Optical Setup Editor: Tools > Parameter Overview

Figure 389. The parameter overview dialog which also allows you to set new values for the given parameters.

This tool opens a resizable dialog giving you an overview of most numerical parameters of all Optical Setup

Elements. This dialog (↪→Fig. 389) comprises a table with the following columns.
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COLUMN DESCRIPTION

{Unnamed} The first column allows you to collapse / expand all parameters of an Optical

Setup Element or its building blocks. Simply click on the and symbols,

respectively. At the top of this column you can select to collapse all levels (1),

collapse only the Category level (2) or show all levels (*).

Object The object to which the shown Parameters belong.

Category Allows further grouping of the parameters. For example the surface or

medium to which the parameter belongs.

Parameter Name of the parameter.

Value By default the current value of the parameter is shown in this column. How-

ever, you can enter a new value here. It must be within the allowedMinimum

–Maximum range (these columns can be made visible using Show Minimum

and Maximum Allowed Values). Otherwise it is marked red.

If you click OK the new value is set for the corresponding parameter.

Furthermore this dialog has the following controls:

ITEM DESCRIPTION

Filter Table by Only rows containing the given string either in the Object, Category (if appli-

cable) or the Parameter column are shown. The matching is case insensitive.

It is possible to search for multiple words and word groups embraced by quo-

tation marks, for example: "surface #1" scaling.

Show Minimum and Maxi-

mum Allowed Values

If you check this option, two additional columns are displayed showing the

absolute minimum and maximum values of the parameter – you must not

enter a value outside of this range.

Sec. 43.7 describes a similar technique allowing you to change a single parameter without the need to open a

separate dialog.

The available parameters are explained in Sec. 43.5.

43.6.2 Optical Setup Tools

These tools assist you in defining the optical setup, especially the execution sequence of the Optical Setup

Elements, by

• generating the sequence automatically (↪→Sec. 43.6.2.1)

• toggling the active light source (↪→Sec. 43.6.2.2)

• inserting elements into the sequence (↪→Sec. 43.6.2.3)

• excluding elements from the sequence (↪→Sec. 43.6.2.4)

• exchanging one element in the sequence by another (↪→Sec. 43.6.2.5)

• synchronizing the sampling of the detectors (↪→Sec. 43.6.2.6)

• converting a Grating Optical Setup into a General Optical Setup (↪→Sec. 43.6.2.7)

• deleting all linkages (↪→Sec. 43.6.2.8) or

• sorting the entries in the Optical Setup Editor (↪→Sec. 43.6.2.9) .
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43.6.2.1 Generate Sequence

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Complete Sequence Generation / Layout Tools > Partial Sequence

Generation

• Optical Setup Editor: Tools > Generate Sequence > Complete Sequence Generation /

Tools > Generate Sequence > Partial Sequence Generation

Configuring an Optical Setup requires the creation of all linkages between Optical Setup Elements which shall

be simulated. This can be done manually or by using the Optical Setup ToolGenerate Sequence. First the user

has to drag all Optical Setup Elements to the Optical Setup View in an order which corresponds to the desired

execution sequence. Then Generate Sequence can be used for creating the corresponding linkages between

the Optical Setup Elements automatically.

Figure 390. The same optical setup before (top) and after (bottom) automatic sequence generation.

This algorithm uses the following rules to connect the elements in the Optical Setup:

1. The algorithm only considers the light source with index 0, Components, and Ideal Components. Detec-

tors are not included in the Generate Sequence algorithm, because they can be connected to more than

one Optical Setup Element (↪→Sec. 43.2.2). Analyzers cannot be linked at all.

2. The start element is the Optical Setup Element with the lowest index which is not connected to another

element).

3. This start element is then connected to the element with the next larger index having a free input. Usually

a transmission linkage is generated.

4. The 2nd and 3rd step are repeated until no element without output connection can be found anymore.

There are two options available for generating a sequence: Complete Sequence Generation means the con-

nection of all free elements. Partial Sequence Generation allows the user to define the maximum end element

of the sequence algorithm (↪→Fig. 391).
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Figure 391. If the user likes to apply the Generate Sequence algorithm only to a subset of the system, the index of the

end element has to be configured in the Partial Sequence Generation dialog.

This Partial Sequence Generation can be helpful when the Optical Setup the user likes to configure is split at

one specific Optical Setup Element.

43.6.2.2 Toggle Light Source

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Toggle Light Source

• Optical Setup Editor: Tools > Toggle Light Source

The configuration of a second light source in an Optical Setup that contains already an active light source

can be helpful, e. g. to investigate the behavior of the defined optical system when another source is used for

illumination. VirtualLab Fusion supports adding additional light sources to an existing Optical Setup. To ensure

that only one light source is used for the simulation of the Optical Setup, the active source always gets the

special index 0. All additionally added light sources get an index of 500 or higher. In the Optical Setup only

linkages from the source with the index 0 are supported. Light sources with index 500 or higher cannot be

connected with other Optical Setup Elements.

To change the active light source of a configured Optical Setup, one has to use the Optical Setup Tool Toggle

Light Source. If only one other light source exists in the Optical Setup, the indices between this light source

and the active one are toggled. If the Optical Setup contains more than one additional light source, the user

has to select the index of the light source which shall be activated. This selection is done by the dialog shown

in Fig. 392.

Figure 392. Dialog for selecting the active light source.

43.6.2.3 Insert Element into Optical Setup

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Insert Element

• Optical Setup Editor: Tools > Insert Element into Optical Setup
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To insert a new Optical Setup Element into an already configured Optical Setup, the Path table of the Optical

Setup Editor can be used to relink the corresponding connections manually. Or you can use the Optical Setup

Tool Insert Element into Optical Setup which inserts a currently not linked element behind a given already linked

element. The affected elements are relinked automatically. For the linkage from the precedent to the inserted

element the used reference coordinate system is specified in the dialog. For the linkage from the inserted

element to a possible subsequent element usually the “T” (transmission type) or “0” reference coordinate system

is used. Detector linkages are not changed. Fig. 393 shows an example.

Figure 393. Example how the Insert Element into Optical Setup tool works. The left image shows the initial situation. The

right image shows the setup after the Aperture #6 has been linked to the reference coordinate system named “1” (red) of

the Ideal Beam Splitter #4. Aperture #6 has been linked automatically to Ideal Lens #2 which was previously the subse-

quent element of the Ideal Beam Splitter #4. Therefor its reference coordinate system “T” (blue) is used.

Figure 394. For inserting a new Optical Setup Element into an existing Optical Setup, the element and its position in the

execution sequence can be specified.

Fig. 394 shows the edit dialog where the user can define the Optical Setup Element which shall be inserted as

well as its position in the execution sequence.
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ITEM DESCRIPTION

Element to Insert Select the index of theOptical Setup Element you like to insert into the existing

Optical Setup.

Insert Behind Select the index of the Optical Setup Element behind which the Element to

Insert shall be inserted.

Reference Output Coordi-

nate System

The output coordinate system of the element which is chosen as Insert Behind

which will serve as reference for the Element to Insert.

How shall the position of

the element to be inserted

be handled?

If the Element to Insert has already got an absolute position / orientation, the

user can decide whether it will be kept or be re-initialized.

Keep the Absolute Posi-

tion and Orientation after

Inserting

If selected, the absolute position / orientation of the Element to Insert will be

kept.

Re-initialize Relative Posi-

tion and Orientation

If selected, the relative position and orientation of the Element to Insert will

be re-initialized after inserting.

Which of the following val-

ues shall be kept con-

stant?

Since the position and orientation of the subsequent elements may be

changed by the insert operation, the user may select the handling of these

data.

Relative Position and Ori-

entation of Subsequent

Element

If selected, the relative positions and orientations of the subsequent elements

will be kept constant.

Absolute Position and

Orientation of Subse-

quent Element

If selected, the absolute positions and orientations of the subsequent ele-

ments will be kept constant.

This Optical Setup Tool is only available if there is at least one not linked Component or Ideal Component and

at least one linkage.

43.6.2.4 Exclude Element from Optical Setup

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Exclude Element

• Optical Setup Editor: Tools > Exclude Element from Optical Setup

For fast excluding of an Optical Setup Element from a configured Optical Setup without losing its validity, the

Optical Setup ToolExclude Element fromOptical Setup can be used. This tool removes all linkages of a selected

Optical Setup Element. Fig. 395 shows the edit dialog of this tool.
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Figure 395. Dialog for selecting the index of the Optical Setup Element to exclude.

Important: The Optical Setup Element is excluded from the execution sequence only, it is not removed

from the Optical Setup itself. Only all linkages which start or end at the selected Optical Setup Element

are relinked and so the simulation is done without this Optical Setup Element.

ITEM DESCRIPTION

Element to exclude Select the index of Optical Setup Element you like to exclude from the Optical

Setup.

Which of the following val-

ues shall be kept con-

stant?

Since the position and orientation of the subsequent elements may be

changed by the exclude operation, the user may select the handling of these

data.

Relative Position and Ori-

entation of Subsequent

Element

If selected, the relative positions and orientations of the subsequent elements

will be kept constant.

Absolute Position and

Orientation of Subse-

quent Element

If selected, the absolute positions and orientations of the subsequent ele-

ments will be kept constant.

VirtualLab Fusion only supports to exclude Optical Setup Elements which are the end element of one linkage

and the start element of one or more linkages. If no elements which meet this conditions are available, the

Optical Setup Tool Exclude Element from Optical Setup cannot be applied.

Important: Only Ideal and Real Components can be excluded from Optical Setups, because all other

elements can only be the start (light sources) or end (detectors) points of light paths.

43.6.2.5 Exchange Elements in Optical Setup

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Exchange Elements

• Optical Setup Editor: Tools > Exchange Elements in Optical Setup

Sometimes it is helpful to exchange an Optical Setup Element in a configured Optical Setup by another more
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suited element. This can be done manually by using the Path table in the Optical Setup Editor and relinking of

all corresponding linkages. Alternatively, the Optical Setup Tool Exchange Elements in Optical Setup can be

used to solve this task. The user has to specify the element which shall be excluded from the Optical Setup

and the element to substitute. This selection is done by the dialog shown in Fig. 396

Figure 396. To exchange an Optical Setup Element with a new one in an existing Optical Setup, use the Optical Setup

Tool Exchange Optical Setup Elements.

ITEM DESCRIPTION

Element to insert Select the index of the Optical Setup Element you like to insert into the Optical

Setup.

Element to exclude Select the index of the Optical Setup Element you like to exclude from the

Optical Setup.

How shall the position of

the element to be inserted

be handled?

If the Element to insert has already got an absolute position / orientation, the

user can decide whether it has to be kept or be re-initialized.

Keep the Absolute Posi-

tion and Orientation after

Inserting

If selected, the absolute position / orientation of the Element to insert will be

kept.

Copy Absolute Position

From Substituted Element

If selected, the absolute position and orientation of the Element to exclude

will be copied to the Element to insert after inserting.

Which of the following val-

ues shall be kept con-

stant?

Since the position and orientation of the subsequent elements may be

changed by the insert operation, the user may select the handling of these

data.

Relative Position and Ori-

entation of Subsequent

Element

If selected, the relative positions and orientations of the subsequent elements

will be kept constant.

Absolute Position and

Orientation of Subse-

quent Element

If selected, the absolute positions and orientations of the subsequent ele-

ments will be kept constant.

Fig. 397 shows a sample application of the Exchange Elements in Optical Setup tool.



CHAPTER 43. OPTICAL SETUP 469

Figure 397. An example for the usage of the Exchange Elements in Optical Setup tool. The Linear Phase Transmission

with index #3 is exchanged by the Spherical Phase Transmission with index #2.

43.6.2.6 Synchronize Detector Sampling

Availability

Toolboxes: All

Accessible:

• Ribbon: Layout Tools > Synchronize Detector Sampling

• Optical Setup Editor: Tools > Synchronize Detector Sampling

Figure 398. The dialog for synchronizing detector window and resolution among detectors.

Using this Optical Setup Tool you can copy the detector window and resolution settings (↪→Sec. 74.1.1) from

one detector to another. This tool opens a dialog (↪→Fig. 398) with the following settings:
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ITEM DESCRIPTION

Detector to Copy the Set-

tings from

The detector from which the detector window and resolution settings are

copied.

Detectors to Copy the Set-

tings to

This section of the dialog allows you to select one or more detectors to which

the settings from the Detector to Copy the Settings from are copied. The

Selection Tools allow you to either Select All or to Unselect All detectors in

the list.

Validity This control (↪→Sec. 5.10) displays a red cross if no detector to copy the set-

tings to is selected.

43.6.2.7 Convert to General Optical Setup

O G O S

This tool converts a complete Grating Optical Setup (↪→Sec. 43.11.1) into a General Optical Setup by means

of the following rules:

• The Ideal Plane Wave is converted into a Plane Wave (↪→Sec. 51.2).

• Each stack of the grating component is converted into a Grating component (↪→Sec. 60.3).

• If the Raw Data Detectors are in Light View mode they are converted into a Camera Detector

(↪→Sec. 74.5.2). Else they are converted into an Universal Detector (↪→Sec. 74.4).

As a result you obtain a General Optical Setup which produces nearly the same near field results as the original

Grating Optical Setup. However, for all the analyzers of a Grating Optical Setup there are no equivalents in a

General Optical Setup. So among others you cannot directly evaluate the efficiencies. But you can use the

Efficiency detector from the LightTrans Defined Detectors Catalog (↪→Sec. 33) to this end.

43.6.2.8 Delete All Linkages

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Delete All Linkages

• Optical Setup Editor: Tools > Delete All Linkages

This Optical Setup Tool deletes all linkages (also linkages to the detectors) in the underlying Optical Setup.

43.6.2.9 Sort Table Entries

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Optical Setup Editor: Tools > Sort Table Entries

This Optical Setup Tool can be used for sorting the Path table of the Optical Setup Editor in a well-defined way.

This tool is very helpful if the linkages were set in a confused order, e. g. first the last two elements in the Optical

Setup were connected and then the light source at the end of the light path configuration. Then this Optical
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Setup Tool sorts the table entries in the Path table in the order of their execution when the Optical Setup is

simulated. This tool is also automatically applied after loading a stored Optical Setup.

43.6.3 Component Tools

There are tools which operate on specific types of Optical Setup Elements.

The Split Component tool splits one Lens System or Light Guide component into distinct elements

(↪→Sec. 43.6.3.1). The Combine Components tools combines several consecutive Curved Surfaces, Spherical

Lenses, and Lens Systems into a single Lens System (↪→Sec. 43.6.3.2). The Turn Component tool turns a

Curved Surface, Lens System, or Spherical Lens by 180° about its y-axis (↪→Sec. 43.6.3.3).

43.6.3.1 Split Component

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Split Component

• Optical Setup Editor: Tools > Split Component...

If the user likes to evaluate a detector result within a Lens System or Light Guide component, VirtualLab Fusion

provides the Optical Setup Tool Split Component to split the component after the specified surface(s). So the

user can place a detector between the resulting components.

Figure 399. Edit dialog of the Split Component tool

The edit dialog of this tool (↪→Fig. 399) has the following settings:
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ITEM DESCRIPTION

Component to Split The index of the component to be split. Any Lens System or Light Guide with

at least two surfaces is available in this list.

Split after Each Surface If this option is active, the selected Component to Split is split after each

surface, i. e. each resulting component contains exactly one surface.

Set Surface Rotation to El-

ement

O C S

/ .

If checked, the rotation / inclination of the surfaces will be set to the new com-

ponents. The single surface inside each new component will not be inclined

anymore, then. If not checked, the new components will have the same ori-

entation as the original one. The single surface inside each new component

will keep its inclination as before.

Surface Rotation at Ele-

ment is Isolated

O S S R E .

If checked, the rotation / inclination of the element, which has been taken from

the surface, will be set as isolated. So, subsequent elements which have a

relative position and orientation to the inclined element are not affected.

Split after Surface If this option is active, you can select the index of the surface after which the

component shall be split into two. All indices of the surfaces of the selected

Component to Split (except that of its last surface) are available.

After pressing the OK button of the edit dialog, the selected component is split into two or more components.

The split components are connected by linkages. Fig. 400 shows an example: the resulting Optical Setup

contains two Lens Systems which are connected.

Figure 400. An example for the usage of the Optical Setup Tool Split Component.

If no valid component to split is available, VirtualLab Fusion displays an error message when executing the

Split Component tool.

43.6.3.2 Combine Components

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Combine Component

• Optical Setup Editor: Tools > Combine Component...

Real Components of type Curved Surface (↪→Sec. 58.1), Spherical Lens (↪→Sec. 57.3), Lens System

(↪→Sec. 57.1), or Light Guide (↪→Sec. 57.2) can be tried to be combined into new components of type Lens

System. All optical surfaces inside the original components will form a new sequence if possible.

Calling this tool, the dialog shown in Fig. 401 allows to specify the operation.
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Figure 401. Edit dialog of the Combine Components tool

The edit dialog of this tool provides the following settings and information:

ITEM DESCRIPTION

Index and Name of Com-

ponent

The first column shows the indices and names of components which can be

combined to a new component. Adjacent rows with the same background

color mark those components which can be combined to the same resulting

Lens System. Example from Fig. 401: The elements #9, #10, #11, and #12

can be combined to one Lens System, the elements #3, #4, and #7 can be

combined to another Lens System.

Separation In this column the user has to select which separations shall be kept. If a

combination is not possible at one place, the box is checked read-only (like

between #12 and #3 in Fig. 401). Each box which is not checked will result

in a combination of the components above and below the dashed line.

Combination This column gives the information about the new components which would

result from the current selections.

Combination Info... This opens a dialog that informs about the restrictions which determine what

components can be combined with others (see below).

The restrictions for a Lens System component that determine the restrictions for combining existing components

are the following:

• All optical surfaces have to be centered to one common optical axis.

• Optical surfaces in the sequence may not be tilted to the optical axis nor rotated about this axes in refer-

ence to the first surface in the sequence.

If it is not possible to combine any components in the current Optical Setup, an error message will be given.



CHAPTER 43. OPTICAL SETUP 474

43.6.3.3 Turn Component

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Turn Component

• Optical Setup Editor: Tools > Turn Component

If you execute this tool, there is first a dialog where you can select any Curved Surface, Lens System, or

Spherical Lens component present in the Optical Setup. If no such component is available, an error message

is shown instead.

Then this tool does the following steps on the selected component:

• Multiply the x- and z-scaling (↪→Sec. 35.1.2) of all surfaces with -1. This means that they are rotated by

180° about their y-axis.

• Invert the order of the surfaces, their corresponding distances, and media.

In effect, the whole component is turned by 180° about its y-axis. Note that in contrast to rotating a component

by 180° via its edit dialog (↪→Sec. 5.6), this tool changes through which surface light enters the component as

well as the position of the internal coordinate system relative to the component.

43.6.4 Catalog Support

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Ribbon: Layout Tools > Catalog Support (ribbon group)

• Optical Setup Editor: Tools > Catalog Support

The menu items in this section allow you to save light sources (↪→Part VIII), components (↪→Part IX), and

detectors (↪→Part XI) to the corresponding catalogs.

The entries for light sources and detectors are only available for a General and a Light Guide Optical Setup.

ITEM DESCRIPTION

Add Light Source from

Catalog

Loads the selected item from the light sources catalog and adds it to the

Optical Setup. See Sec. 33 for details on the catalog dialog.

Save Light Source to

Catalog

Opens a dialog to select one light source. Saves the selected item to the light

sources catalog after asking for name and categories (↪→Sec. 33.1).

Add Component from

Catalog

Loads the selected item from the components catalog and adds it to the Op-

tical Setup. See Sec. 33 for details on the catalog dialog.

Save Component to

Catalog

Opens a dialog to select one component. Saves the selected item to the

components catalog after asking for name and categories (↪→Sec. 33.1).

Add Detector from Cat-

alog

Loads the selected item from the detectors catalog and adds it to the Optical

Setup. See Sec. 33 for details on the catalog dialog.

Save Detector to Cata-

log

Opens a dialog to select one detector. Saves the selected item to the com-

ponents catalog after asking for name and categories (↪→Sec. 33.1).
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43.6.5 Import / Export Elements

Availability

Optical Setups: General, Laser Resonator, Light Guide, and Light Shaping Optical Setup

Accessible:

• Optical Setup Editor: Tools > Import/Export Elements

It can be helpful to save an Optical Setup Element to hard disk. This allows you to later import them into another

Optical Setup. Doing so, you can define kind of a catalog of often used Optical Setup Elements. In contrast

to the Catalog Support tool (↪→Sec. 43.6.4) this works also for light sources, Ideal Components, detectors,

and analyzers. To export an Optical Setup Element from an Optical Setup, the user simply has to click the

Import/Export Elements > Export Optical Setup Element item in the Tools menu. Then a dialog (↪→Fig. 402) is

shown where the index of the element to export has to be specified.

Figure 402. To export an Optical Setup Element, the index of the element to export has to specified.

VirtualLab Fusion supports only the export of one Optical Setup Element at a time. After pressing theOK button

in the selection dialog, the user has to specify the file name and location to store the selected Optical Setup

Element to. The Optical Setup Elements are saved with the file extension *.lpe.

To import a previously stored Optical Setup Element from hard disk, one has to select the Import/Export Ele-

ments > Import Stored Optical Setup item in the menu for the Optical Setup Tools. Then a file open dialog is

shown where the user has to specify the element to be imported. The selected file must have the file extension

*.lpe. If the import of the selected Optical Setup Element was successful, the new element is added to a default

position in the flowchart area of the Optical Setup View and can subsequently be linked to other elements.

43.6.6 Find Focus Position

Availability

Optical Setups: General Optical Setup

Accessible:

• Ribbon: Optical Setup > Find Focus Position

• Optical Setup Editor: Tools > Find Focus Position

This Optical Setup Tool optimizes the position of one detector so that it is in the focus, i. e. the position where a

Ray Results Profile simulation yields the smallest spot diameter. For evaluation of the size within the detector

plane the RMS detector is used on the ray bundle. Only the position of detecting devices having exact one

active linkage can be optimized.
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Figure 403. The edit dialog of the Find Focus Position tool.

Its edit dialog (↪→Fig. 403) has the following options

ITEM DESCRIPTION

Detector to Optimize The detector whose position shall be optimized.

Spot Size Radial Option for the detection of the RMS value. If this option is selected the radial

size is determined by the detector.

Spot Size X Only Option for the detection of the RMS value. If this option is selected only the

extension in x-dimension is evaluated by the detector.

Spot Size Y Only Option for the detection of the RMS value. If this option is selected only the

extension in y-dimension is evaluated by the detector.

Spot Size Refers to Cen-

troid

Flag whether the RMS value is measured to the centroid of the ray bundle.

If this option is not selected the position of the central ray will be used as

reference for the RMS calculation.

Optimize Only z-

Coordinate

The focus finder can be used to detect the 3D position of the focus. The

user can select whether only the z-coordinate of the focus position shall be

used in the generated or updated Optical Setup, or whether the complete 3D

information shall be used.

Generate New Optical

Setup

The user can define whether a new Optical Setup shall be generated, or

whether the optimized position shall be set into the active Optical Setup.

43.6.7 Optimize Detector Positions

Availability

Optical Setups: General Optical Setup

Accessible:

• Ribbon: Optical Setup > Optimize Detector Positions

• Optical Setup Editor: Tools > Optimize Detector Positions

If a detector is not placed at the optimal lateral position, an embedding of the incoming field might be necessary

to match it with the detector position. This Optical Setup Tool generates a newOptical Setup where the positions

of all detectors of the original Optical Setup are optimized so that they are placed right in the middle of the

incoming light distribution. This optimization is done using Ray Results Profile simulations. Only the position

of detectors having exact one active linkage can be optimized.
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In case the detector is tilted in reference to the optical axis, there are two options available. The selection is

done via the dialog shown in Fig. 404.

Figure 404. Dialog for choosing an option for optimizing the position of a tilted detector.

ITEM DESCRIPTION

... Inside Detector Plane If chosen, the optimization will do a lateral shift of the detector in its own plane.

... Perpendicular to Opti-

cal Axis

If chosen, the optimization will do a shift of the detector inside the plane per-

pendicular to the optical axis.

43.6.8 Show Simulation Report

Availability

Optical Setups: General Optical Setup with Classic Field Tracing & Light Shaping Optical Setup

Accessible:

• Optical Setup Editor: Tools > Show Simulation Report

After the simulation of an Optical Setup, it is possible to view and save several information about the simulation

process in VirtualLab Fusion using this Optical Setup Tool. It shows a VirtualLab Fusion document which lists

all available information, ↪→Fig. 405.

This document works like a web browser. The initial page Report Overview shows a list of all Optical Setup

Elements (as well as their processing durations) through which the light has been propagated. If a magnifier

symbol is clicked on, a new page with the report of the associated element will be opened (↪→Fig. 406).
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Figure 405. Simulation report document showing a list of processed Optical Setup Elements.

Initially only a rough overview of the processing of the selected Optical Setup Element is given. More details

for the report entries can be explored by clicking on the associated magnifier symbol . For any selected page

except the initial page (↪→Fig. 405) the following controls are available:

ITEM DESCRIPTION

(Export to XML) By clicking on this button the report information is exported into a XML file as

described below.

Full Expansion If checked, the report tree expands completely, i. e. all report entries are

visible.

Close Tab If pushed, the currently selected page will be closed.

The entire simulation report can be exported to a XML file via the ribbon item File > Export > Export as

XML or the button on the bottom of the report window. The XML file is stored along with the style file

lt_logstyle.xslt that transforms the XML to a human-readable tabular form if opened in a web browser,

looking similar to the report document itself. Additionally, some CSS files for formatting the text will be saved.

Finally, an XML schema file (lt_logstyle.xsd) which contains the structure definition of the logging XML file
will be created in the same directory.
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Figure 406. Simulation report document showing details in a new page.

Important: If the Optical Setup has not been simulated in the current VirtualLab Fusion session, the

Simulation Report is not available. Reports are not stored with the Optical Setup.

43.6.9 Create New Parameter Run

Availability

Toolboxes: All

Accessible:

• Ribbon: Optical Setup > New Parameter Run

• Optical Setup Editor: Tools > Create New Parameter Run

This tool provides the simulation of an existing Optical Setup within a Parameter Run (↪→Sec. 44). This allows

the modification of one or more parameters of the optical setup and the evaluation of all included detectors in

the Optical Setup.

For the generation of a Parameter Run, the Optical Setup has to be consistent.

If at least one parameter run is already open, the new parameter run obtains the view settings and (if possible)

the parameter(s) to vary from the last opened parameter run.
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43.6.10 Create New Parametric Optimization

Availability

Optical Setups: All but Light Shaping Optical Setup

Accessible:

• Ribbon: Optical Setup > New Parametric Optimization

• Optical Setup Editor: Tools > Create New Parametric Optimization

If the Optical Setup is consistent, a parametric optimization document (↪→Sec. 102.1) can be opened using this

Optical Setup Tool.

43.6.11 Remove All Lookup Tables

Availability

Toolboxes: AR/VR/XR Package

Accessible:

• Optical Setup Editor: Tools > Remove All Lookup Tables

This Optical Setup Tool deletes all lookup tables for all grating regions with real gratings (↪→Sec. (c)) for all light

guide components.

43.6.12 Update Add-ons in Detectors

Availability

Optical Setups: All that contain a Universal Detector (↪→Sec. 74.4) with at least one snippet based

Detector Add-on (↪→Sec. 74.4.5).

Accessible:

• Ribbon: Layout Tools > Update Add-ons in Detectors

This tool updates all predefined Detector Add-ons in all Universal Detectors in the current Optical Setup. Pre-

defined refers to all snippet based add-ons which have the same name as an Add-on provided by Wyrowski

Photonics. Update means that the snippet is copied from the downloaded version of the add-on. It is recom-

mended to keep the downloaded add-ons up-to-date by either clicking on the Add-ons tab of a Universal

Detector or by clicking Detectors > Apply Detector Add-on > Update Predefined Add-ons if a Data Array or

Chromatic Fields Set is open. The values of the parameters of the add-on are kept while updating.
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43.7 Parameter Overview Tree

Figure 407. The parameter overview tree which allows you to set new values for the given parameters.

This docking tab page (↪→Sec. 4.3) provides you with quick access to most numerical parameters of all Optical

Setup Elements. It contains the following controls.

ITEM DESCRIPTION

Filter Table by Only parameters containing the given string or being in a category matching

the given string are shown. The matching is case insensitive. It is possible

to search for multiple words and word groups embraced by quotation marks,

for example: "surface #1" scaling.

{Tree View} Shows all parameters matching the current filter string. You can navigate

through the tree with the arrow keys and Page Up and Page Down . You can
expand / collapse nodes using + , * and - .

New Value Shows the value of the currently selected parameter and allows you to change

it (if it is not a coupled parameter, ↪→Sec. 43.10). If the value is valid and

different from the original value, you can submit it to the Optical Setup with

the Enter key or the -button.

You canmove between the controls with the Enter key. TheOptical Setup Element or linkage currently selected
in the Optical Setup View (↪→Sec. 43.1) is highlighted.

Sec. 43.6.1 describes a similar tool which allows you to set multiple parameters at once but within a separate

dialog.

The available parameters are explained in Sec. 43.5.

43.8 Positions

The details of the positioning concept for Optical Setups can not be presented here extensively. So this section

gives a short overview but you can learn more about the concepts of coordinate systems and positioning via a

supplemental file available upon request.

An Optical Setup is associated with a global coordinate system (GCS), while every Optical Setup Element

(OSE) owns two or three kinds of coordinate systems (CS):

1. Internal Coordinate System (ICS): Unambiguously specified coordinate system which is related to the

inner structure of the OSE. Its origin is identical to the position of the element within the global coordinate

system.



CHAPTER 43. OPTICAL SETUP 482

2. (Referring) Input Coordinate System (InCS, components and detectors only): The z-axis of this coordinate

system defines the typical input direction of light. The position of the origin and the orientation of the x-

and y-axes are related to the structure of the OSE (↪→Sec. 43.8.1).

3. Reference Output Coordinate Systems (OutCS, components and light sources only): The z-axis of an

output coordinate system defines the typical direction for a special kind of output (e.g. transmission type

or reflection type). The position of the origin and the orientation of the x- and y-axes are related to the

structure of the OSE (↪→Sec. 43.8.1).

Usually, the positioning of Optical Setup Elements is done by defining the relative position and orientation of

the InCS with reference to the output CS of the previous Element in path. This principle is shown in the sketch

below (↪→Fig. 408) and explained in Sec. 43.8.2.

Figure 408. Principle of positioning of Optical Setup Elements. The blue coordinate system is the output CS of the pre-

vious element while the green one indicates the input CS of the element to position. Its origin is translated by the axial

distance ∆Z and a lateral shift ∆X. Its orientation is rotated by η, which means a rotation of the OSE about the y-axis.

The red coordinate system is the Internal CS of the element.

An alternative workflow is the positioning of Optical Setup Elements by defining the absolute position and

orientation of either the InCS or the ICS with reference to the global coordinate system (GCS). The GCS is

defined by the position and orientation of the currently active light source element.

43.8.1 Element Internal Definition of Axes, Coordinate Systems, and Reference Points

All information about the definitions of axes, coordinate systems and reference points can be got and (in some

cases) set via the Coordinate Systems page (↪→Fig. 409) of each Optical Setup Element’s edit dialog.

Figure 409. Page selector for information about axes, coordinate systems and reference points of Optical Setup Ele-

ments.

43.8.1.1 Internal Coordinate System
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The Internal Coordinate System (ICS) is related to the inner structure of the OSE. Its position and orientation

relative to the geometry of the element are shown in the panel Internal Coordinate System. Furthermore, the

geometrical parameters are described here. For an example see Fig. 410.

The position of the origin of the ICS in relation to the global coordinate system of the Optical Setup gives the

absolute position of the element (↪→Sec. 43.8.2).

Figure 410. Example (Spherical Lens) for the Internal Coordinate System panel with the description of the geometrical

parameters.

43.8.1.2 Reference Points

Although the orientations of the input and output coordinate systems are either fixed or calculated automatically,

the internal position (i. e. referring to the ICS) of these coordinate systems can be chosen by the user from a list

of reference points in order to have a great flexibility for the relative positioning (↪→Sec. 43.8.2). These points

are distinguished points of the element’s structure which could come into consideration to serve as a reference

for distance measurements. For a spherical lens, for instance, these are the vertices, the intersections of the

principal planes with the symmetry axis, and the center of the lens. The list of all reference points of an element

is shown in the panel Reference Points. For an example see Fig. 411.
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Figure 411. Example (Spherical Lens) for the Reference Points panel with the description of all reference points.

The Programmable Component allows to define new reference points by the user, see Sec. 61.3.

43.8.1.3 Reference Coordinate Systems

The information of all reference coordinate systems are given in the panel Reference Coordinate Systems

(↪→Fig. 412). Here you can see the orientation and meaning of the input coordinate system and of each output

CS. Furthermore you can set the origin to one of the reference points.
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Figure 412. Example (Spherical Lens) for the Reference Coordinate System panel with the description of the coordinate

systems.

ITEM DESCRIPTION

Coordinate System Which coordinate system shall be shown?

Default Position of Coor-

dinate System

The sketch shows the position and orientation of the CS in relation to the

element’s structure. Note: Only a sample position is shown, that means

there will be no update if the reference point is changed!

Origin (Reference

Point) PE

Select the reference point which provides the position of the origin of the

reference CS here. For grating components illuminated by an ideal plane

wave, the reference point of the input coordinate system cannot be set. For

the grating cells diffuser component no reference points can be set at all.

Note: Since the Programmable Component allows to define new reference coordinate systems, the edit control

is completely different for Programmable Components (↪→Sec. 61.3).

43.8.2 Positioning of Optical Setup Elements

All information about the position and orientation can be get and (in most cases) set via the Position / Orientation

page (Fig. 413) of each Optical Setup Element’s edit dialog.

Figure 413. Page selector for information about position and orientation of Optical Setup Elements.
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43.8.2.1 Basic Principles of Positioning

There are two modes of positioning for Optical Setup Elements which can be combined:

1. Basal Positioning: The basal positioning influences the positions of all of these Optical Setup Elements

whose location and orientation refer to the current element.

2. Isolated Positioning: The isolated positioning of an element has no consequences for the position of any

other Optical Setup Element. It is always applied additionally (i.e. after) doing the Basal Positioning.

Figure 414. Principles of positioning.

a) The original positions of the three elements I, II and III. Element I is the reference element for element II, and at the

same time, this is reference element for III.

b) If the position of II is changed by increasing r1 to r′1 using Basal Positioning, the absolute position of element III is
changed too. This is due to the fact that the relative distance r2 is kept.
c) In contrast, a distance value of ∆r1 using Isolated Positioning shifts the element II (additionally to its basal positioning)
without changing the position of the following element III.

If both modes of positioning are used for the same element, its resulting position and orientation are calculated

by the consecutive application of basal positioning first, followed by the isolated positioning.

Please note: For the simulation of an Optical Setup, always the position and orientation which results from the

described combination of both principles will be used.
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43.8.2.2 Basal Positioning

The relative positioning of an Optical Setup Element is done by defining a translation and a rotation of the

element’s referring input coordinate system (InCS) in relation to the reference output coordinate system (OutCS)

of the Optical Setup Element it is linked to (↪→Fig. 408). The origin of the InCS is translated from the origin of

the reference OutCS via a distance ∆Z on the z-axis of the OutCS and a lateral shift (∆X, ∆Y) perpendicular to
that z-axis. This information can be entered in the control shown in Fig. 415. Furthermore, it contains a control

for defining an inclination or rotation which can be used for certain types of elements and that is explained in

detail in Sec. 5.6.

Figure 415. Control for determining the basal position and orientation of an Optical Setup Element.
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ITEM DESCRIPTION

Enter Absolute Position-

ing Data

Clicking this button will open an edit dialog where absolute position and ori-

entation for the element can be entered.

Reference Element Optical Setup Element that serves as reference for positioning. It is identical

to the previous element in the path.

Reference Output Coordi-

nate System

The name of that output coordinate system (OutCS) of theReference Element

which defines the reference for the relative distances and angles.

Delta Z PV Distance to the reference element, measured on the z-axis of the OutCS.

(This means the z-component of the distance vector from the OutCS origin to

the InCS origin.)

Delta X PV Shift of the element in x-direction, lateral to the z-axis of the OutCS. (This

means the x-component of the distance vector from the OutCS origin to the

InCS origin.)

Delta Y PV Shift of the element in y-direction, lateral to the z-axis of the OutCS. (This

means the y-component of the distance vector from the OutCS origin to the

InCS origin.)

Inclination / Rotation PE Control for defining the relative orientation of the Optical Setup Element. It

defines the rotation angles of the input coordinate system of this element in

reference to the OutCS of the reference element.↪→Sec. 5.6

The absolute positioning of an Optical Setup Element is done by defining a translation and a rotation of the

element’s input coordinate system (InCS) or the elements internal coordinate system (ICS) in relation to the

global coordinate system GCS of the Optical Setup. It can be entered after clicking the button Enter Absolute

Positioning Data, which opens the dialog explained in Sec. 43.8.2.4.

43.8.2.3 Orientations of Optical Setup Elements

In many cases, the orientation of an Optical Setup Element can be set freely.

There are several ways to define the orientation of an Optical Setup element which are all equivalent

(↪→Sec. 139.2). Each of these conventions uses some rotations, applied to the input coordinate system InCS,

referring to the reference output coordinate system OutCS. The rotation is centered around the origin of the

InCS as pivotal point, in any case. This ensures that the translation values (z-distance and lateral shift in x and

y) will be kept independent from the orientation.

The control for defining an orientation is described in Sec. 5.6.

43.8.2.4 Positioning Control

An alternative way to edit the basal position of an element is to use the positioning control of the Optical Setup

Element in the Optical Setup View (↪→Sec. 43.1 and Fig. 416).
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Figure 416. The positioning control in the Optical Setup View.

The layout of the control can be configured via the Optical Setup View’s context menu. The following menu

items refer to the positioning control:

ITEM DESCRIPTION

Show Position Controls The visibility of the positioning controls can be set here.

Show Only z-Positions If checked, only the z-Positions of the elements are shown. This menu item

is a shortcut to the more detailed advanced option described below.

Advanced Position Con-

trol Settings > Show Ab-

solute Positions if Possi-

ble

If checked, absolute positions and orientations are shown if available. (Which

will be not the case for detectors.) The absolute values are red colored. Rel-

ative values are blue.

Advanced Position Con-

trol Settings > Info for In-

ternal CS / Info for Input

CS

If Show Absolute Positions if Possible is chosen, this selection determines

whether the absolute positioning information is shown for the internal coordi-

nate system ICS or the input coordinate system InCS.

Advanced Position Con-

trol Settings > Include Iso-

lated Positioning

If checked, the basal as well as the isolated positioning information will be

shown. If unchecked, only the basal positioning information will be shown. In

the latter case, the values will be written in an italic font.

Advanced Position Con-

trol Settings > z-Position

Only / Position Only / Po-

sition & Orientation / Non-

Zero Values Only

The display mode for the control. It determines how much information will be

shown.

If one of the display modes is chosen which doesn’t show all information (i. e. z-Position Only or Position

Only), the control will indicate whether or not there are non-zero values hidden. If there are non-zero x- or

y-translation values which are not visible in z-Position Only mode, the symbol indicates that there is hidden

information. If there are non-zero orientation values which are not visible in z-Position Only or Position Only

mode, the symbol indicates that there is hidden information.

There can also be hidden information in case of isolated positioning. Whether or not the shown values include

isolated positions or orientations is indicated by the font as shown in Fig. 417.

Figure 417. A regular font (left hand side example) indicates that no isolated positioning has been used. An underlined

font (center example) indicates that the shown values represent the combined resulting position of isolated and basal po-

sitioning. If the font is italic (right hand side example), the basal position is shown only, despite there is an isolated posi-

tioning given and effective in the simulation.
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Another indicator is shown in Fig. 418. It appears if the shown value is rounded. If so, hovering the mouse

cursor over the control will open a tooltip giving the exact values. Please note: This feature has to be activated

in the Global Options Dialog (↪→Sec. 6.5).

Figure 418. The indicator for rounded values.

A single click on the positioning control opens the dialog shown in Fig. 419.

Figure 419. Dialog for editing the basal Optical Setup Element position and orientation via external position control.

ITEM DESCRIPTION

Definition Type This allows to define whether the position and orientation represent relative

or absolute measurements.

Measurement from The reference coordinate system to be used.

...to The referring coordinate system to be defined here.

X/Y/Z PV The basal translation of the element as described above (Sec. 43.8.2.2,

where the values are named Delta X/Y/Z).

Reference Point to be

Used as Center Point

The pivotal point for the rotations which specify the orientation.

Orientation Angles The basal orientation of the element can be specified here, as described in

Sec. 5.6.
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43.8.3 Isolated Positioning of Optical Setup Elements

T O S E L S D -

.

Sometimes, one may want to vary the position or the orientation of a single Optical Setup Element without

change of the absolute positions and orientations of the following elements whose distances refer to this ele-

ment. In this case the variation has to be done as isolated positioning. The functionality is shown in Fig. 414c.

Basal and isolated positioning may be combined. The basal one is always applied first.

There are two different kinds of isolated positioning possible: Isolated translation and isolated orientation. At

first, it has to be chosen which kind of isolated positioning shall be done, this selection is made via the control

shown in Fig. 420. If isolated translation and isolated orientation shall be done, here the order of these two

steps can be defined too.

Figure 420. Control to activate isolated positioning.

ITEM DESCRIPTION

Use Isolated Translation If checked, isolated translation positioning is activated and the corresponding

parameters can be entered (↪→Sec. 43.8.3.1).

Use Isolated Orientation If checked, isolated orientation positioning is activated and the corresponding

parameters can be entered (↪→Sec. 43.8.3.2).

Order of Steps If set to 1: Translation -> 2: Orientation, isolated translation positioning is

done before isolated orientation positioning. If set to 1: Orientation -> 2:

Translation, isolated orientation positioning is done before isolated translation

positioning.

43.8.3.1 Isolated Translation

Isolated translation positioning means dislocation of the element via translation from its former position, deter-

mined by basal positioning. The translation vector is defined via the control shown in Fig. 421.
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Figure 421. Control to define the isolated translation values and directions.

ITEM DESCRIPTION

Axes Selection Here the coordinate system can be selected in which the translation vector is

defined. The selectable entries depend on the kind of Optical Setup Element

which is edited.

Axes Pushing this button will open an information window that displays the direc-

tions of the selected coordinate system axes in reference to the internal co-

ordinate system of the element.

Delta X/Y/Z PV These values define the vector which will be used for the isolated translation.

43.8.3.2 Isolated Orientation

Isolated orientation positioning means dislocation of the element via rotation, referring to its former orientation,

which already has been determined by basal positioning. This rotation is defined via the control shown in

Fig. 422.
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Figure 422. Control to define the isolated orientation values and rotation center points.

ITEM DESCRIPTION

Reference Point to be

Used as Center Point PE

Here the center point for the rotation that defines the isolated orientation can

be selected. The selectable entries depend on the kind of Optical Setup Ele-

ment which is edited.

Isolated Orientation An-

gles PE

This control (↪→Sec. 5.6) is used to define the angles which determine the

isolated orientation.

43.8.3.3 (Absolute) Position Information about an Optical Setup Element

The absolute position of an element in an Optical Setup is measured in the Global Coordinate System (GCS)

of the Optical Setup. This is identical with the Internal Coordinate System of the currently active Light Source

element.

All information about the absolute position and orientation of an Optical Setup Element can be found in the

control shown in Fig. 423.
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Figure 423. Control that shows the absolute position and orientation of an Optical Setup Element.

ITEM DESCRIPTION

Show Basal Position and

Orientation Only

If selected, the absolute position information is calculated from the basal posi-

tion only. So one can see the position and orientation all other referring Opti-

cal Setup Elements will use. Important: This mode is for information purpose

only. Every simulation will use the combined basal and isolated positioning.

Show Result of Basal and

Isolated Positioning

If selected, the absolute position information is calculated from the basal po-

sition as well as the subsequent isolated positioning. So one can see the

position and orientation as it will be used during the simulation.

Position of Origin > of In-

ternal CS / of Input CS

This selection determines for which CS the values X, Y, and Z are given for.

Position of Origin > X/Y/Z Position of the origin of the internal coordinate system or the input coordi-

nate system (depending on the corresponding selection) of the element in

the global coordinate system.

Inclination / Rotation The orientation of the element’s internal coordinate system, given via the Ori-

entation Definition Type currently selected. For more information about these

definition types and the associated angles please see Sec. 139.2.1.

43.9 Channel Configuration

A surface can be illuminated from the front (along the optical axis) or from behind (against the optical axis).

Furthermore light can be reflected or transmitted. In consequence there are four ways light can take on a

surface:
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CHANNEL DESCRIPTION

+/+ Light comes from the front and is transmitted through the surface.

+/- Light comes from the front and is reflected at the surface.

-/- Light comes from behind and is transmitted through the surface.

-/+ Light comes from behind and is reflected at the surface.

As you can see the channels refer to the sign the z-component of the direction vector of the incident and

outgoing light has, respectively.

Figure 424. The table for setting the propagation channels. Here light coming from the front and transmitted through the

component is taken into account as well as light reflected at the respective outermost surfaces.

The Channel Configuration tab page of Real and Ideal Components contains a table (↪→Fig. 424) where you

can configure which propagation channels are taken into account in case manual channel configuration is

set (↪→Sec. 43.3.1). In this way you can avoid that unnecessary light paths are calculated and so make the

simulation faster.

If there are two or more surfaces there is an additional row All Surfaces where you can change the configuration

of all surfaces at once.

For certain components certain channels might be unavailable. For example ideal mirrors have no transmission

channels. In case of pre-selected channel configuration, the complete table is read-only.

For a light guide component you can configure the propagation channels in more detail in the edit dialog of the

grating regions (↪→Sec. 42.1).

43.10 Parameter Coupling

This expert tool allows you to define dependencies of selected Optical Setup parameters on others via a snippet.

Changing the independent parameter leads to a change of the value of the dependent parameters, hence

referred to as coupled parameters.

For any Optical Setup, you can switch on or off this mechanism via the Optical Setup > Use Parameter

Coupling ribbon item or via the Property Browser. If parameter coupling is switched on, you can edit it via the

Optical Setup > Edit Parameter Coupling ribbon item. The resulting edit dialog is explained in the subsection

Sec. 43.10.1.

Note that any changes on coupled parameters in the Optical Setup are ignored as their value depends

on the independent parameters. The effects of parameter coupling are explained in detail in subsection

Sec. 43.10.2.
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43.10.1 Edit Dialog for the Parameter Coupling

Figure 425. The edit dialog for parameter coupling showing the Parameter Specification page.

The edit dialog for the parameter coupling (↪→Fig. 425) is a wizard with 4 pages:

1. The Welcome page giving you a short introduction.

2. The Parameter Specification page where you can setup the parameters to be used as input or output of

the coupling snippet. (↪→Sec. 43.10.1.1)

3. The Snippet Specification page where you define the snippet which does the actual parameter coupling.

(↪→Sec. 43.10.1.2)

4. The Summary Page which gives an overview of all coupled parameters you have added to the output

dictionary of your snippet. Furthermore it gives for each coupled parameter the value it has if the snippet

is executed with the current Optical Setup configuration.

Furthermore at the bottom of the edit dialog there is a validity control (↪→Sec. 5.10) which shows current mis-

configurations (invalid snippet and alike).

This dialog is resizable.

43.10.1.1 Parameter Specification page

This page comprises a table with the following columns.
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COLUMN DESCRIPTION

{Unnamed} The first column allows you to collapse / expand all parameters of an Optical

Setup Element or its building blocks. Simply click on the and symbols,

respectively. At the top of this column you can select to collapse all levels (1),

collapse only the Category level (2) or show all levels (*).

Object The object to which the shown Parameters belong.

Category Allows further grouping of the parameters. For example the surface or

medium to which the parameter belongs.

Parameter Name of the parameter.

Use in Snippet In this column you can select which parameters are available in the snippet

– either as input or as output parameters or as both.

Short Name The user can define a short name for the parameter which is used in the

snippet. It can be an arbitrary non-empty string, but it must be unique. The

short name proposed by VirtualLab Fusion is the Parameter name1– or the

last part of it if the parameter name contains multiple parts separated by a ‘|’.

Thus the proposed short name might not be unique.

This table contains all parameters made available by Parameter Extraction (↪→Sec. 43.5) but integer values like

the number of sampling points.

The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or theParameter column pass this filter. Thematching is case insensitive.

Show Only Used Parame-

ters

Only rows where the Use in Snippet column is checked pass this filter.

43.10.1.2 Snippet Specification page

On the Snippet Specification page you see the following controls:

1 For the parameters within a Multiple Light Source (↪→Sec. 49) the index of the sub light source is appended to the default short name;

for the parameters of a Surface Layout (↪→Sec. 40.2) the region index is appended.
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ITEM DESCRIPTION

Edit Opens the Source Code Editor (↪→Sec. 7.3) to edit the actual coupling snippet.

The source code editor is the same as described in Sec. 7.3 with the only

difference that it has a additional region on its Source Code tab (↪→Fig. 426)

where you see the short names of all parameters you have selected on the

Parameter Specification page. These short names can be used as keys for

the input and output dictionary, respectively, by double-clicking on them.

Validity Shows whether the snippet is syntactically correct (↪→Sec. 5.10). For exam-

ple if you use non-existing short names in your snippet the syntax is correct

and this validity indicator shows no issues. However, the snippet is never-

theless inconsistent and cannot be evaluated correctly. This kind of error is

shown by the “global validity indicator” at the bottom of the form only.

{Global Parameters} If you have defined Global Parameters in your snippet you can set them at

the bottom of this page. ↪→Sec. 7.4

Figure 426. The Source Code tab of the source code editor for Parameter Coupling. Note the list of short names in the

lower right corner. Double-clicking on an entry in this list copies it to the current cursor position in your source code.

43.10.2 Effects of the Parameter Coupling

The parameter coupling has the following effects:

• During each simulation of the Optical Setup, the coupled parameters are calculated according to the

current configuration of the Optical Setup (especially the current value of those parameters used as input

of the coupling snippet).

• Changes in the Optical Setup can make the Parameter Coupling invalid, for example if you delete an

element which contains a parameter used in the coupling snippet. In this case Optical Setup simulations

are no longer possible, you have to first adapt the Parameter Coupling via its edit dialog – or switch it off

via the ribbon item Optical Setup > Use Parameter Coupling.
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• You can still edit the coupled parameters via the edit dialogs of the Optical Setup Elements and the

Definition of Basal Position and Orientation dialogs (↪→Sec. 43.8.2.4). However, if you close such a dialog

with OK, the coupled parameters you have just changed are reset and a warning is shown. Coupled

parameters in other dialogs are adapted to your changes without further notice.

• There are various places with a parameter specification table similar to that of the Parameter Coupling di-

alog: Parameter Overview (↪→Sec. 43.6.1), Parameter Run (↪→Sec. 44), PolarizationAnalyzer (↪→Sec. 87),

Parametric Optimization (↪→Sec. 102.1), and Export to optiSLang (↪→Sec. 124.1.1).

– In all these places, coupled parameters are grayed out as their actual values are determined by the

coupling snippet. You cannot change anything for them.

– In all these places but the Polarization Analyzer, the General Parameters (single values, vectors,

arrays, …) of the coupling snippet are available as additional parameters.

Fig. 427 shows an example.

• Also in the Parameter Overview Tree (↪→Sec. 43.7) the coupled parameters are grayed out and read-only.

• Coupled Parameters are not exported to the parameters.xml file generated by the batch mode export

(↪→Sec. 9) or optiSLang export, respectively.

• In the result table of the Parameter Run or the Parametric Optimization, the values of the coupled param-

eters are logged per simulation step.

Figure 427. The effect of Parameter Coupling in a parameter specification table (here: Parameter Overview).

First line: General Parameter of the coupling snippet

Second line: Coupled parameter (grayed out)

Third line: “Normal” parameter

43.11 Specific Optical Setups

Despite the General Optical Setup (which can be opened e. g. via the New button in the Start ribbon) there are

some optical setups available which support specific components with specific propagation operators.

Grating, Laser Resonator, Light Guide, and Light Shaping Optical Setups require the corresponding package

(↪→Sec. 1).

43.11.1 Grating Optical Setup

Via the menu items below Start > Gratings you can obtain preconfigured Optical Setups containing the following

Optical Setup Elements:

• Ideal Plane Wave (↪→Sec. 51.7)

• A grating component (↪→Sec. 64). Depending on the selected menu item this grating component contains

a preconfigured stack with the actual grating.

• Two Raw Data Detectors (↪→Sec. 74.5.5) for reflected and transmitted light, respectively

• Grating Order Analyzer (↪→Sec. 84)

If needed, further analyzers can be added in the resulting Optical Setup View.

For the propagation to the detectors a special Rayleigh expansion propagation (↪→Sec. 93.8) is used to adapt

for the periodic nature of the gratings.

The following restrictions apply to Grating Optical Setups.

• Optical Setup Elements but the analyzers cannot be deleted. The two detectors can be switched on and

off by deactivating the linkages leading to them.
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• The detectors are always parallel to the grating component. Thus isolated orientation of the grating

component is disabled.

• The position of the grating component cannot be changed. For detectors, only the z-position can be

changed.

43.11.2 Laser Resonator Optical Setup

For analyzing laser resonators an Optical Setup is required. This can be generated from the main window

via Start > Laser Resonators > Laser Resonator Optical Setup or via the session editor that is available from

Start > Laser Resonators > Laser Resonator Session Editor.

The Optical Setup will contain already the eigenmode analyzer that is not available in other Optical Setups. In

this type of Optical Setup, only this eigenmode analyzer can be processed.

It can be configured similar to other types of Optical Setups. However, an element from the section High

Reflective (Start) Mirrors has to be used as first element. In that category, ideal plane and spherical mirrors,

the stored mirror function, and the double surface component.

There are some restrictions for building up a valid resonator system in VirtualLab Fusion. These restrictions

are:

• The last element of the resonator has to be chosen from the category Outcoupling Mirrors. This category

contains an ideal plane, an ideal spherical and an ideal micro-structured mirror. Next to these mirrors the

user can select a double surface component or a programmable component for the element used for out

coupling.

• Reflection type reference coordinate systems are admissible for ideal plane or ideal spherical mirrors only.

A special component for a Laser Resonator Optical Setup is the Laser Crystal. The Laser Crystal can be used

stand alone as start and end element in a valid system definition for a laser resonator.

Figure 428. The tree of the Optical Setup View for a Laser Resonator Optical Setup.

Detectors that are used in the Optical Setup are computed once at the end of the eigenmode computation. For

that, the fundamental mode that has been computed is used.

43.11.3 Light Guide Optical Setup

A Light Guide Optical Setup always contains a Light Guide component (↪→Sec. 57.2) to which you can add a

restricted selection of light sources, components, and detectors. The Uniformity Detector (↪→Sec. 74.6.8) is

specific for this kind of Optical Setup.

For a Light Guide Optical Setup always manual channel configuration (↪→Sec. 43.9) is used.

43.11.4 Light Shaping Optical Setup

Via the menu item Start > Light Shaping > Light Shaping Light Shaping Optical Setup with Grating / Prism /

Mirror Cells you obtain a preconfigured Optical Setup containing the following Optical Setup Elements:

• Far Field Source (↪→Sec. 52.2)

• Plate (↪→Sec. 63) labeled as Light Shaper

• Camera Detector (↪→Sec. 74.5.2) which can be used either for the transmission type or the reflection type

reference coordinate system and
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• Local Linear Grating Analyzer (↪→Sec. 90) for grating cells light shaper .

Start > Light Shaping > Light Shaping Optical Setup opens an empty Optical Setup which can be configured

as Light Shaper. In any such Optical Setup the user can add any real optical component to the system, but it

has to be ensured that the output of the system is always a Camera Detector which has one active connection

to a light shaping component.

Light shaping component and Camera Detector must be parallel. Thus isolated orientation of the light shaping

component is disabled and the Camera Detector cannot be rotated.

All Simulation Engines (↪→Sec. 43.4) but Classic Field Tracing can be used. For General Profile the special

Cells Array Propagation (↪→Sec. 93.9) is used to reduce the numerical effort after the light shaping component.

44 Parameter Run

The Parameter Run document allows you to run several Optical Setup simulations (↪→Sec. 43), whereas for each

iteration one or more parameters have a different value. The results of the distinct Optical Setup simulations

are shown in a special table which allows further analyses. The variable parameters are listed in Sec. 43.5.

There are three steps in using the Parameter Run document which can be performed with the Next button.

1. Define the parameter sets to be used for the distinct Optical Setup simulations (↪→Sec. 44.2).

2. Set up the detecting devices whose results you want to analyze (↪→Sec. 44.4).

3. Start the parameter run and analyze its results (↪→Sec. 44.5). Only for this step the Parameter Run >

Go! ribbon item is enabled.

The Show button shows either the original, unmodified Optical Setup or the Optical Setup with the parameters

of a certain iteration step.

You can save the parameter run via the File menu or the Start ribbon tab. A newly opened parameter run derives

its settings from the last activated parameter run, including the settings of the Combined Outputs (↪→Sec. 44.5.1)

and the parameter to vary if applicable.

Handling of Obsolete Parameters

If you load a Parameter Run which has been saved in a previous version of VirtualLab Fusion, there

might be some obsolete parameters still present in the parameter specification table. On the other hand,

newly added parameters might not yet be available.

If no results have been calculated yet, the parameters are updated automatically. Otherwise, updating

the parameters would delete the results. Then or in case the Parameter Run is in Programmable mode,

only a warning is shown in both the Messages tab (↪→Sec. 4.3) and the window title (“⚠ Old Parameters

⚠”).

If one of the varied parameters changed, the Parameter Run cannot be configured and simulated any-

more. You can only analyze the results or Refresh the document via the ribbon (which deletes the

results).

44.1 Ribbon of the Parameter Run Document

The ribbon of the Parameter Run document has the following entries:

ITEM DESCRIPTION

Go! Allows you to start the actual parameter run. Only enabled if you are on the

Results page of the document window. During the parameter run, the button

changes into a Stop button which allows you to stop the calculation.
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After Completion For long running parameter runs it can be useful if after completion the Pa-

rameter Run saves itself and optionally the computer shuts down. This can

be defined with this option which is also available in the property browser

(↪→Sec. 4.3).

If the Parameter Run has not been saved before it is saved at {Path for
User Settings}\Autosaved Files. The Path for User Settings can be set

on the Saving tab of the Global Options dialog (↪→Sec. 6). Below this combo

box the used file name is displayed.

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Parameter Run for which this option is set.

Refresh Refreshes the document to use the current set of parameters. Note that this

deletes existing results. See also the note on handling of obsolete parameters

on page 501.

Show Optical Setup This button has two sub-entries:

• Show Initial Optical Setup: Shows the Optical Setup from which the

Parameter Run was originally created. This can be invoked directly if

the upper part of the Show Optical Setup button is clicked.

• Show Optical Setup for Certain Iteration Step…: Shows the Opti-

cal Setup with the parameters of a certain iteration step which can be

selected in a separate dialog.

No Logging During

Execution

If you press this button, the results of the individual iteration steps are only

written after the parameter run has finished. This improves performance es-

pecially in case of many fast iteration steps. If this button is not pressed the

results are written as soon as they are available. Note that this button is dis-

abled during an ongoing parameter run and that it can also be changed via

the Property Browser.

Create Output from

Selection

If you click this button, for each table row of the current selection a combined

output is generated as defined by the settings in the matching combined out-

put box (↪→Sec. 44.5.1). During the output creation, the button changes into

a Stop Output Creation button which allows you to stop the calculation.

Double clicking on a row header is a short cut for selecting this row completely

and clicking Create Output from Selection. Similarly, double-clicking a sin-

gle table cell is a short cut for selecting this row and clicking Create Output

from Selection. It is also possible to generate the combined output out of the

current selection via the context menu or the Create Output from Selection

button of the results table.

Delete Results Simply deletes all already calculated results. This can be useful as Parameter

Runs with results can be occupy much RAM or hard disc space.

44.2 Parameter Specification Page

The table on the Parameter Specification page shows you all parameters available for the underlying Optical

Setup. You can select which parameters to Vary and the corresponding value ranges.

With these settings you define a “parameter space”. There are four modes how the parameter sets for the

distinct iterations are determined from this parameter space.
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1. Standard Mode: All selected parameters are varied equidistantly from the minimum to the maximum of

the specified value range.

2. Programmable Mode: A snippet defines how the parameters are varied.

3. Scanning Mode: The parameter space is fully scanned in equidistant steps.

4. Random Mode: Uniformly distributed random combinations are used. Especially useful for Monte Carlo

simulations and tolerance analysis.

Fig. 429 shows an illustration of the different modes for a two-dimensional parameter space. The combo box

in the upper part of the Parameter Specification page (Fig. 430) allows you to select this Usage Mode.

Figure 429. Illustration of the different usage modes for the parameter run. A two-dimensional parameter space defined

by two parameters X1 and X2 is shown. Red: Resulting parameter sets for the standard mode. Green: Example how
the parameter sets can be generated by a snippet in the programmable mode. Blue: Resulting parameter sets for the

scanning mode. Grey: Some randomly generated parameter sets.

If you change the parameter specification page, the results table is cleared. But if applicable, results

from previous runs are kept.

Example: You start a parameter run varying a Length from 200mm to 400mm in 3 steps. After this

run has finished you decide that you want to use 4 steps. Then the results for a Length of 200mm and

400mm are kept as it is not necessary that they are calculated anew.

Figure 430. The Parameter Specification Page of the Parameter Run Document in Scanning Mode.
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The table lists all Parameters of all Objects which can be altered in the parameter run. Often, a Category

column is available to group similar parameters.

In the Vary column you must select one or more parameters which you want to alter in the parameter run. For

these parameters you can define the value range by setting the start (From) and end (To) value. The default

From and To values for all parameters are their absolute minimum and maximum values – you must not enter

a value outside of this range. It is possible to enter a To value which is smaller than the From value.

The Steps and the Step Size column are explained in the following subsections, as their meaning depends on

the Usage Mode. For your information also the Original Values of all parameters are given.

The first column allows you to collapse / expand all parameters of an Optical Setup Element or its categories.

Simply click on the and symbols, respectively. At the top of this column you can select to collapse all

levels (1), collapse only the Category level (2) or show all levels (*).

The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or the Parameter column pass this filter. The matching is case insensi-

tive. It is possible to search for multiple words and word groups embraced by

quotation marks, for example: "surface #1" scaling.

Show Only Varied Param-

eters

Only rows where the Vary column is checked pass this filter.

44.2.1 Notes on Standard Mode

In Standard mode the number of Steps is the same for all varied parameters. The specified value ranges are

split into equidistant sub-intervals. If you set Steps to 2, it means that a simulation is done for the From value

and To value, respectively. Instead of setting the number of Steps, you can alternatively set the Step Size.

In case of an integer parameter, the step size can become a fractional number, too. In this case the values

used for the distinct iterations are rounded to the closest integer.

44.2.2 Notes on Programmable Mode

Figure 431. The additional Parameter Specification page for the Programmable Mode of the Parameter Run.
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If you have chosen Programmablemode on the Parameter Specification page you can customize the individual

steps of the parameter run by programming a code snippet on an additional page (↪→Fig. 431). With this snippet

you define array entries parameters[i,j], which mean the value the ith varied parameter should have in the

jth iteration step. Here, varied denotes a parameter where you have checked Vary on the previous page. Keep
in mind that counting starts with zero: The value the second varied parameter should have in the fifth iteration

step, for example, is entered in parameters[1,4]. The following global parameters are available by default:

ITEM DESCRIPTION

NumberOfParameters The number of parameters with checked Vary column on the parameter spec-

ification page.

NumberOfIterations The number of Steps set on the parameter specification page.

MinimumValues The From values set on the parameter specification page. Index 0 of the array

represents the topmost parameter in the table.

MaximumValues The To values set on the parameter specification page. Index 0 of the array

represents the topmost parameter in the table.

This additional page has the following controls:

ITEM DESCRIPTION

Definition This group box allows you to program the actual code snippet. Edit opens the

Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent.

In the lower right corner of theSource Code tab of the source code editor there

is an additional button Add System Parameter. It opens a dialog where you

can enter one or more words to search for one or more specific parameters

of the underlying Optical Setup. The search is not case sensitive. When you

then press OK, a statement is added at the current cursor position to retrieve

the first of the selected parameters as PhysicalValue. (If you change the

index in this statement, you can access others of the selected parameters

but the first one.)

Parameters The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

More information about programming can be found in Sec. 7.

After you have set up the snippet, you can verify it on the subsequent Parameter Visualization page

(↪→Sec. 44.3). It shows a table visualizing the specified parameters array in a more readable form. If you

have specified an array entry whose indices are not allowed (e. g. parameters[-1,-1]), the table remains

empty. If you have specified a value which is out of the allowed value range (i. e. the default From - To interval)

of the corresponding parameter, this value is marked red.

44.2.3 Notes on Scanning Mode

In Scanningmode each parameter can be varied with its own number of Steps. The specified value ranges are

split into equidistant sub-intervals. All possible parameter combinations are calculated which means that the

overall number of iterations is the product of the number of steps for each parameter.

If you set Steps to 2 for a certain parameter, it means that the From value and To value, respectively, are taken

into account. Instead of setting the number of Steps, you can alternatively set the Step Size.

In case of an integer parameter, the step size can become a fractional number, too. In this case the values

used for the distinct iterations are rounded to the closest integer.
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44.2.4 Notes on Random Mode

Figure 432. The available settings for the random mode

InRandommode the number of Steps is the same for all varied parameters. For this mode the following settings

are available (↪→Fig. 432):

ITEM DESCRIPTION

{Distribution drop down} The values distributed randomly within the specified parameter ranges can

follow one of the following distributions

• Uniform Distribution: All values of the specified parameter ranges have

the same probability.

• Normal Distribution: The values follow a Gaussian normal distribution.

Note that this distribution is defined for an infinite value range and thus

some values might be out of the actual parameter range. How many

values are out of the parameter range depends on the width of the nor-

mal distribution which can be configured with the setting The parameter

range corresponds to.

• Cutoff Normal Distribution: Same as Normal Distribution with the differ-

ence that if a value would be outside the specified parameter range, a

new random number within the parameter range is generated.

Fig. 433 shows an example of the various distributions.

Set Seed Manually (to) Always a fixed seed is used with which the generation of the random numbers

starts. If you check this option, you see the used Seed which then you can

alter if you want to use another random number distribution.

The parameter range cor-

responds to

O N D C N D

With this setting you can specify how broad the normal distribution is relatively

to the parameter ranges defined by the user. If you keep the default value of

3, then the parameter ranges correspond to the 3σ interval of the normal

distribution, i. e. 99.73 % of all values are within the parameter ranges.

Figure 433. Histogram of 5 000 values distributed randomly in the range -1 … +1.

Left: Uniform Distribution, middle: Normal Distribution, right: Cutoff Normal Distribution.

For Normal Distribution and Cutoff Normal Distribution, the range of -1 … +1 corresponds to -2.5σ… +2.5σ.
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44.3 Parameter Visualization Page

This page simply shows the value of each varied parameter in each iteration of the Parameter Run. Invalid

entries (especially resulting from wrong snippets in Programmable Mode) are marked red.

Note that if you enter this page, iterations having exactly the same varied parameters are merged into one.

In this case you see fewer iteration steps than you have specified in the Parameter Specification Page

(↪→Sec. 44.2) and a warning is shown. This mechanism speeds up further calculations.

With Ctrl +C you can copy the currently selected cells to the Windows™ clipboard. With the Show Physical

Units option of the property browser (↪→Sec. 4.3) you can convert all values to their respective base unit and

omit all units. For example, “1 nm” will then be shown as “1e-9” and “180°” will be shown as “3.1416”. This

simplifies using the copied values in external programs.

Figure 434. The Parameter Visualization page if three parameters are varied randomly.

44.4 Detecting Devices Specification

Figure 435. The Detecting Devices Specification Page of the Parameter Run Document.



CHAPTER 44. PARAMETER RUN 508

On this page you can select one or more detecting devices whose results you want to analyze. It is ensured

that at least one detecting device is selected.

It has the following controls.

ITEM DESCRIPTION

Ray Results Profile This check box allows you to check or uncheck both Detectors [Rays] and

System: 3D at once. It is marked as if only one of these two options has

been selected.

Detectors [Rays] If checked the detectors specified in the detector table (see below) are used

for this profile.

System: 3D If checked a 3D view of the rays propagating through the Optical Setup is

generated for each iteration. ↪→Sec. 17.1

General Profile This check box allows you to check or uncheck both Detectors [General] and

Modeling Analyzer at once. It is marked as if only one of these two options

has been selected.

Detectors [General] If checked the detectors specified in the detector table (see below) are used

for this profile.

Modeling Analyzer If checked the modeling analyzer (↪→Sec. 43.4.6) is executed for each itera-

tion.

{Detector Table} Lists all available detectors (↪→Part XI). You can select which detectors shall

be evaluated. If you click on theOpen button of any detector, the correspond-

ing edit dialog is displayed.

{Analyzer Table} Lists all available analyzers (↪→Part XII). You can select which analyzers shall

be evaluated. If you click on theOpen button of any analyzer, the correspond-

ing edit dialog is displayed.

Classic Field Tracing If you check this option, the selected detectors are also analyzed with Classic

Field Tracing.

Validity This control (↪→Sec. 5.10) checks that at least one detector has been selected

and warns if the current configuration might be other than intended.

Note that depending on context not all of these controls might be visible. For example the analyzer table

vanishes if there are no analyzers in the Optical Setup.

If you change the Detecting Devices page, the results table is cleared.
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44.5 Results Page

Figure 436. The layout of the results table. In this example three iteration steps were calculated where the wavelength is

varied from 1 µm to 3 µm and the weight is varied from 1 to 3 at the same time.

The Go! button starts the parameter run. After clicking, the button changes into a Stop button which allows

you to stop the calculation. Then the Stop button becomes a Go! button again which allows you to continue

the calculation later. The Parameter Run ribbon tab contains a button with the very same functionality.

In the upper right corner you can see and change the number of parallel iterations (↪→Sec. 6.15) for this Param-

eter Run. In case distributed computing is activated (↪→Sec. 8), you see the number of clients and can activate

their configuration here.

The parameter run fills a table where the results of each Optical Setup simulation are shown in a separate

column. Each detector is shown in a single row. If a detector consists of several sub-detectors (e. g. the

beam parameters detector, ↪→Sec. 74.6.1), their results are shown in separate rows. The columns are sorted

ascending by iteration number and the rows are sorted numerically by the index of the detector and then

alphabetically. Thus the position of a certain result can change while new results are being calculated. During

calculation the table always scrolls to the most recent result. The table layout is illustrated in Fig. 436.

The varied parameters per iteration step are shown in separate rows at the top of the table.

The number of shown digits can be changed via the Number of Digits setting in the property browser. The

Format of Complex Numbers can also be changed there. The default values of both settings are taken from

the Global Options dialog (↪→Sec. 6.5).

You can select a subset of all results by clicking on the column or row headers or by directly selecting a cell

range. This selection can be copied to the Windows™ clipboard via the context menu or the shortcut Ctrl+C .
With the Show Physical Units option of the property browser (↪→Sec. 4.3) you can convert all values to their

respective base unit and omit all units. For example, “1 nm” will then be shown as “1e-9” and “180°” will be

shown as “3.1416” (if Number of Digits is set to 5). This simplifies using the copied values in external programs.

By default the rows are sorted alphanumerically by the Detector and the Subdetector. Using the Sort Rows op-

tion of the property browser (↪→Sec. 4.3) you can ensure that the same order as on the Parameter Specification

page is used.

The Combined Output column contains a control to configure the Combined Output for each row separately.

This control and which combined outputs are available is explained in Sec. 44.5.1. Additionally, the following

controls are available:
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ITEM DESCRIPTION

Create Output from Se-

lection

For each table row of the current selection a combined output is generated as

defined by the settings in the matching combined output box (↪→Sec. 44.5.1).

This button has the same functionality as the corresponding ribbon button

(↪→Sec. 44.1).

Use Already Calculated

Results for Next Run

If you check this checkbox, already calculated results are kept for the next

parameter run simulation. To ensure that this caching mechanism is used as

often as possible, this checkbox is checked again after each simulation.

Filter Rows by … Applies a search string to the table. Only rows matching the given string are

shown, whereas the following rules apply:

• The search is not case sensitive, i. e. lens, Lens, and LENS yield the

same results.

• It is possible to search for multiple words and word groups embraced by

quotation marks. Rows containing at least one of these words or word

groups in any of their cells are shown.

• A - in front of a word or word group means ‘not’, e. g. -lens shows all
lines not containing ‘lens’.

• Expressions in quotation marks are searched as entered. For exam-

ple ``-2.5'' searches for the number -2.5, not for rows not containing
2.5. And ``Lens System'' searches for rows containing directly “lens
system”, not for rows containing “lens” or “system”.

44.5.1 Combined Outputs

There are different types of parameter run results (e. g. physical values, harmonic fields (sets), or data arrays).

Out of a one-dimensional selection of such parameter run results (that is a table row), various combined outputs

can be derived. Combined Output means that the distinct parameter run results are plotted over the iteration

parameter ξ. Because of this the combined output has always one dimension more than the individual param-

eter run results. For example out of several one-dimensional results f (x) a two-dimensional combined output
f (ξ, x) is obtained (↪→Fig. 437). The only exception from this rule is that you can plot single physical values into

two-dimensional data arrays if there are exactly two varied parameters.
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Figure 437. Two-dimensional Data Array as combined output for one-dimensional fields. Here the iteration parameter is

the distance behind a lens.

Usually the iteration parameter is the Iteration Step (= the column headers). But if only one parameter is varied

and you do not create a combined output for this varied parameter, then the iteration parameter is the varied

parameter itself. With the option Always Plot versus Iteration Step in the Property Browser you can enforce

that always the Iteration Step is used as iteration parameter. In the combined output the results are sorted by

the iteration parameter.

The available types of combined outputs are summarized in the following table.

COMBINED OUTPUT DESCRIPTION

Data Array

(For physical values)

Combined output where the physical values are plotted on the y-axis versus

the iteration parameter on the x-axis. Does not work for single physical val-

ues.

If there are exactly two varied parameters you can also select other more

understandable types of data arrays as output, ↪→Sec. 44.5.1.1.

Harmonic Fields Set

(For harmonic fields)

All selected (member) fields (of a harmonic fields set) are simply placed into

one harmonic fields set.

2D Data Array

(For one-dimensional har-

monic fields)

For each value of the varied parameter (plotted along the x-axis), the field

values are plotted along the y-axis. In case of harmonic fields sets, one subset

per mode is created.

Further information and an example for this combined output can be found in

Sec. 44.5.1.2.

Animation

(For two-dimensional har-

monic fields)

Either the selected field quantities or the light view of the selected two-

dimensional harmonic fields (sets) are shown as an animation (↪→Sec. 20).

Further information for this combined output can be found in Sec. 44.5.1.3.

Animation

(For 2D / gridless data ar-

rays or corresponding sets

of data arrays)

Shows the selected subsets of the selected data arrays as an animation

(↪→Sec. 20).

Further information for this combined output can be found in Sec. 44.5.1.4.
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1D / 2D / Gridless Data Ar-

ray

(For 1D / 2D / gridless data

arrays or corresponding sets

of data arrays)

This combined output offers two modes: either all subsets are merged into

a single data array which might require interpolation and embedding of the

data. The other mode is that the subsets are put into different data arrays of

a Set Of Data Arrays so that no interpolation is necessary. Furthermore you

can choose which subsets are considered (and which data arrays for Sets of

Data Arrays).

Further information for this combined output can be found in Sec. 44.5.1.5.

2D Data Array

(For 1D data arrays)

For each value of the varied parameter (plotted along the x-axis), the values

of the resulting 1D data array are plotted along the y-axis. Different subsets

in the original data arrays become different subsets in the resulting data ar-

ray. The resulting data array inherits the interpolation from the original data

arrays.

In case the size of the original data arrays differs from iteration to iteration,

the set of coordinates of the resulting array will be a union of the coordinate

sets of all original arrays. The data of the source data arrays will be interpo-

lated to this new grid. Usually, this merge mode will lead to a non-equidistant

coordinate grid, but no data will be lost since all of the original data points will

be kept.

1D / 2D Chromatic Fields

Set

(For 1D / 2D Chromatic Fields

Sets)

All selected Chromatic Fields Sets are added incoherently to a newChromatic

Fields Set.

2D Chromatic Fields Set

(For 1D Chromatic Fields

Sets)

For each value of the varied parameter (plotted along the x-axis), the values

of the resulting 1D Chromatic Fields Set are plotted along the y-axis.

All original Chromatic Fields Sets must have the same sampling which can

be achieved by configuring the detector generating these Chromatic Fields

Sets accordingly (↪→Sec. 74.1.1).

Animation

(For two-dimensional Chro-

matic Fields Sets)

For each selected Chromatic Fields Set a bitmap is generated according to

the settings in the edit dialog (↪→Sec. 44.5.1.6) of the combined output. Each

of these bitmaps then becomes one frame of the final animation.

Animation

(For Order Collections)

For each Order Collection a bitmap is generated according to the settings

in the edit dialog (↪→Sec. 44.5.1.7) of the combined output. Each of these

bitmaps then becomes one frame of the final animation.

Animation

(For Ray Distributions)

For each Ray Distribution a bitmap is generated which resembles the actual

document view (↪→Sec. 17). Each of these bitmaps then becomes one frame

of the final animation.

You can set the view settings applied to the Ray Distribution document prior

to the conversion into a bitmap using the dialog described in Sec. 17.2.3.

Ray Distribution

(For Ray Distributions)

All Ray Distributions are merged into a single Ray Distribution as separate

modes.

Single Documents

(For harmonic fields & data

arrays)

The selected documents are just shown as separate document windows. This

combined output is always used if only a single document is to be shown. For

harmonic fields (sets) the settings of the Raw Data Detector which generated

these fields are used.
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In the Combined Output column of the results table, there is a control where you can select one of the combined

outputs suitable for the results in that column. If the currently selected combined output has specific options,

they can be changed via a -button.

44.5.1.1 Data Array Combined Output for Physical Values and Two Varied Parameters.

Figure 438. The edit dialog for the combined output of physical values if exactly two parameters are varied.

If there are exactly two varied parameters plotting the physical values in a somehow two-dimensional data array

is far more understandable than plotting them in a simple one-dimensional data array.

Thus in this case you can open a dialog (↪→Fig. 438) to select the output type most appropriate for your needs.

Fig. 439 shows an example of the various output types.

Figure 439. The various output types for physical values. In this example both wavelength and polarization angle were

varied for a grating and the efficiency of the zeroth transmitted order is shown. From left to right: Plot All Data on One

Axis, 1D Multigraph, 2D Gridded, and 2D Gridless.

The edit dialog has the following options.
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ITEM DESCRIPTION

Plot All Data on One Axis /

Separate Varied Parame-

ters along 2 Dimensions

If you select Plot All Data on One Axis, the data is simply plotted versus iter-

ation step into a one-dimensional data array. This is the kind of output you

obtain if there are not exactly two varied parameters. The left-most image of

Fig. 439 shows an example for this.

On the other hand, if you select Separate Varied Parameters along 2 Dimen-

sions the data is shown in a somehow two-dimensional data array – how

exactly is defined by the Data Array Type and Abscissa setting, respectively.

Data Array Type There are three possibilities how the data can be plotted along 2 Dimensions.

• 1D Multigraph: One varied parameter is taken as abscissa. The

other parameter is “stacked” into several subsets. In Multigraph mode

(↪→Sec. (b)), which is the default for this output type, you see them as

separate data rows. In the second image of Fig. 439 the data is plotted

versus wavelength and you see one data row per polarization angle.

• 2D Gridded: The data is plotted in a two-dimensional gridded data array

(one parameter plotted on the abscissa, one on the ordinate. This type

is appropriate if the data is on a regular grid, i. e. if it was obtained with

the scanning mode of the Parameter Run (↪→Sec. 44.2).

• 2DGridless: The data is plotted in a two-dimensional gridded data array

(one parameter plotted on the abscissa, one on the ordinate. This type

is more appropriate if the data was not obtained with the scanning mode

of the Parameter Run.

Abscissa Defines which of the two varied parameters is plotted on the abscissa.

If the data was not obtained with the scanning mode of the Parameter Run or not all parameter combinations

have been calculated, the data may not be on a regular grid. To create gridded data arrays nevertheless,

missing grid positions are filled up with NaNs (= “Not a number”). This applies to the 1D Multigraph and the 2D

Gridded type, respectively. In such a case, using linear interpolation is pointless. Thus these data array types

are not shown with linear interpolation by default, which you can change later on (↪→Sec. 11.2.1, Sec. 11.2.2).
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44.5.1.2 2D Data Array Combined Output

Figure 440. Settings for the 2D Data Array combined output, here in Manual Settings mode.

This combined output creates a two-dimensional data array by plotting the varied parameter along the x-axis

and the field values of one-dimensional fields along the y-axis. However, each of the fields to be combined

might have its own sampling – which is not allowed for data arrays. Thus the dialog shown in Fig. 440 offers

the following ways to unify the field sampling:

ITEM DESCRIPTION

Inherit Field Size All fields are shown with the default number of sampling points and stretched

to fill the data array window. This means that all fields are shown completely

even if they have very different physical extensions.

Manual Setting Allows you to set Sampling Points, Sampling Distance and / or Array Size of

the y-dimension of the resulting data array manually.

Only two of these three settings can be changed at the same time. The re-

maining property is calculated automatically.

Automatic Setting The y-extension of the resulting data array is Size Factor times the size of

the largest harmonic field (in physical coordinates). Size factors larger than 1

just embed the result while size factors between 0 and 1 cut off a part of the

result.

By default, the default number of sampling points is used to sample the lateral

extension. A finer sampling with more sampling points can be defined with a

larger Oversampling Factor.

The default number of sampling points is the number of sampling points as set up in the Global Options dialog

(Sampling subcategory, ↪→Sec. 6.12) for the x-direction.

Fig. 441 shows an example for Inherit Field Size and Automatic Setting.
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Figure 441. Propagation of a divergent Gaussian beam, shown with “Automatic” (left) and “Inherit” (right) sampling. For

larger beam diameters the amplitude becomes smaller. Thus the beam seems to get smaller in “Inherit” mode.

44.5.1.3 Animation Combined Output for Harmonic Fields

Figure 442. Edit dialog for animation combined output.

On the first tab of this dialog (↪→Fig. 442) you can choose whether you want to see the Light View (↪→Sec. 12.2.1)

or the Data View (↪→Sec. 12.2.2) of the fields in an animation. In case of Light View, the real color view is

animated if each iteration has at least one visible wavelength. Otherwise the linear intensity view is animated.

In case of Data View, you can configure on the Image Options (↪→Sec. (a)) tab which field quantities are to be

shown in which way.

In both cases you can adjust the sampling on the Bitmap Resolution (↪→Sec. (b)) tab.

(a) Image Options Tab
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An animation is a sequence of individual bitmap images (↪→Sec. 20). The controls of this tab (↪→Fig. 443)

determine how these individual bitmap images are created from the given harmonic fields.

ITEM DESCRIPTION

Use Twin Image Repre-

sentation

If checked, each bitmap image is composed of two images side by side, which

are created from the same field using different color mapping settings (see

below).

Set Options for Image With this item, available if the check box Use Twin Image Representation is

enabled, the part of the image (Left or Right) can be chosen for which the

options shall be edited.

Color Mapping The controls within this group are used for several dialogs and are therefore

described in Sec. 5.11 in detail. If you create an animation of a phase distri-

bution, an analytical spherical phase radius is ignored.

Figure 443. Image options for animation combined output.

(b) Bitmap Resolution Tab

This tab page (↪→Fig. 444) determines the resolution of the resulting bitmaps. It offers three ways to define the

field sampling:
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ITEM DESCRIPTION

Inherit Field Size All fields are shown with the default number of sampling points and stretched

to fill the animation view. This means that all fields are shown completely

even if they have very different physical extensions.

Manual Setting Allows you to set Pixels, (physical) Pixel Size and / or (physical) Bitmap Size

manually.

Only two of these three settings can be changed at the same time. The re-

maining property is calculated automatically.

Automatic Setting The shown bitmap size is Size Factor times the size of the largest harmonic

field (in physical coordinates). Size factors larger than 1 just embed the result

while size factors between 0 and 1 cut off a part of the result.

By default, the default number of sampling points is used. A finer sampling

with more sampling points can be defined with a larger Oversampling Factor.

The default number of sampling points is two times the number of sampling points as set up in the Global

Options dialog (Sampling subcategory, ↪→Sec. 6.12).

Figure 444. Bitmap resolution settings for animation combined output.

44.5.1.4 Animation Combined Output for Data Array and Sets of Data Arrays

This combined output allows you to show selected subsets of selected data arrays as frames of an animation

(↪→Sec. 20). To this end, the individual subsets are interpolated and filled up with zero values so that all subsets

have the same coordinate range with the same sampling. The subsets are sorted so that all subsets of the first

data array are shown first, then all subsets of the second data array and so on.
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Figure 445. Settings for animation combined output.

The edit dialog of this combined output (↪→Fig. 445) has the following controls:
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ITEM DESCRIPTION

All Data Arrays /

Single Data Array

O S D A

With the Single Data Array option you can choose the index of one specific

data array for which the animation is generated. Otherwise All Data Arrays

are shown. ↪→Sec. 44.5.1.5

All Subsets /

Single Subset

With the Single Subset option you can choose the index of one specific sub-

set for which the animation is generated. Otherwise All Subsets are shown.

↪→Sec. 44.5.1.5

Field Quantity Defines the field quantity to be shown in the resulting animation. Only has an

effect if the input data arrays are complex-valued.

Aspect Ratio The aspect ratio of the resulting animation is determined in different ways:

• True to Physical Scale: The aspect ratio is determined from the ratio of

the x-axis range of the data array to its y-axis range. This option is not

available if the two coordinate axes have different physical properties.

• User-Defined: If you choose this option you can define a suitable aspect

ratio. For example you can use 16 : 9 to ensure that the animation (and

a video possibly generated out of it via File > Export) looks nicely on

matching monitors or projectors. For gridded data arrays the default

user-defined aspect ratio is calculated from the number of data points

in the data array.

• Free: You can setWidth and Height of the single bitmaps as you want.

Width /Height The width and height of the resulting bitmaps. If the Aspect Ratio is not Free

and you change one dimension, then the other dimension is always changed

automatically.

Scale Frames to • Common Value Range: The global minimum and maximum value of all

subsets is used to scale the color table. As a result you can see in which

subsets there are smaller values then in others.

• Individual Value Range: The color table for each frame is adapted to

the minimum and maximum value of the individual data. As a result all

subsets use all colors of the color table.

• User-Defined Value Range: The user can enter the minimum and max-

imum value which is used to scale the color table.

44.5.1.5 Data Arrays Combined Output for Data Array and Sets of Data Arrays

This combined output offers two modes:

1. All subsets are merged into a single data array. Because all subsets must have the same coordinate

range with the same sampling, the individual subsets are interpolated and filled up with zero values if

necessary. This is the same behavior as for the appending manipulation of data arrays (↪→Sec. 24.5.2).

2. The subsets are put into different data arrays of a Set Of DataArrays so that no interpolation is necessary.

(If Sets of Data Arrays are combined, the subsets of one data array remain in one data array.)

The dialog shown in Fig. 446 also allows you to define that either one specific subset is taken from each iteration,

or all subsets. In the same manner, you can define for Sets of Data Arrays that either one data array is taken

from each iteration, or all data arrays.
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Figure 446. The edit dialog for Sets of Data Arrays with gridded data arrays.

Figure 447. Control for entering the desired data array or subset index. With the arrow buttons you can decrease / in-

crease the index by one. The control also shows the maximum index you can set.

ITEM DESCRIPTION

All Data Arrays O S D A .

If you choose this option, all data arrays are used for the combined output.

Single Data Array O S D A D A .

If you choose this option, one specific data array is extracted from the Set of

Data Arrays result of each iteration. You can set the index of the data array

to extract via entering it directly into the control shown in Fig. 447 or by using

the arrow buttons in said control.

All Subsets If you choose this option, all subsets are used for the combined output.

Single Subset O S .

If you choose this option, one specific subset is extracted from each data

array. You can set the index of the subset to extract via entering it directly into

the control shown in Fig. 447 or by using the arrow buttons in said control.

Data Array N

In this case you obtain one single Numerical DataArray as combination result

which contains all the data in separate subsets. The data is interpolated and

embedded as described in Sec. 24.5.2. The order in that data arrays is as

follows: First come all subsets from the first data array from the first iteration,

then all subsets from the second data array of the first iteration and so on.

Set of Data Arrays In this case you obtain one single Set of Data Arrays as combination result.

The first data array of this document contains all subsets from the first data

array from the first iteration, the second data array contains all subsets from

the second data array from the first iteration and so on. In this way no data

needs to be resampled.

An example illustrating the effect of the settings explained above: Assumewe have 7 iterations. In each iteration

a Set of Data Arrays with 3 data arrays is created; each data array has 2 subsets. Then you obtain the following

results.
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DATA ARRAY

AS COMBINATION RESULT

SET OF DATA ARRAYS

AS COMBINATION RESULT

All Data Arrays,

All Subsets

Data Array with 42 subsets Set of Data Arrays with 21 data arrays,

each having 2 subsets

All Data Arrays,

Single Subset

Data Array with 21 subsets Set of Data Arrays with 21 data arrays,

each having 1 subset

Single Data Array,

All Subsets

Data Array with 14 subsets Set of Data Arrays with 7 data arrays,

each having 2 subsets

Single Data Array,

Single Subset

Data Array with 7 subsets Set of Data Arrays with 7 data arrays,

each having 1 subsets

44.5.1.6 Animation Combined Output for 2D Chromatic Fields Sets

Figure 448. Edit dialog of the Animation Combined Output for two-dimensional Chromatic Fields Sets.

In the edit dialog of the Animation Combined Output for two-dimensional Chromatic Fields Sets (↪→Fig. 449)

you can set the following:
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ITEM DESCRIPTION

Real Color /

False Color

Allows you to set the color mode (↪→Sec. 14.2) used for the bitmap generation.

In Real Color wavelengths out of the visible range are shown black.

{Color Table Button} O F C .

Allows you to select the color table (↪→Sec. 11.2.4).

All Wavelengths /

Single Wavelength

Either All Wavelengths of the shown Chromatic Fields Up are summed in the

resulting bitmap. Or you can select the index of the Single Wavelength to be

shown either via the arrow buttons or by entering it directly.

Aspect Ratio The aspect ratio of the resulting animation is determined in different ways:

• True to Physical Scale: The aspect ratio is determined from the ratio of

the x-axis range of the data array to its y-axis range. This option is not

available if the two coordinate axes have different physical properties.

• User-Defined: If you choose this option you can define a suitable aspect

ratio. For example you can use 16 : 9 to ensure that the animation (and

a video possibly generated out of it via File > Export) looks nicely on

matching monitors or projectors. For gridded data arrays the default

user-defined aspect ratio is calculated from the number of data points

in the data array.

• Free: You can setWidth and Height of the single bitmaps as you want.

Width /Height The width and height of the resulting bitmaps. If the Aspect Ratio is not Free

and you change one dimension, then the other dimension is always changed

automatically.

Scale Frames to • Common Value Range: The global minimum and maximum value of all

subsets is used to scale the color table. As a result you can see in which

subsets there are smaller values then in others.

• Individual Value Range: The color table for each frame is adapted to

the minimum and maximum value of the individual data. As a result all

subsets use all colors of the color table.

• User-Defined Value Range: The user can enter the minimum and max-

imum value which is used to scale the color table. In Real Color mode

zero values always correspond to black. Thus you cannot set the mini-

mum value.
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44.5.1.7 Animation Combined Output for Order Collections

Figure 449. Edit dialog of the Animation Combined Output for Order Collections.

In the upper part of the edit dialog of the Animation Combined Output for Order Collections (↪→Fig. 449) you

can define which coordinates are used to plot which data of the individual orders. In the lower part you can

define properties of the resulting bitmaps.

In detail:
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ITEM DESCRIPTION

Coordinate Type The coordinates versus which the individual orders are plotted: either the

order numbers, the spherical angles θ and φ, the Cartesian angles α and β,

the wave vector components kx and ky, or the position (x; y).

Data to Show Allows to set whether the efficiencies or certain Rayleigh coefficients (Ex, Ey,

Ez, TE, TM) of the orders are shown.

Field Quantity If you want to show Rayleigh coefficients, you must also select which part of

its complex value is to be shown.

Selection Strategy With this option you can restrict the shown orders. The following three strate-

gies are available:

• All: No restrictions apply

• Above Efficiency Threshold: Only (propagating) orders above the

given Efficiency Threshold are shown.

• Order Range: All orders in the range between Minimum Order (inclu-

sive) and Maximum Order (inclusive) are shown.

Note that evanescent orders are only shown if order numbers or wave

vector components are used as Coordinate Type.

Largest Dimension in Pix-

els

Either height or width (whatever is larger) of the resulting bitmaps in pixels.

Dot Size The size of the dots representing the orders in pixels.

Scale Each Bitmap Indi-

vidually

If checked each bitmap uses the complete color range defined by the Color

Table. Otherwise a global scaling is applied so that you can see e. g. bright-

ness differences between different bitmaps.

Color Table If you click on this button you can select the color table to be used.

Background Color The color used for those regions of the bitmap where no dots are drawn.

44.6 Iteration Document

The Eigenmode Analyzer (↪→Sec. 89) generates iteration documents which simply consist of the Results page

of the parameter run document (↪→Sec. 44.5). It has the following ribbon entries:

ITEM DESCRIPTION

Go! Allows you to start the actual iteration. While the iteration is in progress, the

button changes into a Stop button which allows you to stop the calculation.

After Completion For long running iterations it can be useful if after completion the Iteration

Document saves itself and optionally the computer shuts down. This can

be defined with this option which is also available in the property browser

(↪→Sec. 4.3).

If the Iteration Document has not been saved before it is saved at {Path for
User Settings}\Autosaved Files. The Path for User Settings can be set

on the Saving tab of the Global Options dialog (↪→Sec. 6). Below this combo

box the used file name is displayed.

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Iteration Document for which this option is

set.



CHAPTER 45. LLGA RESULTS GENERATOR 526

Show Optical Setup Shows the Optical Setup from which the Iteration Document was originally

created.

No Logging During

Execution

If you press this button, the results of the individual iteration steps are only

written after the complete iteration has finished. This improves performance

especially in case of many fast iteration steps. If this button is not pressed

the results are written as soon as they are available. Note that this button is

disabled during an ongoing iteration and that it can also be changed via the

Property Browser.

Create Output from

Selection

If you click this button, for each table row of the current selection a combined

output is generated as defined by the settings in the matching combined out-

put box (↪→Sec. 44.5.1). During the output creation, the button changes into

a Stop Output Creation button which allows you to stop the calculation.

Double clicking on a row header is a short cut for selecting this row completely

and clicking Create Output from Selection. Similarly, double-clicking a sin-

gle table cell is a short cut for selecting this row and clicking Create Output

from Selection. It is also possible to generate the combined output out of the

current selection via the context menu or the Create Output from Selection

button of the results table.

45 LLGA Results Generator

Availability

Toolboxes: Grating Package

Accessible: Main Window: Start > Grating > LLGA Results Generator

The Local Linear Grating Approximation (LLGA) approach decomposes an arbitrary structure into a set of

simple gratings. For such a set of simple gratings, the LLGA Results Generator can calculate rigorous results

(Rayleigh coefficients per order for both Ex- and Ey-polarization) by means of the Fourier Modal Method (FMM,

↪→Sec. 96.3). For each grating to analyze, the LLGA Results Generator requires period, rotation angle, and

incident angle of the incoming light. Furthermore it has to know

• the wavelength of the incoming light

• the complex refractive index before and after the gratings and

• the range of diffraction orders for which results shall be calculated .

A LLGA Results Generator containing this imported information can be either obtained from the Local Linear

Grating Analyzer (↪→Sec. 90) or from a matching XML file via Start > Grating > LLGA Results Generator.

The results of the LLGA results generator are either added to the imported XML file or written in a new XML

file with the same structure.
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Figure 450. The document window of the LLGA Results Generator.

Some Additional Grating Parameters needed to build up the grating structure are not part of the imported

information but can be specified in the document window of the LLGA Results Generator. This window has the

following options.
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ITEM DESCRIPTION

Grating Type The assumed type of the gratings. In the moment only sawtooth gratings are

available.

Number of Height Levels A continuous height profile is always converted into a quantized one for the

FMM. More height levels mean a higher numerical effort of the FMM.

If your structure will be fabricated quantized you may enter the fabricated

number of height levels.

Modulation Depth Themodulation depth of all gratings; i. e. the height difference between lowest

and highest height level.

Number of Evanescent Or-

ders

The FMM calculates all propagating orders and the specified Number of

Evanescent Orders. More evanescent orders lead to more accurate results,

but both calculation time and memory consumption increase.

The order range specified in the imported information only defines how many

orders are written into the resulting XML file.

Use TEAMode for Periods

larger than

The computational effort of the FMM increases not only with the number of

evanescent orders but also with the number of propagating orders. Thus

large periods cannot be calculated well with the FMM. However, the thin ele-

ment approximation (TEA) is sufficient for large periods (roughly five times the

wavelength or larger). Thus TEA instead of FMM is used for periods larger

than the given threshold.

Keep Already Calculated

Results

If the imported XML file already contains some results, you can either choose

to calculate all results anew or to Keep Already Calculated Results. Note that

the latter should only be used if a calculation was stopped for some reason

and you restart it with exactly the same settings.

Go! If clicked the calculations are started and the Go!-button turns into a

Stop-button to interrupt the calculations. As the LLGA Results Generator

uses a document window you can continue to work with other documents

or dialogs during the calculations.

(Export) The button at the bottom of the dialog can be used to trigger the export of

the calculated lookup table into an XML file. The file contains all parameter

sets of the lookup table as well as the already calculated results. Attention:

For large lookup tables the XML format can result in very large files.

The LLGA Results Generator calculates the efficiency of the grating cells array during the rigorous evaluation.

This efficiency is defined by

ηtotal =
∑s ∑l ∑j ws ·

∣∣∣Abefore GCA
j,l,s

∣∣∣2 · ηj,l,s

∑s ∑l ∑j ws ·
∣∣∣Abefore GCA

j,l,s

∣∣∣2 (45.1)

using the following input variables
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ITEM DESCRIPTION

ηtotal The averaged efficiency of the grating cells array.

ηj,l,s The efficiency of the first order (working order) for one cell of the grating cells

array for one wavelength and one lateral mode.

j The index for all cells of the grating cells array.

l The index of the lateral modes.

s The index of the spectral modes.

ws The weights for the specific wavelength.

Aj,l,s The field value of the electric field that hits the specific cell.

For the evaluation of the efficiency only the first order (working order) is taken into account. The result is logged

into the Detector Result tab page of the main window.

46 LUT Results Generator

This document type is generated by the Grating Channel Analyzer (↪→Sec. 91) if the light guides in the optical

system contain channels for which rigorous results are still to be calculated. It allows you to continue your tasks

while the rigorous calculations are done – or do these calculations on another computer. When the calculations

are finished a copy of the original Optical Setup is generated with the calculated rigorous results set to the

corresponding grating regions (↪→Sec. 42).

Figure 451. The General tab of the document window of the LUT Results Generator.

The corresponding document window (↪→Fig. 451) has the following options.
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ITEM DESCRIPTION

{General tab} On this tab you can define whether already calculated results are kept or

whether to Clear Lookup Tables before Calculation. Furthermore this tab

contains information about the Number of Lookup Tables and the progress

of the running calculations.

{Custom Fourier Modal

Method}

On this tab you can define whether you want to use your own Fourier Modal

Method or the one implemented in VirtualLab Fusion. See Sec. 96.4 for de-

tails.

Go! If clicked the calculations are started and the Go!-button turns into a

Stop-button to interrupt the calculations. As the LUT Results Generator uses

a document window you can continue to work with other documents or dialogs

during the calculations.

47 Session Editors

Session Editors are wizard documents for specific application scenarios which allow you to set up all needed

documents at once. They can be found in Start > Laser Resonators and Start > Diffractive Optics, respectively.

Each Session Editor generates a new VirtualLab Fusion Session. Single documents within a Session cannot

be closed separately. To close a Session close the Session Editor. To avoid unintended closing of dependent

documents, an inquiry dialog is displayed before closing.

If you click Finish in the Session Editor, all necessary documents are generated. If you change the settings in

the Session Editor, you have to click Refresh to bring these changes into the dependent documents. It is also

possible to change the dependent documents directly.

All documents of a Session can be saved separately.

47.1 Annotations for Session Editors in the Diffractive Optics Package

This section contains annotations for certain wizard pages of the session editors in the Diffractive Optics Pack-

age.

47.1.1 Effect of Coherence and the M2 Value on Beam Splitter and Diffuser Systems

The input beam of a beam splitting or diffusing system is modeled as coherent, monochromatic field with

Gaussian amplitude distribution and a beamquality of M2 =1. Nevertheless beam splitting and diffuser elements

will work also for laser beams with M2 >1 or spatially partial coherence. The input beam parameters specified

in the session editors are just used for calculation of the spot diameter in the target plane and to check if the

distance between the diffraction orders will be larger than the spot diameter. If a laser beam with M2 >1 should

be used the spot diameter in the target plane may be larger than the diameter calculated by the session editor.

Please check in this case that the distance between the diffraction orders is larger than the spot diameter of

your beam in the target plane.

47.1.2 Supported Optical Setups for Beam Splitters and Diffusers

In order to simplify the parameter specification only four different optical setups are supported. Nevertheless

the most of the real existing optical systems can be described by one of the idealized setups mentioned below.

• The 1f- and 2f-setups are containing a lens creating the far field of the diffractive optical element in the

focal plane of the lens. The lens is simulated using a lens transmission. The focal length of the lens

transmission must be equal to the effective focal length of a real lens or lens system. To simulate the
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effect of real lenses after the end of the optimization replace the lens transmission by a real lens or lens

system in the resulting Optical Setup.

• The paraxial far field setup assumes a large distance between diffractive optical element and target

plane. The light propagation to the target plane is modeled by Fraunhofer diffraction integral. Near field

diffraction effects are not considered during the optimization but can be modeled in the resulting Optical

Setup.

• Angular spectrum setup allows you to optimize a diffractive optical element creating the desired angular

diffraction patterns.

All optical elements in the setups are surrounded by a medium that can be specified together with all other

system parameters on the next page. For angular spectrum setup vacuum is always assumed as surrounding

medium.

47.1.3 Supported Optical Setups for Beam Shapers

In order to simplify the parameter specification only three different optical setups are supported. Nevertheless

the most of the real existing optical systems can be described by one of the idealized setups mentioned below.

• The 1f- and 2f-setups are containing a lens creating the far field of the beam shaping element in the

focal plane of the lens. The lens is simulated using a lens transmission. The focal length of the lens

transmission must be equal to the effective focal length of a real lens or lens system. To simulate the effect

of real lenses after the end of the optimization replace in the resulting Optical Setup the lens transmission

by a real lens or lens system.

• The Fresnel setup assumes a large distance between beam shaping element and target plane.

All optical elements in the setups are surrounded by a medium that can be specified together with all other

system parameters on the next page.

47.1.4 Output Field Parameters for Beam Splitters

The separation of diffraction orders is controlled during the design by the period of the beam splitting element.

Depending on the fabrication constraints (pixel size and pixel size increment; see next pages) it is probably

not possible to achieve exactly the calculated period of the element. This will lead to small deviations between

the desired separation of orders and the practically achieved separation. Both values are displayed on the

summary page at the end of the session editor.

An Offset of the desired diffraction orders can be specified on this page. The offset can be for example helpful

to separate the zeroth order from the other diffraction orders. A zeroth order may appear because of fabrication

tolerances of the surface profile of a diffractive optical element. Please take into account that in case of a

height profile with two height levels, a transmission with two phase levels and amplitude-only transmissions

always a diffraction pattern symmetric to the optical axis will appear. That means that the offset should be large

enough so that all desired orders are shifted above or below the optical axis. Use the Suggest Offset button to

get a suggestion for the offset that fulfills this condition.

Since the most diffractive optical elements do not diffract all light into the desired diffraction orders also higher

orders will appear (stray light). In order to avoid disturbing effects in the application a Maximum Relative Stray

Light Intensity can be specified. Please take into account that very small values could be unrealistic.

47.1.5 Output Field Parameters for Diffusers

An Offset of the desired diffraction orders can be specified on this page. The offset can be for example helpful

to separate the zeroth order from the other diffraction orders. A zeroth order may appear because of fabrication



CHAPTER 47. SESSION EDITORS 532

tolerances of the surface profile of a diffractive optical element. Please take into account that in case of height

profiles with two height levels, transmissions with two phase levels or amplitude-only transmissions always a

diffraction pattern symmetric to the optical axis will appear. This means that the offset should be large enough

so that all desired orders are shifted above or below the optical axis. Use the Suggest Optional Offset button

to get a suggestion for the offset that fulfills this condition.

Since the most diffractive optical elements do not diffract all light in the desired diffraction orders also higher

orders will appear (stray light). In order to avoid disturbing effects in the application a Maximum Relative Stray

Light Intensity can be specified. Please take into account that very small values could be unrealistic.

47.1.6 Output Field Diameter

A rectangular area symmetric to the optical axis is reserved in the target plane for the creation of the desired

light pattern. Around this light pattern another rectangular region is used for the distribution of the stray light.

The ratio between output field diameter and light pattern diameter is expressed by a Diameter Factor. The

output field diameter should be approximately two times larger than the light pattern diameter for continuous

DOEs and four times larger than the light pattern diameter for pixelated DOEs in order to reduce the energy

loss because of diffraction at rectangular pixels.

Increasing the diameter factor helps to reduce the uniformity error. If a maximum stray light intensity limit was

introduced increasing the diameter factor allows to distribute the energy of the stray light over a larger area

and helps to reduce the maximum stray light intensity.

The output field diameter is controlled by the feature size of the diffractive optical element. Increasing the

output field diameter requires smaller features of the diffractive optical element. Take into account that the

feature size can be limited to a minimum value. This will limit the output field size to a maximum value. The

manual or automatic selection of the output field size has only an effect if the automatic calculation of pixel size

is activated (see later pages). In case of manual adjustment of the pixel size the user is responsible to ensure

that sufficiently large output field diameters can be reached by the selected pixel size.

47.1.7 Merit Functions for the Iterative Fourier Transform Algorithm

The optimization principle of the Iterative Fourier Transform Algorithm (IFTA) used for optimization of diffrac-

tive optical elements differs from other parametric optimization algorithms. Other algorithms often analyze an

spread sheet and evaluate the merit functions. In a second step parameters are varied and analysis of spread

sheet and evaluation of merit functions is repeated. From the change of merit functions conclusions for fur-

ther modifications of parameters can be done. The evaluation of the merit functions results is essential for the

optimization.

In contrast, the IFTA performs an analysis of the system. It corrects intensity deviations of the output field

from the desired output field. This means special constraints will be applied on the output field intensity. In a

second step the corrected output field is back propagated in the plane of the diffractive optical element and the

element parameters are calculated. Additional constraints must be applied on the element in order to fulfill all

fabrication conditions (for example discrete height levels). These two steps are called iteration. All selected

merit functions, specifications of the desired output field and specifications of the diffractive optical element are

translated as constraints of the output field and the element. Thus an evaluation of the merit functions values

is not required.

This means for example achieving a low uniformity error can be done by replacing the real output field intensity

by the intensity of the desired output field. Doing this requires not the knowledge of the uniformity error value

itself. The maximum relative intensity of stray light can be limited by cutting all intensity values of the stray light

that are above a specified limit. Again, the exact value of the merit function is not required for optimization.
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Therefore it is not required to evaluate the merit functions values during the optimization. Instead calculation

of the values requires additional computational time and will thus reduce the performance of the optimization.

The logging of the merit function results can be deactivated using Disable Logging of Merit Functions during

Optimization. The optimized Optical Setup will contain detectors and analyzers for evaluation of the merit

functions values after optimization.

Seven different merit functions can be used during the optimization of a diffractive optical element and final

evaluation. It follows a short overview of available merit functions. The implemented formulas are given in

Sec. 137.2.

ITEM DESCRIPTION

Window Efficiency Measures the amount of energy of the input field diffracted in a typically rect-

angular or circular signal region in the target plane. The signal region has the

shape and the extension of the desired output intensity pattern. The achieved

quality of the output field is not considered. This means that for example a

lens concentrating all light in the signal region may reach an efficiency of

100%. It is recommended to use the conversion efficiency instead.

Conversion Efficiency Measures the amount of energy of the input field diffracted in a typically rect-

angular or circular signal region in the target plane. Any noise in the signal

region is ignored. The signal region has the shape and the extension of the

desired output intensity pattern. A lens focusing for example all light in the

signal region would lead in contrast to the window efficiency to a very low ef-

ficiency since the generated spot is typically different from the desired output

field and will be considered as noise.

Signal to Noise Ratio The SNR is the ratio between the integral intensity of the output field to the

integral intensity of the noise. It is expressed in dB.

Uniformity Error The maximum error of the output field intensity compared to the desired out-

put field intensity. The definition is similar to the definition of a contrast.

Maximum Relative Inten-

sity of Stray Light

Diffractive optical elements achieve often a conversion efficiency below

100%. This means that not all light is diffracted in the desired output field

intensity pattern. The remaining light typically appears as stray light around

a rectangular or circular signal region in the target plane. This merit function

measures the ratio of the maximum intensity of the stray light relative to the

mean intensity of the output field within the signal region.

Relative Zeroth Order In-

tensity

This merit function measures the intensity of the zero order relative to the

mean intensity of the output field within a rectangular or circular signal region

in the target plane. It is often a measure for the amount of undiffracted light.

Zeroth Order Efficiency The amount of energy of the input field diffracted into the zeroth order.

47.1.8 Merit Functions for Refractive Beam Shapers

Five different merit functions can be used for analysis and optimization of a refractive beam shaping element.

It follows a short overview of available merit functions. The implemented formulas are given in Sec. 137.2.
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ITEM DESCRIPTION

Window Efficiency Measures the amount of energy of the input field diffracted in a typically rect-

angular or circular signal region in the target plane. The signal region has the

shape and the extension of the desired output intensity pattern. The achieved

quality of the output field is not considered. This means that for example a

lens concentrating all light in the signal region may reach an efficiency of

100%. It is recommended to use the conversion efficiency instead.

Conversion Efficiency Measures the amount of energy of the input field diffracted in a typically rect-

angular or circular signal region in the target plane. Any noise in the signal

region is ignored. The signal region has the shape and the extension of the

desired output intensity pattern. A lens focusing for example all light in the

signal region would lead in contrast to the window efficiency to a very low ef-

ficiency since the generated spot is typically different from the desired output

field and will be considered as noise.

Signal to Noise Ratio The SNR is the ratio between the integral intensity of the output field to the

integral intensity of the noise. It is expressed in dB.

Uniformity Error The maximum error of the output field intensity compared to the desired out-

put field intensity. The definition is similar to the definition of a contrast.

Maximum Relative Inten-

sity of Stray Light

A beam shaping elements probably does not reach a conversion efficiency

of 100%. This means that not all light is deflected in the desired output field

intensity pattern. The remaining light is typically reflected or appears as stray

light around a rectangular or circular signal region in the target plane. This

merit function measures the ratio of the maximum intensity of the stray light

relative to the mean intensity of the output field within the signal region.

47.1.9 Transmission Types

Three different types of transmissions are supported. That are:

• An Amplitude-Only Transmission just introduce an amplitude modulation between zero and one to incom-

ing fields. Zero means absorption and one means that light may pass the transmission without change.

No phase modulation is allowed. Diffractive optical elements can use for example chromium layers to

create an amplitude-only transmission.

• A Phase-Only Transmission creates a phase modulation from -π to +π without changing the amplitude of

an incoming field. Diffractive optical elements with micro structured height profiles can create an phase-

only transmissions.

• AComplex Transmission allowsmodulation of amplitude and phase of an incoming field. Diffractive optical

elements containing a micro structured height profile and additionally a chromium mask can create for

example a complex transmission.

47.1.10 Period, Pixel Size and Number of Pixels

• The Period of the diffractive optical element is calculated from the angular resolution required for the

desired output intensity.

• The Pixel Size of the diffractive optical element is calculated from the maximum deflection angle. This

angle follows from the maximum angle of the desired output intensity and an additional frame that is used
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for stray light that can not diffracted into the desired intensity pattern. Expert user can set the pixel size

to an user defined value but must ensure that the pixel size is small enough to create the desired output

intensity with sufficient high quality.

• The Number of Pixels per Period follows just from period and pixel size. Since only an integer number of

pixels are allowed the pixel number must be rounded and the period may differ slightly from the optimal

value. This rounding leads to small deviation of the output field angular resolution from the desired value.

The deviation is displayed on the next page.

47.1.11 Import of Arbitrary Input Field

The power weights of the desired diffraction orders of the beam array can be imported from a harmonic field,

from an ASCII file or from a bitmap file. Every sampling point in the data file represents one diffraction order.

It is typically not necessary to introduce diffraction orders with zero weights in order to generate “free spaces”

between the desired orders. These free spaces will result in the later application from illuminating several

periods of the diffractive optical element. The weights of the beam array should be specified without a dark

frame around the desired diffraction orders. Such a dark frame will be added by the session editor if required.



VIII Sources:
Generating Fields

VirtualLab Fusion provides a growing set of source models. Each model

describes an electromagnetic field in a plane. The theoretical back-

ground can be found in Sec. 132.

The following chapters explain how to use the generator dialogs, starting

with the description of those controls that most source generator dialogs

(except that for Stored Fields) have in common. The type specific pa-

rameters are described in Sections Sec. 51 and Sec. 52.
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48 Common Controls of the Source Generator Dialogs

48.1 Dialog for Sources in the Optical Setup

Figure 452. Sample edit dialog for light sources in the Optical Setup.

The edit dialogs for light sources in the Optical Setup (↪→Fig. 508) are divided into 3 pages:

• Coordinate Systems ↪→Sec. 43.8.1

• Position / Orientation ↪→Sec. 43.8.2

• Source Parameters

The Source Parameters tab is again divided into the following tab pages:

• Basic Parameters ↪→Sec. 48.1.1

• Specific Parameters; specific for the distinct light sources and thus explained in Sec. 51 to Sec. 52

• Polarization ↪→Sec. 48.3

• Mode Selection ↪→Sec. 48.1.2

In the lower left corner of the dialog there are the following controls:

ITEM DESCRIPTION

Saves the component into the user-defined light sources catalog (↪→Part V).

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further

information.
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48.1.1 Basic Parameters

Figure 453. Controls for defining the aperture of the single modes.

On the Basic Parameters tab of the light source dialog (↪→Fig. 453) you can set the aperture of the single modes.

ITEM DESCRIPTION

Shape You can choose whether the single modes have a Rectangular or an Elliptical

shape.

Size The size or diameter of the aperture. If the light source determines the aper-

ture size automatically, this control is not visible.

Relative Edge Width PV The width of the smoothing edges defined relatively to the lateral extension

of the mode. If the extension in x- and y-direction differ, the minimum of both

values is taken.

Absolute Edge Width PV The width of the smoothing edges in meters (↪→Fig. 454). If the light source

determines the aperture size automatically, this control is not visible.

Figure 454. Definition of the edge width of smoothing edge functions.

For the Panel Type Source (↪→Sec. 52.7.1) the aperture does not change the overall size of the modes.

Thus you cannot set a relative edge width of more than 50% which makes that the whole area of the

mode is attenuated by the aperture.
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48.1.2 Mode Selection

Figure 455. Controls for the selection which wavelengths are to be generated.

On the Mode Selection tab of the light source dialog (↪→Fig. 455) you can set whether All Wavelengths are

generated or only a Single Wavelength. In the latter case you can select which wavelength index PV is taken.

Furthermore light sources can have their special way of selecting the generated lateral modes. This is explained

in the light source specific chapters.

48.2 Dialog for Sources in the Main Window

The edit dialogs for sources in the main window (partly also used from within the Optical Setup) have some

common controls for all types of source generators.

They define the

• definition of the field via the panel Basic Parameters (↪→Sec. 48.2.1)

• definition of spectral parameters via the panel Spectral Parameters (↪→Sec. 48.2.2)

• definition of the polarization via the panel Polarization (↪→Sec. 48.3)

• selection of (fundamental) modes via the panel Mode Selection (↪→Sec. 48.2.4)

• sampling of the fields via the panel Sampling (↪→Sec. 48.2.5)

The panel Spatial Parameters is type specific, so its contents are described in the corresponding subsections

of Sec. 51 and Sec. 52.

The Default Parameters button resets the parameters on all tabs to their default values.

48.2.1 Basic Parameters

The panel is shown in Fig. 456 for the selection Automatic Setting. It comprises three parts:

ITEM DESCRIPTION

Medium at Source Plane The medium in which the source field is generated. This control is explained

in Sec. 34.1.

Source Field: Longitudi-

nal and Lateral Offset

These settings are explained in subsection Sec. 48.2.1.1.

Input Field: Position, Size

and Shape

These settings are explained in subsection Sec. 48.2.1.2.
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Figure 456. Tab page for setting the basic parameters of a light source.

48.2.1.1 Relation between Source Field and Input Field

Figure 457. Effect of a Lateral Offset of 100 µm in x-direction on a Gaussian Wave. The origin of coordinates of the input

plane is marked.

We distinguish between the field in the source plane and and the field in the input plane.

By the parameters on the Spatial Parameters tab the field is defined in a certain source plane. For example,

this is the waist (plane) for a Gaussian wave.

However, the field put into VirtualLab Fusion by the source dialog might be defined in another plane parallel to

the source plane: the input plane.

The group boxSource Field: Longitudinal and Lateral Offset allows you to configure the relation between source

plane and input plane:
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ITEM DESCRIPTION

Distance to Input Plane PV This value describes the distance between input plane and source plane

along the z-axis: distance = zInput Plane − zSource Plane.
For some of the sources this value is fixed to zero.

In the case of spherical and quadratic waves this value must not be zero and

the spherical phase radius is set to this value.

Lateral Offset PV This value describes the offset between the origins of the coordinates for the

source and the input plane.

Within the Optical Setup the lateral offset specified within this region of the dialog is handled by the usage of

coordinate systems.

48.2.1.2 Position, Size and Shape of the Input Field

VirtualLab Fusion follows the concept of smooth fields. For physically meaningful fields, jumps in the data

should be avoided. Numerically this is achieved by using smoothing edge functions as shown in Fig. 460.

Figure 458. Shifted Gaussian Wave with unchecked Apply Lateral Offset of Source Field.
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Figure 459. Shifted Gaussian Wave with checked Apply Lateral Offset of Source Field.

Note the larger overall field size.

Figure 460. Definition of the edge width of smoothing edge functions.

The group box Input Field: Position, Size and Shape allows you to define position, size, and shape of this

smooth edge in the input plane:
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ITEM DESCRIPTION

Automatic Setting If checked, a reasonable size (suggested field size) of the field is determined

automatically. This option is only available for some light sources, e. g. those

defining exponentially decreasing fields.

Field Size Factor PV The suggested field size is multiplied by this factor for Automatic Setting.

Manual Setting If checked, the field size can be entered by the user.

Apply Lateral Offset of

Source Field PE

By default, the resulting input field is centered at the position (0m; 0m) in the

input plane. By checking this box, the field is shifted by the Lateral Offset

of the source plane (↪→Sec. 48.2.1.1). Note, the resulting numerical array

(sampled field) will still be centered at (0m; 0m), so additional zero-values

will be generated. An example is given in Fig. 458 and Fig. 459.

Shape PE The field may be Rectangularly or Elliptically shaped.

Diameter PV Physical size of the field physical dimension in the input plane.

Relative Edge Width PV The width of the smoothing edges defined relatively to the (smaller of the both

values of) Diameter.

Absolute Edge Width PV The width of the smoothing edges, defined in physical units. ↪→Fig. 460.

48.2.2 Spectral Parameters

At this panel the spectral information for the field has to be defined. In the simplest case, using Power Spec-

trum Type > Single Wavelength, a single Wavelength PV can be defined yielding a monochromatic field. The

remaining options, Triplet of Wavelengths and List of Wavelengths, result in polychromatic fields represented

by a harmonic field set.

The Weight values are given as intensities, i. e. those values are scaling values for A2 of the corresponding

fields.

The panel adapts its design to the chosen Type of Power Spectrum. The types Single Wavelength, Triplet of

Wavelengths and List of Wavelengths are explained in Sec. 48.2.2.1, Sec. 48.2.2.2, Sec. 48.2.2.3, respectively.

The selection Triplet of Wavelengths is a special case of the more general selection List of Wavelengths.

48.2.2.1 Single Wavelength

Figure 461. Panel for setting the spectral parameters (Single Wavelength) of a source generator.

Description of parameters:
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ITEM DESCRIPTION

Wavelength PV The vacuum wavelength.

Weight PV The intensity value (scaling of A2).

Preview Some approximate preview of the resulting color. A wavelength out of the

visible range of the spectrum is marked black.

48.2.2.2 Triplet of Wavelengths

Figure 462. Panel for setting the spectral parameters (Triplet of Wavelengths) of a source generator.

Description of the Parameters:

ITEM DESCRIPTION

Wavelength PE The vacuum wavelengths.

Weight PV The intensity values (scaling of A2).

Preview Some approximate preview of the resulting color according to the given val-

ues.

Default RGB Values Resets the values of the wavelengths and their weights to the default values

depending on the current color system (see Sec. 6.7.1), which will result in

white light.
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48.2.2.3 List of Wavelengths

Figure 463. Panel for setting the spectral parameters (List of Wavelengths) of a source generator.

In this mode you have a table on the upper part of the dialog. There you can change already present data

points or delete whole rows. Del deletes the content of the current cell (or the whole row if a complete row is

selected). Shift + Del deletes the whole row in any case. This table has four columns:

COLUMN DESCRIPTION

Index The mode index.

Wavelength The vacuum wavelengths.

Amplitude The amplitude values for the wavelengths.

Phase The phase values for the wavelengths.

In the lower part there are some additional buttons:

ITEM DESCRIPTION

Add Datapoint Add a data point to the list of wavelengths.

Load from File Loads the wavelength and weight values from a .txt-file. The format is de-

scribed below.

Save to File The wavelength and weight values are saved to a .txt-file.

Load from Diagram The wavelength and weight values are loaded from a diagram. Suitable dia-

grams can be generated via the spectrum generators described in Sec. 53.

Show Diagram Shows the wavelength and weight values in a diagram.

For convenience, the spectral values can be defined also using diagrams or simple text files. An example of

the format used for the text files is described below. Comment lines start with ’#’, columns must be separated

by either spaces, tabs, semicolons, |, or &. The decimal separator must be a period.

# Spectrum Data
# Wavelength Amplitude Phase
4.1E-07 1 0
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4.5E-07 2 0
4.8E-07 1 0

48.2.3 Spatial Parameters

Although this panel is specific to the particular source model, it contains the shared entry Generate Cross

Section (↪→Fig. 464).

Figure 464. Define a 1D simulation by using a cross section.

By checking the box Generate Cross Section, for Classic Field Tracing a 1D cross section (either along x- or

y-axis) will be generated instead of a 2D field. For the other simulation engines this setting has no effect.

ITEM DESCRIPTION

Generate Cross Section PE If checked, a 1D cross section Along X-Axis or Along Y-Axis is generated.

48.2.4 Mode Selection

In the case that a spectrum has been defined (more than one wavelength) or that laterally-shifted modes are

used (non-coherent simulations), harmonic field sets with several members will be generated. This panel allows

to define the number of modes being used for the simulation.

In general, the accuracy of the results increases with the number of modes. However the numerical effort

increases as well. So a good compromise has to be found. Additionally, using less modes can already give a

good insight into the behavior of optical systems.

The panel allows to define subsets of modes in order to control both accuracy and numerical effort. The spectral

values and the laterally-shifted modes are selected independent of each other. However, once a selection of

spectral values has been defined, each spectral value will be applied to every lateral mode.
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Figure 465. The Mode Selection tab in two different configurations. Left: The mode selection tab for a basic source

model having only wavelength modes. Right: The mode selection tab for a partially coherent source with Uniform 2D

Grid as Selection Strategy for the lateral modes.

The tab page shown in Fig. 465 is divided into two parts as described below. The first part is the definition of

modes. For the definition of the lateral modes several selection strategies are available. The user can also

specify the weight function that shall be applied to the lateral modes. The setting for the Definition of Lateral

Modes are explained in the following table.

ITEM DESCRIPTION

Definition Strategy Five strategies are available to define the positions of the lateral modes. They

are described below in a separate table.

This section is only visible for partially coherent light sources.

(↪→Sec. 52)

Weight Function You can either use a Constant Weight for all modes or User-Defined Weights

per mode. For the latter there is an Edit button which opens a dialog. In this

dialog you can define the intensity weights dependent on the lateral position

either by programming a snippet PE or via a data table. See Sec. 5.13 for more

details.

This section is only visible for partially coherent light sources.

(↪→Sec. 52)

The following strategies can be used for the Selection of Lateral Modes.
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SELECTION STRATEGY DESCRIPTION

Uniform 2D Grid A uniform rectangular grid of laterally-shiftedmodes is adjusted to the physical

dimension of the emitting surface. The Lateral Level PV defines how often the

initial grid is refined by bisection. The Initial Grid Size PV is 3× 3 modes in

Automatic Mode or a user-defined size in Manual mode.

Random The lateral positions of the modes are distributed randomly across the emit-

ting surface. For each consecutive simulation other mode positions are used.

You can specify the Number of Lateral Modes PV .

Random (seed=0) The lateral positions of the modes are distributed randomly across the emit-

ting surface whereas for each consecutive simulation the same mode posi-

tions are used. You can specify the Number of Lateral Modes PV .

User Defined The user can define the Number of Lateral Modes PV and then specify their

positions via a snippet PE or a data table. This can be done by clicking on Edit

and setting up the dialog described in Sec. 5.13.

None Only one lateral mode at the position (0m; 0m) is used.

The second part of the Mode Selection tab page can be used to select the lateral and spectral modes which

shall be used for the simulation. The basis for the mode selection is given by the number of modes specified

within the Spectral Parameters tab and the Definition of Lateral Modes group box.

The user can select between different selection strategies to specify which modes shall be used for the simu-

lation. Within this part of the dialog the user can also see several information which allow to get an impression

on accuracy and the numerical effort of the current simulation setup.

The following parameters can be accessed within this part of the dialog:
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ITEM DESCRIPTION

Selection Strategy This defines the Selection Strategy for selecting certain wavelengths and lat-

eral modes from the full set of modes specified in the Spectral Parameters

tab and the Definition of Lateral Modes area on theMode Selection tab. Four

options are available:

• Full Set of Spectral and Lateral Modes: All wavelengths given in the

Spectral Parameters tab are used. All specified modes will be pro-

cessed.

• Spectral Selection Ordered by Index: The first n wavelengths given in

the Spectral Parameters tab are used. n is the Number of Spectral

Modes PV . For each wavelength all lateral modes defined within the

above section will be processed.

• Spectral Selection Uniform in Index: An algorithm selects nwavelengths
which are well distributed across the index range. n is the Number of

Spectral Modes PV . For each wavelength all lateral modes defined within

the above section will be processed.

• Single Mode Selection: Only one mode is generated by the light source.

The user can enter an Index of Spectral Mode and an Index of Lateral

Mode to specify which mode shall be generated by the light source.

These parameters can be varied within the Parameter Run to perform

a complex simulation and reduce the numerical effort (large data may

be swapped to hard disc).

n is the Number of Spectral Modes.

Number of Active Modes For your information, this section shows the Total Number of Modes which is

the product of the Number of Lateral Modes and the Number of Wavelengths.

The number of lateral modes again can be the product of the lateral modes

for x- and y-direction. Note that the dialog ensures that the Total Number of

Modes does not exceed just over 2 billion.

48.2.5 Sampling

The generated field is represented by one or more arrays of sampled data. When using sampled fields, care

has to be taken for ensuring that the original fields can always be reconstructed from the sampled fields with

sufficient accuracy, that is the Whittaker Shannon theorem[Goo68] has to be taken into account. VirtualLab

Fusion provides an automatic sampling mode which takes care of the sampling theorem and suggests corre-

sponding sampling parameters. The user can scale these values or even modify them in the manual mode.

The panel is shown in Fig. 466.
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Figure 466. Panel for Sampling of a source generator.

Description of the parameters:

ITEM DESCRIPTION

Automatic Sampling If checked, the sampling parameters will be determined automatically.

Manual Sampling If checked, the sampling parameters have to be entered by the user.

Oversampling Factor PV This parameter can be entered for the Automatic Sampling mode only. The

Sampling Distance will be divided by this value.

Copy Active Parameters

from...

This option is available for the Manual Sampling mode only. If pressed, a

window will appear where a document can be selected to copy the Sampling

Distance or the number of Sampling Points from, depending on which of both

is currently selected.

Sampling Points PV In case of Manual Sampling, the number of sampling points can be entered

here. This number refers to the array size.

Sampling Distance PV In case of Manual Sampling, the sampling distance can be entered here.

Array Size Read Only. The size of the complex array, automatically calculated from Di-

ameter and (2×) Absolute Edge Width that are defined on the panel Basic

Parameters.

Size of Embedding Frame

(Sampling Points)

This value defines the size (in sampling points) of the embedding frame which

is added to the array of sampled field data.

Total Sampling Points Read Only. Number of sampling points of the resulting field including the

embedding frame.

Total Array Size Read Only. Size of the resulting array including the embedding frame.
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48.3 Polarization

This panel allows you to enter the Jones vector that determines the relation of Ex and Ey to the scalar field

U (↪→Sec. 22.10). You can either enter the Jones vector directly or set the polarization parameters of either

linearly, circularly or elliptically polarized light; depending on the selected Type of Polarization.

The following parameters are the same for all polarization types:

ITEM DESCRIPTION

Type of Polarization Can be either Linearly Polarized, Circularly Polarized, Elliptically Polarized, or

General Input via Jones vector. Depending on this setting the panel changes

as shown in Fig. 467 – Fig. 470. In any case, the resulting Normalized Jones

Vector is displayed.

For some light sources only a certain type of polarization is supported and

the selection is disabled.

Jx The x-component of the normalized complex Jones vector.

Jy The y-component of the normalized complex Jones vector.

Figure 467. Panel for setting the polarization parameters of Linearly Polarized light.

ITEM FOR

LINEAR POLARIZATION

DESCRIPTION

Angle PV Angle between the electric field vector and the x-axis.
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Figure 468. Panel for setting the polarization parameters of Circularly Polarized light.

ITEM FOR

CIRCULAR POLARIZA-

TION

DESCRIPTION

Direction of Rotation The direction of rotation can be either Right Circularly Polarized or Left Cir-

cularly Polarized.

Figure 469. Panel for setting the polarization parameters of Elliptically Polarized light.

ITEMS FOR

ELLIPTICAL POLARIZATION

DESCRIPTION

Orientation Angle PV The angle between the semi-major axis of the polarization ellipse and the

x-axis. Can be in the range between -180° and +180°.

Eccentricity PV The (numerical) eccentricity of the polarization ellipse.

Direction of Rotation The direction of rotation can be either Right Elliptically Polarized or Left

Elliptically Polarized.
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Figure 470. Panel for General Input via Jones Vector of the polarization parameters.

ITEMS FOR

INPUT OF JONES VEC-

TOR

DESCRIPTION

Jx∼ PV The x-component of the complex Jones vector. Although the Jones vector

is defined as a normalized one (i. e. it has to have a norm of 1), it is not

necessary to enter the vector in normalized form, the normalization is done

automatically.

Jy∼ PV The y-component of the complex Jones vector.

Representation You can choose to enter either Real / Imaginary or Amplitude / Phase of the

complex numbers.

49 Multiple Light Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Eigenmode Analyzer

Accessible:

• Optical Setup: Light Sources > Multiple Light Source

• Light Sources Catalog: Templates > Multiple Light Source

This source model allows you to combine an arbitrary number of other source models (but Image Light Sources,

↪→Sec. 52.7).
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Figure 471. Edit dialog of a Multiple Light Source.

The edit dialog of this light source (↪→Fig. 471) has the following options:

ITEM DESCRIPTION

Combination Mode • In Coherent mode, all modes for a certain wavelength are summed up

coherently.

• In Incoherent mode, all modes are generated and processed indepen-

dently.

{Table} Contains one row per light source and the following columns:

• Index: The index of the source.

• Light Source Name: A name which helps you to identify the sources.

Can be changed after double clicking in the cell.

• Light Source: Allows you to load, edit, and view the item represented

by the table row. ↪→Sec. 34.1

• Use: In this column you can switch off light source if needed.

Add Lets you select a new light source from the corresponding catalog and adds

it to the bottom of the table.

Remove Removes the currently selected light source from the table after inquiring

whether you really want to do so.

(Move Up) Moves the currently selected light source up by one row.

(Move Down) Moves the currently selected light source down by one row.

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further

information.

Tools This button offers the following tools:

• Remove All Light Sources: Clears the table.

• Duplicate One Light Source, ↪→Sec. 49.1

• Synchronize Selected Parameters, ↪→Sec. 49.2

• Use All Light Sources: The Use flag for all light sources is checked.

• Use Only Current Light Source: The Use flag for the currently selected

light source is checked, all others are unchecked. If no selection is

active, the first light source is used.
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Restrictions for Specific Simulation Engines

• For General Profile and Ray Results Profile, Incoherent mode is only possible if for each wave-

length there are the same number of modes.

• In the EigenmodeAnalyzer (↪→Sec. 89.2), the result must be a single mode. Thus the Multiple Light

Source is restricted to Coherent mode and all light sources must use the same one wavelength.

49.1 Duplicate One Light Source

Figure 472. Dialog for the Duplicate One Light Source tool.

This tool for a Multiple Light Source allows you to select one light source by name and how often it is duplicated

(Number of Duplicates n). n duplicates of the original light source are then inserted into the table right after the

original one.

49.2 Synchronize Selected Parameters

This tool for a Multiple Light Source allows you to select one light source by name from which then selected

parameters are copied to all other light sources.

Figure 473. Dialog for the Synchronize Selected Parameters tool.
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ITEM DESCRIPTION

Select Template Light

Source

Allows you to select one light source (by name) from which selected param-

eters are copied to all other light sources.

Distance to Input Plane Copies the Distance to Input Plane, which can be found on the Basic Param-

eters tab of a light source (↪→Sec. 48.2.1.1).

Input Field: Position Size

and Shape

Copies all settings from the group box of the same name on the Basic Pa-

rameters tab (↪→Sec. 48.2.1.2).

Spectral Parameters Copies all settings from the Spectral Parameters tab (↪→Sec. 48.2.2).

Gaussian Parameters O G W .

Copies all settings from the Spatial Parameters tab of a Gaussian Wave

(↪→Sec. 51.1) but Generate Cross Section and Reference Wavelength.

The dialog ensures that a least one of the Parameters to Synchronize is selected.

Some settings cannot be copied to all types of light sources. For example the Distance to Input Plane

cannot be copied to a Super-Gaussian Wave and Gaussian Parameters can only be copied to other

Gaussian Waves.

50 Stored Complete Field

Availability

Optical Setups: General Optical Setup

Accessible:

• Optical Setup: Light Sources > Stored Complete Field

• Light Sources Catalog: Templates > Stored Complete Field

With this light source a field that has been generated before can be inserted as source field into an Optical

Setup. To use this light source for Classic Field Tracing, you need to set a spatial Harmonic Field or Harmonic

Fields Set on the Equidistant Field Data tab. For General Profile and Ray Results Profile you need to set a

Ray Distribution on the Non-Equidistant Field Data tab, whereas for General Profile this Ray Distribution must

contain field values (↪→Sec. 17.2).

Figure 474. Edit dialog of a stored field source.
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Description of the parameters:

ITEM DESCRIPTION

Equidistant Field Data >

Remove

Removes the currently set harmonic field or harmonic fields set. Note that

then the light source cannot be used for Classic Field Tracing any longer.

Equidistant Field Data >

Set

Sets the field information, i. e. any harmonic field or harmonic fields set which

is in spatial domain. If you click on this button you can do the following:

• Load a harmonic field from a .ca2 file or a harmonic fields set from a

.hfs file.

• Select from Documents allows you to select an already open harmonic

field or harmonic fields set in spatial domain.

Equidistant Field Data >

Show

Displays the field being used as separate document.

Non-Equidistant Field

Data > Remove

Removes the currently set ray distribution. Note that then the light source

cannot be used for General Profile or Ray Results Profile any longer.

Non-Equidistant Field

Data > Set

Sets the ray distribution. If you click on this button you can do the following:

• Load a ray distribution from a .rays file.

• Select from Documents allows you to select an already open ray distri-

bution.

Non-Equidistant Field

Data > Show

Displays the ray distribution being used as separate document.

No further parameters can be defined, the stored field cannot be modified. Thus no additional panels are visible.

51 Basic Source Models

Figure 475. Part of the Sources ribbon showing all Basic Source Models available in the main window. They are ex-

plained in the following sections.

The following basic source models are available:

LIGHT SOURCE DESCRIPTION

Gaussian Wave A Hermite- or Laguerre-Gaussian wave. ↪→Sec. 51.1

Plane Wave A plane wave traveling in an arbitrary direction. ↪→Sec. 51.2

Quadratic Wave A quadratic wave, i. e. a paraxial approximation of a spherical wave. ↪→Sec. 51.3

Spherical Wave A spherical wave generated from a point source at a given distance. ↪→Sec. 51.4

Super-GaussianWave An isotropic and separable super-Gaussian field. ↪→Sec. 51.5

Stored Lateral Field Using this source model any lateral field can be used to define a polychromatic

source. ↪→Sec. 51.6

Ideal Plane Wave A plane wave with an infinite size traveling in an arbitrary direction. ↪→Sec. 51.7

Programmable Light

Source

Allows you to define your own field generator. ↪→Sec. 51.8
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51.1 Gaussian Wave

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Gaussian Wave

• Optical Setup: Light Sources > Basic Source Models > Gaussian Wave

• Light Sources Catalog: Templates > Gaussian Wave

This source model allows you to generate a Hermite- or Laguerre-Gaussian wave (↪→Sec. 132.1). In the fol-

lowing the settings of its edit dialog (↪→Fig. 476) are described.

Figure 476. Parameters for generating a Gaussian wave.

Since the parameters waist, divergence and Rayleigh length depend on each other, one has to define which

parameter is the primary choice. Only these values can be modified, the others are computed on the fly and

are displayed in the dialog. For computing the values, the selected vacuum wavelength is used, if necessary.

During computations, e. g. in an optical system, the primary value is kept fixed. If divergence or Rayleigh

length is chosen, then the actual medium wavelength is used to compute the waist of the Gaussian which is

generated. In that sense, the primary value is the achromatic constant for the Gaussian wave.

For a Hermite-Gaussian mode, some of the parameters are given for both x- and y-direction, which is not

explicitly noted in the following table.

Description of the parameters on the Spatial Parameters tab:
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ITEM DESCRIPTION

Type Selects whether a Hermite-Gaussian or a Laguerre-Gaussian mode is to be

generated.

Order PV Order of the mode. Order 0 corresponds to a Gaussian fundamental mode.

For a Laguerre-Gaussian mode, the left text box refers to the radial order

while the right box specifies the angular order.

M^2 Parameter M2 parameter of the beam.

Reference Wavelength

(Vacuum)

The wavelength to which the selected achromatic parameter (waist, diver-

gence, or Rayleigh length) refers.

Waist Radius 1/(e^2) PV Beam radius in waist position. The radius is determined by a relative intensity

decay by 1/e2 for a Gaussian beam.

Half-Angle Divergence

1/(e^2) PV

Half far field divergence angle measured between the optical axis and the

1/e2 decay of the intensity.

Rayleigh Length PV Rayleigh length of the Gaussian wave.

Offset between y- and x-

plane PV

For Hermite-Gaussian modes different longitudinal waist distances can be

specified in x- and y-direction, which corresponds to the effect of astigmatism.

We define that the waist distance in x-direction is equal to the Distance to

Input Plane and the waist distance in y-direction is the sum of Distance to

Input Plane and the given Offset between y- and x-plane.

Copy from Calculator If one or more Laser Beam Calculators (↪→Sec. 112) are open, you can select

one calculator to copy the corresponding values from the calculator to the

dialog.

A combo box allows you to select whether the x-values, y-values, and both

values, respectively, are filled in the dialog. This setting has only an effect for

Hermite-Gaussian waves.

The remaining tabs of this dialog are explained in Sec. 48.2.

51.2 Plane Wave

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Plane Wave

• Optical Setup: Light Sources > Basic Source Models > Plane Wave

• Light Sources Catalog: Templates > Plane Wave

This source model allows you to generate a plane wave traveling in an arbitrary direction.
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Figure 477. Parameters for generating a plane wave.

The propagation direction of the plane wave can be described in several ways. For this purpose, there are the

options Cartesian Angles, Spherical Angles,Wave Number Vector, and Spatial Frequency which are explained

in the table below.

Description of the parameters on the Spatial Parameters tab:

ITEM DESCRIPTION

Define by The selection allows different methods for defining the direction of the plane

wave as described below.

Cartesian Angles Defines the tilt angles α and β (Alpha PV and Beta PV ) of the plane wave. The

angle unit is degrees.

Spherical Angles Defines the tilt angles in spherical coordinates φ and θ (Phi PV and Theta PV ).

The angle unit is degrees.

Wave Number Vector Defines the direction of the plane wave in terms of components kx
PV and ky

PV

of the wave number vector k. For physical information on how the complex

amplitude field is constructed from the components see Eq. (51.1).

Spatial Frequency Defines the direction of the plane wave in spatial frequencies u PV and v PV for

x and y-direction, in units of 1/m.

The resulting harmonic amplitude field U(x, y) is constructed from the given X and Y components kx and ky of

the wave number vector by

U(x, y) = exp[i(kxx + kyy)]. (51.1)

If the direction is given not asWave Number Vector but in another representation, the conversion formulas as

given in Sec. 139.3 are used.

If the Plane Wave is used within the Optical Setup the direction of the field is handled analytically. A sampling

of the linear phase is not necessary at the output of the light source.

The remaining tabs of this dialog are explained in Sec. 48.2.

51.3 Quadratic Wave

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Quadratic Wave

• Optical Setup: Light Sources > Basic Source Models > Quadratic Wave

• Light Sources Catalog: Templates > Quadratic Wave

This source model represents a quadratic wave, i. e. a paraxial approximation of a spherical wave.
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Figure 478. Parameters for generating a quadratic wave.

Description of the parameters on the Spatial Parameters tab:

ITEM DESCRIPTION

Offset between y- and x-

Plane PV

The radius in x- and y-direction can be different, which corresponds to the

effect of astigmatism. We define that the radius in x-direction is equal to the

Distance to Input Plane PV and the radius in y-direction is the sum between

Distance to Input Plane and the given value Offset between y- and x-plane.

The remaining tabs of this dialog are explained in Sec. 48.2.

51.4 Spherical Wave

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Spherical Wave

• Optical Setup: Light Sources > Basic Source Models > Spherical Wave

• Light Sources Catalog: Templates > Spherical Wave

This source model represents a spherical wave generated from a point source at a given distance.

Figure 479. No further parameters are required for generating a spherical wave. The spherical phase radius is given by

Distance to Input Plane.

A spherical wave U(x, y) is defined by

U(x, y) =
z
r

exp[ikr], (51.2)

with

r =
√
(x− x0)2 + (y− y0)2 + z2, (51.3)

where (x0, y0) and z denote the lateral and longitudinal offset to the origin, respectively. Origin means the center
of the spheres described by the equiphase values, and its distance on the z-axis is also denoted as spherical

phase radius.

Note on convergence: Whether a spherical wave is convergent or divergent depends on the sign of the spher-

ical phase radius and the sign of the principal propagation direction. If both are equal, the wave is divergent, if

not, it is convergent. ↪→Sec. 131.3.
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The distance on the z-axis is represented by Distance to Input Plane PV at the Basic Parameters panel. Hence,

no further parameters are to be described here, see Fig. 479. The remaining tabs of this dialog are explained

in Sec. 48.2.

51.5 Super-Gaussian Wave

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Super-Gaussian Wave

• Optical Setup: Light Sources > Basic Source Models > Super-Gaussian Wave

• Light Sources Catalog: Templates > Super Gaussian Wave

This source model allows you to generate isotropic and separable super-Gaussian fields (↪→Sec. 132.2).

Figure 480. Parameters for generating a super-Gaussian wave.

The Spatial Parameters (↪→Fig. 480) are explained in the following table.
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ITEM DESCRIPTION

Type Determines the type of the Super Gaussian Wave whether it is Isotropic (ro-

tationally symmetric) or Separable (rectangular symmetric). For the mathe-

matical description see Sec. 132.2.

Radius PV Determines theWaist Radius of the super Gaussian wave where the intensity

of the wave is dropped down to the waist definition level (with respect to the

maximum amplitude or intensity) entered below. In case of a separable wave

there are also two independent waist radii for every direction.

Defined at The definition level for the waist radius. Given as fraction of the maximum

amplitude or intensity, depending on the choice of the percentage value ref-

erence.

Edge Width Width of the edge of the super Gaussian function, limited by the minimum and

the maximum level.

Edge Maximum Upper definition level for the edge.

Edge Minimum Lower definition level for the edge.

Order PV Defines the order of the super Gaussian wave. If the type is separable, then

two independent orders mx and my for the x and y-direction are necessary.

For numerical reasons, the order(s) must be in the range 0.1 to 100 000.

Percentage Values Refer

to

Determines if the percentage values of the waist radius definition level, the

maximum edge level and the minimum edge level refer to the maximum am-

plitude or the maximum intensity.

The remaining tabs of this dialog are explained in Sec. 48.2.

51.6 Stored Lateral Field

Availability

Toolboxes: All

Accessible:

• Main window: Sources > Stored Lateral Field

• Optical Setup: Light Sources > Basic Source Models > Stored Lateral Field

In this source model, the lateral field distribution U(x, y) of a globally polarized field (↪→Sec. 131.1) is used as
a base to define a complete polychromatic source. Spectral Parameters and Polarization of the resulting light

source can and must be set independently from the set field.

Figure 481. Parameters for generating a source using a stored lateral field.

Description of the parameters on the Spatial Parameters tab (↪→Fig. 481):
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ITEM DESCRIPTION

Set Sets the lateral field, whichmust be a globally polarized field in spatial domain.

Wavelength and polarization of this field are ignored. When you click on this

button you can do the following:

• Load a lateral field from a .ca2 file.

• Select from Documents allows you to select an already open globally

polarized harmonic field which is in spatial domain.

• Reset the data to the default field.

Show Displays the lateral field being used.

Achromatic in Source

Plane

Any wavelength is applied to the field without adapting the field in the source

plane.

Achromatic in Far Field In this case the sampling distance of the field is modified using the formula

∆xcurrent = ∆x · λcurrent/λfield. Here ∆xcurrent is the resulting sampling distance,
∆x is the sampling distance of the stored lateral field, λfield is the vacuum

wavelength of the stored lateral field and λmedium is the vacuum wavelength

of the current mode.

The Sampling Parameters tab is not available as the sampling is taken from the stored field. The remaining

tabs of this dialog are explained in Sec. 48.2.

51.7 Ideal Plane Wave

Availability

Optical Setups: Grating Optical Setups

This source model allows you to generate a plane wave with an infinite size traveling in an arbitrary direction.

Figure 482. Dialog for an ideal plane wave.

The effects of unpolarized light can be approximated by using circular polarization.
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An Ideal Plane Wave is fully specified by its Wavelength PV , an intensity Weight PV and its polarization. The

polarization control is the same as described in Sec. 48.3, but additionally it allows you to specify the coordinate

system the polarization refers to:

COORDINATE SYSTEM DESCRIPTION

Coordinate System of

Grating

The Jones vector describes the electric field along x- and y-axis of the sub-

sequent grating component, respectively.

Coordinate System of

Light Source

The Jones vector describes the electric field along x- and y-axis of the light

source, respectively. This is the coordinate system used in all other VirtualLab

Fusion light sources.

p-s Coordinate System In grating theory one often uses the nomenclature parallel and senkrecht (=

perpendicular) polarization to describe how the electric field vector is orien-

tated to a reference plane (or short p- and s-polarization). This reference

plane is defined by the normal vector of the grating surface and the direction

vector of the incident light.

The conversion from the coordinate system of the light source (Ex/Ey) is done

with the following equations:

Es =

Ex

Ey

 · ns and Ep =

Ex

Ey

 · np (51.4)

ns and np are the normalized directions of s- and p- polarization, respectively
(in the coordinate system of the light source). For perpendicular incident ns
is equal to the y-axis of the light source.

TE-TM Coordinate System Instead of p- and s-polarization also the nomenclature transversal magnetic

and transversal electric, respectively, is used – or short TM / TE.

51.8 Programmable Light Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Eigenmode Analyzer

Accessible:

• Optical Setup: Light Sources > Basic Source Models > Programmable Light Source

• Light Sources Catalog: Templates > Programmable Light Source

The programmable light source allows you to define your own field generator. This means you write a little

snippet defining a complex value which represents the complex amplitude at a certain position (x; y) in the

source plane. In order to allow an analytically stored spherical phase the following concept is applied: if the

Distance to Input Plane r is not equal to zero, a spherical phase exp(i kr) is multiplied to the values defined in
the snippet.
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Figure 483. Sample edit dialog for the programmable light source.

Besides Generate Cross Section (↪→Sec. 48.2.3), the spatial parameters tab (↪→Fig. 483) contains the following

controls:

ITEM DESCRIPTION

Snippet Edit opens the Source Code Editor (↪→Sec. 7.3) to edit the snippet defining

the source field. A validity indicator (↪→Sec. 5.10) shows whether this snippet

is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

The remaining tabs of this dialog are explained in Sec. 48.2.

52 Partially Coherent Source Models

VirtualLab Fusion models partially spatially coherent fields by a laterally shifted mode model [VT06; WSK07].

To this end a fundamental mode is generated and laterally shifted. For each lateral position a harmonic field is

generated which forms a member of a harmonic fields set. The complete set models the partially coherent field.

Theoretically the model requires an infinite number of shifted modes, but in practice, the simulation converges

and needs only a limited number of modes.

Figure 484. Part of the Sources ribbon showing all Partially Coherent Source Models available in the main window. They

are explained in the following sections.

The following sources can be used to model partially coherent light.
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LIGHT SOURCE DESCRIPTION

Customized Mode Planar

Source

Several copies of the same arbitrary base mode can be placed on different

positions of the source plane. The base mode is taken from an already open

harmonic field. ↪→Sec. 52.1

Far Field Source Several copies of the same arbitrary base mode can be placed on different

positions of the source plane. The base mode is calculated from its far field.

↪→Sec. 52.2

Gaussian Type Planar

Source

Several copies of the same Gaussian base mode can be placed on different

positions of the source plane. Can be used to simulate LEDs and Excimer

lasers. ↪→Sec. 52.3

Grid Gaussian Planar

Source

Several copies of the same Gaussian base mode are placed on a grid.

↪→Sec. 52.4

Multimode Gaussian

Source

Combines several orders of the same Gaussian mode. ↪→Sec. 52.5

Panel Type Source Allows you to generate a rectangular grid of pixels (e. g. from an im-

ported image) whereas each pixel is represented by a spherical wave mode.

↪→Sec. 52.7.1

Programmable Mode Pla-

nar Source

Several copies of the same arbitrary base mode can be placed on different

positions of the source plane. The base mode is generated from a snippet.

↪→Sec. 52.6

Scanning Source Allows you to generate a rectangular grid of modes (e. g. from an imported

image) whereas each mode is a plane wave mode propagating into another

direction. ↪→Sec. 52.7.2

52.1 Customized Mode Planar Source

Availability

Optical Setups: General Optical Setup

Accessible:

• Main window: Sources > Customized Mode Planar Source

• Optical Setup: Light Sources > Partially Coherent Light Sources > Customized Mode Planar

Source

• Light Sources Catalog: Templates > Customized Mode Planar Source

The Customized Mode Planar Source allows you to combine laterally shifted customized modes to a single

source field in a simple way. The lateral positions of the modes are distributed in the source plane with given

size. The modes are handled in an incoherent mode and are handled independently as members of a harmonic

field set.

This source model supports globally polarized fields in spatial domain as customized modes. Spectral Param-

eters and Polarization of these modes can be changed.
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Figure 485. Parameters for generating a source using a customized mode.

The following parameters can be defined on the Spatial Parameters tab.

ITEM DESCRIPTION

Size of Source Plane PV Size of the source plane (emitting surface). The model assumes that the

laterally shifted modes are distributed uniformly across that source plane.

Set Sets the base mode, which must be a harmonic field in spatial domain. The

wavelength of this field is ignored. When you click on this button you can do

the following:

• Load a spatial field from a .ca2 file.

• Select from Documents allows you to select an already open spatial

field.

• Reset the data to the default field.

Show Displays the base mode being used.

Achromatic in Source

Plane

Any wavelength is applied to the field without adapting the field in the source

plane.

Achromatic in Far Field In this case the sampling distance of the field is modified using the formula

∆xcurrent = ∆x · λcurrent/λfield. Here ∆xcurrent is the resulting sampling distance,
∆x is the sampling distance of the stored base mode, λfield is the vacuum

wavelength of the stored base mode and λmedium is the vacuum wavelength

of the current mode.

The remaining tabs of this dialog are explained in Sec. 48.2.

52.2 Far Field Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Light Shaping Optical Setup

Accessible:

• Optical Setup: Light Sources > Partially Coherent Light Sources > Far Field Source

• Light Sources Catalog: Templates > Far Field Source

The far field source allows you to define a spatially partially coherent light source by its far field. See Sec. 132.4

for physical details.
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Figure 486. The Spatial Parameters tab of a Far Field Source. (Local Polarization is defined on the Polarization tab.)

The following parameters can be defined on the Spatial Parameters tab.

ITEM DESCRIPTION

Size of Source Plane PV Defines the area in which the distinct lateral modes are placed.

Definition of Modulation Defines the complex direction weight functions Dl, either by Programmable

Input or by Databased Input. If you use both input types, the two so defined

values are multiplied. If the far field source has been set to Local Polarization

on the Polarization tab, you can define two weight functions: the Ex Modula-

tion and the Ey Modulation. The programmable input is described in subsec-

tion Sec. 52.2.1 and the databased input in subsection Sec. 52.2.2.

The lateral shifts of the modes can be defined on theMode Selection tab. The remaining tabs of this dialog are

explained in Sec. 48.2.

52.2.1 Programming the Complex Direction Weight Functions

For programming you can use either the spherical angles theta and phi or the Cartesian coordinates x, y and

Distance, which is the Distance to Input Plane PV defined on the Basic Parameters tab. It is assumed that theta

and phi are given in radians and that phi is in the range −π . . . + π.
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Figure 487. The Spatial Parameters tab of a Far Field Source in Programmable Input mode. (Global Polarization is de-

fined on the Polarization tab.)

The following conversion formulas are used to calculate theta and phi. 1

r =
√
x2 + y2 +Distance2 (52.1)

theta = arccos
Distance

r
(52.2)

phi = atan2
y
x

(52.3)

The following controls are used for programming the complex weight functions.

ITEM DESCRIPTION

Definition This group box allows you to program a code snippet defining the complex

weight functions. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this

snippet, and a validity indicator (↪→Sec. 5.10) shows whether this snippet is

consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

General information about programming in VirtualLab Fusion can be found in Sec. 7.

1 atan2 is a special implementation of the arctangent function for a fraction of two values. See Microsoft C# documentation or Wikipedia

for reference.

https://docs.microsoft.com/en-us/dotnet/api/system.math.atan2
https://en.wikipedia.org/w/index.php?title=Atan2&oldid=1026614210
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52.2.2 Databased Complex Direction Weight Functions

Figure 488. The Spatial Parameters tab of a Far Field Source in Databased Input mode.

For Databased Input of the complex direction weight functions the following controls can be used.

ITEM DESCRIPTION

Set > Load Loads a data array from a .da file.

Set > Import Imports a data array from a bitmap or text file by means of the import wizard

described in Sec. 121.2.

Set > Select from Docu-

ments

Allows you to select an already open data array.

Set > Reset Resets the modulation data to its default.

Show Shows the current data in a separate data array view (↪→Sec. 13.5).

Preview Table A preview table showing the current data.

The data array to be set must contain only one complex-valued two-dimensional data subset. If both coordinates

are given in degrees or radians the coordinates will be interpreted as spherical angles. In this case the x-

coordinate is always interpreted as the spherical angle φ which is defined in the range −π . . . + π. The y-

coordinate is interpreted as the spherical angle θ within the value range 0 . . . + π
2 .

In any other case the coordinates are used as x-y-coordinates.

The labels of the data array and the physical property of the coordinates are adapted automatically.
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52.3 Gaussian Type Planar Source

Availability

Optical Setups: General Optical Setup

Accessible:

• Main window: Sources > Gaussian Type Planar Source

• Optical Setup: Light Sources > Partially Coherent Light Sources > Gaussian Type Planar Source

• Light Sources Catalog: Templates > Gaussian Type Planar Source

This generator can be used to simulate LEDs and Excimer lasers. See Sec. 132.3 for physical details.

Figure 489. Parameters for generating a Gaussian type source field.

Description of the parameters on the Spatial Parameters (↪→Fig. 489) tab:

ITEM DESCRIPTION

Size of Source Plane PV Size of the source plane (emitting surface). The model assumes that the

laterally shifted modes are distributed uniformly across that source plane. In

the limit of dense modes the size corresponds to the half maximum.

Achromatic Parameter The chosen value is kept constant over set of wavelengths. The values de-

pend on each other and are recomputed using the reference wavelength.

During generation the achromatic parameter is used together with the refrac-

tive index and the vacuum wavelength to compute the waist of the fundamen-

tal Gaussian modes.

HWHM Divergence An-

gle PV

Half width at half maximum divergence angle of the source field (not that of a

single fundamental mode).

Spatial Coherence

Length PV

Spatial coherence length of the source field.

Waist Radius (1/e2) PV Waist radius of the fundamental modes.

The remaining tabs of this dialog are explained in Sec. 48.2.
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52.4 Grid Gaussian Planar Source

Availability

Optical Setups: General Optical Setup

Accessible:

• Main window: Sources > Grid Gaussian Planar Source

• Optical Setup: Light Sources > Partially Coherent Light Sources > Grid Gaussian Planar Source

• Light Sources Catalog: Templates > Grid Gaussian Planar Source

The Grid Gaussian Planar Source source model allows you to combine laterally shifted Gaussian waves to

a single source field in a simple way. The lateral positions are described by a regular grid centered at (0, 0)
with given size and a given period (distance between the single waves). Two modes are available: coherent

and non-coherent. In the coherent case the laterally shifted waves are added (complex number operation),

whereas in the non-coherent case each wave is handled independently as member of a field set.

Figure 490. Parameters for generating a gridded Gaussian wave.

The corresponding edit dialog is shown in Fig. 490. Its Spatial Parameters tab has the following parameters:

ITEM DESCRIPTION

Coherent Mode Flag indicating whether the laterally shifted waves are considered to be in

coherent mode or not.

Waist Radius (1/e2) PV Waist radius of the single Gaussian waves.

Grid Period PV Period of the waves, i. e. distance between them.

Grid Points PV Size of the grid, i. e. number of Gaussian waves.

The remaining tabs of this dialog are explained in Sec. 48.2.

52.5 Multimode Gaussian Source

Availability

Optical Setups: General Optical Setup

Accessible:

• Main window: Sources > Multimode Gaussian Source

• Optical Setup: Light Sources > Partially Coherent Light Sources > Multimode Gaussian Source

• Light Sources Catalog: Templates > Multimode Gaussian Source

The Multimode Gaussian Source allows you to combine several orders of the same Gaussian mode. First

the maximum order has to be defined, then for each order the Weight PV (that refers to the intensity) and the

absolute Phase Offset PV has to be given in the table at the bottom of the Spatial Parameters tab. This table
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also allows you to set certain modes Active or inactive which means that they are not considered in the resulting

field.

The fundamental Gaussian mode can be specified by an achromatic parameter : either the waist, the angle of

divergence, or the Rayleigh length. This parameter is the same for all base modes. Note that base modes with

different wavelengths (according to the settings on the Spectral tab, ↪→Sec. 48.2.2) can have different waists if

the achromatic parameter is the angle of divergence or the Rayleigh length.

In contrast, the higher-order modes have always the same Rayleigh length as the corresponding fundamental

mode. This ensures that fundamental mode and corresponding higher-order modes do not diverge during

propagation.

For the theory of Gaussian beams see Sec. 132.1.

Figure 491. Parameters for generating a Multimode Gaussian Source.

The following parameters can be defined on the Spatial Parameters tab (↪→Fig. 491).
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ITEM DESCRIPTION

Type Selects whether Hermite-Gaussian or Laguerre-Gaussian modes are to be

generated.

Waist Radius 1/(e^2) PV Radius of the fundamental mode in waist position. The radius is determined

by a relative intensity decay by 1/e2 for a Gaussian beam.

Reference Wavelength

(Vacuum)

The wavelength to which the selected achromatic parameter refers.

Half-Angle Divergence

1/(e^2) PV

Half far field divergence angle of the fundamental mode measured between

the optical axis and the 1/e2 decay of the intensity.

Rayleigh Length PV Rayleigh length.

Offset between y- and x-

plane PV

For Hermite-Gaussian modes different longitudinal waist distances can be

specified in x- and y-direction, which corresponds to the effect of astigmatism.

We define that the waist distance in x-direction is equal to theDistance to Input

Plane and waist distance in y-direction is the sum between Distance to Input

Plane and the given value Offset between y- and x-plane.

Coherent Accumulation of

Modes

If you select Coherent Accumulation of Modes the modes of different orders

are added (complex number operation). Otherwise each order is handled

independently as member of a harmonic fields set.

Maximum Order Defines the upper limit for the orders being used. Order 0 corresponds to a

Gaussian fundamental mode. For a Laguerre-Gaussian mode, the left text

box refers to the radial order while the right box specifies the angular order.

The remaining tabs of this dialog are explained in Sec. 48.2.

52.6 Programmable Mode Planar Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Light Shaping Optical Setup

Accessible:

• Optical Setup: Light Sources > Partially Coherent Light Sources > Programmable Mode Planar

Source

• Light Sources Catalog: Templates > Programmable Mode Planar Source

The Programmable Mode Planar Source allows you to program the base mode combine whose laterally shifted

copies are distributed in the source plane with given size. The copies are handled in an incoherent mode and

are handled independently as members of a harmonic field set. The programmed mode is assumed to be

globally polarized. Spectral information can be added using the panel Spectral Parameters.

In order to allow an analytically stored spherical phase the following concept is applied: if the value entered at

Distance to Input Plane is not equal to zero, a spherical phase exp(i kr) is multiplied to the values defined in

the snippet.
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Figure 492. The Spatial Parameters tab for a Programmable Mode Planar Source.

Besides Generate Cross Section (↪→Sec. 48.2.3), the spatial parameters tab (↪→Fig. 492) contains

ITEM DESCRIPTION

Size of Source Plane PV Size of the source plane (emitting surface). The model assumes that the

laterally shifted modes are distributed uniformly across that source plane. In

the limit (dense modes) the size corresponds to half the maximum.

Definition This group box allows you to program the code snippet defining the base

mode. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this snippet,

and a validity indicator (↪→Sec. 5.10) shows whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

General information about programming in VirtualLab Fusion can be found in Sec. 7. The remaining tabs of

this dialog are explained in Sec. 48.2.

This source does not provide automatic sampling. However, the definition of the sampling distance is supported

in the dialog. In particular we require a sampling of the phase residuals caused by mode shifts with respect

to the spherical phase that is defined on axis (originating from the Distance to Input Plane). In the dialog of

the source at the Sampling tab, the required sampling distance is displayed (↪→Fig. 493). If the button Copy

Sampling Distance is pressed, the sampling distance is entered into the corresponding fields.
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Figure 493. Additional support for the sampling of programmable mode planar source.

52.7 Image Light Sources

There are two light sources which allow you to generate a rectangular grid of distinct modes whereas each

mode can have its own intensity weight. These weights can either be taken from an arbitrary image which the

user specifies. Or they can be constant 1.

The Panel Type Source (↪→Sec. 52.7.1) places the modes at different positions and thus you can see the pixels

of the original image in the near field. The Scanning Source (↪→Sec. 52.7.2) propagates the modes into different

directions and thus you can see the original image in the far field.

Figure 494. The Specific Parameters tab of an image light source (here Panel Type Source).

Both light sources have the following controls on the Specific Parameters tab (↪→Fig. 494) in common.
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ITEM DESCRIPTION

From Chromatic Fields

Set

The intensity of each mode is determined from a Chromatic Fields Set. Note

that in this way you can define an intensity distribution for multiple wave-

lengths.

Set Image O F C F S .

Allows you to load a Chromatic Fields Set into the dialog. When you click on

this button you can do the following:

• Load a Chromatic Fields Set from a .cfs file.

• Import a Chromatic Fields Set from a bitmap file. ↪→Sec. 122.2

• Select from Documents allows you to select an already open Chromatic

Fields Set.

Show Image O F C F S .

Shows the currently set Chromatic Fields Set as a separate document.

Constant 1 A constant intensity of 1 is assumed for each pixel.

Number of Pixels / Direc-

tions

O C 1 .

The number of modes to be generated.

Wavelength O C 1 .

The wavelength the generated modes have.

If per wavelength there are more modes to be generated than specified in the Global Options Dialog

(↪→Sec. 6.14; Maximum Number of Modes), a warning is shown in the Validity control.

Figure 495. The Mode Selection tab of an image light source (here Panel Type Source).

These light sources also add functionality to the mode selection tab (↪→Fig. 495):
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ITEM DESCRIPTION

All Pixels / Directions All modes are generated as specified on the Specific Parameters tab.

Select Column Only modes having the specified Column Index are generated.

Select Row Only modes having the specified Row Index are generated.

Select Pixel / Direction Only the mode with the specified Column Index and Row Index is generated.

The remaining controls of the edit dialogs are explained in Sec. 48.1.

52.7.1 Panel Type Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Light Shaping Optical Setup

Accessible:

• Optical Setup: Light Sources > Partially Coherent Light Sources > Panel Type Source

• Light Sources Catalog: Templates > Panel Type Source

The Panel Type Source allows you to generate a rectangular grid of pixels (e. g. from an imported image)

whereas each pixel is represented by a spherical wave mode.

Figure 496. The edit dialog of the Panel Type Source (Specific Parameters tab).

The Specific Parameters tab of its dialog (↪→Fig. 496) has the following controls specific to the Panel Type

Source.
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ITEM DESCRIPTION

Pixel Pitch The x- and y-distance of neighbored pixels.

Aperture Angle The full aperture angle. Together with the pixel pitch this determines the Dis-

tance to Source Plane, i. e. how far behind the source plane the spherical

wave starts from a single point. If the pixel pitch differs in x- and y-direction

the larger of the two values is taken for this calculation.

Distance to Source Plane For your information the distance to the source plane is also given.

The remaining controls of this dialog are explained in Sec. 52.7.

52.7.2 Scanning Source

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Light Shaping Optical Setup

Accessible:

• Optical Setup: Light Sources > Partially Coherent Light Sources > Scanning Source

• Light Sources Catalog: Templates > Scanning Source

The Scanning Source allows you to generate a rectangular grid of modes (e. g. from an imported image)

whereas each mode is a plane wave mode propagating into another direction. Modes more in the center of the

original image have a smaller deviation from the central direction.

Figure 497. The edit dialog of the Scanning Source (Specific Parameters tab).
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The Specific Parameters tab of its dialog (↪→Fig. 497) has the following controls specific to the Scanning Source.

ITEM DESCRIPTION

Central Direction The direction into which the center of the overall field propagates.

Field of View The full field of view, i. e. the difference in the x- and y-direction of the outer-

most pixels.

Angular Pitch The difference in the x- and y-direction of neighbored pixels.

The remaining controls of this dialog are explained in Sec. 52.7.

53 Spectrum Generators

Figure 498. Part of the Sources ribbon showing all available spectrum generators. They are explained in the following

sections.

SPECTRUM GENERATOR DESCRIPTION

Black Body Spectrum A discrete sample at equidistant wavelengths from the black body spectral in-

tensity distribution governing the thermal radiation of an idealized black body.

↪→Sec. 53.1

Gaussian Spectrum A discrete sample at equidistant wavelengths of the Gaussian spectral in-

tensity distribution which arises in Doppler broadening of a spectral line.

↪→Sec. 53.2

Homogeneous Spectrum A constant intensity sampled at equidistant wavelengths. ↪→Sec. 53.3

Lorentzian Spectrum A discrete sample at equidistant wavelengths of the Lorentzian spectral in-

tensity distribution which arises in natural lifetime and collision broadening of

a spectral line. ↪→Sec. 53.4

Databased Spectrum Allows the specification of data points for the generation of a spectrum.

↪→Sec. 53.5

Programmable Spectrum Allows you to program an arbitrary spectrum over wavelength or frequency.

↪→Sec. 53.6

Gaussian Pulse Spectrum An ultra-short pulse with a Gaussian envelope. ↪→Sec. 53.7

Databased Pulse Spec-

trum

Allows the specification of data points for the generation of a pulse spectrum.

↪→Sec. 53.8

Programmable Pulse

Spectrum

Allows you to program an arbitrary pulse spectrum over wavelength or fre-

quency. ↪→Sec. 53.9
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53.1 Black Body Spectrum

Availability

Toolboxes: All

Accessible: Sources > Black Body Spectrum

The Black Body Spectrum generates a discrete sample at equidistant wavelengths from the black body spectral

intensity distribution governing the thermal radiation of an idealized black body (↪→Sec. 132.5.1). Any such

distribution is simply depending on the temperature of the body. The edit dialog (↪→Fig. 499) has the following

parameters:

ITEM DESCRIPTION

Temperature Allows the selection of the absolute temperature in Kelvin. For your informa-

tion also the wavelength is given at which the distribution peaks for the current

temperature according to Wien’s displacement law.

Min. Wavelength The lower bound of the sampling interval is entered here.

Max. Wavelength The upper bound of the sampling interval is entered here.

Sampling Count The total number of sampled wavelengths is defined here.

Figure 499. Dialog for adjusting a black body spectrum.

After finishing the dialog, the wavelengths between the given minimum and maximum are computed according

to the sampling count with constant sampling increment.

Their intensity values are obtained by integrating the intensity function over an interval of half a sampling incre-

ment both at the left and at the right of the wavelength. Thus the sampled wavelengths get an intensity which

is representative for a symmetric interval around them.

By re-scaling the computed values, the peak intensity for the sample is arbitrarily set to 1.

Output is a 2D diagram showing the distribution of the black body radiation at the chosen temperature. The

diagram can be used as the spectrum of a polychromatic light source in the generating dialog of the light source.
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53.2 Gaussian Spectrum

Availability

Toolboxes: All

Accessible: Sources > Gaussian Spectrum

The Gaussian Spectrum generates a discrete equidistant sample of wavelengths with their intensities forming

a Gaussian spectral intensity distribution (which arises from Doppler broadening of a spectral line). Any such

distribution is characterized by a peak wavelength and by the half width wavelength increment at half-maximum.

↪→Sec. 132.5.2.

The edit dialog (↪→Fig. 500) has the following parameters:

ITEM DESCRIPTION

Peak Wavelength Allows the selection of the wavelength carrying the intensity maximum.

Half Width at Half-Max The wavelength difference that defines the line broadening is entered here.

Sampling Count The number of sampled wavelengths is entered here.

Clipping Intensity Here the intensity ratio relative to peak intensity is determined which delimits

the sampling interval.

Figure 500. Dialog for adjusting a Gaussian spectrum.

After finishing the dialog, theminimal andmaximal wavelengths to be included are calculated, and the remaining

wavelengths according to the sampling count are computed with constant sampling increment.

Their intensity values are obtained by integrating the intensity function over an interval of half a sampling incre-

ment both at the left and at the right of the wavelength. Thus the sampled wavelengths get an intensity which

is representative for a symmetric interval around them.

By re-scaling the computed values, the peak intensity for the sample is arbitrarily set to 1.

Output is a 2D diagram showing the Gaussian distribution. The diagram can be used as the spectrum of a

polychromatic light source in the generating dialog of the light source.

53.3 Homogeneous Spectrum

Availability

Toolboxes: All

Accessible: Sources > Homogeneous Spectrum
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The Homogeneous Spectrum allows to generate a constant intensity sampled at equidistant wavelengths. Its

edit dialog (↪→Fig. 501) has the following parameters:

ITEM DESCRIPTION

Central Wavelength Allows the selection of the wavelength defining the middle of the wavelength

band.

Spectral Bandwidth The difference between maximal and minimal wavelength in the selected

band is entered here.

Sampling Increment The difference between two adjacent sampled wavelength values is entered

here.

Figure 501. Dialog for adjusting a homogeneous spectrum.

Output is a 2D diagram showing the homogeneous distribution. The intensity values are arbitrarily set to 1.

The diagram can be used as the spectrum of a polychromatic light source in the generating dialog of the light

source.

If the bandwidth is not an integral multiple of the wavelength increment, then the wavelength samples are

generated symmetrically around the central wavelength. The smallest wavelength in the sample is not larger

than the lower band limit, and the largest wavelength in the sample is not smaller than the upper band limit.

53.4 Lorentzian Spectrum

Availability

Toolboxes: All

Accessible: Sources > Lorentzian Spectrum

The Lorentzian Spectrum generates a discrete sample at equidistant wavelengths of the Lorentzian spectral

intensity distribution which arises in natural lifetime and collision broadening of a spectral line. Any such dis-

tribution is characterized by a peak wavelength and by the half width wavelength increment at half-maximum.

↪→Sec. 132.5.3.

The edit dialog (↪→Fig. 502) has the following parameters:
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ITEM DESCRIPTION

Peak Wavelength Allows the selection of the wavelength carrying the intensity maximum.

Half Width at Half-Max The wavelength difference that defines the line broadening is entered here.

Sampling Count The number of sampled wavelengths is entered here.

Clipping Intensity Here the intensity ratio relative to peak intensity is determined which delimits

the sampling interval.

Figure 502. Dialog for adjusting a Lorentzian spectrum.

After finishing the dialog, theminimal andmaximal wavelengths to be included are calculated, and the remaining

wavelengths according to the sampling count are computed with constant sampling increment.

Their intensity values are obtained by integrating the intensity function over an interval of half a sampling incre-

ment both at the left and at the right of the wavelength. Thus the sampled wavelengths get an intensity which

is representative for a symmetric interval around them.

By re-scaling the computed values, the peak intensity for the sample is arbitrarily set to 1.

Output is a 2D diagram showing the Lorentzian intensity distribution. The diagram can be used as the spectrum

of a polychromatic light source in the generating dialog of the light source.

53.4.1 Used Formula

The Lorentzian power spectrum in dependence on the angular frequency ω is given by the formula

S(ω) =
S0

(ω−ω0)2 + ∆ω2 ,

where ω0 is the central angular frequency, ∆ω the half width at half-maximum of the distribution.

In transforming the density to a function of the wavelength, the relations

ω0 = 2πc/λ0,

∆ω = −ω0/λ0 · ∆λ,

were used.

If wavelengths with a minimal intensity Smin (relative to the peak intensity) shall limit the sampled wavelength

interval, then corresponding lowest and highest angular frequencies are computed from

ωmin = ω0 + ∆ω ·
√

1/Smin − 1,

ωmax = 2ω0 −ωmin,

and the equivalent wavelengths follow from λ = 2πc/ω.
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53.5 Databased Spectrum

Availability

Toolboxes: All

Accessible: Sources > Databased Spectrum

The Databased Spectrum generator allows the specification of data points for the generation of a spectrum.

The generator can be used for direct specification of the data points, or for reading data point values from a

user defined file.

The following settings can be done within the edit dialog of the databased spectrum generator:

ITEM DESCRIPTION

Specification in Wave-

length / Frequency Do-

main

The user can select whether the values defined in the data table shall be used

within the wavelength domain, or the frequency domain.

Central Wavelength / Fre-

quency

To specify the position of the data points the user has to enter the central

wavelength / frequency.

Note that it is ensured that the spectrum covers the same spectral range, i. e.

minimum and maximum are kept. Thus the central frequency νc cannot be

calculated from the central wavelength λc via νc = c/λc.

Data Table The data table allows you to edit the amplitude and phase values of each data

point. A data point can be added by clicking on the Add Data Point tool.

Size of the Wavelength /

Frequency Window

The user can select whether he likes to define the array size of the wave-

length / frequency window or the sampling distance within wavelength / fre-

quency.

Number Data Points The number of data points is visualized. The control to edit the number of

data points is read only because the number of data points is specified by the

number of entries in the data table.

Note: The databased spectrum generator is only configured correctly if at least two data points are within the

data table.

The following data table tools are available :

ITEM DESCRIPTION

Add Data Point Data table tool to add a new data point. Clicking on this tools triggers the

display of a dialog where the user has to enter the amplitude and the phase

of the new data point.

Load from File The user can specify a file which shall be used for filling the table of data

values.

Clear Table The user can reset the data table by clicking on the Clear Table tool.

Note: The data values in the table are always interpreted as equidistant data points.

Fig. 503 shows the edit dialog of the databased spectrum generator.
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Figure 503. Dialog of the databased spectrum generator.

The result of the databased spectrum generator is a 1D Light Field Object which shows amplitude and phase

values over wavelengths. This diagram can be used in polychromatic sources for the specification of the

spectral parameters.

53.6 Programmable Spectrum

Availability

Toolboxes: All

Accessible: Sources > Programmable Spectrum

TheProgrammable Spectrum generator allows the specification of a amplitude / phase function over wavelength

or frequency. Within the generator the user has the possibility to program a simple snippet which describes the

function which shall be realized by the spectrum generator.

Fig. 504 shows the edit dialog of the programmable spectrum generator.
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Figure 504. Dialog of the programmable spectrum generator.

The following settings can be done within the edit dialog of the programmable spectrum generator:

ITEM DESCRIPTION

Specification in Wave-

length / Frequency Do-

main

The user can select whether the return values of the function defined in the

snippet shall be used within the wavelength domain, or the frequency domain.

Central Wavelength / Fre-

quency

To specify the position of the data values the user has to enter the central

wavelength / frequency.

Note that it is ensured that the spectrum covers the same spectral range, i. e.

minimum and maximum are kept. Thus the central frequency νc cannot be

calculated from the central wavelength λc via νc = c/λc.

Definition This group box allows you to program a snippet which generates a distribution

of complex values. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this

snippet, and a validity indicator (↪→Sec. 5.10) shows whether this snippet is

consistent.

Parameters The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

Size of the Wavelength /

Frequency Window

The user can select whether to define the array size of the wavelength / fre-

quency window or the sampling distance within wavelength / frequency.

Number Data Points The number of data points can be entered. The minimum number of data

points to define a valid programmable spectrum generator is two.

The result of the programmable spectrum generator is a 1D Light Field Object which shows amplitude and
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phase values over wavelengths. This diagram can be used in polychromatic sources for the specification of

the spectral parameters.

53.7 Gaussian Pulse Spectrum

Availability

Toolboxes: All

Accessible: Sources > Programmable Spectrum

Figure 505. Edit dialog for a Gaussian Pulse Spectrum

TheGaussian Pulse Spectrum generator is intended to generate an ultra-short pulse with a Gaussian envelope.

Thus its edit dialog (↪→Fig. 505) asks for the parameters of the resulting pulse. As result you obtain a spectrum

with a Gaussian shape if the amplitudes are plotted over frequency.
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ITEM DESCRIPTION

Definition by FWHM Pulse Duration refers to half the maximum squared amplitude.

Definition by 1/e Diameter Pulse Duration refers to 1/e times the maximum squared amplitude.

Pulse Duration Specify the duration of the pulse in time.

Carrier Wavelength The wavelength where the pulse spectrum reaches its maximum.

Carrier Frequency For your information also the frequency where the pulse spectrum reaches

its maximum is given.

Estimated Increase Of

Time Window

With this factor you can enlarge the time window in which the pulse is dis-

played. This factor can be used to ensure that even the broadened pulse

after propagation can be displayed correctly. As a side effect, the number of

sampling points for the resulting spectrum is enlarged by the same factor.

Squared Amplitude Trun-

cation (Frequency Do-

main)

In theory, a Gaussian spectrum has an infinite width. Thus you can specify a

threshold relative to the maximum squared amplitude. Squared amplitudes

smaller than this threshold are not taken into account.

Resulting Size of Angular

Frequency Window

For your information, the resulting band width of the truncated spectrum is

given.

Squared Amplitude Trun-

cation (Time Domain)

In theory, also the Fourier-transformed pulse would have an infinite width.

Thus, a further threshold relative to the maximum squared amplitude is

needed for the time domain.

Resulting Size of Time

Window

For your information, the resulting time window is given to illustrate the ef-

fect of the Time Domain threshold. The overall time window displayed after

temporal Fourier transform (↪→Sec. 31.2.1) is Resulting Time Window times

Estimated Increase Of Time Window.

Resulting Samples For your information; the resulting number of frequency samples which will

be generated by the Gaussian Pulse Spectrum Generator.

53.8 Databased Pulse Spectrum

Availability

Toolboxes: All

Accessible: Sources > Databased Pulse Spectrum

The Databased Pulse Spectrum generator allows the specification of data points for the generation of a pulse

spectrum. The generator can be used for direct specification of the data points, or for importing data points

from a user defined file.

Fig. 506 shows the edit dialog of the databased pulse spectrum generator.
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Figure 506. Dialog of the databased pulse spectrum generator.

The following settings can be done within the edit dialog of the databased pulse spectrum generator:

ITEM DESCRIPTION

Specification in

Time / Frequency Domain

The user can select whether the values defined in the data table shall be used

within the time domain, or the frequency domain.

Carrier Wavelength The carrier wavelength which shall be used for pulse shape generation.

Carrier Frequency The carrier frequency is calculated from the Carrier Wavelength.

{Data Table} The data table allows you to edit the amplitude and phase values of each data

point. A data point can be added by clicking on the Add Data Point tool.

Data Table Tools Clicking on this button opens a collection of various tools which help you in

editing the data table. See below.

Size of the

Time / Frequency Win-

dow

The user can select whether he likes to define the array size of the

time / frequency window or the sampling distance within time / frequency.

Number Data Points This control to show the number of data points is read only because the num-

ber of data points is specified by the number of entries in the data table.

Note: The databased pulse spectrum generator is only configured correctly if at least two data points are within

the data table.

The following data table tools are available:
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ITEM DESCRIPTION

Add Data Point Data table tool to add a new data point. Clicking on this tools triggers the

display of a dialog where the user has to enter the amplitude and the phase

of the new data point.

Load from File The user can specify a file which shall be used for filling the table of data

values. It must contain two columns (one for the amplitude values, one for

the phase values, separated by a space). ‘.’ must be the number separator

and lines can be commented out by prepending ‘#’.

Clear Table The user can reset the data table by clicking on the Clear Table tool.

Note: The data values in the table are always interpreted as equidistant data points.

The result of the databased pulse spectrum generator is a 1D Light Field Object which shows amplitude and

phase values over wavelengths. This diagram can be used in polychromatic sources for the specification of

the spectral parameters. The resulting pulse shape which is displayed over wavelength can be transformed to

the pulse shape in time domain by performing an inverse Fourier transform. More information on that can be

found in Sec. 31.2.1.

53.9 Programmable Pulse Spectrum

Availability

Toolboxes: All

Accessible: Sources > Programmable Pulse Spectrum

The Programmable Pulse Spectrum generator allows the specification of a amplitude / phase function over time

or frequency. Within the generator the user has the possibility to program a simple snippet which describes the

function which shall be realized by the pulse spectrum generator.

The following settings can be done within the edit dialog of the programmable pulse spectrum generator:

ITEM DESCRIPTION

Specification in Time / Fre-

quency Domain

The user can select whether the return values of the function defined in the

snippet shall be used within the time domain, or the frequency domain.

Carrier Wavelength The carrier wavelength which shall be used for pulse shape generation.

Carrier Frequency The carrier frequency is calculated from the Carrier Wavelength.

Definition This group box allows you to program a snippet which generates a distribution

of complex values. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this

snippet, and a validity indicator (↪→Sec. 5.10) shows whether this snippet is

consistent.

Parameters The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

Size of the Time / Fre-

quency Window

The user can select whether he likes to define the array size of the time /

frequency window or the sampling distance within time / frequency.

Number Data Points The number of data points can be entered. The minimum number of data

points to define a valid programmable pulse spectrum generator is two.

Fig. 507 shows the edit dialog of the generator.
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Figure 507. Dialog of the programmable pulse spectrum generator.

The result of the programmable pulse spectrum generator is a 1D Light Field Object which shows amplitude

and phase values over wavelengths. This diagram can be used in polychromatic sources for the specification

of the spectral parameters. The resulting pulse shape which is displayed over wavelength can be transformed

to the pulse shape in time domain by performing an inverse Fourier transform. More information on that can

be found in Sec. 31.2.1.



IX Real Components

This part documents allReal Components like lenses, fibers, holograms,

or gratings which are available within the Optical Setup (↪→Sec. 43) of

VirtualLab Fusion.
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54 Edit Dialog for Real Components (Common Controls)

Figure 508. Example for the edit dialog for real components.

The edit dialogs for all real components (↪→Fig. 508) are divided into several pages:

PAGE DESCRIPTION

Coordinate Systems ↪→Sec. 43.8.1

Position / Orientation ↪→Sec. 43.8.2

Structure The structure tab is specific for the distinct real components and is thus ex-

plained in the following chapters.

Solver / Function N C F T .

Explains the algorithm used to simulate the component.

Channel Configuration N C F T .

↪→Sec. 43.9

Fourier Transforms N C F T .

↪→Sec. 43.4.2

Propagation O C F T .

↪→Sec. 54.1

In the lower left corner of the dialog there are the following controls:
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ITEM DESCRIPTION

Saves the component into the user-defined component catalog (↪→Part V).

Opens a dialog that shows a three-dimensional view of the component. More

information about the 3D view is available in Sec. 5.15.

{Validity Indicator} Indicates whether the component is currently in a consistent state. Not visible

for all components. ↪→Sec. 5.10

54.1 Propagation Tab for Components

T C F T .

Figure 509. Sample propagation tab for real components showing the propagation matrix (here: General Grating).

Figure 510. One cell of the propagation table showing the name of the current building block (top), the currently selected

type of propagation (bottom left), and the edit button (bottom right)

The lower part of the propagation tab contains a table representing individual propagation methods for each

building block in the component. Each row represents a so-called Boundary Segment, i. e. an Optical Surface

with associated stack and the subsequent medium. Each cell (↪→Fig. 510) has the following settings.

ITEM DESCRIPTION

Name The name of the corresponding building block.

Propagation Selection Allows you to select the type of propagation for the corresponding building

block.

Edit Opens the edit dialog associated with the current propagation.

If a homogeneous medium is changed to an inhomogeneous one or vice versa, the propagation method for

this medium will usually change.

The Component Propagation in the upper part of the tab is a short cut to setting all propagation methods at

once. Depending on the type of the component and of the currently active component propagation, there might

by some synchronization rules like “A medium has always the same propagation settings as the antecedent

surface” or “All stacks have the same propagation settings”. The following table gives information about all

possible component propagations.



CHAPTER 54. EDIT DIALOG FOR REAL COMPONENTS (COMMON CONTROLS) 597

COMPONENT PROPAGATION ANNOTATIONS

Collins Integral by ABCD Matrix

(For Spherical Lens & Lens System)

This operator uses the ABCD matrix of the component and thus

can handle only certain surface types and homogeneous media.

All propagation settings are synchronized. ↪→Sec. 96.5

Customized Propagation

(For Double Surface Component, Fiber Ele-

ment, GRIN Component & Inhomogeneous

Medium Component.)

Uses Thin Element Approximation (↪→Sec. 96.2) propagations for

surfaces; several paraxial free space propagations for homoge-

neous media (↪→Sec. 93) and either the Thin Element Approxima-

tion or the Split Step (BPM) propagation (↪→Sec. 96.6) for inho-

mogeneous media. The settings are synchronized separately for

each building block type.

Fourier Modal Method

(For General Grating)

All propagation settings are synchronized. ↪→Sec. 96.3

Geometrical Optics

(For Light Shaper)

–

Geometrical Optics Operator

(For Curved Surface, Spherical Lens & Lens

System)

This operator can handle smooth surfaces and homogeneous me-

dia. All propagation settings are synchronized. ↪→Sec. 96.1

The Geometrical Optics Operator shows an additional Advanced Settings sub-tab which is explained in

Sec. 96.1.1.

For Customized Propagation there are tools available to Synchronize Surface / Medium Propagation Parame-

ters which means that the settings of the first surface / medium are written to all other surfaces / media.

54.2 Editing a Component in the 3D View

If you are in the 3D view of a component (↪→Sec. 5.15) and you click on a surface with the right mouse button

the same surface will appear in red color (signaling the selection) and a context menu with the following entries

gets opened (↪→Fig. 511).

ITEM DESCRIPTION

Edit... Opens the edit dialog (↪→Sec. 35) of the selected surface.

Distance... Opens a dialog for adjusting distance from precedent surface. This menu

item is disabled for the first surface.

Show Separately If checked all surfaces except selected one will be hidden. Other surfaces

will get visible again by unchecking this item or by clicking Reset View in the

general context menu.

If one performs a double click on a surface the corresponding edit dialog (↪→Sec. 35) will open.

By clicking OK in the 3D view dialog all changes made will be inherited by the component.
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Figure 511. Context menu of a selected surface in the 3D view.

55 Conversion Between Components

Figure 512. Possible conversions between real and ideal components.

Fig. 512 lists all possible conversions between real components (and the ideal component Stored Function).

Note that for the Diffractive Lens (↪→Sec. 60.2) and the Diffractive Optical Element (DOE) / Microstructure

component (↪→Sec. 60.1) the available conversions depend on their configuration (indicated by gray boxes).

The optical setup tool to convert a complete Grating Optical Setup into a General Optical Setup with one or

two grating components is explained in Sec. 43.6.2.7. All other conversions can be done via right click on the
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icon of the original component in the Optical Setup View (↪→Sec. 43.1). A new component is then added to the

Optical Setup which gets all linkages of the original component.

The conversions are done as best as possible, but still the results obtained with the converted component

can then differ very much from the results obtained with the original component.

56 Index Modulated & Crystal Components

56.1 Crystal Plate

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Components > Index Modulated & Crystals > Crystal Plate

Figure 513. The structure tab of the Crystal Plate component.

The Crystal Plate component is intended for the rigorous analysis of an anisotropic medium, confined by two

plane parallel infinite surfaces. The Structure tab of its edit dialog (↪→Fig. 522) provides the following settings:
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ITEM DESCRIPTION

Lateral Extent In principle, the Crystal Plate component has an infinite lateral extension.

However, as this is not feasible for the 3D view (↪→Sec. 5.15) and the light

path finder for manual channel configuration (↪→Sec. 43.3.1), a size can be

entered here.

Aperture Read-only control which indicates that the component has an infinite lateral

extension when simulated.

Thickness PV The thickness of the crystal can be set here.

Waveplate Calculator F M .

This button opens a Waveplate Calculator (↪→Sec. 119). This will help to con-

figure the uniaxial crystal plate as a waveplate with a certain retarding effect.

After closing the calculator dialog with Ok, the calculated thickness will be

set to Thickness and the Orientation will be adapted as well. That means

that the optical axis of the crystal is set to the x-y-plane of the component

automatically.

Medium The optical medium (↪→Sec. 37, ↪→Sec. 34.1) the crystal consists of.

Orientation F M .

The orientation of an anisotropic crystal medium in reference to the compo-

nent’s internal coordinate system. In case of uniaxial crystals, only the di-

rection of the optical axis is to be specified (↪→Sec. 5.5). For other types of

anisotropic media, a full orientation has to be defined (↪→Sec. 5.6).

Coating A coating (↪→Sec. 36) for front and back face of the crystal can be defined

here. It is applied to the outer side of both surfaces. ↪→Sec. 34.2.

56.2 Index Modulated Components

Availability

Optical Setups: General Optical Setup & Laser Resonator Optical Setup

Accessible: Optical Setup: Components > Index Modulated & Crystal

These components consist of an index modulated medium between two arbitrary surfaces. There are three

such components which differ only in their default settings and which media can be used.

• Fiber Element: The default settings resemble an optical fiber and by default a Fiber Medium

(↪→Sec. 37.3.4) is used.

• GRIN Lens: The default settings resemble a gradient index lens. Only GRIN Media (↪→Sec. 37.3.6) can

be used.

• Inhomogeneous Medium Component: By default a Programmable Medium (x-y-z-Modulated)

(↪→Sec. 37.3.10) is used.



CHAPTER 56. INDEX MODULATED & CRYSTAL COMPONENTS 601

Figure 514. The Structure tab of an Inhomogeneous Medium Component.

The edit dialog of these components (↪→Fig. 514) has the following controls.

ITEM DESCRIPTION

Center Thickness PV /

Fiber Length PV

The distance of the two surfaces measured on the optical axis.

Individual Apertures for

Each Surface

If you select this option the apertures of the surfaces are set via theEdit button

of the First Surface and Second Surface, respectively.

Uniform Aperture for

Whole Component

If you check this radio button, the same aperture is taken for both surfaces.

The common aperture is then set via the Shape and Diameter controls below

the radio button. If you double-click on one of the Diameter text boxes, the

value from the other text box is being overtaken.

First Surface PE Configures the first surface and displays its name. You can Load a new sur-

face from the catalog (↪→Sec. 33), Edit the current surface or View it with the

three-dimensional view described in Sec. 35.3.

Second Surface PE Configures the second surface and displays its name. You can Load a new

surface from the catalog (↪→Sec. 33), Edit the current surface or View it with

the three-dimensional view described in Sec. 35.3.

Medium Between Sur-

faces PE

Configures the medium between the two surfaces and displays its name. You

can Load a predefined medium from the catalog (↪→Sec. 33), Edit the current

medium (↪→Sec. 37.3.1) or View it with the view described in Sec. 37.2.

The other tab pages are explained in Sec. 54.
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57 Multiple Surfaces Components

57.1 Lens System

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Components > Multiple Surfaces > Lens System

The Structure tab is divided into four sections (from top to bottom):

1. a preview of the current surface media sequence (↪→Sec. 5.14)

2. a table with the current surface media sequence

3. a panel with new surfaces which you can drag into the table

4. a button row .

Figure 515. The structure tab of the Lens System component showing a sample sequence.

The buttons on this tab have the following functionality:

ITEM DESCRIPTION

Tools The tools for a Lens System are described below.

Add Adds a new surface PE from the catalog at the end of the table. The same can

be achieved by dragging the new surface into the table.

Insert Places a new surface from the catalog before the current surface (which is

marked by a triangle in the first table column).

Delete Deletes the selected surface(s).

The table has the following columns:
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ITEM DESCRIPTION

Index The index of the current surface.

Note: This item is read-only.

Distance PV The distance to the precedent surface. The first distance is always zero.

Position The position of the current surface.

Note: This item is read-only.

Type The type (or name in case of catalog surface) of the current surface. If the

mouse hovers above that column, you can edit or view the current surface PE

or load a new one from the Surfaces Catalog. See also Sec. 34.1.

Homogeneous Medium PE The homogeneous medium after the current surface. If the mouse hovers

above that column, you can edit or view the medium behind the current sur-

face or load a new one from the Media Catalog. See also Sec. 34.1.

Important: The last medium is always identical to that of the transmission

type reference coordinate system (see Sec. 43.8.1 for details). Changing that

medium will change the embedding medium between this component and the

next component (which is connected via the transmission type reference CS)

too.

Comment You can enter a comment for a specific surface by clicking into the corre-

sponding comment cell.

You can select a single table row by clicking into it. By pressing Shift at the same time or with dragging

the mouse you can mark consecutive rows. With clicking on the first table column and then drag & drop the

selected rows can be moved (or copied if Shift is pressed at the same time). With Del you can delete the

selected surfaces.

The following Tools are available:



CHAPTER 57. MULTIPLE SURFACES COMPONENTS 604

ITEM DESCRIPTION

Add Surface from Catalog Allows loading a surface with preset parameters from the surface catalog

(↪→Sec. 33).

Duplicate Selected Sur-

face(s)

The currectly selected surfaces are duplicated (including their Distance and

Homogeneous Medium). A simple dialog allows you to specify in which row

(specified by its Index) the duplicated surfaces are inserted. When you enter

n + 1 with n being the currently highest row index, the surfaces are added at

the end of the table.

Remove All Surfaces Removes all surfaces currently set in the table.

Synchronize DefinitionAr-

eas

The definition areas (size and shape) of all surfaces are set to the definition

area of the first surface.

Apply Coating to All Sur-

faces

Loads a coating from the coating catalog and applies it to all (suitable) sur-

faces.

Remove All Coatings Removes the coatings from all surfaces (if present).

Append Component from

Catalog

This tool can be used to append the structural information (sequence of sur-

faces and media) of a component selected from the catalog. The user has to

specify the component that shall be appended.

Append Spread Sheet You can open a Spread Sheet (file format of VirtualLab Fusion 2 – 4) which

is appended at the end of the current surface sequence.

Import ’ZemaxOpticStu-

dio®’ LensFile

You can open a ZemaxOpticStudio® lens file which is appended at the end

of the current surface sequence. More details about import from ZemaxOp-

ticStudio® can be found in Sec. 125.2.

The other tab pages are explained in Sec. 54.

57.2 Light Guide

Availability

Optical Setups: Light Guide Optical Setup & General Optical Setup (only three surface regions per

surface layout)

Accessible: Optical Setup: Components > Multiple Surfaces > Light Guide

The Structure > Solid tab is explained in Sec. 57.2.1 and the Structure / Function > Surface Layouts tab in

Sec. 57.2.2.

The other tab pages are explained in Sec. 54.

57.2.1 Structure > Solid Tab

The Solid tab is divided into four sections (from top to bottom):

1. a 3D preview of the solid (↪→Sec. 5.15)

2. a table with the current surface media sequence

3. a panel with new surfaces which you can drag into the table

4. a button row .
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Figure 516. The Solid tab of the Light Guide component showing a sample sequence.

The buttons on this tab have the following functionality:

ITEM DESCRIPTION

Tools The tools are described below.

Add Adds a new surface PE from the catalog at the end of the table. The same can

be achieved by dragging the new surface into the table.

Insert Places a new surface from the catalog before the current surface (which is

marked by a triangle in the first table column).

Delete Deletes the selected surface(s).

The table has the following columns:
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ITEM DESCRIPTION

# The index of the current surface.

Note: This item is read-only.

Position Shows the absolute position of the surface and allows you to set the position

by clicking on the button, either in absolute coordinates or relative to the pre-

vious surface. The first surface always has its position fixed to the origin of

the internal coordinate system of the component.

Orientation Shows the absolute orientation of the surface and allows you to edit it by

clicking on the button, then a dialog with the control described in Sec. 5.6

opens.

Surface The type (or name in case of catalog surfaces) of the current surface. If the

mouse hovers above the selected row at that column, you can edit or view the

current surface PE or load a new one from the Surfaces Catalog (↪→Sec. 34.1).

Back Medium PE The homogeneous medium after the current surface. If the mouse hovers

above the selected row at that column, you can edit or view the medium of

the current surface or load a new one from the Media Catalog (↪→Sec. 34.1).

Important: The last medium is always identical to that of the transmission

type reference coordinate system (↪→Sec. 43.8.1). Changing that medium

will change the embedding medium between this component and the next

component (which is connected via the transmission type reference CS) too.

Comment You can enter a comment for a specific surface by clicking into the corre-

sponding comment cell.

You can select a single table row by clicking into it. By pressing Shift at the same time you can mark consec-

utive rows. With Del you can delete the selected surfaces.

The following Tools are available:

ITEM DESCRIPTION

Add Surface from Catalog Allows loading a surface with preset parameters from the surface catalog

(↪→Sec. 33).

Duplicate Selected Sur-

face(s)

The currectly selected surfaces are duplicated (including theirPosition,Orien-

tation, and Back Medium) and inserted after the originally selected surfaces.

Remove All Surfaces Removes all surfaces currently set in the table.

Synchronize DefinitionAr-

eas

The definition areas (size and shape) of all surfaces are set to the definition

area of the first surface.

57.2.2 Structure > Surface Layouts Tab

Every surface that has been specified on the Structure > Solid tab (↪→Sec. 57.2.1) contains a surface layout

which in turn may contain several grating regions. The Structure > Surface Layouts tab provides an overview

of all that surface layouts as well as editing access to the layouts and their regions.
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ITEM DESCRIPTION

Surface Name The name of the surface which has been specified on the Structure > Solid

tab.

Edit This button allows editing the layout of the currently selected surface. This

has to be done using the dialog described in Sec. 40.2.

Info Information about the number of regions contained by the layout of the cur-

rently selected surface.

57.3 Spherical Lens

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Components > Multiple Surfaces > Spherical Lens

Figure 517. The edit dialog of the Spherical Lens.
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ITEM DESCRIPTION

Diameter PV The (aperture) diameter of the lens.

Center Thickness PV The center thickness of the lens. If you enter a thickness less than the min-

imum thickness (defined by the Diameter and the radii), the thickness is set

to the minimum thickness.

First Surface You can set the type of the first surface (Plano, Convex, and Concave, re-

spectively). For a Convex or Concave surface you can set the absolute value

of the Radius PV of curvature.

Second Surface You can set the same parameters as for the First Surface.

Medium of Lens Mate-

rial PE
Set the homogeneous medium the lens consists of here. See also Sec. 34.1.

Coating PE You can define a coating (↪→Sec. 36) for the surfaces here. It is applied to the

outer side of both surfaces. ↪→Sec. 34.2.

Test Evaluation For your information, the Focal Length (in Air) for the specified Design Wave-

length is shown. You can choose whether the focal length is defined as Effec-

tive Focal Length feff, Back Focal Length fb, or Front Focal Length ff. They
are calculated with the formulas Eq. (57.1) to Eq. (57.3).

Please note: Regardless of the specific embedding medium for the lens as

well as the temperature and air pressure of the Optical Setup the lens may be

part of: the focal length is always calculated for a lens being in air at standard

conditions (20°C, 101’325Pa).

1
feff

= (n− 1)
[

1
R1
− 1

R2
+

(n− 1)d
nR1R2

]
(57.1)

fb = feff

(
1− (n− 1)d

nR1

)
(57.2)

ff = feff

(
1− (1− n)d

nR2

)
(57.3)

R1 and R2 are the radii of curvature of the first and second surface, respectively. n is the real refractive index

at the Design Wavelength. Eq. (57.1) is the lensmaker’s equation.

This component uses a validity indicator (↪→Sec. 5.10) to indicate if for example the lens is too thin for the

current radii of curvature. The edit dialog cannot be closed with OK in this case.

The other tab pages are explained in Sec. 54.

58 Single Surface & Coating Components

58.1 Curved Surface

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Components > Single Surface & Coating > Curved Surface
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Figure 518. The structure tab of a Curved Surface component.

ITEM DESCRIPTION

Surface Specification This control (↪→Sec. 34.1) allows you to set the optical surface PE this compo-

nent consists of.

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the surface.

The other tab pages are explained in Sec. 54.

58.2 Off-Axis Parabolic Mirror (Wedge Type)

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Components > Single Surface & Coating > Off-Axis Parabolic Mirror

(Wedge Type)

This component describes an off-axis parabolic mirror used for focusing. Its first surface is a cutout of a

paraboloid and its second surface is a plane.
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Figure 519. The Structure tab of the Off-Axis Parabolic Mirror (Wedge Type) component.

T

β

D

X

Y Z

Figure 520. The fundamental parameters of an Off-Axis Parabolic Mirror (Wedge Type) component.

Its edit dialog (↪→Fig. 519) has the following options on the Structure tab:

ITEM DESCRIPTION

Reflected Focal Length The focal length f of the component. Note that this is not the focal length f0

of the parent parabola, which is f0 = f cos2 β/2.

Off-Axis Angle The angle β between incoming and reflected light. ↪→Fig. 520

Overall Thickness The maximum extension T of the component in z-direction. ↪→Fig. 520

Diameter The diameter D of the circular aperture perpendicular to the z-axis of the

component. ↪→Fig. 520

Medium The homogeneous medium between the two surfaces. This control is de-

scribed in Sec. 34.1.

Coating If needed you can define a coating for the two surfaces. This control is de-

scribed in Sec. 34.2.
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The other controls are explained in Sec. 54.

58.3 Plane Surface

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Components > Single Surface & Coating > Plane Surface

Figure 521. The Structure tab of the edit dialog of the Plane Surface component.

The Plane Surface component is intended for the rigorous and fast analysis of the medium transition at a single

plane surface. The Structure tab of its edit dialog (↪→Fig. 522) provides the following settings.
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ITEM DESCRIPTION

Component Size PV In principle the Plane Surface component has an infinite lateral extension.

However, as this is not feasible for the 3D view (↪→Sec. 5.15) and the light

path finder for manual channel configuration (↪→Sec. 43.3.1), you can enter a

Component Size here.

Reference Surface Read-only control to show that the reference surface is a Plane Surface.

Aperture Read-only control to show that the reference surface has an infinite lateral

extension when simulated.

Coating PE This control allows you to set the coating which stores the plane layers.

↪→Sec. 34.2

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the plane surface this component consists of.

The other tab pages are explained in Sec. 54.

58.4 Stratified Media

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Components > Single Surface & Coating > Stratified Media

Figure 522. The Structure tab of the edit dialog of the Stratified Media component.

The Stratified Media component is intended for the rigorous and fast analysis of a sequence of plane layers each
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followed by a homogeneous (isotropic or anisotropic) medium. The Structure tab of its edit dialog (↪→Fig. 522)

provides the following settings.

ITEM DESCRIPTION

Component Size PV In principle the Stratified Media component has an infinite lateral extension.

However, as this is not feasible for the 3D view (↪→Sec. 5.15) and the light

path finder for manual channel configuration (↪→Sec. 43.3.1), you can enter a

Component Size here.

Reference Surface Read-only control to show that the reference surface is a Plane Surface.

Aperture Read-only control to show that the reference surface has an infinite lateral

extension when simulated.

Coating PE This control allows you to set the coating which stores the plane layers.

↪→Sec. 34.2

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the plane surface this component consists of.

The other tab pages are explained in Sec. 54.

59 Single Surface & Function Components

59.1 Functional Grating

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Components > Functional Single Surface > Functional Grating

The Functional Grating component analyzes an infinite periodic grating by directly defining the diffraction orders.
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Figure 523. The Structure tab of the Functional Grating component.

On the Structure tab of the edit dialog of this component (↪→Fig. 523) you can set the following.

ITEM DESCRIPTION

Component Size PV In principle the Grating Component has an infinite lateral extension. However,

as this is not feasible for the 3D view (↪→Sec. 5.15) and the light path finder

for manual channel configuration (↪→Sec. 43.3.1), you can enter aComponent

Size here.

Grating Here you define the periodicity of the grating (1D-Periodic (Lamellar) or 2D-

Periodic) and the Grating Period.

Homogeneous Medium

Behind Surface

For convenience you can set the homogeneousmedium PE behind the compo-

nent here which can also be done via the Optical Setup Editor (↪→Sec. 43.2.1).

This control is described in Sec. 34.1.

On the Function tab you can Edit which diffraction orders have which efficiency. This is done separately For

Illumination From Front Side and For Illumination From Back Side using the control described in in Sec. 5.12.

On the Channel Configuration > Grating Order Channels sub-tab you then can define which these orders are

considered for further simulation, separately For Illumination From Front Side and For Illumination From Back

Side.

The remaining controls and tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Functional Grating has a specific context menu entry to convert it

into a Grating (↪→Sec. 60.3).
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59.2 Functional Meta Lens

Availability

Optical Setups: General Optical Setup

(Only for General Profile or Ray Results Profile if Flat Lens Package is present.)

Accessible: Optical Setup: Components > Functional Single Surface > Functional Meta Lens

Figure 524. The Channel Operator sub-tab of a Functional Meta Lens.

A Functional Meta Lens consists of a single plane surface (↪→Sec. 35.2.7) on which a channel operator de-

scribing a focusing meta material is applied. The structure tab of its edit dialog (↪→Fig. 524) has three sub-tabs:

the Solid sub-tab (↪→Sec. 59.2.1), the Channel Operator sub-tab (↪→Sec. 59.2.2), and the Meta Material Model

sub-tab (↪→Sec. 59.2.3).

Furthermore, this tab has a button Import from ’Zemax OpticStudio®’ System to import a Binary 2 surface into

this component, ↪→Sec. 125.3.

The remaining controls and tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Functional Meta Lens has a specific context menu entry to convert

it into a Diffractive Lens (↪→Sec. 60.2).

59.2.1 Solid Sub-Tab

The Solid sub-tab of the Functional Meta Lens component has the following controls.
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ITEM DESCRIPTION

Surface Specification This control (↪→Sec. 34.1) allows you to edit the plane surface PE this compo-

nent consists of.

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the surface.

59.2.2 Channel Operator Sub-Tab

The channel operator adds the following phase φ (in radians) to the phase of the incident light:

φ = M ∑
i

Ai · ρ2i (59.1)

M is the index of the diffraction order, Ai the Coefficient
PV of the ith monomial, 2i is the Exponent, and ρ the

normalized radius (the distance from the optical axis divided by the Normalization Radius PV ).

The Degree of Polynomial sets the maximum exponent 2i.

59.2.3 Meta Material Model Sub-Tab

This sub-tab defines whether the Convergent Mode and / or Divergent Mode are simulated assuming an ideal-

ized meta material.

59.3 Functional Modulated Metasurface

Availability

Optical Setups: General Optical Setup

(Only for General Profile or Ray Results Profile if Flat Lens Package is present.)

Accessible: Optical Setup: Components > Functional Single Surface > Functional Modulated Meta-

surface
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Figure 525. The Channel Operator sub-tab of a Functional Modulated Metasurface.

A Functional Modulated Metasurface consists of a single plane surface (↪→Sec. 35.2.7) on which a pro-

grammable channel operator describing a metasurface hologram is applied. The structure tab of its edit dialog

(↪→Fig. 525) has three sub-tabs:

• the Solid sub-tab which is the same as for the Functional Meta Lens (↪→Sec. 59.2.1)

• the Channel Operator sub-tab (↪→Sec. 59.3.1) , and

• the Meta Material Model sub-tab (↪→Sec. 59.3.2) .

The remaining controls and tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Functional Modulated Metasurface has a specific context menu entry

to convert it into a Holographic Optical Element (↪→Sec. 60.4).

59.3.1 Channel Operator Sub-Tab

You can program both the effect on the wavefront and the gradient of the wavefront using the corresponding

Edit button which opens the Source Code Editor (↪→Sec. 7.3). A validity indicator (↪→Sec. 5.10) shows whether

this snippet is consistent.

59.3.2 Meta Material Model Sub-Tab

This sub-tab defines whether theDesign Mode and / or itsConjugate Mode are simulated assuming an idealized

meta material.

60 Single Surface & Stack Components
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60.1 Diffractive Optical Element (DOE) / Microstructure

Availability

Optical Setups: General Optical Setup (Only for General Profile and Ray Results Profile.)

Accessible: Optical Setup: Components > Single Surface & Stack > Diffractive Optical Element (DOE)

/ Microstructure

This component is listed under two names (Diffractive Optical Element (DOE) and Microstructure) for conve-

nience.

Figure 526. The Channel Operator sub-tab of a Microstructure.

Such a component consists of a single plane surface (↪→Sec. 35.2.7) on which a channel operator describing

a microstructure is applied. The structure tab of its edit dialog (↪→Fig. 526) has two sub-tabs:

• the Solid sub-tab (↪→Sec. 60.1.1)

• the Channel Operator sub-tab (↪→Sec. 60.1.2) .

The remaining controls and tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Microstructure has specific context menu entries to convert it into

other component types (↪→Sec. 55).

60.1.1 Solid Sub-Tab

The Solid sub-tab of the Microstructure Component has the following controls.



CHAPTER 60. SINGLE SURFACE & STACK COMPONENTS 619

ITEM DESCRIPTION

Surface Specification This control (↪→Sec. 34.1) allows you to edit the plane surface PE this compo-

nent consists of.

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the surface.

60.1.2 Channel Operator Sub-Tab

The microstructure can be defined as ideal structure (Complex Surface Response) or as real structure (Stack).

If defined as transmission, you can use the following controls:

ITEM DESCRIPTION

Set Sets the desired Jones Matrix Transmission. When you click on this button

you can do the following:

• Load a Jones Matrix Transmission from a .ca2 file.

• Select from Documents allows you to select an already open Jones

Matrix Transmission.

• Reset the data to the default transmission.

Show Shows the Complex Amplitude document containing the currently set trans-

mission.

Interpolation Method You can decide whether a Continuous or a Pixelated interpolation is used to

interpolate the given data.

If defined as stack, you can use the following controls:

ITEM DESCRIPTION

Stack PE Configures a stack with one or more micro-structured surfaces and displays

its name. You can Load another stack from the catalog (↪→Sec. 33). Further-

more, you can Edit the current stack (↪→Sec. 39.2) or View it.

OnFront Side of Base Sur-

face

If checked it is assumed that the stack is placed on the front side of the base

surface. This means that in comparison to its normal orientation it is rotated

by 180° about the y-axis and thus points against the optical axis. Sec. 39.1.2

shows an example.

On Back Side of Base Sur-

face

If checked it is assumed that the stack is placed on the back side of the base

surface. This means that it is used in its normal orientation.

Method for Stack Analysis The propagation method used for the stack analysis. In contrast to Thin Ele-

ment Approximation, the Advanced Thin Element Approximation additionally

can handle parabasal effects and absorption.

Accuracy Factor PV The accuracy factor used for the propagation through the stack, separately

for x- and y-direction.

Sampling Distance PV Instead of theAccuracy Factor you can also specify directly the used sampling

distance for x- and y-direction.
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60.2 Diffractive Lens

Availability

Optical Setups: General Optical Setup

(Only for General Profile or Ray Results Profile if Flat Lens Package is present.)

Accessible: Optical Setup: Components > Single Surface & Stack > Diffractive Lens

Figure 527. The Solid sub-tab of a Diffractive Lens.

A Diffractive Lens consists of a single plane surface (↪→Sec. 35.2.7) on which a channel operator describing

a diffractive focusing structure is applied. The structure tab of its edit dialog (↪→Fig. 527) has three sub-tabs:

the Solid sub-tab (↪→Sec. 60.2.1), the Channel Operator sub-tab (↪→Sec. 60.2.2), and the Diffractive Structure

Model sub-tab (↪→Sec. 60.2.3).

Furthermore, this tab has a button Import from ’Zemax OpticStudio®’ System to import a Binary 2 surface into

this component, ↪→Sec. 125.3.

The other tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Diffractive Lens has a specific context menu entry to convert it

into a Functional Meta Lens (↪→Sec. 59.2). A Diffractive Lens in Real Structure mode (↪→Sec. 60.2.4.1) can

additionally be converted into a Microstructure (↪→Sec. 60.1).

60.2.1 Solid Sub-Tab

The Solid sub-tab of the Diffractive Lens component (↪→Fig. 527) has the following controls.
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ITEM DESCRIPTION

Surface Specification This control (↪→Sec. 34.1) allows you to change the surface PE this component

consists of.

Homogeneous Medium

Behind Surface

This control (↪→Sec. 34.1) allows you to configure the homogeneous

medium PE behind the surface.

60.2.2 Channel Operator Sub-Tab

The channel operator adds the following phase φ (in radians) to the phase of the incident light:

φ = M ∑
i

Ai · ρ2i (60.1)

M is the index of the diffraction order, Ai the Coefficient
PV of the ith monomial, 2i is the Exponent, and ρ the

normalized radius (the distance from the optical axis divided by the Normalization Radius PV ).

The Degree of Polynomial sets the maximum exponent 2i.

60.2.3 Diffractive Structure Model Sub-Tab

Figure 528. The Diffractive Structure Model sub-tab of a Diffractive Lens if a Real Structure is assumed.

Whereas the Channel Operator sub-tab defines the phase and thus the direction of the single diffraction orders,

the Diffractive Structure Model (↪→Fig. 528) defines the efficiencies of the diffraction orders. This can be done

assuming either an Idealized Grating Structure (↪→Sec. 60.2.4) or a Real Structure (↪→Sec. 60.2.4.1).
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60.2.4 Efficiencies from Idealized Grating Structure

In case of an Idealized Grating Structure you simply define the Efficiency PV perOrder in a table. The table rows

are sorted automatically by the Order number. With buttons you can add a new order to the end of the table or

remove the currently selected order from the table.

60.2.4.1 Efficiencies from Real Structure

A Real Structure can be defined with the following controls (↪→Fig. 528):

ITEM DESCRIPTION

Design Wavelength PV The (vacuum) wavelength used for the translation from the wavefront defined

on the Channel Operator tab to a height profile.

Height Scaling Factor PV Allows you to alter the modulation depth of the overall structure to change the

efficiencies of the distinct orders.

Use Profile Quantization If you check this option the diffractive structure is quantized according to the

Number of Height Levels.

Export Structure O U P Q .

Allows you to export the diffractive structure into various file formats using the

dialog described in Sec. 127.2.

Orders for Simulation Allows you to define which of the diffractive orders is used for simulation. All

other orders are suppressed to improve simulation performance and to get

clearer results.

The structure is then analyzed by means of the Thin Element Approximation (↪→Sec. 96.2) if the local grating

period is larger than 5 times the wavelength. Otherwise the Fourier Modal Method (↪→Sec. 96.3) is used.

60.3 Grating

Availability

Optical Setups: General Optical Setup

(Only for General Profile or Ray Results Profile if VirtualLab Fusion Advanced is present.)

Accessible: Optical Setup: Components > Single Surface & Stack > Grating

The Grating component analyzes an infinite periodic grating rigorously by means of the FMM / RCWA solver

(↪→Sec. 96.3).
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Figure 529. The Structure tab of the Grating component.

On the Structure tab of its edit dialog (↪→Fig. 529) you can set the following.

ITEM DESCRIPTION

Component Size PV In principle the Grating Component has an infinite lateral extension. However,

as this is not feasible for the 3D view (↪→Sec. 5.15) and the light path finder

for manual channel configuration (↪→Sec. 43.3.1), you can enter aComponent

Size here.

Grating Stack Here you first define the periodicity of the grating (1D-Periodic (Lamellar) or

2D-Periodic), then the optical stack (↪→Sec. 39) describing the grating. To this

end the control described in Sec. 34.1 is used.

Additionally you can define the orientation of the grating stack, i. e. whether it

is placed On Front Side of Reference Surface or On Back Side of Reference

Surface.

Homogeneous Medium

Behind Surface

For convenience you can set the homogeneousmedium PE behind the compo-

nent here which can also be done via the Optical Setup Editor (↪→Sec. 43.2.1).

This control is described in Sec. 34.1.

On the Channel Configuration > Grating Order Channels sub-tab you can define which orders are considered

for further simulation, separately For Illumination From Front Side and For Illumination From Back Side.

The efficiencies of the simulated orders are calculated by the FMM / RCWA solver PE (↪→Sec. 96.3). You can

Edit it on the Solver tab. On the Solver > Sampling sub-tab you can set the Number of Sampling Points for

Look-Up Table, which means for how many incident directions efficiencies are calculated rigorously.
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The other tab pages are explained in Sec. 54. In the Optical Setup View (↪→Sec. 43.1), a Grating has specific

context menu entries to convert it into other component types (↪→Sec. 55).

Note that for simulations the thickness of the stack is ignored, a phase term eikz with z being the thickness
of the stack is not applied.

60.4 Holographic Optical Element

Availability

Optical Setups: General Optical Setup

(Only for General Profile or Ray Results Profile if Flat Lens Package is present.)

Accessible: Optical Setup: Components > Single Surface & Stack > Holographic Optical Element

Figure 530. The Channel Operator sub-tab of a Holographic Optical Element.

A Holographic Optical Element consists of a single plane surface (↪→Sec. 35.2.7) on which a programmable

channel operator describing a hologram is applied. The structure tab of its edit dialog (↪→Fig. 530) has three

sub-tabs:

• the Solid sub-tab which is the same as for the Diffractive Lens (↪→Sec. 60.2.1),

• the Channel Operator sub-tab (↪→Sec. 60.4.1), and

• the Diffractive Structure Model sub-tab which is the same as for the Diffractive Lens (↪→Sec. 60.2.3) .

The other tab pages are explained in Sec. 54.

In the Optical Setup View (↪→Sec. 43.1), a Holographic Optical Element has a specific context menu entry to

convert it into a Functional Modulated Metasurface (↪→Sec. 59.3).
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60.4.1 Channel Operator Sub-Tab

You can program both the effect on the wavefront and the gradient of the wavefront using the corresponding

Edit button which opens the Source Code Editor (↪→Sec. 7.3). A validity indicator (↪→Sec. 5.10) shows whether

this snippet is consistent.

60.5 Microlens Array

The Microlens Array component supports the specification of a microlens array using a reference surface and

a stack. The stack is used to define the structure per period. In addition to the configuration for the structure,

the component comes with an advanced channel handling. It supports a lateral channel decomposition, which

means per illuminated microlens, a channel mode is generated, which is propagated through the subsequent

system. The user can specify some additional options, which are also described within this chapter.

Figure 531. The Solid page of the edit dialog of the Microlens Array component.

Fig. 531 shows the solid page (on the structure slider) of the Microlens Array component. The following param-

eters can be specified by the user:
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ITEM DESCRIPTION

Component Surface The microlens array structure is defined on a reference surface. Currently

only plane reference surfaces are supported. This control is currently read-

only.

Domain: Size and Shape The user can specify the size of the domain / reference surface. The user can

select between rectangular and elliptical shape.

Medium behind Surface The medium specification after the surface /microlens array can be config-

ured in this section of the dialog.

Effect on Field Outside of

Domain

If light hits the component and is larger than the size of the domain of the

component, it needs to be decided how the field outside is handled. In general

blocking or passing is supported. In the current version of VirtualLab Fusion

only blocking aperture is supported.

Next to the specification of the reference surface (and its domain) the user can define the surface add-ons on

the corresponding tab page.

Figure 532. The Surface Add-On page of the edit dialog of the Microlens Array component.

Fig. 532 shows the location, where the user can specify the surface add-on. In this case we support the

specification of a stack. The period of the stack is used to define the period of the microlens array. The stack

should only contain one surface (at least in current implementation). It is recommended that the stack period

and the period of the surface in the stack are defined synchronously.

In addition to the structure definition, the component supports an advanced channel configuration.

On the Channel Configuration page the following sub-pages are available:
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PAGE DESCRIPTION

Master Channels On this page the user can specify the master channels that shall be used for

field tracing (surface channels for +/+, +/-, -/+, and -/-).

Sub-Channels: x-Domain Here the user can define the handling for the sub-channels in x-domain.

Sub-Channels: k-Domain Here the user can define the handling for the sub-channels in k-domain.

Region Boundary Man-

agement

For the channels (master and sub-channels) the user can specify aperture

settings in this section of the dialog.

Channel Mode Manage-

ment

If the channel decomposition is activated there are several channel mode

selection options, which can be selected/configured on this page.

Figure 533. The Master Channel page of the edit dialog of the Microlens Array component.

Fig. 533 shows the table to configure the master/surface channels of the Microlens Array component. The

configuration is the same as for all other components in VirtualLab Fusion. For the surface (here only one) the

plus-plus, plus-minus, minus-minus and minus-plus channel can be opened or closed. This information will be

evaluated by the light path finder. In case of pre-configured channel configuration the table is read-only and

filled automatically from the system configuration.
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Figure 534. The Sub-Channel: X-Domain page of the edit dialog of the Microlens Array component.

Fig. 534 shows the tab page for the configuration of the sub-channels in x-domain.

The following options can be selected from the user:

PAGE DESCRIPTION

None If None mode is selected no channel decomposition will be performed.

VirtualLab Fusion has a build-in channel decomposition, which is applied if

a pointwise sequence is terminated and the mesh of the input field is non-

bijective.

Structure-Related In case of Structure-Related channel decomposition, the information of the

sub-channels is extracted from the structure (in case of the microlens array

the periodic rectangular cells of the stack on the size of the surface domain).

If this option is selected a well-defined index logic (in form of a slug) is used

to enumerate the channels. On the bottom of the page a schematic scheme

is displayed to visualize the index logic of the channels.

Channel Mask Data The user can also specify the channel mask for decomposition as a set of

masks (regions). In this case the region information is used for the channel

decomposition. This option is not available in current implementation.

Programmable Alternatively the user can implement the channel mask using the VirtualLab

Fusion snippet technology. This option is not available in current implemen-

tation.

On the Sub-Channels: k-Domain page there are several options for the channel decomposition in k-domain.
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This is not available for the Microlens Array and all options are disabled. This is a preparation for further

components that perform a channel decomposition in k-domain (and x-domain).

On the Region Boundary Management page there are several numerical parameters available to define the

aperture handling of the master and the subchannel.

Figure 535. The Region Boundary Management page of the edit dialog of the Microlens Array component.

Fig. 535 shows the tab page for the configuration region boundary/aperture settings of the Microlens Array

component. The tab page is divided into two parts:

REGION DESCRIPTION

Master Region & Compo-

nent

In this section the user can specify the parameters for the soft edge for the

master region. The size of the master region is defined on the Solid page of

the component. The user can define the location of the edge. The edge can

be configure as Inner Soft, Outer Soft or Shared Soft edge. In addition the

user needs to specify the size of the edge. This configuration can be done by

specification of Relative or Absolute edge width.

Sub-Channel Regions In this section the user can specify the parameters for the soft edge for the

sub-regions (x-domain). The size of the sub-regions is implicitly defined by

the period of the stack (for Structure-Related channel definition). The user

can define the location of the edge. The edge can be configure as Inner Soft,

Outer Soft or Shared Soft edge. In addition the user needs to specify the size

of the edge. This configuration can be done by specification of Relative or

Absolute edge width.

On the last page of the Channel Configurationmain section of the edit dialog of the Microlens Array component

the user has the option to specify the way how the evaluated channels are handled.
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Figure 536. The Channel Mode Management page of the edit dialog of the Microlens Array component.

For the channel mode management the following options are currently available:

REGION DESCRIPTION

All Channel Modes If this option is selected, all channels, that are illuminated by the incident light

will be processed as output modes. This might be the most consistent speci-

fication, but can be lead also to high numerical effort, because depending on

the size of the incident light and the size of the channels a high number of

channels might be generated.

Selected Channel Mode In addition we also support the processing of one selected channel mode

only. The channel mode that should be processed is selected by index of the

channel. The index logic for Structure-Related channel definition is visualized

(schematic) on the Sub-Channels: x-Domain tab page.

For the channel mode management more options will be added in future.

61 Programmable Component

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Components > Programmable Component

This component allows the user to define an own propagation through a user defined component, more precisely
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to manipulate the incoming field in an arbitrary way. This can be done by programming so called snippets, which

is some source code to be written by the user in C#.

Furthermore, there is complete freedom for positioning a Programmable Component, i. e. the reference coor-

dinate systems (↪→Sec. 43.8) as well as the input transface (↪→Sec. 93.1) can be defined by the user.

61.1 Geometry of a Programmable Component

The geometry of a Programmable Component has to be defined by the user, so its definition is completely

different from that of other real components. Every building block like optical surfaces, media and so on has to

be defined as so called Global Parameter inside the source code editor. Even though there are three different

kinds of snippets (described below in Sec. 61.2), each global parameter will be accessible from within each

of the snippets, no matter where it has been defined first. For more information regarding the general use of

snippets and the source code editor, please see Sec. 7.3.

Figure 537. Example for the bounding box of a prism.

Since the geometry is defined by the user, there is no preview available for this kind of component. But it

may be useful, mainly for the positioning (↪→Sec. 61.3), to define a bounding box which is a cuboid meant to

circumscribe the whole component (↪→Fig. 537). It can be defined in the panel Bounding Box on page Structure

of the edit dialog of the Programmable Component (↪→Fig. 538).
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Figure 538. The input controls for the bounding box of a Programmable Component.

ITEM DESCRIPTION

Width in X Width of the bounding box.

Height in Y Height of the bounding box.

Thickness in Z Thickness of the bounding box, may be zero.

Note

TheBounding Boxwill have no effect for the propagation through the component or for any of its function-

ality. It serves two helpful purposes only. If the box is defined adequately, it allows to get an impression

of the components dimensions inside the 3D view of the complete Optical Setup (↪→Fig. 539). And it

provides the positions of the two default reference points (↪→Sec. 61.3): one is situated in the center of

the front side of the bounding box and one in the center of the box’s back side.
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Figure 539. Example for viewing the bounding box of a Programmable Component in the system’s 3D view.

61.2 Propagating through a Programmable Component

Figure 540. The controls for defining the propagation through a Programmable Component.

Defining the propagation through a Programmable Component requires the following controls which can be

found on the tab page Structure > Component Specification (↪→Fig. 540).
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ITEM DESCRIPTION

Relative Position of Field

to Position of Input Trans-

face

The field reaching the Programmable Component is always rotated into the

Input Transface plane. But if the option Resolve via Zero Padding is checked,

equidistant field data will be also padded into zeros in a way that the new ori-

gin of the field’s coordinate system will be identical to that of the input trans-

face. If the option Keep Stored in the Field’s Coordinate System is chosen,

no additional preparation will be done.

Snippet for Equidistant

Field Data

The snippet defining the effect of the Programmable Component on the input

field if equidistant field data enters the component. This always happens if the

system is analyzed with Classic Field Tracing. Edit opens the Source Code

Editor (↪→Sec. 7.3), and a validity indicator (↪→Sec. 5.10) shows whether this

snippet is consistent.

↪→Sec. 61.2.1

Snippet for Non-

Equidistant Field and

Ray Data

The snippet defining the effect of the Programmable Component on the input

field if non-equidistant data enters the detector. This always happens if the

system is analyzed with General Profile or Ray Results Profile. Edit opens

the Source Code Editor (↪→Sec. 7.3), and a validity indicator (↪→Sec. 5.10)

shows whether this snippet is consistent.

↪→Sec. 61.2.2

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippets.

↪→Sec. 7.4

Programmable Components might be set to a mode where the source code cannot be changed and

thus the Input Field Preparation and the Algorithms groupboxes are hidden.

More general information about programming in VirtualLab Fusion can be found in Sec. 7.

61.2.1 Snippet for Equidistant Field Data

Here, the effect of the Programmable Component on the InputField has to be programmed. This field is rep-
resented by a HarmonicFieldsSet inside the snippet. This kind of object may contain several single harmonic
fields which can e. g. represent field data for different wavelengths. They are accessible via InputField[0],
InputField[1], and so on.
The code in this snippet may contain any manipulation of the field. Especially, it has to describe the propaga-

tion of the field from the Input Transface of the Programmable Component to its Output Transface, including

free space propagations and rotations as well as every effect caused by the building blocks of the element’s

geometry like surfaces and media. Input and Output Transface are the “transfer interfaces” where the field is

taken from the free space propagation operator before and given to the free space propagation operator behind

the element, respectively. For more information about this concept have a look at Sec. 93.1.

61.2.2 Snippet for Non-Equidistant Field and Ray Data

Within the Optical Setup the Programmable Component has no well defined geometry because it is fixed within

the source code. So the user has the possibility to implement how an InputRay is manipulated by the pro-

grammable component.

The user can specify the following parameters for each ray:

• Position
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• Direction

• Optical Path Length / Absolute Phase

• Absorption

• Wavefront Surface Response

• Field Scaling Values

• Complex Surface Response

• Coherent Index

This snippet is used if the system is evaluated with either the General Profile or the Ray Results Profile engine.

It is also used for the evaluation of optical path lengths of a system within pulse simulations.

The default implementation of this snippet defines that there is no effect on the incident ray. The user can define

any method to modify the parameters of the ray but he is responsible that the implementation of the Snippet for

Equidistant Field Data and the Snippet for Non-Equidistant Field and Ray Data provide the correct functionality.

61.3 Positioning a Programmable Component

As every other component, a programmable one is positioned via reference coordinate systems, defining rela-

tive positions and orientations. For more information about these concepts see Sec. 43.8. Here, the definition

of user defined reference points and reference coordinate systems, available only for the Programmable Com-

ponent, is described.

61.3.1 User-Defined Reference Points

There are always two predefined Reference Points for every Programmable Components which can neither be

changed nor removed. These Reference Points lie in the center of the front and the back side of the Bounding

Box. So every reference coordinate system can be located in one of these two points. By default, the front

center is used for the referring “Input” coordinate system and the back center is used for the transmission type

reference coordinate system (see Sec. 61.3.2 below).

If more reference points are needed, they can be added on the page Coordinate Systems of the Programmable

Component’s edit dialog. In the panel Reference Points a list of all defined Reference Points as well as an Edit

button can be found (↪→Fig. 541).
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Figure 541. The overview for the Reference Points of a Programmable Component.

The Edit button will open the dialog for defining new Reference Points shown in Fig. 542.

Figure 542. The edit dialog for user defined Reference Points of a Programmable Component.

The following options are available in this dialog:

ITEM DESCRIPTION

Remove Removes the selected user defined Reference Point.

Add Adds a new user defined Reference Point.

Description The unique name of the Reference Point.

X/Y/Z The x/y/z-coordinate of the Reference Point (referring to the component’s In-

ternal Coordinate System).
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61.3.2 User-Defined Reference Coordinate Systems

In order to have maximum freedom in positioning an Optical Setup Element, reference coordinate systems

are used. For a Programmable Component, they can be added, changed and removed on the page Coordi-

nate Systems of the Programmable Component’s edit dialog, inside the panel Reference Coordinate Systems

(↪→Fig. 543).

Figure 543. The edit dialog for the Reference Coordinate Systems of a Programmable Component.

The following options are available in this panel:

ITEM DESCRIPTION

Add Adds a new user defined reference coordinate systems.

Remove Removes the selected reference coordinate systems. Can be used only if

the reference CS is not already in use for positioning of subsequent Optical

Setup Elements. Furthermore, removing is not possible for the referring “In-

put” coordinate systems and the last reference coordinate system besides

“Input”.

Name The unique name of the reference coordinate systems. Can be changed only

if it is not already in use for positioning of subsequent Optical Setup Elements.

The name of the referring “Input” coordinate system cannot be changed as

well.

Reference Point TheReference Point for defining the origin of the reference coordinate system

can be selected here. Please see also Sec. 61.3.1 and Sec. 43.8.

Axes Pushing the button opens a new dialog (see Fig. 544 and description below)

for setting the base vectors of the reference coordinate system. The axes

have to form a right handed Cartesian coordinate system.

The axes of an reference coordinate system are to be defined using the dialog shown in Fig. 544.

Figure 544. Dialog for the definition of the axes of reference coordinate systems.

The options in this dialog are:
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ITEM DESCRIPTION

X/Y/Z Axis The x/y/z-axis of the reference coordinate system to be edited. All axes have

to form a right-handed Cartesian coordinate system and are to be defined

relative to the Internal Coordinate System of the Programmable Component.

Validity This control (↪→Sec. 5.10) indicates whether or not the entered axes are valid.

62 Subsystem

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Components > Subsystem

The Subsystem component can be configured to use a complete Optical Setup within an Optical Setup Element.

The subsystem has to fulfill some restrictions to be used within the Subsystem Component.

Fig. 545 shows the edit dialog of the Subsystem Component.

Figure 545. The edit dialog of the Subsystem component. Within this example no subsystem is configured yet.

The following settings are available:
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ITEM DESCRIPTION

Set The Set button can be used to set a subsystem into the Subsystem com-

ponent. The system has to fulfill several requirements which are explained

below. After clicking the Set button and selecting the subsystem to set the

requirements are checked and the Optical Setup is set into the Subsystem

component.

Remove By clicking on the Remove button the underlying system is removed.

Show By clicking on the Show button the underlying system is displayed as

VirtualLab Fusion document.

The following rules have to be fulfilled in order to set up a consistent subsystem into the Subsystem component:

1. There must be an active light source.

2. The system has to be configured consistently.

3. Only one detector which defines the output of the subsystem.

4. There has to be a unique path to the output detector.

All parameters of the Optical Setup Elements within the subsystem are available for Parameter Extraction

(↪→Sec. 43.5).

With Pre-Selected Channel Configuration (↪→Sec. 43.3.1) all surfaces of a component but the first one

have only one transmission channel open. As this affects also the subsystem component, subsystems

with reflection work properly only with Manual Channel Configuration for General Profile and Ray Results

Profile.

63 Light Shaper

Availability

Optical Setups: Light Shaping Optical Setup

Accessible: Optical Setup: Components > Multiple Surfaces > Diffractive Light Shaper / Refractive

Light Shaper



CHAPTER 63. LIGHT SHAPER 640

Figure 546. The structure tab of the edit dialog for a diffractive light shaper.

A light shaper consists of two plane surfaces on which one boundary operator can be placed. This opera-

tor can be either a Grating Cells Array (↪→Sec. 40.1.1) for a Diffractive Light Shaper or a Prism Cells Array

(↪→Sec. 40.1.2) for a Refractive Light Shaper.

The homogeneous region between this two surfaces is referred to as base block. Therefor the user has to

specify the homogeneous Base Block Medium and the Thickness of Base Block. Geometrical Optics is used

to propagate through the component.

The Structure tab of the component has the following controls.

ITEM DESCRIPTION

Base Block Medium PE The homogeneous medium between the two surfaces. This control is de-

scribed in Sec. 34.1.

Thickness PV The thickness of the base block, i. e. the distance between the two plane

surfaces along the z-direction.

Use Operator on First Sur-

face /

Use Operator on Second

Surface

A Light Shaping Optical Setup allows the usage of diffractive, refractive and

reflective cells array (↪→Sec. 40.1) either on the first surface (pointing towards

the light source) or on the second surface. The type of cell array which shall

be used is selected by clicking on the corresponding menu item in the main

menu. The currently active cells array can be edited with the corresponding

Edit button.

The other tab pages are explained in Sec. 54.
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64 General Grating Component in a Grating Optical Setup

Figure 547. The edit dialog for a General Grating component.

This grating component consists of a base block on whose boundaries optical stacks PV (↪→Sec. 39) can be

placed. The base block is a homogeneous region. Therefor the user has to specify the homogeneous Base

Block Medium and the Thickness of Base Block. The stacks can be an arbitrary combination of surfaces and

media.

On the bottom of the edit dialog (↪→Fig. 547) you can set up the PreviewWavelength. If you open the edit dialog

it is set to the wavelength of the active light source, but you can alter it to any wavelength for which the materials

used in the component provide refractive index data. The preview wavelength is used for the calculation of the

refractive indices

• in the stack preview which can be accessed via the corresponding View buttons in the Structure > Solid

tab.

• in the stack edit dialog which can be accessed via the corresponding Edit buttons in the Structure > Solid

tab.

• in the diffraction order calculation and the transition point preview of the FMM edit dialog (↪→Sec. 96.3.1).

64.1 Structure Tab

There are the following controls on the Structure tab (↪→Fig. 547):
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ITEM DESCRIPTION

1D-Periodic (Lamellar) /

2D-Periodic

Defines the periodicity of the grating. Depending on this setting, several con-

trols in the edit dialog of stacks (↪→Sec. 39.2) and of the FMM (↪→Sec. 96.3.1)

change.

Base Block Medium PE Allows to view and change the homogeneous medium of the base block.

These controls are described in Sec. 34.1.

Thickness of Base

Block PV

Allows to set the thickness of the base block. Can be also set to zero if the

effects of the base block shall be ignored.

Use Stack on First Sur-

face /

Use Stack on Second Sur-

face

Allows you to switch on / off the stack on the front and the rear side of the

base block, respectively. If switched off, the stack is not used for the grating

analysis but still stored in the component. If you switch it back on, the same

stack is available again and can be viewed and changed with the controls

described in Sec. 34.1. Both stacks can be used at the same time.

No rotation about z-axis /

Rotation about z-axis by

180°

If a stack is placed on the front side of the base block, it is rotated by 180°

about the y-axis – compared to placement on the rear side and the view dis-

played in the stack edit dialog (↪→Sec. 39.2). With Rotation about z-axis by

180° you can apply an additional rotation about the z-axis. Sec. 39.1.2 dis-

cusses that in more detail with explanatory figures.

Tools This button reveals two tools which ease the set-up of a grating component.

Tools > Swap Stacks This tool swaps the stacks so that the first stack becomes the second stack

and vice versa.

Tools > Reduce Compo-

nent to First Stack

This tool is a short cut for the following steps:

1. Disable the second stack.

2. Set the thickness of the base block to zero.

3. Change the medium of the transmission type reference coordinate sys-

tem to equal the Base Block Medium.

This tool is only enabled if the thickness of the first stack is larger than zero,

as otherwise this tool would make the component inconsistent.

The overall thickness of the grating component (= thickness of first stack + thickness of base block + thickness

of second stack) must not be zero. Otherwise the validity indicator in the bottom left corner (↪→Sec. 5.10) shows

a white-red cross.

On the bottom of this page the Common Period of both stacks is shown for your information. This period

influences the computational effort of the FMM.

Calculation of the Common Period

If both stacks are used:

1. Both stack periods are rounded to a multiple of 1 pm to deal with possible numerical errors.

2. The least common multiple of this rounded periods is taken as common period.

64.2 Propagation Tab

Grating components can be analyzed by means of the Fourier Modal Method (FMM; ↪→Sec. 96.3). With its edit

dialog the number of diffraction orders and the structure decomposition can be set.

You can also use a special version of the Thin Element Approximation operator (↪→Sec. 96.2) which ensures

that exactly one period is analyzed with sufficient resolution.
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65 Double Surface Component

Availability

Optical Setups: Laser Resonator Optical Setup

Accessible: Optical Setup: High Reflective (Start) Mirrors > Outer Surface of Double Surface Compo-

nent; Laser Crystal

Figure 548. The Structure tab of the Double Surface Component.

This component consists of two surfaces with a medium in between. The structure tab of its edit dialog

(↪→Fig. 548) has the following controls.
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ITEM DESCRIPTION

Center Thickness PV The distance of the two surfaces measured on the optical axis.

Individual Apertures for

Each Surface

If you select this option the apertures of the surfaces are set via theEdit button

of the First Surface and Second Surface, respectively.

Uniform Aperture for

Whole Component

If you check this radio button, the same aperture is taken for both surfaces.

The common aperture is then set via the Shape and Diameter controls below

the radio button. If you double-click on one of the Diameter text boxes, the

value from the other text box is being overtaken.

First Surface PE Configures the first surface and displays its name. You can Load a new sur-

face from the catalog (↪→Sec. 33), Edit the current surface or View it with the

three-dimensional view described in Sec. 35.3.

Second Surface PE Configures the second surface and displays its name. You can Load a new

surface from the catalog (↪→Sec. 33), Edit the current surface or View it with

the three-dimensional view described in Sec. 35.3.

Medium Between Sur-

faces PE

Configures the medium between the two surfaces and displays its name. You

can Load a predefined medium from the catalog (↪→Sec. 33), Edit the current

medium (↪→Sec. 37.3.1) or View it with the view described in Sec. 37.2.

The other tab pages are explained in Sec. 54.



X Ideal Components
and Functions
In contrast to Real Components consisting of surfaces and media there

are also Ideal Components. This name doesn’t mean that these ele-

ments work without any numerical error or physical approximation but

rather that they are idealized by some means.

Sec. 66 describes the controls that all Ideal Components have in com-

mon.

The functionality of Transmission Functions (↪→Sec. 67) is completely

defined by a single mathematical operator T (x, y) which is multiplied

with the incoming field. These functions can also be used in the main

window via the Functions ribbon tab to generate Jones Matrix Trans-

mission documents which can then be manipulated or multiplied with

harmonic fields.

The remaining Ideal Components are explained in Sec. 68 to Sec. 73.
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66 Edit Dialog of Ideal Components

Figure 549. Example for the edit dialog for Ideal Components.

The edit dialogs for all Ideal Components (↪→Fig. 508) are divided into several pages:

• Coordinate Systems ↪→Sec. 43.8.1

• Position / Orientation ↪→Sec. 43.8.2

• Function: This page is specific for the distinct ideal components and is thus explained in the following

chapters. But it may contain a Basic Parameters tab as described in Sec. 66.1.

• Channel Configuration ↪→Sec. 43.9

• Fourier Transforms ↪→Sec. 43.4.2

66.1 Basic Parameters

In the upper part of this tab page you can select one out of three Construction Methods, which are explained

in the table below. Depending on the construction method, the tab page looks like shown in Fig. 550 or like in

Fig. 551.
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Figure 550. Tab page for setting the Basic Parameters of a transmission function with the construction method Single

Function with Aperture.

Figure 551. Tab page for setting the Basic Parameters of a transmission function with the construction method Periodic

Function.

CONSTRUCTION

METHOD

DESCRIPTION

Single Function without

Aperture

O O S . N A

Z F / S A .

There are no specific controls for this construction method.

Single Function with

Aperture

The aperture is applied by multiplying the actual transmission value t by 1
inside and by 0 outside the specified aperture. The edge of the aperture

can be defined smooth, then the values don’t “jump” from 1 to 0 but follow a

Gaussian function (decreasing to a value of 0.01) as shown in Fig. 552.

The controls to setup the aperture are explained in a separate table below.

In case of an Aperture transmission function, this option is named just Single

Function.

Periodic Function N Z F / S A .

In this case you can set the Period PV of the function.
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Figure 552. Definition of the edge width of an aperture.

The following controls (↪→Fig. 550) are specific for the Single Function with Aperture construction method:

ITEM DESCRIPTION

Automatic Setting If checked, a reasonable size of the aperture for the transmission function is

determined automatically. This option is available for some functions only,

e. g. exponentially decreasing ones.

Manual Setting If checked, the aperture size has to be entered by the user.

Shape The aperture may be Rectangularly or Elliptically shaped.

Diameter PV Size of the aperture.

Relative Edge Width PV The width of the aperture edge, defined relatively to the (smaller of the both

values of) diameter.

Absolute Edge Width PV The width of the aperture edge, defined in physical units. ↪→Fig. 310.

For an Aperture transmission, a separate aperture cannot be set on the Basic Parameters tab. For a Zernike

Fringe / Seidel Aberrations transmission, only circular apertures are allowed.

The following controls (↪→Fig. 551) are specific for the Single Function with Aperture construction method:

ITEM DESCRIPTION

Period PV If Periodic Function was chosen as Construction Method, here the length of

the period for the replication is set. The first value is used for replication in

x-direction, the second one for the y-direction.

Specific for grating transmissions: For gratings, the Period will be deter-

mined automatically from the Grating Period and the Rotation Angle, both to

be specified at the Physical Parameters panel.

67 Transmission Functions

Generally, the change of amplitude, phase, and polarization of an electromagnetic field can be described by an

operator T named Transmission Operator. Its function is mathematically described as

E out
xy (x, y) = T E in

xy(x, y) (67.1)
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67.1 Transmission Functions in the Main Window

If you want to apply a transmission function to a harmonic field in the main window, you have to prepare this

operation by first generating a document called Jones Matrix Transmission via the items in the ribbon group

Functions > Transmission Functions. This document consists of a complex scalar component t(x, y) that can
change amplitude and phase of the input field, and the Jones matrix J (↪→Sec. 69), that has an effect on the

polarization (but in the most cases at least on amplitude or phase too). The transmission process, that means

the application of the transmission operator onto the field, can then be simulated by multiplying the harmonic

field with the Jones matrix transmission. This can be done via Manipulations > Array - Array Operation >

Multiplication (↪→Sec. 22.1.1).

The resulting output field is calculated by

E out
xy = t(J · E in

xy). (67.2)

Figure 553. The edit dialog for generating a Jones Matrix Transmission (here: Random Phase Transmission) in the main

window.

The edit dialog of transmission functions (↪→Fig. 553) has the following controls specific to the main window.

ITEM DESCRIPTION

Generate Cross Section If checked, a one-dimensional cross section either Along x-Axis or Along y-

Axis through the defined two-dimensional value distribution will be generated.

Default Parameters Resets all settings in the dialog to their default values.

The remaining controls that all types of transmissions have in common are explained in Sec. 66.1 (Basic Pa-

rameters tab) and Sec. 67.3.1.1 (Sampling tab), respectively. The type specific parameters are described in

Sec. 67.5.1 to Sec. 67.6.4.

67.2 Transmission Functions in the Optical Setup

If you want to apply a transmission function to a harmonic field inside anOptical Setup, you can do this by adding

the corresponding Ideal Component. The controls specific to transmissions are embedded in the general Ideal
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Components dialog (↪→Sec. 66). The controls that all types of transmissions have in common are explained in

Sec. 66.1 (Basic Parameters tab) and Sec. 67.3.1.2 (Sampling tab), respectively. The type specific parameters

are described in Sec. 67.5.1 to Sec. 67.6.4.

67.3 Common Controls of the Transmission Generator Dialogs

Some parameters are common for all types of transmission generator. They regard the lateral sampling of the

function, the size and shape of the aperture and the periodicity and are entered via the two tab pages Basic

Parameters (Sec. 66.1) and Sampling (Sec. 67.3.1). The third panel Physical Parameters is type specific, so

its contents are described in the appropriate sections below.

67.3.1 Sampling

As in the Optical Setup transmission functions are applied directly on an incoming harmonic field, the Sampling

tab of a transmission function looks and behaves differently in the main window (↪→Sec. 67.3.1.1) and in the

Optical Setup (↪→Sec. 67.3.1.2).

67.3.1.1 Sampling in the Main Window

Figure 554. Tab page for setting the Sampling parameters of a transmission function in the main window.

Description of the parameters:

ITEM DESCRIPTION

Automatic Sampling If checked, the sampling parameters will be determined automatically.

Manual Sampling If checked, the sampling parameters have to be entered by the user.

Accuracy Factor This parameter can be entered for the Automatic Sampling mode only. The

Sampling Distance will be divided by this value.

Copy Active Parameters

from...

This option is available for the Manual Sampling mode only. If pressed, a

window will appear where a document can be selected to copy the Sampling

Distance or the number of Sampling Points from, depending on which of both

is currently selected.

Sampling Points In case of Manual Sampling, the number of sampling points can be entered

here.

Sampling Distance In case of Manual Sampling, the sampling distance can be entered here.

Array Size The size of the transmission function, automatically calculated from the set-

tings on the Basic Parameters tab:

• In case of a Single Function with Aperture: Diameter plus two times the

Absolute Edge Width .

• In case of a Periodic Function: Equal to the Period.
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67.3.1.2 Sampling in the Optical Setup

Figure 555. Tab page for setting the Sampling parameters of a transmission function in the Optical Setup.

Description of the parameters:

ITEM DESCRIPTION

Automatic Sampling If checked, the sampling parameters will be determined automatically.

Keep Sampling The sampling parameters of the incoming harmonic field are used.

Manual Sampling If checked, the sampling parameters have to be entered by the user.

Accuracy Factor This parameter can be entered for the Automatic Sampling mode only. The

suggested sampling distance will be divided by this value. However, if the

sampling distance of the incoming harmonic field is smaller, it will be taken

instead.

Sampling Points In case of Manual Sampling, the number of sampling points can be entered

here.

Sampling Distance In case of Manual Sampling, the sampling distance can be entered here.

67.4 Programmable Function

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Ideal Components > Programmable Function

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.5). The controls that all transmission functions have in common are described in Sec. 67.3.

67.5 Apertures and Lenses

67.5.1 Aperture

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Aperture

• Optical Setup: Ideal Components > Apertures and Lenses > Aperture
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The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.1). The controls that all transmission functions have in common are described in Sec. 67.3.

67.5.2 Ideal Lens

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Ideal Lens

• Optical Setup: Ideal Components > Apertures and Lenses > Ideal Lens

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.3). If this transmission is created in the main window, the Wavelength Dependency is

fixed to Chromatic.

The controls that all transmission functions have in common are described in Sec. 67.3.

67.5.3 Spherical Phase

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Spherical Phase

• Optical Setup: Ideal Components > Apertures and Lenses > Spherical Phase

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.7). If this transmission is created in the main window, the Wavelength Dependency is

fixed to Chromatic.

The controls that all transmission functions have in common are described in Sec. 67.3.

67.5.4 Stop

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Stop

• Optical Setup: Ideal Components > Apertures and Lenses > Stop

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.8). The controls that all transmission functions have in common are described in Sec. 67.3.

67.5.5 Zernike & Seidel Aberrations

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Zernike & Seidel Aberrations

• Optical Setup: Ideal Components > Apertures and Lenses > Zernike & Seidel Aberrations
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The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.9).

The controls that all transmission functions have in common are described in Sec. 67.3.

67.6 Grating Transmissions

67.6.1 Rectangular Grating Transmission

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Rectangular Grating

• Optical Setup: Ideal Components > Grating Transmissions > Rectangular Grating Transmission

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.2.1). If this transmission is created in the main window, the Wavelength Dependency is

not available – always the set up Modulation Depth is used.

The controls that all transmission functions have in common are described in Sec. 67.3.

67.6.2 Sawtooth Grating Transmission

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Sawtooth Grating

• Optical Setup: Ideal Components > Grating Transmissions > Sawtooth Grating Transmission

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.2.2). If this transmission is created in the main window, the Wavelength Dependency is

not available – always the set up Modulation Depth is used.

The controls that all transmission functions have in common are described in Sec. 67.3.

67.6.3 Sinusoidal Grating Transmission

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Sinusoidal Grating

• Optical Setup: Ideal Components > Grating Transmissions > Sinusoidal Grating Transmission

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.2.3). If this transmission is created in the main window, the Wavelength Dependency is

not available – always the set up Modulation Depth is used.

The controls that all transmission functions have in common are described in Sec. 67.3.
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67.6.4 Triangular Grating Transmission

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Triangular Grating

• Optical Setup: Ideal Components > Grating Transmissions > Triangular Grating Transmission

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.2.4). If this transmission is created in the main window, the Wavelength Dependency is

not available – always the set up Modulation Depth is used.

The controls that all transmission functions have in common are described in Sec. 67.3.

67.7 Random Diffusers

67.7.1 Random Cells Diffuser and Speckle Type Diffuser

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > Diffusers > Random Cells Diffuser and

Ideal Components > Diffusers > Speckle Type Diffuser

The Random Cells Diffuser generates a pattern of cells with a fixed Cell Size but random amplitude and / or

phase. The Speckle Type Diffuser applies an interpolation between the cells – thus you see speckles as in

reality.
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Figure 556. Physical Parameters for a Random Cells Diffuser and a Speckle Type Diffuser.

ITEM DESCRIPTION

Use Seed You can use this option to obtain reproducible results despite the random

distribution of the amplitude and / or phase values: With the same Seed PV

and the same physical settings you always obtain the same pattern.

Modulation Mode The Amplitude Mode generates a random amplitude distribution, the Phase

Mode generates a random phase distribution. In Complex Mode both ampli-

tude and phase are altered independently.

Maximum Amplitude PV In Amplitude Mode or Complex Mode, a random amplitude between zero and

Maximum Amplitude is chosen per cell / speckle.

Maximum Phase PV In Phase Mode or Complex Mode, a random phase between -Maximum

Phase and +Maximum Phase is chosen per cell / speckle.

Cell Size PV If you select this Grid Definition, you enter the cell size directly.

Divergence Angle PV In this mode, the cell size is calculated from the full divergence angle using

the grating equation Eq. (67.3).

Pattern Diameter PV In this mode, you define the overall size of the diffraction pattern at a certain

Distance. These values yield the divergence angle and thus the cell size.

Achromatic For the grating equation Eq. (67.3), the wavelength of the incoming harmonic

field is taken.

Chromatic The givenWavelength is used for the grating equation Eq. (67.3).

The following relation is used for the conversion from divergence angle α to cell size dgrid, where n is the
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refractive index and λ is the wavelength.

dgrid =
λ

2n sin(0.5α)
(67.3)

67.7.2 Random Phase

Availability

Toolboxes: All

Accessible: Functions > Random Phase

Figure 557. Physical Parameters for a Random Phase transmission.

The following options and parameters (↪→Fig. 557) are available:

ITEM DESCRIPTION

Generate Quantized

Phase

If checked, the generated transmission is quantized, which means

that it contains only phase values that are elements of the set

{−π + 2π j/Q : j = 0, 1, . . . , Q− 1}, where Q denotes the Number of Quan-

tization Levels.

Number of Quantization

Levels

Number of quantization levels used for generating quantized transmissions.

Generate Hermitean

Transmission

If checked, the generated transmission is Hermitean, i. e. t(x, y) =

t?(−x,−y), where ? denotes the Hermitean conjugate.

67.8 Miscellaneous Functions

67.8.1 Linear Phase

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Linear Phase

• Optical Setup: Ideal Components > Miscellaneous Functions > Linear Phase

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.4). If this transmission is created in the main window, the Wavelength Dependency is

fixed to Chromatic.

Within the Optical Setup the linear phase which is applied by the functional operator is handled as analytical

parameter.

The controls that all transmission functions have in common are described in Sec. 67.3.
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67.8.2 Single Phase Dislocation

Availability

Toolboxes: All

Accessible:

• Main window: Functions > Single Phase Dislocation

• Optical Setup: Ideal Components > Miscellaneous Functions > Single Phase Dislocation

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.6).

The controls that all transmission functions have in common are described in Sec. 67.3.

68 Stored Function

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Ideal Components > Stored Function

The controls specific for this transmission function are identical to those of the corresponding boundary re-

sponse (↪→Sec. 41.3.10).

The controls that all transmission functions have in common are described in Sec. 67.3.

In the Optical Setup View (↪→Sec. 43.1), a Stored Function has a specific context menu entry to convert it into

a Microstructure (↪→Sec. 60.1).

69 Jones Matrix Multiplication

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Ideal Components > Jones Matrices

Some optical elements and devices influence the polarization state of light. Mathematically this process can

be described by a change of the electric field vector by a matrix, called Jones matrix J

E out
xy = J · E in

xy. (69.1)

For globally polarized fields, this means a change of the Jones vector:

Jout = J · Jin. (69.2)

For your convenience, the four important cases of Phase Shift, Polarizer, Retarder, and Rotator are im-

plemented as separate components in VirtualLab Fusion (described in the following sections Sec. 69.2 to

Sec. 69.5). That means, the user does not have to enter the Jones matrix but only one single parameter

describing the appropriate physical effect. For other cases an arbitrary Jones Matrix component can be used.

The controls described in Sec. 69.1 to Sec. 69.5 are embedded in the general dialog for Ideal Components

which is described in Sec. 66.

69.1 Jones Matrix

For the multiplication of an arbitrary Jones matrix this function is used.
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Figure 558. Controls for defining the parameters of an arbitrary Jones matrix multiplication.

The following parameters are available for a General Jones Matrix Multiplication (↪→Fig. 558):

ITEM DESCRIPTION

Jones Matrix PV Matrix with four complex entries.

Representation Representation of the complex values in the Jones matrix.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

The control shown in Fig. 558 is embedded in the general dialog for Ideal Components which is described in

Sec. 66.

69.2 Phase Shift

A Phase Shift adds a phase difference φ to both Ex and Ey. The appropriate Jones matrix is

J =

exp(iφ) 0

0 exp(iφ)

 . (69.3)

Figure 559. Controls for defining the parameters of a Phase Shift.

The following parameters are available for a Phase Shift component (↪→Fig. 559):

ITEM DESCRIPTION

Phase Shift PV The phase shift φ for both Ex and Ey.

Jones Matrix The resulting Jones matrix that describes the phase shift.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

The control shown in Fig. 559 is embedded in the general dialog for Ideal Components which is described in

Sec. 66.
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69.3 Polarizer

A linear polarizer is a kind of optical filter that will pass only that part of Exy which oscillates in a certain direction.

If this direction is given by an angle α, the corresponding Jones matrix is given by

J =

 cos2 α sin α cos α

sin α cos α sin2 α

 . (69.4)

Figure 560. Controls for defining the parameters of a linearly polarizing Jones matrix multiplication.

The following parameters are available for a Polarizer component (↪→Fig. 560):

ITEM DESCRIPTION

Polarization Angle PV The angle of the plane of polarization of the filtered, linearly polarized light.

Type Here you can select one of the two special cases Along x Direction, which

corresponds to a polarization angle of α = 0°, which means that the compo-

nent Ey is set to 0, or Along y Direction, which corresponds to a polarization

angle of α = 90°, which means that the component Ex is set to 0. The case of

an arbitrary polarization angle is called General.

Jones Matrix The resulting Jones matrix that describes the linear polarization.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

The control shown in Fig. 560 is embedded in the general dialog for Ideal Components which is described in

Sec. 66.

69.4 Retarder

Retarders as e. g. quarter-wave plates or half-wave plates “retard” Ey against Ex by a phase difference φ.

Thereby linearly polarized light can be transformed into circularly polarized and vice versa, for example. The

appropriate Jones matrix is

J =

1 0

0 exp(−iφ)

 . (69.5)

Figure 561. Controls for defining the parameters of a Jones matrix retardation.
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The following parameters are available for a Retarder component (↪→Fig. 561):

ITEM DESCRIPTION

Phase Delay PV The phase shift Ey shall get.

Type Here you can select one of the two important special cases Quarter-Wave

Retarder, which corresponds to a phase delay of π/2, used for transforming
linearly polarized light to circularly polarized and vice versa, or Quarter-Wave

Retarder, which corresponds to a phase delay of π, used for transforming

right-circularly polarized light into left-circularly and vice versa. The case of

an arbitrary phase delay is called General.

Jones Matrix The resulting Jones matrix that describes the retardation.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

The control shown in Fig. 561 is embedded in the general dialog for Ideal Components which is described in

Sec. 66.

69.5 Rotator

The angle of rotation θ of the plane of polarization determines the Jones matrix as follows

J =

cos θ − sin θ

sin θ cos θ

 . (69.6)

Figure 562. Controls for defining the parameters of a Jones matrix rotation.

The following parameters are available for a Rotator component (↪→Fig. 562):

ITEM DESCRIPTION

Rotation Angle PV The angle by which the plane of polarization shall be rotated.

Jones Matrix The resulting Jones matrix that describes the rotation of the plane of polar-

ization.

Hermitian Matrix Indicates whether the matrix is Hermitian.

Unitary Matrix Indicates whether the matrix is unitary.

The control shown in Fig. 562 is embedded in the general dialog for Ideal Components which is described in

Sec. 66.

70 Beam Splitters

Both kinds of idealized beam splitters (Ideal Beam Splitter ↪→Sec. 70.1 as well as Polarization Beam Splitter

↪→Sec. 70.2) can be regarded as being infinitely thin semi-transparent mirrors, splitting the incident light into
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two different directions. One fraction of light is transmitted straight forward without any direction change. The

remaining fraction is reflected following the law of reflection.

The transmitted part can be obtained by connecting the next setup element to the transmission type reference

coordinate system. The reflected part is provided to a setup element connected to the reflection type reference

coordinate system correspondingly.

The only difference between both types of beam splitters is the calculation of the fractions provided by each of

the output reference coordinate system connections.

The following sketches illustrate the functions of the two output reference coordinate systems in three different

positioning setups: The first figure Fig. 563 shows the output directions if the beam splitter is not rotated at all.

The second figure Fig. 564 illustrates the output directions in case of a basal rotation of the splitter. In the third

figure Fig. 565 the effect of an isolated rotation of the splitter on the output directions can be seen.

Figure 563. If the beam splitter is not rotated at all, the mirror normal is the direction vector (+
√

0.5, 0,+
√

0.5)T . A field

which travels into local positive z-direction will be split into one transmitted part, running unmodified into local positive z-

direction further on and a reflected part, traveling into local negative x-direction.
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Figure 564. If the beam splitter is rotated basal using a rotation matrix M, the mirror normal is the direction vector

M · (+
√

0.5, 0,+
√

0.5)T . Due to the rotation being basal, the elements connected to the reference coordinate systems
are rotated (referring to global coordinates) as well. A field which travels into local positive z-direction will be split into one

transmitted part, running unmodified into local positive z-direction further on and a reflected part. The latter one follows

the law of reflection, depending on the mirror’s orientation.

Figure 565. If the beam splitter is rotated isolated using a rotation matrix M, the mirror normal is the direction vector

M · (+
√

0.5, 0,+
√

0.5)T . Due to the rotation being isolated, the elements connected to the reference coordinate systems
are not rotated as well. A field which travels into local positive z-direction will be split into one transmitted part, running

unmodified into local positive z-direction further on and a reflected part. The latter one follows the law of reflection, de-

pending on the mirror’s orientation.

70.1 Ideal Beam Splitter

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > beam Splitters > Ideal Beam Splitter
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The Ideal Beam Splitter has two types of reference output coordinate systems: Output 0 and Output 1. The

output 0 is a transmission type system which provides an unmodified field as described above. The output 1 is

a reflection type system that gives a mirrored field which follows the law of reflection as mentioned above.

The energy of the incoming field is split up between both of the outputs. With a slider control you can set the

specific Ratio PV of distributing the energy of the input field to the output fields. Or you can directly set the

percentage for one of the two output coordinate systems.

Figure 566. The edit controls for an Ideal Beam Splitter.

The other tab pages are explained in Sec. 66.

70.2 Polarization Beam Splitter

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > beam Splitters > Polarization Beam Splitter

The output reference coordinate system “y@100%” is a reflection type system which gives a mirrored field fol-

lowing the law of reflection. The output reference coordinate system “x@100%” is a transmission type system,

leaving the field’s orientation unchanged. See also Fig. 563 to Fig. 565.

Figure 567. The edit controls for a Polarization Beam Splitter.

A polarization beam splitter splits the incoming light according to its degree of polarization. The amplitudes

of the different outputs at each of the output reference coordinate systems (“x@100%” and “y@100%”) are
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calculated as follows.

Ex@100% =

√0.5 + 0.5p · Ex√
0.5− 0.5p · Ey

 (70.1)

Ey@100% =

√0.5− 0.5p · Ex√
0.5 + 0.5p · Ey

 (70.2)

p is the Polarization Degree PV .

For p = 0, the polarization beam splitter behaves just like a normal ideal beam splitter with an energy ratio of

50%, while for p = 100%, the field is split into pure Ex and pure Ey polarization.

The other tab pages are explained in Sec. 66.

71 Manipulators

The following manipulation functions are available as Ideal Components in the Optical Setup.

• Field Size and Sampling (↪→Sec. 22.8.2)

• Identity Operator (↪→Sec. 71.1)

• Lateral Shift (↪→Sec. 71.2)

• Sample Spherical Phase (↪→Sec. 71.3)

71.1 Identity Operator / Coordinate Break

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Ideal Components > Manipulators > Identity Operator; Coordinate Break

This Ideal Component just returns the incoming field. It can be helpful if you want to change the position of a

set of detectors at the same time: Just connect the detectors with the Identity Operator and change the position

of the Identity Operator. Fig. 568 shows the edit dialog of the identity operator.
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Figure 568. The dialog for an Identity Operator.

ITEM DESCRIPTION

Calculate Field in Opera-

tor Plane

With this option the user can specify for the Classic Field Tracing whether

the field shall be calculated in the plane of the identity operator or not. If this

checkbox is switched off the ideal component is used for positioning only. The

Coordinate Break element which can be found in the Optical Setup Tree is

actually an Identity Operator where this option is switched off by default.

71.2 Lateral Shift

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > Manipulators > Lateral Shift

This operator allows you to shift the incoming field both in x- and y-direction by the specified Lateral Shift PV .

The other settings are explained in Sec. 66.
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Figure 569. The dialog for setting up a Lateral Shift.

71.3 Sample Spherical Phase

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > Manipulators > Sample Spherical Phase

This Ideal Component just resamples the incoming harmonic field so that the spherical phase radius can be

removed by a subsequent Optical Setup Element without loss of information. It has no specific settings; the

general edit dialog for Ideal Components is explained in Sec. 66.

See also Sec. 12.1.1 for the concept of the spherical phase radius.

72 Mirrors

72.1 Ideal Plane Mirror

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Ideal Components > Mirrors > Ideal Plane Mirror
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Figure 570. The edit dialog for an Ideal Plane Mirror with Function tab selected.

The Ideal Plane Mirror is an idealized plane mirror with the specified Reflectance PV . You can determine the

Mirror Inclination via the control for defining an element’s orientation (↪→Sec. 5.6).

The other tab pages are explained in Sec. 66.

72.2 Ideal Spherical Mirror

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Ideal Components > Mirrors > Spherical Mirror
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Figure 571. Appearance of the Physical Parameters tab in a General Optical Setup.

The Function tab of the edit dialog of a spherical mirror (↪→Fig. 571) has three sub-tabs. The Basic Parameters

sub-tab is explained in Sec. 66.1 and the Sampling tab is explained in Sec. 67.3.1.2.

The Physical Parameters sub-tab allows you to enter the following parameters:

ITEM DESCRIPTION

Mirror Radius PV The radius of curvature if the mirror was a real mirror. A negative value means

a concave mirror, i. e. a incident plane wave is converging after reflection.

Reflectance PV Allows you to consider the absorption of a real mirror inside the specified

aperture. This factor, which must be between 0 and 1, is multiplied to the

intensity values of the incident field. The reflectance outside the aperture (if

one is specified) is always zero.

Additional settings for outcoupling are available on this tab in a Laser Resonator Optical Setup (if the mirror is

not used as start mirror):

ITEM DESCRIPTION

Transmittance Inside

Aperture PV

Via this value the user sets the transmittance inside the aperture at the out-

coupling mirror. If Resulting from Reflectance is chosen, the transmittance is

adapted via T = 1− R automatically. In case of Manual Setting an arbitrary

value between 0 and 1 can be adjusted. The value of Reflectance will be

leaved unchanged in this case.

Transmittance Outside

Aperture PV

Herewith the transmittance outside the aperture can be adjusted. This setting

allows the user to build up unstable resonators.
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Figure 572. Appearance of the Physical Parameters tab in a Laser Resonator Optical Setup.

The other tab pages are explained in Sec. 66.

72.3 Ideal Stored Mirror Function

Availability

Optical Setups: Laser Resonator Optical Setup

Accessible: Optical Setup: Ideal Components > Mirrors > Ideal Stored Mirror Function
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Figure 573. The edit dialog for an Ideal Stored Mirror with Function tab selected.

The Function tab of the edit dialog of the Ideal Stored Mirror Function (Fig. 573) has the following options:

ITEM DESCRIPTION

Set Sets a Jones Matrix Transmission which represents the mirror function.

Show Shows the stored mirror function as Jones Matrix Transmission.

Interpolation Method Specifies whether the given sampled data is interpolated or not.

Reflectance The reflectance of the mirror, i. e. a value between 0 and 1.

The other tab pages are explained in Sec. 66.

73 Special Components

The following ideal components are available at Ideal Components > Special Components in the Optical Setup

Tree.

• 1f-Setup (↪→Sec. 31.1.1)

• 2f-Setup (↪→Sec. 31.1.1)

• ABCD Matrix Setup (↪→Sec. 73.1)

• Evanescent Field Filter (↪→Sec. 73.2)

• Field Decomposition (↪→Sec. 73.3)
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73.1 ABCD Matrix Setup

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Ideal Components > Special Components > ABCD Matrix Setup

This Ideal Component allows you to define an ABCD matrix from an arbitrary number of optical elements. The

effect of this ABCD matrix on the incoming field is then simulated

• for General Profile and Ray Results Profile with the ray transfer equation Eq. (134.1) and

• for Classic Field Tracing with the propagation algorithm given by Collins Eq. (134.3). For this propagation

technique the matrix elements A and B of the resulting ABCD matrix must not be zero.

Figure 574. The edit dialog for the ABCD Matrix Setup. The validity indicator (↪→Sec. 5.10) shows a warning because
matrix element A is zero and thus Classic Field Tracing cannot be used to propagate through this Ideal Component.

The edit dialog of this component is the general edit dialog for Ideal Components (↪→Sec. 66). Its Function

tab (↪→Fig. 574) comprises the control to define the ABCD matrix (↪→Sec. 5.16) and additionally the following

controls:

ITEM DESCRIPTION

Resulting ABCD Matrix Shows the resulting ABCD matrix.

Copy from Calculator Copies the ABCD matrix elements from an ABCD Law Calculator

(↪→Sec. 104).
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73.2 Evanescent Field Filter

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Ideal Components > Special Components > Evanescent Field Filter

This Ideal Component just eliminates the evanescent part of the field and reduces the sampling accordingly.

Only propagating plane waves remain in the spectrum of plane waves representation of the field. It can be

helpful to study the importance of evanescent fields. It has no specific settings; the general edit dialog for Ideal

Components is explained in Sec. 66.

73.3 Field Decomposition

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Ideal Components > Special Components > Field Decomposition

This Ideal Component decomposes a field laterally into distinct modes which can improve performance.

Figure 575. The Physical Parameters sub-tab of the Field Decomposition component.

The Function tab of the edit dialog of a Field Decomposition component (↪→Fig. 575) has two sub-tabs. The

Basic Parameters sub-tab is explained in Sec. 66.1. The Physical Parameters sub-tab allows you to enter the

following parameters:
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ITEM DESCRIPTION

Type of Decomposition PE Allows you to choose between Rectangular Segments and Annular Ellipses.

Fig. 576 illustrates the two decomposition types.

Relative Edge Width for

Decomposition PV

Hard edges in a mode can lead to unwanted effects. Thus you have the op-

portunity to define a relative edge width during which the field values decrease

from their original values to zero. The larger this value, the softer the edge

becomes but also the larger the overlap of the modes becomes, which leads

to higher numerical effort.

Number of Segments PV O R S

Defines the number of segments in both x- and y-direction, respectively.

Number of Annuli PV O A E

Defines the number of “rings”.

The other tab pages are explained in Sec. 66.

Figure 576. A field decomposed into lateral segments (to which different colors were assigned). Left: 3 × 2 Rectangular

Segments, right: 6 Annular Ellipses.



XI Detectors:
Evaluating Data

Detectors evaluate field data or even a numerical data array in various

ways. For example you can extract the value at a certain point, deter-

mine the spot size, or calculate the magnetic field.
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74 Detectors in the Optical Setup

74.1 Base Dialog

All detectors in the Optical Setup use the same base dialog which has the following controls.

ITEM DESCRIPTION

Coordinate Systems ↪→Sec. 43.8.1

Position / Orientation ↪→Sec. 43.8.2

Detector Parameters >

Detector Window and

Resolution

↪→Sec. 74.1.1

Detector Parameters >

Detector Function

Contains the specific settings for the respective detector.

Free Space Parameters ↪→Sec. 43.4.2

Save Saves the detector to the catalog (↪→Sec. 33). Not visible if the edit dialog

is shown from within the detectors catalog. For technical reasons the Pulse

Evaluation detector cannot be saved.

74.1.1 Detector Window and Resolution

Figure 577. The Detector Window and Resolution sub-tab page.

The Detector Window and Resolution sub-tab page of a detector (↪→Fig. 577) allows you to configure both size

and position of the detector window as well as the resolution of the detector. The incident field is interpolated

accordingly.
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ITEM DESCRIPTION

Scale Window Size by

Factor

If this option is checked, you can define a scaling factor separately for x- and

y-direction. A scaling factor larger than one means that the incident field is

embedded, a factor smaller than one means that it is cropped.

Set Window Size If this option is checked, you can directly set the size of the detector window.

Copy from …

{Detector Window}

Copies the detector window from an open document window with a rectangle

marker. The size and the position of the selection in that document are set

into the dialog. This can also be done via right click on the detector icon in

the Optical Setup View (↪→Sec. 43.1).

Center Position The center position of the detector window relative to the internal coordinate

system of the detector.

Scale Sampling Distance

by Oversampling Factor

If this option is checked, you can define a scaling factor separately for both

x- and y-direction. A scaling factor larger than one makes the sampling of the

incident field finer, a factor smaller than makes it coarser.

Set Sampling Distance If this option is checked, you can directly set the resolution of the detector.

Set Number of Sampling

Points

With this option you can choose from various predefined resolutions. Global

Options refers to the default number of sampling points defined in the Global

options dialog (↪→Sec. 6.12). If you select User-Defined you can choose an

arbitrary number of sampling points.

Independent from the number of sampling points a one-dimensional input

field always stays one-dimensional. In contrast, if you specify only one sam-

pling point for one direction, you can make a two-dimensional field one-

dimensional.

Copy from …

{Detector Resolution}

Copies the resolution from an open document window displaying either a har-

monic field or a harmonic fields set. The sampling distance of that document

is used for it.

Interpolation Method Defines which interpolation method is to be used if resampling of the incident

field is necessary.

The functionality of the Copy from … button for the detector window can also be accessed from the context

menu of a detector in the Optical Setup View (↪→Sec. 43.1).

74.2 Copy Settings from Other Detector

This tool can be accessed via the context menu of a detector symbol in the Optical Setup View (↪→Sec. 43.1).

It copies certain settings from a template detector to the currently selected detector.

Figure 578. The dialog to copy certain settings from another detector.

Its edit dialog (↪→Fig. 578) has the following settings.
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ITEM DESCRIPTION

Template Detector Here you can select the detector from which the settings are copied. The

currently selected detector is excluded from that list because it is the target

of the copy operation.

Detector Window and

Resolution

If this option is checked, all settings on the Detector Window and Resolution

tab (↪→Sec. 74.1.1) are copied from the template detector.

Position and Orientation If this option is checked, the basal position and orientation settings

(↪→Sec. 43.8.2.2) are copied from the template detector.

74.3 Programmable Detector

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Programmable Detector

The Programmable Detector allows you to evaluate the incoming field with a snippet.

The Detector Parameters tab contains two sub-tabs: the Detector Window and Resolution sub-tab which is

explained in Sec. 74.1.1 and the Detector Function sub-tab which is explained below.

The remaining tab pages are explained in Sec. 74.1. General information about programming in VirtualLab

Fusion can be found in Sec. 7.

Figure 579. The Detector Function page of the Programmable Detector.

On this tab page you can define the detector function by two snippets (for equidistant and non-equidistant data,
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respectively). In these snippets you have access to the incoming field in spatial domain via the InputField
variable in case of equidistant data and the RayTracingResult variable in case of non-equidistant data, respec-
tively. In both cases the field in spectral domain is available via the SpectralField variable, a ModeCollection
which can contain a mix of equidistant and non-equidistant member fields. The settings on theDetector Window

and Resolution tab are already applied to the fields available within the snippets.

For equidistant data the user can specify whether the incident field shall be calculated centered to the optical

system and whether the linear phase of the incident field shall be handled analytically or be sampled before

applying the snippet of the Programmable Detector.

The Detector Function tab (↪→Fig. 579) contains the following controls:

ITEM DESCRIPTION

Evaluate Field in

x-Domain

If you check this option, the field in x-domain is calculated and available as

InputField or RayTracingResult variable in the snippets. Otherwise these
variables are null.

Evaluate Field in

k-Domain

If you check this option, the field in k-domain is calculated and available as

SpectralField variable in the snippets. Otherwise this variable is null.
The dialog ensures that at least the spatial or the spectral field is evaluated.

Linear Phase The user can specify whether the linear phase of the incident equidistant field

shall be sampled (option Resolve via Sampling) or whether it is handled an-

alytically by the snippets (option Keep Stored as Vector).

Relative Position of Field

to Position of Input Trans-

face

The field reaching the Programmable Detector is always rotated into the de-

tector plane. But if the option Resolve via Zero Padding is checked, equidis-

tant field data will be also padded into zeros in a way that the new origin of

the field’s coordinate system will be identical to that of the detector. If the

option Keep Stored in the Field’s Coordinate System is chosen, no additional

preparation will be done.

Snippet for Equidistant

Field Data

The snippet evaluated by the Programmable Detector if equidistant field data

enters the detector. This happens if the system is analyzed with Classic Field

Tracing or if the system is analyzed with General Profileand the last Fourier

transform done is not a pointwise one. Edit opens the Source Code Editor

(↪→Sec. 7.3), and a validity indicator (↪→Sec. 5.10) shows whether this snippet

is consistent.

Snippet for Non-

Equidistant Field and

Ray Data

The snippet evaluated by the Programmable Detector if non-equidistant data

enters the detector. This happens if the system is analyzed with General

Profile and the last Fourier transform done is a pointwise one or if the system

is analyzed with Ray Results Profile. Edit opens the Source Code Editor

(↪→Sec. 7.3), and a validity indicator (↪→Sec. 5.10) shows whether this snippet

is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippets. ↪→Sec. 7.4

Programmable Detectors might be set to a mode where the source code cannot be changed and thus

the Input Field Preparation group box, the Use Field in Spatial / Spectral Domain check boxes, and the

Algorithms groupbox are hidden.
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Notes for Snippet Developers

A Programmable Detector can also be used in the main window (↪→Sec. 75.1). Then the ParentSystem
/ ParentLightPath is null and the IndexOfDetector is -1, which must be handled in the snippets.

74.4 Universal Detector

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Field Visualization > Universal Detector

This detector can be used to evaluate any vectorial component (Ex, Ey, Ez, Hx, Hy, or Hz) of an incoming

light distribution. These components are given as different subsets of an Electric, Magnetic or Electromagnetic

Field (↪→Sec. 13.1, ↪→Sec. 13). If the incoming light has multiple modes, one field is generated per mode and

all resulting data are collected in one Set Of Objects (↪→Sec. 16). Depending on the subsequent configuration

coherent modes can be added up (with different settings) or not.

The implemented formulas for the calculation of the magnetic field are given in Sec. 137.7.1.

Based on the Electromagnetic Field any merit function can be evaluated. This is realized in VirtualLab Fusion

by detector Add-ons which are available in the Universal Detector.

Figure 580. The edit dialog of the Universal Detector.

The edit dialog of this detector (↪→Fig. 580) provides the following sub pages for different configuration settings:
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ITEM DESCRIPTION

Field Quantities Via the controls on this tab page the user can define which field quantities in

which domain shall be evaluated. A detailed description of the parameters

can be found under Sec. 74.4.1

Detector Window (x-

Domain)

On this tab page the user specifies the detector window and the resolution

(for gridded data) for the evaluated field in x-domain. For details please check

Sec. 74.4.2.

Detector Window (k-

Domain)

On this tab page the user specifies the detector window and the resolution

(for gridded data) for the evaluated field in k-domain. For details please check

Sec. 74.4.3.

Gridless Data The universal detector also allow the evaluation of the field data in gridless

format. The settings for the gridless data output can be specified here.

Add-ons As stated above it is supported to evaluate any detector function based on the

evaluated Electromagnetic Field. On the Add-ons page the user can specify

a tree of detector add-ons which are processed after the Universal Detector

calculated the Electromagnet Field.

In the following sections the controls on the tab pages are explained more in detail.

74.4.1 Field Quantities

The tab page Field Quantities allows the user to specify the electromagnetic field components to evaluate as

well as the domains in which the component shall be calculated. A selection of advanced configuration options

are also available which are explained below.

Fig. 581 shows the controls to configure the field quantities.

Figure 581. The user interface to configure the field quantities within the universal detector (and the system modeling

analyzer).

The following settings can be configured
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ITEM DESCRIPTION

Components Allows the user to select which vectorial components of the field are evalu-

ated. The dialog ensures that at least one component is selected.

Domain The user can select whether to evaluate the electromagnetic field in x-domain

and/or k-domain. The dialog ensures that at least one option is selected.

Configure Field Data Visu-

alization by Electromag-

netic Field Quantity Add-

On

In the controls explained above the user configures which quantities/domains

shall be calculated by the detector. This input data is provided to the detector

Add-Ons of the Universal Detector. A standard add-on is the output of the

data. Here the user can select what of the evaluated quantities should be

generated as document windows in VirtualLab Fusion. By clicking on the

configuration button a dialog opens in which the mentioned configuration can

be done. More information on that see Sec. 74.4.5.1.

Apply Paraxial Approx-

imation for Component

Calculation

The Universal Detector provides an option to calculate field components by

paraxial assumptions. Typically the field components Ex and Ey are provided

by the engine. All other components can be calculated from these two field

component. To speed up detector evaluation VirtualLab Fusion provides an

option to use simplified formulas for the field component calculation. This

enable also that there is no need to have special versions of detector add-

ons with paraxial assumptions.

Sum Mutual Coherent

Modes

Source modes in VirtualLab Fusion are typically incoherent (different or same

wavelength). During propagation through an optical setup a source mode

could be split into different modes (e.g. at a grating), where the modes are

typically coherently to each other. The Universal Detector provides an option

whether the coherent modes should be summed up before further processing

via Detector Add-ons. If the user decides to Sum Mutual Coherent Modes

additional options will be available to define how the modes shall be summed

up.

How to Sum Mutually Co-

herent Modes

If the user selected to Sum Mutual Coherent Modes, he needs to specify the

summation type how themodes shall be summed up. There are various Sum-

mation Types how coherent modes can be summed up: Coherent Summa-

tion, Incoherent Summation, and Partial Coherent Summation. For the latter

you can specify the degree of coherence by entering a Coherence Time PV

(or copying it from a Coherence Time & Length Calculator ↪→Sec. 105). .

Note: The settings in these control define which field component in which domain shall be calculated. This

is not identical with the result visualization of the Universal Detector. The values to show as data array are

configured under Electromagnetic Field Quantities. Detailed information see Sec. 74.4.5.1.

74.4.2 Detector Window (x-Domain)

The user can specify the detector window and the resolution (for gridded data) in x-domain for the Universal

Detector. The configurations are done in the tab page Detector Window (x-Domain).

Fig. 582 shows the user interface to configure the detector window in x-domain.
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Figure 582. The user interface to configure the detector window (x-domain) within the universal detector (and the system

modeling analyzer).

In these controls the user can specify the following parameters:

ITEM DESCRIPTION

Detector Window Cen-

tered Around

The user has to specify where the output data of the detector shall be given.

VirtualLab Fusion provides two options to the user: Detector Position and

Center of Field Mode.

Lateral Window Position In x-domain the user has an additional freedom to define also a lateral shift of

the coordinate system. This option is independent to the general positioning

control of each optical system element.

Detector Window Size In the group box Detector Window Size the user can specify the window size

for evaluation of the field component. The window size can be specified From

Field Data or via Manual Setting. In case of From Field Data the field size

might be different for each mode that illuminates the detector. In that case the

user can specify an additional Size Scaling Factor. In case ofManual Setting

the same detector window size is applied on each incident field mode. In this

case the user needs to specify theWindow Size directly.

Detector Grid Resolution Finally the user can specify in the section Detector Grid Resolution the grid

which is used to generate gridded data by the Universal Detector. The user

has again two options for the general specification of the resolution: From

Field Data or Manual Setting. In case From Field Data each incident mode is

analyzed and the input sampling is used as detector grid. The user can op-

tionally enter a Grid Period Scaling Factor. If the user selects Manual Setting

all incident modes will converted on the same grid. In case Manual Setting is

selected the user has the option to select whether to Set Grid Period (which

corresponds to the sampling distance) or to Set Grid Points.

74.4.3 Detector Window (k-Domain)

The user can also specify the detector window and the resolution (for gridded data) in k-domain for theUniversal

Detector. The configurations are done in the tab page Detector Window (k-Domain). The configuration is quite

similar to the Detector Window (x-Domain). Main difference is that size and grid period are specified in wave

numbers and not in length unit.

Fig. 583 shows the user interface to configure the detector window in k-domain.
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Figure 583. The user interface to configure the detector window (k-domain) within the universal detector (and the system

modeling analyzer).

In these controls the user can specify the following parameters:

ITEM DESCRIPTION

Detector Window Cen-

tered Around

The user has to specify where the output data of the detector shall be given.

VirtualLab Fusion provides two options to the user: Detector Position and

Center of Field Mode.

Detector Window Size In the group box Detector Window Size the user can specify the window size

for evaluation of the field component. The window size can be specified From

Field Data or via Manual Setting. In case of From Field Data the field size

might be different for each mode that illuminates the detector. In that case the

user can specify an additional Size Scaling Factor. In case ofManual Setting

the same detector window size is applied on each incident field mode. In this

case the user needs to specify theWindow Size directly.

Detector Grid Resolution Finally the user can specify in the section Detector Grid Resolution the grid

which is used to generate gridded data by the Universal Detector. The user

has again two options for the general specification of the resolution: From

Field Data or Manual Setting. In case From Field Data each incident mode is

analyzed and the input sampling is used as detector grid. The user can op-

tionally enter a Grid Period Scaling Factor. If the user selects Manual Setting

all incident modes will converted on the same grid. In case Manual Setting is

selected the user has the option to select whether to Set Grid Period (which

corresponds to the sampling distance) or to Set Grid Points.

74.4.4 Gridless Data

VirtualLab Fusion supports also the evaluation of the electromagnetic field of gridless data by the Universal

Detector. The gridless output is only possible if the incident light at the detector comes in gridless format. In

addition there is another limitation, which will not allow the generation of gridless data output of the Universal

Detector: In case more than one coherent mode illuminates the detector and the user has defined to sum up

the coherent modes this summation can also be only done on an equidistant grid. In case the input data is

gridded but the user defined to show only gridless data the detector will fall back to gridded data output.

Fig. 584 shows the user interface to configure the gridless data output of the Universal Detector.
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Figure 584. The user interface to configure the gridless data output of the universal detector (and the system modeling

analyzer).

The user can specify the following options in the section Gridless Data:

ITEM DESCRIPTION

Show Result w/o Interpo-

lation for Gridless Data

By selecting Yes for Show Result w/o Interpolation for Gridless Data the user

defines that he likes to generate gridless data as detector output. If the in-

cident light of the detector comes in gridded format gridless data will not be

generated by the detector. If Yes is selected additional options are shown

below the decision controls.

Show Interpolated Result

on Equidistant Grid

If the user selects to generate gridless data he can activate to generate also

gridded data. If this option is checked and the input field comes in gridless

format the Universal Detector will generate gridless as well as gridded data.

Quantity For gridless data VirtualLab Fusion supports to select whether the gridless

data shall contain Field Values or only Positions, Directions and Wavefront

data. The generation of Positions, Directions and Wavefront corresponds to

the standard results generated in classical ray tracing software. Note: In the

modeling profile Ray Result the universal detector is restricted to generate

always Positions, Directions and Wavefront data.

Gridless Sampling Points Finally the user can specify the gridless sampling points that shall be gener-

ated. The user has two options: Use Number of Points from Field Data or

to use Manual Sampling. In case of Number of Points from Field Data the

number and location of points for gridless data is directly used from the input

field of the detector. If the user decides to use Manual Sampling the point

selection mode has to be specified. VirtualLab Fusion supports the following

selection modes: x-y-Grid, Hexapolar and Random. For the specification of

x-y-Grid the user needs to specify the number of points in x- and y-direction.

In case of Hexapolar the density has to specified. In Random point selection

mode the user need to specify the number of points, the seed value for ran-

dom generation and also whether a mesh shall be generated for the random

generated points. Detailed information can be found in Sec. 43.4.4.1.

74.4.5 Detector Add-ons

In the tab page Add-ons the user has the option to define a tree of Detector Add-ons. ↪→Fig. 585 shows the

user interface to specify the detector Add-ons.
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Figure 585. The user interface to define the detector add-ons which can be used within the universal detector.

A detector add-on is typically defined by a user-defined/customized snippet. This enables the full flexibility to

develop any merit function the user has in mind even if the merit function is not yet available as prepared add-

on. VirtualLab Fusion comes with a variety of predefined detector add-ons which can be easily synchronized

via pushing the corresponding button (via internet).

Note that you can chain the add-ons: One add-on can use the output of another add-on as input. Thus in the

end you have a tree of add-ons with the Data from Universal Detector as root. There is a pre-defined add-on

Electromagnetic Field Quantities (↪→Sec. 74.4.5.1) directly dependent on Data from Universal Detector.

In the tree view on top of the tab page you can use drag & drop to resort the add-ons and change their de-

pendencies (a child entry always gets its input from the direct parent). For each add-on there are the following

controls available in the tree view.

ITEM DESCRIPTION

/ Allows you to toggle whether the output of this add-on is shown ( ) or not

( ). Note that even if the output is not shown, the add-on is still processed if

its output is required as input for another add-on.

For the Electromagnetic Field Quantities this button opens the dialog de-

scribed in Sec. 74.4.5.1. For all other add-ons the dialog described in

Sec. 74.4.5.2 allows you to edit and save the add-on.

× Closes the add-on. Before, you are asked whether you want to save the

add-on snippet.

On the bottom of this tab page there are the following buttons.
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ITEM DESCRIPTION

New Adds a new default add-on.

Load Loads and adds an add-on stored on hard disc. By default a folder with add-

ons prepared by LightTrans is opened.

Duplicate Duplicates the selected add-on and append it to the detector add-on tree. For

this operation a detector add-on has to be selected in the tree above. Note:

The default add-on (Electromagnet Field Quantities) cannot be duplicated.

The folder with the add-ons prepared by LightTrans is updated via Internet.

Optionally also the snippets of all favorites (↪→Sec. 76.9) are then updated

if they have the same name as a predefined addon. The values of your fa-

vorites’s snippet parameters are kept.

Note for Snippet Developers

Note that an Universal Detector can also be used in the main window (↪→Sec. 75.1). Then the

ParentSystem is null and the DetectorIndex is -1, which must be handled in the snippet.

74.4.5.1 Electromagnetic Field Quantities

The Universal Detector comes always with the Electromagnet Field Quantities add-on by default. This add-on

can not be removed from the tree. It is also not possible to change its position in the tree of detector add-ons.

The task of the Electromagnet Field Quantities add-on is to show the available field components in its domains.

The detector add-on could be disabled. In addition it allows to define a subset of the information evaluated by

the Universal Detector.

↪→Fig. 586 shows the edit dialog of the Electromagnetic Field Quantities add-on.

Figure 586. The edit dialog of the Electromagnet Field Quantities add-on.

Within the edit dialog the following options can be configured
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ITEM DESCRIPTION

Field Components Allows you to select which vectorial components of the field shall be dis-

played. Only calculated field components (from Universal Detector or Sys-

tem Modeling Analyzer can be selected. The dialog ensures that at least one

component is selected.

Domain The user can select whether to show the field in x-domain and/or k-domain.
Only domains which are calculated can be selected

Amplitude If selected only the amplitude of the field will be generated as output.

Amplitude/Phase (w/o
Wavefront Phase)

The user can also select whether to show amplitude and phase of the calcu-

lated field component. The phase will be given in 2PI modulo format and will

not include the smooth wavefront phase.

Wavefront Phase In addition to the amplitude (and 2PI modulo phase) of the field component, it

is also supported to show the wavefront phase. The wavefront phase will be

displayed as a separate data array and is common for all field components.

Wavefront Phase w/o
Spherical Part

For many applications it might be meaningful to investigate only the residuals

of the wavefront phase. Therefore the user can select whether to show the

wavefront phase without the spherical part. The spherical part is evaluated

by fitting of the given wavefront phase data.

Show Polarization El-

lipses

O E-F C .

If checked, polarization ellipses for the E-field will be calculated and added to

the output.

Plane O S P E .

If all three E-Field Components are selected, the plane to calculate the el-

lipses for can be chosen here.

O S P E .

This button will open a dialog for configuring the view settings for the graph-

ics add-on which visualizes the polarization ellipses. It is described in

Sec. 11.7.3.

Ignore Vanishing Jones

Vectors

If checked, no polarization ellipses will be calculated at positions where the

amplitudes of both of the Jones vector’s components are below a certain frac-

tion (given be Threshold) of the maximum field amplitude (see also Sec. 11.8).

Threshold O I V J V .

The threshold for identifying vanishing Jones vectors.

Color Table

The color table (↪→Sec. 11.2.4) to be used (initially) in the resulting document

window.

Color for Undefined Val-

ues

The user can select a color for undefined values. This will be used (initially)

in the resulting document window.

Interpolation Method The interpolation method of the resulting data array(s).
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74.4.5.2 Edit Dialog for Detector Add-ons

Figure 587. The edit dialog for a (sample) detector add-on.

The edit dialog for detector add-ons (↪→Fig. 587) has the following standard controls.

ITEM DESCRIPTION

Name The name of the detector add-on. It is equal to the Title defined on the Snippet

Help tab when you click on Edit.

Edit Opens the Source Code Editor (↪→Sec. 7.3).

Read Me Shows the Snippet Help (↪→Sec. 7.3.3) in a separate window.

Validity The validity indicator (↪→Sec. 5.10) shows whether the snippet defining the

detector add-on is consistent.

Saves the detector add-on to hard disc so that it can be loaded into another

detector. If you save the add-on in the default path, it is added to the Favorites

in the ribbon for Data Arrays and Harmonic Fields Sets (↪→Sec. 76.9).

In addition to the standard controls mentioned in the table above the dialog may contain a list of user controls

which are dynamically defined by the type of global parameters of the detector add-on, ↪→Sec. 7.4.

74.5 Field Visualization

74.5.1 Angular Spectrum Visualizer

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Detectors > Field Visualization > Angular Spectrum Visualizer

This detector shows the angular spectrum, i. e. the (physical) Fourier transform (↪→Sec. 31.1) of the field.

The used dialog is nearly the same as for the Raw Data Detector, described in Sec. 74.5.5.

74.5.2 Camera Detector

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Light Shaping Optical Setup

Accessible:

• Optical Setup: Camera Detector; Detectors > Field Visualization > Camera Detector

• Ribbon: Detectors > Camera Detector
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Figure 588. The specific settings for the camera detector in a General or a Light Guide Optical Setup.

Figure 589. The specific settings for the camera detector in a Light Shaping Optical Setup.

The settings of the Camera Detector depend on the type of Optical Setup it is used in. It can also be applied on

harmonic fields and harmonic fields set via Detectors > Camera Detector. In this case it behaves as if it would

be used in a General Optical Setup.
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ITEM DESCRIPTION

Handling of Coherence O L S O S

The camera detector supports two operation modes to evaluate the distinct

modes of the incident field. In Standard Mode the coherent modes are in-

terpreted coherently. The Incoherent Approximation evaluates the incident

coherent modes by incoherent superposition which can speed up calcula-

tions.

Coherence Parameters O G L G O S

There are various Summation Types how coherent modes can be summed

up: Coherent Summation, Incoherent Summation, andPartial Coherent Sum-

mation. For the latter you can specify the degree of coherence by entering a

Coherence Time PV (or copying it from a Coherence Time & Length Calculator

↪→Sec. 105). These settings have no effect for Classic Field Tracing as this

engine only supports incoherent modes.

Components to Integrate O G L G O S

You can select one or more vectorial components which are shown in the

result. In a Light Shaping Optical Setup always Ex-Component and Ey-

Component are used and thus this group box is invisible.

Real Color /

False Color

Allows you to preset the color mode (↪→Sec. 14.2) of the resulting Chromatic

Fields Set if it is a two-dimensional one.

{Color Table Button} O F C .

Allows you to select one color table (↪→Sec. 11.2.4).

If the Camera Detector is used in a Light Shaping Optical Setup, both the size of the Detector Window

and the Detector Resolution can only be set manually.

The remaining controls of this dialog are explained in Sec. 74.1.

74.5.3 PSF & MTF

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Field Visualization > PSF & MTF

This detector calculates both the Point Spread Function (PSF) and the Modulation Transfer Function (MTF).

The user is responsible to place the detector at the appropriate evaluation position (= focus), which is expected

to be different depending on the system’s settings (e. g. illumination).
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Figure 590. The edit dialog for the PSF & MTF detector.

Its edit dialog (↪→Fig. 590) has the following settings.
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ITEM DESCRIPTION

Apply Ideal Lens If this option is checked you can set a focal length. Then the field is propa-

gated into the focus of an Ideal Lens with that focal length. Otherwise it is

assumed that the field entering the detector is already in the focus.

Summation Type If there is more than one coherent mode, the modes can be added coher-

ently, incoherently, or partially coherently. For the latter you can specify the

degree of coherence by entering a Coherence Time PV (or copying it from a

Coherence Time & Length Calculator ↪→Sec. 105). This setting has no effect

for Classic Field Tracing as this engine only supports incoherent modes.

Components to Integrate Allows you to select which vectorial components of the field are integrated

and thus taken into account for the PSF and MTF calculation. Ex, Ey and / or

Ez can be used whereas the dialog ensures that at least one component is

selected.

PSF Allows you to set whether the PSF is returned as Chromatic Fields Set

(↪→Sec. 14) by the detector.

Real Color /

False Color

O PSF .

Allows you to preset the color mode (↪→Sec. 14.2) of the resulting Chromatic

Fields Set with the PSF data. Only has an effect if the incident field is two-

dimensional.

MTF Allows you to set whether the MTF is returned as Data Array(s) by the detec-

tor.

Along x-Axis /

Along y-Axis /

Two-Dimensional

O MTF .

By default the two-dimensional MTF is shown. But you can also select that an

cross section Along x-Axis or Along y-Axis is shown additionally. This cross

section always starts with a spatial frequency or line density of zero.

Versus Line Density /

Versus Wave Number

O MTF .

The MTF can be plotted either Versus Line Density with the unit cycles or line

pairs per millimeter. Or it can be plotted Versus Wave Number with the unit

1/m.

Calculate Line Density /

Wave Number Limit

O A -A A -A

If checked, the line density or wave number is calculated where the contrast

first falls below the specified limit.

Color Table Allows you to preset the color table for the two-dimensional Chromatic Fields

Set with the PSF data in False Color mode and the two-dimensional Data

Array with the MTF Data.

The dialog ensures that you cannot unselect all output possibilities.

Fig. 603 shows how the edit dialog looks like if the detector is used in the main window (via Detector from

Catalog; ↪→Sec. 75.1). If this detector is used in an Optical Setup, a dialog with additional controls is used

(↪→Sec. 74.1).
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74.5.4 Radial / Azimuthal Polarization

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Field Visualization > Radial / Azimuthal Polarization

This detector plots the radial component Eρ and / or the azimuthal component Eφ (↪→Fig. 591) of a field into a

data array. If the field consists of multiple modes the data arrays for the distinct modes are collected in a Set

of Data Arrays (↪→Sec. 16).

Figure 591. Decomposition of the electric field vector E into Cartesian components (blue) and polar coordinate compo-

nents (green).

The conversion from Ex and Ey to Eφ and Eρ is done by the following equations:

Eρ(ρ, φ) = cos φEx(x, y) + sin φEy(x, y) (74.1)

Eφ(ρ, φ) = − sin φEx(x, y) + cos φEy(x, y) (74.2)

The polar coordinates are given by ρ =
√

x2 + y2 and φ = atan2 y/x 1.

Figure 592. The edit dialog of the Polarization Detector. Note that you cannot uncheck the only selected polarization

component as then no component would be selected.

The edit dialog for the detector is shown in Fig. 592 and has the following controls and the Detector Function

sub-tab.

1 atan2 is a special implementation of the arctangent function for a fraction of two values. See Microsoft C# documentation or Wikipedia

for reference.

https://docs.microsoft.com/en-us/dotnet/api/system.math.atan2
https://en.wikipedia.org/w/index.php?title=Atan2&oldid=1026614210
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ITEM DESCRIPTION

Polarization Components

to Evaluate

You can select either the E_Rho-Component Eρ, the E_Phi-Component Eφ, or

both. The dialog ensures that at least one polarization component is selected.

The remaining controls of this dialog are explained in Sec. 74.1.

74.5.5 Raw Data Detector

Availability

Optical Setups: General Optical Setup, Grating Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Detectors > Field Visualization > Raw Data Detector

A Raw Data Detector gives the raw field data at the position where it is placed. These raw data can be either

equidistant or non-equidistant. Its edit dialog (↪→Fig. 593) allows you to preset several view settings like the

visible region for equidistant data.

Figure 593. Dialog with the Settings for the Raw Data Detector.

The Use for One-Dimensional Fields adapts the dialog to either one-dimensional or two-dimensional harmonic

fields.

If you click on the Copy from ... button a dialog appears where you can select any open Harmonic Field or

Harmonic Fields Set document. The view settings of this document determine the values within the dialog (the

visible region specifies the settings for the View Size).

Furthermore there are two tab pages.

The General tab of the dialog (↪→Fig. 593) has the following controls:
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ITEM DESCRIPTION

Sample Linear Phase Flag that indicates whether the analytically stored linear phase of the input

field shall be sampled. If this option is not selected the linear phase is re-

moved from the field and an information about the removed linear phase term

is plotted into the Messages tab of the VirtualLab Fusion main window.

Sample Quadratic Phase Flag that indicates whether the analytically stored quadratic phase of the input

field shall be sampled. If this option is not selected the quadratic phase is

removed from the field and an information about the removed quadratic phase

term is plotted into the Messages tab of the VirtualLab Fusion main window.

Light View / Data View Sets whether light view or data view shall be visible in the resulting field and

adapts the dialog accordingly.

Use Cubic Interpolation If checked, the cubic interpolation for the view (↪→Sec. 11.2.1) is used.

Display Mode You can choose either Visual Perception or Linear Intensity Detector.

↪→Sec. 12.2.1

Field / Polarization Quan-

tity

Either the Field Quantity (↪→Sec. 11.1) or the eccentricities or angles of the

polarization ellipses (↪→Fig. 12.2.2.3) can be displayed by the Raw Data De-

tector.

Vectorial Component /

Combined Component

Depending on the selected Field / Polarization Quantity, you can either select

the Vectorial Component (for Field Quantities except Summed Squared Am-

plitudes, ↪→Sec. 12.2.2.2) or the Combined Component for Summed Squared

Amplitudes (↪→Sec. 11.1).

This control is not visible if Polarization Eccentricities or Polarization Angles

are set as Field / Polarization Quantity.

Show Polarization El-

lipses

If neither Polarization Eccentricities nor Polarization Angles are selected as

Field / Polarization Quantity, polarization ellipses can be shown as overlay in

the view (see Fig. 91 for an example).

Polarization Plane Actually, the field vector at a certain point describes a polarization ellipse in the

plane perpendicular to the propagation direction. For clarity, VirtualLab Fu-

sion only shows polarization ellipses which result from projecting this ellipse

onto one of the coordinate planes. This Polarization Plane can be defined

by the user if polarization ellipses are shown – either as Show Polarization

Ellipses overlay or as Field / Polarization Quantity.

Color Palette For the Data View or the Linear Intensity Detector mode of the Light View, you

can choose one out of several color tables (↪→Sec. 11.2.4). This color table

is used for the shown mode and the shown field quantity only. All other color

tables are taken from the Global Options dialog (↪→Sec. 6.9).

Physical Aspect Ratio /

Free Aspect Ratio

The Aspect Ratio (↪→Sec. 11.5) used for displaying the field.

Show Whole Field If checked, it is not zoomed into the field, i. e. you will see the whole field.

Thus, Center Position and View Size are disabled.

Center Position These two text boxes allow you to specify the center (x- and y-position) of the

region you want to see. If you have checked Use for One-Dimensional Fields

only one text box is shown.
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View Size These two text boxes allow you to specify the size in x- and y-direction of the

region you want to see. If you have checked Use for One-Dimensional Fields

only one text box is shown.

The Graphic Tools page (↪→Fig. 594) allows you to preset the visibility, position and extension (if applicable) of

the three marker types (↪→Sec. 11.3). If you have checked Use for One-Dimensional Fields only one input box

is shown for all entries and a profile line cannot be specified.

Figure 594. Graphic Tools page of the Raw Data Detector dialog.

The remaining controls of this dialog are explained in Sec. 74.1. Note that in a Grating Optical Setup the Raw

Data Detector cannot be tilted and shifted.

For data view settings which are not set by this dialog, always the settings from the Global Options

dialog (↪→Sec. 6.11) are taken into account. This applies for e.g. the Artifacts Threshold and the Scaling

of the polarization ellipses.

74.6 Merit Functions

74.6.1 Beam Parameters

Availability

Toolboxes: All

Accessible:

• Optical Setup: Detectors > Basic Detectors > Beam Parameters

• Ribbon: Detectors > Beam Parameters

The beam parameters of a wave are calculated based on the second momentum theory (↪→Sec. 137.1).

If the ribbon item Detectors > Beam Parameters is clicked the dialog shown in Fig. 595 will appear. The

following beam parameters can be calculated (for the underlying formulas see Sec. 137.1):
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ITEM DESCRIPTION

Diameter X The diameter measured from the optical axis along the x-axis.

Diameter Y The diameter measured from the optical axis along the y-axis.

Waist Diameter X The waist diameter measured from the optical axis along the x-axis.

Waist Diameter Y The waist diameter measured from the optical axis along the y-axis.

Full Divergence Angle X The full angle of divergence angle measured from the optical axis along the

x-axis.

Full Divergence Angle Y The full angle of divergence angle measured from the optical axis along the

y-axis.

Waist Distance X The distance of the present z-position of the wave from the waist measured

along the x-axis.

Waist Distance Y The distance of the present z-position of the wave from the waist measured

along the y-axis.

M2-Parameter in

x-Direction

The M2 parameter of the wave measured along the x-axis.

M2-Parameter in

y-Direction

The M2 parameter of the wave measured along the y-axis.

Centroid X The x-position of the centroid.

Centroid Y The y-position of the centroid.

RotationAngle of the Prin-

cipal Axis

The angle between the principal axis of the wave and the x-axis.

Figure 595. Edit dialog if the Beam Parameters detector is used in the main window.

The edit dialog of this detector (↪→Fig. 595) offers the following settings:
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ITEM DESCRIPTION

Vectorial Component Selects the complex amplitude (Ex or Ey) for which the beam parameters shall

be calculated.

Beam Parameters This section of the dialog allows you to select the beam parameters to be

evaluated. With the Selection Tools you can Select All entries or Unselect All

entries.

Calculate Beam Parame-

ters Relative to the Cen-

troid

If checked, then in a first step always the centroid of the wave is determined

and in a second step all beam parameters are calculated relative to the cen-

troid.

Calculate Beam Parame-

ters Relative to the Princi-

pal Axis.

If not checked all beam parameters are calculated along the x- and y-axis. If

checked, then in a first step the rotation angle of the principal axis of the wave

measured to the x-axis is determined. In a second step all beam parameters

are calculated relative to the principal axis and not to the x- and y-axis.

Refine Sampling to Fully

Sampled Spherical Phase

Harmonic fields may contain analytical spherical phase factors. In the parax-

ial case, the detector truly accounts for the spherical phase without actually

measuring it on the sampling points of the field. In the non-paraxial case,

analytical spherical phase factors must be sampled in a correct manner in

order to ensure an unbiased evaluation of the beam parameters. If checked,

VirtualLab Fusion is forced to interpolate the field for a lossless sampling of

the spherical phase factor. In presence of a spherical phase factor with small

radius this option can dramatically increase the computing time and memory

resources needed.

This option has an effect only for Classic Field Tracing or in the main win-

dow. To get the analogous behavior for General Profile, you should activate

the option Scale Sampling Distance by Oversampling Factor on the Detector

Window and Resolution tab (↪→Sec. 74.1.1). Then the sampling is refined to

completely sample the analytic quadratic phase of the field.

Values having less than…

of the maximum intensity

are ignored.

For mathematical reasons the beam parameters detector is very sensitive to

noise which can change the results by a factor 10 or more. Thus this setting

allows you to ignore all field values having less than the given percentage of

the maximum squared amplitude in the field.

You can set this value to zero to switch off this noise filtering.

Fig. 595 shows how the edit dialog looks like if the detector is used in the main window. If this detector is used

in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).

74.6.2 Diffractive Optics Merit Functions

Availability

Toolboxes: All

Accessible:

• Optical Setup: Detectors > Basic Detectors > Diffractive Optics Merit Functions

• Ribbon: Detectors > Diffractive Optics Merit Functions

Diffractive Optics Merit Functions are a collection of merit functions that are typically used to evaluate beam
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shaping, beam splitting and light diffusing systems. VirtualLab Fusion supports the following merit functions.

The corresponding formulas are given in Sec. 137.2.

ITEM DESCRIPTION

Window Efficiency The part of the paraxial power of the input field diffracted inside the signal

region.

Conversion Efficiency The part of the paraxial power of the input field diffracted in the part of the

signal that is inside the signal region. Noises inside the signal region are

ignored.

Signal to Noise Ratio

(SNR)

The strength of the signal relative to the noises measured in dB.

Uniformity Error The maximum deviation of the output field squared amplitude from the signal

field squared amplitude inside the signal region.

Relative Zeroth Order In-

tensity

The paraxial intensity of a field component (squared amplitude) of the ze-

roth order of the output field related to somewhat like the mean value of the

intensities of the desired output orders.

Zeroth Order Efficiency The part of the paraxial power of the input field diffracted into the zeroth order.

Maximum Relative Inten-

sity of Stray Light

The relative maximum intensity outside of the signal region.

Optimal Scale Factor A real valued or complex scaling factor between the complex amplitude of

the output field in the signal region and the complex amplitude of the desired

output field. The optimal scale factor is typically used for the calculation of

the most standard merit functions.

Thesemerit functions can be calculated via Detectors > Diffractive OpticsMerit Functions or in anOptical Setup.

Most of the Diffractive Optics merit functions can also be logged during the IFTA optimization (↪→Sec. 97).
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Figure 596. Edit dialog if the Diffractive Optics Merit Functions detector is used in the main window.

The edit dialog of this detector (↪→Fig. 596) offers the following settings:

ITEM DESCRIPTION

Vectorial Component Selects the vectorial component (Ex or Ey) for which the merit functions shall

be calculated.

Selected Merit Functions Allows the selection of the standard merit functions that shall be calculated.

With the Selection Tools you can Select All entries or Unselect All entries.

Desired Output Field Allows the selection of the desired output field used for the calculations.

Evaluation Region Mode Allows you to define the way how the Evaluation Region is determined. There

are four possibilities:

1. Arbitrary Evaluation Region: Allows you to Set an arbitrary harmonic

field as evaluation region.

2. Create from Desired Output Field: The chosen Vectorial Component

of the Desired Output Field is used as evaluation region, whereby all

absolute values larger than zero are taken into account for computing

the merit functions.

3. Equal to Incident Field Selection: If you choose this option (which is

only available in the main window), you must select an open harmonic

field document as Incident Field. The evaluation region is then created

from the physical coordinates of the selection in this field.

4. Equal to Desired Output Field Selection: If you choose this option

(which is only available in the main window), you must select an open

harmonic field document as Desired Output Field. The evaluation re-

gion is then created from the physical coordinates of the selection in

this field.
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Evaluation Region If you have chosen Arbitrary Evaluation Region as Evaluation Region Mode,

the Set button allows to either

• Load a suitable Complex Amplitude File from hard disc or

• select a harmonic field document which is already opened in the main

window.

The Show button allows you to to view the currently set evaluation region.

Allow Scale Freedom If checked the scale factor (↪→Sec. 138.1.1) is calculated for all merit functions

calculations, otherwise the scale factor is set to one.

Signal Type Sets the specific type of the signal, i. e. for which field quantity the merit

functions are being evaluated. Can be either Amplitude, Squared Amplitude,

Complex Amplitude or Phase.

Efficiency Related to Inci-

dent Field of Optical Sys-

tem

If this item is checked all efficiency calculations are related to the power of the

incident field. In this way, possible energy losses in the optical system (e. g.

caused by absorption or reflection) can be considered.

If this detector is used in the Optical Setup, the incident field is the field directly

after the light source. If this detector is used in the main window, you can

define an arbitrary Incident Field.

Incident Field O M W .

There are two buttons to define an arbitrary incident field. The Set button

allows you to either

• Load a suitable Complex Amplitude File from hard disc or

• select a suitable document which is already opened in the main window.

In both cases the set incident field must be a spatial harmonic field.

The Show button allows you to to view the currently set incident field.

Fig. 596 shows how the edit dialog looks like if the detector is used in the main window. If this detector is used

in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).

74.6.3 Multimode Fiber Coupling Efficiency

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Merit Functions > Multimode Fiber Coupling Efficiency

This detector calculates how much of the incident light can couple into either a step-index fiber or a gradient

index fiber. This evaluation is done per wavelength.
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Figure 597. The edit dialog for the Multimode Fiber Coupling Efficiency detector.

Its edit dialog (↪→Fig. 597) has the following settings.
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ITEM DESCRIPTION

Mode Type Allows you to select between Linearly Polarized Bessel modes which occur

in step-index fibers and Linearly Polarized Laguerre modes which occur in

gradient index fibers.

Efficiency Related to

Source Field

If this item is checked the calculated efficiency will be related to the power

of the field directly after the light source. This means that the efficiency will

become smaller due to e. g. absorption and reflections in the optical setup.

Core Diameter The core diameter d of the fiber.

Core Material Allows you to set the material in the fiber core with the control described in

Sec. 34.3. Only the real-valued refractive index ncore(λ) is used.

Cladding Material O L P B

Allows you to set the material of the fiber cladding with the control described

in Sec. 34.3. Only the real-valued refractive index ncladding(λ) is used.

Gradient Constant O L P L

For gradient index fibers the refractive index distribution is given by

n2(r) = ncore(λ)2

(
1− 2∆

(
r
r0

)2
)

(74.3)

whereas ncore is the refractive index in the center given by the Core Material;
r0 = d/2 is the core radius; and ∆ is the gradient constant.

Maximum Azimuthal Or-

der /

Maximum Radial Order

Defines how many modes are considered for the calculation of the coupling

efficiency.

Validity This control indicates whether the current configuration is valid, ↪→Sec. 5.10.

Error messages can be shown in a separate dialog.

For example it is checked that the modes are not cut off, which would be the

case if the cutoff parameter V = π/λ · d
√

n2
core − n2

cladding
is less than 1. Also

V > 300 is not practical.

74.6.4 Power

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Detectors > Merit Functions > Power
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Figure 598. The edit dialog for the power detector.

This detector calculates the power P in watts, either for the complete field in the detector plane or for a region

of it. It is calculated via

P = n
ε0

2
c ∑

i
∆i · A2

i . (74.4)

n is the refractive index derived from the embedding medium of the field, ε0 is the dielectric constant and c is
the vacuum speed of light. Ai is the squared amplitude of the data point i and ∆i is the area this data point

occupies (sampling distance in x-direction times sampling distance in y-direction for equidistant data).

ITEM DESCRIPTION

Vectorial Components to

Evaluate

You can select any combination of Ex-Component, Ey-Component, and Ez-

Component. The dialog ensures that at least one vectorial component is se-

lected. The squared amplitudes of all selected components are summed up

to the Ai in Eq. (74.4).

The remaining controls of this dialog are explained in Sec. 74.1.

74.6.5 Pulse Evaluation

Availability

Optical Setups: General Optical Setup

Accessible: Optical Setup: Detectors > Merit Functions > Pulse Evaluation

This detector combines several settings for both the evaluation of pulses (↪→Sec. 74.6.5.1) and of the optical

path length for distinct wavelengths (↪→Sec. 74.6.5.2).

A validity control in the bottom left corner (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further information.

The remaining controls of this dialog are explained in Sec. 74.1.

74.6.5.1 Pulse Evaluation

The actual Pulse Evaluation tab page (↪→Fig. 599) allows you to plot the field data of a polychromatic fields set

over wavelength and over time. In this way you can examine the pulse shape if the incoming harmonic fields

set represents a laser pulse.

To this end, you can choose to extract the field

1. at a specific position, resulting in 1D Data Arrays with wavelength / time being the x-axis,

2. at a line, resulting in 2D Data Arrays with wavelength / time being the x-axis, and / or
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3. at a specific region, resulting in 2D Data Arrays with one subset per wavelength / time value. Out of such

a data array, an animation can be generated using Manipulations > Create Animation

Figure 599. The settings for the actual pulse evaluation, here for the Pulse (3D) mode.

More specifically, the Pulse Evaluation tab page has the following options:

ITEM DESCRIPTION

Vectorial Component to

Evaluate

You can select at least one of the vectorial components Ex, Ey, and Ez. For

each selected vectorial component separate data arrays are shown.

Oversampling Factor With this factor you can adjust the sampling and thus the accuracy in the time

domain. A higher oversampling factor leads to a smaller sampling distance.

Exclude Time Shift The pulse needs a certain time ts to propagate through the system. If you

check this option, the shown pulse reaches its peak at the time ts. Otherwise
the pulse is centered around the time of 0 s. The time ts is the time shift as
calculated by the set Fit Method for Evaluation.

Extend Time Window If you check this option, an oversampling in frequency domain is introduced

depending on the settings on the Frequency Sampling on the Optical Path

Length Evaluation tab. The residuals of the fitted linear phase function and

the correct phase function are used for this oversampling. Thus the set Fit

Method for Evaluation also alters the effect this setting.

An oversampling in frequency domain leads to an embedding in time domain,

thus a larger time window is shown.
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Fit Method for Evaluation Allows you to select any of the three fit methods explained in Sec. 74.6.5.2.

The fit method influences the effect of Exclude Time Shift and Extend Time

Window.

Pulse at Point (1D) On this tab page you can select and configure the Evaluation of Pulse at Point

(1D). This means you extract the field data at a specific Position (x,y) PV re-

sulting in 1D Data Arrays with wavelength / time being the x-axis.

If you click theCopy From… button, you can select a document window show-

ing two-dimensional (field) data from whose point marker (↪→Sec. 11.3) the

new Position (x,y) is taken.

For the 1D evaluation, you can also choose to calculate the Minimum, Maxi-

mum and / or Full Width Half Maximum of the resulting data arrays.

Pulse at Line (2D) On this tab page you can select and configure the Evaluation of Pulse at Line

(2D). This means you extract the field data at a certain line (defined by Start

Point (x,y) and End Point (x,y)). The result of this evaluation are 2D Data

Arrays with wavelength / time being the x-axis.

If you click theCopy From… button, you can select a document window show-

ing two-dimensional (field) data fromwhose line marker (↪→Sec. 11.3) the new

Start Point (x,y) and End Point (x,y) are taken.

Pulse (3D) On this tab page you can select and configure the Evaluation of Pulse (3D).

This means you extract the field data from a certain region (defined by Center

Point PV and Size). The result of this evaluation are 2D Data Arrays with one

subset per wavelength / time value.

If you click the Copy From… button, you can select a document window

showing two-dimensional (field) data from whose rectangle or ellipse marker

(↪→Sec. 11.3) the new Center Position and Size are taken.

As the 3D evaluation can be quite costly, you can adjust the sampling defining

either the Resolution or the number of Sampling Points.

74.6.5.2 Optical Path Length Evaluation

As explained in Sec. 74.6.5.1, the pulse evaluation depends on a fit method. This refers to several methods

of fitting a linear function to optical path lengths (or more precisely: absolute phases) versus frequency ν. The

Optical Path Length Evaluation tab (↪→Fig. 600) allows you to configure the Pulse Evaluation detector so that it

shows these fitted functions.



CHAPTER 74. DETECTORS IN THE OPTICAL SETUP 707

Figure 600. The settings for the optical path length evaluation.

ITEM DESCRIPTION

Evaluate Optical Path

Length

This checkbox defines whether the optical path length over the frequencies ν

shall be shown.

Evaluate Phase by Optical

Path Length

This checkbox defines whether the absolute versus the frequencies ν shall

be shown.

Fit I: Time Shift without

Dispersion

The first type of linear fit does not consider dispersion effects in the optical

system the detector is placed in. The user can specify whether the fitted

linear function shall be drawn additionally in the phase diagram and whether

the residuals shall be evaluated.

Fit II: Time Shift by Re-

gression

The second type of linear fit does consider dispersion effects in the optical

system the detector is placed in. The dispersion effect is fitted by a linear

regression to the absolute phase curve. The user can specify whether the

fitted linear function shall be drawn additionally in the phase diagram and

whether the residuals shall be evaluated.

Fit III: Time Shift with Dis-

persion

The third type of linear fit does consider dispersion effects in the in the optical

system the detector is placed in. The dispersion effect is evaluated by the

group velocity of the pulse. The user can specify whether the fitted linear

function shall be drawn additionally in the phase diagram and whether the

residuals shall be evaluated.
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Automatic Sampling VirtualLab Fusion estimates the frequency sampling for the selected light

path. The calculated oversampling factor will be logged into the logging win-

dow of VirtualLab Fusion.

Manual Sampling The manual sampling mode allows the user to enter a self-defined Oversam-

pling Factor (Frequencies).

Oversampling Factor (Fre-

quencies)

ForManual Sampling the oversampling factor can be configured to use more

frequencies for the OPL analysis. This oversampling factor will also influence

theExtend TimeWindow option on thePulse Evaluation tab (↪→Sec. 74.6.5.1).

Figure 601. Resulting diagrams of the Optical Path Length Evaluation of a sample Optical Setup.

Fig. 601 shows some sample results generated by the Optical Path Length Evaluation tab.

The slopes of the fitted linear functions give the time shift, i. e. the time the pulse needed to propagate through

the (sub-)system. The Optical Path Length Evaluation logs the obtained time shifts into the detector window

(one per selected fit method), see Fig. 602 for an example. The time shifts can be used for further investigations

of pulses in VirtualLab Fusion, especially for the temporal Fourier Transformation (↪→Sec. 31.2.1).

The residual functions calculated by the Optical Path Length Evaluation can be used to increase the time

window for the Inverse Temporal Fourier Transformation, see Sec. 31.2.1.

Figure 602. The slope of the linear fits is logged into the Detector Results tab of the VirtualLab Fusion main window.

74.6.6 Singlemode Fiber Coupling Efficiency

Availability

Toolboxes: All

Accessible:

• Optical Setup: Detectors > Basic Detectors > Singlemode Fiber Coupling Efficiency

• Ribbon: Detectors > Fiber Coupling Efficiency

This detector allows the calculation of the coupling efficiency of the incident field into a single mode fiber.

Actually this function does not calculate the modes of a fiber. The fiber mode must be specified separately. For

a description of the physical background see Sec. 137.3.
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Figure 603. Dialog for the calculation of the fiber coupling efficiency of a harmonic field in the main window.

The edit dialog of this detector (↪→Fig. 603) offers the following settings:

ITEM DESCRIPTION

Specify Gaussian Mode

Field

If you check this option, a Gaussian mode field is calculated directly from

either the numerical aperture of the fiber or the diameter of the fiber mode.

Fiber NA PV Allows you to enter the numerical aperture of the fiber if you want to Specify

Gaussian Mode Field.

Mode Field Diameter

(1/e^2) PV

Allows you to enter the 1/e2 diameter of the Gaussian mode field.

Specify Customized Mode

Field

Instead of specifying a Gaussian mode field you can also use an arbitrary

Mode Field.

Mode Field There are two buttons to define an arbitrary mode field. The Set button allows

you to either

• Load a suitable Complex Amplitude File from hard disc or

• select a suitable document which is already opened in the main window.

In both cases the set mode field must be a spatial harmonic field.

The Show button allows you to to view the currently set mode field.

Efficiency Related to Inci-

dent Field of Optical Sys-

tem

If this item is checked the calculated efficiency will be related to the power of

the incident field. In this way, possible energy losses in the optical system

(e. g. caused by absorption or reflection) can be considered.

If this detector is used in the Optical Setup, the incident field is the field directly

after the light source. If this detector is used in the main window, you can

define an arbitrary Incident Field.

Incident Field O M W .

There are two buttons to define an arbitrary incident field. The Set button

allows to either

• Load a suitable Complex Amplitude File from hard disc or

• select a suitable document which is already opened in the main window.

In both cases the set incident field must be a spatial harmonic field.

The Show button allows you to to view the currently set incident field.

Fig. 603 shows how the edit dialog looks like if the detector is used in the main window. If this detector is used

in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).
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74.6.7 Spot Size

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Merit Functions > Spot Size

Figure 604. The edit dialog of the Spot Size detector.

This detector can be used to measure the spot size of the incident beam with different measurement algorithms.

For Classic Field Tracing and General Profile the beam diameter algorithms of the beam parameters detector

are used (↪→Sec. 74.6.1), whereas for locally polarized fields the amplitudes of Ex and Ey are summed up. For

Ray Results Profile the user can select whether he likes to measure the RMS or the peak value of the incident

ray bundle.

The edit dialog (↪→Fig. 604) of this detector has the following options.
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ITEM DESCRIPTION

Evaluation of All Modes

Together

If this option is checked, all modes are regarded as one ensemble for which

one spot size is determined.

Evaluation of All Modes

Separately

If this option is checked, the spot size is determined separately for each indi-

vidual mode.

Use Centroid as Refer-

ence

Flag whether the spot size is measured relatively to the centroid of the field.

If this option is not selected, the position of the central ray (General Profile

and Ray Results Profile) or the center of the field (Classic Field Tracing) will

be used as reference.

Refine Sampling to Fully

Sampled Spherical Phase

Harmonic fields may contain analytical spherical phase factors. If this option

is checked, VirtualLab Fusion is forced to interpolate the field for a lossless

sampling of the spherical phase factor. In presence of a spherical phase

factor with small radius this option can dramatically increase the computing

time and memory resources needed.

Values having less than…

of the maximum intensity

are ignored.

For mathematical reasons the beam parameters detector is very sensitive to

noise which can change the results by a factor 10 or more. Thus this setting

allows you to ignore all field values having less than the given percentage of

the maximum squared amplitude in the field.

You can set this value to zero to switch off this noise filtering.

Detect RMS The user can select whether the RMS definition shall be used for size mea-

surement.

Detect Peak Value The user can select whether the peak value definition shall be used for size

measurement.

Measure Radial Spot Size Option for the detection of the RMS or peak value. If this option is selected

the radial size is determined by the detector and thus the detector generates

only one output value for the size. If this option is not selected the detector

will calculate the RMS or peak value separately for x- and y-direction.

The remaining controls of this dialog are explained in Sec. 74.1.

74.6.8 Uniformity Detector

Availability

Optical Setups: Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Merit Functions > Uniformity Detector

This detector calculates the average summed squared amplitude Ii within small pupils around various positions

ρi. The pupils all have the same size and shape (rectangular or elliptical). From these Ii the following values

are calculated:

• The minimum value Imin and the maximum value Imax
• Uniformity error U = Imax−Imin

Imax+Imin
• Arithmetic mean and standard deviation .
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Figure 605. The edit dialog of the Uniformity Detector.

The edit dialog (↪→Fig. 605) has the following settings.
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ITEM DESCRIPTION

Summation Type If there is more than one coherent mode, the overlaying modes can be added

coherently, incoherently, or partially coherently. For the latter you can specify

the degree of coherence by entering a Coherence Time PV (or copying it from

a Coherence Time & Length Calculator ↪→Sec. 105). This setting has no effect

for Classic Field Tracing as this engine only supports incoherent modes.

Pupil Parameters Here you can define Shape and Size PV of the pupils.

Pupil Positions from Cen-

tral Rays /

Pupil Positions on Grid

If the first option is checked the positions of the pupils are determined au-

tomatically from the central rays of the incident ray bundles. Otherwise you

can define an equidistant rectangular grid on which the pupils are placed.

This grid is centered around the origin of the field.

Pupil Grid O P P G .

Here you can define the Number of Pupils PV and the Distance PV of the pupils

for both x- and y-direction. Note that the defined grid is always centered

around the origin of the detector coordinate system. Thus is not influenced

by the position of the detector window (↪→Sec. 74.1.1).

Preview O P G .

A preview of the lateral distribution of the pupils on the grid. If pupils are lying

outside the detector window, this will be indicated.

Diagram Output If checked, an additional diagram output will be generated.

O D O .

If pressed, a dialog for configuring the shown Distribution of Pupils With Val-

ues as described in Sec. (a).

74.7 Point Evaluation

74.7.1 Two Point Contrast

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Detectors > Point Evaluation > Two Point Contrast
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Figure 606. The dialog for the Two Point Contrast detector.

This detector allows you to calculate the contrast between the values (a certain field quantity of a certain

vectorial component) at two specified positions in the detector plane. If V1 is the larger value and V2 the smaller

one, the contrast C is defined by

C =
V1 −V2

V1 + V2
. (74.5)

On the Detector Parameters tab page of its dialog (↪→Fig. 606), the following settings can be made.

ITEM DESCRIPTION

Position 1 PV The first position in physical coordinates. With the Copy From button you can

copy the physical position from the Point Manipulation Cross of the selected

harmonic field or harmonic field set.

Position 2 PV The second position in physical coordinates. With the Copy From button you

can copy the physical position from the Point Manipulation Cross of the se-

lected harmonic field or harmonic field set.

Field Quantity The Field Quantity (↪→Sec. 11.1) for which the contrast is calculated.

Vectorial Component /

Combined Component

Depending on the selected Field Quantity, you can either select the Vecto-

rial Component (↪→Sec. 12.2.2.2) or the Combined Component (for Summed

Squared Amplitudes, ↪→Sec. 11.1).

The remaining tab pages are explained in Sec. 74.1.

74.7.2 Value Monitoring

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Detectors > Point Evaluation > Value Monitoring
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Figure 607. The dialog for the Value Monitoring detector.

This detector calculates a value (a certain field quantity of a certain vectorial component) at a specific position

in the detector plane. To this end a pointwise sinc interpolation is used in case of Classic Field Tracing.

It can be especially helpful for the Parameter Run (↪→Sec. 44). On the Detector Parameters tab page of its

dialog (↪→Fig. 607), the following settings can be made.

ITEM DESCRIPTION

Detect Value at PV The position in physical coordinates for which the specified Field Quantity and

component shall be given.

Copy From You can copy the physical position from the Point Manipulation Cross of the

selected harmonic field or harmonic field set.

Field Quantity The Field Quantity (↪→Sec. 11.1) which shall be shown.

Vectorial Component /

Combined Component

Depending on the selected Field Quantity, you can either select the Vecto-

rial Component (↪→Sec. 12.2.2.2) or the Combined Component (for Summed

Squared Amplitudes, ↪→Sec. 11.1).

The remaining tab pages are explained in Sec. 74.1.

74.8 Wavefront Detectors

These detectors all evaluate the smooth wavefront and thus allow to remove an off-axis spherical phase from

the phase of a field. To this end the control described in Sec. 74.8.1.

They are evaluated per mode, in case of locally polarized fields the wavefront of the vectorial component (Ex

or Ey) with the larger power is used.

Assume Geometric Field Zone for Detector Evaluation is always checked for these detectors as a wavefront is

only well defined if there are no diffraction effects.

74.8.1 Control for Setting the Reference Wavefront

Figure 608. The control for setting the reference wavefront.

This control (↪→Fig. 608) allows you to define a reference wavefront which is subtracted from the incident field

prior to further analysis. It has the following settings.
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ITEM DESCRIPTION

Constant Phase The phase front is evaluated unchanged. (The Piston coefficient of the

Zernike & Seidel Aberrations Detector (↪→Sec. 74.8.5) contains the average

phase.)

This mode has no additional parameters.

Linear Phase The average phase and a possible linear phase is subtracted from the phase

front before the actual evaluation. In this case you have two Determination

options for the linear phase: Fitted Direction and User-Defined Direction; see

table below.

Spherical Phase An off-axis spherical phase is subtracted from the phase front before the ac-

tual evaluation. In this case you have three Determination options for the

radius and the origin of the spherical phase: Fitted Radius and Origin, User-

Defined Radius at Optimized Origin, and User-Defined Radius and Origin;

see table below.

DETERMINATION MODE DESCRIPTION

Fitted Direction /

Fitted Radius and Origin

All parameters are determined automatically by VirtualLab Fusion.

User-Defined Direction F L P

The average phase is determined by VirtualLab Fusion. The Linear Phase

is entered by the user as Cartesian angles α and β. The direction in other

direction conventions can be copied from a Direction Converter (↪→Sec. 108)

using the From Calculator button.

User-Defined Radius at

Optimized Origin

F S P

The average phase and the origin of the spherical phase are determined by

VirtualLab Fusion. The Phase Radius is entered by the user.

User-Defined Radius and

Origin

F S P

The average phase is determined by VirtualLab Fusion. The Phase Radius

and the Origin of the spherical phase are entered by the user. As mathemat-

ically a spherical phase with an offset corresponds to a spherical phase plus

a linear phase, you can also enter Linear Phase (α, β) instead of Origin (x, y).

If you want to enter the direction in another convention than Cartesian angles

α and β you can use the From Calculator button to copy it from a Direction

Converter (↪→Sec. 108).

74.8.2 Polynomial Aberrations Fit

Availability

Optical Setups: General Optical Setup & Light Guide Optical Setup

Accessible: Optical Setup: Detectors > Wavefront Detectors > Polynomial Aberrations Fit
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Figure 609. Dialog for the calculation of a polynomial phase or aberrations approximation in the main window (via Detec-

tor from Catalog; ↪→Sec. 75.1).

This detector performs a least squares polynomial fit to the phase of the evaluated harmonic field with selectable

degree of the polynomial (between 1 and 12, inclusively).

Its edit dialog (↪→Fig. 609) has the following settings:

ITEM DESCRIPTION

Polynomial Degree The maximal exponent sum m + n of the basis monomials xm · yn to be used.

{Reference Wavefront} PE This control is explained in Sec. 74.8.1.

Maximum Number of Data

Points Used For Fitting PV

For fields with many sampling points or rays fitting can be very time consum-

ing. Thus by default only 1000 random data points with non-zero amplitude

are extracted from the mode. But you can change this for speed up or con-

vergence tests.

Phase Fitted by Polyno-

mial /

Aberrations Fitted by

Polynomial

If checked, the fitted polynomial is displayed in a data array.

Difference of Phase to

Polynomial Fit /

Difference of Aberrations

to Polynomial Fit

If checked, the difference of the original phase (relative to reference wave-

front) to the fitted phase of the selected field, i. e. the fitting error, is displayed

in a data array.

Phase Radius & Origin O O R O

The phase radius and the origin of the spherical phase are given as detector

results.

Origin O U -D R O O

The origin of the spherical phase is given as detector result.

Fig. 612 shows how the edit dialog looks like if the detector is used in the main window. If this detector is used

in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).
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74.8.3 RMS of Phase

T W E (↪→S . 74.8.4)

.

Figure 610. Dialog for the calculation of the root mean square of the phase in the main window.

This detector enables the user to calculate the Root Mean Square (RMS) of the phase.

If used in the main window the dialog shown in Fig. 610 will appear. The following table gives an overview over

the possible settings of the dialog:

ITEM DESCRIPTION

Unwrap Phase Phase is unwrapped before RMS calculation.

Apply Weighting If checked, the phase values are weighted according to the corresponding

amplitude or squared amplitude.

{Reference Wavefront} PE This control is explained in Sec. 74.8.1.

Subtract Average Phase Average phase is subtracted before RMS calculation.

If this detector is used in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).

74.8.4 Wavefront Error

Availability

Optical Setups: General Optical Setup, Light Guide Optical Setup, and Laser Resonator Optical Setup

Accessible: Optical Setup: Detectors > Wavefront Detectors > Wavefront Error

This detector calculates the deviation of the wavefront in the incoming field distribution from a reference wave-

front (in wavelengths).

For the simulation engines General Profile and Ray Results Profile, the evaluation is done per coherent mode.
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Figure 611. The dialog for the Wavefront Error detector.

On the Detector Parameters tab page of its dialog (↪→Fig. 607), the following settings can be made.

ITEM DESCRIPTION

{Reference Wavefront} PE This control is explained in Sec. 74.8.1.

Data Arrays The deviation of the phase from the reference wavefront is given as data

array. It is given inmultiples of the wavelength and as one subset per coherent

mode.

Peak-to-Valley The peak-to-valley value (i. e. the maximum deviation minus the minimum

deviation) of the wavefront error is output. It is given in multiples of the wave-

length and as one value per coherent mode.

RMS The root mean square of the wavefront error is output. It is given inmultiples of

the wavelength and as one value per coherent mode. You can either apply a

Weighting by Amplitude or by Squared Amplitude to ensure that phase values

from almost dark regions of the field do not influence the resulting RMS value.

Phase Radius & Origin O O R O

The phase radius and the origin of the spherical phase are given as detector

results.

Origin O U -D R O O

The origin of the spherical phase is given as detector result.

The phase radius is the distance between the detector plane and the source plane of the spherical phase. The

remaining controls are explained in Sec. 74.1.
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74.8.5 Zernike & Seidel Aberrations Detector

Availability

Toolboxes: All

Accessible:

• Optical Setup: Detectors > Basic Detectors > Zernike Fringe / Seidel Aberrations

• Ribbon: Detectors > Zernike Fringe / Seidel Aberrations

This detector allows the calculation of the Zernike fringe, Zernike standard, and Seidel aberrations within a

circular pupil. They refer to wavelengths. For example a Zernike fringe tilt of 1 corresponds to phase values in

the range −1λ(= −2π) . . . + 1λ(= +2π). The corresponding formulas are given in Sec. 134.2.

The evaluation is done per mode. A spherical phase factor can be separated from the phase front to be fitted.

Figure 612. Dialog of the Zernike & Seidel Aberrations Detector in the main window.

If the ribbon item Detectors > Zernike Fringe / Seidel Aberrations is clicked, the dialog shown in Fig. 612 will

appear. It allows the following settings:

ITEM DESCRIPTION

Evaluate as You can choose between Zernike Fringe Aberrations, Zernike Standard Aber-

rations, and Seidel Aberrations.

Polynomial Degree O Z S A

Allows you to set the maximum polynomial degree of the used Zernike terms,

and thus indirectly the number of coefficients to be detected.

{Reference Wavefront} PE This control is explained in Sec. 74.8.1.

Maximum Number of Data

Points Used For Fitting PV

For mode fields with many sampling points or rays fitting can be very time

consuming. Thus by default only 1000 random data points with non-zero

amplitude are extracted from the mode. But you change this for speed up or

convergence tests.
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Calculate Maximum Ra-

dial Extent

If you select this option the maximum radial extent of the fitted polynomial is

determined automatically from the smallest centered circle containing all data

points with non-zero amplitude.

Set Maximum Radial Ex-

tent

Themaximum radial extent can influence the actual coefficients of the polyno-

mial quite strongly. Thus if e. g. the aperture of a Zernike & Seidel Aberrations

Ideal Component (↪→Sec. 67.5.5) is not fully illuminated by the mode field you

can obtain unexpected results. To avoid this you can set a certain maximum

radial extent manually.

Aberrations / Phase Fitted

by Zernike Fringe / Zernike

Standard / Seidel Polyno-

mial

If checked, the unwrapped aberrations fit respective the phase fit is displayed

in a data array per mode.

Difference of Aberrations /

Phase to Zernike Fringe /

Zernike Standard / Seidel

Fit

If checked, the difference of the original phase to the fitted phase of the se-

lected field (i. e. the fitting error) is displayed in a data array per mode.

Phase Radius & Origin O O R O

The phase radius and the origin of the spherical phase are given as detector

results.

Origin O U -D R O O

The origin of the spherical phase is given as detector result.

The phase radius is the distance between the detector plane and the source plane of the spherical phase.

Fig. 612 shows how the edit dialog looks like if the detector is used in the main window. If this detector is used

in an Optical Setup, a dialog with additional controls is used (↪→Sec. 74.1).

Note that coefficients being less than 10−8 the maximum coefficient are set to zero.

75 Detectors for Harmonic Fields and Harmonic Fields Sets

Several detectors can be applied to harmonic fields or harmonic fields sets via the Detectors ribbon. If you

are in the Data View (↪→Sec. 12.2.2) of a Harmonic Fields Set you can decide whether you want to apply the

detector to all member fields or only to the currently visible one, either via a separate dialog or a checkbox

at the very bottom of the edit dialog. If you are in the Light View (↪→Sec. 12.2.1), always all member fields

are evaluated. The Camera Detector and the Complex Histogram detector are an exception: they are always

applied to all member fields.

75.1 Detector from Catalog

Via Detectors > Detector from Catalog you can apply any detector from the detector catalog (but pulse evalu-

ation detectors) on the current harmonic field or harmonic fields set.

If you click on this ribbon item, first the catalog dialog (↪→Sec. 33) opens where you can select a detector. Then

a dialog (↪→Fig. 613) with further options opens.
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Figure 613. The edit dialog for the Detector from Catalog ribbon item.

ITEM DESCRIPTION

Load Loads another detector from the catalog (↪→Sec. 33).

Edit Edits the current detector.

View Always disabled as detectors have no distinct view.

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.

Validity Indicates whether a valid detector is currently selected. ↪→Sec. 5.10

Hint

Programmable Detectors using the ParentLightPath variable cannot be used in the main window.

75.2 Physical Detectors

The following physical detectors are available for harmonic fields and harmonic fields sets in the main window.

• Beam Parameters; ↪→Sec. 74.6.1

• Diffractive Optics Merit Functions; ↪→Sec. 74.6.2

• Fiber Coupling Efficiency; ↪→Sec. 74.6.6

• Wavefront Error; ↪→Sec. 74.8.4

• Spherical Phase Radius; ↪→Sec. 137.6

• Zernike Fringe / Seidel Aberrations; ↪→Sec. 74.8.5

75.3 Field Components

75.3.1 Electric Field

This option enables you to extract the electric field components (Ex, Ey, and Ez) of a harmonic field and to store

them into different subsets of a data array.
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Figure 614. X-component of the electric field of a Gaussian wave, linearly polarized in x-direction.

75.3.2 Magnetic Field (H-Field)

This detector allows you to calculate the magnetic field components Hx, Hy, and Hz from a harmonic field. The

components of the magnetic field (Hx, Hy, and Hz) are stored in different subsets of a data array.

Figure 615. X-component of the magnetic field of a Gaussian wave, linearly polarized in x-direction.

The data array supports the configuration of view settings as described in Sec. 13.5.

The implemented formulas are given in Sec. 137.7.1.

75.3.3 Poynting Vector

This detector displays the components of the time averaged Poynting vector of a harmonic field. In the data ar-

ray contains the x-component, the y-component, and the z-component of the Poynting vector. The z-component

of the time averaged Poynting vector is in general the intensity of the electrical field. Only for paraxial fields the
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intensity is proportional to the sum of the squared amplitudes of the x- and y-field component. The components

of the averaged Poynting vector are stored in different subsets of the data array.

Figure 616. Z-component of the Poynting vector of a Gaussian wave.

The data array supports the configuration of view settings as described in Sec. 13.5.

The implemented formulas are given in Sec. 137.7.2.

75.4 Numerical Detectors

All detectors described in this section show their output in the Detector Results window. Unless otherwise

noted, they are applicable for harmonic fields, harmonic fields sets, transmissions, and signal regions.

75.4.1 Average

Via Detectors > Average the average of every field quantity (squared amplitude, amplitude, phase, real and

imaginary part) will be calculated. The average c̄ is defined by

c̄ =
1

Nx Ny

Nx ,Ny

∑
i=0,j=0

ci,j. (75.1)

Nx and Ny are the number of sampling points in x- and y-direction. ci,j stands for any field quantity of the

sampling point [i, j].

Figure 617. The edit dialog shown if the average detector is applied on harmonic fields sets.

For harmonic fields or harmonic fields sets this detector has an edit dialog (↪→Fig. 617) with the following options:
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ITEM DESCRIPTION

Vectorial Component The vectorial component to be evaluated (either Ex or Ey) can be selected.

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.

75.4.2 Complex Histogram

Creates a histogram showing how often complex numbers in certain equidistant intervals occur within a har-

monic field. The histogram shows a selectable part of the complex number plane. The creation of a one-

dimensional histogram showing just how often certain real or imaginary parts occur is also possible.

In addition it is output how many distinct values occur, i. e. how many of the intervals in the complex histogram

are non-zero. In this way you can for example count to how many levels the data was quantized.

For locally polarized fields a histogram for both the Ex- and the Ey-component of the field is generated.

Figure 618. Dialog for the Complex Histogram detector.

After the selection of this menu item the dialog shown in Fig. 618 will appear. It allows the following settings:

ITEM DESCRIPTION

Real Axis Enable Enables or disables the real axis in the complex histogram. If the real axis and

the imaginary axis are enabled a two-dimensional histogram will be created.

If one axis is disabled a one-dimensional histogram will be created.

Real Axis Min The minimum real value of all complex numbers of the harmonic field that is

taken into account for the calculation of the histogram.

Real Axis Max The maximum real value of all complex numbers of the harmonic field that is

taken into account for the calculation of the histogram.

Real Axis Steps The number of intervals used between Real Axis Min and Real Axis Max for

the creation of the histogram.

Imaginary Axis Enable Enables or disables the imaginary axis in the complex histogram. If the real

axis and the imaginary axis are enabled a two-dimensional histogram will be

created. If one axis is disabled a one-dimensional histogram will be created.

Imaginary Axis Min The minimum imaginary value of all complex numbers of the harmonic field

that is taken into account for the calculation of the histogram.
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Imaginary Axis Max The maximum imaginary value of all complex numbers of the harmonic field

that is taken into account for the calculation of the histogram.

Imaginary Axis Steps The number of intervals used between ImaginaryAxis Min and ImaginaryAxis

Max for the creation of the histogram.

Get Field Extrema Detects automatically the minimum and maximum real and imaginary value

and sets the results in the dialog.

Apply to All Fields in Har-

monic Fields Set

O H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown. If the Harmonic Fields Set contains both locally and globally

polarized fields, this option is also not shown as in this case it is not possible

to evaluate all fields at once. As both rules contradict each other, an error is

shown if both conditions are met.

75.4.3 Field Deviation

This detector provides a convenient way to calculate the absolute differences between the amplitudes and

phases of two harmonic fields or two harmonic fields sets, respectively. The results are written into different

subsets of a Data Array. For harmonic fields sets one data array per member field is returned, bundled into a

Set of Data Arrays.

This detector can be used via Detectors > Field Deviation. Then a dialog opens where you can select the

second harmonic field / harmonic fields set. In case of harmonic fields sets, the number of member fields must

be the same for the two documents. If the two fields to compare do not have the same sampling, they are

resampled to a common sampling (largest field size and smallest sampling distance).

75.4.4 Minimum / Maximum Value

Via Detectors > Minimum / Maximum Value maximum and minimum value of every field quantity and their

respective position in the field will be calculated.

Figure 619. The edit dialog shown if the minimum / maximum detector is applied on harmonic fields or harmonic fields

sets.

For harmonic fields or harmonic fields sets this detector has an edit dialog (↪→Fig. 619) with the following options:

ITEM DESCRIPTION

Vectorial Component The vectorial component to be evaluated (either Ex or Ey) can be selected.

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.
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75.4.5 Momentum

Figure 620. Dialog for momentum calculation

The dialog in Fig. 620 can be accessed via Detectors > Momentum. It has the following entries.

ITEM DESCRIPTION

Vectorial Component O

Selects the vectorial component (Ex or Ey) for which the momenta shall be

calculated.

Order X The order in x of the momentum which shall be calculated (see below).

Order Y The order in y of the momentum which shall be calculated (see below).

Order ThetaX The order in Θx of the momentum which shall be calculated (see below).

Order ThetaY The order in Θy of the momentum which shall be calculated (see below).

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.

All values have to be positive integers inclusive zero. The calculated momenta will be shown in the Detector

Results tab page.

The momentum theory is very useful to determine the beam parameters ( ↪→Sec. 74.6.1) of an arbitrary wave

with global polarization. The formulas are given in Sec. 137.8

75.4.6 Standard Deviation

Via Detectors > Standard Deviation the standard deviation σ from the average c̄ (↪→Sec. 75.4.1) can be calcu-
lated for every field quantity (squared amplitude, amplitude, phase, real and imaginary part). It is defined by

σ =

√√√√ 1
Nx Ny

Nx ,Ny

∑
i=0,j=0

(
ci,j − c̄

)2. (75.2)

Nx and Ny are the number of sampling points in x- and y-direction. ci,j stands for any field quantity of the

sampling point [i, j].

Figure 621. The edit dialog shown if the standard deviation detector is applied on harmonic fields or harmonic fields sets.
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This detector has an edit dialog (↪→Fig. 621) with the following options:

ITEM DESCRIPTION

Vectorial Component The vectorial component to be evaluated (either Ex or Ey) can be selected.

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.

75.4.7 Summed Norm

Via Detectors > Summed Norm the summed norm of the whole field component can be calculated. Additionally,

if a range or rectangle marker is visible, the summed norm within the current selection and the ratio between

these two values is calculated.

The summed norm S of a certain region is defined as the sum of the squared amplitude A2 of each pixel in this

region:

S =
Nx ,Ny

∑
i=0,j=0

A2. (75.3)

Nx and Ny are the number of sampling points in x- and y-direction, respectively. A2 is the squared amplitude of

either Ex or Ey if the data view (↪→Sec. 12.2.2) is visible or the summed intensity if the light view (↪→Sec. 12.2.1)

is visible.

Figure 622. The edit dialog of the summed norm detector.

In case this detector is applied on the data view a dialog (↪→Sec. 622) with the following options is shown:

ITEM DESCRIPTION

Vectorial Component The vectorial component to be evaluated (either Ex or Ey) can be selected.

Apply to All Fields in Har-

monic Fields Set

O (↪→S . 12.2.2) H F S

If checked, the detector is evaluated for all member fields of the Harmonic

Fields Set. Otherwise only the currently visible member field is evaluated.

In the Light View always all member fields are evaluated and thus this option

is not shown.

76 Detectors for Data Arrays

All the detectors in this section work for (gridded) Numerical Data Arrays (↪→Sec. 13.5) as well as for docu-

ment types based on gridded data arrays (chromatic fields sets [↪→Sec. 14] and pulse and field components

[↪→Sec. 15]).
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76.1 Data Point Average

Via Detectors > Data Point Average the average of one or more selected field quantities will be calculated. The

average c̄ refers to the set of all data points (instead of a unit area like m2 or mm2 or the like) and is defined by

c̄ =
1

Nx · Ny

Nx ,Ny

∑
i=0,j=0

ci,j. (76.1)

Nx and Ny are the number of data points in x- and y-direction. ci,j stands for any field quantity of the data point

[i, j].
For objects with complex-valued data or with more than one subset, a dialog opens where you can select one

or more field quantities (↪→Sec. 11.1) for which the data point average is calculated. If you select/unselect All,

all/no field quantities are selected. Furthermore, you can select whether the calculation shall be done on all of

the subsets or only on the currently visible one.

76.2 Complex Histogram

Creates a histogram showing how often complex numbers in certain equidistant intervals occur within the data.

The histogram shows a selectable part of the complex number plane. The creation of a one-dimensional

histogram showing just how often certain real or imaginary parts occur is also possible.

In addition it is output how many distinct values occur, i. e. how many of the intervals in the complex histogram

are non-zero. In this way you can for example count to how many levels the data was quantized.

Figure 623. Dialog for the Complex Histogram Detector for Data Arrays.

After the selection of this menu item the dialog shown in Fig. 623 will open. It allows the following settings:

ITEM DESCRIPTION

Evaluate Current Subset /

All Subsets

Allows to select whether the calculation shall be done for all subsets or only

for the currently visible one.

Note: If Evaluate All Subsets is selected, no Min or Max values can be en-

tered because they could strongly vary in range and meaning for the different

subsets.

Real Axis Enable Enables or disables the real axis in the complex histogram. If the real axis and

the imaginary axis are enabled, a two-dimensional histogram will be created.

If one axis is disabled a one-dimensional histogram will be created.

Real Axis Min F E C S .

The minimum real value that is used for the calculation of the histogram.
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Real Axis Max F E C S .

The maximum real value that is used for the calculation of the histogram.

Real Axis Steps The number of intervals used between Real Axis Min and Real Axis Max for

the creation of the histogram.

Imaginary Axis Enable F .

Enables or disables the imaginary axis in the complex histogram. If the real

axis and the imaginary axis are enabled, a two-dimensional histogram will be

created. If one axis is disabled a one-dimensional histogram will be created.

Imaginary Axis Min F E C S .

Theminimum imaginary value that is used for the calculation of the histogram.

Imaginary Axis Max F E C S .

The maximum imaginary value that is used for the calculation of the his-

togram.

Imaginary Axis Steps F .

The number of intervals used between ImaginaryAxis Min and ImaginaryAxis

Max for the creation of the histogram.

Get Field Extrema F E C S .

Detects automatically the minimum and maximum real and imaginary value

and sets the results into the dialog.

76.3 Full Width at Half Maximum

For real-valued data, this detector calculates the width which corresponds to half of the maximum value of a

lateral data distribution. Therefor the position of the first maximum in the field is calculated. Starting from this

position, the innermost positions are searched in both (i. e. x- and y-) directions for these positions where the

function falls below the half of the maximum value.

For objects with complex-valued data or with more than one subset, a dialog opens where you can select

one or more field quantities (↪→Sec. 11.1) for which the full width at half of the maximum is calculated. If you

select/unselect All, all/no field quantities are selected. Furthermore, you can select whether the calculation

shall be done on all of the subsets or only on the currently visible one.

76.4 Minimum / Maximum (Position and Value)

For real-valued data, this detector searches for the minimum /maximum value and the (smallest) x-(y-)position

where the minimum /maximum is reached.

For objects with complex-valued data or with more than one subset, a dialog opens where you can select one

or more field quantities (↪→Sec. 11.1) for which the minimum /maximum is calculated. If you select/unselect All,

all/no field quantities are selected. Furthermore, you can select whether the calculation shall be done on all of

the subsets or only on the currently visible one.

76.5 Standard Deviation

Via Detectors > Standard Deviation the standard deviation σ from the average c̄ (↪→Sec. 76.1) can be calculated
for one or more given field quantities. It is defined by

σ =

√√√√ 1
Nx · Ny

Nx ,Ny

∑
i=0,j=0

(
ci,j − c̄

)2. (76.2)
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Nx and Ny are the number of data points in x- and y-direction. ci,j stands for any field quantity of the data point

[i, j].
For objects with complex-valued data or with more than one subset, a dialog opens where you can select one

or more field quantities (↪→Sec. 11.1) for which the standard deviation is calculated. If you select/unselect All,

all/no field quantities are selected. Furthermore, you can select whether the calculation shall be done on all of

the subsets or only on the currently visible one.

76.6 Uniformity Error

O - .

The uniformity error detector can be applied by clicking on the ribbon item Detectors > Uniformity Error. The

user needs to specify a desired output field that is used to evaluate the uniformity error. The uniformity error

Eunif is defined as follows:

Eunif =
Qmax −Qmin

Qmax + Qmin

. (76.3)

Qmin /max is the smallest / largest occurring quotient of the values in the data array divided by the values in the

desired output field.

The output of the detector are the minimum quotient Qmin, the maximum quotient Qmax and the calculated

uniformity error.

Figure 624. The edit dialog of the Uniformity Error Detector.

Fig. 624 shows the edit dialog of the uniformity detector. The following setting can be done by the user:

ITEM DESCRIPTION

DesiredOutput Field > Set The user has to specify a desired output field as data array. If you click on

this button you can do the following:

• Load a data array from a .da file.

• Import a data array from a bitmap or text file by means of the import

wizard described in Sec. 121.2.

• Select from Documents allows you to select an already open data array.

In any case the data array has to contain only one subset. It has to be equidis-

tant and the data has to be real-valued.

Desired Output Field >

Show

Shows the desired output field as separate Data Array document.

Evaluate Current Subset /

Evaluate All Subsets

If you click on the first control, only the currently visible subset is evaluated.

If you click on the latter, all subsets of the Data Array are evaluated sepa-

rately. These controls are only visible if the Data Array contains more than

one subset.
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76.7 Sum within Selection

Using Detectors > Sum Within Selection, the sum of all values inside a previously marked selection can be

obtained.

This detection works for one-dimensional as well as for two-dimensional Numerical Data Arrays. As described

in Sec. 11.3, a coordinate range has to be selected in the 1D case, a rectangle or elliptic selection is prerequisite

in the 2D case.

In each of the cases, data points which are covered only partially by the selection are considered according to

the intersection between the data point’s coordinate range and the selection.

76.8 Add Polarization Ellipses

The ribbon button Detectors > Add Polarization Ellipses allows you to calculate polarization ellipses for

Electric or Electromagnetic Fields (↪→Sec. 13.1) either if none were calculated by the Universal Detector

(↪→Sec. 74.4) or if the ellipses shall be calculated anew for whatever reason. This functionality is described

in Sec. 32.3 in more detail.

76.9 Apply Detector Add-on

The ribbon button Detectors > Apply Detector Add-on allows you to apply any detector add-on onto Data

Arrays (↪→Sec. 13) and Chromatic Fields Sets (↪→Sec. 14) just like the Universal Detector does (↪→Sec. 74.4.5).

Via clicking on the upper part of the split button or on Apply Detector Add-on in its lower part, you can load a

detector add-on from hard disc. Then the dialog explained in Sec. 625 opens where you can change the loaded

snippet or create a new one.

In addition the lower part of the button contains those add-ons that you have stored as favorite in the edit dialog

for detector add-ons (↪→Sec. 76.9.1, Sec. 74.4.5.2). And it has the additional entry Update Predefined Add-ons

which loads the most up-to-date addons from the Wyrowski Photonics Website. Optionally also the snippets of

all favorites are then updated if they have the same name as a predefined addon. The values of your favorites’s

snippet parameters are kept.

76.9.1 Dialog for Applying a Detector Add-on on a Data Array

Figure 625. Edit dialog for a detector add-on.
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ITEM DESCRIPTION

New Add-on Allows you to load the add-on to be applied, either From Template or From

File.

Edit Opens the source code editor for the add-on’s snippet.

{Parameter Box} This box contains the parameters defined in the snippet if there are any.

↪→Sec. 7.4

Wave Front Data (Op-

tional)

Data which describe the wave front of a electric /magnetic / electromagnetic

field can be set, removed or shown here if needed. Wave Front Data means

theWavefront Phase mentioned in Sec. 74.4 which is the smooth part of the

phase of the field in the detector plane. Only this data, extracted by the Uni-

versal Detector shall be used if needed (because the data have to correspond

to the calling field by all means). Whether or not this data are to be set at all

depends on the actual add-on’s snippet.

Medium to Use Detector In The optical medium the add-on shall be applied in can be defined here

(↪→Sec. 37.3.1, ↪→Sec. 34).

Saves the add-on as separate file into the Favorites folder. Shortcuts to these

files are shown when you click on the lower part of the Apply Detector Add-on

button (↪→Sec. 76.9).



XII Analyzers:
Evaluating Optical
Systems

Analyzers evaluate an Optical Setup or a single Optical Setup Element

in a special way, independent from the simulation engines described in

Sec. 43.4.

For example the Distortion Analyzer (↪→Sec. 78) calculates the distor-

tion introduced by one Optical Setup Element, whereas the Eigenmode

Analyzer (↪→Sec. 89) calculates the eigenmode of a complete laser res-

onator optical setup.



CHAPTER 77. COATING ANALYZER 735

77 Coating Analyzer

O G O S .

Knowing the reflection properties of a certain surface is very important for many applications. If these properties

don’t meet the needs of the optical setup, it may be necessary to equip the surface with a coating.

The function of the Coating Analyzer is the evaluation of the reflection and transmission values of an optical

surface in order to provide a base for the decision on applying a coating. The improvement achieved by a

certain coating can be evaluated too. Supported outputs are tables with Fresnel coefficients as well as data

arrays (↪→Sec. 13.5) showing the dependencies of a certain coefficient on wavelength and angle of incidence.

The analyzer element has to be configured before each use via its edit dialog which is called by double click on

the element’s symbol in the Optical Setup View or on the corresponding table entry in the Optical Setup Table.

It has a wizard structure and has to be filled by the sequential steps described in the following subsections.

77.1 Selection of the Surface to Analyze

At first, the component that contains the surface to analyze has to be selected. The component can be a Curved

Surface (↪→Sec. 58.1), Lens System (↪→Sec. 57.1), or Spherical Lens (↪→Sec. 57.3) which must be linked to the

active light source. Then, the surface itself can be selected.

Figure 626. Controls for selecting the surface to analyze.

ITEM DESCRIPTION

Component The component the surface to be analyzed belongs to. This may be either a

Curved Surface, a Lens System, or a Spherical Lens.

Surface The surface to be analyzed. It is selected by its index inside its component.

77.2 Selection of Analyzer Output

Figure 627. Controls for selecting the analyzer’s output.

The following types of output are available:
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ITEM DESCRIPTION

Reflectance Only Only the reflectance for TE and TM is calculated and shown in the Detector

Results tab of the main window.

All Coefficients [Table] The reflectance, transmittance, and the complex Fresnel coefficients will be

calculated for TE as well as for TM for a given wavelength, angle of incidence

and lateral position on the surface.

Incidence Angle Depen-

dent Coefficients [DataAr-

ray]

The user will have to select up to four parameters to calculate a 1D data array

for. It will show the dependency of this parameter on the angle of incidence

for a given wavelength.

Wavelength Dependent

Coefficients [Data Array]

The user will have to select up to four parameters to calculate a 1D data

array for. It will show the dependency of this parameter on the wavelength for

a given angle of incidence.

Wavelength andAngle De-

pendency [Data Array]

The user will have to select up to four parameters to calculate a 2D data array

for. It will show the dependencies of this parameter on the wavelength and

the angle of incidence.

Note on Optimization

This analyzer can be used for Parametric Optimization (↪→Sec. 102) under the following conditions:

1. Reflectance Only is used as output mode. In this case you can optimize the reflectance for one

specific wavelength and incidence angle.

2. For any of the data array outputs you can use the Parametric Optimization if you select that the

reflectance (= reflection intensity coefficient) is calculated. Because then the minimum and maxi-

mum reflectance as well as the arithmetic mean of all reflectance values in the resulting data arrays

are being calculated and those values can be used as optimization constraints.

77.3 Configuring the Analyzer Output

Each type of output requires certain parameters that are described in the following.

77.3.1 Reflectance Only and All Coefficients [Table]

Figure 628. Configuration of the Reflectance Only or the All Coefficients output.
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Figure 629. Example for an output of all Fresnel coefficients in one table.

ITEM DESCRIPTION

Lateral Position on Sur-

face

Coordinates of the position on the surface where the Fresnel coefficients shall

be calculated for.

Wavelength Wavelength the coefficients shall be calculated for.

Incidence Angle Incidence angle the calculation shall be done for. It is defined in relation to

the normal vector of the surface to analyze.

Use Collimation Angle If this box is checked, the incidence angle is determined from the angle be-

tween the normal vector of the surface to be analyzed and the output axis

of the Optical Setup Element which prepends it in the execution sequence of

the Optical Setup. ↪→Fig. 630.
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Figure 630. Meaning of the collimation angle: Angle between the normal vector of the surface to analyze and the output

axis of its prepended element in the Optical Setup (Reference Element).

77.3.2 Incidence Angle Dependent Coefficients [Data Array]

Figure 631. Configuration of the Incidence Angle Dependent Coefficients output.

ITEM DESCRIPTION

Intensity Coefficients Select this option if you want to calculate reflectance or transmittance.

Complex Fresnel Coeffi-

cients

Select this option if you want to calculate the complex reflection and trans-

mission coefficients.

Reflection / Transmission Select here if reflection and / or transmission coefficients shall be calculated

and returned as separate subsets in the resulting data array.

perpendicular (TE) / paral-

lel (TM)

Select here which polarization state(s) shall be calculated and returned as

separate subsets in the resulting data array.

Wavelength Wavelength the coefficients shall be calculated for.

Angle Range Range of incidence angles the calculation shall be done for.
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77.3.3 Wavelength Dependent Coefficients [Data Array]

Figure 632. Configuration of theWavelength Dependent Coefficients output.

ITEM DESCRIPTION

Intensity Coefficients Select this option if you want to calculate reflectance or transmittance.

Complex Fresnel Coeffi-

cients

Select this option if you want to calculate the complex reflection and trans-

mission coefficients.

Reflection / Transmission Select here if reflection and / or transmission coefficients shall be calculated

and returned as separate subsets in the resulting data array.

perpendicular (TE) / paral-

lel (TM)

Select here which polarization state(s) shall be calculated and returned as

separate subsets in the resulting data array.

Wavelength Range Range of wavelengths the coefficients shall be calculated for.

Incidence Angle Angle of light incidence the calculation shall be done for.

Use Collimation Angle If this box is checked, the incidence angle is determined from the angle be-

tween the normal vector of the surface to be analyzed and the output axis

of the Optical Setup Element which prepends it in the execution sequence of

the Optical Setup. ↪→Fig. 630.

77.3.4 Wavelength and Angle Dependency [Data Array]

Figure 633. Configuration of theWavelength and Angle Dependency output.
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Figure 634. Example for a 2D data array output of the reflectance for TM polarization.

ITEM DESCRIPTION

Intensity Coefficients Select this option if you want to calculate reflectance or transmittance.

Complex Fresnel Coeffi-

cients

Select this option if you want to calculate the complex reflection and trans-

mission coefficients.

Reflection / Transmission Select here if reflection and / or transmission coefficients shall be calculated

and returned as separate subsets in the resulting data array.

perpendicular (TE) / paral-

lel (TM)

Select here which polarization state(s) shall be calculated and returned as

separate subsets in the resulting data array.

Wavelength Range Range of wavelengths the coefficients shall be calculated for.

Angle Range Range of incidence angles the calculation shall be done for.

78 Distortion Analyzer

O G O S .

The Distortion Analyzer calculates the distortion of a laser beam introduced by one component for various an-

gles in one direction. It works for the index modulated components (↪→Sec. 56.2), a Lens System (↪→Sec. 57.1),

a Spherical Lens (↪→Sec. 57.3), or a Curved Surface (↪→Sec. 58.1).

For each angle a small ray bundle is propagated through the selected component and the so calculated deflec-

tion yreal compared to the reference deflection yref yields the distortion D for this angle.

D =
yreal − yref

yref
(78.1)

whereas yref = f · tan α for Tan(Theta) distortion and yref = f · α for Theta distortion. f is the effective focal

length of the analyzed component.
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Figure 635. The edit dialog for the distortion analyzer in Single Distortion Values mode.

The edit dialog of this analyzer (↪→Fig. 635) has the following options.
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ITEM DESCRIPTION

Component to Analyze Allows you to select any allowed component. If there is only one suitable

component in the Optical Setup, it is used automatically without the necessity

to edit the dialog first.

Calculate Distortion for

Effective Focal Length

If this option is checked, the effective focal length f is determined automati-
cally by evaluating the selected component. Otherwise the user can set the

Effective Focal Length.

Effective Focal Length O C D E F L

.

The effective focal length of the component.

Evaluation Distance O C D E F L

.

If you want to get the deflection yreal of a component it must be measured in a
certain evaluation distance behind the component. If the reference deflection

yref refers to the effective focal length, this evaluation distance is the back

focal length. If Calculate Distortion for Effective Focal Length is not checked,

the user must not only specify the Effective Focal Length, but also this Eval-

uation Distance.

Reference Positions Defines whether yref is the Tan(Theta) Distortion or the Theta Distortion as

defined above.

Calculated Positions Defines whether yreal is the position of the Central Ray or of the Centroid of
the ray bundle with which the component is analyzed.

Absolute Distortion /

Relative Distortion

In case of Absolute Distortion, the distortion is defined as D = yreal − yref,
otherwise it is D = (yreal−yref)/yref as defined in Eq. (78.1).

Angle Range Defines along which direction the distortion is scanned (x- or y-axis of the

component, whereas in both cases the positive or the negative range can be

used).

Distortion Data Array You can scan a complete angle range and the results are returned as data

array – or as set of data arrays if the light source of the system emits more

than one wavelength.

Single Distortion Values In this case you directly enter the angles you want to analyze. This mode

allows you to optimize the distortion of certain angles with the Parametric

Optimization (↪→Sec. 102).

Maximum Angle O D D A

The maximum angle of the scanned range. The minimum angle always

equals the Scanning Step Size.

Scanning Step Size O D D A

The distance between two consecutive angles in the scanned range.

Number of Distortion Val-

ues

O S D V

The number of angles for which you want to calculate the distortion. Then

you can enter the concrete angle values in a simple table.

Independent of whether Distortion Data Array or Single Distortion Values is selected, the maximum distortion

and the angle of maximum distortion are additionally calculated.
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79 Field Curvature Analyzer

O G O S .

The Field Curvature Analyzer calculates the field curvature for both tangential and sagittal plane by evaluat-

ing the focus position for various incident angles or positions. It works for the index modulated components

(↪→Sec. 56.2), a Lens System (↪→Sec. 57.1), a Spherical Lens (↪→Sec. 57.3), or a Curved Surface (↪→Sec. 58.1).

For each angle or position a small ray bundle is propagated through the selected component and its focus

position is determined.

Figure 636. The edit dialog for the field curvature analyzer for a Finite Object Distance in Single Field Curvature Values

mode.

The edit dialog of this analyzer (↪→Fig. 636) has the following options.
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ITEM DESCRIPTION

Component to Analyze Allows you to select any allowed component. Note that this component

needs not to be connected to a light source. If there is only one suitable

component in the Optical Setup, it is used automatically without the neces-

sity to edit the dialog first.

Evaluate Field Curvature

Relative to Focal Plane

If this option is checked, the evaluation is done in the focal plane z = f0 of

the component where f0 is the effective focal length for on-axis incidence. In

case the active light source has more than one wavelength you can choose

the Reference Wavelength which is used for the calculation of f0.

Otherwise the user can set the Evaluation Distance, measured from the ref-

erence point of the transmission coordinate system of the Component to

Analyze (↪→Sec. 43.8.1.3).

Finite Object Distance If this option is not checked, the evaluation is done with collimated ray bun-

dles entering the component with certain angles. Otherwise ray bundles are

created which originate in the given Distance to Object Plane at a certain

object height (= distance from optical axis).

Results for Sagittal Plane /

Results for Tangential

Plane

Allows you to define whether the results for the tangential plane (contains the

optical axis) and / or the sagittal plane (perpendicular to the tangential plane)

are calculated. The dialog ensures that at least one plane is selected.

Angle Range /

Object Height Range

Defines along which direction the field curvature is calculated (x- or y-axis

of the component, whereas in both cases the positive or the negative range

can be used).

Field Curvature Data Array You can scan a complete angle range and the results are returned as data

array – or as set of data arrays if the light source of the system emits more

than one wavelength.

Single Field Curvature Val-

ues

In this case you directly enter the angles or object heights you want to ana-

lyze. This mode allows you to optimize the field curvature of certain angles

or object heights with the Parametric Optimization (↪→Sec. 102).

Maximum Angle /

Maximum Object Height

O F C D A

The maximum angle or object height of the scanned range. The minimum

angle always equals the Scanning Step Size.

Scanning Step Size O F C D A

The distance between two consecutive angles or object heights in the

scanned range.

Number of Field Curvature

Values

O S F C V

The number of angles or object heights for which you want to calculate the

field curvature. Then you can enter the concrete values of the angles or

object heights in a simple table.

Independent of whether Field Curvature Data Array or Single Field Curvature Values is selected, the maximum

field curvature and the angle or object height of maximum field curvature are additionally calculated.

80 Field Inside Component Analyzer: Split Step

O G O S .

The Field Inside Component Analyzer: Split Step can be used to visualize the field components inside an
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inhomogeneous region of the optical system. To enable this analysis the split step propagation needs to be

selected within an index-modulated component (↪→Sec. 56.2) or a Double Surface Component (↪→Sec. 65). For

each step of the split step propagation along the z-direction an intermediate result is calculated which is then

processed further by this analyzer.

Figure 637. The edit dialog of the Field Inside Component Analyzer for the split step propagation.

Fig. 637 shows the edit dialog of the analyzer which allows the following settings:
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ITEM DESCRIPTION

Optical Setup Element To

Analyze

The user needs to select the Optical Setup Element that shall be evaluated.

Within the combobox all available components in the underlying Optical Setup

will be listed.

Harmonic Field Compo-

nent

In this group box you can set up which harmonic field components (Ex, Ey, Ez,

Hx, Hy, Hz, Sx, Sy and / or Sz) are extracted from the intermediate fields. Each

field component is shown in a data array in a Set of Data Arrays (↪→Sec. 16).

In case of two-dimensional fields a subset is generated for each z-position.

In case of one-dimensional fields the components are plotted along the z-

direction in a single two-dimensional subset.

Evaluate Power Along z The user can specify whether the power shall be calculated per z-slab. The

resulting function will be visualized within a one-dimensional data array.

Evaluate Custom Merit

Function

For several applications it can be helpful to define customized merit functions

for the propagation through inhomogeneous media. The user can define a

snippet which calculates a list of physical values out of each intermediate

result. The result is a one-dimensional data array where the physical values

are plotted versus the z-position in individual subsets.

Custom Merit Function

Evaluation

O E C M F .

This group box allows you to program the evaluation snippet. Edit opens the

Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator

(↪→Sec. 5.10) shows whether this snippet is consistent. Below there is a re-

gion where you can set the values of the global parameters of the snippet (if

present); ↪→Sec. 7.4.

The dialog ensures that at least one output is selected.

81 Focal Length Analyzer

O G O S .

This analyzer calculates both the effective and the back focal length of the index modulated components

(↪→Sec. 56.2), a Lens System (↪→Sec. 57.1), a Spherical Lens (↪→Sec. 57.3), or Curved Surface (↪→Sec. 58.1).

This is done by ray tracing and evaluating a paraxial ray bundle.

Figure 638. The edit dialog of the Focal Length Analyzer.

Its edit dialog, shown in Fig. 638, has the following options.
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ITEM DESCRIPTION

Component to Analyze Allows you to select any allowed component. Note that this component needs

not to be connected to a light source. If there is only one suitable component

in the Optical Setup, it is used automatically without the necessity to edit the

dialog first.

Evaluate All Wavelengths

of Active Light Source

In this mode the focal lengths are calculated for all wavelengths specified in

the active light source (those with index 0).

Evaluate Single Wave-

length

In this mode you can set the wavelength for which the focal lengths are cal-

culated.

82 Optical Path Length Analyzer

O G O S .

The Optical Path Length Analyzer can be used to evaluate the optical path lengths of a sub-path in the un-

derlying Optical Setup. The active source in the Optical Setup must be configured as a polychromatic source,

because otherwise this analyzer would generate no valuable output. The sampling in the frequency domain

has to be adapted for the specified sub-path. Therefor the user can select the Automatic Sampling mode. In

this case, VirtualLab Fusion will estimate the oversampling factor for the frequency domain. Alternatively the

user can specify an oversampling factor for the frequencies manually. This oversampling factor will increase

the accuracy of further investigations, e. g. the Inverse Temporal Fourier Transformation (↪→Sec. 31.2.1).

The user can specify the end element (= detector) of the sub-path to be evaluated and as well as the output of

the analyzer. The Optical Path Length Analyzer can display the optical path length over frequencies ν or the

absolute phase over the frequencies ν. Additionally a linear function can be fitted to the absolute phase. For

the linear fit the Optical Path Length Analyzer provides three different methods.

Fig. 639 shows the edit dialog of the Optical Path Length Analyzer.

Figure 639. The edit dialog of the Optical Path Length Analyzer. The user can set up the sub-path which shall be evalu-

ated as well as the output of the analyzer.
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ITEM DESCRIPTION

From Light Source The active light source in the Optical Setup the analyzer is placed in. This

light source must be polychromatic, otherwise an error will be shown if the

analyzer processed.

To Detector The user can specify the end element (= detector) of the sub-path for which

the optical path length shall be evaluated. The end element must be con-

nected with the active light source by a unique path.

Evaluate Optical Path

Length

This checkbox defines whether the optical path length versus the frequencies

ν shall be shown.

Evaluate Phase by Optical

Path Length

The Optical Path Length Analyzer can also calculate the absolute phase. By

checking this option a diagram is shown where the phase over ν can be in-

vestigated.

Fit I: Time Shift without

Dispersion

The first type of linear fit does not consider dispersion effects in the system

which shall be analyzed. The user can specify whether the fitted linear func-

tion shall be drawn additionally in the phase diagram and whether the resid-

uals shall be evaluated.

Fit II: Time Shift by Re-

gression

The second type of linear fit does consider dispersion effects in the system

which shall be analyzed. The dispersion effect is fitted by a linear regression

to the absolute phase curve. The user can specify whether the fitted linear

function shall be drawn additionally in the phase diagram and whether the

residuals shall be evaluated.

Fit III: Time Shift with Dis-

persion

The third type of linear fit does consider dispersion effects in the systemwhich

shall be analyzed. The dispersion effect is evaluated by the group velocity of

the pulse. The user can specify whether the fitted linear function shall be

drawn additionally in the phase diagram and whether the residuals shall be

evaluated.

Automatic Sampling VirtualLab Fusion estimates the frequency sampling for the selected light

path. The calculated oversampling factor will be logged into the logging win-

dow of VirtualLab Fusion and additionally be shownwhen the dialog is opened

the next time.

Manual Sampling The manual sampling mode allows the user to enter a self-defined oversam-

pling factor (of frequencies).

Oversampling Factor (Fre-

quencies)

The oversampling factor can be configured to use more frequencies for the

OPL analysis. This oversampling factor will also increase the accuracy of

further investigations, e. g. the Inverse Temporal Fourier Transformation

(↪→Sec. 31.2.1).
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Figure 640. Diagrams generated by the Optical Path Length Analyzer for a sample Optical Setup.

Fig. 640 shows some sample results of the Optical Path Length Analyzer for a sample system.

The slopes of the fitted linear functions give the time shift, i. e. the time the pulse needed to propagate through

the (sub-)system. The Optical Path Length Analyzer logs the obtained time shifts into the detector window (one

per selected fit method, ↪→Fig. 641). The time shifts can be used for further investigations of pulses in VirtualLab

Fusion, especially for the temporal Fourier Transformation (↪→Sec. 31.2.1).

The residual functions calculated by the Optical Path Length Analyzer can be used to increase the time window

for the Inverse Temporal Fourier Transformation (↪→Sec. 31.2.1).

Figure 641. The slope of the linear fits is logged into the Detector Results tab on the bottom of the VirtualLab Fusion main

window.

83 Parameter Variation Analyzer

N L R S .

This analyzer allows you to define a parameter variation for the underlying Optical Setup and then evaluate the

results of that variation with a snippet.

Figure 642. The dialog of the Parameter Variation Analyzer.
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Fig. 642 shows its dialog. In the upper part there is a button to Configure Parameter Variation. It opens a dialog

with the same pages as for the Parameter Run (but welcome page and results table). ↪→Sec. 44.2 – Sec. 44.4.

After configuring the parameter variation, some basic information about it are shown next to the button.

Below there is a group box Evaluate Results to program the evaluation snippet. In this snippet you can change

and start the parameter variation (if necessary multiple times), then retrieve the results from this variation and

evaluate them.

Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this snippet, and a validity indicator (↪→Sec. 5.10) shows

whether this snippet is consistent. Below there is a region where you can set the values of the global parameters

of the snippet (if present); ↪→Sec. 7.4.

84 Grating Order Analyzer

O G S .

The Grating Order Analyzer (↪→Fig. 643) calculates the coordinates, Rayleigh coefficients, and efficiencies of

all diffraction orders of a grating.

The edit dialog of the analyzer contains two tabs, the General tab (↪→Fig. 643), and the Single Orders tab

described in Sec. 84.1. The General tab allows you to select which kind of output you want to obtain. The

dialog ensures that always at least one output is specified – you cannot uncheck the last checked check box.

Figure 643. The General tab of the Grating Order Analyzer.



CHAPTER 84. GRATING ORDER ANALYZER 751

OUTPUT DESCRIPTION

Order Collections If checked, an Order Collection is generated, one each for Transmission, Re-

flection, and / or the Incident Wave (as reference). An Order Collection docu-

ment (↪→Sec. 18) contains the coordinates, efficiencies, and Rayleigh coeffi-

cients of all the respective orders.

Single Order Output If checked, the coordinates, efficiencies, and Rayleigh coefficients of sin-

gle orders are output as physical values into the Detector Results Panel

(↪→Sec. 4.3). In this case a new tab page Single Order Output (↪→Sec. 84.1)

is shown where you can define what data is shown for which orders. You can

select whether you are interested in the orders for Transmission, Reflection,

and / or the Incident Wave (as reference).

Summed Transmission,

Absorption, and Reflec-

tion

If checked, the sum R of all reflection efficiencies as well as the sum T of all

transmission efficiencies is calculated. The absorption A is then 1− R− T.
These values are shown in the Detector Results Panel (↪→Sec. 4.3).

Polar Diagram (Angle α

Only)

If checked, a Diffraction Order Diagram Data (↪→Sec. 19) is generated where

the efficiencies of all propagating orders are plotted versus their Cartesian

angle α.

The directions are calculated by means of the grating equation (↪→Sec. 139.5) and if necessary converted by

the formulas given in Sec. 139.3. The Rayleigh coefficients are calculated by the propagation method set up

in the edit dialog of the component (↪→Sec. 64.2). The calculation of the efficiencies is explained in Sec. 139.6.

84.1 Single Order Output

O S O O G .

Figure 644. The Single Orders tab of the Grating Order Analyzer.
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The Single Orders tab (↪→Fig. 644) of the Grating Order Analyzer allows you to configure which data about

single orders is shown in the Detector Results Panel (↪→Sec. 4.3). It has the following options.

ITEM DESCRIPTION

Selection Strategy With this option you can restrict the shown orders. The following three strate-

gies are available:

• All: No restrictions apply

• Above Efficiency Threshold: Only (propagating) orders above the

given Efficiency Threshold are shown.

• Order Range: All orders in the range between Minimum Order (inclu-

sive) and Maximum Order (inclusive) are shown. This is the recom-

mended mode for the Parametric Optimization (↪→Sec. 102) and the

optiSLang Bridge (↪→Sec. 103).

Coordinates This group box allows you to select which coordinates of the individual orders

are shown in the Detector Results Panel. If you select Positions you can set

a Distance for which the positions are calculated.

Note that angles and positions are only shown for propagating orders,

not for evanescent ones.

Efficiencies /

Rayleigh Coefficients

Allows you to select which data of the individual orders is shown.

The dialog ensures that you select at least one of the Coordinates or one of the Rayleigh Coefficients or the

Efficiencies.

85 Ellipsometry Analyzer

O G O S .

This analyzer calculates the Rayleigh coefficient R = Aeiφ of one selected order for both TM and TE polarization

(or p and s polarization). From this derived properties such as the resulting polarization ellipse are calculated

– in dependency from wavelength and angle.

Figure 645. The dialog for the Ellipsometry Analyzer.

Its edit dialog (↪→Fig. 645) has the following settings.
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ITEM DESCRIPTION

Analyzed Output This analyzer can be either applied to the Rayleigh coefficients for Reflection

or Transmission.

Selected Order Index of the selected order. For 1D-periodic gratings the second index should

be zero.

Output Amplitude Component Ψ and Phase Difference ∆ can be used to calculate

the resulting polarization ellipse for linearly polarized incident light. They are

defined by the equation

RTM

RTE

= tan Ψ · ei∆ .

The Müller MatrixM describes the transformation of the Stokes parameters

by the analyzed element.

M =


1/2(Ap + As) 1/2(Ap − As) 0 0

1/2(Ap − As) 1/2(Ap + As) 0 0

0 0 Ap · As · cos ∆ Ap · As · sin ∆

0 0 −Ap · As · sin ∆ Ap · As · cos ∆



Used Physical Property

for Angles

Both Ψ and ∆ are in principle angles. You can determine whether their unit

should be degrees or radians.

Phase Shift of TM Relative

to TE

The given value is added to ∆. This can make the calculated diagrams more
comparable with those found in the literature or obtained by measurements.

{Parameter Variation} This table allows you to start kind of a parameter run (↪→Sec. 44) over wave-

length and spherical angle ϑ. This means that for each combination of the

specified wavelengths and angles the desired Output is being calculated and

then plotted versus wavelength into a 1D data array. The different angles

form distinct subsets. This means that at least 2 wavelengths Steps must be

specified, but its possible to specify only one angle.

86 Field Inside Component Analyzer: FMM

O G O S .

This analyzer calculates the field inside a grating rigorously by means of the Fourier Modal Method

(↪→Sec. 96.3). If the grating component (↪→Sec. 64.1) is 1D-periodic, the result is a single Data Array showing

the field in the x-z-plane at y = 0. If the grating component is 2D-periodic, the result is a Set of Data Arrays with

one Data Array for each z-layer.
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Figure 646. Field inside a dielectric sawtooth grating for an incidence angle θ = 20◦. Left: 1 period shown, right: 2 peri-
ods shown. Then the sawtooth structure is more clearly recognizable.

Figure 647. The dialog for the Field Inside Component Analyzer: FMM.

Its edit dialog (↪→Fig. 647) has the following settings.
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ITEM DESCRIPTION

Vectorial Component In this group box you can set up which vectorial components (Ex, Ey, Ez, Hx,

Hy and / or Hz) are shown in the resulting data array (↪→Sec. 13.5). The dialog

ensures that at least one vectorial component is selected.

Forward Propagating /

Backward Propagating

For detailed analyses you can switch off the influence of either the forward or

the backward propagating modes.

Number of Periods Sometimes the structure of the field inside a grating can be recognized more

easily if more than one period is shown (See Fig. 646 for an example). Thus

you can set the Number of Periods which can be any real number greater

than or equal to 1.

z-Range Usually the base block of a grating component is much larger than the grating

stacks. Thus the special effects of the stacks might not be resolved in the

result field. To circumvent this problem, you can can restrict the z-Range to

First Stack Only or Second Stack Only. Showing the Whole Component or

Base Block Only is also possible. For example, Fig. 646 was made with the

option First Stack Only.

Sampling This group box allows you to set up an equidistant sampling separately for

x-Direction and z-Direction, either by specifying the Sampling Distance or the

number of Sampling Points.

Accurate results can be expected for an resolution of λ/5 or less, but this might

lead to high memory consumption and / or calculation time. If a 2D-periodic

is analyzed, the sampling for the x-direction is also used for the y-direction.

87 Polarization Analyzer

O G O S .

This analyzer can be used for optimizing polarizers and anti-reflection structures. It computes either the

summed reflection or transmission efficiency for two orthogonal polarization directions and calculates advanced

merit functions like the polarization contrast out of it. To this end, the propagation currently configured in the

grating component is used. The summed efficiency is either calculated from all (propagating) orders or from a

user-defined order range.

The polarization directions can be given in the following coordinate systems:



CHAPTER 87. POLARIZATION ANALYZER 756

COORDINATE SYSTEM DESCRIPTION

Coordinate System of

Grating

The Jones vector describes the electric field along x- and y-axis of the grating

component, respectively.

Coordinate System of

Light Source

The Jones vector describes the electric field along x- and y-axis of the light

source, respectively.

p-s Coordinate System In grating theory one often uses the nomenclature parallel and senkrecht (=

perpendicular) polarization to describe how the electric field vector is orien-

tated to a reference plane (or short p- and s-polarization). This reference

plane is defined by the normal vector of the grating surface and the direction

vector of the incident light.

The conversion from the coordinate system of the light source (Ex/Ey) is done

with the following equations:

Es =

Ex

Ey

 · ns and Ep =

Ex

Ey

 · np (87.1)

ns and np are the normalized directions of s- and p- polarization, respectively
(in the coordinate system of the light source). For perpendicular incident ns
is equal to the y-axis of the light source.

TE-TM Coordinate System Instead of p- and s-polarization also the nomenclature transversal magnetic

and transversal electric, respectively, is used – or short TM / TE.

Figure 648. The edit dialog for the polarization analyzer.

The edit dialog for this analyzer (↪→Fig. 648) has the following settings.
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ITEM DESCRIPTION

Analyzed Output This analyzer can be either applied to the efficiencies for Reflection or Trans-

mission.

Analyzed Orders With this option you can restrict the analyzed orders. The following two strate-

gies are available:

• All: The summed efficiency of all propagating orders is evaluated.

• Order Range: All orders in the range between Minimum Order (in-

clusive) and Maximum Order (inclusive) are taken into account for the

summed efficiency.

Polarization Refers to Allows you to specify the coordinate system the polarization refers to, see

table above.

Output The following outputs can be calculated:

• Efficiency Ex-Direction Ix, that is the overall reflection / transmission ef-

ficiency for Ex-polarization.

• Efficiency Ey-Direction Iy, that is the overall reflection / transmission ef-

ficiency for Ey-polarization.

• Polarization Contrast P = Ix/Iy

• Average Efficiency A =
(

Ix+Iy
)

2

Vary Wavelength and/or

Orientation

Shows some additional controls allowing you to start kind of a parameter run

(↪→Sec. 44) over wavelength and / or the available orientation angles. This

means that for each combination of the specified wavelengths or orienta-

tion angles the desired Output is being calculated and stored in a data ar-

ray. Fig. 648 shows a sample configuration of the dialog where the spherical

angles θ and φ are varied. See also the note below.

Advanced Output If you check Diagram the resulting data array is shown as separate data array

view (↪→Sec. 13.5): 1D data array if one parameter is varied, 2D data array

if two parameters are varied, 1D data array with data plotted versus iteration

number if more than two parameters are varied.

For each selected output ω (i. e. either Ix, Iy, A and / or P) you can calculate
additional merit functions: the Minimum ωmin, the Maximum ωmax and the

Uniformity Error U = ωmax−ωmin
ωmax+ωmin

. With the results shown in Fig. 648 the maxi-

mum polarization contrast would be 107.35 (for a wavelength of 500 nm and

an incident angle of 4°), the minimum polarization contrast would be 10.125

(for a wavelength of 400 nm and an incident angle of 0°) and thus the unifor-

mity error of the polarization contrast would be 82.763 %.

The dialog ensures that always at least one output is checked.

Note on the available angles

If you create a new Polarization Analyzer in your Optical Setup, the available angles in the Polarization

Analyzer are set according to the Orientation Definition Type of the grating component in that Optical

Setup. But you change it with the Orientation Definition control.

See Sec. 139.2 for details about the various orientation definition types.
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Note on using the analyzer with Parameter Extraction

If the wavelength and / or the orientation are varied, it is not possible to vary the same parameter(s) via

normal parameter extraction (Parameter Run, Parametric Optimization, Parameter Overview, …) at the

same time.

88 Programmable Grating Analyzer

O G O S .

Figure 649. The dialog for the Programmable Grating Analyzer.

This analyzer can be used to define a user-defined merit function on the rigorous calculated result of the Fourier

Modal Method. The analyzer allows the access to the rigorous calculated Rayleigh coefficients as well on the

calculated efficiencies. The following settings can be configured

ITEM DESCRIPTION

Algorithm This group box allows you to program a code snippet defining the merit func-

tion. Edit opens the Source Code Editor (↪→Sec. 7.3) to edit this snippet, and

a validity indicator (↪→Sec. 5.10) shows whether this snippet is consistent.

Parameters PE The controls in this group box allow you to set the values of the global param-

eters of the snippet. ↪→Sec. 7.4

89 Eigenmode Analyzer

O L R O S .

The eigenmode analyzer calculates eigenmodes and eigenvalues of resonator systems.
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89.1 Eigenmode Algorithms

For computing eigenmodes two iterative algorithms from numerical linear algebra are available:

• Fox-Li algorithm, also known as power iteration

• Arnoldi algorithm

Both methods are being discussed in general books on linear algebra. The algorithm of Fox-Li is discussed

in [Sie86] also from the physical point of view. General information about these algorithms can be found e. g.

on Wikipedia (here for the power iteration and here for the Arnoldi algorithm). Usually one can expect that the

Arnoldi algorithm requires much less iterations compared to the Fox-Li algorithm. Further the Arnoldi algorithm

provides the option to compute estimates for higher order modes.

The eigenmode computation is based on applying these operators to a system that represents a round trip of

the resonator. Such a system is generated internally from the resonator system that is being defined in the

Optical Setup by the user. After each round trip the resulting mode is resampled according to the sampling

defined by the initial mode and the additional resampling operator (↪→Sec. 89.2).

Figure 650. The dialog for the Eigenmode Analyzer.

In the Algorithm panel (↪→Fig. 650) you can select the algorithm to be used. In both cases, the Number of

Iterations PE must be given as stopping criterion of the iteration. Additionally, the stopping criterion based on

the Relative Deviation Threshold PE can be activated. Then the iteration stops as soon as one of the criteria is

fulfilled. The deviation value (default 1e-6) refers to a relative deviation (rescaled) dR between two successive

iterates fi+1, fi:

dR =
‖ f̃i+1 − fi‖
‖ fi‖

(89.1)

where f̃i+1 := c · fi+1 with a complex constant c that is chosen such that the absolute deviation (rescaled) dA

is minimal:

dA = ‖ f̃i+1 − fi‖ (89.2)

If the Arnoldi algorithm is selected, also the option Compute Higher Modes is available. The number of higher

modes being computed is restricted by the number of iterations. Only those modes with an eigenvalue above

10 per cent of the largest eigenvalue are computed. Note, the numerical accuracy decreases for higher modes.

https://en.wikipedia.org/wiki/Power_iteration
https://en.wikipedia.org/wiki/Arnoldi_iteration
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89.2 Initial Mode Parameters and Sampling

The iterative algorithm requires some initial mode. This mode can be defined at the corresponding tab page of

the analyzer, see Fig. 651.

Figure 651. The Initial Mode tab of the dialog for the Eigenmode Analyzer.

The initial mode is used as start mode of the iteration. Further this mode defines the wavelength of the resonator

and the initial state of polarization. The medium that is associated with the initial mode is used as embedding

medium behind the left mirror element of the resonator.

Several types of an initial mode are available: Multiple Light Source (↪→Sec. 49), Gaussian Wave (↪→Sec. 51.1),

PlaneWave (↪→Sec. 51.2), Programmable Light Source (↪→Sec. 51.8), Quadratic Wave (↪→Sec. 51.3), Spherical

Wave (↪→Sec. 51.4), Stored Lateral Field (↪→Sec. 51.6) and Super-Gaussian Wave (↪→Sec. 51.5). It can be

defined via the Edit button. The wavelength of the mode is available for Parameter Extraction (↪→Sec. 43.5).

The initial mode is placed right of the most left element (mirror) of the resonator. This position is called reference

plane. We define a reference sampling in this reference plane that is applied after each round trip iteration.

The reference sampling is defined from the initial mode together with the resampling operator. This operator PE

can be configured via the Edit button and behaves like the Field Size and Sampling manipulation in the Optical

Setup (↪→Sec. 22.8.2).

After starting the iteration the sampling is written into the Messages tab. The sampling should be chosen to

match the resulting mode. If it is to small or undersampled no convergence will be achieved. Otherwise the

computation effort might be too large.

89.3 Outcoupling Mode

At the end of the eigenmode computation the outcoupling mode is being computed. In case of an ideal spherical

mirror as right boundary of the resonator, the outcoupling is defined by transmittance settings of the mirror

(↪→Fig. 572). The medium specified here (↪→Fig. 652) will just be used as embedding medium of the outcoupling

mode.

Otherwise the right mirror of the resonator is ignored and replaced by a simple change of media considering

preservation of energy in paraxial approximation without Fresnel effects (i. e. T = 1):

|E′|2 = |E|2
∣∣∣∣n1

n2

∣∣∣∣ , (89.3)
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where n1 and n2 are the real parts of the refractive indices before and after the media change.

For this purpose the external medium is specified on the outcoupling tab (↪→Fig. 652).

Figure 652. The Outcoupling tab of the dialog for the Eigenmode Analyzer.

How to enter the homogeneous medium is described in Sec. 34.1.

89.4 Logging

During iteration logging is available. This logging can be configured at the logging tab (↪→Fig. 653).

Figure 653. The Logging tab of the dialog for the Eigenmode Analyzer.

The logging refers to the reference plane. After each round trip the current iterate of the eigenmode, the

corresponding beam radius and the deviation of successive iterates (↪→Sec. 89.1) can be computed. Switching

off the logging will slightly reduce the computation time.

The Edit View Settings button allows you to set the way how the eigenmodes are shown. To this end the same

settings as for the Raw Data Detector (↪→Sec. 74.5.5) can be used.

89.5 Iteration Document

Starting the eigenmode analyzer results in an Iteration Document (↪→Fig. 654). This document simply consists

of the Results page of the parameter run document (↪→Sec. 44.5).

Figure 654. The Iteration Document of the Eigenmode Analyzer.

The document contains the logging of the iteration. Eigenmode at reference plane, eigenvalues (first and

second), deviation, losses ((1− eigenvalue)2) and beam radius at reference plane are included. These values



CHAPTER 91. GRATING CHANNEL ANALYZER 762

support convergence control. Additional data can be computed at the end of each iteration step using detectors,

see Sec. 43.11.2.

With the Go! button or the Iteration > Go! ribbon item you can start the calculation of the iterations. Then

these buttons turn into a Stop button allowing you to stop the calculation.

90 Local Linear Grating Approximation Analyzer

Availability

Optical Setups: Light Shaping Optical Setup (↪→Sec. 43.11.4)

Accessible: In the Optical Setup: Analyzers > Local Linear Grating Analyzer

The diffraction efficiencies of the gratings in a Grating Cells Array (↪→Sec. 40.1.1) can be given by the user. Or

they can be calculated rigorously by means of the Fourier Modal Method. However, these rigorous simulations

can be quite time consuming and they require VirtualLab Fusion Advanced. Thus they have been separated

from the actual simulation by implementing the following workflow.

1. To a Light Shaping Optical Setup with one Diffractive Light Shaper (↪→Sec. 63) you add a Local Linear

Grating Approximation (LLGA) Analyzer.

2. You execute this analyzer which extracts all grating parameters present in the Grating Cells Array of the

Light Shaper.

3. You configure the resulting LLGA Results Generator (↪→Sec. 45) and start the rigorous simulations, if

necessary on a more powerful PC or workstation or on a computer which is eligible to run VirtualLab

Fusion Advanced.

4. You load the results from the LLGA Results Generator into the Order Configuration tab of the Grating

Cells Array.

91 Grating Channel Analyzer

O L G O S .

This analyzer examines the grating regions to determine which orders are propagating in the light guide. For

real gratings it also generates a LUT Results Generator (↪→Sec. 46) which then analyzes the efficiencies of

these orders rigorously.

It has an edit dialog to predefine whether a custom Fourier Modal Method shall be used for the rigorous analy-

ses, ↪→Sec. 96.4.



XIII Propagations:
Operators for
Propagating Fields

VirtualLab Fusion offers a large variety of free space propagation op-

erators which can only be used for homogeneous, isotropic media

(↪→Sec. 93). Real components (↪→Part IX) can contain surfaces and

both homogeneous and inhomogeneous media. Thus they need spe-

cial propagations (↪→Sec. 96).
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92 Common Controls

These controls are active for those operators that provide controls for modifying the output field size and sam-

pling in order to simplify their handling. The button Full Automating indicates whether each of the panels

described in the following subsections is set to Automatic Sampling. Furthermore, with this button you can

reset all panels to Automatic Sampling , i. e. to the default values.

92.1 Accuracy Settings

This panel (↪→Fig. 655) is used to adapt the sampling of the input field to minimize numerical errors. There are

different ways to determine the sampling parameters:

ITEM DESCRIPTION

Automatic Sampling The correct sampling of the input field is ensured by VirtualLab Fusion. You

can adjust the automatic sampling with the Accuracy Factor PV . The greater

this factor the more sampling points will be in the input field. A factor of 1 (de-

fault) means the number of sampling points VirtualLab Fusion uses normally

for automatic sampling. If you want to further minimize numerical errors you

can set this factor to values greater than 1. In this case the propagation will

be more time consuming. Vice versa, if you set the factor to values between

0 and 1 you can speed up propagation, but more numerical errors will be

present.

Keep Sampling Un-

changed

The sampling of the input field is not changed.

Calculate from Input Field

Sampling

The original sampling of the input is taken as reference, but you can decrease

the sampling distance with the Sampling Factor and embed the field with the

Embedding Factor. Both factors can be set separately for x- and y-direction.

A factor of 1 refers to the original parameters of the input field and a factor

larger than 1 increases both accuracy and numerical effort. Only available

for the thin element approximation (Sec. 96.2) and the split-step propagation

(↪→Sec. 96.6), where it replaces the Keep Sampling Unchanged setting.

Manual Sampling In this mode you can adapt either the Sampling Points or the Sampling Dis-

tance if you want to find the best compromise between numerical errors and

calculation time. The Array Size is just given for your information. If you check

this item,Manual Sampling is also selected for theOutput Field Sampling and

the Size and Shape of Output Field panel (Sec. 92.2 and Sec. 92.3).

For some propagation operators you can decrease numerical errors if you

embed the field into a zeroized frame. Therefore these operators have addi-

tional Embedding Factors for x- and y-direction which can be changed only

together with the Sampling Distance. An embedding factor of 1 refers to the

original size of the input field.

The Copy Active Parameters from button allows you to select another har-

monic field, from which either the Sampling Points or the Sampling Distance

are copied, depending on what item is activated.

Depending on the propagation operator and whether it is used in themain window or in theOptical Setup, certain

itemsmay not be available. Two examples are given in Fig. 655 and Fig. 656. Furthermore, if you selectManual
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Sampling in the Optical Setup only the activated entries (Sampling Points or the Sampling Distance) are shown

as the other parameters are not calculated until you propagate through the Optical Setup (↪→Fig. 656).

If a propagation operator dialog has no accuracy panel, the sampling is kept unchanged.

Figure 655. Accuracy tab for Fresnel propagation in the main window in Manual Sampling Mode.

Figure 656. Accuracy tab for thin element approximation in Manual Sampling Mode.

92.2 Output Field Sampling

Figure 657. Panel for adjusting the output field sampling.

For the two Rayleigh Sommerfeld Operators the sampling of the resulting field can be adjusted via the panel

shown in Fig. 657.
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ITEM DESCRIPTION

Automatic Sampling The correct sampling of the output field is ensured by VirtualLab Fusion.

Oversampling Factor PV The greater this factor the more sampling points will be in the output field.

A factor of 1 (default) means the number of sampling points VirtualLab Fu-

sion uses normally for automatic sampling. Increasing this factor increases

the number of sampling points and decreases the sampling distance accord-

ingly. Vice versa, setting this factor to values between 0 and 1 decreases the

number of sampling points.

This item is only visible if Automatic Sampling is selected.

Manual Sampling In this mode you can adapt either the Sampling Points or the Sampling Dis-

tance if you want to find the best compromise between numerical errors and

calculation time. The Array Size is just given for information.

Copy Active Parameters

from

This button allows you to select another harmonic field, from which either the

Sampling Points or the Sampling Distance are copied, depending on what

items are activated.

Sampling Points Allows you to specify the number of sampling points for both directions.

Sampling Distance Allows you to specify the sampling distance for both directions.

Array Size For your information, the array size (i. e. Sampling Points × Sampling Dis-

tance) is given.

Size of Embedding Frame

(Sampling Points)

You can add a zeroized frame around the output with the given width in sam-

pling points.

Total Sampling Points This value corresponds to Sampling Points + 2 × Size of Embedding Frame.

Total Array Size This value gives the total array size, i. e. the Array Size plus the size of the

embedding frame.

92.3 Size and Shape of Output Field

Figure 658. Panel for setting size and shape of output field.

For the two Rayleigh Sommerfeld Operators as well as the Geometrical Optics Operator, the size and shape

of the resulting field is adjustable. The concerning dialog tab is shown in Fig. 658.
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ITEM DESCRIPTION

Automatic Setting The correct size of the output field is ensured by VirtualLab Fusion.

Field Size Factor PV The greater this factor the larger the output field will be. A factor of 1 (default)

means the field size VirtualLab Fusion uses normally as automatic setting.

Increasing this factor increases the field size. Vice versa, setting this factor

to values between 0 and 1 decreases field size.

This item is only visible if Automatic Setting is selected.

Manual Setting In this mode you can adapt the Shape, the Diameter, and the Edge Width.

Shape You can choose whether a Rectangular or Elliptical virtual aperture is applied

to the output field. Standard for automatic sampling is a rectangular virtual

aperture.

Diameter Determines the field size for both x- and y-direction.

Relative Edge Width The width of the virtual aperture relative to the field size.

Absolute Edge Width The width of the virtual aperture in physical coordinates.

Size of Embedding Frame

(Sampling Points)

You can add a zeroized frame around the output with the given width in sam-

pling points.

This parameter is only available for the Geometrical Optics Operator.

93 Free Space Operators

VirtualLab Fusion offers a large variety of free space propagation operators which can be used for homoge-

neous, isotropic media. These operators can be used for the linkages of the Optical Setup (↪→Sec. 93.1). All

operators having an icon in the following table can be used via the Propagations ribbon tab of Harmonic Fields

and Harmonic Fields Set as well.
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OPERATOR DESCRIPTION

Automatic Propagation

Operator

Automatic selection of light propagation method that is physical sufficiently

accurate but also as fast as possible. The propagation method tests the phys-

ical accuracy of Spectrum of Plane Waves Operator, Fresnel Operator, Far

Field Operator, and Geometrical Optics Operator. ↪→Sec. 93.2

Far Field Operator Paraxial and non-paraxial light propagation from beam waist to far field, far

field to beam waist and from far field to any other far field plane. ↪→Sec. 93.3

Geometrical Optics Op-

erator

Light propagation in geometrical optics approximation. Diffraction and inter-

ference effects are neglected. ↪→Sec. 96.1

Spectrum of Plane

Waves Operator

Rigorous light propagation. ↪→Sec. 93.4

Rayleigh Sommerfeld Op-

erator

( Convolution & Sum-

mation)

Rigorous light propagation. ↪→Sec. 93.5

Fresnel Operator Light propagation in paraxial approximation. ↪→Sec. 93.6

Combined SPW/Fres-

nel Operator

Light propagation in paraxial approximation that combines Spectrum of Plane

Waves Operator and Fresnel Operator to improve the calculation speed and

reduce the required RAM memory. ↪→Sec. 93.7

Rayleigh Expansion Prop-

agation

O G O S .

Rigorous light propagation of propagating and evanescent diffraction orders

behind a grating. ↪→Sec. 93.8

Cells Array Propagation O L S O S .

Light propagation after grating cells arrays. ↪→Sec. 93.9

Geometric Rotation Oper-

ator

O 2D , 1D .

An operator for rotating fields in geometrical optics approximation.

↪→Sec. 93.1.1

Diffractive Rotation Oper-

ator

O 2D , 1D .

A rigorous operator for rotating fields. ↪→Sec. 93.1.2

93.1 Propagation between Optical Setup Elements

O C F T G L R O S .

Generally, the propagation of a field between Optical Setup Elements is equivalent to propagating the field

between two arbitrarily positioned planes. These planes are related to the Optical Setup Elements involved

and are called transfaces. This is a special shortcut for “transfer interface” and means the location of the field

transfer between two kinds of operators. The output transface τ1 of the start element is the plane where the

output of the propagation through this element is given to the homogeneous medium free space operator. The

input transface τ2 of the target element is the plane where the output of the free space operator is given to the

propagation operator of the second element.

The position and orientation of the output transface – the starting point for the homogeneous medium free space

operator – is determined by the propagation through the start element and the type of the reference output

coordinate system chosen for this element (but the output coordinate system does not have to be identical to

this transface’s position and orientation). It is stored after the element’s propagation in the coordinate system of
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the field itself: the origin of this coordinate system is identical to the position of the transface and the orientation

is given by the coordinate system’s x-y-plane.

The position and orientation of the input transface – the end point for the homogeneous medium free space

operator – is determined by the geometry of the target element and, of course, the relative position of the target

element to the start element.

There are two general cases to be distinguished for the propagation between Optical Setup Elements, related

to two different algorithms used for propagating the field from output transface τ1 to input transface τ2:

1. The planes τ1 and τ2 are parallel. The algorithm used for this configuration is shown in Fig. 659.

2. The planes τ1 and τ2 are not parallel. The algorithm used for this configuration is shown in Fig. 660.

Please note: this case cannot be simulated with 1D fields.

X

Y Z

X

Y Z

1: Free Space
Propagation

2: Shift
zS

zT

X

Y Z

Figure 659. Algorithm for the propagation between Optical Setup Elements where output transface and input transface

are parallel. There are two operations at most: the actual free space propagation followed by a lateral shift.



CHAPTER 93. FREE SPACE OPERATORS 770

X

Y Z

X

Y Z

1: Free Space
Propagation

zS

X

Y Z

2: Truncation (with
recentering)

X

Y Z

X

Y Z

X

Y Z

X

Y Z

X

Y

Z

3: Tilt

X

Y Z

zT4: Shift

X

Y

Z

X

Y

Z

Figure 660. Algorithm for the propagation between Optical Setup Elements where output transface and input transface

are not parallel. The operators 1: actual free space propagation and 3: rotation operation can be configured by the user.

In the following, only those two steps of the complete algorithm will be described which can be configured by

the user himself:



CHAPTER 93. FREE SPACE OPERATORS 771

1. The free space operator used to propagate the free space distance between two parallel planes.

2. The rotation operator which is used if the input transface of the target element is rotated relative to the

output transface of the start element. Please note: This operator cannot be used with 1D fields.

More information on coordinate systems can be found in Sec. 43.8.

The configuration dialogs of both of these operators can be accessed via the dialog shown in Fig. 661, having

two tab pages.

Figure 661. The dialog to select the propagation method which shall be used for simulating the free space between the

start element and the target element of a linkage.

TAB PAGE DESCRIPTION

Free Space Operator On this tab page you can select one of the available free space operators.

Depending on the type of the Optical Setup (↪→Sec. 43.11) different operators

are available. The Edit button opens the edit dialog of the currently selected

operator, explained in the corresponding help chapter (see below).

Rotation Operator On this tab page you can choose between the Geometric Rotation Operator

(↪→Sec. 93.1.1) and the Diffractive Rotation Operator (↪→Sec. 93.1.2). The

Edit button opens the edit dialog of the currently selected operator which is

explained in the corresponding help chapter.

93.1.1 Geometrical Rotation Operator

Fig. 662 shows the edit dialog of the Geometric Rotation Operator.

Figure 662. Dialog for setting the approximation parameters for the Geometric Rotation Operator.

The following parameters can be specified on the Approximation Parameters tab page:
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ITEM DESCRIPTION

Phase Derivative Approxi-

mation Level

The Geometric Rotation Operator works with direction information that is de-

rived from the phase of the incident light. The directions are typically evalu-

ated by fitting a smooth function into the phase of the incident field. The user

can define which type of smooth phase function shall be fitted. Alternatively

the local derivative can be used to evaluate the direction data numerically.

Polynomial Degree In case of polynomial fit this number defines the maximal exponent sum m+ n
of the basis monomials xm · yn used for the phase fit. The default value is 6.

Tube Resolution The user can specify whether the tubes shall be defined automatically or man-

ually. In Automatic mode the user can specify an Accuracy Factor PV which

increases the number of tubes that are used within the geometrical optics op-

erator. Alternatively the user can specify the Number of Tubes PV directly in

Manual mode.

The size and sampling of the target field can be specified on the Target Field Sampling tab page which is shown

in Fig. 663.

Figure 663. Dialog for setting the target field size and sampling for the Geometric Rotation Operator.

The user can enter the following parameters:

ITEM DESCRIPTION

Sampling in Target Plane The user can specify whether the sampling distance / number of sampling

points of the target field shall be set automatically. In Automatic mode the

user can specify an Oversampling Factor PV which can be used to increase

the resolution of the output field. Alternatively the user can specify the number

of Sampling Points PV or the Sampling Distance PV directly in Manual mode.

Field Size Factor PV The Geometric Rotation Operator uses the same algorithm to estimate the

field size of the output field as the Diffractive Rotation Operator. By adapting

the Field Size Factor this field size can be increased or decreased.
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93.1.2 Diffractive Rotation Operator

Figure 664. Dialog for setting the parameters for the Diffractive Rotation Operator.

There are only two parameters which can be set for the Diffractive Rotation Operator in its edit dialog

(↪→Fig. 664):

ITEM DESCRIPTION

Field Size Factor PV Factor by which the field size of the resulting field of the rotation operation will

be enlarged in each direction.

Oversampling Factor PV Factor by which the sampling distance of the resulting field of the rotation

operation will be reduced in each direction.

93.2 Automatic Propagation Operator

The Automatic Propagation Operator selects the appropriate propagation operator from either SPW Operator

(↪→Sec. 93.4), Fresnel Propagation Operator (↪→Sec. 93.6), Far Field Operator1 (↪→Sec. 93.3), and Geometrical

Optics Operator (↪→Sec. 96.1). The selection is based on finding a compromise between numerical accuracy

and numerical effort required for computing the propagated field. The selection algorithm is shown in Fig. 665.

Figure 665. Flowchart for the selection algorithm applied by the automatic propagation operator.

Both the deviation of the propagation operator and its numerical effort are estimated by one-dimensional cal-

culations and a comparison with a SPW reference result in 1D. The primary criterion for selecting the operator

1 All three modes of the non-paraxial Far Field Operator are tested.
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is that the deviation must not exceed a certain fraction of the total energy of the field. This is the Deviation

Threshold specified in the Accuracy tab. From the admissible set of operators (deviation below limit), the op-

erator with the lowest numerical effort is selected. Further, the numerical effort is assumed to be some limit

(number of sampling points). The effort limit is taken from the value Maximum Number of Sampling Points

per Field defined in the Global Options, ↪→Sec. 6.14. Furthermore, the parameter Power Portion for Field Size

Estimation (↪→Sec. 6.12) is used to estimate the field size of the propagated field. A more detailed description

is given in [WK11].

The different implementations of this operator for the main window and the Optical Setup (↪→Sec. 43) are

discussed in the following subsections.

93.2.1 Implementation in the Main Window

If the automatic propagation is used in the main window you can do an analysis prior to the actual propagation

by clicking on the Analyze button. The resulting window as shown in Fig. 666 displays the estimated values for

deviation and numerical effort and the estimated sampling of the propagated field. In the case of a Harmonic

Fields Set, the analysis can be done per member field by selecting the index of the member and Analyze it.

The operator used for the actual propagation can depend on the selected member.

Figure 666. Results of the analysis if the automatic propagation is used in the main window.

The tab for editing the general Propagation Parameters is shown in Fig. 667.

ITEM DESCRIPTION

Propagation Distance The propagation distance.

SPW Operator If checked, the SPW Operator can be selected.

Fresnel Propagation Op-

erator

If checked, the Fresnel Propagation Operator can be selected.

Far Field Operator If checked, the Far Field Operator can be selected.

Geometrical Optics Oper-

ator

If checked, the Geometrical Optics Operator can be selected.

Analyze Press this button to perform the analysis, compute estimates for deviation

and numerical effort. Displays the results and the selected operator.

Ok Starts the actual propagation.
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Figure 667. Dialog for editing the settings of the Automatic Propagation Operator.

Via the Accuracy tab you can set the following:

ITEM DESCRIPTION

Accuracy Factor The accuracy factor for the individual operators. It also influences the esti-

mate of the size of the propagated field.

Deviation Threshold The fraction of the total energy of the field which “suitable” propagation tech-

niques must not exceed.

Power Portion for Field

Size Estimation

The Power Portion for Field Size Estimation specifies howmuch of the energy

of the incoming field is present in the output field. This value must be below

100 %. A higher value means both increased accuracy and computational

effort.

Analysis for one member

only

If checked, you can select which member field determines the used propaga-

tion operator. If unchecked, the propagation operator is determined indepen-

dently for each member field.

Figure 668. Panel for accuracy settings.

93.2.2 Implementation in the Optical Setup

If the automatic propagation is used within the Optical Setup (↪→Sec. 43), no separate analysis can be done.

However, corresponding information can be found in the logging window (↪→Sec. 43.6.8) after the simulation is

finished.

The tab for editing the general Propagation Parameters has the following parameters.
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ITEM DESCRIPTION

SPW Operator If checked, the SPW Operator can be selected.

Fresnel Propagation Op-

erator

If checked, the Fresnel Propagation Operator can be selected.

Far Field Operator If checked, the Far Field Operator can be selected.

Geometrical Optics Oper-

ator

If checked, the Geometrical Optics Operator can be selected.

Via the Accuracy tab you can set the following:

ITEM DESCRIPTION

Accuracy Factor PV The accuracy factor for the individual operators. It also influences the esti-

mate of the size of the propagated field. This setting might also be set for the

whole Optical Setup via the Property Browser (↪→Sec. 43.4.7.1).

Deviation Threshold PV The fraction of the total energy of the field which “suitable” propagation tech-

niques must not exceed. This setting might also be set for the whole Optical

Setup via the Property Browser (↪→Sec. 43.4.7.1).

Power Portion for Field

Size Estimation PV

The Power Portion for Field Size Estimation specifies howmuch of the energy

of the incoming field is present in the output field. This value must be below

100 %. A higher value means both increased accuracy and computational

effort.

Analysis for one member

only

If checked, you can select which member field determines the used propaga-

tion operator. If unchecked, the propagation operator is determined indepen-

dently for each member field.

The setting Analysis for one member only available in the main window can be set only for the whole Optical

Setup via the Property Browser (↪→Sec. 43.4.7.1).

93.3 Far Field Operator

Figure 669. Dialog of the Far Field Operator.

The Far Field Operator has the dialog shown in Fig. 669. Its Propagation Parameters tab allows the user to

enter the propagation distance and the propagation mode. Three different propagation modes are supported:

propagation fromWaist to Far Field, Far Field to Waist, and Far Field to Far Field. Additionally it is possible to

select between the general Far Field Operator (Non-Paraxial) and a Paraxial (Fraunhofer) approximation. The

Accuracy tab is explained in Sec. 92.1.

If used in the Optical Setup, thePropagation Distance cannot be set as it is determined from the positions

of the Optical Setup Elements. Thus, the corresponding controls are not visible.
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The implemented formulas are given in Sec. 136.1.2.

93.4 Spectrum of Plane Waves Operator

Figure 670. Dialog of the propagation with spectrum of plane waves (SPW), Fresnel transform or a combination of both.

If this operator is used for a linkage (↪→Sec. 93.1) its edit dialog has only the Accuracy tab explained in Sec. 92.1.

If used in the main window, there is an additional Propagation Parameters tab with the following controls:

ITEM DESCRIPTION

Propagation Distance The propagation distance. Can be positive and negative.

The implemented formulas are given in Sec. 136.1.3.

93.5 Rayleigh Sommerfeld Operator

Figure 671. Dialog of the propagation with Rayleigh Sommerfeld Convolution operator showing the Propagation Parame-

ters tab. The dialog for the Rayleigh Sommerfeld Summation operator is equivalent.

For this propagation operator two distinct numerical implementations are available (↪→Sec. 136.1.4), namely

Rayleigh Sommerfeld Convolution and Rayleigh Sommerfeld Summation. The corresponding dialog

(↪→Fig. 670) has three tab pages which are explained in ↪→Sec. 92.

If used in the main window, there is an additional Propagation Parameters tab with the following controls:

ITEM DESCRIPTION

Propagation Distance The propagation distance. Can be positive and negative.

93.6 Fresnel Propagation Operator

If the Fresnel Propagation Operator is used for a linkage (↪→Sec. 93.1) its edit dialog (↪→Fig. 670) has only the

Accuracy tab explained in Sec. 92.1. If used in the main window, there is an additional Propagation Parameters

tab with the following controls:

ITEM DESCRIPTION

Propagation Distance The propagation distance. Can be positive and negative.

The implemented formulas are given in Sec. 136.1.5.

93.7 Combined SPW / Fresnel Operator

This propagation operator automatically combines the spectrum of plane waves propagation (↪→Sec. 93.4) and

the Fresnel propagation (↪→Sec. 93.6) to achieve an efficient propagation of paraxial waves free of numerical
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errors. For propagation of harmonic fields close to the waist of a wave, spectrum of plane waves is used. For

larger distances the Fresnel propagation is used. Sec. 136.1.6 explains in more detail when which propagation

is used.

If this operator is used for a linkage (↪→Sec. 93.1) its edit dialog (↪→Fig. 670) has only an Accuracy tab where

you can set the accuracy factor (↪→Sec. 92.1). If used in the main window, there is an additional Propagation

Parameters tab with the following controls:

ITEM DESCRIPTION

Propagation Distance The propagation distance. Can be positive and negative.

93.8 Rayleigh Expansion Propagation

O G O S .

Figure 672. The Dialog for the Rayleigh Expansion Propagation.

This free space operator can take advantage of the Rayleigh coefficients calculated by rigorous methods. It

has the following options:

ITEM DESCRIPTION

Always Return Two-

Dimensional Fields

If the grating component is set to 1D-periodic mode (↪→Sec. 64.1) or if for

one direction only one order is calculated by the FMM (↪→Sec. 96.3.1.1), the

resulting fields will be one-dimensional. However, the two-dimensional field

view can be more intuitive. Thus you can enforce two-dimensional fields by

checking this option.

Number of Periods PV Sometimes it can be more intuitive if more than one period is shown, which

can be set with this option. For 2D-periodic gratings this setting affects both

x- and y-direction of the resulting field.

Output Field Oversam-

pling Factor PV

The number of sampling points per period is the number of calculated diffrac-

tion orders times the Output Field Oversampling Factor.

Apply Evanescent Field

Filter

Evanescent waves vanish after a very short propagation distance. By check-

ing this option you can enforce that they vanish even for a propagation dis-

tance of zero.

The implemented algorithm is documented in Sec. 136.1.7.

93.9 Cells Array Propagation

O L S O S .
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This free space operator is available after the Light Shaper component. The Grating Cells Array performs a

mode decomposition, where all modes have the same intensity distribution but are located in different positions

and have different propagation directions. The free space operator uses these analytic information of the light

field object in the input plane and calculate the positions of the modes in the output plane. Additionally the

intensity distribution of all modes is propagated by wave optical propagation techniques into the target plane.

This propagation operator can be selected by the user. The user can use the Far Field Operator (↪→Sec. 93.3)

or the Automatic Propagation Operator (↪→Sec. 93.2). By default the Far Field Operator is used. The output of

the free space operator is a new light field object which contains the propagated mode and the analytic stored

positions and directions for all modes. This light distribution can be used for further investigations within the

Camera Detector (↪→Sec. 74.5.2).

Figure 673. The Dialog for the Cells Array Propagation

Fig. 673 shows the edit dialog of the Cells Array Propagation. Its has the following controls.

ITEM DESCRIPTION

Propagation Operator Here you can choose between Far Field Operator or Automatic Propagation

Operator as wave optical propagation.

Edit Edits the currently selected propagation operator.

Accuracy Factor Influences the spot size in the target plane of the propagated wave. An ac-

curacy factor of 1 means that 95% of the power of the propagated spots will

be used for further investigation. Increasing the Accuracy Factor by 1 means

that 0.5% will be added to this power portion. So an Accuracy Factor of 11

means that 100% of the propagated field will be used.

94 2D / 3D Propagation

For Harmonic Fields, Harmonic Fields Sets, and Ray Distributions in the main window there is the ribbon

button Propagations > 2D Propagation / Propagations > 3D Propagation (depending on the dimensionality of

the field). This button opens a dialog to create a Parameter Run in which the field is propagated by different

distances. From this Parameter Run you then can generate instructive diagrams or animations showing how

the field evolves, see Fig. 674 for an example.
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Figure 674. Interference of two Gaussian beams. This is the result of a one-dimensional Harmonic Field propagated to

different distances with the 2D Propagation feature. The results where then combined into a two-dimensional data array.

Said dialog (↪→Fig. 675) has the following options.

ITEM DESCRIPTION

Propagation Method O H F H F S

You can select and Edit any of the operators listed in Sec. 93 which are suit-

able for both one- and two-dimensional harmonic fields.

Start Point The minimum propagation distance.

End Point The maximum propagation distance.

Number of Propagation

Steps

The number of propagation steps between the start point and the end point

(including).

Remove Constant Phase

Factor exp(ikz)

O H F H F S

During the propagation typically a constant phase factor exp(ik∆z) depending
on the propagation distance will occur. Its fast oscillation along the optical axis

makes it difficult to notice the change of the phase, the real and imaginary part

of the harmonic field during the propagation. Enable this option to remove the

constant phase factor (recommended for real and imaginary part and phase

display).

Figure 675. The dialog for defining a 3D Propagation for a Harmonic Field or Harmonic Fields Set.

When this dialog is closed with OK, a Parameter Run (↪→Sec. 44) with the appropriate settings is created
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and started automatically. After the Parameter Run completes you can create a nice-looking combined output

(↪→Sec. 44.5.1).

95 Propagation through Idealized Systems

The Propagations tab for Harmonic Fields and Harmonic Fields Sets also offers the possibility to propagate

through simple, idealized setups. 1f-Setup and 2f-Setup are described in Sec. 31.1.1. ABCD Matrix Simulation

is described in the following section.

95.1 ABCD Matrix Simulation

Availability

Toolboxes: All

Accessible: Harmonic Field and Harmonic Fields Set: Propagations > ABCD Matrix Simulation

This function is a generalization of the 1f-Setup / 2f-Setup (↪→Sec. 31.1.1): You can define an arbitrary sys-

tem as ABCD matrix through which the current Harmonic Field or Harmonic Fields Set is propagated in an

idealized way. VirtualLab Fusion also offers the ABCD Law Calculator (↪→Sec. 104) which has similar function-

ality for Gaussian waves. Furthermore, in an Optical Setup you can use the ABCD Matrix Setup component

(↪→Sec. 73.1).

Figure 676. Dialog for defining the parameters of an ABCD matrix propagation.

Fig. 676 shows the edit dialog for an ABCD matrix simulation. It has the following controls:
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ITEM DESCRIPTION

Simulation Type You can choose between three methods (Collins Integral, Spectrum of Plane

Waves, and Rayleigh-Sommerfeld Convolution). See Sec. 134.1 for an ex-

planation of these methods.

Allow Scaling of Field Pa-

rameters during Propaga-

tion

If checked, the field will be resampled to avoid numerical problems. This

option is only available if the matrix element B is not zero.

Propagate Inverse by Us-

ing Inverted Matrix

Using the inverse ABCD matrix corresponds to an inverse propagation. Thus

this checkbox allows you to invert the ABCD matrix being used for the simu-

lation.

Resulting ABCD Matrix Shows the automatically calculated ABCD Matrix of the combination of the

optical elements.

ABCD Matrix Control Allows you to define the system ABCD matrix by composing it of an arbitrary

number of optical elements. ↪→Sec. 5.16

96 Propagation Operators for Real Components

For real components in the Optical Setup (↪→Sec. 43), the following propagation operators are available:

COMPONENT PROPAGATION ANNOTATIONS

Collins Integral by ABCD Matrix

(For Spherical Lens & Lens System)

This operator uses the ABCD matrix of the component and thus

can handle only certain surface types and homogeneous media.

All propagation settings are synchronized. ↪→Sec. 96.5

Customized Propagation

(For Double Surface Component, Fiber Ele-

ment, GRIN Component & Inhomogeneous

Medium Component.)

Uses Thin Element Approximation (↪→Sec. 96.2) propagations for

surfaces; several paraxial free space propagations for homoge-

neous media (↪→Sec. 93) and either the Thin Element Approxima-

tion or the Split Step (BPM) propagation (↪→Sec. 96.6) for inho-

mogeneous media. The settings are synchronized separately for

each building block type.

Fourier Modal Method

(For General Grating)

All propagation settings are synchronized. ↪→Sec. 96.3

Geometrical Optics

(For Light Shaper)

–

Geometrical Optics Operator

(For Curved Surface, Spherical Lens & Lens

System)

This operator can handle smooth surfaces and homogeneous me-

dia. All propagation settings are synchronized. ↪→Sec. 96.1

96.1 Geometrical Optics Operator

The Geometrical Optics Propagation Operator is available both for free space propagation through homoge-

neous media and for propagation through real components. It is based on the principles of geometrical optics.

The propagation is performed along rays. In our case, the direction of rays is defined by so called Channels.

Rays within one channel have different position but the same direction. The operator first builds up the chan-

nels. In a second step, rays are propagated. In the first step, the directions of the channels have to be computed

in the initial plane from the field data. In particular the phase of the field is used. The actual phase of the field
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is replaced by a fitted phase using different levels of approximation: Constant phase, Linear phase, linear and

Spherical phase, linear, spherical and Cylindrical phase. From this phase approximation the directions of the

channels are computed. Alternatively the Local Gradient of the phase can be used to define the channel direc-

tions. Further, the channels are defined throughout the system by stepping from surface to surface. Depending

on the settings of the operator, this procedures takes Refraction into account or not. Once the channels are

defined, the rays carrying the field information are propagated through the system. The path of the rays is

defined by the channels. Depending on the settings of the operator Fresnel Effects and Cross Talk is taken into

account or not.

A detailed description of the operator is given in an external paper. An explanation of the Size and Shape of

Output Field tab is given in Sec. 92.3.

The Propagation Parameters tab (↪→Fig. 677) has the following parameters:

ITEM DESCRIPTION

A: Constant Take (0, 0, 1) as direction of rays in the input plane.

B: Linear Perform a fit of a linear phase for defining the directions of rays in the input

plane.

C: B + Spherical Perform a fit of a linear and spherical phase for defining the directions of rays

in the input plane.

D: C + Cylindrical Perform a fit of a linear, spherical and cylindrical phase for defining the direc-

tions of rays in the input plane.

E: Polynomial Perform a general polynomial fit of the phase for defining the directions of rays

in the input plane. The maximal exponent sum m + n of the basis monomials

xm · yn can be set on the Accuracy tab

F: Local Gradient Take the local gradient for defining the directions of rays in the input plane.

I: Optical Path Length Consider the optical path length only during tracing rays through the system.

II: I + Fresnel Consider the optical path length and Fresnel effects during tracing rays

through the system.

III: I + Refraction Consider the optical path length and refraction during tracing rays through the

system.

IV: III + Fresnel Consider the optical path length, refraction and Fresnel effects during tracing

rays through the system.

V: IV + Cross Talk: Consider the optical path length, refraction, Fresnel effects and cross-talk

between Ex and Ey during tracing rays through the system.
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Figure 677. Dialog for editing the Geometrical Optics Operator showing the tab with propagation parameters.

The Accuracy tab (↪→Fig. 678) has the following parameters:

ITEM DESCRIPTION

Number of Channels Number of channels being used.

Accuracy Factor PV In the automatic mode, the accuracy factor (I) scales the number of channels

being used.

Number of Rays to Be

Traced

Sets the number of rays that are to be traced. These numbers correspond to

the number of sampling points of the output field.

Accuracy Factor PV In the automatic mode, the accuracy factor (II) scales the number of rays

being traced.

Polynomial Degree In case that option E: Polynomial is being selected, this number defines the

maximal exponent sum m + n of the basis monomials xm · yn used for the

phase fit.
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Figure 678. Tab for editing the accuracy settings.

96.1.1 Advanced Settings

If for a Curved Surface, Lens System, or Spherical Lens you have selected Geometrical Optics Operator as

Component Propagation, the Advanced Settings sub-tab of the Propagation tab allows you to choose whether

you want to Minimize Use of Geometric Optics or not (↪→Fig. 679). This is important for concave surfaces only,

as there is no difference between these options in the case of non-concave ones.

Figure 679. Advanced Settings tab for the geometrical optics operator.

ITEM DESCRIPTION

No (faster) Wave-optical propagation techniques are used till the aperture plane is

reached, then geometrical optics is applied. This is the faster option, but

at the expense of less accuracy.

Yes (slower) The use of wave-optical propagation techniques is maximized, but at the ex-

pense of a slower calculation.



CHAPTER 96. PROPAGATION OPERATORS FOR REAL COMPONENTS 786

96.2 Thin Element Approximation

Figure 680. Propagation Parameters tab for the thin element approximation operator.

The thin element approximation can be used for propagating through surfaces, homogeneous and inhomoge-

neous (index modulated) media. It is assumed that paraxial/parabasal conditions hold. The paraxial mode is

documented by [Goo68]. Using the paraxial mode, the method is identical to the modeAI/AII of the geometrical

optics operator, see Sec. 96.1. The implemented algorithm is documented in Sec. 136.2.1.

The edit dialog (↪→Fig. 680) has two tabs: The Propagation Parameters tab explained below and the Accuracy

tab explained in Sec. 92.1.

The Propagation Parameters tab consists of a table with the following options:

ITEM DESCRIPTION

A: Paraxial Take (0, 0, 1) as direction of rays in the input plane.

B: Parabasal Perform a fit of a linear phase for defining the directions of rays in the input

plane. This option will be available in a future version of VirtualLab Fusion.

I: Optical Path Length Consider the optical path length only during tracing rays through the system.

II: I + Fresnel Consider the optical path length and Fresnel effects during tracing rays

through the system. This option is not available if the parabasal operator

is used for inhomogeneous or homogeneous media.

96.3 Fourier Modal Method / Rigorous Coupled-Wave Analysis

O G P .

The Fourier Modal Method (FMM) or Rigorous Coupled-WaveAnalysis (RCWA) is a rigorous propagation tech-

nique. This method demands the periodicity of all physical values that are involved in the associated setup,

i. e. the analyzed structure and the input field and consequently also the output field have to be periodical1

(↪→Fig. 681). For more details about the FMM see [Kno78; Li96; Tur97; Li01].

1 A grating component is per definition periodical and an ideal plane wave fulfills the appropriate condition too.
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Figure 681. Physical setup which is expected for analyses using the Fourier Modal Method.

The FMM requires a structure built up by a sequence of discrete arbitrary cells which are characterized by

their complex refractive index ( ↪→Fig. 681). The sizes of these cells define so called transition points in lateral

direction which create a sequence of layers in longitudinal direction on their part1. To analyze non-discrete

structures configure the FMM to use a sufficient large number of layers and transition points.

Order Limit of the FMM

A maximum of 23 170 grating orders can be analyzed by the FMM. For 1D-periodic gratings this corre-

sponds in best case to a period of roughly 12 000 × wavelength. But for 2D-periodic gratings this limit

translates to e. g. 152 × 152 orders or at most (75 × wavelength)2. However, RAM consumption and

computational effort increase very rapidly with the number of orders, so that the practical limit is much

lower.

96.3.1 Editing the Fourier Modal Method

There are in principle two things you can edit for the FMM: the number of diffraction orders (↪→Sec. 96.3.1.1)

and how the grating to analyze is decomposed into blocks of constant refractive indices (↪→Sec. 96.3.1.2). In

the edit dialog of the FMM they can be edited on different tab pages.

96.3.1.1 Setting the Number of Diffraction Orders

One numerical parameter for the FMM is the overall number of diffraction orders considered during calculation.

A higher number means increased accuracy but higher numerical effort. Fig. 682 show the controls to edit this

as well as the additional information label.

1 Hereby one period can also contain any periodical substructures.
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Figure 682. The Numerical Parameters tab of the FMM where you can adjust the number of calculated orders in case of

a 2D-periodic grating.

You can either specify the Number of Diffraction Orders PV or the Number of Evanescent Orders PV . In the

first case you can specify the number of diffraction orders directly. In the latter case, the overall number of

diffraction orders calculated by the Fourier Modal Method is the number of evanescent orders plus the number

of propagating orders. The dialog ensures that always an odd number (greater or equal 3) of diffraction orders

is calculated.

The information gives the following information:

ITEM DESCRIPTION

Number of calculated

diffraction orders

The number of orders calculated by the FMM.

Number of propagating

orders

This number is calculated for reflection and transmission from the grating

equation (↪→Sec. 139.5) for perpendicular incident. As this information de-

pends on the wavelength, you can set the preview wavelength which is then

also used for the decomposition preview (↪→Sec. 96.3.1.3, Sec. 96.3.1.4).

For a 2D periodic grating you can specify the numbers of orders separately for the x- and the y-direction.

96.3.1.2 Decomposition into Layers and Transition Points

The transition points are always generated for the range −Period/2 . . . + Period/2, but are stored internally

with positive positions. Thus, the x-coordinates in the decomposition preview are shifted by half a period

in comparison to all other previews and results.
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Figure 683. The Structure Decomposition tab of the FMM in case of a 2D-periodic grating component with two stacks.

With the controls shown in Fig. 683, you can adjust the decomposition of a real structure into Layers and

Transition Points on the Advanced Settings sub-tab.

This tab page comprises three parts. In the upper part you can adjust the layer decomposition with the following

settings:

ITEM DESCRIPTION

Automatic The layer decomposition is done automatically.

Accuracy Factor PV A greater value means that the decomposition lasts longer and that more lay-

ers are generated, which increases the calculation time of the Fourier Modal

Method. (Doubling the number of layers means roughly double the calcula-

tion time.)

Manual An equidistant layer decomposition is used.

Number of Layers PV The specified number of layers is distributed equidistantly over the modulated

region. If stacks are placed on both surfaces of the grating component, the

number of layers is used per stack.

Overall Thickness The overall thickness of the modulated region, which is is the sum of the

extensions of the two stacks.

In the middle part of the tab page you can adjust the transition point decomposition with the following settings:
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ITEM DESCRIPTION

Automatic The transition point decomposition is done automatically as described in a

technical note. The size of the smallest detectable features is given in the

info label.

Accuracy Factor PV A greater value means that smaller features are detectable but also that the

decomposition lasts longer.

Manual The transition points are distributed equidistantly. Each layer has the same

number of transition points.

Number of Points The specified number of transition points is distributed equidistantly over one

Period of the structure.

Point Distance PV Instead of the Number of Points the user can also specify the distance be-

tween transition points. Then, the number of points is calculated from this

value and the Period.

Period The period of the modulated region.

The lower part contains an information label and the following controls:

ITEM DESCRIPTION

Remove Redundant Data Especially if you have set the decomposition to Manual redundant data may

occur (i. e. transitions between identical refractive indices or layers with the

same refractive index distribution). If you check this item, such redundant

data is removed after the decomposition.

Decomposition Preview Opens a preview of the resulting decomposition. The preview for 1D-periodic

gratings is explained in Sec. 96.3.1.3 and the preview for 2D-periodic gratings

in Sec. 96.3.1.4.

The information label gives the following information:

ITEM DESCRIPTION

(Maximum) Total number

of layers

The total number of layers including one layer for the base block. In case Re-

move Redundant Data is checked this gives the maximum number of layers

– which is only reached if there are no redundant layers.

Minimum transition point

distance

The size of the smallest detectable feature. If no such small features are

present in the structure, Automatic decomposition yields only larger distances

between consecutive transition points.

Transition point distances of less than 0.1 nm can only be resolved in Manual mode without Remove

Redundant Data.
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96.3.1.3 Decomposition Preview for 1D-Periodic Gratings

Figure 684. The Transition Point Preview showing a combination of a volume grating with a triangular grating.

The decomposition preview (↪→Fig. 684) has a diagram tab and a table tab showing the layers and transition

points used for the Fourier Modal Method. Furthermore, the overall dimensions of the grating component are

given.

The positions in the table tab are “up-to-positions”. In the example given in Fig. 685, the refractive index 1.4611

is in the range from 1.3989 µm to 1.6011 µm. The Reference Wavelength used for the calculation of the

refractive indices can be set on the bottom of the dialog.

Figure 685. Example showing a part of the table tab of the decomposition preview for 1D-periodic gratings

In the diagram tab, the data is shown in a data array view (↪→Sec. 13.5). In particular, the view has the same

context menu which allows you to change the shown field quantity (↪→Sec. 11.1) to e. g. imaginary part, change

the aspect ratio (↪→Sec. 11.5) or the color table (↪→Sec. 11.2.4).

Furthermore you can zoom via mouse wheel or via the context menu, exactly as for data arrays (↪→Sec. 11.4).

However, this zooming always scales both dimensions of the data array. Thus a better suited Zoom tool is

available for this preview: If you click on the Zoom button, a separate dialog is shown where you can specify

exactly the rectangular region to be shown in the diagram. If you click Show Whole Component on said dialog,

you can reset the view to show the complete data. If the grating component contains only one stack, then this

stack is shown by default. Otherwise the whole component is shown. The table always shows the complete

data.

The -button shows the currently set up diagram as separate data array view (↪→Sec. 13.5).
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96.3.1.4 Decomposition Preview for 2D-Periodic Gratings

Figure 686. The decomposition preview for 2D-periodic gratings.

The decomposition preview for 2D-periodic gratings shows the refractive index distribution of one period in the

currently selected layer, either as Diagram or as Table. In the lower section of the dialog you can set up the

Reference Wavelength used for the calculation of the refractive indices as well as the Layer Index. As further

information the position and thickness of this layer are given.

Figure 687. Example showing a part of the table tab of the decomposition preview for 2D-periodic gratings.

Non-equidistant data arrays are used for the preview (↪→Sec. 13). In particular, the view has the same context

menu which allows you to change the shown field quantity (↪→Sec. 11.1) to e. g. imaginary part, zoom into the

view (↪→Sec. 11.4), change its aspect ratio (↪→Sec. 11.5) or the color table (↪→Sec. 11.2.4).

Via the context menu of the table you can copy the current selection to the Windows™ clipboard. Via the

-button you can generate a separate data array document of the current view.

The constant interval interpolation is used (↪→Sec. 13.2.1) and thus the positions in the table are “from-positions”.

In the example given in Fig. 687, the block with the refractive index of 1.4611 covers the x-range from 323.4 nm

to 676.6 nm.

96.4 Custom Fourier Modal Method

O AR/VR/XR P .

You can analyze the efficiencies of the grating regions rigorously with the Fourier Modal Method (FMM) imple-

mented in VirtualLab Fusion (↪→Sec. 96.3). However, if you want you can also use your own FMM available in

a separate dynamic link library (DLL) programmed with the .Net framework of Microsoft.

This DLL must contain at least a namespace of arbitrary name with a class of arbitrary name in which a static
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method with arbitrary name is included. But this method must have parameters of the following types in the

given order:

TYPE DESCRIPTION

OpticalStack The stack with correctly set medium in front of the stack (MediumBefore) and
medium behind the stack (MediumAfter).

double The vacuum wavelength with which the stack is illuminated.

Vector3D The incident wave vector.

VectorC Ex- and Ey-component of the input plane wave.

The return value of this method must be of type RigorousSimulationResultsForPlaneWaveInput, a type con-
taining both efficiencies and Rayleigh coefficients for both transmitted and reflected light.

Most of the data types mentioned above are defined in the VirtualLabAPI.dll.

Figure 688. The control to define a custom FMM.

There is a control (↪→Fig. 688) to define the location of the custom FMM. It has the following settings:

ITEM DESCRIPTION

Use Customized Fourier

Modal Method

If this option is not checked, the VirtualLab FMM is used to calculate rigorous

results of gratings.

Select DLL O U C F M M .

The user can select the DLL which provides the customized FMM.

Name of Class O U C F M M .

It is necessary to define the class which contains the FMM function to apply

for FMM. The name of the class has to be unique within the selected DLL.

Name of Fourier Modal

Method

O U C F M M .

In addition the user needs to specify the function name which contains the

FMM calculation. This method must have the input and output parameters as

described above.

Tip

You might want to define for example accuracy factors for your FMM. This can be done on the Additional

Parameters tab of the stacks in the Light Guide component (↪→Sec. 57.2). The parameters defined

there are then also available for Parameter Extraction, thus e. g. for Parameter Run and Parametric

Optimization.

96.5 Collins Integral by ABCD Matrix

If the optical surfaces of a component or rather their optical effects can be described by the ABCD matrix

formalism, one can decide to use the propagation algorithm given by Collins [Col70]. For a Lens System or a

Spherical Lens this method can be selected as Component Propagation on the Propagation Methods sub-tab

(↪→Sec. 54.1).
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In this case the Propagation Methods sub-tab has one additional control:

ITEM DESCRIPTION

Info This will write some information to theMessages tab of the main window: The

ABCDmatrix for transmission as well as the complex transmission coefficient

(for the whole component). All these values are determined for the default

wavelength (↪→Sec. 6.1.1) and assume air in front of the component.

The Collins integral cannot be used for reflection as always a propagation distance is required which is not

present for reflection on the first surface.

The controls in the edit dialog (↪→Sec. 92.1) allow you to adjust the accuracy of the calculation.

96.6 Split Step (BPM) Propagation

T C P -

.

This propagation operator is applicable for inhomogeneous media with small refractive index modulation δn�
n. Furthermore, paraxial conditions are assumed to hold and the influence of reflected waves is assumed to be
negligible. The operator is based on the classical ideas of paraxial beam propagation methods, see e. g. [YL92]

and [TY82]. The implemented algorithm is documented in Sec. 136.2.2.

Figure 689. Propagation Parameters tab for the split step (BPM) propagation.

The Propagation Parameters tab of its edit dialog (↪→Fig. 689) allows you to either set the Number of Steps PV

(n) used for the propagation or theMaximum Step Size PV (∆z). The automatic selection of the step size will be
added in a future version of VirtualLab Fusion. In the bottom part of the dialog the user can select the integration

method which shall be used to include the refractive index modulation during the split step propagation. The

user can select between Use Trapezoid Integration and Use Numerical Integration. The trapezoid integration

is faster because only three points will be used to calculate the refractive index integral. We recommend the

usage of the trapezoid integration for very slow index modulations and especially for z-invariant media. The

Accuracy tab can be used to define the numerical parameters of the split step propagation. Fig. 690 shows the

user control which can be used to control the split step propagation numerically.
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Figure 690. Accuracy tab for the split step (BPM) propagation.

The following parameters can be entered by the user:

ITEM DESCRIPTION

Automatic Field Size For automatic field size determination the incident field size and the media

specification is taken into account. For several media field size estimation

rules are implemented. If the Automatic Field Size mode is selected the user

can enter a Field Size Factor PV which influences the field size estimation

directly.

Keep Field Size The keep field size mode can be used if the incident field size shall be kept. In

that case the user can enter the Embedding Factor PV which will be multiplied

on the field size of the incident field.

Manual Field Size For manually defining the field size used for propagation the Manual Field

Size mode can be selected. The user has to specify the Field Size PV for x-

and y-direction.

Automatic Sampling The automatic sampling mode can be used to adapt the sampling of the in-

cident field automatically to the size of the features in the inhomogeneous

medium. If this mode is selected the user can enter an Oversampling Fac-

tor PV which influences the sampling adaption of the incident field.

Keep Sampling If the user selects the keep sampling mode the sampling of the incident field

is kept for the simulation through the index modulated media. The user can

enter a Sampling Factor PV which is applied on on the incident field.

Manual Sampling The manual sampling mode allows the specification of the Sampling Dis-

tance PV or the Number of Sampling Points PV manually.
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XIV Design &
Optimization

VirtualLab Fusion offers four algorithms to design the optimal optical

elements for your needs:

• IFTA Optimization: You can design transmissions acting for exam-

ple as paraxial beam splitters and beam shapers. ↪→Sec. 97

• Cells Array Design: A special design approach where the desired

functionality is achieved by many small optical elements (gratings,

prisms, or mirrors). ↪→Sec. 100

• Light Guide Design: Special design algorithm for light guides used

in AR & VR devices. ↪→Sec. 101.2

• Parametric Optimization: Intended for the optimization of selected

parameters of an Optical Setup (↪→Sec. 43). The merit function

used therefor can be freely configured. ↪→Sec. 102
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97 IFTA Optimization

Availability

Toolboxes: Diffractive Optics Package

Accessible: Ribbon: File > New > IFTA Optimization or Start > New > IFTA Optimization

The IFTA optimization document supports two transmission design methods (the actual Iterative Fourier Trans-

form Algorithm Approach or IFTA [AWS97] and Geometrical Optics Beam Shaping) as well as basic analysis

features. The designed transmissions can be exported to a real structure or to fabrication data using the struc-

ture design (↪→Sec. 98).

The corresponding document window is divided into three panels which are described in the following.

97.1 Specification Panel

The specification panel contains data for specifying the transmission design problem. The consistency of these

values can be checked via IFTA Optimization > Check Consistency.

All the data contained in the specification panel is stored when saving a transmission design document.

The controls of the specification panel (↪→Fig. 691) are ordered in several groups, which are described in the

following subsections.

Figure 691. Specification panel of the standard transmission design.

97.1.1 Input Field

The input field can be chosen either to be constant or it can be set to any single globally polarized harmonic

field.
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ITEM DESCRIPTION

Wavelength Wavelength of input field.

Constant Input Field For selecting a constant input field with the given wavelength. This corre-

sponds to the illumination of the transmission by an untilted plane wave.

Arbitrary Input Field Selected when the input field was set to a given harmonic field (see below).

Set After pressing this button, the user is asked for selecting a globally polarized

harmonic field, a copy of which is included into the design problem document

as input field.

Show Show a copy of the current input field.

The input field can be adapted to the sampling of the transmission (↪→Sec. 97.1.2) via IFTA Optimization >

Embed / Extract Input Field. This function is especially useful after changing the embed frame width in the

specification panel (↪→Sec. 97.1).

97.1.2 Transmission

The Transmission group box enables you to choose sampling parameters and the type of the transmission

function to be optimized.

ITEM DESCRIPTION

Sampling Points Number of sampling points in x- and y-direction.

Sampling Distance Sampling distance in x-and y-direction.

Type of Transmission The available types of transmission functions are documented below.

Number of Quantization

Levels

Contains the number of quantization values for quantized transmission types.

The following transmission types are supported:

ITEM DESCRIPTION

Continuous Phase-Only The transmission T (x) is a continuous phase-only function, i. e. at each po-
sition x the condition |T (x)| = 1 is fulfilled.

Quantized Phase-Only The transmission T (x) is an equidistantly quantized phase-only function, i. e.
at each position x the condition T (x) ∈ M̃phase,Q is fulfilled, where M̃phase,Q

is given in Eq. (97.1).

Continuous Amplitude-

Only

The transmission T (x) is a normalized amplitude-only function, i. e. at each
position x the conditions |T (x)| < 1 and arg[T (x)] = 0 are fulfilled.

Quantized Amplitude-

Only

The transmission T (x) is an equidistantly quantized amplitude-only func-

tion, i. e. at each position x the condition T (x) ∈ M̃ampl,Q is fulfilled, where

M̃ampl,Q is given in Eq. (97.2).

Complex The transmission t(x) is a normalized complex-valued function, i. e. at each
position x the condition |t(x)| < 1 is fulfilled.

Possible quantization values for quantization to Q equidistant phase-only values:

M̃phase,Q = {exp(i2π j/Q) : j ∈ Z} . (97.1)

Possible quantization values for quantization to Q equidistant amplitude-only values:

M̃ampl,Q = {j/(Q− 1) : j ∈ [0, Q− 1]} . (97.2)
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97.1.3 Propagation

The settings within this group box determine the propagation operator which is to be used between transmission

and signal plane.

ITEM DESCRIPTION

Type of Propagation The supported propagation operators are explained below.

Propagation Distance /

Focal Length

Propagation distance between transmission and output plane or focal dis-

tance of considered 2 f -setup.

Embed Frame Width If this value is greater than 0, the transmission field is embedded into a frame

of zero-samples of the given width before applying the propagation operator.

If in x-direction Nx sampling values are specified for the transmission func-

tion (↪→Sec. 97.1.2) and an embed frame width Nembed is specified, then the

transmission is embedded to a size of (Nx + 2Nembed).

Pixelation Factor For the propagation operators which do not correspond to Fourier transforms,

it can be necessary to simulate pixelation effects (↪→Sec. 138.1.2) by replacing

each sampling point by Npix × Npix sampling points, where Npix is the given

pixelation factor. Pixelation is applied after embedding.

Simulate Pixelation Ex-

actly

For the propagation operators which correspond to Fourier transforms, pix-

elation effects can be simulated exactly by using the method explained in

Sec. 138.1.2.

The following propagation operators are supported:

ITEM DESCRIPTION

Far Field (Angular Spec-

trum)

Corresponds to performing a spatial Fourier transform (↪→Sec. 31.1). The

output plane coordinates are given in angular spectrum domain.

1f-/2f-Setup Corresponds to performing a spatial Fourier transform (↪→Sec. 31.1). The

output plane coordinate system is related to the back focal plane of a 2f-setup

(↪→Sec. 31.1.1). This setting applies also for 1f-setups.

Fresnel Transform Corresponds to the Fresnel transform propagation (↪→Sec. 93.6) with output

coordinate scaling as given in Output Field Sampling (↪→Sec. 97.1.4).

Spectrum of Plane Waves Corresponds to the spectrum of plane waves propagation operator as ex-

plained in Sec. 93.4. The output plane sampling distance is equal to the

transmission plane sampling distance divided by the given pixelation factor.

97.1.4 Output Plane Sampling

In this group box the output plane sampling parameters are given, which follow from the transmission plane

sampling (↪→Sec. 97.1.2) and the propagation operator settings (↪→Sec. 97.1.3).

If the propagation operator Far Field (Angular Spectrum) is selected, by checking Use Angular Coordinates it

can be determined whether the output plane sampling is to be given in degrees instead of the internally used

wave number coordinates (1/m). The calculation of the output plane parameters in degrees is done in paraxial

approximation assuming a linear dependency between the angles in degrees and the angles in wave number

coordinates. For non-paraxial designs the display in degrees should not be used.
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97.1.5 Output Field Requirements

The constraints on the resulting output field as given in this group box determine the signal plane projection

operator to be used for the IFTA design method.

ITEM DESCRIPTION

Desired Output Field Set or show the desired output field. For setting a new Desired Output Field,

all currently open globally polarized harmonic fields can be selected in a sep-

arate dialog. This dialog also allows you to create the Optimization Region

from the selection (↪→Sec. 11.3.4) in the selected field.

In case of using a harmonic field, it has to have the sampling parameters as

specified in the Output Plane Sampling box. If the number of sampling points

do not match, you cannot start the optimization. If the sampling distances do

not match, they are set to the values shown in the Output Plane Sampling

box. The wavelength and other physical parameters of the specified field are

ignored.

Optimization Region To Set a new Optimization Region, any currently opened region document

(↪→Sec. 21) can be selected. The IFTA optimizes only this region of the output

field to match the Desired Output Field.

Note that if you set an analytic region, it is sampled internally: Only those

sampling points of the desired output field are optimized whose center point

lies within the analytic region. ↪→Fig. 692

Sample Optimization Re-

gion from Desired Output

Field

If checked, a sampledOptimization Region is created from all positions where

the current Desired Output Field is not exactly equal to zero.

Allow Phase Freedom Determines whether the phase of the Desired Output Field is significant or

whether it can be set freely by the IFTA.

Allow Scale Freedom If this control is checked, during each iteration the current result field is scaled

by a factor α to match the desired output field. As a result usually the stray

light decreases at the cost of also decreased conversion efficiency. Otherwise

α is always 1.

Limit Scale Factor Ac-

cording to Goal Efficiency

When this option is checked, a lower bound for the amplitude of the scale fac-

tor α is imposed, which corresponds to the given goal efficiency. This option

can be helpful for increasing the achieved conversion efficiency.

Limit Stray Light When this option is checked, the IFTA restricts the amplitude of the output field

for positions outside of the Optimization Region to a certain upper threshold,

which corresponds to the given Maximum Relative Intensity of Stray Light

(↪→Sec. 137.2).

Limit Feature Size Enables imposing a limitation to the minimum feature size in the transmission

using the method of [AW98]. From the given Minimum Feature Size a cor-

responding maximum spatial frequency in the output field is calculated. The

stray light in the region with spatial frequencies higher than this maximum

frequency must not exceed theMaximum Stray Light Intensity for Higher Fre-

quencies (which is calculated analogly to the Maximum Relative Intensity of

Stray Light).
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Analytic RegionSampled Field

Figure 692. Effect if an elliptic optimization region (red) is applied on a sampled desired output field (gray). Only the dark

gray sampling points constitute the actual optimization region because their center is within the ellipse.

97.2 Design Panel

The design panel is for selecting and controlling the transmission design algorithm.

When saving a transmission design document, all parameters of the used design algorithms as set in the design

panel are stored. In contrast, any logging data is not saved.

The controls within the upper row of the design panel (↪→Fig. 693) are described in the following table. The

lower part of the design panel depends on the selected design algorithm (see following subsections).

ITEM DESCRIPTION

Design Method Combo box for selecting the transmission design method to be used. The

available design methods are documented in the following subsections.

Set After clicking this button, the user is asked to select a transmission function,

which will be considered as the current solution of the transmission design

problem. This function can be used for selecting a transmission to be ana-

lyzed within the Analysis panel (↪→Sec. 97.3), or to be set as an initial solution

for the chosen optimization algorithm.

Show Shows a copy of the current solution for the transmission function to be opti-

mized.
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Figure 693. Design panel of the standard transmission design with iterative Fourier transform algorithm approach se-

lected as design method.

97.2.1 Iterative Fourier Transform Algorithm Approach

IFTA iteration has to begin with some initial transmission T 0 that is created in the so-called initialization step,

which has to be chosen according to the considered design problem. For beam splitting designs, T 0 is typically

obtained from backward propagation of the desired output field with ideal spot intensities and randomly chosen

phases. For beam shaper designs other strategies for choosing T 0 are used. ([AWS97])

VirtualLab Fusion supports the following methods for creating the initial transmission function T 0:

ITEM DESCRIPTION

Constant 1 Constant initial transmission function T 0 ≡ 1.

Random Phase The initial transmission T 0 is chosen to have a random phase distribution

and the amplitude |T 0(x)| ≡ 1.

Backward Propagated De-

sired Output Field

The initial transmission is obtained from propagating the Desired Output

Field backward to the transmission plane. In this operation the phase of

the desired output field is not neglected, even if phase freedom is selected

(↪→Sec. 97.1.5).

Backward Propagated De-

sired Output Field (Ran-

dom Phase)

The initial transmission is obtained from propagating the current desired out-

put field with a superimposed random phase backward to the transmission

plane.

When using the IFTA, best results are typically obtained by introducing the transmission and signal constraints

step by step. In the phase synthesis step, iterations are performed without amplitude freedom. In the sub-

sequent SNR optimization step, amplitude freedom is switched on to optimize the signal-to-noise ratio. If
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quantization is necessary, one or two further iteration steps are required, which are described in the following

subsection.

The rows in the table appearing in the upper part of the design panel (↪→Fig. 693) correspond to the design

steps explained above. The design steps can be switched on and off by the corresponding check boxes. For

the iterative design steps the corresponding number of iterations can be specified in the second column of that

table.

The controls within the Logging group box are documented in Sec. 97.2.1.1. The following table contains all

remaining controls of the design panel as shown in Fig. 693:

ITEM DESCRIPTION

Soft Introduction of Trans-

mission Constraint

Determines whether the transmission constraint is to be introduced softly by

using relaxed projections with projection strength λ linearly increasing from 0

to 1. This option may be useful for avoiding the creation of speckles during

the design of beam shapers.

Omit Final Transmission

Projection

Omitting the final transmission plane projection can be helpful for examining

the impact of the signal plane projection.

Create Transmission Ani-

mation

Creates an animation for showing the evolution of the transmission function

during the design iterations. Several options are available by the Options

button (↪→Sec. 97.2.1.2).

Create Output Field Ani-

mation

Creates an animation for showing the evolution of the output field during

the design iterations. Several options are available by the Options button

(↪→Sec. 97.2.1.2).

Show Final Transmission

and Output Field

Shows final transmission and output field after the transmission design algo-

rithm has completed.

Start Design Starts the design algorithm. After this button has been pressed, it turns into a

Stop button. If you click this button one time, the current iteration is finished

and then the design is stopped. If you cannot wait so long, click again on

the now Stop Immediately button to cancel the design immediately. But then

the design is in an inconsistent state and further evaluations on the Analysis

tab might lead to wrong results. While a design is in progress, the progress

bar indicates the progress in the current design step while in the title of the

document window the overall progress in percent and an estimation of the

remaining calculation time is shown.

97.2.1.1 Logging

Within the logging table, the most important merit functions and some further parameters can be observed

during iteration.
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ITEM DESCRIPTION

Enable Logging By unchecking this option you can turn off the logging completely. This can

increase performance, especially in the case of many fast iterations. If this

option is checked, at least the total number of iteration steps is logged.

When logging is enabled and a design is running, a Suspend Logging button

is shown which allows to suspend logging for the currently running design. If

this button is pressed again, logging continues normally.

Configure Configure which merit functions and parameters are to be logged (see below).

Less merit functions to log result in increased performance.

Show Diagram Transfer selected columns of the table to a newly created one-dimensional

data array with one subset per merit function (↪→Sec. 13.5).

Preserve Table If checked, the contents of the table is not cleared when starting (or continu-

ing) the design by pressing Start Design.

The following merit functions and parameters are supported for logging:

ITEM DESCRIPTION

Iteration Index in Current

Design Step

Iteration counter for current design step.

Window Efficiency The part of the paraxial power of the input field diffracted inside the signal

region.

Conversion Efficiency The part of the paraxial power of the input field diffracted in the part of the

signal that is inside the signal region. Noises inside the signal region are

ignored.

Signal-to-Noise Ratio The strength of the signal relative to the noises measured in dB.

Uniformity Error The maximum deviation of the output field squared amplitude from the signal

field squared amplitude inside the signal region.

Relative Zeroth Order In-

tensity

The squared amplitude of the zeroth order of the output field related to some-

what like the mean value of the intensities of the desired output orders.

Maximum Relative Inten-

sity of Stray Light

The relative maximum intensity outside of the signal region.

Projection Strength Projection strength parameter λ which may vary due to a softly introduced

transmission constraint or during the quantization steps.

Magnitude of Optimal

Scale Factor

Amplitude |α| of the optimal scale factor α.

Argument of Optimal

Scale Factor

Phase arg[α] of the optimal scale factor α.

Zeroth Order Efficiency The part of the paraxial power of the input field diffracted into the zeroth order.

The formulas behind the merit functions are given in Sec. 137.2.
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97.2.1.2 Options for Creating Animations

Animations correspond to a sequence of individual bitmap images (↪→Sec. 20). The controls of the dialog shown

in Fig. 694 determine how these individual bitmap images are created from the given transmissions or output

fields.

ITEM DESCRIPTION

Apply Interpolation Determines whether the complex amplitude is to be interpolated before it is

converted to a bitmap image. The interpolation settings available via the Op-

tions button are described in Sec. 22.8.1.

Use Twin Image Repre-

sentation

If checked, each bitmap image is composed of two images side by side, which

are created from the same transmission or output field using different color

mapping settings (see below).

Edited Image Options With this item, available if the check box Use Twin Image Representation

is enabled, the part of the image (left or right) can be chosen for which the

options shall be edited.

Color Mapping The controls within this group are described in Sec. 5.11.

Figure 694. Settings for generation of animations.

97.2.2 Geometrical Optics Beam Shaping

This design approach can be used only for designing continuous phase-only transmission functions using phase

and scale freedom. Therefore, some of the settings in the specification panel need to have appropriate values.

The energy mapping between transmission plane and signal plane can be calculated analytically (i. e. in one

non-iterative step) only for one-dimensional problems. In case of two-dimensional design problems one of the

following separability types has to be selected:
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ITEM DESCRIPTION

Cartesian Coordinates Input field, desired output field, and the resulting transmission obey Carte-

sian separability. For the transmission function T (x, y) this means that

two one-dimensional functions T x(x) and T y(y) exist, so that T (x, y) =

T x(x)T y(y).

Rotational Symmetry Input field, desired output field, and the resulting transmission are rotation-

ally symmetric. For the transmission function T (x, y) this means, that a

one-dimensional function T r(r) exists, so that T (x, y) = T r(r), where
r =

√
x2 + y2.

97.3 Analysis Panel

Figure 695. Analysis panel of the standard transmission design.

The analysis panel (↪→Fig. 695) is used for analyzing the current solution of the transmission design problem.

It supports the following features:

• Calculation of common merit functions (↪→Sec. 74.6.2),

• Performing tolerancing analyses with respect to linear and binary mask scaling errors (↪→Sec. 97.3.2),

• Obtaining the optical setup which is represented by the current solution of the transmission design prob-

lem.
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ITEM DESCRIPTION

Show Output Field Shows output field when recalculating values of merit functions. The output

field is calculated under consideration of the scale error values currently set

(↪→Sec. 97.3.1).

Recalculate Recalculates merit functions (↪→Sec. 74.6.2) which are checked in the table

on the left hand side. The merit function values are calculated under consid-

eration of the scale error values (↪→Sec. 97.3.1) currently set.

Show Optical Setup Shows an Optical Setup (↪→Sec. 43) which corresponds to the current solution

of the transmission design problem.

Note that the shown output field is more or less just a Fourier Transform of the current transmission. It

does not include Fresnel effects, non-paraxial distortion effects, diffraction effects; and depending on

the Type of Propagation set on the Specification tab also not the pixelation effect. To see these effects

you should use the optical setup created by Show Optical Setup or even convert the transmission into

a real structure (↪→Sec. 98).

97.3.1 Scale Errors for Phase-only Transmissions

By using the thin element approximation [WB91], phase-only transmission functions can be transformed to a

corresponding height profile. Within this approximation several error types are equivalent and can be described

by the linear scale error γ:

• There are several possible reasons for linear scaling errors of the realized height profile, which can be

described by the parameter γ. Examples are wrong etching times, wrong etching rates, or thermal ex-

pansion or shrinking effects when using hot embossing.

• Deviations between the actual wavelength λact and the wavelength λref which was assumed during the

design cause a linear scale error γ = λref/λact.

• Deviations between the actual refractive index nact of the structured material and the refractive nref which
was assumed during the design cause a linear scale error γ = nact/nref.

ITEM DESCRIPTION

Impose Linear Scale Error

by Scale Factor

If checked, the given linear scale error is imposed. A value of 1 corresponds to

the ideal case of no scale error. This feature can be used only if the designed

transmission is phase-only.

Impose Binary Mask Scale

Errors

If checked, the given binary mask scale errors are imposed. This feature

can be used only if the designed transmission is phase-only quantized to 2q

levels. The integer q is the number of binary mask steps. The scale errors

for the up to four most important binary masks steps, corresponding to phase

modulations of π, π/2, π/4, and π/8, can be given. Values of 1 correspond
to the ideal case of no scale errors.

97.3.2 Scan Scale Error Range

By using the controls within this group box, basic tolerancing analysis can be performed by modifying the value

of a selected scale error within a given range, while all other scale errors keep their value as specified by the

controls within the group box Scale Errors for Phase-Only Transmissions (↪→Sec. 97.3.1).
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ITEM DESCRIPTION

Modify Scale Error Selection of scale error to be modified. All scale errors that can be entered

in the group box Scale Errors for Phase-Only Transmissions (↪→Sec. 97.3.1)

are available for selection.

From First scale error value to be considered.

To Last scale error value to be considered.

Number of Steps Number of values to be considered in the given value range.

Create Output Field Ani-

mation

Creates an animation for showing the behavior of the output field during the

changing of the selected scale factor. Several options are available via the

Options button (↪→Sec. 97.2.1.2).

Recalculate Recalculates the table containing the results of the tolerancing analysis. This

table contains rows for each considered scale error value and columns for

each merit function which is selected in the top left table of the analysis panel.

After this button has been pressed, it turns into a Stop button to cancel the

tolerancing analysis immediately. While an analysis is in progress, in the title

of the document window the progress in percent and an estimation of the

remaining calculation time is displayed.

Show Diagram Shows a one-dimensional data array (↪→Sec. 13.5) where each subset shows

the dependency of one of the selected merit functions from the modified scale

error.

97.4 Multiple Runs of the IFTA Optimization Document

Figure 696. The dialog to start multiple runs of the IFTA optimization document.

Via the ribbon item IFTA Optimization > Multiple Runs you can run the currently open IFTA optimization
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document multiple times which is useful if the IFTA design starts with a random phase. After completion of

each run the resulting merit functions are being calculated and logged to a file in comma separated value

(CSV) format. Furthermore, the resulting transmissions are saved into the same folder as the CSV file.

In the upper part of the corresponding dialog (↪→Fig. 33.1) you can configure which Merit Functions are logged

to the CSV file. For each merit function you can set up three different kinds of conditions:

• Between: The merit function must be between the given Minimum and Maximum value.

• Less Than: The merit function must be less than the given Maximum value.

• Greater Than: The merit function must be greater than the given Minimum value.

The Saving group box allows the following settings.

ITEM DESCRIPTION

Result File Name The file name used for the resulting transmission and the summary CSV file.

For the transmissions, to this file name the run number is appended. For the

summary file, Summary is appended as well as the date and time in brackets.

Keep in mind that characters like ‘*’ and ‘?’ are not allowed in file names.

Save Result to The path where the results are stored. It can be changed with the -button.

If you want the results to be shown in the Windows Explorer you can click on

the path label.

Save and Log You can choose whether All Results or Only Results Fulfilling All Conditions

are saved as transmission files and logged into the CSV file.

If all results are saved, the CSV file has an extra Conditions column indicating

whether the design passed all conditions or whether at least one condition

failed. Furthermore, passed and failed, respectively, is appended to the file

names of the transmissions.

In the bottom of the dialog you can specify the Number of Runs.

If you click on the Start button it turns into a Stop button and no further settings are allowed. Clicking on Close

simply closes the dialog and stops the simulations.

97.5 Preparing the Desired Output Field

The following ribbon items allow you to set a specific Desired Output Field.

ITEM DESCRIPTION

IFTA Optimization >

Regular BeamSplitter Pat-

tern

↪→Sec. 97.5.1

IFTA Optimization >

Sinc Compensation

Allows you to select a harmonic field via a dialog. Then the sinc modulation

due to pixelation is compensated (↪→Sec. 138.1.2) and the resulting field is

inserted as Desired Output Field. If you want to see a copy of the resulting

field, simply check Show Resulting Field.

97.5.1 Preparation of the Desired Output Field for Regular Patterns

By this dialog the desired output field can be set up for design of regular beam splitters, that is

• All signal orders have equal intensity,

• The signal orders are equidistant, and

• The signal orders are centered around the optical axis.
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ITEM DESCRIPTION

Number of Signal Orders Number of signal orders in x- and y-direction. This number must not be larger

than the number of sampling points within one period of the transmission

function as set in the specification panel (↪→Sec. 97.1).

Even Orders Missing This can be applied if the desired output orders have got even splitting ratios.

By checking this option a symmetric signal order configuration is achieved,

where only odd output orders are used for signal orders. If this option is not

checked, all signal orders are consecutive.

If the desired output field has an odd number of orders in one direction and

an even number in the other direction, this symmetrization is only done for

the “even” direction (↪→Fig. 697).

Figure 697. Desired output field with 5 × 6 orders and Even Orders Missing. As you can see, it is symmetric to the point

(0; 0) marked with a cross.

98 Structure Design

A Jones matrix transmission – e. g. calculated by the standard transmission design of VirtualLab Fusion – has

the additional ribbon item Design > Structure Design. It opens the structure design dialog which allows you

to calculate a pixelated surface profile from this transmission using the thin element approximation [Goo68].

This means the surface profile height is proportional to the phase values of the transmission.

Smooth or micro-structured surfaces with or without discrete height steps can be created. The calculated

surface profile is returned as a Sampled Surface (↪→Sec. 35.2.11). This Sampled Surface is then placed in a

Microstructure Component (↪→Sec. 60.1) which is either added to an existing or a new Optical Setup.

If the transmission is periodical, then the resulting Sampled Surface is periodized accordingly.

The edit dialog of the structure design consists of three tab pages. Each tab page contains a selection of

parameters for the structure design. The following tab pages are available:

1. Target

2. Optical Setup

3. Surface Parameters

The subsequent sections describe the setting entries on each tab page.
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98.1 Target

On the first page of the structure design dialog, the user can specify the target of the structure design. Fig. 698

shows the first page of the structure design dialog. The following targets can be selected:

ITEM DESCRIPTION

New Optical Setup The output of the Structure Design can also be a New Optical Setup. You

can adapt the generated Optical Setup to make further simulations. (e. g.

tolerancing).

Add to Existing Optical

Setup

You can also add the generated Real Components to an existing Optical

Setup.

Figure 698. Target page of the structure design edit dialog

98.2 Optical Setup

The resulting structure can either work in a transmission or a reflection Setup.

If you select Height Profile of Transparent Plate you obtain a transmission setup consisting of two components:

a Curved Surface (↪→Sec. 58.1) with the front surface and the Microstructure Component. In this setup you

have the following settings.

ITEM DESCRIPTION

Substrate Medium The medium between the two surfaces. The controls are described in

Sec. 34.1.

Surrounding Medium The medium behind the microstructure. The controls are described in

Sec. 34.1.

Thickness of Substrate The distance between the two surfaces.

Wavelength The vacuum wavelength for which the phase function shall be translated into

a height profile.

If you selectHeight Profile of Mirror you obtain a reflection setup containing only the Microstructure Component.

In this setup you have the following settings.
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ITEM DESCRIPTION

Substrate Medium The medium between behind the microstructure. This medium always con-

sists of the Ideal High Reflectance Material.

Surrounding Medium The medium in front of the microstructure. Only used for the calculations of

the heights in the microstructure. The controls are described in Sec. 34.1.

Wavelength The vacuum wavelength for which the phase function shall be translated into

a height profile.

Fig. 699 shows the Optical Setup page of the structure design in case of Height Profile of Transparent Plate.

Figure 699. Settings for optical setup parameters of the structure design edit dialog.

The refractive index of the substrate medium must not be equal to the refractive index of the surrounding

medium. Otherwise an error message is shown and the dialog is locked. The shown error message can be

seen in Fig. 700.

Figure 700. Error message which is shown when the user sets up surrounding medium and substrate medium which are

not valid. The dialog is also locked.

98.3 Surface Parameters

Fig. 701 shows the Surface Parameters tab page of the structure edit dialog.
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Figure 701. The user can specify the parameters of the optical surface which shall be calculated from the given phase

function.

The Surface Parameters tab has the following entries:
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ITEM DESCRIPTION

Unwrapping Allows the complete or partial unwrapping of the phase in order to generate

a smooth surface profile with heights larger than the height equivalent to 2π.

For the unwrapping a line by line unwrapping method is used. The trans-

mission should not contain phase dislocations. The following selections are

possible: None – no unwrapping.

Partially (Neglecting Spherical Phase) – a partial unwrapping without consid-

ering the spherical phase factor information. If the unwrapped phase would

be larger than the Modulo, it is wrapped.

Full (Neglecting Spherical Phase) – the phase is unwrapped completely with-

out considering the spherical phase factor information. Not available for File

Export.

Full (Considering Spherical Phase) – the phase is unwrapped completely

while considering the spherical phase factor information. This option should

be used if a transmission contains a strongly undersampled spherical phase

factor. Not available for File Export.

Modulo The maximum phase value in case of Partially (Neglecting Spherical Phase)

unwrapping. Only multiples of 2π are supported.

Enforce Quantization If checked a hard quantization of the transmission is introduced. Enable this

to calculate surface profiles with discrete height steps.

Number of Quantization

Levels per 2 pi Phase

Modulation

The number of quantization levels that should be introduced for discrete

height profiles. This parameter is only active if Enforce Quantization is

checked.

Height Modulation Depth

per 2 pi

Displays the profile height corresponding to a 2π phase modulation for the

wavelength of the transmission.

Total Modulation Depth Displays the total profile height. This value is for quantized, not unwrapped

surface profiles always smaller than the height modulation depth per 2π.

Assume Smooth Height

Profile

(Cubic 8 Point Interpola-

tion)

Check this for non-quantized, non-periodic profiles that do not contain jumps,

steps, and high frequency variations. Thus, the resulting sampled surface

uses cubic 8 point interpolation.

Pixelated Height Profile

(Nearest Neighbor Inter-

polation)

Check this for quantized profiles that are composed of rectangular pixels.

Thus, the resulting sampled surface uses nearest neighbor interpolation.

Handle Fresnel Zone Tran-

sitions

(Fresnel Interpolation)

Check this for profiles containing jumps corresponding to 2π, 4π, …phase

steps. Those profiles should not contain discrete height levels. This parame-

ter is only visible if Unwrapping is set to None or Partially (Neglecting Spheri-

cal Phase). The resulting sampled surface uses a special interpolation which

avoids interpolation artifacts at the Fresnel jumps.

99 Beam Shaper Design

O D O P .
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VirtualLab Fusion offers three possibilities to design a beam shaping element (see table). They can be found

in the Beam Shaper Design group of the Start > Diffractive Optics menu of the ribbon.

DESIGN METHOD DESCRIPTION

“Gaussian → Top Hat”

Transmission Design

Allows you to easily solve a subset of beam shaping design problems:

transforming a (super-)Gaussian input field into another super-Gaussian top

hat using a geometrical optics approach. Only the transmission is calcu-

lated which can be converted into a surface by using the structure design

(↪→Sec. 98). The corresponding dialog is described in Sec. 99.1.

Diffractive Beam Shaper Opens a session editor for the design of refractive beam shapers.

↪→Sec. 99.2.

Refractive Beam Shaper Opens a session editor for the design of refractive beam shapers. This ses-

sion editor returns an Optical Setup (↪→Sec. 43) with an initial beam shaper

component designed by the geometrical optics approach. This component

can then be further optimized with the parametric optimization (↪→Sec. 102).

99.1 “Gaussian→ Top Hat” Transmission Design

The dialog for a “Gaussian→ Top Hat” transmission design allows you to easily solve a subset of beam shaping

design problems: transforming a (super-)Gaussian input field into another super-Gaussian top hat using a

geometrical optics approach. By clicking OK you obtain the transmission for transforming the specified Input

Field into the Desired Output Field, and optionally also other Output (↪→Sec. 99.1.3).

You can select one of the following optical Setup Types:

ITEM DESCRIPTION

1f-/2f-Setup The resulting transmission can be used both in a 1f- and a 2f-setup. The

Focal Length of the lens used in this setup can be given.

Fresnel Setup The resulting transmission generates the desired output field in the far field.

The Distance between the transmission and the desired output field can be

given.

Angular Spectrum The desired output field is generated in the far field of the resulting transmis-

sion. It is given in angular coordinates.

In principal the used design approach can be used only for One-dimensional problems. In case of two-

dimensional design problems one of the following Symmetry types has to be selected:

ITEM DESCRIPTION

Rectangular Input field, desired output field, and the resulting transmission obey Cartesian

separability. For the resulting transmission function T (x, y) this means that
two one-dimensional functions T x(x) and T y(y) exist, so that T (x, y) =

T x(x)T y(y).

Circular Input field, desired output field, and the resulting transmission are rotationally

symmetric. For the resulting transmission function T (x, y) this means, that
a one-dimensional function T r(r) exists, so that T (x, y) = T r(r), where
r =

√
x2 + y2.

Depending on the symmetry type, the layout of the dialog changes.
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Furthermore the Setup tab allows you to specify the Embedding Medium the beam shaper is placed in, i. e.

you can Load a predefined homogeneous medium from the catalog (↪→Sec. 33), Edit the current medium

(↪→Sec. 37.3.1) or View it with the view described in Sec. 37.2. And you can choose whether you Design

Transmission for Refractive Beam Shaper or Diffractive Beam Shaper. In the latter case an eventual spherical

phase is sampled in the transmission.

99.1.1 Setting up Input Field and Desired Output Field

The Input Field and Desired Output Field tab of the dialog are quite similar. In both tab pages you can set

the Waist Radius of the field referring to 1/e2 of the maximum squared amplitude and the order of the super-

Gaussian function (↪→Sec. 132.2). An order of two corresponds to a Gaussian function. For the input field you

can also specify theWavelength which is also taken for the desired output field.

99.1.2 Setting up the Transmission

The aperture of the transmission can be adjusted with the following settings:

ITEM DESCRIPTION

Automatic Setting If checked, a reasonable aperture size of the transmission is determined au-

tomatically.

Field Size Factor This factor is applied to the suggested transmission size computed for auto-

matic setting. A greater factor cuts off less of the input field.

Manual Setting If checked, the aperture size has to be entered by the user.

Shape The aperture may be Rectangularly or Elliptically shaped.

Diameter Size of the aperture.

The sampling of the transmission can be adjusted with the following settings:

ITEM DESCRIPTION

Automatic Sampling If checked, the sampling parameters will be determined automatically.

Manual Sampling If checked, the sampling parameters have to be entered by the user.

Accuracy Factor This parameter can be entered for the Automatic Sampling mode only. A

greater factor increases the number of sampling points.

Sampling Points In case of Manual Sampling, the number of sampling points can be entered

here.

Sampling Distance In case of Manual Sampling, the sampling distance can be entered here.

Array Size Read Only. The size of the resulting transmission.

99.1.3 Output Specification

On the Output tab page you can specify that either an Optical Setup is generated by the dialog, containing

a light source with the input field and a transmission storing the calculated transmission. Depending on the

current Setup Type some additional Optical Setup Elements are included needed to obtain the desired output

field in the target plane. If the setup type is not Angular Spectrum there is also a preconfigured diffractive optics

merit functions detector inserted into the Optical Setup.

As alternative or in addition to Show Optical Setup the dialog can return input field, transmission, and desired

output field as separate field documents.
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99.2 Design of Diffractive Beam Shaper

The IFTA optimization document requires setting up input field and desired output field with correct sampling

parameters. The sampling parameters of both fields depend on the optical setup and on the distance between

the diffractive optical element (DOE) and the target plane. The document shown in Fig. 702 helps you setting

up the IFTA optimization document for diffractive beam shapers.

Figure 702. First page of the document for setting up an IFTA optimization document for diffractive beam shapers.

The user has to specify at least the Input Field and the Desired Output Field. The user should make sure

before the specification of the desired output field that there is a frame of zero-valued sampling points around

the desired light distribution so that the size of the Desired Output Field is at least 4 times the size of the

desired light distribution. Additionally the setup type (1f-/2f-setup or Fresnel setup) and the distance between

the element and the target plane can be specified in the dialog.

Further settings:
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ITEM DESCRIPTION

Optimization Region The optimization of beam shapers and other diffractive optical elements

(DOEs) requires the specification of a so called optimization region which de-

scribes an area in the target plane in which stray light will be minimized during

optimization. Outside of this area stray light is allowed. If you select Arbitrary

Optimization Region as Creation Method, you can Set any already open re-

gion document as optimization region. With the option Create from Desired

Output Field an optimization region will be created containing all parts of the

desired output field with amplitude values larger than 10% of the maximum

amplitude. The last option Equal to Selection in Desired Output Field means

that the optimization region will be generated from the rectangular selection

marker (↪→Sec. 11.3.4) which was present in the Desired Output Field at the

time you have set it into the setup dialog.

Rectangular Pixelation By checking this check box you indicate that the element designed by the IFTA

will contain rectangular pixels after fabrication. In this case the “pixelation

effect” (↪→Sec. 138.1.2) will be simulated exactly.

This option is only available if the Optical Setup is set to 1f-/2f-setup.

Pixelation Factor In case of Fresnel Setup, the “pixelation effect” (↪→Sec. 138.1.2) cannot be

simulated exactly. Thus a Pixelation Factor npix must be set. Consequently,
each pixel in the resulting element is simulated by npix× npix sampling points.
A pixelation factor

This option is only available if the Optical Setup is set to Fresnel Setup.

Determine Pixels Size Au-

tomatically

If this option is checked, the pixel size in the resulting element is determined

automatically, but it is a multiple of the Pixel Size Increment of the machine

used for exposure of the structures. Alternatively, you can specify an arbitrary

Pixel Size.

Transmission Aperture Allows you to set size and shape of the resulting transmission which repre-

sents the element.

After specification of the parameters click the Next button. A new page will show the sampling parameters

of input field, desired output field and DOE transmission. The Create Optimization Document button allows

you to create the IFTA optimization document. If the optimization is finished, press Next again. The correct

document should be preset. The Extract button generates a new transmission reduced to the Transmission

Aperture defined on the first page.

100 Cells Array Design

Availability

Toolboxes: Light Shaping Package

Accessible: Optical Setup: Optical Setup > New Cells Array Design
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Figure 703. The Design tab of a Cells Array Design document if a Mirror Cells Array is to be designed.

Using this approach you can design a Cells Array (↪→Sec. 40.1) to generate the desired light pattern for a given

optical setup. To this end a random position in the light pattern is selected for each cell in the Cells Array and

the outgoing direction is calculated from this position and the cell’s position. The optical parameters of the cell

are then determined so that the cell deflects the incoming light into the outgoing direction.

• For a Grating Cells Array (↪→Sec. 40.1.1), Grating Period and Rotation Angle are determined so that

the light of the first order is diffracted into the desired direction. A random lateral offset can be used to

introduce random phases in the target plane.

• For a Prism Cells Array (↪→Sec. 40.1.2), Tilt Angle and RotationAngle are determined so that the incoming

light is refracted into the desired direction. A random offset height can be used to introduce random phases

in the target plane. The change in the resulting direction caused by different offset heights is considered

correctly.

• For a Mirror Cells Array (= a Prism Cells Array used in reflection), Tilt Angle and Rotation Angle are

determined so that the incoming light is reflected into the desired direction. A random offset height can

be used to introduce random phases in the target plane. The change in the resulting direction caused by

different offset heights is considered correctly.

The number of possible spot positions in the light pattern is taken directly from the sampling of the data defining

the pattern. The design algorithm assumes that the light pattern is a binary one, i. e. every pixel with less than

half the maximum amplitude is set to zero; all other pixels are set to the maximum amplitude. In this way, every

spot position is illuminated by nearly the same number of cells.

A new Cells Array Design can only be created from an existing Light Shaping Optical Setup (↪→Sec. 43.11.4).

The design document window (↪→Fig. 703) has two tab pages. The Lighting Setup tab summarizes the most

essential parameters of the initial Optical Setup. The Show Initial Optical Setup allows you to show the initial

Optical Setup again in case it has been closed.

The Design tab contains the following controls.

ITEM DESCRIPTION

Wavelength The wavelength for which the cells are designed. By default this is the wave-

length of the active light source in the Optical Setup.
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Set Allows you to set a data array describing the light pattern in three different

ways (see below). It is assumed that the light pattern is centered around the

position of the camera detector in the Optical Setup. The data array must

contain only one two-dimensional subset.

Set > Load Loads a data array from a .da file.

Set > Import Imports a data array from a bitmap or text file by means of the import wizard

described in Sec. 121.2.

Set > Select from Docu-

ments

Allows you to select an already open data array.

Show Shows the current light pattern in a separate data array view (↪→Sec. 13.5).

Variability of Spot Posi-

tions

If one certain position in the light pattern is illuminated by different cells,

they all aim at the very same position. However, if you set a Variability of

Spot Positions greater than zero the actual spot positions “are shook” around

the pattern position. The variability can be set independently for x- and y-

direction. The given percentage refers to the distance to neighboring spots.

See Fig. 704 for an example.

Use Seed for Spot Selec-

tion, Shaking, and Param-

eter Selection

A Cells Array Design uses random numbers to

• define which cell illuminates which position,

• how much the actual spot position is altered if Variability of Spot Posi-

tions is used, and

• to select a random lateral shift or offset height (depending on the type

of the cells array).

Thus the design differs every time you click on Go!. If this shall not be the

case, you can set a fixed arbitrary seed value with this option.

Apply Random Lateral

Shift to Each Grating Cell

O G C A .

If checked, a random lateral shift is applied to each grating cell resulting in

random linear phases in the target pattern.

Apply Random Off-

set Height to Each

Prism /Mirror Cell

O P M C A .

If checked, a random offset height is applied to each cell resulting in random

phase offsets in the target pattern.

Maximum Offset Height O P M C A .

If Apply Random Offset Height is checked, each cell gets a random offset

height between zero and this value. Note that for technical reasons, the re-

sulting offset height of certain cells can be slightly larger than this value.

Use Fabrication Con-

straint

If checked, you can either specify the Maximum Tilt Angle (for Mirror and

Prism Cells Array) or the Minimum Grating Period (for Grating Cells Array).

If this constraint is violated for one cell, the design algorithm tries up to ten

times to find another random solution for that cell.

Go! Starts the actual design. While the design is running, a progress bar is shown.

The result is a new Optical Setup containing the designed cells array.
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Figure 704. Two diagrams of the spot positions for different Variability of Spot Positions. Left: A variability of (0 %; 0 %).
Right: A variability of (75 %; 25 %).

101 Design of Light Guides

101.1 Footprint and Grating Analysis

O AR/VR/XR P .

This design tool allows you to analyze in-depth the footprints at regions in a light guide as well as the perfor-

mance of gratings with variable grating parameters per grating region. The following workflow can be realized

by the provided tool:

1. Select the optical setup you like to use for analysis of footprints and grating performance. The selected

optical setup can contain an arbitrary number of light guide components. Per component there can be

also an arbitrary number of surfaces in it. And per surface also an arbitrary number of grating regions is

supported for the analysis. The active light source within the selected system should be a plane wave,

because the tool will adapt the angles defined in the plane wave for the footprint analysis. The plane

wave has to be monochromatic.

2. Define a list of field of view angles (Cartesian angles) that should be used for the analysis. The tool allows

an arbitrary number of angles to be defined, but at least one angle must be specified.

3. Perform footprint analysis. Here VirtualLab Fusion performs per specified field of view angle an analysis

of the underlying setup and evaluates per grating region the positions (footprints) where the light interacts

with the gratings. In addition also the direction vectors are evaluated and stored, under which each grating

region is illuminated.

4. After the footprint analysis is done, there are several tools to investigate the evaluated information (eval-

uation by interactive footprint tool, heatmap visualization or access to the raw data).

5. In addition to access to the footprint data, the user has the option to evaluate the performance of gratings

per region. This is supported only for regions which contain real gratings. The user can define a value
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range for one or two grating parameters per region and VirtualLab Fusion will automatically calculate

lookup tables which contain the Rayleigh matrices per incident angle and order. These lookup tables can

be also displayed as efficiency curves for different polarization states (note: each grating interaction inside

the light guide might change the polarization of the light, which is completely included in the modeling of

such a device by physical optics).

6. After all lookup tables are calculated and stored on the hard disc (as 1D or 2D data array) the user can

generate a new optical setup, where the grating regions might contain a grating with variable grating

parameters (so called grating parameter modulation function; ↪→Sec. 42.1.3). By clicking on the cor-

responding button the user can define the regions which should pre-configured with the corresponding

grating parameter variation function. All lookup tables, which were calculated per region, will be stored

within the region automatically.

The resulting optical setup can be used for further investigations and optimizations. After configuring the system

in that way there is no need to do rigorous analysis of gratings even for a local grating parameter variation,

because all information is already stored in the lookup tables. This enables an efficient and performant usage

of the system within a parametric optimization.

Figure 705. The first page of the document window for the footprint and grating analysis.

The corresponding document window consists of two pages. On the bottom you have a Validity indicator

(↪→Sec. 5.10) which shows errors and warnings and gives you hints how to solve these issues.

On the first page (↪→Fig. 705) you can configure the following.
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ITEM DESCRIPTION

Set Allows you to set an Optical Setup either from a document window of

VirtualLab Fusion or from file. The Optical Setup must be a Light Guide Op-

tical Setup (↪→Sec. 43.11.3) with a Plane Wave light source (↪→Sec. 51.2).

Show Shows the currently set Optical Setup.

Field of View Angles for

Design

Allows you to define a set of field of view angles (in Cartesian coordinates) that

should be used for evaluation. This table can only be edited via the buttons

next to its right side.

Efficiency of Zeroth Order

/ Efficiency ofAll Other Or-

ders

By default efficiencies of all gratings orders are set to 100%. This could lead

to long computation times depending on the selected orders and maximum

level for the light path finder. Therefore we offer the user to configure the

efficiencies of the zeroth order (typically used to distribute the light over an

area) and the other specified orders.

Analyze Starts the analysis of the footprints, i. e. the positions (and also direction)

where the light hits the gratings. The text box below this button logs the

progress of this analysis. When the analysis is running this button becomes a

Stop button to cancel the analysis. When the analysis finishes this button is

disabled. It becomes enabled again when any of the above options changes.

Figure 706. The second page of the document window for the footprint and grating analysis.

After the first page is successfully handled the next button will be enabled. The second page of the wizard

consists mainly of a table with the following columns.
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COLUMN DESCRIPTION

Status Shows the status of the Vary column at a glance. Fig. 706 shows the four possible states.

• The first row in Fig. 706 has invalid lookup tables. They were calculated before, but

the current configuration does not match the calculated lookup tables. A recalculation

of the lookup tables solves this issue and will be done automatically if you press the

Calculate Lookup Tables button.

• For the second row a valid lookup table has been calculated.

• For the third row a parameter configuration was configured but the corresponding lookup

table has not been calculated yet.

• For the fourth and fifth row no parameter variation is specified.

Region The name of the analyzed grating region. ↪→Sec. 42.1.

View Shows the footprints in a separate dialog. ↪→Sec. 101.3

Heatmap Shows the “heatmap” of the region as separate Data Array 2D document.

Raw Data Shows the raw data for both the footprints and the heat map as set of gridless data arrays.

Vary This column allows you to define the variation of one or two parameters per grating. So first you

have to check the box that you want to vary parameters, then choose the parameter(s) to vary

in a separate dialog (↪→Sec. 101.4). When then the lookup tables have been calculated with

the Calculate Lookup Tables button, you can either delete ( ) the results or show them

as separate Data Array document ( , ↪→Sec. 101.1.1 ). For visualization of the lookup table

context, the information of the calculated Rayleigh coefficients is transferred into efficiencies

for different polarization states (we show the efficiency for TE, TM, left circular, right circular

polarization and unpolarized). Note: The state of polarization will change while the light travels

through the light guide and interacts with several gratings.

Besides the table this page has the following controls.

ITEM DESCRIPTION

Path for Storing Lookup

Tables

The tool stores the lookup table information (Rayleigh matrices) in form of 1D

or 2D data arrays. During the calculation of the lookup tables the data arrays

are stored on the hard disc. The user can define the path, where the lookup

tables shall be stored.

Calculate Lookup Ta-

bles

Starts the calculation of the selected lookup tables. The text box below this

button logs the progress of this calculation. When the analysis is running this

button becomes a Stop button to cancel the calculation.

Generate Optical Setup

with Modulation Function

By pressing this button a dialog is opened, which is described in Sec. 101.1.2.

After the dialog is closed withOk an optical setup is generated, which contains

pre-configured grating regions with modulated grating parameters according

to the parameters defined in the previous dialog.

101.1.1 Select Lookup Tables to Show

This dialog shows a list of all directions and order information for which the lookup tables are already calculated.

This information is extracted from the folder defined in the analysis tool. The user can select an arbitrary number

of directions and order combination. At least one entry in the table has to be selected to enable the OK. After

pressing the OK button VirtualLab Fusion will generate one data array per selected entry, which shows the

efficiency distribution over the define parameter range. The information of the lookup tables (Rayleigh matrix
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per grating parameter) will be transferred to efficiency values for different polarization states. Each polarization

state is stored as a subset in the generated data array. The efficiency will be calculated for TE, TM, left circular,

right circular polarization as well as unpolarized light. Note: The state of polarization will change while the light

travels through the light guide and interacts with several gratings, but the visualization for different “standard”

polarization states give you already an insight into the performance and the dynamic range of the gratings that

are analyzed.1

Fig. 707 shows a sample output of the efficiency visualization tool for different polarization states.

Figure 707. Sample output for displaying the efficiencies for different polarization states of a 1D grating parameter varia-

tion.

101.1.2 Select & Configure Grating Regions

After the tool has calculated the lookup tables it can be used to generate a new optical setup, where the gratings

per region might be modulated. This can be triggered by clicking on theGenerate Optical Setup with Modulation

Function button. A dialog is shown, where the user can configure the parameters used for the pre-configuration

of the optical setup.

The dialog is shown in Fig. 708.

1 This feature was introduced on initiative of Yifeng Gao and Dr. Yuan Chen.
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Figure 708. Dialog to configure the parameters to use for generation of the optical setup with preconfigured grating pa-

rameter modulation functions.

The following parameters can be configured within the table provided in the dialog:

ITEM DESCRIPTION

Modulate Select the grating region that should be pre-configured to contain modulated grating pa-

rameters.

Region The name of the grating region. ↪→Sec. 42.1.

Points X The grating parameter modulation function for each function will be initially configured to

be a sampled one. The number of points in x-direction can be selected here.

Points Y The grating parameter modulation function for each function will be initially configured to

be a sampled one. The number of points in y-direction can be selected here.

Use Spline The grating parameter modulation function for each function will be initially configured to

be a sampled one. The interpolation of the points can be done by nearest neighbor or

spline interpolation. By checking this option, the interpolation method will be set to spline.

This can be also changed afterward in the edit dialog of the grating parameter modulation

function.

After pressingOK a new optical setup will be generated, that contains the configured grating parameter variation

function.

101.2 Light Guide Grating Design

O AR/VR/XR P .

With the light guide grating design wizard the user is enabled to optimize the grating parameters for a light

guide setup including an eye pupil expander (EPE) grating and / or the grating region used for outcoupling. The

typical initial starting point is the optical setup generated by the Layout Design Calculator (↪→Sec. 113).

Within the wizard the user needs to first select the optical setup which should be used for optimization and

identify the regions for incoupling, EPE and outcoupling. The document supports the design of ideal gratings

as well as real gratings. For real gratings the wizard allow to select the grating parameters (maximum number

2) for EPE and outcoupling grating to be optimized. Furthermore the user can specify a set of field of view (FOV)

angles which should be used for the optimization. Per FOV angle the user specifies the desired outcoupling

efficiency in advanced. Several additional options for the EPE grating are provided, as well as a set of control

parameters for the algorithm (like caching).

If the design is configured completely, VirtualLab Fusion will perform the optimization per FOV angle with the
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desired outcoupling efficiency. Finally the results per FOV optimization are combined to a common solution.

For the combination of all subresults a Voronoi algorithm is applied.

The resulting optical setup can be optimized further in a subsequent parametric optimization (↪→Sec. 102).

Figure 709. The document window of the Light Guide Grating Design.

The document window of the Light Guide Grating Design (↪→Fig. 709) is divided into several pages (which are

described below). On the bottom you have a validity indicator (↪→Sec. 5.10) and buttons to navigate between

the pages.

On the first page you have the following controls:

ITEM DESCRIPTION

Set Sets the Optical Setup to optimize. When you click on this button you can do

the following:

• Load an optical setup from a file.

• Select from Documents allows you to select an already open optical

setup.

Show Shows the set optical setup in a separate document window.

Light Guide Component Defines which element in the optical setup is the light guide to optimize.

Assign Regions Defines which surface region of the selected light guide has which function-

ality (Incoupling Grating, Eye Pupil Expander, or Outcoupling Grating).

On the second page the user can select whether you want to optimize Eye Pupil Expander and / or Outcoupling

Grating. For the selected regions you then can choose one or two grating parameters to Vary with the control

described in Sec. 101.4.

In the upper part of the third page you can define for which (Cartesian) angles of the field of view the design is

done. In addition to the field of view angle to use for optimization, the user has to specify a desired outcoupling

efficiency. If Eye Pupil Expander is set on the second page, you can set Optimization Options for Eye Pupil

Expander to define its Desired Efficiency and the Allowed Stray Light inside the eye pupil expander region.

Furthermore this page has the following options:
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ITEM DESCRIPTION

Show Optimized Optical

Setups per Field of View

Angle

If checked for each angle defined in the upper part one optical setup is gen-

erated with which you can examine the performance of the optimized light

guide for this angle.

Use Cache During Design If checked you can set a directory into which caching data is written. When

you cancel and restart the design this caching data is used whenever possible

to speed up the design. If you notice strange behavior during the design, it

might be because of inconsistent caching data. In this case simply uncheck

this option. By default the Path for Temporary Files defined in the Global

Options dialog (↪→Sec. 6.17) is used.

On the last page you can start the configured design using the Go! button. As the design can be time

consuming, you can first get an idea of the resulting Voronoi segmentation by clicking Analyze which runs

much faster.

If you press the Go! button after the design has finished and no parameters are changed, just the resulting

documents are created anew. If in this case you want to enforce a complete recalculation, click on the Reset

button first.

Below these buttons there are two tabs. The Logging tab shows the progress of the design process. The

Diagrams tab shows a visualization of the Eye Pupil Expander Region and / or the Outcoupling Region which

you can Configure by means of the dialog described in the following section Sec. 101.3.1.

101.3 Footprint Diagrams

Footprint diagrams showwhere the light hits a grating region. For the Light Guide Grating Design (↪→Sec. 101.2)

they are shown directly in the design document, whereas for the Footprint and Grating Analysis (↪→Sec. 101.1)

they are shown in a separate dialog.

When you click on Configure the dialog described in Sec. 101.3.1 is shown.

101.3.1 Configuring a Grating Layout and Footprint Diagram

Figure 710. The edit dialog for configuring a Grating Layout and Footprint Diagram.

A Grating Layout and Footprint Diagram can be configured by a dialog (↪→Fig. 710) with the following settings.
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ITEM DESCRIPTION

Show Segmentation If you click this option, the Voronoi cells are show in the diagram. Their colors

can be adjusted with the Segmentation Properties explained below. If this op-

tion is not used, you can only define the Region Border Color and the Region

Fill Color.

Border Color O S S

The color used to draw the borders of the Voronoi cells.

Fill Mode O S S

Determines with which color the Voronoi cells are filled. Three modes are

available:

• Footprint Colors: The Voronoi cells are filled with the color of the corre-

sponding footprint as defined in the Footprint Properties box. To ensure

a good contrast between the Voronoi cell and the footprint (if shown),

you can set the Opacity of Filling.

• Constant: All cells are filled with the same Fill Color.

• Parameter Values: All cells are filled according to the selected grating

parameter. The settings for this mode are explained below. This mode

is only available after a design was run where at least one parameter

was varied in the corresponding region.

Parameter to Show O F M P V

In case two parameters of the gratings are varied, you can select here which

of the two parameters is used to determine the color of the distinct cells.

Color Table O F M P V

Depending on the value the Parameter to Show has in a certain cell, this cell

is filled with the matching color from the set Color Table (↪→Sec. 11.2.4).

Automatic Scaling O F M P V

If this option is checked, the minimum and maximum color of the Color Table

are assigned to the minimum and maximum occurring value of the Param-

eter to Show, respectively. Otherwise you can set Minimum and Maximum

according to your liking.

Footprint Properties The center of the Voronoi cells are those positions where the center of a

diffracted light beam enters the region. These positions can be marked by

rings (“footprints”). This table allows you to select for which Field of View

Angles you want to see the footprints (left column, the uppermost check mark

allows you to select all / no angles). In the right column you can change the

color of the footprints for each angle.
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101.4 Grating Parameter Variation

Figure 711. The control to configure the variation of grating parameters.

The control shown in Fig. 711 allows you to select one or two grating parameters which you want to Vary. For

these parameters you can define the value range by setting the start (From) and end (To) value. The default

From and To values for all parameters are their absolute minimum and maximum values – you must not enter

a value outside of this range. It is possible to enter a To value which is smaller than the From value.

Furthermore you can enter either the number of Steps (which are not necessarily identical) or the Step Size.

The defined value range(s) are then scanned with the resulting number of steps. See Sec. 44.2.3 for details.

The first column allows you to collapse / expand all parameters of one Category. Simply click on the and

symbols, respectively. At the top of this column you can select to collapse all levels (1), collapse only the

Category level (2) or show all levels (*).

The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or the Parameter column pass this filter. The matching is case insensi-

tive. It is possible to search for multiple words and word groups embraced by

quotation marks, for example: "surface #1" scaling.

Show Only Varied Param-

eters

Only rows where the Vary column is checked pass this filter.

102 Parametric Optimization

The parametric optimization in VirtualLab Fusion allows you to optimize optical setups by means of nonlinear

optimization algorithms. For that purpose VirtualLab Fusion supports the definition of merit functions that are

to be optimized. Merit functions can take into account detector results. Further several types of parameter

constraints are formulated as merit functions as well. Finally a common merit function is constructed by a

weighted sum of individual merit functions.

Parameters available for parametric optimization are marked with a PV in this manual (↪→Sec. 43.5).

Implementation details are given in Sec. 138.2.
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102.1 Parametric Optimization Document

The parametric optimization document can be generated for Optical Setups (↪→Sec. 43) containing at least one

analyzer or one detector linked to the active light source which calculates a fixed number of physical values.

For some detectors or analyzers this is only the case in a specific configuration. For example the Grating Order

Analyzer (↪→Sec. 84) can only be used for Parametric Optimization if at least one of the following conditions is

fulfilled:

• Summed Transmission, Absorption, and Reflection is checked. Then theOverall Transmission Efficiency,

theOverall Reflection Efficiency, and theOverall Reflection and Transmission Efficiency can be optimized.

• Single Order Output, but only with Order Range as Selection Strategy, as only then the number of results

is known prior to the Optical Setup simulation.

If the currently active Optical Setup is consistent, a parametric optimization document can be opened via the

ribbon item Optical Setup > New Parametric Optimization or the Optical Setup Tool (↪→Sec. 43.6) Create

New Parametric Optimization.

As other documents in VirtualLab Fusion, the parametric optimization document is designed as a wizard. That

means the user can switch between the different pages sequentially via the Next and Back buttons. The

appearance of any page may depend on the settings made on preceding pages. All pages are documented in

the next sections.

The parametric optimization document can be saved and loaded via the File menu of the main window of

VirtualLab Fusion. The ribbon of this document is explained in Sec. 102.1.1.

Handling of Obsolete Parameters

If you load a Parametric Optimization which has been saved in a previous version of VirtualLab Fusion,

there might be some obsolete parameters still present in the parameter specification table. On the other

hand, newly added parameters might not yet be available.

If no results have been calculated yet, the parameters are updated automatically. Otherwise, updating

the parameters would delete the results. Then, only a warning is shown in both the Messages tab

(↪→Sec. 4.3) and the window title (“⚠ Old Parameters ⚠”).

If one of the varied parameters changed, the Parametric Optimization cannot be configured and simu-

lated anymore. You can only analyze the results or Refresh the document via the ribbon (which deletes

the results).

102.1.1 Ribbon

The ribbon of the Parametric Optimization document has the following entries:

ITEM DESCRIPTION

Go! Allows you to start the optimization. Only enabled if you are on the Opti-

mization Results page of the document window. During the optimization, the

button changes into a Stop button which allows you to stop the calculation.
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After Completion For long running optimizations it can be useful if after completion the Para-

metric Optimization saves itself and optionally the computer shuts down. This

can be defined with this option which is also available in the property browser

(↪→Sec. 4.3).

If the Parametric Optimization has not been saved before it is saved at {Path
for User Settings}\Autosaved Files. The Path for User Settings can be
set on the Saving tab of the Global Options dialog (↪→Sec. 6). Below this

combo box the used file name is displayed.

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Parametric Optimization for which this op-

tion is set.

Refresh Refreshes the document to use the current set of parameters. Note that this

deletes existing results. See also the note on handling of obsolete parameters

on page 832.

Show Optical Setup This button has three sub-entries:

• Show Initial Optical Setup: Shows the Optical Setup from which the

Parametric Optimization was originally created. This can be invoked

directly if the upper part of the Show Optical Setup button is clicked.

• Show Optical Setup for Certain Simulation Step…: Shows the Op-

tical Setup with the parameters of a certain simulation step which can

be selected in a separate dialog.

• Show Optimized Optical Setup: Shows an Optical Setup with the op-

timal values of free parameters (that is the values yielding the minimum

target function value) and with the start values of the fixed parameters.

The start values of fixed parameters usually equal the initial values, but

they might also be edited in the Start Value column of the constraint

table (↪→Sec. 102.1.4). If there are two or more simulation steps with

the same target function value, the first one is taken automatically.

No Logging During

Execution

If you press this button, the results of the individual simulation steps are only

written after the optimization has finished. This improves performance es-

pecially in case of many fast simulation steps. If this button is not pressed

the results are written as soon as they are available. Note that this button is

disabled during an ongoing optimization and that it can also be changed via

the Property Browser.

Create Output from

Selection

If you click this button, for each table row of the current selection a combined

output is generated, i. e. a separate one-dimensional data array where the

data in this row is plotted versus the simulation step. During the output cre-

ation, the button changes into a Stop Output Creation button which allows

you to stop the calculation.

Double clicking on a row header is a short cut for selecting this row completely

and clicking Create Output from Selection. It is also possible to generate

the combined output out of the current selection via the context menu or the

Create Output from Selection button of the results table.
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102.1.2 Parameter Selection Page

If you change the Parameter Selection page, the results table is cleared.

By clicking Next on the welcome page of the document the parameter selection page (↪→Fig. 712) is shown.

This page lists the parameters of the underlying Optical Setup that may be varied by the optimization algorithm.

Via the Vary column the user determines if a parameter shall be variable (checked) or fix (unchecked). At least

one parameter must be variable.

For your information also the Original Values of all parameters are given.

Figure 712. Parameter selection page of the parametric optimization document. The parameter Distance Before has

been declared as variable for the optimization.

The first column allows you to collapse / expand all parameters of an Optical Setup Element or its categories.

Simply click on the and symbols, respectively. At the top of this column you can select to collapse all

levels (1), collapse only the Category level (2) or show all levels (*).

If at least one parameter has been checked, the Next button is enabled. By clicking Next one switches to the

detector specification page (↪→Sec. 102.1.3).

The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or the Parameter column pass this filter. The matching is case insensi-

tive. It is possible to search for multiple words and word groups embraced by

quotation marks, for example: "surface #1" scaling.

Show Only Varied Param-

eters

Only rows where the Vary column is checked pass this filter.
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102.1.3 Detecting Device Specifications Page

If you change the Detecting Device Specifications page, the results table is cleared and the constraints

page needs to be updated again.

This page is the same as the corresponding page for the Parameter Run (↪→Sec. 44.4) with the following

exceptions.

• For a Parametric Optimization, you can only check one out of Ray Results Profile, General Profile, and

Classic Field Tracing.

• Only detectors or analyzers which output physical values can be optimized and are thus shown in the cor-

responding tables. For the same reason, the check boxes 3D View and Modeling Analyzer are disabled.

If the Next button is clicked, the constraint specification page will be displayed (↪→Sec. 102.1.4).

102.1.4 Constraint Specification Page

If you change the Constraint Specification page, the results table is cleared.

The constraint specification page (↪→Fig. 713) lists the constraints (↪→Sec. 138.2.1) that have been implicitly de-

fined on the previous pages of the document in a table. By means of that table the user defines the composition

of the target function (↪→Sec. 138.2.1).

Figure 713. Constraint specification page containing parameter constraints, merit function constraints and general con-

straints

Each row stands for a constraint, whereupon the constraints are sorted into their classes:

1. The parameter constraints are listed with light blue background color. Every free parameter, which was

selected on the parameter selection page (↪→Sec. 102.1.2), implies a parameter constraint on this page.

2. The merit function constraints appear with light orange color. A merit function constraint is created for

each detector merit function that gets evaluated during optimization. Note that the set of evaluated

merit functions can be adjusted by editing or enabling/disabling of detectors. This is possible either in

the initial Optical Setup or later on the detector specification page of the created optimization document

(↪→Sec. 102.1.3).
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3. If there are general constraints predefined in the Optical Setup, they will be listed with light turquoise

background color.

The constraint table consists of the following columns:

COLUMN DESCRIPTION

Constraint Host The Optical Setup Element that hosts the parameter(s) or the merit function,

respectively, of the constraint. This column is read-only.

Constraint Name The name of the constraint. This column is read-only.

Use One can enable or disable constraints via this column.

Weight Here the constraint weights gi can be specified for the target function

(↪→Sec. 138.2.1).

Constraint Type On this column one specifies the constraint type, which triggers the kind of

contribution to the target function. Via clicking on a cell one can choose

among Lower Limit, Upper Limit, Range and Target Value (↪→Sec. 138.2.1.2).

Target Value is not available for parameter constraints.

Value 1 Here the constraint values corresponding to constraint types Lower Limit, Up-

per Limit or Target Value or the lower bound of constraint typeRange, respec-

tively, are entered.

Value 2 If Range is chosen as Constraint Type the user can enter the upper bound

here.

Start Value Here the user can enter the start values of free parameters for optimization

(each free parameter corresponds to a parameter constraint). In case of merit

function or general constraints this column lists the merit function or general

values, respectively, that correspond to the entered parameter start values.

Changing any parameter start value invalidates the merit function or general

start values (symbolized via N/A). In the case all values can be recalculated

by clicking the Update button.

Contribution On this column the relative contribution
100gi f̂i(s)

F(x) of a constraint value (s is
the Start Value) to the target function F is displayed (F and the weights

gi are defined in Sec. 138.2.1, i is the constraint number, f̂i) is defined in

Sec. 138.2.1.1. Contribution values will be updated by clicking the Update

button. If values get invalid, N/A is displayed instead. This column is read-

only. The overall Target Function Value is shown below the table.

Furthermore, the following controls buttons are available below the table:

ITEM DESCRIPTION

Tools Opens a menu containing the optimization tools (see below).

Target Function Value Here the current value of the target function F (Eq. (138.4)) is displayed.

Update Updates the Start Value and Contribution column if values got invalid (sym-

bolized via N/A).

The following optimization tools are available:
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ITEM DESCRIPTION

Reset Start to Initial Val-

ues

Start values of all parameters (whether they are currently free or not) will be

reset to their initial values that are stored in the initial Optical Setup.

Set Optimized Start Val-

ues

Parameter values that were found by the last run of the optimization algorithm

(appearing in the last column of the results table [↪→Fig. 717]) will be set as

start values for another optimization run.

Set Values from Certain

Simulation Step

Parameter values from any already calculated simulation step will be set as

start values for another optimization run. Via a dialog you can select from

which simulation step the values are taken.

Distribute Contributions

Uniformly

Weights of constraints with a contribution greater zero will be adapted to get

an uniform distribution of contribution.

Set Contribution... Opens a dialog for setting a new target contribution of a single con-

straint whereupon the ratio of the other contributions remain unchanged

(↪→Sec. 102.1.4.1). This command is only available if the current contribu-

tions are up-to-date. If not, one has to press Update before.

Reset Weights Resets weights of all contributions to their initial value 1.

Reset All Settings Resets all constraints to their initial states.

102.1.4.1 Target Contribution Dialog

Via this dialog the user is able to set a new contribution for one of the constraints whose current contributions are

unequal zero. To achieve the specified contribution the weights of all constraints will be adapted appropriately.

Figure 714. Dialog for setting a target contribution for a selected constraint

The available constraints are listed in a table. Like on the constraint specification page of the optimization

document (↪→Sec. 102.1.4) the constraints are sorted into parameter constraints, merit function constraints and

general constraints (each group with different background color). The table has three columns:
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ITEM DESCRIPTION

Constraint Host The Optical Setup Element that hosts the parameter(s) or the merit function,

respectively, of the constraint. This column is read-only.

Constraint Name The name of the constraint. This column is read-only.

Select Herewith the user selects the constraint, for that a certain target contribution

shall be achieved. There is only a single selection possible.

Below the constraint table the target contribution can be input:

ITEM DESCRIPTION

Enter Target Contribution For the selected constraint the current contribution (as shown in the optimiza-

tion document, too) is displayed. The user can specify the wanted contribution

in percent here. Please note that one has to press OK or Apply to validate

the current input. Otherwise, the currently entered value will be forgotten if

one selects another constraint.

If OK or Apply is pressed, the weights of all constraints are recalculated to achieve the wanted contribution

for the selected constraint. Thereby the ratios of the other constraint’s contributions among each other remain

unchanged. The constraint table of the underlying optimization document is updated immediately.

102.1.5 General Settings Page

If you change the General Settings page, the results table is cleared.

On this page general settings concerning the optimization algorithm that is used for minimizing the target func-

tion (↪→Sec. 138.2.1) can be adjusted.

Figure 715. General settings page of the parametric optimization document

First of all one should decide on the Optimization Strategy:
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ITEM DESCRIPTION

Local Optimization If selected, one of the local optimization algorithms is applied.

Global Optimization If selected, the global optimization method of simulated annealing

(↪→Sec. 102.1.5.1) is applied.

Local optimization algorithms are fast but their success in finding the global minimum strongly depends on the

choice of the start value – at least for functions that are not strictly convex in the area of interest. Therefore, in

cases where no good start values are known, global optimization should be preferred (↪→Sec. 102.1.5.1).

Currently, three nonlinear local algorithms for minimizing a multivariate function are provided:

• Downhill Simplex method of Nelder and Mead [NM65]

• Powell’s method [Pow64]

• Levenberg-Marquardt algorithm [Lev44][Mar63]

The first two methods do not make use of the derivatives of the target function, the third one calculates the

derivatives numerically.

For local algorithms the following settings (Local Optimization Settings) are available:

ITEM DESCRIPTION

Optimization Algorithm Choose one of the three optimization algorithms given above.

Maximal Number of Itera-

tions

Here the maximal number of iterations. The algorithm stops when either the

estimated error is less than theMaximal Tolerance, or the maximal number of

iterations is reached. Please consider that the number of function evaluations

is higher than the number of iterations.

Maximal Tolerance Herewith the stop criterion for the algorithm is specified. The algorithm stops

when either the estimated error is less than the specified value εmax, or Max-

imal Number of Iterations was reached. See Sec. 138.2.2 for the definition of

the estimated error.

Initial Step Width Scale

Factor

Via this factor the step widths from the start values to the first iteration values

of all free parameters are scaled. Thereby the user can control the search

area around the start value. The step widths also depend on the constraint

types and constraint values of the corresponding parameter constraints.

The iteration process of a local algorithm stops when either the estimated error ε is less than the tolerance εmax,

or the maximum number of iterations is reached.

102.1.5.1 Simulated Annealing

The simulated annealing method is based on an analogy from materials science and enables the global search

for theminimum by an random temperature term t that is added to the current target function value. It is obtained
from

t = T log r , (102.1)

where r is a random value between 0 and 1. T is the temperature, which is gradually decreased according

to an annealing schedule, which is specified on the Global Optimization Settings group box (↪→Fig. 716). The

selected local optimization algorithm is applied to the adapted target function at each annealing step. Currently,

the downhill simplex algorithm is the only possible choice for the applied local optimization algorithm.
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The following Global Optimization Settings can be specified:

ITEM DESCRIPTION

Optimization Algorithm The global optimization method. Only Simulated Annealing is available.

Number of Annealing

Steps

The number of steps n at which the temperature is evenly decreased by

∆T = TS
n to zero. At each annealing step, iteration stops if either theMaximal

Number of Iterations of the applied local optimizer is reached or if the esti-

mated error is less than the tolerance, but typically this only occurs during the

final step, when the temperature is zero.

Start Temperature Temperature TS at which the annealing process is started.

Figure 716. Group box with global optimization settings. Only visible if Global Optimization strategy is chosen.

For locating the global minimum successfully, appropriate values for Start Temperature and Number of Anneal-

ing Stepsmust be chosen. Unfortunately, this is something of a trial and error process in most cases. Generally,

it is a good idea to do some iterations via a Parameter Run (↪→Sec. 44) within the considered parameter range

for better understanding the target function value range. If the start temperature is too low the algorithm will

possibly get stuck in the surrounding of a local minimum. On the other hand, temperature values that are too

high will increase the probability for “jumping out” of the surrounding of an already detected global minimum.

102.1.6 Optimization Results Page

Figure 717. Optimization results page of the parametric optimization document

On this page the optimization can be started or stopped via the Go! button or the Parametric Optimization >

Go! ribbon item and one can track the advance in the optimization progress via the results table (↪→Fig. 717).

The table shows the following information per simulation step:
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• The resulting target function value of each simulation step (Optimizer Logging row). Sec. 138.2.1 explains

how this value is calculated.

• The values of all varied parameters in the Parameter Constraints row.

• All enabled general constraints in the General Constraints row.

• All enabled merit functions.

Each simulation step, which is equal to an evaluation of the target function by the optimization algorithm, is

logged in a new column. Note, that in general the simulation step number does not equal the iteration number.

E. g. in Powell’s method the target function can be evaluated more than 100 times during one iteration [Pow64].

If the optimization algorithm stops or is stopped by the user, the last column will always show the optimized

parameters (for which the smallest target function value was obtained).

The appearance and the handling of this page is very similar to the results page of the parameter run document

(↪→Sec. 44.5), but it has less output options.

You can select a subset of all results by clicking on the column or row headers or by directly selecting a cell

range. This selection can be copied to the Windows™ clipboard via the context menu or the shortcut Ctrl+C .

ITEM DESCRIPTION

Create Output from Se-

lection

If you click this button, for each table row of the current selection a combined

output is generated, i. e. a separate one-dimensional data array where the

data in this row is plotted versus the simulation step. This button has the

same functionality as the corresponding ribbon button (↪→Sec. 44.1).

Filter Rows by … Applies a search string to the table. Only rows matching the given string are

shown, whereas the following rules apply:

• The search is not case sensitive, i. e. lens, Lens, and LENS yield the

same results.

• It is possible to search for multiple words and word groups embraced by

quotation marks. Rows containing at least one of these words or word

groups in any of their cells are shown.

• A - in front of a word or word group means ‘not’, e. g. -lens shows all
lines not containing ‘lens’.

• Expressions in quotation marks are searched as entered. For exam-

ple ``-2.5'' searches for the number -2.5, not for rows not containing
2.5. And ``Lens System'' searches for rows containing directly “lens
system”, not for rows containing “lens” or “system”.

The following options for the result table are available in the Property Browser (↪→Sec. 4.3).
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ITEM DESCRIPTION

Always Plot versus Simu-

lation Step

If you create a combined output of the values in a table row, usually these

values are plotted versus the Simulation Step (= the column headers). But

if there are only one or two parameter constraints and you do not create a

combined output for these constraints, then you can choose to plot versus

these constraints instead by setting the option Always Plot versus Simulation

Step in the Property Browser to False. ↪→Sec. 44.5.1.1

Log Contributions If this option is enabled, not only the target function (↪→Sec. 138.2.1) is logged

for each optimization step, but also the contribution of each merit function to

it. In this way you can easily recognize when one merit function dominates

the optimization process.

No Logging During Opti-

mization

Provides the same functionality as the No Logging During Execution ribbon

item (↪→Sec. 102.1.1).

Sort Rows By default the rows are sorted alphanumerically by the Detector and the Sub-

detector. Using this option you can ensure the same order as in the Param-

eter Selection and the Constraint Specification page is used.

After Completion For long running optimizations it can be useful if after completion the op-

timization document saves itself and optionally the computer shuts down.

This can be defined with this option which is also available in the ribbon

(↪→Sec. 102.1.1).

If the document has not been saved before it is saved at {Path for User
Settings}\Autosaved Files. The Path for User Settings can be set on the
Saving tab of the Global Options dialog (↪→Sec. 6).

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Parameter Run for which this option is set.

Automatic Saving Here you can enable or disable that the document is saved periodically after

a certain time interval.

Interval for Automatic

Saving

O A S .

The time interval after which the document is saved automatically.

Number of Digits The number of digits of the shown values. The default is taken from the

Number of Digits of the Global Options dialog (↪→Sec. 6.5).

Show Physical Units With this option you can convert all values to their respective base unit and

omit all units. For example, “1 nm” will then be shown as “1e-9” and “180°”

will be shown as “3.1416”. This simplifies using copied values in external

programs.

102.1.6.1 Additional Information in the Table

If only one parameter constraint is optimized, it might happen that the same parameter value is used in distinct

simulation steps. Such duplicate simulations are not shown in the table.

If the optimizer chooses parameters which result in an inconsistent Optical Setup (e. g. negative thicknesses),

the target function is set to NaN (an indicator for invalid values). If any of the chosen parameters violates its

specified constraints it is marked with red font color. Both such simulation steps can be hidden by setting Show

Only Valid Simulation Steps in the Property Browser to False.

Merit functions where the specified constraint is fulfilled are marked with green font color.
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The currently best result(s), i. e. the simulation step(s) with the minimum target function value, are marked with

golden background.

103 optiSLang Package

The optiSLang Optimization in VirtualLab Fusion allows you to optimize optical setups with additional optimizing

algorithms. Just like Parametric Optimization (↪→Sec. 102), in optiSLang Bridge definedmerit functions are to be

optimized. Merit functions can consider detector results. Many types of parameter constraints are formulated

as merit functions as well. Parameters available for parametric optimization are marked with a PV in this manual

(↪→Sec. 43.5).

103.1 optiSLang Optimization Document

The optiSLang optimization document can be generated for Optical Setups (↪→Sec. 43) containing at least one

analyzer or one detector linked to the active light source which calculates a fixed number of physical values.

For some detectors or analyzers this is only the case in a specific configuration. For example the Grating Order

Analyzer (↪→Sec. 84) can only be used for optiSLang Optimization if at least one of the following conditions is

fulfilled:

• Summed Transmission, Absorption, and Reflection is checked. Then theOverall Transmission Efficiency,

theOverall Reflection Efficiency, and theOverall Reflection and Transmission Efficiency can be optimized.

• Single Order Output, but only with Order Range as Selection Strategy, as only then the number of results

is known prior to the Optical Setup simulation.

If the currently active Optical Setup is consistent, an optiSLang Optimization document can be opened via the

ribbon item Optical Setup > Optimize with optiSLang.

As other documents in VirtualLab Fusion, the optiSLang Optimization document is designed as a wizard. That

means the user can switch between the different pages sequentially via the Next and Back buttons. The

appearance of any page may depend on the settings made on preceding pages. All pages are documented in

the next sections.

The optiSLang Optimization document can be saved and loaded via the File menu of the main window of

VirtualLab Fusion. The ribbon of this document is explained in Sec. 102.1.1.

Handling of Obsolete Parameters

If you load an optiSLang Optimization which has been saved in a previous version of VirtualLab Fusion,

there might be some obsolete parameters still present in the parameter specification table. On the other

hand, newly added parameters might not yet be available.

If no results have been calculated yet, the parameters are updated automatically. Otherwise, updating

the parameters would delete the results. Then, only a warning is shown in both the Messages tab

(↪→Sec. 4.3) and the window title (“⚠ Old Parameters ⚠”).

If one of the varied parameters changed, the optiSLangOptimization cannot be configured and simulated

anymore. You can only analyze the results or Refresh the document via the ribbon (which deletes the

results).

103.1.1 Ribbon

The ribbon of the optimization document has the following entries:

ITEM DESCRIPTION



CHAPTER 103. OPTISLANG PACKAGE 844

Go! Allows you to start the optimization. Only enabled if you are on the results

page of the document window. During the optimization, the button changes

into a Stop button which allows you to stop the calculation.

After Completion For long running optimizations it can be useful if after completion the Para-

metric Optimization saves itself and optionally the computer shuts down. This

can be defined with this option which is also available in the property browser

(↪→Sec. 4.3).

If the Parametric Optimization has not been saved before it is saved at {Path
for User Settings}\Autosaved Files. The Path for User Settings can be
set on the Saving tab of the Global Options dialog (↪→Sec. 6). Below this

combo box the used file name is displayed.

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Parametric Optimization for which this op-

tion is set.

Refresh Refreshes the document to use the current set of parameters. Note that this

deletes existing results. See also the note on handling of obsolete parameters

on page 843.

Show Optical Setup This button has three sub-entries:

• Show Initial Optical Setup: Shows the Optical Setup from which the

optiSLang Optimization was originally created. This can be invoked

directly if the upper part of the Show Optical Setup button is clicked.

• Show Optical Setup for Certain Simulation Step…: Shows the Op-

tical Setup with the parameters of a certain simulation step which can

be selected in a separate dialog.

• Show Best Design Optical Setups: Allows you to select one of setups

regarded as best designs from optiSLang.

No Logging During

Execution

If you press this button, the results of the individual simulation steps are only

written after the optimization has finished. This improves performance es-

pecially in case of many fast simulation steps. If this button is not pressed

the results are written as soon as they are available. Note that this button is

disabled during an ongoing optimization and that it can also be changed via

the Property Browser.

Create Output from

Selection

If you click this button, for each table row of the current selection a combined

output is generated, i. e. a separate one-dimensional data array where the

data in this row is plotted versus the simulation step. During the output cre-

ation, the button changes into a Stop Output Creation button which allows

you to stop the calculation.

Double clicking on a row header is a short cut for selecting this row completely

and clicking Create Output from Selection. It is also possible to generate

the combined output out of the current selection via the context menu or the

Create Output from Selection button of the results table.



CHAPTER 103. OPTISLANG PACKAGE 845

103.1.2 Parameter Selection and Simulation Engine Selection Page

If you change this page, the results table is cleared.

When you create a new document the parameter selection page (↪→Fig. 718) is shown.

The upper part of this page with simulation engine drop down lets you select the simulation engine (↪→Sec. 43.4)

or analyzer (↪→Part XII) that is used for the optimization process. Analyzers can be edited using the Edit button.

Figure 718. Parameter selection page of the optiSLang optimization document. The parameter Distance Before has been

declared as variable for the optimization.

The middle part of this page lists the parameters of the underlying Optical Setup that may be varied by the

optimization algorithm. Via the Vary column the user determines if a parameter shall be variable (checked) or

fix (unchecked). At least one parameter must be variable.

The Short Name of the varied parameters is by default the last part of the Parameter Name1. However, it must

be unique for the varied parameters so you can change it if needed.

For your information also the Original Values of all parameters are given.

The first column allows you to collapse / expand all parameters of an Optical Setup Element or its categories.

Simply click on the and symbols, respectively. At the top of this column you can select to collapse all

levels (1), collapse only the Category level (2) or show all levels (*).

The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or the Parameter column pass this filter. The matching is case insensi-

tive. It is possible to search for multiple words and word groups embraced by

quotation marks, for example: "surface #1" scaling.

Show Only Varied Param-

eters

Only rows where the Vary column is checked pass this filter.

If at least one parameter has been checked, the Next button is enabled. By clicking Next one switches to the

constraints specification page (↪→Sec. 103.1.3).

A validity indicator (↪→Sec. 5.10) shows errors if for example

• the Optical Setup does not have merit functions for the currently selected Simulation Engine. This can

happen if all detectors are in a state that they cannot be used for the optiSLang optimization, e. g. they

are inconsistent or do not calculate physical values in the current configuration,
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• no parameter to Vary is selected, or

• the value range of one varied parameter is too large .

103.1.3 Constraint Specification Page

If you change the constraint specification page, the results table is cleared.

The constraint specification page (↪→Fig. 713) lists the constraints (↪→Sec. 138.2.1) that have been implicitly

defined on the previous page of the document in a table. Bymeans of that table the user defines the composition

of the target function (↪→Sec. 138.2.1).

Figure 719. Constraint specification page containing parameter constraints and merit function constraints.

Each row stands for a constraint, whereupon the constraints are sorted into their classes:

1. Every free parameter, which was selected on the parameter selection page (↪→Sec. 102.1.2), implies a

parameter constraint on this page. They are listed with gray background color because they cannot be

edited in this table.

2. The merit function constraints appear with light orange color. A merit function constraint is created for

each detector merit function that gets evaluated during optimization.

The constraint table consists of the following columns:

1 For the parameters within a Multiple Light Source (↪→Sec. 49) the index of the sub light source is appended to the default short name;

for the parameters of a Surface Layout (↪→Sec. 40.2) the region index is appended.
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COLUMN DESCRIPTION

Parameter Host The Optical Setup Element that hosts the parameter(s) or the merit function,

respectively, of the constraint. This column is read-only.

Parameter Name The name of the parameter. This column is read-only.

Use One can enable or disable merit functions via this column, but not parameters.

Parameter Type On this column one specifies the constraint type only for merit functions, which

triggers the kind of contribution to the target function. Via clicking on a cell

one can choose among Lower Limit, Upper Limit, and Target Value.

Value 1 For parameters the minimum allowed value is shown here. For merit func-

tions, the Lower Limit, Upper Limit, or Target Value can be entered here.

Value 2 For parameters the maximum allowed value is shown here. For merit func-

tions this column is unused by OptiSLang Optimization Document.

Start Value Here the user can see the start values of both parameters andmerit functions.

The values for the merit functions can be calculated by clicking the Update

button.

103.1.4 General Settings Page

On this page the optimization algorithm that is used for minimizing the target function can be defined. In the

moment only the global optimization method Evolutionary Algorithm (EA 10000, ↪→Sec. 138.2.3.2) is available.

Figure 720. General settings page of the optiSLang Optimization Document.

103.1.5 Results Page

On this page the optimization can be started or stopped via the Go! button or the optiSLang Optimization >

Go! ribbon item and one can track the advance in the optimization progress via the results table (↪→Fig. 717).

The table shows the following information per simulation step:

• The values of all varied parameters in the Parameter Constraints row.

• All enabled merit functions.
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Figure 721. Optimization results page of the parametric optimization document

The appearance and the handling of this page is very similar to the results page of the parameter run document

(↪→Sec. 44.5), but it has less output options. Each simulation done by optiSLang is logged into a new column.

You can select a subset of all results by clicking on the column or row headers or by directly selecting a cell

range. This selection can be copied to the Windows™ clipboard via the context menu or the shortcut Ctrl+C .

ITEM DESCRIPTION

Create Output from Se-

lection

If you click this button, for each table row of the current selection a combined

output is generated, i. e. a separate one-dimensional data array where the

data in this row is plotted versus the simulation step. This button has the

same functionality as the corresponding ribbon button (↪→Sec. 44.1).

The following options for the result table are available in the Property Browser (↪→Sec. 4.3).
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ITEM DESCRIPTION

Always Plot versus Simu-

lation Step

If you create a combined output of the values in a table row, usually these

values are plotted versus the Simulation Step (= the column headers). But

if there is only one parameter constraint and you do not create a combined

output for this constraint, then you can choose to plot versus this constraint in-

stead by setting the option Always Plot versus Simulation Step in the Property

Browser to False.

Sort Rows By default the rows are sorted alphanumerically by the Detector and the Sub-

detector. Using this option you can ensure the same order as in the Param-

eter Selection and the Constraint Specification page is used.

After Completion For long running optimizations it can be useful if after completion the op-

timization document saves itself and optionally the computer shuts down.

This can be defined with this option which is also available in the ribbon

(↪→Sec. 103.1.1).

If the document has not been saved before it is saved at {Path for User
Settings}\Autosaved Files. The Path for User Settings can be set on the
Saving tab of the Global Options dialog (↪→Sec. 6).

Note that Save & Shutdown Computer can lead to data loss if there are

unsaved documents but the Parameter Run for which this option is set.

Automatic Saving Here you can enable or disable that the document is saved periodically after

a certain time interval.

Interval for Automatic

Saving

O A S .

The time interval after which the document is saved automatically.

Number of Digits The number of digits of the shown values. The default is taken from the

Number of Digits of the Global Options dialog (↪→Sec. 6.5).

Show Physical Units With this option you can convert all values to their respective base unit and

omit all units. For example, “1 nm” will then be shown as “1e-9” and “180°”

will be shown as “3.1416”. This simplifies using copied values in external

programs.



XV Calculators

VirtualLab Fusion offers various calculators which implement formulas

and algorithms often used in optics. Usually, they can be found in the

Calculators menu of the Start ribbon.
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CALCULATOR DESCRIPTION

ABCD Law Calculator Allows you to define a rotationally symmetric optical system and to calculate

how a laser beam is altered by this system. The ABCD law is used to this

end. ↪→Sec. 104

Coherence Time & Length

Calculator

Calculates the coherence time and the coherence length for different spectra.

↪→Sec. 105

Debye-Wolf Integral Cal-

culator

With this calculator one can easily calculate the field in or near the focus of

an ideal lens which is illuminated with collimated light. ↪→Sec. 106

Diffraction Angle Calcula-

tor

Calculates the diffraction angles for a given period, wavelength and angle of

incidence. ↪→Sec. 107

Direction Converter Converts between Cartesian and spherical angles as well as wave numbers

and spatial frequencies. ↪→Sec. 108

Fiber Mode Calculator Calculates the (linearly polarized) modes inside an optical fiber. ↪→Sec. 109

Fresnel Effects Calculator Calculates the Fresnel effects at a material transition for different wavelengths

and angles of incidence. ↪→Sec. 110

k-Layout Visualization Shows the k-Layout diagram for a given grating setup. Available via the Start

> Light Guide ribbon item. ↪→Sec. 111

Laser Beam Calculator A simple calculator which helps you to determine all fundamental parameters

of a Gaussian beam from given parameters. ↪→Sec. 112.

Layout Design Creates an optical setup with a light guide fulfilling the given specifications. In

particular, the grating regions have the correct positions and sizes. Available

via the Start > Light Guide ribbon item. ↪→Sec. 113

Memory Calculator Calculates how much memory a certain field needs (depending on number of

sampling points, polarization state, and so on). ↪→Sec. 114

Modulation Depth Calcu-

lator

Allows you to calculate the modulation depth of a Diffractive Optical Element

(DOE) generating a phase difference of 2π. ↪→Sec. 115.

Rigorous Analysis of

Slanted Gratings

Slanted gratings are an important sub-class of gratings but can be analyzed

only inefficiently by the Fourier Modal Method. So this calculator allows you

to analyze them by the Integral Method, and for reference also by the Fourier

Modal Method. ↪→Sec. 116

Spherical Lens Calculator This calculator can be used for paraxial calculations based on the lens

maker’s equation as well as on the imaging equation of a spherical lens.

↪→Sec. 117

Vector & Coordinate Sys-

tem Viewer

This tool visualizes coordinate system base vectors which are rotated in re-

lation to a reference coordinate system in the 3D space. ↪→Sec. 118.

104 ABCD Law Calculator

ABCD matrices give an easy way to describe the transformation of a Gaussian beam in radially symmetric

optical systems without limiting apertures. Therefor the complex radius of curvature q of a Gaussian beam is

defined as follows:
1

q(z)
=

1
R(z)

− i
M2λ

πw(z)2 (104.1)
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R(z) is the Phase Radius at a certain position z and w(z) is the Beam Radius at the same position z. Further-
more, M2 is the M2Parameter of the Gaussian beam and λ itsWavelength. See also Sec. 51.1 for reference.

The complex radius of curvature qin of the Input Gaussian Beam is transformed by an ABCD matrixM into the

complex radius of curvature qout of the Output Gaussian Beam by the so-called ABCD law [ST91]:

qout =
Aqin + B
Cqin + D

(104.2)

Figure 722. The ABCD Law Calculator

The dialog of this calculator is shown in Fig. 722 and has the following controls:

ITEM DESCRIPTION

Input Gaussian Beam Allows you to enter Wavelength λ, M2Parameter, Beam Radius w(z), and
Phase Radius 1/e2 R(z) of the input beam. It is assumed that both beam and

phase radius are given at the same position z.

ABCD Matrix Control Allows you to define the system ABCD matrix by composing it of an arbitrary

number of optical elements. ↪→Sec. 5.16

Resulting ABCD Matrix Shows the automatically calculated ABCD Matrix of the combination of the

optical elements.

Output Gaussian Beam Displays Beam Radius 1/e2 and Phase Radius if the input beam has been

propagated through the optical system represented by the ABCD matrix.

105 Coherence Time & Length Calculator

This calculator calculates the coherence time and the coherence length for different spectra. It has the following

controls which can be set in the dialog shown in Fig. 723.
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Figure 723. Coherence Time & Length Calculator

ITEM DESCRIPTION

Ambient Material Allows you to define thematerial in which the spectrum is defined. ↪→Sec. 34.3

Gaussian Spectrum /

Lorentzian Spectrum

The type of the spectrum.

Peak Wavelength Allows you to set the peak (vacuum) wavelength λ of the spectrum.

Bandwidth (Wavelength) Allows you to set the bandwidth ∆λ of the spectrum in the wavelength domain.

Peak Frequency Shows the corresponding frequency ν of the peak wavelength.

Bandwidth (Frequency) Shows the bandwidth ∆ν of the spectrum in the frequency domain.

∆ν = c∆λ/λ2 where c is the speed of light in the ambient material.

Coherence Time Shows the coherence time τ = s/π∆ν. s is 2 for a Gaussian spectrum and 1

for a Lorentzian one.

Coherence Length Shows the coherence length l = c · τ.

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration, which happens for example if the wavelength is not valid for

the given ambient material. In such a case, no calculated values are shown.

You then can click on the -button for further information.

106 Debye-Wolf Integral Calculator

With the Debye-Wolf Integral (↪→Sec. 139.1) one can easily calculate the field in or near the focus of an ideal

lens which is illuminated with collimated light.
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Figure 724. The Debye-Wolf Integral Calculator

VirtualLab Fusion offers a calculator to easily evaluate this integral (↪→Fig. 724). It is separated into three tabs

(see below). Furthermore it contains the following controls.

ITEM DESCRIPTION

Create Results Starts the generation of the results. The electromagnetic field (Ex, Ey, and

Ez) and the electric energy density are calculated.

After clicking, this button turns into a Stop button which allows you to cancel

a long lasting calculation.

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further

information.

The Light Source tab allows you to set the Wavelength and polarization of the incident collimated light. For

setting the polarization the control described in Sec. 48.3 is used.

The Optical Setup tab has the following controls.

ITEM DESCRIPTION

Ambient Material Allows you to define the material around the focusing lens. ↪→Sec. 34.3

Numerical Aperture The numerical aperture of the focusing lens.

Focal Length The focal length of the lens.

Distance from Focal Plane

to Result Field

You can calculate the field in the focus (if this value is zero) or slightly out of

the focus (if this value is unequal zero).

The Numerical Parameters tab contains those settings with which you can reduce the accuracy of the results

to achieve faster calculations.
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ITEM DESCRIPTION

Field Size The lateral extension of the results.

Estimate Field Size Estimates the field size F according to

F = 6 · (0.61λ ·NA+ |d| · tan (arcsin NA/n))

with the Wavelength λ, the Numerical Aperture NA, the Distance from Focal

Plane to Result Field d, and the refractive index n of the Ambient Material.

Sampling Points The number of sampling points in the result fields.

Number of Directions The Debye-Wolf integral over all angles (↪→Sec. 139.1) is approximated by a

sum over a certain number of discrete angles. This number can be set here.

107 Diffraction Angle Calculator

This calculator is a visualization of the grating equation given in Sec. 139.5. Only a one-dimensional intersection

(y = 0) is shown and thus only the angles α are given.

The Grating Period Px, the Incident Angle αin (out of which the incident wave vector is calculated), and the

Wavelength λ can be entered directly. The refractive indices nin and nout can be specified by setting the First
Material and the Second Material using the control described in Sec. 34.3. Incident wave and reflected orders

are in the first material, the transmitted orders are in the second material. If a material has no refractive index

data for the given wavelength, a refractive index of 1 is used.

Using the Switch Materials button you can swap the two materials easily.

In the Diffraction Orders box, you can change the Maximum Shown Order. This parameter determines how

many propagating orders you will see – evanescent orders are not shown in this diagram. The minimum and

maximum propagating order, both for reflection and transmission, are shown as Reflected Orders Range and

Transmitted Orders Range, respectively.

The results are visualized in a Diffraction Orders Diagram (↪→Sec. 19). If you want to save or manipulate this

diagram, you can generate a Separate Diagram document.
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108 Direction Converter

Figure 725. Direction Converter

There are different ways how angles can be specified. This calculator converts between the following four

representations using the equations given in Sec. 139.3:

• Cartesian Angles

• Spherical Angles

• Wave Vector Components and

• Spatial Frequencies .

The independent parameters vacuum wavelength λvac and refractive index n have to be specified in the dialog:

ITEM DESCRIPTION

Vacuum Wavelength Vacuum wavelength λvac to calculate the wave number k from.

Homogeneous Medium Defines the medium that provides the refractive index n(λvac) for the calcu-

lation of the wave number k. This control is described in Sec. 34.3.
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109 Fiber Mode Calculator

Figure 726. The document window of the Fiber Mode Calculator.

The Fiber Mode Calculator calculates the propagation constants, effective refractive indices and field distribu-

tions of the modes in a fiber.

It has the following controls:
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ITEM DESCRIPTION

Mode Type Allows you to select between Linearly Polarized Bessel modes which occur

in step-index fibers and Linearly Polarized Laguerre modes which occur in

gradient index fibers.

Wavelength The wavelength λ of the modes.

Core Diameter The core diameter d of the fiber.

Core Material Allows you to set the material in the fiber core with the control described in

Sec. 34.3. Only the real-valued refractive index ncore(λ) is used.

Cladding Material O L P B

Allows you to set the material of the fiber cladding with the control described

in Sec. 34.3. Only the real-valued refractive index ncladding(λ) is used.

Gradient Constant O L P L

For gradient index fibers the refractive index distribution is given by

n2(r) = ncore(λ)2

(
1− 2∆

(
r
r0

)2
)

(109.1)

whereas ncore is the refractive index in the center given by the Core Material;
r0 = d/2 is the core radius; and ∆ is the gradient constant.

Maximum Azimuthal Or-

der /

Maximum Radial Order

The table with the mode structure is updated every time you change one of

the parameters. By setting the maximum azimuthal or radial order you can

influence how long this update takes (and how long to Create Mode Fields).

Create Mode Fields Calculates for each mode the complex-valued field distribution and displays

the result in a 2D Data Array with one subset per mode. If clicked the button

turns into a Stop-button to cancel the calculation. As the calculator is a docu-

ment window you can continue to work with other documents or dialogs during

the calculation. You can adjust the sampling of the fields with Oversampling

Factor and Field Size Factor from the Global Options dialog (↪→Sec. 6.12).

Show Mode Structure Displays the mode structure shown in the table as a separate 1D Data Array

with one subset per column. This allows manipulations and comparisons.

Validity This control indicates whether the current configuration is valid, ↪→Sec. 5.10.

Error messages can be shown in a separate dialog.

For example it is checked that the modes are not cut off, which would be the

case if the cutoff parameter V = π/λ · d
√

n2
core − n2

cladding
is less than 1. Also

V > 300 is not practical.

{Table} Shows information for each existing mode: azimuthal and radial order, prop-

agation constant and effective refractive index.

110 Fresnel Effects Calculator

The Fresnel Effects calculator enables you to get the complex Fresnel Coefficients according to Fresnel’s

equations given in Sec. 139.4:

There is the possibility to get all coefficients at a glance for a given wavelength and incidence angle, but there

is also the possibility to get a diagram of the dependencies on wavelength and angle of incidence. These
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both kinds of output (Tables ↪→Sec. 110.2 and Diagram ↪→Sec. 110.3) are described in the following, after the

description of the materials setup of the calculator (Sec. 110.1).

110.1 Materials and Coating Setup

Figure 727. The controls for the setup of the materials and an optional coating.

The controls of the dialog are explained in detail in the following table:

ITEM DESCRIPTION

First Material Material in front of the surface to examine the Fresnel coefficients for. For the

usage of the control see Sec. 34.3.

Switch Materials Sets the First Material as Second Material and vice versa.

Second Material Material behind the surface to examine the Fresnel coefficients for. For the

usage of the control see Sec. 34.3.

Coating A coating to be considered for the calculation. For the usage of the control

see Sec. 34.2.

The image in the bottom of Fig. 727 shows the sequence of the materials, the coating and the surface. Solid

material is symbolized by , liquid by , and gaseous material or vacuum by . Which side of the surface

is coated is shown by the symbols and .
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110.2 Tables Output Panel

Figure 728. The calculator’s panel with the output of all Fresnel coefficients for one wavelength and one incidence angle

at a glance.

The controls of the dialog are explained in detail in the following table:

ITEM DESCRIPTION

Wavelength Wavelength λ to do the calculation for.

Angle of incidence Angle of incidence θ to do the calculation for.

Intensity Coefficients Reflectance R and transmittance T.

Complex Fresnel Coeffi-

cients

Reflection coefficient ρ and transmission coefficient τ in Amplitude/Phase no-

tation.
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110.3 Diagram Output Panel

Figure 729. The calculator’s panel with the output of a diagram with wavelength or angular dependency.

ITEM DESCRIPTION

Abscissa(e) What dependency shall be shown in the diagram? Dependency on Wave-

length, Incidence Angle, Energy, orWavelength and Angle?

Wavelength/Energy Wavelength λ or wavelength range (energy range in case of Energy depen-

dence) to do the calculation for.

Angle of Incidence Angle of incidence θ or angle range to do the calculation for.

Polarization Shall the coefficients be calculated for Transverse Electric (TE), Transverse

Magnetic (TM) polarization or both (TE and TM)?

Coefficient Which coefficient shall be calculated? Reflectance R, Transmittance T, ampli-
tude or phase of the complex reflection coefficient ρ (Reflection Coeff (Ampli-

tude), Reflection Coeff (Phase)), or amplitude or phase of the complex trans-

mission coefficient τ (Transmission Coeff (Amplitude), Transmission Coeff

(Phase)).

111 k-Layout Visualization

O AR/VR/XR P .

This calculator generates a k-Layout diagram for the specified grating setup. Its document window (↪→Fig. 730)

has two tabs, a zoomable diagram, and a validity indicator (↪→Sec. 5.10).
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Figure 730. The document window of the k-Layout Visualization.

The Physical Settings tab has the following controls:

ITEM DESCRIPTION

Wavelength The (vacuum) wavelength for which the k-Layout is generated.

Surrounding Medium Defines the surrounding medium by means of the control described in

Sec. 34.1.

Light Guide Medium Defines the light guide medium by means of the control described in

Sec. 34.1.

Width x Height The extension of the field of view in degrees for both x- and y-direction.

Offset The offset of the field of view from perpendicular incidence in degrees for both

x- and y-direction.

Grating Parameters Period, Rotation Angle, and Grating Order of the three involved gratings: In-

coupling Grating, Eye Pupil Expander, and Outcoupling Grating.

The View Settings tab has the following controls:

ITEM DESCRIPTION

Colors All colors to be used in the diagram can be set here.

Fill Field of View Boxes Defines whether the “field of view boxes” are drawn filled or just as outline.

Opacity of Field of View

Boxes

In case of filled boxes, the opacity of the filling can be set here. The maximum

value of 1 means full opacity.

112 Laser Beam Calculator

The Laser Beam Calculator (↪→Fig. 731) allows you to calculate all parameters of a laser beam (M2, waist

radius, divergence, Rayleigh length, waist distance, and beam radius) if only some of these parameters are

known. To this end the equations given in Sec. 132.1 are used.
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This calculator is designed as document, i. e. you can open more than one document and and then open a

Gaussian generator dialog (↪→Sec. 51.1) to import the data there.

Figure 731. Laser Beam Calculator

The following parameters can be specified:

ITEM DESCRIPTION

Type You can choose among different types of a laser beam. Depending on the

type the document windows slightly changes. The following types are avail-

able:

• For an Arbitrary Laser Beam, the M2 value can be set freely.

• For a Fundamental Gaussian ModeM2 is always 1. But in this case you

can choose whether you want to enter 1/e2, FWHM, or HWHM values.

• For a Hermite-Gaussian Mode and a Laguerre-Gaussian Mode, the M2

value is calculated from the given order(s).

Parameters O F G M

Defines which parameters you actually set:

• 1/e2 Waist Radius, Divergence Half Angle: The beam radius is deter-

mined by a relative intensity decay by 1/e2 for a Gaussian beam. The

divergence angle is measured between the optical axis and the 1/e2

decay of the intensity.

• 1/e2 Waist Diameter, Divergence Full Angle: The beam diameter is de-

termined by a relative intensity decay by 1/e2 for a Gaussian beam. The

divergence angle is measured between the 1/e2 decays of the intensity.

• FWHMWaist and Divergence Angle: The waist and the divergence an-

gle are defined as full width half maximum (FWHM) of the laser beam

intensity. The conversion factor from 1/e2 radius / half angle to FWHM

is
√

2 ln 2.
• HWHM Waist and Divergence Angle: The waist and the divergence

angle are defined as half width half maximum (FWHM) of the laser beam

intensity.
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Order O H -G M L -G M

Order 0 corresponds to the fundamental Gaussian mode. For a Laguerre-

Gaussian mode, the left text box refers to the radial order while the right box

specifies the angular order.

M2 Parameter M2 parameter of the beam. Can be set only for Arbitrary Laser Beams. Oth-

erwise it is fixed to 1 (Fundamental Gaussian Mode) or calculated from the

Order.

Reference Wavelength

(Vacuum)

Vacuum wavelength of the Gaussian wave.

Waist Radius Beam size in waist position.

Divergence Angle The divergence angle in the far field.

Rayleigh Length Rayleigh length of the Gaussian wave.

Longitudinal Waist Dis-

tance

Distance from the waist used for the calculation of Beam Radius and Phase

Radius.

Beam Size (z = 0) Beam size in a distance from the waist which is specified by Longitudinal

Waist Distance.

Phase Radius (z = 0) Radius of curvature of the phase in a distance from thewaist which is specified

by Longitudinal Waist Distance. In the waist position this radius is always

infinity.

113 Layout Design Calculator

O AR/VR/XR P .

This calculator creates an optical setup with a light guide fulfilling the given specifications. In particular, the

grating regions have the correct positions and sizes.
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Figure 732. The document window of the Layout Design Calculator.

Its document window (↪→Fig. 732) has three tabs, a button Create Result which creates the optical setup and

the corresponding k-layout (↪→Fig. 111), and a validity indicator (↪→Sec. 5.10).

The Incident Light tab has the following controls.

ITEM DESCRIPTION

Wavelength The (vacuum) wavelength of the incident light.

Beam Size The beam size in x- and y-direction.

Distance Source to Light

Guide

The distance between the source and the light guide component.

Surrounding Medium The medium outside of the light guide. The controls are described in

Sec. 34.1.

Extension The extension of the field of view in degrees for both x- and y-direction.

Offset The offset of the field of view from perpendicular incidence in degrees for both

x- and y-direction.

The Light Guide tab contains the specification of the actual light guide.
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ITEM DESCRIPTION

Absolute Position The lateral position of the center of the incoupling grating relative to the inter-

nal coordinate system (↪→Sec. 43.8.1.1) of the light guide component.

Position Outcoupling

Grating

The lateral position of the outcoupling grating (and thus the output channel)

relative to the center of the incoupling grating.

Thickness of Light Guide The thickness of the light guide.

Design for Reflection If this option is checked, the light leaves the light guide on the same side as

the incident light.

Light Guide Medium The medium within the light guide. The controls are described in Sec. 34.1.

Orientation Incoupling

Grating

A value of 0° means that the incident light is deflected along the x-axis.

Fixed Incoupling Period Determines whether the Period Incoupling Grating or the Mode Density is

determined by the user.

Period Incoupling Grating O F I P .

The period of the incoupling grating.

Desired Maximum Dis-

tance of Outcoupling

Beams

O F I P .

The period of the incoupling grating is determined so that the desired maxi-

mum distance for the outcouplping beams is reached. Themaximum distance

of the outcoupling beams is calculated for the field of view mode which has

the smallest density. In case no period could be calculated for the entered

value an error message will be displayed.

Deflection Angle Eye

Pupil Expander

Specifies by how many degrees the Eye Pupil Expander changes the lateral

direction of the light.

The Outgoing Light tab has the following controls.

ITEM DESCRIPTION

Distance Light Guide to

Eye

The distance between light guide and eye (represented by a Camera Detec-

tor).

Size of Eye Box The size of the eye box (represented by the window size of the detector).

114 Memory Calculator

The Memory Calculator (↪→Fig. 733) allows you to calculate howmuch memory a certain field needs (depending

on number of sampling points, polarization state, and so on).

Figure 733. Memory Calculator
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The required memory depends on the following parameters.

ITEM DESCRIPTION

Sampling Points The number of sampling points of a field.

Real-Valued /

Complex-Valued

In contrast to Real-Valued numbers, Complex-Valued numbers store two

numbers per pixel (real and imaginary part).

Globally Polarized /

Locally Polarized

In contrast to a Globally Field, a Locally Polarized field contains two field

components (Ex and Ey).

115 Modulation Depth Calculator

The Modulation Depth Calculator (↪→Fig. 734) allows you to calculate the modulation depth of a Diffractive

Optical Element (DOE) generating a phase difference of 2π. To this end the Thin Element Approximation

(TEA) is used.

Figure 734. Modulation Depth Calculator

The following parameters can be specified:
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ITEM DESCRIPTION

Setup The user can specify whether the modulation depth shall be calculated for a

transparent plate which works in transmission, or for aHeight Profile of Mirror.

Substrate Medium The medium of the substrate block of the DOE. Note that the substrate can

only be configured if the optical setup Height Profile of Transparent Plate is

selected, otherwise it is set to Ideal Mirror.

Surrounding Medium The surrounding medium of the DOE.

Wavelength The vacuum wavelength for which the modulation depth shall be calculated.

Number of Quantization

Levels per 2 pi Phase

Modulation

The number of quantization levels that are used to generate a phase modu-

lation of 2π.

Height Modulation Depth

per 2 pi

Displays the profile height h corresponding to a 2π phase modulation.

For a transparent plate this height is h = λ/∆n, where λ is the Wavelength,

and ∆n is the (positive) difference of the refractive indices of the two media.

For a mirror this height is h = λ/2ns where ns is the refractive index of the

Surrounding Medium.

Modulation Depth of

Quantized Surface

The highest level of a quantized surface never corresponds to a phase differ-

ence of 2π as then it would have the same effect as the lowest level. Thus

the overall Modulation Depth of Quantized Surface hq is only hq = h · (l−1)/l

where l is the Number of Quantization Levels.

The refractive index of the substrate medium must not be equal to the refractive index of the surrounding

medium. Otherwise no results are displayed and the validity indicator in the bottom left corner shows an error

message.

116 Rigorous Analysis of Slanted Gratings

O V L F A .

Slanted gratings are an important sub-class of gratings but can be analyzed only inefficiently by the Fourier

Modal Method (↪→Sec. 96.3). So this calculator allows you to analyze them by the Integral Method ([SK11]),

and for reference also by the Fourier Modal Method.



CHAPTER 116. RIGOROUS ANALYSIS OF SLANTED GRATINGS 869

Figure 735. Calculator for Rigorous Analysis of Slanted Gratings

Its document window (↪→Fig. 735) has the following controls:

ITEM DESCRIPTION

Wavelength The (vacuum) wavelength for which the analysis is done.

Surrounding Medium Defines the medium in front of the grating. This control is described in

Sec. 34.1.

Substrate Medium Defines the medium behind the grating. This control is described in Sec. 34.1.

Period The period of the grating.

Fill Factor The width of the grating ridges relative to the period.

Slant Angle The angle of the left and the right flank of the grating, respectively.

Polarization Whether the analysis is done for the TE Polarization or the TM Polarization.

Order to Analyze Which of the grating orders is analyzed.

Analyze Grating Efficien-

cies for Transmission

with this checkbox you can switch between analysis of transmitted and re-

flected orders.

Range of Curvatures This calculator models the slanted grating with rounded edges of a certain

curvature. More precisely a range of curvatures is scanned.

Number of Steps for Anal-

ysis

Defines howmany curvatures in the givenRange of Curvatures are analyzed.

Analyze by … Defines whether the gratings are analyzed by the Integral Method and / or the

Fourier Modal Method.
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117 Spherical Lens Calculator

This calculator can be used for paraxial calculations based on the lens maker’s equation as well as on the

imaging equation of a spherical lens.

117.1 Lens Definition

In this page (↪→Fig. 736), a spherical lens can be defined by using the following parameters:

ITEM DESCRIPTION

Embedding Medium The medium the lens is supposed to be used in.

Lens Medium The medium the lens is made of.

First Surface Type The type (convex, concave, or planar) of the first lens surface.

First Surface Radius The curvature radius of the first spherical lens surface.

Center Thickness The center thickness of the lens, i.e. the distance of one surface vertex to the

other.

Second Surface Type The type (convex, concave, or planar) of the second lens surface.

Second Surface Radius The curvature radius of the second spherical lens surface.

Figure 736. The Lens Definition page of the Spherical Lens Calculator

In the lower area of the dialog, some characteristic distances will be given for a certain Design Wavelength.

These distances are:
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ITEM DESCRIPTION

Effective Focal Length The effective focal length of the lens if used with the givenDesignWavelength

inside the given Embedding Medium.

Front Focal Length The distance from the front vertex to the front focal point. For a converging

lens, this will be negative.

Back Focal Length The distance from the back vertex to the back focal point. For a converging

lens, this will be positive.

V1P1 The distance of the front principal point measured from the front vertex.

e The distance of the two principal points to each other.

V2P2 The distance of the back principal point measured from the back vertex.

The calculations are based on the lens maker’s equation:

1/ f = (n− 1)
(

1
r1
− 1

r2

)
+

d(n− 1)2

nr1r2
, (117.1)

with f being the effective focal length, n the ratio of the refractive indices of the lens medium and the embedding

medium, r1 the curvature radius of the first surface (positive if convex), r2 the curvature radius of the second

surface (positive if concave), and d being the center thickness.

117.1.1 Setting a New Focal Length

If a certain effective, back, or front focal length shall be realized, the corresponding lens parameters can be

calculated. By clicking Set to the right of the respective Effective / Back / Front Focal Length text box, a new

dialog (↪→Fig. 737) will open.

Figure 737. Dialog for setting a new focal length for the Spherical Lens Calculator
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ITEM DESCRIPTION

New Effective / Back /

Front Focal Length

The desired focal length can be entered here.

Curvature Radius of the

Surfaces / Non-planar Sur-

face

If this option is chosen and one of the surfaces is defined to be planar then

the curvature radius of the other surface which will realize the desired focal

length will be calculated.

If it is chosen and none of the surfaces is planar, the curvature radii of a

symmetric lens will be calculated.

Center Thickness I ,

- .

I ,

- .

I ,

- .

If this option is chosen, the center thickness which will realize the desired

effective focal length will be calculated.

Refractive Index of Lens

Medium

If this option is chosen, the refractive index of the lens which will realize the

desired effective focal length inside the given Embedding Medium will be cal-

culated. A new non-dispersive medium with this refractive index will be set

as Lens Medium.

117.2 Paraxial Imaging with a Lens

Two equations are important for calculating distances and sizes for paraxial imaging.

The imaging equation describes the relation between the focal length f , the object distance so, and the image

distance si:
1
f
=

1
si
− 1

so
, (117.2)

while the magnification yi/yo (i.e. the ratio of the image size yi to the object size yo) is related to the object and

image distance as follows:

yi/yo =
si
so

. (117.3)

All possible dependencies of these four quantities f , so, si, and yi/yo can be analyzed in the Imaging page of

the calculator (↪→Fig. 738).
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Figure 738. The Imaging page of the Spherical Lens Calculator

There are two modes for using the calculations in this page:

• If Retrieve from Lens Definition is checked, the Effective Focal Length is copied from the Lens Definition

page and cannot be altered here. If one of the three other quantities is changed, the two remaining values

are calculated.

• If Retrieve from Lens Definition is unchecked, the button Select Constants allows to decide which two of

the four quantities shall be kept constant while a new value is entered.

118 Vector & Coordinate System Viewer

This tool serves the visualization of coordinate system base vectors which are rotated in relation to a reference

coordinate system in the 3D space. It allows to understand the effect that has any value for any angle that

belongs to any type of orientation definition. For an overview of all available orientation definition types see

Sec. 139.2.
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Figure 739. Vector & Coordinate System Viewer

The following parameters can be specified:
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ITEM DESCRIPTION

Longitude/Latitude The view direction can be set via the values of Longitude and Latitude. An

alternative is the rotation of the view by dragging via mouse inside the view.

Definition Type The orientation definition type (see Sec. 139.2) can be chosen here.

Angle Phi / Theta / Alpha

/ Beta / Gamma / Rho /

Sigma / Tau

The angles which belong to the definition types Spherical Angles, Direction

Angles, and Cartesian Angles, resp. All these angles are used in order to

define the orientation of the new z’-axis. The new directions of the x’- and

y’-axis are defined by rotating the original x-y-z-system about the node line

(marked blue in the view). The node line is the normal to the plane which is

spanned by the old z- and the new z’-axis.

Angle Zeta After defining a new z’-axis via spherical, Cartesian or direction angles, the

new system x’-y’-z’ can be rotated additionally about the new z’-axis by the

Angle Zeta. This will result in a new system x”-y”-z’.

Euler Angle: Ψ / Θ / Φ For the orientation definition type Euler Angles, the angles can be specified

here.

Rotation Axis: x- / y- / z-

axis

For the orientation definition type Sequence of Axis Rotations, this will define

the axis rotation sequence.

Fixed Axes If checked, the rotations are done about fix coordinate axes. Otherwise the

second and third rotation are done about the new coordinate axes resp. Ex-

ample: If Fix Axes is checked, the sequence Z-Y-Z means rotation about the

old z-axis, followed by a rotation about the old y-axes, followed by another

rotation about the old z-axis. If it is not checked, the sequence Z-Y-Z means

a rotation about the old z-axis, followed by a rotation about the new y’-axes,

followed by another rotation about the new z’-axis.

Latitudemeasured form x-

/ y- / z-axis

The axis which shall point upwards in the view can be chosen here.

Zoom Factor This value allows to define a zoom into the view. An alternative is zooming

via mouse wheel.

Axis Scale Factor This values allows scaling of the (red) coordinate base vectors in the view.

Start/Stop Rotation about

x- / y- / z-axis

In order to allow a better notion of the 3D relations, an animation can be

started/stopped by clicking this button.

Rotation Speed If an animation has been started, the rotation speed can be set here.

119 Waveplate Calculator

If a waveplate shall be designed with the objective of creating a certain phase retardation for polarized light

of a given wavelength, then the correct thickness of the plate has to be known. The waveplate calculator (as

shown in Fig. 740) serves that purpose.
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Figure 740. Calculator for determining the thickness of a waveplate.

The following parameters have to be specified:

ITEM DESCRIPTION

Design Wavelength The vacuum wavelength the waveplate shall be designed for.

Retardation If the entry Free Definition is selected, either a certain Wavelength Fraction

or Phase Difference can be set in the text-box as the desired value of retar-

dation. Otherwise, a pre-defined value can be set here: A Half Wave can be

chosen as well as a Quarter Wave which correspond to the well-known types

of common waveplates.

Medium The uniaxial, anisotropic medium the waveplate shall consist of.

Use Minimum Thickness If checked, a minimum thickness for the waveplate can be defined.

Absolute Retardation In case a certain minimum thickness is given, the ”absolute retardation” will

describe the absolute phase effect of a waveplate of the calculated thickness

on polarized light. This may be an integer multiple of the defined Retardation.

Calculated Thickness The thickness a waveplate of the givenMediummust have in order to produce

the desired Retardation.

Please note: The formula for calculating the thickness is an approximation in that it only takes into account the

optical path length differences for a single transition of light. Resonance effects due to multiple reflections are

thus not included, although they naturally have an effect on the polarization of the transmitted light.



XVI Export and Import

Different programs use different file formats. This part of the manual

explains the most important file formats which can be imported into /

exported from VirtualLab Fusion.
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In the following all supported file formats are listed, grouped by the VirtualLab Fusion objects which can handle

them.

VIRTUALLAB FUSION

OBJECT

SUPPORTED FILE FORMATS

Animations • Export the current frame to various raster graphics formats

(*.bmp, *.png, *.jpg).

• Export the whole animation as an animated GIF file (*.gif). ↪→Sec. 123.1

• Export the whole animation as a video file (*.avi).

• Create an overview image of all frames (*.bmp; *.jpg; *.png; *.tif).

↪→Sec. 123.2

Boundary Operators • Export of Grating Cells Arrays to text file (*.csv) or GDSII Data (*.gds).

↪→Sec. 126.1

• Export of Prism or Mirror Cells Arrays to text file (*.csv) or stereolithography

format (*.stl). ↪→Sec. 126.2

Coatings Import of Macleod Coatings. ↪→Sec. 128

Chromatic Fields Sets • Export to Field Information format (*.fin). ↪→Sec. 122.1

• Import of various raster graphics formats (*.bmp, *.png, *.jpg). ↪→Sec. 122.2

Data Arrays • Export to text file (*.txt, *.csv). ↪→Sec. 121.1

• Import of various raster graphics formats (*.bmp, *.gif, *.png, *.jpg, *.pcx,

*.tif) and of text files (*.txt, *.csv, *.fin). ↪→Sec. 121.2

Harmonic Fields • Export and import to various raster graphics formats (*.bmp, *.png, *.jpg,

*.tiff). ↪→Sec. 120.1

• Export of current view to vector format (*.emf)

• Export and import of Field Information format (*.fin). ↪→Sec. 120.2.1

• Export and import of “ASCII” format (*.txt; *.csv). ↪→Sec. 120.2.2

• Export and import of “CodeV” format (*.dat). ↪→Sec. 120.2.3

• Export and import of “Plain Text” format (*.ptf). ↪→Sec. 120.2.4

• Import of “ZemaxOpticStudio® BeamFile” binary format (*.zbf).

↪→Sec. 120.3

Harmonic Fields Sets • Export and import of Field Information format (*.fin). ↪→Sec. 120.2.1

• Export to various raster graphics formats (*.bmp, *.png, *.jpg).

↪→Sec. 120.1.2

• Import of various raster graphics formats (*.bmp, *.png, *.jpg).

↪→Sec. 120.1.3.3, ↪→Sec. 120.1.3.4

Materials Import from ZemaxOpticStudio® Glass Catalogs (*.agf). ↪→Sec. 129

Optical Setups • Export to XML / Batch Mode files / optiSLang Project ↪→Sec. 124.1

• Import Parameters from XML. ↪→Sec. 43.6

• Import of optiSLang Results. ↪→Sec. 124.2

• Export to JCMsuite format. ↪→Sec. 124.3

• Export to stereolithography format (*.stl) and to the IGES format (*.igs) via

the 3D View. ↪→Sec. 5.15

• Import of ZemaxOpticStudio® LensFile format (*.zmx, *.zos) and archive

format (*.zar). ↪→Sec. 124.4
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Real Components • Export to stereolithography format (*.stl) and to the IGES format (*.igs) via

the 3D View. ↪→Sec. 5.15

• Import of ZemaxOpticStudio® LensFiles (*.zmx, *.zos) and archives (*.zar)

into a Lens System component. ↪→Sec. 125.2

• Import of ZemaxOpticStudio® LensFiles (*.zmx, *.zos) and archives (*.zar)

into a Diffractive Lens or Meta Lens. ↪→Sec. 125.3

• Export of diffractive components (Diffractive Lens or Holographic Optical

Element with quantized real structure). ↪→Sec. 127.2

Surfaces • Export of pixelated data to plain text (*.ptf), ASCII (*.txt), CIF, GDSII, point

cloud, stereolithography format (*.stl), bitmap (*.bmp), and 16-bit grayscale

image (*.png). ↪→Sec. 127

• Export to stereolithography format (*.stl) and to the IGES format (*.igs) via

the 3D View. ↪→Sec. 5.15

• Import of pixelated data into the Sampled Surface (↪→Sec. 35.2.11). Sup-

ported formats: plain text (*.ptf), ASCII (*.txt), CIF, GDSII, and bitmap

(*.bmp). ↪→Sec. 127

• An additional section Sec. 130 summarizes which obsolete VirtualLab Fusion files can be imported into

which objects.

• Some dialogs allow an import / export to their own specific formats which are explained in the correspond-

ing sections (e. g. snippets, ↪→Sec. 7.3).

• The file formats native of VirtualLab Fusion are given in Sec. 4.1.

120 Export and Import of Field Data

120.1 Image Formats

Restrictions of Image Formats

There are in principal two kinds of raster graphics images supported by VirtualLab Fusion:

• 24 bit RGB: 8 bit or 256 different levels per color channel (red, green, blue). Thus altogether more

than 16 million colors are possible.

• 16 bit grayscale: 24 bit RGB images can only contain 256 gray levels, whereas 16 bit gray scale

images support 65 536 gray levels.

The maximum size of an image file is 4 gigabytes, which restricts the image size to roughly 36 000 ×
36000 pixels for 24 bit RGB images and 44 000 × 44000 pixels for 16 bit grayscale images.

120.1.1 Export Harmonic Fields to Images

When you export a Harmonic Field you are first asked for the file name and which of the three export variants

you want (each leading to different possible file formats).
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IMAGE TYPE DESCRIPTION

24 bit RGB Raster Graph-

ics

Exports the field into a red-green-blue color image. Supports the following

file formats: Windows Bitmap file (*.bmp); Portable Network Graphic (*.png);

JPEG File Interchange Format (*.jpg, *.jpeg); and Tagged Image File Format

(*.tif, *.tiff). Opens the dialog described in Sec. 120.1.1.1.

16 bit Grayscale Raster

Graphics

16 bit grayscale supports 65 536 gray levels. Such a file can only be saved

as Portable Network Graphic (*.png) or Tagged Image File Format (*.tif, *.tiff).

This export uses the dialog described inSec. 120.1.1.1.

Vector Graphics Exports the currently visible view to an Enhanced Windows Metafile (*.emf),

a vector format. In this case a dialog to adjust export settings analog to

Fig. 11.6.1 appears.

120.1.1.1 Dialog for Export to Raster Graphics

Figure 741. The dialog for exporting a harmonic field to a raster graphics file.

The Field Quantity of one Vectorial Component will be exported but not the Light View. If you want to export the

latter, please use theCopy View to Clipboard function (↪→Sec. 11.6.1) instead. If you export a phase distribution,

an analytical spherical phase radius is not exported.

If a 24 bit RGB image is to be generated you can configure the color mapping via the control described in

↪→Sec. 5.11.

Additionally a preview is available which can be updated with the Preview button.

The bitmap size is automatically calculated from the number of sampling points of the field. The resolution of

the resulting bitmap file is set according to the sampling distance.

120.1.2 Export Harmonic Fields Sets to Images

If the Light View (↪→Sec. 12.2.1) is visible it will be exported to the specified file. If the Data View (↪→Sec. 12.2.2)

is visible the current Harmonic Field is exported as described in Sec. 120.1.1.
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120.1.3 Import Harmonic Field Data from Bitmap Files

Figure 742. Dialog to select how a bitmap shall be imported.

If you want to import a RGB raster graphics file, you can choose between three options:

ITEM DESCRIPTION

Monochromatic (LUT

based)

With the help of a so-called look-up table (LUT) the RGB values of the bitmap

are converted to values of the selected field quantity and vectorial component.

↪→Sec. 120.1.3.1

There is also a special variant for importing an intensity distribution into the

Diffractive Optics Package, ↪→Sec. 120.1.3.2.

RGB (False Color) The bitmap is imported into a polychromatic Harmonic Fields Set. Each of the

channels R, G, and B is stored into one Harmonic Field. Their wavelengths

can be set and weighted freely. ↪→Sec. 120.1.3.3

RGB (Real Color) The bitmap is imported into a polychromatic Harmonic Fields Set in a way

that guarantees the best color fidelity when viewed in the light view (in display

mode Visual Perception). ↪→Sec. 120.1.3.4

The following image formats are supported: Windows Bitmap file (*.bmp); Portable Network Graphic (*.png);

JPEG File Interchange Format (*.jpg, *.jpeg); and Tagged Image File Format (*.tif, *.tiff).

If you import a 16 bit grayscale image, the Monochromatic (LUT based) is started automatically.

The sampling distance of the resulting Harmonic Fields Set is calculated from the resolution stored in the file.

For example the bitmap export of VirtualLab Fusion sets this value according to the original sampling distance.

If no resolution is stored in the bitmap file the resolution of the screen is taken.

120.1.3.1 Importing Monochromatic Images

In order to understand then input parameters needed, the following technical details have to be considered.

For importing a bitmap as one field quantity of a harmonic field, it is necessary to project a three-dimensional

color vector to an one-dimensional subspace of the color space (here referred to as Color Scale). This allows

a mapping of all values along the color scale to numerical values in an interval to be specified.

The color scale which determines the mapping from bitmap colors to numerical values has to be specified by

the user. A gray scale is predefined, but the best result will be achieved if the same color scale will be used the

bitmap has been created with.

Furthermore, using a middle color can have the effect that one color is assigned to two different values which

yields unexpected results.
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Figure 743. Options dialog for monochromatic bitmap import.

ITEM DESCRIPTION

Vectorial Component The vectorial component which is encoded in the bitmap data.

Field Quantity The field quantity which is encoded in the bitmap data. After import, the se-

lected Field Quantity is shown by default.

Start Value The smallest value of the Field Quantity. The color at the left of the color scale

is assumed to be this value.

End Value The largest value of the Field Quantity. The color at the right of the color scale

is assumed to be this value.

Use Middle Color If checked, you can set a middle color for the color scale if the bitmap to be

imported is given in a three-color scale.

Wavelength The wavelength the generated harmonic field will have.

Output Colors From Pre-

defined Table

If selected, the color table in the output’s data view can be specified indepen-

dently from the color scale used for the input mapping color→ value.

O O C F P T -

.

The color table to be used in the output’s data view can be selected here.

Output Colors From Input

Mapping

If selected, the color scale used for the input mapping will be used as color

table in the output’s data view as well.

120.1.3.2 Importing Monochromatic Images as Intensity Distribution

For importing a bitmap as an intensity distribution, it is necessary to project a three-dimensional color vector c
to an one-dimensional subset of the color space (here referred to as Color Scale).

It is strongly recommended to use a color scale other than the predefined gray scale (i. e. luminance scale)

only, if the bitmap has been created with the same color scale. Furthermore, using a middle color can have the

effect that one color is assigned to two values which yields unexpected results.
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Figure 744. Options dialog for importing intensities from a bitmap.

This import is only available for the Arbitrary Array Beam Splitter Session Editor as well as the Pattern Gen-

erating Diffuser Session Editor of the Diffractive Optics Package. It has the dialog shown in Fig. 744 with the

following options.

ITEM DESCRIPTION

Start Value The smallest intensity. The color at the left of the color scale is assumed to

be this value.

End Value The largest intensity. The color at the right of the color scale is assumed to

be this value.

Use Middle Color If checked, you can set a middle color for the color scale if the bitmap to be

imported is given in a three-color scale.

Mirror Horizontally Applies transformation f (x, y) → f (−x, y), that is the data is mirrored hori-

zontally by a mirror that corresponds to the y-axis.

Mirror Vertically Applies transformation f (x, y) → f (x,−y), that is the data is mirrored verti-
cally by a mirror that corresponds to the x-axis.

Transpose Applies transformation f (x, y) → f (y, x), that is the data is mirrored by a

mirror that corresponds to a diagonal in the x-y-plane.

Light Pattern Dimension O P G D S E

Allows you to specify the physical size of the imported light pattern. This can

be done either by Specification of Sampling Distance of Light Pattern or by

Specification of Size of Light Pattern.

Preview If this button is pressed, a preview of the bitmap is (re)calculated. Recalcula-

tion is not done automatically as this can be very time-consuming.

120.1.3.3 Importing False Color RGB Images

The result of the import process is a polychromatic harmonic fields set with three fields of three different wave-

lengths. These wavelengths can be determined and weighted by the user.
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Figure 745. Options dialog for false color bitmap import.

ITEM DESCRIPTION

Vectorial Component The vectorial component the bitmap information shall be converted to.

Field Quantity The field quantity the bitmap values stand for.

Wavelength 1/2/3 The wavelengths of the three harmonic fields the bitmap channels are

matched with.

Weight The (intensity) weight the channel is multiplied with.

Default RGB Values By clicking this button the Wavelengths and Weights are set to the default

values. These are values which produce the most natural false color image.

Preview By clicking this button you can see how the light view of the imported image (in

display mode Visual Perception) will look like using the current parameters.

120.1.3.4 Importing Real Color RGB Images

The result of the import process is a polychromatic harmonic fields set with three fields of three different wave-

lengths. These wavelengths are determined from the used color system if Automatic is chosen. Then the light

view (in display mode Visual Perception only, see Sec. 12.2.1) reproduces Hue and Saturation (H and S in

the HSV color system) of the original image exactly (if no gamut errors occur). The Value (V in the HSV color

system) may differ slightly due to the interpolation. This real color import is based upon a color transform from

the bitmap’s color space to the color space used in VirtualLab Fusion(usually ’VirtualLab Color Space’).
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Figure 746. Options dialog for real color bitmap import.

ITEM DESCRIPTION

Automatic Use three wavelengths that are suitable for the color system used for display,

so that minimal out-of-gamut errors occur.

User Defined Choose three wavelengths (Wavelength 1/2/3) for the color space conver-

sion. Warning: There is a very high probability for out-of-gamut errors while

converting if these values differ from the automatically determined ones, so

the result’s colors may look strange.

120.2 Text Formats

120.2.1 Field Information Format

The Field Information format is the only text format capable of storing the complete field information (all modes

and all field quantities).

It contains a header at the beginning of the file into which for example the wavelength, the embedding material,

and the sampling distance are written. Each header line starts with a specific character, the header indicator.

Then follows the field data whereas a complex number is written per sampling point. One row in the field data

is written to one line of the resulting text file.

If the file to be exported is a harmonic fields sets with multiple modes or a locally polarized field, the data is split

into multiple files bearing the same base file name followed by either “Mode#{number}_{wavelength}” or “_Ex”

/ “_Ey”.

The export and the import dialog for this format are explained in the following subsections.

120.2.1.1 Export Dialog

Figure 747. The export dialog for the field information format.
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The export dialog (↪→Fig. 747) for the Field Information format (↪→Sec. 120.2.1) has the following controls.

ITEM DESCRIPTION

Decimal Separator You can either choose point or comma as decimal separator or enter an ar-

bitrary character.

Column Separator You can either choose one of the various predefined column separators or

enter an arbitrary character.

Header Indicator The first character of lines with additional information (e. g. the wavelength or

the embedding material).

Format of Complex Num-

bers

The following formats are supported:

• Real Part / Imaginary Part: {real part} + i{imaginary part}

• Amplitude / Phase: {amplitude} · exp({phase} · i)
• MATLAB, a more compact variant of the Real Part / Imaginary Part for-

mat: {real part}+{imaginary part}i

• PTF, a format used for the PTF export (↪→Sec. 120.2.4):

({real part}, {imaginary part})

Validity This control (↪→Sec. 5.10) shows a red-white cross and an info button if you

enter an invalid decimal separator, column separator, or header indicator.

120.2.1.2 Import Dialog

Figure 748. The import dialog for the field information format.

The import dialog (↪→Fig. 748) for the Field Information format (↪→Sec. 120.2.1) has the following controls.
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ITEM DESCRIPTION

Decimal Separator You can either choose point or comma as decimal separator or enter an ar-

bitrary character.

Column Separator You can either choose one of the various predefined column separators or

enter an arbitrary character.

Header Indicator The first character of lines with additional information (e. g. the wavelength or

the embedding material).

Format of Complex Num-

bers

The following formats are supported:

• Real Part / Imaginary Part: {real part} + i{imaginary part}

• Amplitude / Phase: {amplitude} · exp({phase} · i)
• MATLAB, a more compact variant of the Real Part / Imaginary Part for-

mat: {real part}+{imaginary part}i

• PTF, a format used for the PTF export (↪→Sec. 120.2.4):

({real part}, {imaginary part})

(View Text File) Opens an additional dialog allowing you to take a look into any of the files to

be imported. In this way you can for example see what column separator is

the correct one (“»” indicates a tab character).

At the top of the dialog the base file name is given. All files starting with the base file name are imported.

120.2.2 ASCII Format

Text files in “ASCII” format must consist of separated real numbers.

A single field quantity of a harmonic field can be exported to an “ASCII” text file. Every line of the exportedASCII

text consist of separated real numbers which represent one row of the complex amplitude. Several header lines

may be prepended with the following information.

• file creation date and time

• complex amplitude type (Harmonic Field or Jones Matrix Transmission)

• number of sampling points and sampling distance (Introduction of Part VIII)

• whether the complex amplitude has an imaginary component or not

• spherical phase radius (↪→Sec. 12.1.1)

• the wavelength of the harmonic field

• the stored field component (↪→Sec. 12.2.2.2) and field quantity (↪→Sec. 11.1)

The first character on header lines is always ”#”.

120.2.2.1 Export Dialog

The following options can be adjusted in the dialog displayed in Fig. 749.
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ITEM DESCRIPTION

Create header Forces creation of a prepending header as described above.

Decimal Separator Choose between ”.” and ”,”.

Column Separator Choose either from a list of predefined characters or choose an arbitrary col-

umn separator by selecting Other.

Field Quantity Sets the field quantity to be exported from the harmonic field or transmission.

Vectorial Component Sets vectorial component to be exported from the complex amplitude. This

item is only available for harmonic fields.

Transpose Complex Am-

plitude

The complex amplitude is transposed (↪→Sec. 22.6) before exporting.

Remove Spherical Phase

Factor from Sampling

Points before Export

Removes spherical phase factor from sampling points before export.

Figure 749. Dialog to adjust options for ASCII export.

120.2.2.2 Import Dialog

There is a dialog offering several options to alter the way ASCII text is parsed (↪→Fig. 750).
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ITEM DESCRIPTION

{Complex Amplitude

Type}

Destination type of import: Transmission or Complex Amplitude Field.

Wavelength Wavelength of the imported complex amplitude.

Complex Data If checked the resulting complex amplitude stores real and imaginary part of

the imported data. Otherwise only the real part is stored and the imaginary

part is assumed to be zero.

Default Parameters Resets the options above to their default values.

Vectorial Component The data can be imported either to the Ex Component or the Ey Component.

Field Quantity Choose the field quantity of the complex amplitude to be imported. After im-

port, the selected Field Quantity is shown by default. Note that you can import

e. g. phase values even if Complex is switched off: the imported values are

written into the phase of complex numbers from which then only the real part

is stored.

Transpose The imported data is transposed, i. e. the rows in the data represent the y-

dimension of the imported data and the columns in the data represent the

x-dimension.

Skip Header Lines Feature to skip a given number of lines at the beginning of the file.

Skip Lines Starting with Feature to skip lines starting with the given character.

Decimal Separator Choose between “.” and “,”.

Column Separator Choose form list of predefined characters or enter custom one.

Preview A preview panel supports the user to verify settings. It shows the currently

selected Field Quantity.

{First Lines of Imported

File}

Table showing the first lines of the imported text file as parsed by VirtualLab

Fusion. Cells that cannot be parsed are marked red.
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Figure 750. Dialog to adjust options for ASCII import.

120.2.2.3 Dialog for Import of Intensities

Figure 751. Options dialog for importing intensities from an ASCII file.

This import is only available for the Arbitrary Array Beam Splitter Session Editor as well as the Pattern Gen-

erating Diffuser Session Editor of the Diffractive Optics Package. It has the dialog shown in Fig. 751 with the

following options.
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ITEM DESCRIPTION

Skip Header Lines Feature to skip a given number of lines at the beginning of the file.

Skip Lines Starting with Feature to skip lines starting with the given character.

Decimal Separator Choose between “.” and “,”.

Column Separator Choose form list of predefined characters or enter custom one.

Mirror Horizontally Applies transformation f (x, y) → f (−x, y), that is the data is mirrored hori-

zontally by a mirror that corresponds to the y-axis.

Mirror Vertically Applies transformation f (x, y) → f (x,−y), that is the data is mirrored verti-
cally by a mirror that corresponds to the x-axis.

Transpose Applies transformation f (x, y) → f (y, x), that is the data is mirrored by a

mirror that corresponds to a diagonal in the x-y-plane.

Light Pattern Dimension O P G D S E

Allows you to specify the physical size of the imported light pattern. This can

be done either by Specification of Sampling Distance of Light Pattern or by

Specification of Size of Light Pattern.

Preview If this button is pressed, a preview of the bitmap is (re)calculated. Recalcula-

tion is not done automatically as this can be very time-consuming.

{Preview of First Lines of

Imported File}

Table showing the first lines of the imported text file as parsed by VirtualLab

Fusion. Cells that cannot be parsed are marked red.

120.2.3 Code V Format

Code V files consist of two parts: the header contains information like data type and wavelength and so on,

and the following second part contains the actual data. Lines starting with a ’!’ are ignored.

The header lines include the following information:

• creation date and exported field components as comments

• data type

• wavelength

• real part of the complex refractive index of the medium in which the harmonic field is embedded.

• grid spacing (in VirtualLab Fusion: sampling distance)

• array size (in VirtualLab Fusion: sampling points)

Note that the data is always exported as Code V DataType VGridSpatial, i. e. with 6 values per sampling point

(real and imaginary part of Ex, Ey, and Ez, respectively). Each row of the field data in VirtualLab Fusion is

exported to one line in the Code V file.

There is neither an export nor an import dialog for this text format.

120.2.4 Plain Text Format

PTF files use a special format to store complex or real fields: The first three lines contain header information

including the date of creation. The first character on header lines is always ”#”. The fifth line indicates the size

of the field; for instance ”128 128”. All following lines until end of file store sampling points; beginning at the

bottom left and ending at the top right corner of the complex amplitude. There are two different formats for

representing either real or complex sampling points:

• Complex values→ (Re(value), Im(value)).
• Real values→ value.

Of course, all elements of a file must have the same representation.
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During import a dialog asks for the following parameters:

ITEM DESCRIPTION

{Complex Amplitude

Type}

Destination type of import: Transmission or Complex Amplitude Field.

Wavelength Wavelength of the imported complex amplitude.

Complex Data If checked the resulting complex amplitude stores real and imaginary part of

the imported data. Otherwise only the real part is stored and the imaginary

part is assumed to be zero.

Default Parameters Resets the options above to their default values.

120.3 ZemaxOpticStudio® BeamFile Binary Format

ZemaxOpticStudio® BeamFiles are stored either in text format or in binary format. VirtualLab Fusion is able to

import beam files in binary format. After importing the data of a *.zbf file into a harmonic field, some additional

data are written into the messages tab. Furthermore, there is the possibility to let VirtualLab Fusion calculate

the irradiance (↪→Sec. 137.5.3) for the imported field data.

121 Export and Import of Data Arrays

121.1 Export of Data Arrays

One subset of a VirtualLab Fusion Data Array can be exported to a text file in “ASCII” format (↪→Sec. 120.2.2).

Fig. 752 shows the configuration dialog for this export. The current implementation of VirtualLab Fusion sup-

ports only the export of 1D and 2D data arrays that are equidistant.

Figure 752. The dialog to specify the text export for data arrays.

The following parameters can be specified:
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ITEM DESCRIPTION

File Name The user can specify the file name which shall be used to export the selected

subset and the selected quantity.

Subset to export You can specify which subset shall be exported. This option is only available

if the data array hasmore than one subset. Otherwise the single subset within

the data array will be exported.

Quantity to export If the selected data subset is complex the user can specify which quantity shall

be used for the export. The user can select between real part, imaginary part,

amplitude, phase or squared amplitude.

Decimal Separator You can either choose period or comma as decimal separator or enter an

arbitrary character.

Column Separator You can either choose one of the various predefined column separators or

enter an arbitrary character.

Header Indicator The ASCII export allows you to export additional information of the data ar-

ray. These information (including sampling distance and number of sampling

points) are shown at the beginning of the resulting text file in lines starting

with the specified Header Indicator.

This dialog uses a validity indicator (↪→Sec. 5.10) which shows a red-white cross and an info button if you enter

an invalid decimal separator, column separator, or header indicator. Furthermore it shows a warning if the

specified file already exists.

121.2 Import of Data Arrays

VirtualLab Fusion allows you to import one or more bitmap and text files into one object called Numerical Data

Array (this general data storage concept is explained in Sec. 13). The following bitmap formats are supported:

• Windows bitmap files (*.bmp)

• Graphics Interchange Format files (*.gif)

• JPEG file interchange format (*.jpg, *.jpeg)

• Portable network graphics (*.png)

• Picture exchange files (*.pcx)

• Tagged Image File Format files (*.tif, *.tiff; can also be 16 bit grayscale images)

A text file may have the extensions .txt, .csv, or .fin but must be a one- or two-dimensional array of real numbers.

For the import, a wizard dialog has to be used. It provides the settings explained in the following:
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ITEM DESCRIPTION

Save Import Settings Allows you to store the current settings so that you can re-use them on another

computer or after a restart of VirtualLab Fusion.

Load Import Settings Loads previously stored import settings.

Reset Dialog Resets the dialog to its initial state.

Dimensionality On the first page, you can set up whether you want to importOne-Dimensional

or Two-Dimensional data. Furthermore, it has to be specified whether the

Data are Complex-Valued or Data are Real-Valued.

Subset import table Data arrays may consist of more than one subset (↪→Sec. 13). Each sub-

set can be configured individually with the table on the second page (see

Fig. 753). This table including the Add Subset and Delete Last Subset but-

tons is described in Sec. 121.2.1.

x-Axis /

y-Axis

These controls on the third page allow you to set up the coordinate axes of

the data array. It is assumed that equidistant coordinates are used. See

Sec. 121.2.3 for details on these controls. For one-dimensional data arrays

only the x-Axis control is shown.

Next > /

Finish

Switches to the next page or starts the actual import (on the last page). In the

case any settings in the dialog are incorrect, this button is disabled until the

error is corrected.

121.2.1 Import of Subsets

Figure 753. The table containing the import settings of the individual data files. An error message is shown here, because

one file is still to be defined.

Data arrays can consist of more than one subset (↪→Sec. 13). The subsets can be real- or complex-valued

(either all are real-valued or all are complex). In the latter case, two data files are needed to describe either

the Amplitude / Phase or the Real / Imaginary part of the complex values. Thus, the import of a data array can

require the import of several data files. The table control shown in Fig. 753 comprises one row per data file and

the following columns.



CHAPTER 121. EXPORT AND IMPORT OF DATA ARRAYS 895

ITEM DESCRIPTION

Subset # The index for each of the subsets.

Description This column allows you to give a (short) description for the imported data, for

example “Ex field data”.

Physical Property The physical property (e. g. Electrical Field Strength) of the imported data. If

the complex Interpretation is set to Amplitude / Phase, the phase data has

always the physical property Angle (Rad).

Interpretation In case of complex-valued data, you can specify the interpretation of the files

to be imported. If you select Amplitude / Phase, the first row of the subset will

contain the amplitude data and the second row the phase data. If you select

Real / Imaginary, the first row of the subset will contain the data for the real

part of the complex values and the second row for the imaginary part.

File Import Opens a dialog for choosing a file and configuring the import settings for either

text or bitmap files. See Sec. 121.2.2 for details. The same dialog is shown

automatically if a new file needs to be imported, i. e.

• this table control is shown for the first time or

• a new subset is added.

File Name This read-only column gives the name of the file containing the actual data.

Data Points For your information, this read-only column gives the number of data points

which are extracted from the given file. This value must be the same for all

rows of the table. Otherwise an error message will be shown beneath the

table.

Below the table, there are two buttons to add a new subset or to delete the last subset from the table. If the

already imported data are inconsistent, an error message is shown beneath the table.

121.2.2 Import Settings for one Data Array Subset

Figure 754. The dialog comprising the settings needed to import a (bitmap) file to a data array.

(The imported image was provided by Ricardo Cancho Niemietz via English Wikipedia as public domain.)

The dialog to import a file to a data array (↪→Fig. 754) contains the following sections.

https://en.wikipedia.org/wiki/User:Ricardo_Cancho_Niemietz
https://en.wikipedia.org/wiki/File:Grayscale_8bits_palette_sample_image.png
https://en.wikipedia.org/wiki/Public_domain
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ITEM DESCRIPTION

File Name Shows the file name and allows you to change it via the -button.

Supported file extensions: .txt, .csv, .jpeg, .jpg, .bmp, .png, .pcx, .gif, .tif, .tiff.

Text files must be a one- or two-dimensional array of real numbers.

Specific import settings The settings specific for bitmap files are described in subsection

Sec. 121.2.2.1.

The settings specific for text files are described in subsection Sec. 121.2.2.2.

Preview The preview on the right part of the dialog is actually a data array view de-

scribed in Sec. 13.5. Initially no preview is shown – you must click Refresh

Preview to create the preview, which may take some time.

121.2.2.1 Specific Import Settings for Bitmap Files

Figure 755. The specific import settings for bitmaps (with annotations).

ITEM DESCRIPTION

Color Range You can configure theColor Scale of the imported file by clicking the color but-

tons for the Start Color and End Color, respectively. If you have checked Use

Additional Middle Color you can also configure a Middle Color. It is strongly

recommended to use a color scale other than the predefined gray scale (i. e.

luminance scale) only, if the bitmap has been created with the same color

scale. Furthermore, using a middle color can have the effect that one color is

assigned to two values which yields unexpected results.

Corresponding Value

Range

A pixel having exactly the Start Color is assigned the Start Value of the value

range. In the same manner, a pixel having exactly the End Color is assigned

the End Value of the value range. Other colors within the color range get a

corresponding value between Start Value and End Value. Colors outside of

the specified color scale are first projected to the nearest point of the color

scale (in RGB space).
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121.2.2.2 Specific Import Settings for Text Files

Figure 756. The specific import settings for text files.

ITEM DESCRIPTION

Number of Header Lines

to Skip

The specified number of lines on the beginning of the document (which may

contain header information) are skipped.

Skip Lines Starting with If checked, any line starting with the specified character is skipped. It is rec-

ommended to not combine this option with Number of Header Lines to Skip.

Decimal Separator You can either choose period or comma as decimal separator or enter an

arbitrary character.

Column Separator You can either choose one of the various predefined column separators or

enter an arbitrary character.

Note that the row separator is always a line break. Numbers can be either given in normal format (e. g. 1234
or in scientific format (e. g. 1.234e3). If in a non-skipped row there is any character which is not a number, a

space, a decimal separator or a column separator, the import will fail. Multiple consecutive column separators

(e. g. spaces) will be treated as one.

121.2.3 Control for Configuring an Axis of a Data Array

Figure 757. Control for configuring one axis of a data array.

The control for defining the coordinate axis of a data array (Fig. 757) has the following settings.
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ITEM DESCRIPTION

Description The caption of the coordinate axis.

Physical Property The physical property (e. g. Length) of the coordinates. An overview of all

supported physical properties and the corresponding units is given in Sec. 5.1.

Interpolation Method The type of interpolation which is used if a value between adjacent sampling

points has to be interpolated. The available interpolation methods are listed

in Sec. 13.2.2.

Dimensions The dimensions along the axis can be determined either via Sampling Dis-

tance, Array Size, or Coordinate Extent.

Sampling Distance The distance between two adjacent coordinates.

Array Size The distance between the coordinates of the first and the last data point.

Coordinate Extent A I M N N -

.

The distance between the lower boundary of the nearest neighbor interval

of the first data point and the upper boundary of the interval of the last data

point.

Positioning The position of the axis can be determined either via entering a Start Coor-

dinate or by defining that the axis range shall be centered. This can be done

referring to the exact center (Center Around Zero) or to the coordinate of the

data point which has the next higher coordinate to the exact center (Center

Around Zero Node).

Center Around Zero If chosen, the coordinate range will be centered around 0.

Center Around Zero Node For an odd number of sampling points, this will be the same as Center Around

Zero. If chosen for an even number N of sampling points, the coordinate

range will be set in the following way: That sampling point whose (zero

based!) index equals N/2 will get the coordinate 0.

Start Coordinate The coordinate of the first sampling point.

Equals minimum bound-

ary of first interval

A P S D

I M N N .

If checked, the start coordinate refers to the lower boundary of the nearest

neighbor interval of the first data point instead of the coordinate of the first

data point itself.

122 Export and Import of Chromatic Fields Sets

122.1 Field Information Format for Chromatic Fields Sets

Chromatic Fields Sets can be exported into a slightly modified Field Information format (↪→Sec. 120.2.1).

It contains a header at the beginning of the file into which for example the wavelength and the sampling distance

are written. Each header line starts with a specific character, the header indicator.

Then follows the actual data whereas a number (the squared amplitude) is written per sampling point. One row

in the field data is written to one line of the resulting text file.

Distinct wavelengths are exported into distinct files bearing the same base file name followed by the wavelength.

The export dialog for this format is explained in the following subsection.
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122.1.1 Export Dialog

Figure 758. The export dialog for Chromatic Fields Sets.

The export dialog (↪→Fig. 758) for the Field Information format (↪→Sec. 122.1) has the following controls.

ITEM DESCRIPTION

File Name Shows the current file name. Via the button you can browse to the place

where you want to store the file and change the actual file name.

Data to Export O C F S

You can either export All Wavelengths into separate files, select a Single

Wavelength to export or export the (incoherent) Summation of the data of

all wavelengths.

Wavelength to Export O S C F S

Allows you to select one distinct wavelength of the Chromatic Fields Set to

export.

Decimal Separator You can either choose period or comma as decimal separator or enter an

arbitrary character.

Column Separator You can either choose one of the various predefined column separators or

enter an arbitrary character.

Header Indicator The first character of lines with additional information (e. g. the wavelength or

the sampling distance).

Validity This control (↪→Sec. 5.10) shows a red-white cross and an info button if you

enter an invalid decimal separator, column separator, or header indicator.
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122.2 Import a Chromatic Fields Set from Bitmap Files

Figure 759. Dialog to select how a bitmap shall be imported.

If you want to import a bitmap file into a Chromatic Field Set, you can choose between two options:

ITEM DESCRIPTION

RGB (False Color) Each of the channels R, G, and B is stored into one subset of the Chromatic

Fields Set. Their wavelengths can be set and weighted freely. ↪→Sec. 122.2.1

RGB (Real Color) The bitmap is imported in a way that guarantees the best color fidelity

when the resulting Chromatic Fields Set is viewed in the real color mode.

↪→Sec. 122.2.2

Three bitmap formats are supported: Windows bitmap files (.bmp), JPEG images (.jpg, .jpeg), and portable

network graphics (.png).

The sampling distance of the resulting Chromatic Fields Set is calculated from the resolution stored in the file.

For example the bitmap export of VirtualLab Fusion sets this value according to the original sampling distance.

If no resolution is stored in the bitmap file the resolution of the screen is taken.

122.2.1 Importing False Color RGB Images

The result of the import process is a Chromatic Fields Set with three fields of three different wavelengths. These

wavelengths can be determined and weighted by the user.

Figure 760. Options dialog for false color bitmap import.
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ITEM DESCRIPTION

Wavelength 1/2/3 The wavelengths of the three harmonic fields the bitmap channels are

matched with.

Weight The (intensity) weight the channel is multiplied with.

Default RGB Values By clicking this button the Wavelengths and Weights are set to the default

values. These are values which produce the most natural false color image.

Preview By clicking this button you can see how the real color view (↪→Sec. 14.2) of

the imported image will look like using the current parameters.

122.2.2 Importing Real Color RGB Images

The result of the import process is a Chromatic Fields Set with three fields of three different wavelengths.

These wavelengths are determined from the used color system if Automatic is chosen. Then the real color view

(↪→Sec. 14.2) reproduces Hue and Saturation (H and S in the HSV color system) of the original image exactly

(if no gamut errors occur). The Value (V in the HSV color system) may differ slightly due to the interpolation.

This real color import is based upon a color transform from the bitmap’s color space to the color space used in

VirtualLab Fusion(usually ’VirtualLab Color Space’).

Figure 761. Options dialog for real color bitmap import.

ITEM DESCRIPTION

Automatic Use three wavelengths that are suitable for the color system used for display,

so that minimal out-of-gamut errors occur.

User Defined Choose three wavelengths (Wavelength 1/2/3) for the color space conver-

sion. Warning: There is a very high probability for out-of-gamut errors while

converting if these values differ from the automatically determined ones, so

the result’s colors may look strange.

123 Export of Animations

Via File > Export you can

• export the current frame of the animation to a bitmap, .png, or .jpg file

• export the whole animation as an animated GIF file (↪→Sec. 123.1)
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• export the whole animation as an .avi video file. Note that for technical reasons the frames per second

set up in the options dialog (↪→Sec. 20.3) are rounded internally to the next integer or

• create an overview image of all frames (↪→Sec. 123.2).

123.1 Export as Animated GIF

Animated GIF files have two limitations:

1. The GIF format uses a color palette of 256 colors only, so the bitmaps in the animation (which use true

colors) have to be converted. Thus if you start the export to animated GIF files, you are first asked whether

you want to use an Adaptive color scale which generates a palette of 256 colors so that the converted

bitmaps differ as little as possible from the original ones – or a Grayscale which uses 256 shades of gray,

i. e. only the brightness information of the bitmaps in the animation is maintained.

2. The frame duration is taken from the animation options (↪→Sec. 20.3). However, GIF is limited to frame

durations being a multiple of 10 milliseconds. If this is not the case rounding is done automatically and a

warning is shown.

After deciding about the color scale you can specify the name of the exported file.

123.2 Overview Image of an Animation

Figure 762. Edit dialog for creating an overview image of an animation.

Via File > Export > Overview Image you can create an image which shows all (or some, depending on the con-

figuration) frames of an animation side by side – like an index print. In the corresponding edit dialog (↪→Fig. 762)

you can configure the following.
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ITEM DESCRIPTION

Layout As an information, the number of frames in the animation is shown and the size of

the resulting image. You can set the general Layout, i. e. the number of columns

and rows into which the frames are written. If the number of frames does not match

the number of columns times the number of rows, a warning is shown by the Validity

Control in the bottom left corner of the dialog (↪→Sec. 5.10).

Furthermore you can define an additional Space Between Frames to separate the

columns and rows. It is filled with an transparent color.

Stitching Order Defines the order in which the individual frames are written into the columns and

rows. A table below illustrates the different settings.

Stitch Horizontally First means that one row is filled before a new row is started.

Stitch Vertically Firstmeans that one column is filled before a new column is started.

Start at Top / Bottom defines whether first the top most row is filled or the bottom

most one.

Result is saved at… With the button you can set the path and name of the resulting overview image.

The extension of the file name defines the used image codec (bitmap, PNG with

lossless compression, JPG with lossy compression, or TIF).

The following table illustrates how the different stitching orders influence the location of 6 frames on a 3 × 2

layout.

Stitch Horizontally First Stitch Vertically First

Start at Top 1; 2; 3

4; 5; 6

1; 3; 5

2; 4; 6

Start at Bottom 4; 5; 6

1; 2; 3

2; 4; 6

1; 3; 5

124 Export and Import of Optical Setups

Optical Setups can be used easily fromwithin other programs using the batchmode described in Sec. 9. Sample

batch mode files can be generated using File > Export > Create Batch Mode Files. The menu File > Export

contains also various exports to specific target applications which are described in the following subsections.

Optical Setups can also be exported into the stereolithography format (*.stl) via the 3D View (↪→Sec. 5.15).

124.1 Export Parameters to XML

Most parameters of an Optical Setup can be exported to an XML file. Some of these are changeable, which

means they can be re-imported into VirtualLab Fusion when changed in the XML file. And some of the change-

able numerical parameters are also variable which means their value can be varied within a certain range. See

also the chapter about Parameter Extraction Sec. 43.5.

For each parameter the following information is exported.
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TAG DESCRIPTION

Name Name and category of the parameter. If changed, re-import into VirtualLab

Fusion might fail.

ID O

Facilitates re-import into VirtualLab Fusion.

ShortName O

User-specified short name, e.g. set in the dialog described in Sec. 124.1.1.

Not used during re-import.

PreSelectedByUser O

Indicates a parameter preselected by the user, e.g. via the dialog described

in Sec. 124.1.1. Not used during re-import.

Value The value of the parameter.

PhysicalProperty O

The physical property of the value. Not used during re-import.

Min O

The minimum of the range in which the value can be varied. Can be set in

the dialog described in Sec. 124.1.1. Not used during re-import.

Max O

The maximum of the range in which the value can be varied. Can be set in

the dialog described in Sec. 124.1.1. Not used during re-import.

In addition at the begin of the XML document the notes (↪→Sec. 43.1) and all available simulation engines

(↪→Sec. 43.4) of the Optical Setup are given. As the available parameters depend on the selected simulation

engine, the selected engine is marked by an Used tag.
The XML export can be triggered in three different ways.

RIBBON ITEM DESCRIPTION

File > Export > Export as

XML

Exports all parameters. You only have to specify path and name of the XML

file.

File > Export > Create

Batch Mode Files

Creates a parameters.xml file in the specified path and a sample batch file
for external execution of VirtualLab Fusion. See Sec. 9 for details on the

available command line arguments. The XML file contains only changeable

parameters of Optical Setup Elements which are connected to the active light

source (with index “0”).

File > Export > Export to

optiSLang Project

Special variant of the batch mode export specifically tailored for optiS-

Lang. Only variable parameters are exported from Optical Setup Elements

which are connected to the active light source (with index “0”). The Optical

Setup is executed during export to generate initial results. A special dialog

(↪→Sec. 124.1.1) is used to configure the export.

The parameter values in an XML file can be re-imported into an Optical Setup using an Optical Setup Tool

(↪→Sec. 43.6).
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124.1.1 Export to optiSLang Project

Figure 763. Edit dialog for the export to an optiSLang project.

If you click on File > Export > Export to optiSLang Project the dialog shown in Fig. 763 opens where you can

configure the export.

ITEM DESCRIPTION

Export Folder The folder into which the files needed for the optimization in optiSLang are ex-

ported. It is recommended that this folder is empty. The path can be changed

with the -button. If you want to access the path directly, e. g. for cleanup,

you can click on the path label.

Simulation Engine Allows you to select the simulation engine to be used for the optimization in

optiSLang.

Export Only Varied Param-

eters

If checked only the varied parameters are exported. This yields a much

smaller parameter file and thus much faster execution times.

{Parameter Table} See below.

Validity This control (↪→Sec. 5.10) indicates whether there are issues with the current

configuration. If this is the case you can click on the -button for further

information.

The table lists all Parameters of all Objects which can be altered in optiSLang. Often, a Category column is

available to group similar parameters.

For each parameter you can specify a Short Name identifying that parameter.

In the Vary column you must select one or more parameters which you want to alter in optiSLang. For these

parameters you can define the value range by setting the start (From) and end (To) value. The default From

and To values for all parameters are their absolute minimum and maximum values – you must not enter a

value outside of this range. It is possible to enter a To value which is smaller than the From value. For your

information also the Original Values of all parameters are given.

The first column allows you to collapse / expand all parameters of an Optical Setup Element or its categories.

Simply click on the and symbols, respectively. At the top of this column you can select to collapse all

levels (1), collapse only the Category level (2) or show all levels (*).
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The table can be filtered with the following controls. Only rows passing all filters are shown.

ITEM DESCRIPTION

Filter Table by All rows containing the given string either in the Object, Category (if applica-

ble) or the Parameter column pass this filter. The matching is case insensi-

tive. It is possible to search for multiple words and word groups embraced by

quotation marks, for example: "surface #1" scaling.

Show Only Varied Param-

eters

Only rows where the Vary column is checked pass this filter.

124.2 Import optiSLang Results

If you click on File > Import > Import optiSLang Results a dialog opens where you can either enter a path directly

or browse for it using the -button. This path must contain a system.lpd and a matching parameters.xml in
the format used for the data exchange with optiSlang and the batch mode (↪→Sec. 9). The parameters of the

Optical Setup are then changed to the values in the parameters.xml and the resulting Optical Setup is shown
as new document in VirtualLab Fusion.

Using this import you can re-import Optical Setups optimized by optiSLang.

124.3 Export to JCMsuite Format

Grating Optical Setups can be converted to JCMsuite files. These files allow you to analyze the structures

rigorously by using the finite element method within JCMsuite. (In case of 2D-periodic structures, only the

plane at y = 0 is exported.)

Figure 764. The dialog for configuring the export to JCMsuite files.

This feature can be accessed via File > Export > Export to JCMsuite Format if a Grating Optical Setup is active.

This menu item opens the dialog shown in Fig. 764 and offers the following settings.

ITEM DESCRIPTION

Output Path Specifies the path where the resulting JCMsuite files are stored. You can

either enter the path directly. If the path does not exist, it is created on in-

quiry. Or you can access the default Windows™ folder selection dialog via

the -button.

Assume Periodic Struc-

ture Definition

JCMsuite can assume the outside of the structure to be either periodic or

transparent. With this setting you can switch between these two possibilities.

124.4 Import of ZemaxOpticStudio® LensFiles and ArchiveFiles

File > Import > Import ’ZemaxOpticStudio®’ LensFile imports the surface data from a *.zmx, *.zos, or *.zar file

into an Optical Setup.
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ZemaxOpticStudio® license needed

The import of *.zmx or *.zar files requires a valid ZemaxOpticStudio® license of version ’19.4 SP2’ or

newer. Importing *.zos files requires a version ’21.3’ or newer. It has to be a ’Professional’ or ’Premium’

edition in any case, a ’Standard’ edition will not work.

If no valid license can be found or theGlobal Options are configured accordingly (↪→Sec. 6.16), VirtualLab

Fusion may use a rudimentary import algorithm on *.zmx files which may produce unsatisfactory results.

Import features which are not supported by the rudimentary algorithm are marked with the symbol ZOS L .

A new Optical Setup will be created by the import algorithm. It contains a light source, a Camera Detector as

well as a Spot Size detector. All surfaces except for the object plane, the image plane and coordinate breaks

will be imported into a VirtualLab Fusion component each (see below for a list of supported surface types). The

media between the Optical Setup Elements are set to “Air (Zemax OS)” but the materials which are connected

to the surfaces in the lens file are imported to VirtualLab Fusion materials (Sec. 124.4.2) and are used as

subsequent media. Temperature and pressure are copied from the ZemaxOpticStudio® lens file to the Optical

Setup too (Sec. 124.4.3).

The type of the light source in the imported Optical Setup depends on the distance behind the object plane.

If it is infinite, a Plane Wave light source is used, otherwise a Spherical Wave light source is inserted. The

material behind the object plane determines the embedding medium of this source. The wavelengths of the

light source are set to the wavelengths as found in the file after converting to vacuum. The field size is taken

from the entrance pupil diameter. The ray pattern and the ray density for a ray tracing source are copied from

a spot diagram, if there is one in the lens file.

124.4.1 Supported ZemaxOpticStudio® Surface Types

VirtualLab Fusion can import some types of optical surfaces from a ZemaxOpticStudio® lens file.

The supported surface types are summarized in the following table:
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SURFACETYPE IN ZEMAX

OPTICSTUDIO®

REPRESENTATION IN VIRTUALLAB FUSION

Biconic Anamorphic Surface

Binary 1 A Combined Surface, consisting of a Plane or Aspherical Surface and a Poly-

nomial Surface. The latter may be height-scaled, see 124.4.1.1 for more

information.

Binary 2 Two cases have to be distinguished:

• Valid OpticStudio® license present ZOS L and Flat Lens Package present

and import called from main menu (instead of using the Lens System

tool as described in Sec. 125.2): VirtualLab Fusion tries to determine

whether the Binary 2 surface forms a diffractive lens together with its

preceding or its subsequent surface by evaluating the involved materi-

als. Both surfaces will be represented by a Diffractive Lens component

(↪→Sec. 60.2) in the imported optical setup. The Binary 2 surface will be

a surface whose channel operator represents the diffractive properties

of the Binary 2.

• Else: The import creates a Combined Surface, consisting of a Plane

or Aspherical Surface and an Aspherical Surface. The latter may be

height-scaled, see 124.4.1.1 for more information.

Coordinate Break ZOS L N/A

(Coordinate breaks are not imported because they are not needed in

the imported Optical Setup. All positions and orientations of the surfaces are

set correctly without referring to theses virtual planes.)

Even Asphere Surface Aspherical Surface

Extended Asphere Aspherical Surface

Odd Asphere Surface Aspherical Surface

Q-Type Asphere Forbes Surface

Standard Surface A Conical Surface or Plane Surface, depending on the radius of the Standard

Surface.

Tilted Surface Plane Surface

Toroidal A couple of cases have to be distinguished:

Z > 0 Z = 0

R 6= 0 CS: Toroidal + Zernike Standard Toroidal Surface

R = 0 CS: Cylindrical + Zernike Standard Cylindrical Surface

with R being the Radius of Rotation and Z being the number of Zernike coef-

ficients given in the lens file. ’CS’ stands for Combined Surface.

Zernike Fringe Sag ZOS L A Z .

A Combined Surface, consisting of a Plane or Aspherical Surface and a

Zernike Fringe Surface

Zernike Standard Phase A Combined Surface, consisting of a Plane or Conical Surface and a Zernike

Standard Surface. The latter may be height-scaled, see 124.4.1.1 for more

information.

Zernike

Standard Sag ZOS L

A Z .

A Combined Surface, consisting of a Plane or Aspherical Surface and a

Zernike Standard Surface
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Surfaces of unsupported types are considered to be Plane Surfaces.

124.4.1.1 Handling of Surfaces Which Define Phase Variations Directly

In the case of Binary 1, Binary 2 (if no OpticStudio® license present) and Zernike Standard Phase, the phase

functions given in ZemaxOpticStudio® are transformed into a height profile in VirtualLab Fusion. This height

profile is always the second of the two sub-surfaces in the imported Combined Surface.

The height profile is computed using the thin element approximation [Goo68]. This means that the surface

profile height is proportional to the phase values. To this end, the wavelength and the refractive indices of the

media before and behind the surface are calculated from the data in the ZemaxOpticStudio® lens file. (The

refractive indices are relative to theAir (Zemax OS), in order to resemble the behavior of ZemaxOpticStudio®.)

If necessary, the z-scaling of the height profile in VirtualLab Fusion can be used to compensate side effects,

caused e. g. by using only the first wavelength of the ZemaxOpticStudio® lens file.

124.4.2 Importing Materials from ZemaxOpticStudio® LensFiles

There are different kinds of specifications for material data in ZemaxOpticStudio®. The following specification

types are supported by VirtualLab Fusion:

• MIL Number Glasses and

• Model Glasses are interpreted as representing a simple dispersion formula as described in the Ze-

maxOpticStudio® user manual.

• The materialMIRROR is imported as being an idealized material with a constant refractive index of 1 and
a very high constant absorption coefficient of 10151/m, leading to an almost perfect reflection behavior.

• All table glasses (file extension *.ztg) as well as

• all catalog glasses (file extension *.agf) are expected to be stored in the subdirectory “Glasscat” of the

Path for ’ZemaxOpticStudio®’ User Data. This search path can be specified in the Global Options dialog

(↪→Sec. 6.17).

Please note: Although Model Glasses as well as MIL Number Glasses are defined via Abbe number νd and re-

fractive index nd, these kinds of materials are not imported to a Virtual Lab material using the Abbe Number (νd)

dispersion formula. Regarding Model Glasses, the reason is the additional partial dispersion parameter ∆PgF

which can be defined there. MIL Number Glasses just use a different dispersion formula in ZemaxOpticStudio®

compared to our formula (↪→Sec. A.4.1). So, a special programmable material is used for the import of Model

Glasses and MIL Number Glasses.

124.4.3 Handling of the Environment Conditions

In ZemaxOpticStudio®, all specified wavelengths are defined in air. The dispersion of this air is defined by

an environment temperature and pressure. To fully represent this behavior in VirtualLab Fusion, the following

steps are done during import:

1. A newmaterial is defined using the Edlén equation given in Sec. 38.2.1. For the temperature and pressure

which are parameters of this equation the values from the ZemaxOpticStudio® lens file are used. This

new material is hence referred to as Air (Zemax OS).

2. The vacuum wavelength λvac is calculated by solving the equation λair =
λvac

nair(λvac)
for λvac. nair is the

refractive index of the Air (ZemaxOS) and λair is the first wavelength in the ZemaxOpticStudio® lens file.

3. The reference material (↪→Sec. 38.2.1) of all imported materials is set to the Air (ZemaxOS).
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124.4.4 Combining Imported Surfaces

Each surface of the ZemaxOpticStudio® lens file (except for object plane, image plane and coordinate breaks)

is imported to a Curved Surface component. Subsequent to the actual import, the user is asked whether to

combine these surfaces to one or more Lens System component(s). If desired, this combination will be tried

as described in Sec. 43.6.3.2.

124.4.5 Handling Unpacked Data From ZAR Archives

In case a Zemax *.zar archive file shall be imported ZOS L , the contained files of the archive will be extracted into

a temporary folder. The unpacked lens file will be used for the actual import then. The extraction folder will be

deleted after VirtualLab Fusion has closed.

In case the unpacked data shall be stored for later use anyway, the files can be saved to a different, permanent

folder via the dialog shown in Fig. 765.

Figure 765. Dialog for handling the extracted data from a Zemax *.zar archive.

Clicking the underlined link will open the temporary folder, while pressing the Yes, Save Now button allows to

specify a different, permanent folder for storing the data to.

125 Export and Import of Real Components

125.1 Stereolithography Format

All real components can be exported into the stereolithography format (*.stl) via their 3D View (↪→Sec. 5.15).

125.2 Import of ZemaxOpticStudio® LensFiles into a Lens System Component

A tool in the edit dialog of the Lens System component (↪→Sec. 57.1) allows importing ZemaxOpticStudio®

lens file data into a lens system.

ZemaxOpticStudio® license needed

The import of *.zmx or *.zar files requires a valid ZemaxOpticStudio® license of version ’19.4 SP2’ or

newer. Importing *.zos files requires a version ’21.3’ or newer. It has to be a ’Professional’ or ’Premium’

edition in any case, a ’Standard’ edtion will not work.

If no valid license can be found or theGlobal Options are configured accordingly (↪→Sec. 6.16), VirtualLab

Fusion may use a rudimentary import algorithm on *.zmx files which may produce unsatisfactory results.

At first, VirtualLab Fusion checks whether or not the surface data in the file fulfill the restrictions of a Lens

System component. Most important are the following conditions:

• All positions have to be on one line which is considered to be the optical axis of the system to be imported.

• No surface, except for standard surfaces with infinite radius (considered to be plane surfaces), may be

tilted to the optical axis.
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All other properties of the import algorithm are explained in Sec. 124.4.

The imported surfaces are appended at the end of the current surface sequence. To maintain the overall

structure, surfaces which could not be imported are replaced by a Plane Surface and materials which could not

be imported are replaced by the “Air (ZemaxOS)”.

125.3 Import of ZemaxOpticStudio® LensFiles into a Diffractive Lens or Meta Lens

The edit dialogs for diffractive and meta lenses have a button Import from ’Zemax OpticStudio®’ System on

their Structure page. Using this button, a .zmx, .zos or .zar file can be selected via ’file open’ dialog. This file

will be searched for surfaces of type ’Binary 2’.

• If no ’Binary 2’ surface can be found, an error message will be given.

• If there is exactly one ’Binary 2’ surface contained in the lens file, it will be imported automatically into the

diffractive or meta lens component.

• If more than one ’Binary 2’ surface are found, the user will be asked which of them is to be imported.

126 Export of Cells Arrays

126.1 Export of Grating Cells Arrays

The grating parameters can be exported by pressing on the -button on the bottom of the edit dialog of the

Grating Cells Array. This triggers the Export Grating Cells Array dialog, which can be used for configuring the

export parameters of the set up Grating Cell Array. The export to CSV (comma separated values) and GDSII

is supported for the GCA.

Figure 766. The dialog to set up the export parameters for a Grating Cells Array.

Fig. 766 shows the edit dialog to export a Grating Cells Array. It has the following settings:
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ITEM DESCRIPTION

Grating Type For the export of the Grating Cells Array data the grating type need to be

specified. Currently on sawtooth grating is supported for the fabrication ex-

port.

Calculate Binary Masks The export allow to calculate binary masks. Checking this option allow the

export to GDSII format. If this option is not selected, only CSV format is

available.

Number of Discrete Height

Levels

The export supports also a quantization of the gratings. Therefor the user

need to specify the number of discrete height levels which he will use for the

fabrication process.

Text File (*.csv) The user can select to export the parameters of the Grating Cells Array into a

comma separated value format. Within this format the analytic parameters of

all grating cells are written into a text file in matrix form. The different grating

parameters are written in three different blocks within the text file. The blocks

are arranged under each other. Additional information about the GCA as the

number of cells and the cell size are written in the header of the csv file. The

csv format can be easily opened with a text editor or a spreadsheet.

GDSII Data (*.gds) VirtualLab Fusion offers the possibility to export the Grating Cells Parameter

into the GDSII format. Therefor the element has to be factorized into binary

masks. The GDSII option is only available if the Calculate Binary Masks op-

tion is checked. The element within the GDSII format is not pixelated. This

reduces the storage effort and increases the specification accuracy. Fig. 767

shows a typical Grating Cells Array exported to GDSII format.

Figure 767. The Grating Cells Array can be exported to GDSII.

After pressing the OK button the user needs to specify the location and file name for both the .csv and the

GDSII file.
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126.2 Export of Prism Cells Arrays

The prism parameters can be exported by pressing on the -button on the bottom of the edit dialog of the

Prism Cells Array (PCA). This triggers the Export Prism Cells Array dialog, which can be used for configuring

the export parameters of the set up Prism Cell Array. The export to CSV (comma separated values) text files

and to the STL format is supported for PCAs.

Figure 768. The dialog to set up the export parameters for a Prism Cells Array. Here the settings for STL export are

shown.

Figure 769. A Prism Cells Array extruded to a solid.

The following settings can be done within the Export Prism Cells Array dialog (↪→Fig. 768):
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ITEM DESCRIPTION

Text File (*.csv) The user can select to export the parameters of the Prism Cells Array into a

comma separated value format. Within this format the analytic parameters of

all prism cells are written into a text file in matrix form. The different grating

parameters are written in three different blocks within the text file. The blocks

are arranged under each other. Additional information about the PCA as the

number of cells and the cell size are written in the header of the CSV file. The

CSV format can be easily opened with a text editor or a spreadsheet.

STL (*.stl) VirtualLab Fusion offers the possibility to export the whole Prism Cells Pa-

rameter into the standard STL format.

Decimal Separator O .

Allows the user to choose either ’,’ or ’.’ as decimal separator or to enter a

custom one.

Column Separator O .

Allows the user to choose either among distinct customized column separa-

tors like space, tab stop, semicolon, …; or to enter a custom one.

Extrude STL Mesh O STL .

For the STL format you can extrude the surface to a real solid. To this end

an additional plane surface is added at Extrusion Distance below the actual

surface, ↪→Fig. 769. With this checkbox you can switch the extrusion on or

off.

Extrusion Distance O STL .

The additional plane surface is perpendicular to the optical axis and placed at

a certain distance z from the negative z-extension of the actual surface (the

“lowermost point”). This distance z is the Extrusion Distance which can be

set by the user.

X-Y-Z Scaling Factor O STL .

You can use this factor to apply an overall scaling on the exported data if

necessary.

At the bottom of the dialog the minimum and the maximum height of the Prism Cells Array are given.

After clicking on the OK button the user needs to specify the location and file name for both the CSV and the

STL file.

The exported STL file will have slightly smaller numerical values for the minimum and the maximum

height value of the full structure. This is due to the fact that some STL reading programs have problems

if VirtualLab Fusion exports the edges from one prism cell to the next with ideal 90°; so the actual prism

surface is reduced a tiny bit so that instead of totally vertical edges slightly slanted ones are exported.

The difference is negligible for the optical effect.

127 Export and Import of Optical Surfaces

In VirtualLab Fusion, optical surfaces are exported by first sampling the height profile with a given pixel size.

This pixelated height profile can then be exported either directly into a single file. Or the height profile can be

decomposed into several masks: One mask stores the binary information whether or not half the total profile
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height shall be removed from the substrate, another mask stores whether or not a fourth of the total profile

height shall be removed and so on.

The height level data can be exported to various text and binary formats. In addition to the actual data files,

always a summary file in a specific XML format (↪→Sec. 127.4) is created containing additional metadata, for

example the pixel size. This summary file can additionally be generated as HTML, text, or rich text file. Together

with the XML file always a file summary.xslt is saved which ensures that the XML file is shown in a more

human-readable form if opened with a web browser.

All these formats (but the point cloud and the stereolithography (*.stl) format) can be imported into a Sampled

Surface (↪→Sec. 35.2.11) if a XML file in the format as specified in Sec. 127.4 is provided.

Sec. 127.1 explains the export dialog in detail.

127.1 Export Dialog (for Standard Surfaces)

Figure 770. The dialog for configuring the export of a surface (here: General Parameters tab).

To configure the export to your needs a dialog opens during the export (↪→Fig. 770). This dialog comprises

up to three tab pages which are explained in the following subsections. Furthermore it contains a button for

starting and stopping the actual export as well as a progress bar indicating the progress of the current export

step (which is shown in a label below the progress bar).

ITEM DESCRIPTION

Export Starts the actual export. After the export has been started this button turns

into a Stop button, allowing you to cancel the current export process. Fur-

thermore, the Close button is disabled during the export.

127.1.1 General Parameters

The General tab page (↪→Fig. 770) contains the following controls:
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ITEM DESCRIPTION

Path The path into which the resulting files are saved. This path can be changed

with the Select button. If you want to open that path in the Windows™ Ex-

plorer, you can click on the path label.

File Names Allows you to set the file name used for all data and summary files (without

the specific file extensions). Summary files are supplemented by “_summary”

and data files representing masks are supplemented by “_MASK_#”, where

# is the number of the mask. The file name also defines the name of the

main structure in GDSII and CIF files. It must not contain any of the following

characters: \/ : * ? < > |.

Export Binary Masks This option is only enabled for a surface with 2n discrete height levels. n is

the number of resulting masks (which is given in brackets) and can be in the

range from 1 to 12.

File Name Convention If Export Binary Masks is checked, one data file per mask is created. If you

choose Ascending then the file ..._MASK_1 contains the binary mask with the
smallest height modulation. Otherwise it contains the largest height modula-

tion – half the total profile height.

Export as ... This group box allows you to select the file format(s) for the resulting data

files. It is ensured that at least one format is selected. Not all file formats are

always available:

• Bitmap files can only be generated if the surface contains discrete height

levels, but no more than 256.

• CIF and GDSII format are only available if Export Binary Masks is

checked.

• The Point Cloud, the STL, and the 16-bit grayscale format are only avail-

able if Export Binary Masks is not checked.

Sec. 127.3 gives some annotations for the used file formats.

Summary Files At least a XML file with additional metadata is always generated, as this file is

needed if you want to re-import the data into VirtualLab Fusion. But you can

select HTML, text, and rich text as additional, more human-readable, formats.

Sec. 127.4 explains the structure of the summary files and lists the metadata

written during the export of surfaces. Sec. 127.3 gives some annotations for

the used file formats.



CHAPTER 127. EXPORT AND IMPORT OF OPTICAL SURFACES 917

127.1.2 Export Parameters

Figure 771. The General Parameters tab for exporting a surface.

The Export Parameters tab page (↪→Fig. 771) contains the following controls:

ITEM DESCRIPTION

Export Whole Surface /

Export Only One Period

This item is only enabled if the surface is set to be periodic (↪→Sec. 35.1.1).

If you choose to Export Whole Surface then a rectangle with the size of the

outer definition area is exported. Otherwise, only one period is exported.

Oversampling Factor If the surface is already pixelated you can specify an integer oversampling

factor. The pixel size used for the export is then the original pixel size of the

surface divided by that oversampling factor.

Pixel Size As all export formats support only pixelated data, a pixel size must be speci-

fied. If the surface is already pixelated, you cannot set the Pixel Size directly

but only an Oversampling Factor as explained above. For one-dimensional

pixelated surfaces the pixel size in the unmodulated direction is always equal

to the overall size of the surface. Note that the internally used pixel size is

always a multiple of 1 nm.

Invert All heights are inverted. For the export of binary masks that means that if this

option is not checked the written data (= the white areas in a bitmap) describes

what remains after the production process. In contrast, if the heights are

inverted the written data describes what is removed, e. g. etched away.

Additionally to these controls there is an info label giving the size of the exported region as well as the number

of pixels in the resulting data files.
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127.1.3 GDSII/CIF Settings

Figure 772. The specific settings for the GDSII and the CIF export.

If GDSII or CIF are selected as output format, you have the following options on an additional tab (↪→Fig. 772).

ITEM DESCRIPTION

Compression For GDSII or CIF export a compression can be selected. In this case, the

individual shapes are combined to 1× nRectangular Shapes. Fig. 773 shows

an example. This can lead to file sizes reduced by a factor 10 or more.

Structure Name from File

Name

The structure name is used in a GDSII / CIF file to group the shapes which

represent the structure. If the user checks this option the structure name is

the file name specified by the user, succeeded by “_MASK_” and the mask

number.

Custom If the user checks this option, he can specify an arbitrary structure name. In

this case, the same structure name is used for all masks.
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Figure 773. Illustration for the effect of the Compression for GDSII or CIF export.

Left: Stored shapes if None (1×1 Square Shapes) are used.
Right: Stored shapes for the same region if 1 × n Rectangular Shapes are used.

See also notes on allowed file and structure names for GDSII in Sec. 127.3.

127.1.4 STL Settings

Figure 774. The specific settings for the STL export.
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Figure 775. A toroidal surface extruded to a solid.

For the STL format you can extrude the surface to a real solid. To this end an additional plane surface is added

at a certain position below the actual surface. Fig. 775 shows an example. There are two settings for this

extrusion on a separate tab page (↪→Fig. 774).

ITEM DESCRIPTION

Extrude to Solid With this checkbox you can switch the extrusion or or off.

Extrusion Distance The additional plane surface is perpendicular to the optical axis and placed

at a certain distance z from the negative z-extension of the surface (the “low-

ermost point”). This distance z is the Extrusion Distance which can be set by
the user.

127.2 Export Dialog for Diffractive Structures

Figure 776. The dialog for exporting a diffractive structure as polygons.

In contrast to the export dialog for standard surfaces, this dialog (↪→Fig. 776) allows not only the export of

pixelated data but also of polygons. It contains the following controls:
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ITEM DESCRIPTION

Path The path into which the resulting files are saved. This path can be changed

with the Select button. If you want to open that path in the Windows™ Ex-

plorer, you can click on the path label.

File Names Allows you to set the file name used for all data and summary files (without

the specific file extensions). Summary files are supplemented by “_summary”

and the data files representing masks are supplemented by “_MASK_#”,

where # is the number of the mask. The file name also defines the name

of the main structure in GDSII and CIF files. It must not contain any of the

following characters: \/ : * ? < > |.

Invert Flag whether the masks shall be inverted. That means for example that you

replace a positive resist by a negative one.

File Name Convention One data file per mask is created. If you choose Ascending then the file

..._MASK_1 contains the binary mask with the smallest height modulation.

Otherwise it contains the largest height modulation – half the total profile

height.

Export Type The user can define whether pixelated data or polygons are exported. After

selecting the export type the dialog offers specific settings for the selected

type.

Sampling Distance O P D E .

The pixel size that should be used for the export.

Polygon Detection Accu-

racy

O P D E .

The user can specify an integer value i. This integer value is used to calculate
the accuracy of the polygon detection relative to the wavelength. The total

accuracy (= maximum lateral distance between level curve and polygon line)

is calculated by the formula (λ/i).

Maximum Number of

Points per Polygon

O P D E .

The user can specify the maximum number of points for a polygon. The de-

fault value for this option is 8 000 which is admissible for both CIF and GDSII.

Furthermore, the lower limit is 100.

Export as ... By defining the export types the user can specify in which format the files shall

be exported. In case of pixelated data export the module supports the export

to: bitmap, ASCII and plain text, GDSII and CIF format. For the polygon data

export the formats GDSII and CIF are available. At least one of the data

export file types has to be selected. Sec. 127.3 gives some annotations for

the used file formats.

Summary Files At least a XML file with additional metadata is always generated, as this file is

needed if you want to re-import the data into VirtualLab Fusion. But you can

select HTML, text, and rich text as additional, more human-readable, formats.

Sec. 127.4 explains the structure of the summary files and lists the metadata

written during the export of surfaces. Sec. 127.3 gives some annotations for

the used file formats.

{Export Progress} During the export the dialog informs you about the progress of the current

export step. The current export step is displayed in the info label below the

progress bar.
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Go! Starts (and stops) the export.

Preview Shows a preview of the structure to be exported in the 3D view explained in

Sec. 5.15.

See also notes on allowed file names in Sec. 127.3.

Tip

Export of polygons ismuch faster when done for rotationally symmetric surfaces. Thus if you export for

example a Diffractive Lens (↪→Sec. 60.2), ensure that the surface is a non-periodic Aspherical, Conical,

or untilted Plane Surface with a circular definition area.

127.3 Annotations for the Various File Formats

FILE FORMAT ANNOTATION

Bitmap In this case an indexed Windows bitmap file with 256 gray values is created

(8 bits per pixel). Its header contains the color definition for every height level

and additional data. The color definition allows to display the bitmap in every

painting program.

After the header a byte matrix follows which contains the height levels directly

as hexadecimal data. For example, if you have exported an element with

eight height levels a byte value of 00 corresponds to the smallest height level

and 07 to the largest one. The real height can be calculated by multiplying

the height level with the height level difference given in the summary file.

White is associated with the largest height, black with the lowest one. How-

ever, the gray values assigned to the height levels might not be equidistant.

Thus, if you want to export the real heights from the bitmap, use the height

levels directly, not the gray values.

ASCII format The heights in meters are stored. The file contains a matrix of numbers with

Nx columns and Ny rows (Nx and Ny being the number of sampling points in

x- and y-direction, respectively). The columns are separated by a space. It

is recommended to use ASCII instead of the Plain text format because ASCII

files are smaller (roughly 33% for binary masks) and they can be generated

up to 5 times faster.

Plain text format The height values in meters are stored. A line contains the data of one single

pixel. The header contains information about the number of sampling points

in x- and y-direction, respectively.
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GDSII format As explained in Sec. 127.1.3, both GDSII and CIF format use a structure

name to identify the main structure which contains the actual data. However,

the GDSII format only supports the following characters: a. . .z, A. . .Z, 0. . .9,
underscore, question mark, and dollar sign. This means that the structure

name can only contain these characters. Consequently, the File Names can

only contain a. . .z, A. . .Z, 0. . .9, and underscore if the option Structure Name
from File Name is used as described in Sec. 127.1.3.

Point Cloud format This format stores the x- and y-positions in µm along with the corresponding

height, also in µm. Not that the data is transformed so that only positive values

occur.

STL format This format often used for stereolithography stores a triangular mesh. Due to

technical reasons, more than 3860 · 3860 ≈ 15 · 106 pixels cannot be exported

with the STL format.

Rich Text Format The rich text format only supports the characters of the Windows-1252 char-

acter set natively. Thus the Path and the File Names must not contain other

characters than these if you want to use the rich text format as summary file.

127.3.1 Annotations for Binary Masks

If a standard surface is exported with the Calculate Binary Masks option (↪→Sec. 127.1.1), some file formats

are used a bit differently:

• Bitmap files use only 1 bit per pixel to store a black / white image of the mask.

• ASCII format and plain text format do not store height levels but “1” and “0” to indicate the binary mask

information.

127.4 Metadata Summary Files

VirtualLab Fusion provides a general XML format for storing additional metadata for exported data files. The

main idea of this format is that the XML file contains several metadata entries (which can be grouped) for a

collection of data files (which can also be grouped). The metadata are stored as description (e. g. “Total Profile

Height”) / value (e. g. 532 nm) pairs.

Up to now, such summary files are only used for the export of surfaces. In this case the following metadata is

stored:

• Metadata Group “Element Parameters”

– Element Size

– Element Shape (elliptic / rectangular)

– Height Outside Element

– Absorbing Material Outside Element

– Total Profile Height

– Exported Binary Masks (yes/no)

– Number of Height Levels (only if the surface Contains Discrete Height Levels)

– Height Level Difference (only if the surface Contains Discrete Height Levels)

– Pixel Size

– Data Represents Only One Period (“yes”: Export Only One Period was selected during export; “no”:

Export Whole Surface was selected during export)

– Number of Exported Pixels

https://en.wikipedia.org/wiki/Windows-1252
https://en.wikipedia.org/wiki/Windows-1252
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• Metadata Group “Period Parameters” (only if Data Represents Only One Period)

– Size of One Period

– Resulting Repetitions (Element Size / Size of One Period)

– Size of Inner Definition Area

– Shape of Inner Definition Area

– Height Outside Inner Definition Area

– Absorbing Material Outside Inner Definition Area

• Metadata Group “Mask Information” (only if Exported Binary Masks is “yes”)

– Number of Masks

– Height Modulation of Mask # 1

– Height Modulation of Mask # 2

– …

• Metadata Group “Specific Export Settings”

– Invert Profile

– Compression for GDSII / CIF (only if GDSII / CIF have been generated)

128 Import of Macleod Coatings

VirtualLab Fusion supports importing Macleod coatings in the following two ways.

1. You can import the data directly into VirtualLab Fusion’s coatings catalog by clicking on the Import

Macleod Coating Data button, which is located within the Catalog Tools of the catalog. After the import

you are prompted for a name and categories to insert the imported coating into the User Defined catalog

(see also Sec. 33.1).

2. In the edit catalog of a coating you can replace the current data with the imported Macleod data by clicking

the -button.

The order of the layer sequence of an optical thin film coating is important for its optical properties. When applied

to any surface between a solid and a non-solidmedium in automatic coating applicationmode, VirtualLab Fusion

will put layer #1 automatically as the very next one to the solid substrate. As this convention is not used within

Macleod, a dialog asks you to confirm the imported layer sequence for non-symmetrical layer structures. If

necessary the order of the layer sequence can be inverted in the dialog in question.

Furthermore Macleod files contain also the substrate and the surrounding material. During the import you are

prompted whether these two materials are to be saved into VirtualLab Fusion’s material catalog. If you want to

do so, the dialog in Fig. 777 is shown.
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Figure 777. Import dialog for Macleod substrate and surrounding material.

In the upper part of this dialog there is a table with the following columns:

COLUMN DESCRIPTION

Import Allows you to select which materials shall be imported. If the selected item

is marked red then its name is not unique, already present in the file for user

defined entries, or empty. If it is marked green the file can be imported.

Name Shows the name of the material and allows you to change it.

State of Matter Macleod materials have no state of matter. Thus you can set it in this column

whereas VirtualLab Fusion already provides an educated guess.

The lower part of the catalog defines the categories in which all entries are stored. You can add a new category

with the -button and remove a category with the -button.

If you press Ok the chosen materials will be saved to the user defined materials catalog.

129 Import of Materials from ZemaxOpticStudio® Glass Catalogs

Via the Catalog Tools of the catalog main form (Sec. 33) for materials you can Import ’ZemaxOpticStudio®’

Glass Catalogs.
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Figure 778. Import dialog for a ZemaxOpticStudio® glass catalog with some inconsistent entries.

This catalog tool first shows the standard Windows dialog for opening one or more files with the file extension

.agf. The preselected path in this dialog is the GlassCat folder in the Path for ’ZemaxOpticStudio®’ User

Data as specified in the Global Options dialog. The selected files are then imported with the dialog shown in

Fig. 778. In the upper part of this dialog there is a table with the following columns:

COLUMN DESCRIPTION

Import Allows you to select which materials shall be imported from the Ze-

maxOpticStudio® glass catalog. Materials whose name is not unique, al-

ready present in the user defined catalog, or empty cannot be imported. If

such a material is selected the corresponding row is marked red. Otherwise,

it is marked green and OK is shown in the Status column.

Name Shows the name of the material and allows you to change it.

State of Matter Materials imported from ZemaxOpticStudio® have no state of matter. By

default they are assumed to be solids, but you can change it in this column.

Status The following states are possible:

• Error: An error message is shown for those materials that cannot be

imported.

• Warning: A warning message is shown in case the import cannot be

done smoothly.

(As an example, sometimes a wavelength is given more than once in a

glass file. In that case the import is possible. But the data are cleaned

by computing average data for the non-unique wavelengths.)

• OK: If no problems occur, the status is OK if the respective material is

marked for import.

By clicking on a column caption, you can sort by this column.

The Selection Tools allow you to either Select All materials in the table or to Unselect All.
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The lower part of the catalog defines the categories into which all materials are stored. You can add a new

category with the -button and remove a category with the -button.

130 Import of Obsolete VirtualLab Fusion Files

The following document types are no longer supported by VirtualLab Fusion but can still be imported into newer

document types.

DOCUMENT TYPE ANNOTATIONS

Materials andmaterial cat-

alogs

(*.mtr, *.mct)

Can be imported into the Materials catalog. ↪→Sec. 33.4.

Coatings and coating cat-

alogs

(*.ctg, *.cct)

Can be imported into the Coatings catalog. ↪→Sec. 33.4.

Spread Sheets

(*.ops)

Surfaces and media contained in a Spread Sheet can be imported into a Lens

System component (↪→Sec. 57.1).

Import via File > Import > Import Old VirtualLab Files is also possible. In

this case, an Optical Setup is created containing one Lens System with the

surfaces and media contained in the Spread Sheet.

VLab 1.x Complex Ampli-

tudes

(*.ca)

Can be imported via File > Import > Import Old VirtualLab Files. ↪→Sec. 130.1

Data Field Diagrams

(*.dgr)

Can be imported into a Data Array via File > Import > Import Old VirtualLab

Files. The interpolation of the resulting Data Array depends on the interpola-

tion set up in the diagram and on whether the data is equidistant (see table

below). If the resulting interpolation method is Constant Interval then the user

is asked for the upper limit(s) of the resulting Numerical Data Arrays. More

details about interpolation methods for DataArrays can be found in Sec. 13.2.

Data Series Diagrams

(*.diagram)

Can be imported into a Data Array via File > Import > Import Old VirtualLab

Files. Depending on whether or not the original diagram was a polar diagram,

the resulting diagram will either be a Numerical 1D Data Array (if it was not a

polar diagram) or a Diffraction Orders Diagram (if it was a polar diagram).

Plane Waves Field

(*.pwf, *.rf)

Can be imported into a Data Array via File > Import > Import Old VirtualLab

Files.

PIXELATED INTERPOLATION

IN DIAGRAM

SPLINE INTERPOLATION IN DIA-

GRAM

Resulting interpolation method

for equidistant Data Arrays

Nearest Neighbor Linear (Real/Imaginary)

Resulting interpolation method

for non-equidistant DataArrays

Constant Interval Linear (Real/Imaginary)

Instead of using File > Import > Import Old VirtualLab Files you can also drag importable document types into

the main window of VirtualLab Fusion.



CHAPTER 130. IMPORT OF OBSOLETE VIRTUALLAB FUSION FILES 928

130.1 Import of VirtualLab Fusion 1.x Complex Amplitude

Complex amplitudes saved in VirtualLab Fusion 1.x lack some information in comparison with VirtualLab Fu-

sion, namely wavelength, wave parameters, spherical phase factor and support for different complex amplitude

types. Complex numbers are always stored using float numbers. Local polarization is not supported. Some of

this missing parameters must be specified by an input dialog with the following parameters:

ITEM DESCRIPTION

{Complex Amplitude

Type}

Destination type of import: Transmission or Complex Amplitude Field.

Wavelength Wavelength of the imported complex amplitude.

Complex Data If checked the resulting complex amplitude stores real and imaginary part of

the imported data. Otherwise only the real part is stored and the imaginary

part is assumed to be zero.

Default Parameters Resets the options above to their default values.



XVII Algorithm Manual

This part of the manual gives physical and mathematical background

information to the topics covered in the previous parts of the manual.
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131 Field Data

For locally polarized harmonic fields the two electric field components Ex and Ey are stored, from which all other

field components can be reconstructed. For globally polarized fields, only the scalar field U(x, y) and the Jones
vector J (↪→Sec. 131.1) are stored.
The field data are stored as field values on an equidistantly sampled grid. The number of sampling points

in x- and y-direction, Nx and Ny can be chosen freely in the x- and y-direction respectively. For storing two-

dimensional fields both Nx and Ny are greater than 1. One-dimensional fields are typically stored with Ny = 1.
For each sampling point a complex number is stored by two double precision numbers for the real and imaginary

part. This corresponds to a memory requirement of 2× 8 bytes per sampling point. It is also possible that only
the real part is stored.

In VirtualLab Fusion Ez is calculated according to

Ez(x, y) =
[
F -1

(
− 1

kz

(
kx · [F Ex(x, y)](kx, ky) + ky · [F Ey(x, y)](kx, ky)

))]
(x, y) . (131.1)

where F denotes a Fourier transform and F -1an inverse Fourier transform.

The components of the magnetic field are calculated with the following formulas:

Hx = a0(kyEz − kzEy) (131.2)

Hy = a0(kzEx − kxEz) (131.3)

Hz = a0(kxEy − kyEx) (131.4)

with

a0 =
1
k

√
ε0

µ0
(131.5)

131.1 Global and Local Polarization

If the ratio of the two field components Ex(x, y, zj)/Ey(x, y, zj) is independent of the position (x, y), we obtain

f (x, y, zj) = JU(x, y, zj) (131.6)

with the Jones vector J = [Jx, Jy]. Those fields are uniformly or globally polarized in the x-y-plane.

All other harmonic fields are locally polarized, that is only locally they are of the form shown in Eq. (131.6).

VirtualLab Fusion deals with both states of polarization and handles the change from global to local polarization

automatically.

131.2 Spherical Phase Radius

Sampling of a large spherical phase (e. g. a lens with short focal length) would require a very small sampling

distance and thus many sampling points for correctly sampling the spherical phase in the border areas of the

field. Therefore, VirtualLab Fusion can handle the spherical phase radius as a separate factor multiplied to the

sampled aberrations of the spherical phase. This means that the sampling distance has to be chosen only for

accurate sampling of the aberrations.

Many of the internal operations of VirtualLab Fusion, as for example the homogeneous medium propagation

operators, take into account the stored spherical phase radius.

In harmonic fields sets, a separate spherical phase radius is stored for each harmonic field. Thus, spherical

phase radius functions are not available in the light view of harmonic fields sets.

For newly created harmonic fields, VirtualLab Fusion detects and stores the spherical phase radius automati-

cally.
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131.3 Propagation in Positive Z-Direction?

Part of a complete definition of a harmonic field at a position z′ is the sign of the z-component of its principal
propagation direction sgn(kz). It determines whether the field propagates principally to the positive or the

negative z-direction. For an example of the importance of this distinction see Fig. 779.

Figure 779. Phase of Spherical Wave. Left: Propagating in Positive Z-Direction, Right: Propagating in Negative Z-

Direction.

Fields resulting from an Optical Setup (↪→Sec. 43) always propagate in positive z-direction.

131.4 Interpolation Methods for Equidistant Data

The appropriate interpolation method has to be chosen according to the physical meaning of the data which

shall be interpolated, and according to the acceptable computational effort. If the data represents a harmonic

field, the standard reconstruction method is based on the Sinc interpolation [Goo68]. Unfortunately this method

is typically connected with a relatively high computational effort. If the data represents a diffractive optical

element, nearest neighbor interpolation is recommended.

The following interpolations for equidistant data are supported in VirtualLab Fusion:

ITEM DESCRIPTION

Nearest Neighbor Interpo-

lation

Each sampling point of the resultant field is set to the complex amplitude of

the nearest sampling point of the original field.

Linear (Amplitude/Phase) Linear interpolation with respect to the 2 (one-dimensional case) or 4 (two-

dimensional case) adjacent sampling points. This interpolation is performed

independently for amplitude and phase.

Linear (Real/Imaginary

Part)

Linear interpolation with respect to the 2 (one-dimensional case) or 4 (two-

dimensional case) adjacent sampling points. This interpolation is performed

independently for real and imaginary part.

Cubic 4 Point Complex cubic interpolation with respect to the 4 (one-dimensional case) or

4× 4 (two-dimensional case) neighboring sampling points of the original field.
↪→Fig. 780

Cubic 6 Point Complex cubic interpolation with respect to the 6 (one-dimensional case) or

6× 6 (two-dimensional case) neighboring sampling points of the original field.
↪→Fig. 780
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Cubic 8 Point Complex cubic interpolation with respect to the 8 (one-dimensional case) or

8× 8 (two-dimensional case) neighboring sampling points of the original field.
↪→Fig. 780

Sinc (Fourier Transform) Using this interpolation method finer sampling is achieved by embedding in

the Fourier space. This interpolation method is equivalent to the following

steps:

1. Remove the spherical phase radius (if present). ↪→Sec. 12.1.1

2. Do a physical backward Fourier transformation. ↪→Sec. 31.1

3. Embed the field according to the desired new sampling distance.

↪→Sec. 22.7

4. Do a physical forward Fourier transformation. ↪→Sec. 31.1

5. Embed or extract the field to achieve the desired new field size.

↪→Sec. 22.7

6. Superimpose the previously removed spherical phase radius.

↪→Sec. 22.5.1

Windowed Sinc Variant of the Sinc Interpolation (Fourier Transform), which does the embed

or extract to the desired new field size before the first Fourier transform. This

reduces the required computational effort if only a part of the original field

should be interpolated but yields only a slightly approximated result. More

precisely, first a little bit larger part (larger by 6 sampling points) is extracted

out of the original field in order to reduce numerical errors on the borders of

the interpolated field; the additional sampling points are then removed in a

final step.

Accelerated Sinc If you interpolate to a new field size (x; y), then the original field is first trun-
cated to (t · x; t · y) using a soft aperture of that size. t is the Field Size

Truncation Factor for Accelerated Sinc Interpolation of the Global Options

dialog (↪→Sec. 6.13). Afterwards a Sinc Interpolation (Fourier Transform) is

performed on the truncated field.

Sinc (Pointwise) Sinc interpolation using pointwise superposition of sinc functions, that is for

each sampling point of the resulting field a summation is performed over the

sinc functions of all sampling points of the original field. This interpolation

method can be significantly slower but less memory consuming than Sinc In-

terpolation (Fourier Transform), although besides of numerical errors it yields

the same result.

Truncated Sinc Approximation to the interpolation method Sinc Interpolation (Pointwise) in

which the extent of the sinc function is limited to 6 sampling points.

Combined Depending on the physical extension of the resultant field either cubic 6 point

interpolation (small size) or Windowed Sinc Interpolation (larger size) is used.

The cubic interpolation is used if the extension of the resultant field is smaller

than three sampling points of the original field.
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Figure 780. Illustration which neighbor points are used for a Cubic n Point Interpolation.

132 Sources

VirtualLab Fusion provides a growing set of source models. Each model describes an electromagnetic field in

a plane. The source generation results in a discretized field that is represented by a data array (sampled field)

and additional parameters including, e. g., wavelength(s), physical coordinates and others, see below.

The fields resulting from the source generation are described in the input plane with z = 0. A source field

can be represented by one or more complex amplitude fields. Each of those fields is globally polarized and is

described by

Exy(x, y, 0) = JU(x, y, 0) (132.1)

where J denotes the Jones vector and U(x, y, 0) is a scalar complex function.
In order to handle arbitrary fields U(x) numerically, U(x) has to be sampled with a finite number of (Nx; Ny)

sampling points. In VirtualLab Fusion an equidistant sampling with the sampling distance (δx; δy) corresponds
to sampling points at the positions (xmin, xmin+δx, . . ., xmin+(Nx − 1)δx, ymin, ymin+δy, . . ., ymin+(Ny − 1)δy)
with

xmin = −bNx

2
cδx, ymin = −b

Ny

2
cδy (132.2)

where b·c denotes the rounding down operation.

132.1 Gaussian Wave

132.1.1 Formulas for an Ideal Gaussian Wave

An ideal one-dimensional Gaussian field is defined by

UG(x) = exp
[
− x2

w2(z)

]
exp

[
i
(
− kz

2
− k

x2

2R(z)
+

1
2

arctan
(

z
zR

))]
. (132.3)

The variable k = 2π/λ refers to the wave number; λ is the medium wavelength. z is the Distance to Input Plane.
In contrast to the “Laser Beam Calculator” (↪→Sec. 112), you cannot enter the beam radius w(z) directly in the
generator dialog. It is calculated via

w(z) = w0

√
1 +

(
z

zR

)2
. (132.4)

w0 is theWaist Radius and zR is the Rayleigh length

zR =
πw2

0
λ

(132.5)
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Further fundamental parameters of a Gaussian beam are the Phase Radius R(z) as well as the Half Angle of
Divergence α

2 . These parameters can be calculated by the following equations.

R(z) = z
[

1 +
( zR

z

)2
]

(132.6)

α

2
=

λ

πw0
valid in the far field(z� zR) (132.7)

For all the equations above, waist radius and half angle of divergence are referring to the point where the

squared amplitude is reaching e−2 (≈ 0.135) times the maximum squared amplitude.

A two-dimensional Gaussian field can be constructed by multiplying two one-dimensional fields:

UG(x, y) = UG(x) ·UG(y) (132.8)

whereas the beam parameters may be different for both directions. Different waist distances z lead to an

astigmatic Gaussian field.

132.1.2 Beam Quality and Higher Order Modes

The Gaussian wave generator (↪→Fig. 476) can also be used to generate fields that represent Hermite-Gaussian

or Laguerre- Gaussian modes. A two-dimensional Hermite-Gaussian is derived by:

UH(x, y) = UG(x, y) · exp
[
±i(m + n) arctan

(
z

zR

)]
· Hm

(√
2x

w(z)

)
· Hn

(√
2y

w(z)

)
. (132.9)

where m and n are the order for x- and y-direction, respectively. Hj is the Hermite polynomial for the order j.
The M^2 Parameter of a Hermite-Gaussian is calculated by

M2 =

2m + 1 x-direction

2n + 1 y-direction
(132.10)

A two-dimensional Laguerre-Gaussian is derived by:

UL(x, y) = UG(x, y) · exp
[
±i
(

l arctan
( y

x

)
+ M2 arctan

(
z

zR

))]
· L|l|p

(
2(x2 + y2)

w(z)2

)
(132.11)

where p is the radial order and l is the angle order. L|l|p is an associated Laguerre polynomial. The M^2

Parameter of a Laguerre-Gaussian is calculated by

M2 = 2p + |l|+ 1 (132.12)

Further explanations for these formulas can be found for instance in [ST91].

132.2 Super-Gaussian Wave

This source model allows you to generate isotropic and separable super-Gaussian fields.

An isotropic super-Gaussian field U(x, y) is given by

U(x, y) = exp
[
−
(

r
w0

)m]
, (132.13)

where w0 denotes the waist radius at the amplitude level of 1/e, m denotes the order of the super Gaussian

(m = 2 corresponds to a regular Gaussian) and

r =
√

x2 + y2. (132.14)



CHAPTER 132. SOURCES 935

A separable super Gaussian field U(x, y) is defined by

U(x, y) = exp
[
−
(

x
w0,x

)mx

−
(

y
w0,y

)my]
, (132.15)

where order and waist radius are given for both x- and y-direction.

It is possible to define the waist radius w at any (amplitude or intensity) level k above the minimum edge level,

i.e. different from w0 as defined in Eq. (132.13). This waist radius w is connected to w0 by

w0 =
w

m
√
− ln k

, (132.16)

where the amplitude level 0 < k < 1 is given as fraction of the maximum amplitude of the super Gaussian in

its center.

If you want to create a field with a Top-Hat-like light distribution where only the ”sharpness” of the edges is

known but not the required order of the super Gaussian, then it is possible to enter the width ∆re of the edge

between a lower (minimum) and an upper (maximum) level (yl and yu). The relation between edge width and

order of the super Gaussian is

∆re = w

(
m

√
ln yl
ln k
− m

√
ln yu

ln k

)
. (132.17)

The meaning of all these parameters w (waist radius), k (definition level for waist radius), ∆re (edge width), yl

(minimum level of the edge) and yu (maximum level of the edge) is shown in the sketch in Fig. 781.

Figure 781. Definition of a Super Gaussian by Edge Width and Waist Radius.
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Figure 782. Isotropic Super Gaussian Field as 3D View.

132.3 Gaussian Type Planar Source

This generator can be used to simulate LEDs and Excimer lasers. The details of the model will be described

in a separate paper which can be distributed on request.

The model is based on using a set of fundamental modes. In this case, Gaussian modes are used. The modes

are laterally shifted across the emitting surface. The model assumes a dense set of modes. The computational

model requires a finite set of modes which has to be defined by the user. Currently, the modes are scaled with

the factor 1/√n, where n is the number of lateral positions.

This source can be described by its divergence, by the coherence length or by the waist of the fundamental

modes. Let us discuss the relationship between these values.

A single fundamental mode is a Gaussian field. The complex amplitude U in its waist plane (z = 0) is given by

U(x, y, z = 0) = U0 exp
(
−ρ2/w2

0

)
(132.18)

with ρ2 = x2 + y2. The waist radius w0 defines the radius for which the value of U is decreased by a factor of

1/e. Therefore, the squared amplitude is decreased by 1/e2. In paraxial approximation a propagated Gaussian

remains Gaussian and possesses the 1/e-beam radius w(z). We may then define the half-width 1/e (HWE)

angle divergence of the beam by

θHWE = lim
z> ∞

arctan
(

w(z)
z

)
= arctan

(
w0

z0

)
(132.19)

with the Rayleigh length

z0 = πw2
0/λ. (132.20)
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Finally we obtain

θHWE = arctan
(

λ

πw0

)
. (132.21)

Because the derivation uses a paraxial assumption, the angles are small and the arctan is often omitted in

literature. It is important to note, that the arctan in Eq. (132.21) does not ensure its validity in the non-paraxial

domain.

If we consider non-paraxial beams, the definition of the waist w0 remains unchanged. But for the definition of

the divergence we must consider the far field of the beam in form of the radiant intensity which takes the form

J(θ, φ) = 4π4w4
0k2 cos2 θ exp

(
−1

2
(kw0)

2 sin2 θ

)
. (132.22)

For small angles we have sin θ ≈ θ and cos θ = 1 and Eq. (132.22) reduces to the intensity of a paraxial far

field, which is a Gaussian. The divergence is now defined by the extent of J in terms of θ. Obviously it makes no

sense to define a 1/e value, because of the cos2 θ term. Thus, the half-width at half-maximum (HWHM) angle

of J(θ) is defined as the divergence half-angle θHWHM. Evaluation of Eq. (132.22) results in the relationship

between the waist w0 and the divergence θHWHM according to

w0 = λ

√
ln(2 cos2 θHWHM)√

2π sin θHWHM

. (132.23)

The relation between waist and coherence length is given by

w0 =
√

2 · coherence length. (132.24)

132.4 Far Field Source

The far field source allows you to define a spatially partially coherent light source by its far field.{
Vu `(ρ, z; ω)

}
u
refers to one vectorial component ` of a single mode u out of many uncorrelated modes. It is

defined by {
Vu `(ρ, z; ω)

}
u
=
{

αuD`(θ, φ)
eikr

r

}
u

. (132.25)

The following symbols are used in Eq. (132.25).

• ω = 2πc
λ : Angular frequency.

• k: Wave number.

• ρ: The lateral position (x; y).
• r =

√
x2 + y2 + z2

• αu is the weight of the mode.

• The complex direction weight functions D`(θ, φ).

• The braces with index u indicate the use of the mode coordinate system shifted by ρu.

132.5 Spectrum Generators

132.5.1 Black Body Spectrum

The black body power spectrum uses the energy density distribution law in dependence on the wavelength λ

S(λ) =
8πhc

λ5
1

e
(

hc
λkT

)
− 1

where T is the temperature in Kelvin, h denotes the Planck constant (6.6260755 · 10−34 Js), k is the Boltzmann
constant (1.3806505 · 10−23 J/K), and c stands for the vacuum speed of light (299792458m/s).
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132.5.2 Gaussian Spectrum

A Gaussian spectrum arises in Doppler broadening of a spectral line.

Its dependence on the angular frequency ω is given by the formula

S(ω) = S0 exp
(
− ln 2 · (ω−ω0)

2

∆ω2

)
, (132.26)

where ω0 is the central angular frequency, ∆ω the half width at half-maximum of the distribution.

In transforming the density to a function of the wavelength, the relations

ω0 = 2πc/λ0,

∆ω = −ω0/λ0 · ∆λ,

were used.

If wavelengths with a minimal intensity Smin (relative to the peak intensity) shall limit the sampled wavelength
interval, then corresponding lowest and highest angular frequencies are computed from

ωmin = ω0 + ∆ω ·
√
− ln Smin

ln 2
,

ωmax = 2ω0 −ωmin,

and the equivalent wavelengths follow from λ = 2πc/ω.

132.5.3 Lorentzian Spectrum

The Lorentzian power spectrum arises in natural lifetime and collision broadening of a spectral line.

Its dependence on the angular frequency ω is given by the formula

S(ω) =
S0

(ω−ω0)2 + ∆ω2 ,

where ω0 is the central angular frequency, ∆ω the half width at half-maximum of the distribution.

In transforming the density to a function of the wavelength, the relations

ω0 = 2πc/λ0,

∆ω = −ω0/λ0 · ∆λ,

were used.

If wavelengths with a minimal intensity Smin (relative to the peak intensity) shall limit the sampled wavelength

interval, then corresponding lowest and highest angular frequencies are computed from

ωmin = ω0 + ∆ω ·
√

1/Smin − 1,

ωmax = 2ω0 −ωmin,

and the equivalent wavelengths follow from λ = 2πc/ω.

133 Optical Components

133.1 Surfaces

133.1.1 Approximated Function Domain of Surfaces

Internally all surfaces have an Approximated Function Domain, which is either elliptical or rectangular. If you

extend the (inner) definition area of the surface beyond this limit, you may noticed unwanted “bends” or too

large values for the following reasons.
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• The formula used to describe the surface really becomes invalid beyond this range. Most likely rea-

son is that the radicand of a square root in the formula becomes less than zero. These invalid values

are then replaced by the Position of Surrounding Plane (↪→Sec. 35.1.1.1). Example: Conical Surface

(↪→Sec. 35.2.4).

• The formula used to describe the surface becomes invalid somewhere beyond this range, but the exact

shape of the boundary between valid and invalid values is unknown due to mathematical reasons. Then

an Approximated Function Domain is used which for sure contains only valid values. Invalid values are

replaced by the Position of Surrounding Plane (↪→Sec. 35.1.1.1). This is the case for the Toroidal Asphere

Surface (↪→Sec. 35.2.12).

• The formula used to describe the surface is a polynomial which was designed to deliver height values

within a certain range as long as you are in the Unit Radius. But outside of the unit radius the height

values tend towards infinity. For these surfaces like the Zernike & Seidel Surface (↪→Sec. 35.2.14) the

unit radius defines the Approximated Function Domain.

• You exceed the range of given data for data-based surfaces like the Sampled Surface (↪→Sec. 35.2.11).

Then extrapolation (↪→Sec. 13.3) is used, which can lead to overshooting in case of cubic interpolation of

the data.

• Programmable Surfaces (↪→Sec. 35.2.9) always have an infinite Approximated Function Domain. But in

case your snippet yields invalid values (NaNs), they are replaced by the Position of Surrounding Plane

(↪→Sec. 35.1.1.1).

If along the boundary of the (inner) definition area there are only invalid values, the boundary minimum and

maximum is regarded as zero.

133.1.2 Height Discontinuities and Rescaling of Surfaces

VirtualLab Fusion allows to scale any surface in x-, y-, and z-direction, respectively. Furthermore, VirtualLab

Fusion offers three mathematical operations which introduce height discontinuities into the height profile of an

optical surface.

1. Pixelation introduces rectangular pixels. The height within one pixel remains constant. ↪→Sec. 133.1.2.1.

2. Height Quantization introduces a limited number of equidistant discrete height levels. The height at a

certain position is set to the nearest height level. ↪→Sec. 133.1.2.2.

3. Using Fresnel zones, the height profile is wrapped so that all height values lie within a certain interval.

↪→Sec. 133.1.2.3.

The following equation shows how and in which order these surface manipulations are applied.

h(x, y) = Q
(

αR
(

h′
[
P
(

x
β

)
,P
(

y
γ

)]))
(133.1)

h′(x, y) is the original height profile, e. g. that of a conical surface. h(x, y) is the height profile after applying the
aforementioned manipulations. β, γ and α represent a scaling in x-direction, scaling in y-direction, and scaling

in z-direction, respectively.

The scaling in x-direction and the scaling in y-direction effect the domain of definition of the surface function

(↪→Sec. 35.1.1). Thus, you cannot enter values which are so small that the current size of the definition area

exceeds the domain of definition of the surface function. The scaling in z-direction must not be zero, a negative

scaling in z-Direction means that the height profile is inverted.

P(a) refers to the pixelation operator (↪→Sec. 133.1.2.1), Q(h) to the quantization operator (↪→Sec. 133.1.2.2),
R(h) to the fresnelization operator (↪→Sec. 133.1.2.3).

https://en.wikipedia.org/wiki/NaN
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133.1.2.1 Pixelation

The pixelation function p(a) introduces discrete rectangular pixels in the height profile and is defined as

p(a) =

round
( a

∆a
)

∆a ; If pixelation is used.

a ;else
. (133.2)

∆a represents the pixel size along the x- or y-axis. The pixel size is in general different along both axes.
Note, according to Eq. (133.1), the resulting pixelation effect (the size of a region for which the height is constant)

is influenced by the scaling parameters β (scaling in x-direction) and γ (scaling in y-direction).

The Sampled Surface contains discrete, equidistantly sampled height values with sampling distances

δx and δy along the x- and y-axis, respectively. An additional interpolation method creates a continuous
surface profile from these sampling points. If Nearest Neighbor is the interpolation method set in the

sampled surface, rectangular pixels will always appear. Hence pixelation cannot be disabled then and

the pixel sizes are fixed to δx · δy.

133.1.2.2 Use Discrete Height Levels (Height Quantization)

The function q(h) introduces discrete height levels in an optical surface and is defined as

q(h) =



h If quantization is not used.

qmin if hmin ≤ h < qmin.

qmax if qmax < h ≤ hmax.

round
(

h−qmin
∆h

)
∆h + qmin else

. (133.3)

qmin and qmax are the minimum and the maximum height level of the discretized height profile, respectively. ∆h
is the height difference between two consecutive height levels and is defined as

∆h =
qmax − qmin

n− 1
. (133.4)

hmin represents the minimum height of the original non-discretized surface and hmax its maximum height. n is

the Number of Discrete Height Levels between and including qmin and qmax. The function round(x) returns the
integer value closest to x.

Figure 783. Illustration of the three quantization modes supported by VirtualLab Fusion. The top row shows the respec-

tive quantization functions q(h) and the bottom row shows the effect if this quantization function is applied on a sample

height profile.
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The quantization mode Min-Max-Tread ensures that the z-extension does not change. To this end, qmin is set
to the original minimum height hmin and qmax is set to the original maximum height hmax. As you can see in

the left part of Fig. 783, the “stairway” representing the quantization function starts with a tread (a horizontal

region).

However, the Min-Max-Tread mode has a maximum quantization error q(h)− h of hmax−hmin
2(n−1) . If one resigns the

conservation of the z-extension, this error can be reduced to
hmax−hmin

2n . To this end, the mode Min-Max-Riser

is available where qmin = hmin +
hmax−hmin

2n and qmax = hmax − hmax−hmin
2n . As you can see in the middle part of

Fig. 783, the “quantization stairway” starts with a riser (a vertical line).

A third quantization mode named User Defined Min- and Max-Levels allows you to set arbitrary qmin and qmax
values.

The following table summarizes the three modes.

QUANTIZATION MODE QMIN QMAX

Min-Max-Tread hmin hmax

Min-Max-Riser hmin +
hmax−hmin

2n = hmin + ∆h
2 hmax − hmax−hmin

2n = hmax − ∆h
2

User Defined Min- and Max-

Levels

User Defined User Defined

hmin ≤ qmin < qmax ≤ hmax

The default quantization mode for new surfaces is Min-Max-Riser, with the exception of those surfaces which

are by default restricted to a discrete number of height levels (Rectangular Grating Surface, Sampled Surface,

and Transition Point List Surface). Those surfaces are set to Min-Max-Tread quantization by default so that

quantization does not change the predefined height levels (if they are equidistant). Furthermore, a Rectangular

Grating Surface is always discretized to two height levels.

133.1.2.3 Fresnel Zones

If you use Fresnel zones the height profile is “folded” so that all height values lie in the interval −p · ht . . . (1−
p)ht. ht refers to the Fresnel Height and p refers to the Relative Position on z-Axis.
Thus, if the Relative Position on z-Axis is set to 0% the height values range from 0 to +ht. This is the recom-
mended setting for a height profile containing only positive height values (e. g. a conical surface with positive

radius of curvature).

Vice versa, aRelative Position on z-Axis of 100% is recommended for surfaces with only negative height values

as then the height values are in the range −ht . . . 0.
Any intermediate relative position is of course also feasible. Fig. 784 shows an example for the effect of the

relative position.
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Figure 784. A cylindrical surface with positive radius of curvature and Fresnel zones. The subfigures illustrate the effect

of different values for the Relative Position on z-Axis p.
Left: p = 0 %. Height values range from 0 to 2mm. Middle: p = 50 %. Height values range from -1 to 1mm. Right:

p = 99.99 %. Height values range from -2 to (nearly) 0mm.

Note that the scaling in z-direction is applied after introducing the Fresnel zones. Thus the scaling in z-direction

does not influence the positions of the Fresnel “jumps” but the total profile height of a surface with Fresnel

“jumps” is the scaling factor α times the set Fresnel Height.

133.2 Coatings

The properties of a real coating naturally depend on the conditions of the process it was produced in. First of all,

its thickness depends on the deposition parameters, like the flow direction of the material. Therefore VirtualLab

Fusion allows you to specify some of these parameters, to produce more realistic coatings. The thickness tc

of a coating at the position (xc, yc, zc) is modified by a factor FHK that is derived from the Hertz-Knudsen-Law

(Please read [BE04] or [Bun82] for more information about the deposition of thin films for producing coatings.):

tc(xc, yc, zc) = t0 · FHK = t0 · cos α cos Θ · 1/r2
S (133.5)

In this equation, t0 is the thickness of the coating as specified, that means without consideration of the pro-

cessing parameters. The angle Θ is measured between the normal vector n of the optical surface at position

(xc, yc, zc) and the direction of the particle flow from the source at this point. α means the angle between this

current flow and the direction of the maximum density flow f . The ratio of the distances d0/dc equals rS (where

d0 denotes the distance of the particle source to the origin of the coordinate system, where the optical axis

intersects the surface; and dc is measured from the particle source to the current position (xc, yc, zc)). Please

see also Fig. 785. As you can see, the Hertz-Knudsen-Law assumes a flux density, decreasing laterally with a

cosine law, and decreasing axially with an 1/r2-law.
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Figure 785. Sketch of the meaning of the processing parameters of coatings.

133.3 Media

133.3.1 Scaling and Periodization of Media

Inhomogeneous optical media in VirtualLab Fusion define an arbitrary refractive index distribution n(x, y, z).
From this index distribution one can derive a new index distribution n′(x, y, z) that includes scaling and peri-

odization along the x-, y- , and z-direction.

n′(x, y, z) = n
(

x%Px

Sx
,

y%Py

Sy
,

z%Pz

Sz

)
. (133.6)

Sx, Sy and Sz represent a Scaling in x-Direction, Scaling in y-Direction, and Scaling in z-Direction, respectively.

χ%P is a modulo operator performing the operation χ′ = χ± `P; ` ∈ Z whereas the resulting χ′ lies in the

(cuboid shaped) elementary cell. This elementary cell is defined as (−Px/2 . . . + Px/2; −Py/2 . . . + Py/2; 0 . . . Pz).

133.3.2 GRIN Medium

A GRIN medium is described by a base material and an analytical formula which alters the refractive index of

this base material.

There are several equations to describe the refractive index modulation. The following formulas are imple-

mented:

n(s) = n0 +
N

∑
i=1

nisi (133.7)

n(s) =

√√√√n0 +
N

∑
i=1

nisi (133.8)

n(s) =

n0

√
1− 2∆

( s
b

)p
, s ≤ b

n1 = n0
√

1− 2∆ , s > b
(133.9)

n(s) = n0

(
1− g2

2
s2
)

(133.10)
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n0 is the wavelength dependent complex refractive index of the base material. In the first two cases you define

the maximum order N and the individual parameters ni.

Annotations

• n0 is the wavelength dependent complex-valued refractive index of the base material.

• The actual meaning of s depends on the chosen symmetry. You can define a GRIN lens with either

rotational symmetry (s =
√

x2 + y2) or with cylindrical symmetry (s = |x cos α + y sin α| with the rotation
angle α). α = 0° refers to modulation in x-direction only and α = 90° refers to modulation in y-direction

only.

• For thePolynomial (Eq. (133.7)) and theSquare Root of Polynomial (Eq. (133.8)) you define themaximum

order N and the individual parameters ni.

• The Power Law Index Profile is usually used to describe an optical fiber with a GRIN profile. Then the

border b is equal to the core radius of the fiber. The decrease ∆ describes how much the refractive index

is decreased till the border. Alternatively one can use the refractive index n1 at and outside of the border.

The two values are related via n1 = n0
√

1− 2∆. The (positive) exponent p of the equation is close to 2

for common GRIN fibers and infinity for step-index fibers. This formula is taken from [Nat].

• Approximation of sech(s) (Eq. (133.9)) is a commonly used formula to characterize GRIN media, whereas

the parameter g is referred to as gradient constant. The also-used equation n(ξ) = n0 · sech(gr) yields
nearly identical results for real GRIN lenses. Instead of the gradient constant g also the “pitch length”

PL = 2π/g can be used. In a lens with a length equal to the pitch length, light exits at the same position as

it has entered the lens (↪→Fig. 786). Manufacturers usually do not give the pitch length PL but the length

z of the lens and its “pitch” P.

P =
z

PL
and thus (133.11)

g =
2πP

z
(133.12)

Figure 786. Effect of a GRIN lens on collimated incident light. The pictured lens has a pitch of approximately 1.1. As you

can see, a GRIN lens with a pitch of 0.25 would focus collimated light immediately after the lens.
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133.3.3 Volume Grating Medium

The volume grating medium is designed for analyzing interferograms recorded into a photosensitive Holo-

graphic Material. In VirtualLab Fusion the interferograms can be synthesized by the superposition of an arbitrary

number of plane waves.

Mathematically, the x-period of the volume grating medium is the least common multiple of all subperiods

Pnm = 2π/(kx,n − kx,m). As given angles αn and αm do not transfer linearly into wave numbers kx,n and kx,m,

even the simple case of three interfering waves with angles α of 0°, 10°, and 20° would lead to a period of

far more than one meter. As periods this large are not used in reality, you can specify a Limit Period which

leads to quantized wave numbers. The smaller the Test Period the larger the difference between original and

quantized angles can become. Under certain conditions the resulting Structure Period of Quantized Medium

can be 1
n the test period, where n is an integer. This period is used in simulations, as smaller periods lead to

less computational effort.

The interference pattern can be described as local time-averaged energy density w(x, y, z).

w(x, y, z) = ε0n2
base

(
∑
n

EneiΦn(x,y,z)

)2

(133.13)

The phase function Φn(x, y, z) depends on the incident angle and wavelength of the nth wave. It is assumed
that only waves of exactly the same wavelength will interfere with each other.

En is the amplitude of the nth wave. It is calculated as follows:

En =

√
Fn

∑n Fn

wmax

ε0n2
base

(133.14)

wmax is the overall energy density of all superposing plane waves. Fn is the Weight factor of the nth wave.
Eqs. (133.13)-(133.14) follow from Maxwell’s equations assuming n =

√
ε and µ = 1.

133.3.3.1 Index Modulation

The following equations specify how the local electrical field density w(x, y, z) (↪→Eq. (133.13)) is converted into
a change of the refractive index. The volume grating medium offers three different modes therefor:

(a) Direct

In this case you just specify the desired Refractive Index Modulation ∆n. The refractive index n(x, y, z) at a
certain position is then calculated via

n(x, y, z) = nholo +
w(x, y, z)

wmax
· ∆n (133.15)

wmax can be an arbitrary value, as it cancels out in this case (see Eqs. (133.13)-(133.14)). nholo is the refractive
index of the Holographic Material.

(b) Simulate Exposition Process

In this case you simulate the real exposition process. This means you can set up the overall Power Density P
of all superposing waves, the Exposure Time texp and the Material Response.

Then, the overall energy density is calculated as follows:

wmax = P · texp (133.16)

You can choose between three equations how the Dose to Refractive Index Modulation is modeled:
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DOSE TO REFRACTIVE

INDEX MODULATION

EQUATION PARAMETERS

Linear n(x, y, z) = nholo + lw(x, y, z) l: Linear Factor

Quadratic n(x, y, z) = nholo + lw(x, y, z) +

pw(x, y, z)2
l: Linear Factor
p: Squared Factor

Asymptotic n(x, y, z) = nholo + ∆n− ∆n
1+(w(x,y,z)/w0)

γ ∆n: Refractive Index Modulation
w0: Average Energy Density

γ: Modulation Exponent

↪→Fig. 787

Figure 787. The refractive indices n(w) if asymptotic dose to refractive index modulation is chosen. The blue curve has
the smallest modulation exponent and the red curve the largest.

(c) Photonic Crystals

In this case it is assumed that above a certain energy density wt the original Holographic Material is replaced

by a second material. In VirtualLab Fusion you enter the relative Threshold, i. e.
wt

wmax
.

133.4 Materials

The following dispersion formulas are implemented in VirtualLab Fusion to describe thewavelength dependency

of the real part of the refractive index analytically:

FORMULA NAME EQUATION

Sellmeier 1

n =

√
K1 · λ2

λ2 − L1
+

K2 · λ2

λ2 − L2
+

K3 · λ2

λ2 − L3
+ 1

Sellmeier 2

n =

√
A +

B1 · λ2

λ2 − λ2
1
+

B2

λ2 − λ2
2
+ 1
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Sellmeier 3

n =

√
K1 · λ2

λ2 − L1
+

K2 · λ2

λ2 − L2
+

K3 · λ2

λ2 − L3
+

K4 · λ2

λ2 − L4
+ 1

Sellmeier 4

n =

√
A +

B · λ2

λ2 − C
+

D · λ2

λ2 − E

Sellmeier 5

n =

√
K1 · λ2

λ2 − L1
+

K2 · λ2

λ2 − L2
+

K3 · λ2

λ2 − L3
+

K4 · λ2

λ2 − L4
+

K5 · λ2

λ2 − L5
+ 1

Schott

n =

√
A0 + A1 · λ2 +

A2

λ2 +
A3

λ4 +
A4

λ6 +
A5

λ8

This formula is no longer used by Schott itself but by many other glass manufac-

turers.

Herzberger

n = A + B · L + C · L2 + D · λ2 + E · λ4 + F · λ6 with L =
1

λ2 − 0.028

The Herzberger formula is mainly used in the infrared spectrum.

Conrady

n = n0 +
A
λ
+

B
λ3.5

Useful formula to fit data with only few data points.

Handbook Optics 1

n =

√
A +

B
λ2 − C

− D · λ2

Handbook Optics 2

n =

√
A +

B · λ2

λ2 − C
− D · λ2

Cauchy

n = A +
B
λ2 +

C
λ4 +

D
λ6
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Edlén 1994 (for Air)

n = 1+
p(nst − 1)
96095.43

· 1 + 10−8(0.601− 0.00972T)p
1 + 0.0036610 · T − f (3.7345− 0.0401

1
λ2 ) · 10−10

with

nst = 8.34254 · 10−5 + 0.02406147/(130− 1
λ2 ) + 1.5998 · 10−4/(38.9− 1

λ2 ) + 1,

p being the atmospheric pressure in Pa, T being the temperature in °C, and f
being the Partial Pressure of Water Vapor in Pa. While the latter can be entered

in the dialog, the pressure and temperature are taken from the Optical Setup

which is simulated.

Edlén 1953 (for Air)

n = 1+
nst − 1

1 + 0.0034785 · (T − 15)
· p/101325− 55 · 10−9 · 0.0075 f /(1+ 0.00367 ·T)

with

nst = 6.4328 · 10−5 + 0.0294981/(146− 1
λ2 ) + 2.554 · 10−4/(41− 1

λ2 ) + 1,

p being the atmospheric pressure in Pa, T being the temperature in °C, and f
being the Partial Pressure of Water Vapor in Pa. While the latter can be entered

in the dialog, the pressure and temperature are taken from the Optical Setup

which is simulated.

Power Series

n =

√√√√ 3

∑
i=0

Ai · λ2i +
6

∑
k=1

Ak+3 · λ−2k

Abbe Number (νd)

n(λ) = A +
B
λ2

with

B =
nd − 1

νd

(
λ−2
F
− λ−2

C

)
and

A = nd −
B
λ2
d

,

νd being the (classic) Abbe number, nd the refractive index at the Fraunhofer line
d (λd = 587.5618 nm). Additionally, the Fraunhofer lines F and C (λF = Hβ =

486.134 nm; λC = Hα = 656.281 nm) are used.
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Abbe Number (νe)

n(λ) = A +
B
λ2

with

B =
ne − 1

νe
(

λ−2
F’
− λ−2

C’

)
and

A = ne −
B
λ2
e

,

νe being the (alternative) Abbe number, ne the refractive index at the Fraun-

hofer line e (λe = 546.07 nm). Additionally, the Fraunhofer lines F’ and C’ (λF’ =

479.99 nm; λC’ = 643.85 nm) are used.

134 Functions

134.1 ABCD Matrix Simulation

ABCDmatrices give an easy way to describe transformations in radial symmetric optical systemswithout limiting

apertures, in paraxial approximation. Given a vector rin = (x, α)T describing the distance x to the optical axis

and the direction component α (direction cosine) of an incoming (local) plane wave it is transformed by anABCD

matrix M to the vector rout:

rout =

 x′

α′

 = M · rin =

A B

C D

 x

α

 . (134.1)

Simple optical elements can be described by specific matrices e. g.
( 1

0
d
1
)
for a free space propagation of

distance d, or
( 1
− f−1

0
1
)
for an infinitely extensive, thin lens with focal length f . A system consisting of several

optical elements is described by the product of their matrices (where the order of multiplication depends on the

order in which the elements are passed by the light):

Msystem = Mn−1 ×Mn−2 × · · · ×M0. (134.2)

In this equation M0 is the first of n elements passed through, Mn−1 is the last.

Collins [Col70] described a way to use ABCD matrices for wave optics by giving the following equation (Collins

Integral, here simplified for one dimension),

Uout(x′) = −
ik

2πB
exp(ikL0)∫ ∞

-∞
Uin(x) exp

[
ik
2B

(
Ax2 − 2xx′ + Dx′2

)]
dx,

(134.3)

where L0 is the axial optical distance of the system. Please note that Collins used a differing notation for the

matrix elements, where A and D are interchanged as well as B and C. From the given equation (134.3), which

can be understood as a kind of Fresnel transform, the propagation of spectrum of plane waves as well as the

Rayleigh-Sommerfeld convolution can be derived. All three propagation types are physically equivalent (and

paraxial approximations(!), due to the nature of ABCD matrix representations) and differ only in the numerical

accuracy. For more information about the propagation types and their application read Sec. 93.

Important: As it is not possible to enter the axial optical distance L0, the phase of the result of Eq. (134.3) has

got a constant offset to the real phase, except the case of B = 0, that means the geometrical and optical axial
distance is = 0.
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Furthermore, ABCD matrices give an easy way to describe the transformation of a Gaussian beam in radially

symmetric optical systems without limiting apertures. Therefor the complex radius of curvature q of a Gaussian
beam is defined as follows:

1
q(z)

=
1

R(z)
− i

M2λ

πw(z)2 (134.4)

R(z) is the Phase Radius at a certain position z and w(z) is the Beam Radius at the same position z. Further-
more, M2 is the M2Parameter of the Gaussian beam and λ its wavelength. See also Sec. 132.1 for reference.

The complex radius of curvature qin of the input Gaussian beam is transformed by an ABCD matrixM into the

complex radius of curvature qout of the output Gaussian beam by the so-called ABCD law [ST91]:

qout =
Aqin + B
Cqin + D

(134.5)

134.2 Zernike & Seidel Aberrations

134.2.1 Zernike Polynomials

Zernike Polynomials are usually defined in normalized polar coordinates (ρ, θ), where 0 ≤ ρ ≤ 1; 0 ≤ θ ≤ 2π.

Thus the radii r =
√

x2 + y2 have to be converted into ρ = r/rmax where rmax is the maximum radial extent of

all positions.

Zernike polynomials are defined in standard form in Born and Wolf [BW83] as follows

Zm
n (ρ, θ) = Nm

n Rm
n (ρ)Θm(θ). (134.6)

The normalization constant is

Nm
n =

√
2(n + 1)
1 + δm0

, (134.7)

the radial polynomial is

Rm
n (ρ) =

n−|m|
2

∑
s=0

(−1)s(n− s)!
s!( n+m

2 − s)!( n−m
2 − s)!

ρn−2s, (134.8)

and azimuthal component is given by

Θm(θ) =

cos(|m|θ) for m ≥ 0

sin(|m|θ) for m < 0
.

m is the azimuthal order and n is the radial order. The following table lists the first 36 Zernike polynomials

whereas the index i is the sequential OSA / ANSI standard index1. Fig. 788 illustrates the relation between the

indices i, m, and n for the first 91 Zernike polynomials.

1 Note that other optics software often use Noll’s sequential indices.

https://en.wikipedia.org/w/index.php?title=Zernike_polynomials&oldid=861168248#Noll's_sequential_indices
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i n m Zi(r, θ) = Zm
n (r, θ) Name

1 0 0 1 Piston

2 1 -1 2ρ sin θ Tilt Y

3 1 1 2ρ cos θ Tilt X

4 2 -2
√

6ρ2 sin 2θ Astigmatism Y

5 2 0
√

3(2ρ2 − 1) Defocus

6 2 2
√

6ρ2 cos 2θ Astigmatism X

7 3 -3
√

8ρ3 sin 3θ Trefoil Y

8 3 -1
√

8(3ρ3 − 2ρ) sin θ Coma Y

9 3 1
√

8(3ρ3 − 2ρ) cos θ Coma X

10 3 3
√

8ρ3 cos 3θ Trefoil X

11 4 -4
√

10ρ4 sin 4θ Tetrafoil Y

12 4 -2
√

10(4ρ4 − 3ρ2) sin 2θ Secondary Astigmatism Y

13 4 0
√

5(6ρ4 − 6ρ2 + 1) Spherical

14 4 2
√

10(4ρ4 − 3ρ2) cos 2θ Secondary Astigmatism X

15 4 4
√

10ρ4 cos 4θ Tetrafoil X

16 5 -5
√

12ρ5 sin 5θ Pentafoil Y

17 5 -3
√

12(5ρ5 − 4ρ3) sin 3θ Secondary Trefoil Y

18 5 -1
√

12(10ρ5 − 12ρ3 + 3ρ) sin θ Secondary Coma Y

19 5 1
√

12(10ρ5 − 12ρ3 + 3ρ) cos θ Secondary Coma X

20 5 3
√

12(5ρ5 − 4ρ3) cos 3θ Secondary Trefoil X

21 5 5
√

12ρ5 cos 5θ Pentafoil X

22 6 -6
√

14ρ6 sin 6θ Hexafoil Y

23 6 -4
√

14(6ρ6 − 5ρ4) sin 4θ Secondary Tetrafoil Y

24 6 -2
√

14(15ρ6 − 20ρ4 + 6ρ2) sin 2θ Tertiary Astigmatism Y

25 6 0
√

7(20ρ6 − 30ρ4 + 12ρ2 − 1) Secondary Spherical

26 6 2
√

14(15ρ6 − 20ρ4 + 6ρ2) cos 2θ Tertiary Astigmatism X

27 6 4
√

14(6ρ6 − 5ρ4) cos 4θ Secondary Tetrafoil X

28 6 6
√

14ρ6 cos 6θ Hexafoil X

29 7 -7 4ρ7 sin 7θ Heptafoil Y

30 7 -5 4(7ρ7 − 6ρ5) sin 5θ Secondary Pentafoil Y

31 7 -3 4(21ρ7 − 30ρ5 + 10ρ3) sin 3θ Tertiary Trefoil Y

32 7 -1 4(35ρ7 − 60ρ5 + 30ρ3 − 4ρ) sin θ Tertiary Coma Y

33 7 1 4(35ρ7 − 60ρ5 + 30ρ3 − 4ρ) cos θ Tertiary Coma X

34 7 3 4(21ρ7 − 30ρ5 + 10ρ3) cos 3θ Tertiary Trefoil X

35 7 5 4(7ρ7 − 6ρ5) cos 5θ Secondary Pentafoil X

36 7 7 4ρ7 cos 7θ Heptafoil X
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Figure 788. This figure shows the first 91 Zernike polynomials and their corresponding radial order n and azimuthal or-

der θ. The black numbers in the squares give the OSA / ANSI standard index i. The red numbers give the index of the
corresponding Zernike fringe aberrations. Those Zernike polynomials which can be converted into Seidel aberrations are

marked by a green frame.

134.2.2 Zernike Fringe and Seidel Aberrations

Zernike fringe aberrations are a commonly used subset of 37 Zernike polynomials (↪→Fig. 788) whereas for

Zernike fringe aberrations the normalization constant Nm
n in Eq. (134.6) always equals 1.

There are six Seidel aberrations:
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NAME FORMULA

Piston MP

Distortion MD · ρ cos(θ − θD)

Field Curvature MF · ρ2

Astigmatism MA · ρ2 cos2(θ − θA)

Coma MC · cos(θ − θC)

Spherical Aberration MS · ρ4

The M? and θ? give the magnitude and the orientation angle of the corresponding Seidel aberrations. They can

be derived out of the coefficients of the first nine Zernike fringe aberrations using the formulas given in table V

of [WC92].

135 Manipulations

135.1 Array - Array Operations

There are four basic arithmetic operations for arrays: addition, subtraction, multiplication, and division and

additionally the convolution.

In the case that the two arrays of a array-array operation have not the same sampling distance or the same

array size, at least one of the fields or transmissions has to be resampled before the calculation, because the

underlying operation works pointwise.

The following table shows which parameter has to be adjusted in what case for each operation. The second

and the third column show how the sampling distance ∆new and the array size Snew of the resulting array are

determined by the sampling parameters of the operands (indices 1 and 2). Before starting the calculation, the

array(s) that has got sampling parameters different from that of the result field must be resampled.

Important: The sampling parameters for the directions x and y are checked and adjusted independently!

Operation ∆new Snew

Addition ∆new = min(∆1, ∆2) Snew = max(S1, S2)

Subtraction ∆new = min(∆1, ∆2) Snew = max(S1, S2)

Multiplication ∆new = min(∆1, ∆2) Snew = min(S1, S2)

Division ∆new = min(∆1, ∆2) Snew = min(S1, S2)

Convolution ∆new = min(∆1, ∆2) Snew = max(S1, S2)

135.1.1 Basic Arithmetic Operations

Different types of Complex Amplitude Documents (Harmonic Field vs. Transmission) cannot be used as

operands in every possible combination. A summary of all combinable types and their result for all opera-

tions is shown in the following tables 135.1 - 135.3. The used abbreviations are (GP) for globally polarized

fields and (LP) for locally polarized fields.

Note: If the normalization factor of the Jones vector J′ is zero, the resulting field is set to zero and the Jones
vector to (1, 0)T. If for one sampling point a division by zero occurs, then the result is set to zero too.
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135.1.2 Convolution

The convolution of two Complex Amplitude Documents U1 and U2 is calculated by

U1 ? U2 = F -1[(F U1) · (F U2)]. (135.1)

What types of ComplexAmplitude Documents (Harmonic Field vs. Transmission) can be combined as operands

and their result for all operations is shown in the following table 135.4. The used abbreviations are (GP) for

globally polarized fields and (LP) for locally polarized fields.

Note: If the normalization factor of the Jones vector J′ is zero, the resulting field is set to zero and the Jones
vector to (1, 0)T.
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135.2 Jones Matrix Multiplication

Some optical elements and devices influence the polarization state of light. Mathematically this process can

be described by a change of the electric field vector by a matrix, called Jones matrix J

E out
xy = J · E in

xy. (135.2)

For globally polarized fields, this means a change of the Jones vector:

Jout = J · Jin. (135.3)

Since Transmissions contain their own Jones matrix J (T), the effect of a Jones Matrix Multiplication can be

“added” to the transmission by applying former to the latter, which corresponds to the mathematical operation

J (T)
out = J ·J (T)

in
. (135.4)

For your convenience, the four important cases of Linear Polarization, Phase Shift, Retardation, and Rotation

are implemented as separate manipulations in VirtualLab Fusion.

• Linear Polarization: A linear polarizer is a kind of optical filter that will pass only that part of Exy which

oscillates in a certain direction. If this direction is given by an angle α, the corresponding Jones matrix is

given by

J =

 cos2 α sin α cos α

sin α cos α sin2 α

 . (135.5)

• Phase Shift: A phase shift adds a phase difference φ to both Ex and Ey. The appropriate Jones matrix

is

J =

exp(iφ) 0

0 exp(iφ)

 . (135.6)

• Retardation: Retarders as e. g. quarter-wave plates or half-wave plates “retard” Ey against Ex by a

phase difference φ. Thereby linearly polarized light can be transformed into circularly polarized and vice

versa, for example. The appropriate Jones matrix is

J =

1 0

0 exp(−iφ)

 . (135.7)

• Rotation: The angle of rotation θ of the plane of polarization determines the Jones matrix as follows

J =

cos θ − sin θ

sin θ cos θ

 . (135.8)

135.3 Quantization

Quantization of a complex amplitude field means to introduce discrete amplitude and phase levels.

135.3.1 Hard Quantization

You can enter the numbers q and Q of amplitude and phase levels, respectively.

The quantization is performed independently for amplitude and phase. For each position (x, y) the original field
value u(x, y) = A exp[iφ] is replaced by A′ exp[iφ′], where

A′ =


A if q = 0

Amax if q = 1
Amax
q−1 · b(q− 1) A

Amax
e otherwise

(135.9)
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(where b·e denotes the rounding-to-nearest-integer operation) and

φ′ =

φ if Q = 0
2π
Q · b

Q(φ+π)
2π e − π otherwise

(135.10)

Amax is the maximum amplitude within the input field. Compared to the definition of the phase quantization

operator Πquant,Q used during IFTA optimization (Sec. 97), which corresponds to the case of q = 1, the definition
given in this section allows simultaneous amplitude and phase quantization. Furthermore, the special cases for

q = 0 and Q = 0 have been included for maintaining the original amplitude and phase, respectively. In cases

of q = 1 the amplitude is set to one. If Q = 1, the resulting field has a zero phase.

135.3.2 Soft Quantization

You can enter the numbers q and Q of amplitude and phase levels, respectively. Furthermore a projection

strength λ can be entered.

The quantization is performed independently for amplitude and phase. For each position (x, y) the original field
value u(x, y) = A exp[iφ] is replaced by A′ exp[iφ′]. The amplitude A′ is obtained by

A′ =



A if q = 0

Amax if q = 1∧ C1 = true

Amax
q−1 · b(q− 1) A

Amax
e if q > 1∧ C2 = true

A otherwise

(135.11)

with the Boolean terms

C1 =

(
| A
Amax

− 1| ≥ 0.5λ

)
, (135.12)

C2 =

(∣∣∣∣ A
Amax

− 1
q− 1

· b(q− 1)
A

Amax
e
∣∣∣∣ ≥ λ

2(q− 1)

)
. (135.13)

The phase φ′ is calculated from

φ′ =

φ if Q = 0∨ C3 = true

2π
Q · b

Q(φ+π)
2π e − π otherwise

(135.14)

with the Boolean term

C3 =

(
Q > 0∧

∣∣∣∣φ− 2π

Q
· bQ/(2π)φe

∣∣∣∣ > λπ/Q
)

. (135.15)

Amax is the maximum amplitude within the complex amplitude field.

Compared to the definition of the phase quantization operator Πλ
softquant,Q used during IFTA optimization

(↪→Sec. 97), which corresponds to the case of q = 1, the definition given in this section allows for simulta-

neous amplitude and phase quantization. Furthermore, the special cases for q = 0 and Q = 0 have been

included for maintaining the original amplitude and phase, respectively. If Q = 1, the resulting field has a zero
phase.

135.3.3 Floyd-Steinberg Quantization

You can enter the numbers q and Q of amplitude and phase levels, respectively.

The result of the Floyd-Steinberg quantization contains only field values from the set

M(q,Q) = {A exp[iφ] : A ∈ Mq ∧ exp[iφ] ∈ MQ}, (135.16)
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where the sets Mq and MQ are given by

Mq =

{
jAmax

q− 1
: j = 0 . . . q− 1

}
(135.17)

and

MQ =

{
exp

[
−iπ

(
−1 +

2π j
Q

)]
: j = 0, 1, . . . , Q− 1

}
. (135.18)

Amax is the maximum amplitude within the complex amplitude field.

In contrast to the quantization types described in the previous two sections, the Floyd-Steinberg quantization

is not a pointwise operation. That is, the quantization result at a position (x, y) does not depend only on the

field value u(x, y) but also on the field values on neighboring positions. The basic idea of the Floyd-Steinberg
quantization is to distribute the error, which wasmade by the quantization at a certain position, to the neighboring

positions.

During the application of the Floyd-Steinberg quantization an iteration through all field positions is performed

row by row, whereby within each row positions are considered consecutively from left to right. At a considered

position (x, y) firstly a hard quantization is performed (↪→Sec. 135.3.1). After that the quantization error is

calculated from the difference between u(x, y) and the obtained quantization value.
This difference is spread using the weighting factors shown in Fig. 789 to four neighboring positions, which are

considered in following iterations.

Figure 789. Weighting factors for distribution of quantization errors to neighboring positions during Floyd-Steinberg quan-

tization.

135.4 Dimension Separation

You can separate a two-dimensional complex array or recombine the parts of a previously separated array. A

two-dimensional separable array usep(x, y) fulfills the property

usep(x, y) = ux(x)uy(y), (135.19)

with the one-dimensional arrays ux and uy which are calculated from the (not necessarily separable) current

array u(x, y) by

ux(x) = fxu′x(x), (135.20)

uy(y) = fyu′y(y) (135.21)

with

u′x(x) =
Ny−1

∑
j=0

u(x, yj), (135.22)

u′y(y) =
Nx−1

∑
i=0

u(xi, y) (135.23)

and

fx =

√
f0

Nx

Ny
, (135.24)

fy =

√
f0

Ny

Nx
, (135.25)
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where Nx and Ny denote the number of sampling points and f0 is calculated as

f0 =

Ny−1

∑
j=0

Nx−1

∑
i=0

u(xi, yj)ux(xi)uy(yj)

Ny−1

∑
j=0

Nx−1

∑
i=0
‖ux(xi)uy(yj)‖2

. (135.26)

135.5 Fourier Transforms

135.5.1 Fourier Transform (Space)

The Fourier transform hasmany applications in wave-optical simulations. Examples are the usage in free space

propagation operators (↪→Sec. 93) and the simulation of Fourier transforming optical setups (↪→Sec. 31.1.1).

There are four different Fourier transforms:

• (Physical) Forward: x→ k,

• (Physical) Backward: k→ x,

• Numerical Forward: x→ k, and

• Numerical Backward: k→ x .

The numerical and the “normal” or physical Fourier transform differ in their scaling: The numerical variants

ensure that the summed norm of the field (↪→Sec. 75.4.7) is not changed by the transform. This leads to the

effect that if you embed the Fourier transform of a field in a zeroized frame and then perform the backward

transform, the power and maximum amplitude of the field has changed. This is circumvented if you use the

physical transforms.

The mathematical equations for the Fourier transform and its inverse operation are:

Fourier transform F :

[F U(x, y)](x̂, ŷ) =
∫ ∫ ∞

-∞
dxdy exp[−i2π (xx̂ + yŷ)]U(x, y) (135.27)

Its inverse operation F -1:

[F -1U(x̂, ŷ)](x, y) =
∫ ∫ ∞

-∞
dx̂dŷ exp[i2π (xx̂ + yŷ)]U(x̂, ŷ) (135.28)

The used implementations of the Fourier transform and its inverse operation are using the technique of the Fast

Fourier Transform (FFT) [Bra65] which is based on the discrete Fourier transform [Goo68]. They are given in

the following subsections.

135.5.1.1 Forward: x→ k

The discrete Fourier transform F calculates a complex array in the spectral representation with wave number

coordinates (kx, ky) from an array with spatial coordinates (x, y) using the equation[
F u(x, y)

]
(kx, ky) = S ·∑

x
∑
y

exp[−i(xkx + yky)] u(x, y), (135.29)

with the scaling factor

S =


1√

Nx Ny
for the numerical variant

δxδy
2π for the physical variant and two-dimensional fields

δx√
2π

for the physical variant and one-dimensional fields

(135.30)

The two sums are calculated over the (Nx; Ny) sampling points at a grid, which is defined by the sampling

distance (δx; δy). For constructing the resultant field, Eq. (135.29) is evaluated at (Nx; Ny) sampling points
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with a sampling distance (δkx; δky) given by

δkx =
2π

Nxδx
and (135.31)

δky =
2π

Nyδy
. (135.32)

135.5.1.2 Backward: k→ x

The inverse discrete Fourier transform F -1 calculates a complex array in spatial representation from an array

in spectral representation using the equation[
F -1u(kx, ky)

]
(x, y) = S ·∑

kx

∑
ky

exp[i(xkx + yky)] u(kx, ky), (135.33)

with the scaling factor

S =


1√

Nx Ny
for the numerical variant

δkxδky
2π for the physical variant and two-dimensional fields

δkx√
2π

for the physical variant and one-dimensional fields

(135.34)

The sampling parameters of the two fields are related in the sameway as stated above (Eqs. (135.31)-(135.32)).

136 Propagations

136.1 Free Space Operators

136.1.1 Propagation between Optical Setup Elements

Generally, the propagation of a field between Optical Setup Elements is equivalent to propagating the field

between two arbitrarily positioned planes. These planes are related to the Optical Setup Elements involved

and are called transfaces. This is a special shortcut for “transfer interface” and means the location of the field

transfer between two kinds of operators. The output transface τ1 of the start element is the plane where the

output of the propagation through this element is given to the homogeneous medium free space operator. The

input transface τ2 of the target element is the plane where the output of the free space operator is given to the

propagation operator of the second element.

The position and orientation of the output transface – the starting point for the homogeneous medium free space

operator – is determined by the propagation through the start element and the type of the reference output

coordinate system chosen for this element (but the output coordinate system does not have to be identical to

this transface’s position and orientation). It is stored after the element’s propagation in the coordinate system of

the field itself: the origin of this coordinate system is identical to the position of the transface and the orientation

is given by the coordinate system’s x-y-plane.

The position and orientation of the input transface – the end point for the homogeneous medium free space

operator – is determined by the geometry of the target element and, of course, the relative position of the target

element to the start element.

There are two general cases to be distinguished for the propagation between Optical Setup Elements, related

to two different algorithms used for propagating the field from output transface τ1 to input transface τ2:

1. The planes τ1 and τ2 are parallel. The algorithm used for this configuration is shown in Fig. 790.

2. The planes τ1 and τ2 are not parallel. The algorithm used for this configuration is shown in Fig. 791.

Please note: this case cannot be simulated with 1D fields.



CHAPTER 136. PROPAGATIONS 964

X

Y Z

X

Y Z

1: Free Space
Propagation

2: Shift
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Figure 790. Algorithm for the propagation between Optical Setup Elements where output transface and input transface

are parallel. There are two operations at most: the actual free space propagation followed by a lateral shift.
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Figure 791. Algorithm for the propagation between Optical Setup Elements where output transface and input transface

are not parallel. The operators 1: actual free space propagation and 3: rotation operation can be configured by the user.

136.1.2 Far Field Operator

The far field propagation simulates the propagation of a field U(x, y) with a wavelength λ by a distance ∆z
through an infinite homogeneous medium with a given refractive index n. A propagation can be simulated from

the waist to the far field, from the far field to the waist and from one far field distance to another. The far field

propagation is the far field approximation of the Rayleigh Sommerfeld propagation integral [MW95] (see also
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Sec. 136.1.4). Thus it contains no paraxial approximation. The propagation is defined as:[
PFarField

∆z U(x, y)
]
(x′, y′) ∼ − ikz

2πr
eikr

r

∫ ∫ ∞

-∞
dxdyU(x, y)e−

ik
r (xx′+yy′) (136.1)

with r =
√

x′2 + y′2 + ∆z2 (136.2)

and k =
2πn

λ
. (136.3)

For the estimation of the sampling distance Eq. (136.20) is used if the propagation mode is Waist to Far Field

or Far Field to Waist. For the propagation mode Far Field to Far Field the sampling distance is calculated by

∆x′ = ∆x
∆z + ∆zsph

∆zsph
. (136.4)

∆zsph is the radius of the spherical phase factor which in the far field equals the distance from the waist of the

field. This means that a spherical phase radius (Sec. 131.2) must be set if you use the Far Field to Far Field

mode.

In the paraxial case the following approximation (far field approximation of Eq. (136.17)) is used:[
PFarField-P

∆z U(x, y)
]
(x′, y′) =

A
i

exp(ik∆z) exp
(

ik
2∆z

(
x′2 + y′2

))
·[

F
(

U(x, y)
)] ( k

2π∆z
x′,

k
2π∆z

y′
)

, (136.5)

where A denotes a real-valued factor. The definitions of k and F correspond to those in Sec. 136.1.3.

136.1.3 Spectrum of Plane Waves Operator

The spectrum of plane waves propagation operator PSPW
∆z is used for simulating the propagation of a field

U(x, y) with a wavelength λ by a distance ∆z through an infinite homogeneous medium with a given refractive

index n [MW95],

PSPW
∆z U = F -1

(
exp

[
i2π

√
n2

λ2 − x̂2 − ŷ2∆z

]
F U(x, y)

)
, (136.6)

where x̂ and ŷ are spatial frequencies, i. e. pixel coordinates of the Fourier transformed field.
For more details about the Fourier transform used in this equation see Sec. 135.5.1.

The spectrum of plane waves propagation operator PSPW
∆z as given in Eq. (136.6) can be derived without using

any physical approximations, that is its accuracy is limited only by numerical errors.

The main reason for these numerical errors is the sampling of the phase term in Eq. (136.6) by a finite sampling

distance δx, which can cause sampling problems during the numerical evaluation of Eq. (136.6). These issues
vanish if the propagation distance ∆z is sufficiently small. The following formula gives an approximate maximum
value ∆zmax for the propagation distance, that is in case of ∆z < ∆zmax the numerical error in the application
of PSPW

∆z is often negligible,

∆zmax =
1
2

[√( n
λ

)2
− (U0 − δU)2 −

√( n
λ

)2
−U2

0

]−1

, (136.7)

where U0 = 1/(2δx) and δU = 1/(Nxδx). It should be mentioned that in general the numerical error for all

propagation distances ∆z > 0 is never zero but just decreases with decreasing propagation distance.
The numerical error can be decreased for a given propagation distance ∆z by appending sampling points (with
value zero) at the borders of the field. The number of sampling points is increased from Nx to Nx,min by doing

so. The recommended value for Nx,min can be calculated approximately by

Nx,min =
2

1− 2δx
√( n

λ

)2 − a2
(136.8)
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where

a =
1

2∆z
+

√( n
λ

)2
−
(

1
2δx

)2
. (136.9)

For the estimation of the number of sampling points Eq. (136.8) is used.

136.1.4 Rayleigh Sommerfeld Operator

The propagation integral used in Rayleigh Sommerfeld propagation simulates the propagation of a field U(x, y)
with a wavelength λ by a distance ∆z through an infinite homogeneous medium with a given refractive index

n. It is defined by [MW95] as:

[
PRS

∆z U(x, y)
]
(x′, y′) =

1
2π

∫ ∞

-∞
dxdyU(x, y)

∂ exp(ikR)/R
∂z

, (136.10)

where

1
2π

∂ exp(ikR)/R
∂z

=
z exp(ikR)(1− ikR)

2πR3 (136.11)

and

R =
√
(x− x′)2 + (y− y′)2 + ∆z2. (136.12)

The Rayleigh Sommerfeld propagation integral can be derived without any physical approximation. Actually

the propagation integral is a convolution of a harmonic field and a spherical phase function. It is possible to

solve this convolution by using fast Fourier transforms. In this case the propagation integral has a form

[
PRS

∆z U(x)
]
(x′) = F

[
F -1

(
z exp(ikR)(1− ikR)

2πR3

)
F -1U(x)

]
. (136.13)

If the convolution is evaluated by fast Fourier transforms it is also called Rayleigh Sommerfeld Convolution. In

contrast the integral can also be numerically evaluated by simple summation. In difference to the calculation

of the convolution by fast Fourier transforms, the pure summation is much more time consuming but has the

advantage of a free choice of the number of sampling points and the sampling distance of the propagated field.

This propagation method is accurate for large propagation distances. For smaller distances numerical errors

will occur because of an undersampling of the spherical phase function in Eq. (136.12). The critical distance

∆zmin can be estimated by

∆zmin =
n
λ

√√√√[( λ

2n

)2
− x2

0 − (x0 − δx)2

]2

− 4x2
0(x0 − δx)2. (136.14)

x0 is the radius of the field and is defined as x0 = Nx
2 ∆x. It should be mentioned that for all propagation

distances ∆z 6= 0 the numerical errors never vanish but just decrease more and more with increasing distance.
For propagation distances ∆z < ∆zmin, numerical errors can be reduced by interpolating the harmonic field

before the propagation. The necessary sampling distance δxmin can be estimated by

δxmin =
π

kx0

√
x2

0 + (∆z)2, (136.15)

where

k =
2πn

λ
. (136.16)

For the estimation of the sampling distance Eq. (136.15) is used.
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136.1.5 Fresnel Propagation Operator

The Fresnel propagation operator PFresnel
∆z for simulating the propagation of a field U(x, y) with a wavelength λ

by a distance ∆z through an infinite homogeneous medium with a given refractive index n can be derived using

the paraxial Fresnel approximation [Goo68]:[
PFresnel

∆z U(x, y)
]
(x′, y′) =

A
i

exp(ik∆z) exp
(

ik
2∆z

(
x′2 + y′2

))
·[

F
(

U(x, y) exp
[ ik

2∆z

(
x2 + y2

) ])]( k
2π∆z

x′,
k

2π∆z
y′
)

, (136.17)

where A denotes a real-valued factor. The definitions of k and F correspond to those in Sec. 136.1.3.

In contrast to the spectrum of plane waves operator (↪→Sec. 136.1.3), for the application of the Fresnel propaga-

tion operator the numerical errors become larger for shorter propagation distances ∆z because of the quadratic
phase term in Eq. (136.17). The critical minimum distance ∆zmin for a field with (Nx; Ny) sampling points and

a sampling distance (δx; δy) can be estimated by

∆zmin =
(δx)2nNx

λ
. (136.18)

It should be mentioned that for all propagation distances ∆z 6= 0 the numerical errors never vanish but just

decrease more and more with increasing distance.

For propagation distances ∆z < ∆zmin numerical errors can be reduced by interpolating the field before the

propagation to a smaller sampling distance δxmin, which can be calculated approximately by

δxmin =
Nxδx

2
−

√(
Nxδx

2

)2
− ∆zλ

n
. (136.19)

In difference to most of the other homogeneous medium propagation algorithms, the sampling distance of the

field is scaled during the Fresnel propagation. The sampling distance of the propagated field follows from

∆x′ =
λ∆z

nNx∆x
. (136.20)

For the estimation of the sampling distance Eq. (136.19) is used.

136.1.6 Combined SPW / Fresnel Operator

This propagation operator combines automatically the spectrum of plane waves propagation (↪→Sec. 136.1.3)

and the Fresnel propagation (↪→Sec. 136.1.5) to achieve an efficient propagation of paraxial waves free of

numerical errors. For propagation of harmonic fields close to the waist of a wave, spectrum of plane waves is

used. For larger distances the Fresnel propagation is used. Since the Fresnel propagation is more efficient

the automatic paraxial propagation tries always to use the Fresnel propagation if the distance from the waist is

larger than the minimum distance ∆zmin (↪→Eq. (136.18)). If the spectrum of plane wave propagation is used

the harmonic field will be automatically embedded in order to reduce numerical errors.

In general a combination of both propagation methods is necessary depending on the distances from the waist

of the wave ∆zw,start of the harmonic field before the propagation and ∆zw,end of the harmonic field after the

propagation. The following table shows which combinations of propagation operators may occur.

DISTANCE
∣∣∆ZW,START

∣∣ DISTANCE |∆ZW,END| USED PROPAGATION ALGORITHMS

= 0 < ∆zmin SPW

= 0 ≥ ∆zmin FRT

< ∆zmin < ∆zmin SPW

< ∆zmin ≥ ∆zmin SPW to waist and FRT

≥ ∆zmin ≥ ∆zmin FRT to waist and FRT

≥ ∆zmin < ∆zmin FRT to waist and SPW
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136.1.7 Rayleigh Expansion Propagation

The Rayleigh coefficients R(kx, ky) calculated by the Fourier Modal Method correspond to the complex am-

plitudes of the individual grating orders. Thus a kind of SPW propagation (↪→Sec. 136.1.3) can be used to

calculate the near field in a certain propagation distance ∆z.

PNF
∆z E(x, y, z0 + ∆z) =

√
Nx Ny F -1(exp [ikz∆z]R(kx, ky)

)
, (136.21)

R(kx, ky) are the Rayleigh coefficients for Ex- and Ey-component of the field. Nx and Ny are the sampling

points in x- and y-direction, respectively. The factor
√

Nx Ny is due to the fact that R(kx, ky) is not exactly

F E(x, y) as in VirtualLab Fusion the Fourier transform is defined with a factor 1/√Nx Ny (↪→Sec. 135.5.1.1).

Notes

• To use geometrical optics alongside with the Rayleigh expansion propagation, the harmonic field

calculated by the geometrical optics is transformed to Rayleigh coefficients first.

• As the Rayleigh coefficients represent ideal plane waves with infinite size, you are always in the

near field, regardless of the set ∆z. Thus you never see separate orders if you use the near field
propagation.

• TheOutput Field Oversampling Factor of the Rayleigh Expansion Propagation is considered by an

embedding prior to the inverse Fourier transform. The result is the same as if a sinc interpolation

(↪→Sec. 13.2.2) was applied.

• The Number of Periods parameter of the Rayleigh Expansion Propagation is considered by a

zeroized oversampling prior to the inverse Fourier transform, i. e. by surrounding each pixel with

a suitable amount of zeros.

• x, y, z0, and ∆z in Eq. (136.21) refer to the coordinate system of the grating, not the coordinate

system of the incoming light.

136.2 Propagation Operators for Real Components

136.2.1 Thin Element Approximation

The thin element approximation can be used for propagating through surfaces, homogeneous and inhomoge-

neous (index modulated) media. It is assumed that paraxial / parabasal conditions hold. The paraxial mode is

documented by [Goo68]. Using the paraxial mode, the method is identical to the modeAI/AII of the geometrical

optics operator, see Sec. 96.1.

In principle the propagation of a field E by a distance ∆z from z to z + ∆z is based on:

E(z + ∆z) = Q · E(z) (136.22)

where

Q = exp {−ik0 I(n(x, y, z̃))} (136.23)

Here k0 is the wavenumber with respect to the base-material (without index modulation), and I(n(x, y, z)) is
the integral value of n(x, y, z) along the propagation path, i. e. from z̃ = z to z̃ = z + ∆z. In case of surfaces,
the propagation is applied for each medium (in front and behind the surface) separately, i. e. two consecutive

propagation steps are applied. For the integration a summed trapezoidal rule (Romberg integration) with at

most 4 integration points is used. Hence, only weak modulation of the refractive index along the propagation

path are taken into account. In the case of stronger modulation along the z-variable, the split step propagation

method (↪→Sec. 136.2.2) is to be preferred.
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136.2.2 Split Step (BPM) Propagation

This propagation operator is applicable for inhomogeneous media with small refractive index modulation δn�
n. Furthermore, paraxial conditions are assumed to hold and the influence of reflected waves is assumed to be
negligible. The operator is based on the classical ideas of paraxial beam propagation methods, see e. g. [YL92]

and [TY82]. The field is propagated through a medium by sequence of two alternating propagation steps: a

step assuming a homogeneous medium and a correction step taking into account the index modulation. Using

the notation of [TY82] we can write for the propagation of a field E by distance ∆z from z to z + ∆z:

E(z + ∆z) = P ·Q · P · E(z) (136.24)

where

P = exp
{
−i
( z

2

)
∇2
⊥/[(∇2

⊥ + k2)1/2 + k]
}

(136.25)

and

Q = exp {−i∆zk0δn(x, y)} (136.26)

The effect of the operator P is to propagate the field through a distance ∆z/2 in homogeneous medium of

refractive index n0. The operator Q subsequently imposes a phase change on the propagating field equal to

∆zk0δn taking into account the index modulation δn(x, y). After that the field is propagated by another step

of ∆z/2 in homogeneous medium. This is repeated n-times, until the total propagation distance Z = n∆z is
reached.

Note, the z-dependence of δn(x, y, z) is taken into account by the splitting along the z-distance which corre-

sponds to a piecewise trapezoidal integration rule of δn(x, y, z) with respect to the variable z.

137 Detectors

137.1 Beam Parameters

For calculating the beam parameters of a globally polarized complex amplitude field we use a method based

on the calculation of the second order momenta (↪→Sec. 137.8). The ten momenta used to calculate the beam

parameters are
〈

x2〉, 〈y2〉, 〈xθx〉,
〈
θ2

x
〉
, 〈xy〉,

〈
xθy
〉
, 〈yθx〉,

〈
θxθy

〉
,
〈
yθy
〉
, and

〈
θ2

y

〉
.

Beam parameters are well defined for harmonic fields having some finite lateral extension.

The calculation of beam parameters from the momenta is described by the following table:

ITEM DESCRIPTION

wx(zx) = 4
√
〈x2〉 Diameter in x-direction at the measured plane of the beam

wy(zy) = 4
√
〈y2〉 Diameter in y-direction at the measured plane of the beam

w0
x = 4

√
〈x2〉′ Waist diameter in x-direction of the beam

w0
y = 4

√
〈y2〉′ Waist diameter in y-direction of the beam

θx = 4
√
〈θ2

x〉 Full divergence angle of the beam in x-direction

θy = 4
√〈

θ2
y

〉
Full divergence angle of the beam in y-direction

M2
x = 4 π

λ

√
〈x2〉′ 〈θ2

x〉
′ M2 parameter for the x-axis

M2
y = 4 π

λ

√
〈y2〉′

〈
θ2

y

〉′
M2 parameter for the y-axis

zR
x =

(
w0

x
)2 π

λ Rayleigh Length of the beam in x-direction

zR
y =

(
w0

y

)2
π
λ Rayleigh Length of the beam in y-direction

1
2 arctan 2〈xy〉〈

x2
〉
−
〈
y2
〉 Rotation angle of the principal axis
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137.1.1 Calculation of the Momenta in the Waist

With the help of ABCD matrices, it is possible to calculate the beam parameters in the waist position of the

beam. The changing of the momenta during a propagation is described by Eq. (137.39). The associated ABCD

matrix A B

C D

 =

1 zx/y

0 1

 (137.1)

is used to simulate a free space propagation from the waist plane (marked with an apostrophe) to the measured

plane of the beam. Using this matrix, there follows according to [Mär]〈
x2
〉′

=
〈

x2
〉
+ 2zx 〈xθx〉+ z2

x

〈
θ2

x

〉
(137.2)

〈xy〉′ = 〈xy〉+ za
〈

xθy
〉
+ zb 〈yθx〉+ zazb

〈
θxθy

〉
(137.3)〈

y2
〉′

=
〈

y2
〉
+ 2zy

〈
yθy
〉
+ z2

y

〈
θ2

y

〉
(137.4)

〈xθx〉′ = 〈xθx〉+ zx

〈
θ2

x

〉
(137.5)〈

yθy
〉′

=
〈
yθy
〉
+ zy

〈
θ2

y

〉
(137.6)〈

θ2
x

〉′
=
〈

θ2
x

〉
(137.7)〈

θxθy
〉′

=
〈
θxθy

〉
(137.8)〈

θ2
y

〉′
=
〈

θ2
y

〉
. (137.9)

The parameters zx and zy are the distances from the plane of the measured beam to the waist plane of the

beam. The z parameters can be calculated from equations Eq. (137.5) and Eq. (137.6). It follows

zx = −〈xθx〉
〈θ2

x〉
(137.10)

zy = −
〈
yθy
〉〈

θ2
y

〉 . (137.11)

za and zb can be calculated with the following two equations from [Mär].

za = −
〈

xθy
〉′〈

θxθy
〉 (137.12)

zb = −
〈
yθy
〉′〈

θxθy
〉 (137.13)

137.1.2 Rotating Momenta according to Principal Axes

If the momentum 〈xy〉 is non-zero then the X and Y axes are not the principal axes of the beam. To calculate

the beam parameters in the principal axes, a rotation of the momenta is necessary. The rotation angle can be

calculated by

φ =
1
2

arctan
(

2 〈xy〉
〈x2〉 − 〈y2〉

)
. (137.14)

With the help of the rotation matrix

N =


cos2 φ 2 sin φ cos φ sin2 φ

− sin φ cos φ cos2 φ− sin2 φ sin φ cos φ

sin2 φ −2 sin φ cos φ cos2 φ

 (137.15)
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the rotated momenta in the principal axis are
〈

x2〉
r 〈xθx〉r

〈
θ2

x
〉

r

〈xy〉r (
〈

xθy
〉

r + 〈yθx〉r)/2
〈
θxθy

〉
r〈

y2〉
r

〈
yθy
〉

r

〈
θ2

y

〉
r

 =

N


〈

x2〉 〈xθx〉
〈
θ2

x
〉

〈xy〉 (
〈

xθy
〉
+ 〈yθx〉)/2

〈
θxθy

〉〈
y2〉 〈

yθy
〉 〈

θ2
y

〉
 . (137.16)

The momenta marked with the subscript r are the momenta rotated in the principal axis. Now it is possible to

calculate all beam parameters in relation to the principal axis by substituting all unrotatedmomenta in Sec. 137.1

and in Sec. 137.1.1 by the associated rotated ones.

137.2 Diffractive Optics Merit Functions

This section lists all merit functions and their defining equations which are used for the design and analysis of

diffractive structures in VirtualLab Fusion.

In the equations, it is assumed that the output intensity at position x′ is proportional to |Uout(x′)|2. This assump-
tion is only valid in paraxial approximation.

The symbols α, Uin, Uout, U sig, andWsig are defined in Sec. 138.1.1.

• The window efficiency ηwin is defined as the ratio between the power of the output field in the evaluation

regionWsig and the power of the incident field:

ηwin =

∫
x′∈Wsig

dx′ |Uout(x′)|2∫ ∞
-∞ dξ |Uin(ξ)|2

. (137.17)

• The idea for calculating the conversion efficiency ηconv is to measure the portion of the incident field’s

power which flows into the Desired Output Field [WA98]. Its value is calculated by

ηconv = |α|2

∫
x′∈Wsig

dx′
∣∣U sig(x′)

∣∣2
∫ ∞

-∞ dξ |Uin(ξ)|2
, (137.18)

• The signal-to-noise ratio (SNR) measures the correspondence between a (complex-valued) desired

function (here: α U sig) and a function which possesses errors in addition (here: Uout). The SNR is calcu-

lated by

SNR =

∫
x′∈Wsig

dx′ |Uout(x′)|2∫
x′∈Wsig

dx′
∣∣Uout(x′)− α U sig(x′)

∣∣2 . (137.19)

The numerical value of the SNR is often given in dB. For getting the corresponding dB value, the decadic

logarithm of the result of Eq. (137.19) has to be multiplied by 10.

• Whereas during the calculation of the SNR all positions x′ ∈ Wsig have influence on the result, the

uniformity error is determined only by the positions with the maximum deviations between resulting and

desired output field.

If we denote the largest and smallest occurring values of the quotients between output intensity and

(scaled) desired output intensity by Îmax and Îmin, respectively, that is

Îmax = max
x′∈Wsig

|Uout(x′)|2∣∣α U sig(x′)
∣∣2 , (137.20)
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and

Îmin = min
x′∈Wsig

|Uout(x′)|2∣∣α U sig(x′)
∣∣2 (137.21)

then the uniformity error Eunif can be calculated by [Ben97]

Eunif =
Îmax− Îmin
Îmax+ Îmin

. (137.22)

• The relative zeroth order intensity I0 is calculated by

I0 =
|Uout(0)|2

|α|2
. (137.23)

• The zeroth order efficiency η0 is defined by

η0 =
|Uout(0)|2∫ ∞

-∞ dξ |Uin(ξ)|2
. (137.24)

• The maximum relative intensity of stray light Istray is calculated by

Istray = max
x′ 6∈Wsig

|Uout(x′)|2

|α|2
, (137.25)

• The complex optimal scale factor α is defined in Eq. (138.1).

137.3 Fiber Coupling Efficiency

The coupling efficiency of an arbitrary harmonic field into a single mode fiber can be obtained by calculating

the complex overlap integral between the fiber mode and the harmonic field. The overlap integral is defined by

ηcoupl = ηx,coupl + ηy,coupl (137.26)

=
1∫

R2 |Exy,in|2 dx dy


[∫

R2 Ex,outE∗x,sig dx dy
]2

∫
R2

∣∣Ex,sig
∣∣2 dx dy

+

[∫
R2 Ey,outE∗y,sig dx dy

]2

∫
R2

∣∣Ey,sig
∣∣2 dx dy

 .

Exy,in is the complex amplitude of the incident field,
( Ex,out

Ey,out

)
is the complex amplitude of the field where the

coupling efficiency should be calculated from and
( E∗x,sig

E∗y,sig

)
is the complex conjugate of the reference field - this

means the harmonic field of the fiber mode. Typically as the reference field the Gaussian base mode of the

fiber should be used.

137.4 Polarization

This detector plots either the azimuthal component Eφ or radial component Eρ (please see Fig. 792 for the

meaning) of a harmonic field into a data array.

The conversion from Ex and Ey to Eφ and Eρ is done by the following equation:Eρ(ρ, φ, z)

Eφ(ρ, φ, z)

 =

 cos φ sin φ

− sin φ cos φ

 ·
Ex(x, y, z)

Ey(x, y, z)

 (137.27)
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Figure 792. Decomposition of the electric field vector E into Cartesian components (blue) and polar coordinate compo-

nents (green).

The polar coordinates are given by ρ =
√

x2 + y2 and φ = atan2 y
x .

1

137.5 Radiometry and Photometry

In the field of optics there are several physical properties considering the energy sent out by a light source or

received by a detector or a surface.

At first let us define the radiant flux Φr (in watts) through an area A, which is a power value:

Φr =
∫

S dA, where S = E× H the Poynting vector. (137.28)

Especially this applies for the total power sent out by a source:

Φr,tot =
∮

S dA.

If the light is polychromatic, you have to distinguish between spectral (wavelength dependent) and integral

(wavelength independent) values. They are connected by a relation of the form Φr =
∫ ∞

0 Φr(λ) dλ, in this

example Φr means the integral radiant flux and Φr(λ) =
dΦr
dλ the spectral radiant flux.

Furthermore these physical properties are divided into two kinds of values: physical (radiometric, subscript

r) and psycho-physical (photometric, subscript p) values. For every radiometric value exists a photometric

equivalent, which can be calculated from the first one (given in spectral form) by using the spectral luminous

efficiency function yλ. Here for instance the (spectral) radiant flux Φr(λ) and its photometric equivalent, the

luminous flux Φp:

Φp = 680 lm/W
∫ ∞

0
yλΦr(λ) dλ (137.29)

137.5.1 Radiant Intensity

If you want to know what power is sent out by a point light source into a specific solid angle Ω, you have to

calculate its radiant intensity (↪→Fig. 793). This is defined by

Ir =
dΦr

dΩ
. (137.30)

For the detection the distance to the source has to be known.

1 atan2 is a special implementation of the arctangent function for a fraction of two values. See Microsoft C# documentation or Wikipedia

for reference.

https://docs.microsoft.com/en-us/dotnet/api/system.math.atan2
https://en.wikipedia.org/w/index.php?title=Atan2&oldid=1026614210
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Figure 793. Principle of Detecting the Radiant Intensity. d is the Distance to the Point Light Source.

137.5.2 Radiance

For a non point source emission the radiance gives you the angular and spatial characteristics of the light

source or reflecting area (↪→Fig. 794). It is defined by

Lr =
d2Φr

cos θ dΩ dA
=

dS
dΩ

, (137.31)

where Ω gives the solid angle and A the radiating area you want the radiance to know for. θ is the angle

between the Poynting vector S and the normal vector A.
To use this detector, its position related to the light source or the reflecting area has to be known, as well

as the directionality of the source. This is a curve, giving the dependency of the relative intensity ( I
I0
, where

I0 = I(θ = 0)) from the angle of radiation θ. A special case is a so called Lambert characteristic, which has the

form I
I0
= cos θ, and which leads to an angular independent radiance.
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Figure 794. Principle of Detecting the Radiance. (x,y,z) is the detector position.

137.5.3 Irradiance

The irradiance is the total power going through an area A perpendicularly (↪→Fig. 795) and it is defined by:

Er =
dΦr

cos θ dA
= S⊥, (137.32)

where S⊥ is the magnitude of the component of the Poynting vector perpendicular to A.

Figure 795. Principle of Detecting the Irradiance
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137.5.4 Luminous Intensity

Luminous Intensity is the photometric, i. e. psycho-physical equivalent to the Radiant Intensity (↪→Sec. 137.5.1)

and is calculated from it analog to Eq. (137.29). Under daylight conditions a different spectral luminous efficiency

function yλ has to be used than for night conditions. This is due to the brightness dependency of the spectral

sensitivity of the human eye.

137.5.5 Luminance

Luminance is the photometric, i. e. psycho-physical equivalent to the Radiance (↪→Sec. 137.5.2) and is calcu-

lated from it analog to Eq. (137.29). Under daylight conditions a different spectral luminous efficiency function

yλ has to be used than for night conditions. This is due to the brightness dependency of the spectral sensitivity

of the human eye.

137.5.6 Illuminance

Illuminance is the photometric, i. e. psycho-physical equivalent to the Irradiance (↪→Sec. 137.5.3) and is calcu-

lated from it analog to Eq. (137.29). Under daylight conditions a different spectral luminous efficiency function

yλ has to be used than for night conditions. This is due to the brightness dependency of the spectral sensitivity

of the human eye.

137.6 Spherical Phase

One important function is the detection of spherical phase from the phase information.

A correct detection is only possible if the sampled phase information is not undersampled. The detection is

performed using a two step fitting process. A fitting is complicated due to the fact that the phase is generally

in a modulo 2π representation. And since the additional aberrations to the spherical phase factor may contain

dislocations, an unwrapping of the phase and a fitting of the unwrapped phase is not always possible. Therefore

not the fitting of the phase φ(x, y) but the fitting of the phase derivatives ∂φ(x,y)
∂x = φx(x, y) and ∂φ(x,y)

∂y = φy(x, y)
instead is performed. For the fitting a least squares method is used. Since an analytical fitting of the spherical

phase by a least squares method is not possible in a first step, a quadratic phase is fitted. For the radius rquad
of the quadratic phase follows analytically

rquad =

k
Nx ,Ny

∑
i=0,j=0

(
x2

i,j + y2
i,j

)
Nx ,Ny

∑
i=0,j=0

(
φx

i,jxi,j + φ
y
i,jyi,j

) (137.33)

with k = 2πn
λ and n is the real part of the refractive index. In a second step an iterative fit of a spherical phase

φ = kr with r =
√

x2 + y2 + r2
spher

follows, starting with the result of the quadratic phase fit for rspher. Therefore
rspher has to be optimized in order to minimize the function

G =
Nx ,Ny

∑
i=0,j=0

[(
φx

i,j −
kxi,i

ri,j

)
+

(
φ

y
i,j −

kyi,i

ri,j

)]
. (137.34)

This optimization is done numerically.

137.7 Field Components

137.7.1 Magnetic Field (H-Field)

In VirtualLab Fusion the components of the magnetic field vector H(r, t) are calculated by the following equa-
tions:
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Hx(x, y, z) = − 1
k0

√
ε0

µ0

[
F -1

(
1
kz

(
kxky[F Ex(x, y)] + (k2

y + k2
z)[F Ey(x, y)]

))]
(137.35)

Hy(x, y, z) =
1
k0

√
ε0

µ0

[
F -1

(
1
kz

(
(k2

x + k2
z)[F Ex(x, y)] + kxky[F Ey(x, y)]

])]
(137.36)

Hz(x, y, z) = − 1
k0

√
ε0

µ0

[
F -1(ky[F Ex(x, y)]− kx[F Ey(x, y)]

)]
. (137.37)

with k0 = 2π
λ ,

kx = k0 sin(θ) cos(ϕ) = 2πu,
ky = k0 sin(ϕ) = 2πv,

kz = k0 cos(θ) cos(ϕ) = 2πw and w =
√

n2

λ2 − u2 − v2.

137.7.2 Poynting Vector

In VirtualLab Fusion the components of the time averaged Poynting vector < Sr(t) > are calculated by:

< Sx(t) >t =
1
2

[
Re
[

Ey · H∗z (Ex, Ey)
]
− Re

[
Ez(Ex, Ey) · H∗y (Ex, Ey)

]]
< Sy(t) >t =

1
2

[
Re
[

Ez(Ex, Ey) · H∗x (Ex, Ey)
]
− Re

[
Ex · H∗z (Ex, Ey)

]]

< Sz(t) >t =
1
2

[
Re
[

Ex · H∗y (Ex, Ey)
]
− Re

[
Ey · H∗x (Ex, Ey)

]]

with k0 = 2π
λ ,

kx = k0 sin(θ) cos(ϕ) = 2πu,
ky = k0 sin(ϕ) = 2πv,

kz = k0 cos(θ) cos(ϕ) = 2πw and w =
√

n2

λ2 − u2 − v2.

137.8 Momentum

The momentum theory is very useful to determine the beam parameters ( ↪→Sec. 137.1) of an arbitrary wave

with global polarization.

The momenta of a globally polarized harmonic field U(x, y) are defined by〈
xn, ym, θk

x, θl
y

〉
=

(−iλ̄)k+l

2P
· (I1 + I2) , (137.38)

with

I1 =
∫ ∫

dx dy xnym

[
u(x, y)

∂k

∂xk
∂l

∂yl u∗(x, y)

]
,

I2 = (−1)(k+l)
∫ ∫

dx dy xnym

[
u∗(x, y)

∂k

∂xk
∂l

∂yl u(x, y)

]
,

P =
∫ ∫

dx dy u(x, y)u∗(x, y),

λ̄ =
λ

2π
.
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In a paraxial optical system the changing of the momenta during the propagation of the wave can be described

by ABCD matrices (↪→Sec. 104) in the following way.〈
xn, ym, θk

x, θl
y

〉′
(137.39)

=
〈
(Ax + Bθx)

n, (Ay + Bθy)
m, (Cx + Dθx)

k, (Cy + Dθy)
l
〉

.

138 Design

138.1 Iterative Fourier Transform Algorithm

138.1.1 Basic Concept and Terminology

The basic idea of the Iterative Fourier Transform Algorithm (IFTA) is to design a transmission T which trans-

forms an Input Field Uin into a Desired Output Field U sig. The real Output Field Uout will differ from U sig, these

differences can be measured with Diffractive Optics Merit Functions (↪→Sec. 137.2). The IFTA optimizes these

merit functions.

To make the design task easier and e. g. obtain larger structures in the resulting transmission, you can allow

three types of design freedom in the output plane.

1. In the case of amplitude freedom, the correspondence between output field and desired output field is only

measured within a given lateral region x′ ∈ Wsig, which is denoted as evaluation region or optimization

region.

2. In the case of phase freedom, only the amplitudes of output field and desired output field are of concern,

which mathematically corresponds to the substitutions Uout → |Uout| and U sig →
∣∣U sig

∣∣.
3. In the case of scale freedom, U sig can be scaled by a complex-valued factor α for getting a better corre-

spondence to Uout. This optimal scale factor α is calculated by

α =

∫
x′∈Wsig

dx′U∗out(x
′)U sig(x′)∫

x′∈Wsig

dx′
∣∣U sig(x′)

∣∣2 . (138.1)

U∗out is the complex conjugate of Uout.

138.1.2 Sinc Modulation due to Pixelation

VirtualLab Fusion allows an analytical simulation and compensation of a sinc effect in the far field of pixelated

transmissions.

This feature can be used to correct a desired output field prior to a transmission design and to simulate the

pixelation effect of a transmission after the design.

Pixelation of a transmission function means that every discrete sampling point can be understood as a rectan-

gular pixel. In a mathematical sense this is a convolution between a rect-function and the transmission function

T pix(x′, y′) =
∫ ∫

T (x, y)rect
(

x− x′,
∆x
2

)
rect

(
y− y′,

∆y
2

)
dxdy. (138.2)

In the far field this convolution gives a multiplication between a sinc-function and the far field of the transmission

F (T pix(x′, y′)) = F (T (x, y))sinc(
uπ

∆x
)sinc(

vπ

∆y
). (138.3)

∆x and ∆y are the pixel sizes in x- and y- direction of the transmission. If a sinc-compensation is performed,

VirtualLab Fusion divides the far field by a sinc-function in order to avoid a modulation of the far field due to a

pixelation.
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138.2 Parametric Optimization

The parametric optimization in VirtualLab Fusion allows you to optimize optical systems by means of nonlinear

optimization algorithms. For that purpose VirtualLab Fusion supports the definition of merit functions that are

to be optimized. Merit functions can take into account detector results. Further several types of parameter

constraints are formulated as merit functions as well. Finally a common merit function is constructed by a

weighted sum of individual merit functions.

138.2.1 Definition of the Target Function

Basically, the target function is a summed combination of constraints. Constraints are functions of the parameter

vector x = (x1, . . . , xt)T that can represent ranges or target values of

• the parameters itself (parameter constraints),

• merit functions calculated by detectors (merit function constraints) or

• general (arbitrary) functions (general constraints).

Let { fi(x)}i=1,...,n be the set of user-defined constraints. Then the target function F(x) is defined as the weighted
sum over all constraints:

F(x) =
n

∑
i=1

gi fi(x) , (138.4)

where gi is the weight for the i-th constraint.

Each constraint fi(x) is a composition of an inner function σi(x) and outer function f̂i(s) which conveys the

actual constraint type.

fi(x) = f̂i (σi(x)) (138.5)

f̂i(s) yields an positive value, if the constraint is violated and 0, if not.

138.2.1.1 Definition of the Inner Function σ(x)

The inner function σi(x1, . . . , xt) of the parameter constraint that corresponds to the k-th parameter (1 ≤ k ≤ t)
is the identity function with respect to this parameter:

idk(x1, . . . , xt) = xk . (138.6)

The inner functions of merit function constraints are the underlying detector merit functions. An inner func-

tion σ(x) of a general constraint can be an arbitrary function. Such a function, also called general structure

parameter, is evaluated only during parametric optimization.

Each inner function is evaluated in SI derived units.

138.2.1.2 Definition of the Outer Function f̂ (s)

The outer function f̂i(s) of a constraint fi is quadratic in regions of constraint violation and constant zero if

constraints are fulfilled. f̂i(s) is continuous anyway. The actual definition depends on the constraint type.

There are 4 different constraint types:

• Lower Limit, i.e. f̂i(s) yields a positive value if s = σ(x1, . . . , xt) is smaller than smin:

f̂i(s) = h1(s), where (138.7)

h1(s) =

0 : s ≥ smin

(s− smin)
2 : s < smin .

(138.8)
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• Upper Limit, i.e. f̂i(s) yields a positive value if s is greater than smax:

f̂i(s) = h2(s), where (138.9)

h2(s) =

0 : s ≤ smax

(s− smax)
2 : s > smax .

(138.10)

• Range, i.e. f̂i(s) yields a positive value if s is not in range [smin, smax]:

f̂i(s) = h3(s), where (138.11)

h3(s) = h1(s) + h2(s) , (138.12)

and h1(s) and h2(s) correspond to Eq. (138.8) and Eq. (138.10), respectively.

• Target Value, i.e. f̂i(s) conveys the distance of s to the target value st (which is allowed to be ±∞):

f̂i(s) = h4(s), where (138.13)

h4(s) =



∞ : st = +∞ and s ≤ 0 or

st = −∞ and s ≥ 0
1
s2 : st = +∞ and s > 0 or

st = −∞ and s < 0

(s− st)2 : else .

(138.14)

138.2.2 Calculation of the estimated error

For Powell’s method the estimated error ε is calculated from

ε =

|yi − yi+1| : |yi|+ |yi+1| < 1
2|yi−yi+1|
|yi |+|yi+1|

: else
, (138.15)

where yi = f (xi) and yi+1 = f (xi+1) are the target function evaluations in subsequent iterations. Note that the

estimated error is absolute in the first case and relative in the second.

For the downhill simplex algorithm ε is calculated similarly:

ε =

|y1 − y2| : |y1|+ |y2| < 1
10|y1−y2|
|y1|+|y2|

: else
, (138.16)

However, y1 and y2 are the target function values of the worst and the best vertex of the simplex in each iteration

step.

138.2.3 Global Optimization Algorithms

138.2.3.1 Simulated Annealing

The simulated annealing method is based on an analogy from materials science and enables the global search

for theminimum by an random temperature term t that is added to the current target function value. It is obtained
from

t = T log r , (138.17)
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where r is a random value between 0 and 1. T is the temperature, which is gradually decreased according to

an annealing schedule. The selected local optimization algorithm is applied to the adapted target function at

each annealing step. Currently, the downhill simplex algorithm is the only possible choice for the applied local

optimization algorithm.

For locating the global minimum successfully, appropriate values for start temperature and number of annealing

steps must be chosen. Unfortunately, this is something of a trial and error process in most cases. If the start

temperature is too low the algorithm will possibly get stuck in the surrounding of a local minimum. On the other

hand, temperature values that are too high will increase the probability for “jumping out” of the surrounding of

an already detected global minimum.

138.2.3.2 Evolutionary Algorithm

The Evolutionary Algorithm method is based on an analogy from population-based evolution and enables the

global search for the minimum by a random temperature term that is added to the current target function value.

An Evolutionary Algorithm is inspired by biological evolution. As such, reproduction, mutation, recombination,

and selection act as operators. These operators are continuously used to find desired minimum, maximum or

target value just like evolution of a population results in fittest species.

139 Miscellaneous

139.1 Debye-Wolf Integral

With the Debye-Wolf Integral [Wol59][FT11] one can easily calculate the field in or near the focus of an ideal

aplanatic lens which is illuminated with collimated light.

In cylindrical coordinates (ρ, ϕ, z) the field can be expressed as:

E(ρ, ϕ, z) =


Ex(ρ, ϕ, z)

Ey(ρ, ϕ, z)

Ez(ρ, ϕ, z)

 = −ik f


Ex,in (I0 − I2 cos 2ϕ)− Ey,in I2 sin 2ϕ

Ey,in (I0 + I2 cos 2ϕ)− Ex,in I2 sin 2ϕ

−2iI1
(
Ex,in cos ϕ + Ey,in sin ϕ

)
 , (139.1)

where f is the focal length. k = 2πn/λ. λ is the wavelength of the incident field. n is the refractive index of the

material around the lens. The cylindrical coordinates ρ and ϕ are given by ρ =
√

x2 + y2 and ϕ = atan2 y/x 1.

Ex,in and Ey,in are the components of the Jones vector of the incident field.

I0 =
∫ α

0

√
cos θ sin θ(cos θ + 1)J0(kρ sin θ) exp(ikz cos θ)dθ, (139.2a)

I1 =
∫ α

0

√
cos θ sin2 θ J1(kρ sin θ) exp(ikz cos θ)dθ, (139.2b)

I2 =
∫ α

0

√
cos θ sin θ(cos θ − 1)J2(kρ sin θ) exp(ikz cos θ)dθ. (139.2c)

where J0, J1, J2 are the Bessel functions of first kind. α is related to the numerical aperture NA by

α = arcsin
(
NA

n

)
(139.3)

139.2 Defining Directions and Orientations in R3

In general, we have to differentiate between defining a single direction vector in R3 and defining the orientation

of a solid. The first task requires two angles while the latter one has got three degrees of freedom. Nonetheless,

both purposes are strongly related.

1 atan2 is a special implementation of the arctangent function for a fraction of two values. See Microsoft C# documentation or Wikipedia

for reference.

https://docs.microsoft.com/en-us/dotnet/api/system.math.atan2
https://en.wikipedia.org/w/index.php?title=Atan2&oldid=1026614210
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There is a large variety of equivalent conventions which can be used to define spatial directions and orientations.

This section described all conventions used inside VirtualLab Fusion.

139.2.1 Spherical Angles

Figure 796. Example for defining an orientation using spherical angles and a subsequent rotation about the z-axis.

139.2.1.1 Defining a Single Direction via Spherical Angles

The ”Spherical Angles” convention can be used for defining a direction in reference to another direction using

the spherical angles θ and φ. In VirtualLab Fusion, the reference direction may be given by the x-, y-, or z-axis

if just a single direction is to be defined. The angle θ is the inclination angle between the defined direction and

the reference axis. The plane which contains both the new direction and the reference axis is rotated by the

other angle φ about the reference axis. One can describe the angle φ as the rotation angle of the node vector

for θ as well.

In Fig. 796, the left picture shows the inclination of the vector Z′ by θ and φ. While θ gives the angle between

Z′ and its reference direction Z, φ defines the angle between the node vector N and the Y-axis. It is identical

to the angle between the plane which is defined by Z′ and Z and the X-Z-plane.

139.2.1.2 Defining a Solid’s Orientation via Spherical Angles

The spherical angles θ and φ provide two out of three degrees of freedom a solid’s orientation in R3 has got.

Only one of the solid’s axes can be set by those two angles as described in Sec. 139.2.1.1 above. The third

degree of freedom can be fixed by an additional rotation of the solid about this axis. This additional rotation

can be performed either before setting the solid’s axis via spherical angles or after it.

In VirtualLab Fusion, the axis which is inclined by the spherical angles θ and φ is always the solid’s z-axis. So,

either the solid is rotated by an angle ζ about the z-axis first, followed by the inclination of the solid’s z-axis

according to the spherical angles. Or, the inclination using θ and φ is performed in the first step and the solid

is rotated by the angle ζ about the new z’-axis second.

In Fig. 796, both steps are shown. In the left picture, the z-axis is inclined using θ and φ. In the right picture,

the subsequent rotation about ζ is shown.
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139.2.2 Direction Angles

Figure 797. Example for defining an orientation using direction angles and a subsequent rotation about the z-axis.

139.2.2.1 Defining a Single Direction via Direction Angles

The direction angles ρ, σ, and τ determine a direction in R3. They are defined as the angles between the

direction to be defined and the coordinate axes. Please note that only two of this three angles are independent.

If, for instance, ρ and σ are set, the value of τ follows from ρ and σ, except for its sign. The angle’s cosines are

identical to x-, y- and z-component of the defined direction resp.

In Fig. 797, the left picture shows the definition of the vector Z′ by ρ, σ and τ being the angles between Z′ and
X, Y and Z respectively.

139.2.2.2 Defining a Solid’s Orientation via Direction Angles

The direction angles ρ, σ and τ provide two out of three degrees of freedom (because only two angles are

independent) a solid’s orientation in R3 has got. Only one of the solid’s axes can be set by those angles as

described in Sec. 139.2.2.1 above. The third degree of freedom can be fixed by an additional rotation of the

solid about this axis. This additional rotation can be performed either before setting the solid’s axis via spherical

angles or after it.

In VirtualLab Fusion, the axis which is inclined by the direction angles ρ, σ and τ is always the solid’s z-axis.

So, either the solid is rotated by an angle ζ about the z-axis first, followed by the inclination of the solid’s z-axis

according to the direction angles. Or, the inclination using ρ, σ and τ is performed in the first step and the solid

is rotated by the angle ζ about the new z’-axis second.

In Fig. 797, both steps are shown. In the left picture, the z-axis is inclined using ρ, σ and τ. In the right picture,

the subsequent rotation about ζ is shown.
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139.2.3 Cartesian Angles

Figure 798. Example for defining an orientation using Cartesian angles and a subsequent rotation about the z-axis.

139.2.3.1 Defining a Single Direction via Cartesian Angles

The ”Cartesian Angles” convention can be used for defining a direction in reference to one of the coordinate

system’s base axes. The angles α and β are defined as the angles of the projections of the direction onto the

base planes of the coordinate system.

In Fig. 798, the left picture shows the definition of the vector Z′ by α and β being the angles between Z and the

projection of Z′ onto the x-z-plane and the y-z-plane respectively.

139.2.3.2 Defining a Solid’s Orientation via Cartesian Angles

The Cartesian angles α and β provide two out of three degrees of freedom a solid’s orientation in R3 has got.

Only one of the solid’s axes can be set by those two angles as described in Sec. 139.2.3.1 above. The third

degree of freedom can be fixed by an additional rotation of the solid about this axis. This additional rotation

can be performed either before setting the solid’s axis via Cartesian angles or after it.

In VirtualLab Fusion, the axis which is inclined by the Cartesian angles α and β is always the solid’s z-axis. So,

either the solid is rotated by an angle ζ about the z-axis first, followed by the inclination of the solid’s z-axis

according to the Cartesian angles. Or, the inclination using α and β is performed in the first step and the solid

is rotated by the angle ζ about the new z’-axis second.

In Fig. 798, both steps are shown. In the left picture, the z-axis is inclined using α and β. In the right picture,

the subsequent rotation about ζ is shown.
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139.2.4 Sequence of Axis Rotations

Figure 799. Example for defining an orientation using an axis rotation sequence with fix axes.

139.2.4.1 Defining a Single Direction via Sequence of Axis Rotations

The ”Sequence of Axis Rotations” convention can be used for defining a direction in reference to one of the

coordinate system’s base axes. A sequence of rotations can be defined, each one performed about one of the

coordinate system’s base axes.

In Fig. 799, the definition of the vector Y′′′ via a sequence of three rotations can be reconstructed. At first, a

rotation by angle ζ about the z-axis transfers the reference axis Y into a new vector Y′. In a second step, Y′ is
transformed by a rotation of angle ξ about the x-axis into the vector Y′′. The last step of rotating Y′′ about the
y-axis by using an angle η results in the final vector Y′′′.

139.2.4.2 Defining a Solid’s Orientation via Sequence of Axis Rotations

There are two ways for defining the orientation of a solid using a sequence of axis rotations. On the one hand,

the orientation can be given by a sequence of rotations about axes that are fix in space. On the other hand, the

axes for any subsequent rotation can result from former rotations. These two cases are shown as examples in

Fig. 799 and Fig. 800.

Figure 800. Example for defining an orientation using an axis rotation sequence with non fix axes.
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139.2.5 Defining a Solid’s Orientation via Euler Angles

Figure 801. Example for defining an orientation using Euler angles.

The definition of the orientation of a solid via Euler angles is shown as an example in Fig. 801. The Euler

angles Ψ, Θ, and Φ represent rotation angles applied to non-fix coordinate axes. The whole coordinate system

is rotated about certain coordinate axes in a certain sequence, in this way, Euler angles can be seen as a

special case of an axis rotation sequence (see Sec. 139.2.4.2). Ψ is the first rotation angle, performed about

the z-axis. Θ represents the second rotation angle, applied to a rotation about the new x’-axis, resulting from

the first (Ψ-) rotation. The last step, the Φ-rotation is performed about the new z’-axis, which is a result from

the prior rotation about the x’-axis.

139.2.6 Rotation Matrix

139.2.6.1 Defining a Single Direction via Rotation Matrix

The ”Rotation Matrix” convention can be used for defining a direction in reference to another direction using a

3× 3 - rotation matrix M. In VirtualLab Fusion, the reference direction may be given by the x-, y-, or z-axis if

just a single direction is to be defined.

The direction d is calculated by

d = M · r, (139.4)

where r is the reference direction, being (0, 0, 1) (z-axis as reference), (1, 0, 0) (x-axis as reference), or (0, 1, 0)
(y-axis as reference).

139.2.6.2 Defining a Solid’s Orientation via Rotation Matrix

The orientation of a solid can be completely defined by a 3× 3 - matrix. The solid’s new axes can be calculated

from the old axes just by applying matrix multiplications as described in Sec. 139.2.6.1.

139.2.7 Defining a Single Direction via Direction Vector

A normalized direction vector can be defined by an arbitrary (not-normalized) vector just by normalizing:

d = r/
√

r2
x + r2

y + r2
z , (139.5)

with d being the normalized direction vector and r = (rx, ry, rz)T representing the not-normalized vector.

139.3 Wave Direction Conversions

There are different ways how wave directions can be specified:

• Cartesian angles
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• Spherical angles

• Wave vector components and

• Spatial frequencies .

The Cartesian angles α and β are related to the wave vector components kx and ky by

tan α =
kx

kz
, (139.6)

tan β =
ky

kz
, (139.7)

with wave number

k =
2πn(λvac)

λvac
=
√

k2
x + k2

y + k2
z, (139.8)

The spherical angles φ and θ are related to the wave vector components kx and ky by

kx = k cos φ sin θ and (139.9)

ky = k sin φ sin θ. (139.10)

The spatial frequencies u and v are related to kx and ky by

u = kx/(2π) and (139.11)

v = ky/(2π). (139.12)

139.4 Fresnel Equations

The complex Fresnel coefficients (the transmission coefficients τTE and τTM for perpendicular (TE) and parallel

(TM) polarization as well as the reflection coefficients ρTE and ρTM) according to Fresnel’s equations:

τTE =
2 sin θ′ cos θ

sin(θ + θ′)
(139.13)

ρTE =− sin(θ − θ′)

sin(θ + θ′)
(139.14)

τTM =
2 sin θ′ cos θ

sin(θ + θ′) cos(θ − θ′)
(139.15)

ρTM =
tan(θ − θ′)

tan(θ + θ′)
(139.16)

The refraction angle θ′ is given by the law of refraction: sin θ′ = ñ/ñ′ sin θ, where θ is the incidence angle and

ñ and ñ′ mean the complex refractive indices of the two media.
Furthermore the reflectance R and the transmittance T are calculated using:

RTE/TM =|ρTE/TM|2 (139.17)

TTE/TM =|τTE/TM|2
n′ cos θ′

n cos θ
(139.18)

Here n and n′ are the real parts of ñ and ñ′, respectively.

139.5 Grating Equation

The components of the wave vector kout of a diffraction order (l, m) are calculated by the following equations
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kout,x = kin,x +
2πl
Px

(139.19)

kout,y = kin,y +
2πm

Py
(139.20)

kout,z = sign (nout)

√(
2πnout

λ

)2
− k2

out,x − k2
out,y (139.21)

Px / Py Period of the grating along the x- / y-axis of the grating coordinate system

Py = ∞ for 1D-periodic gratings

kin = e 2πnin
λ Wave vector of the incident field

e Normalized direction vector of the incident field in the grating coordinate system

λ Vacuum wavelength

nin Refractive index the incident wave is defined in.

nout Refractive index the diffracted light is defined in.

nout = −nin for reflected diffraction orders.

139.6 Calculation of Efficiencies from Rayleigh Coefficients

The efficiency η of a grating order can be calculated from its Rayleigh coefficients vector R as follows.

η =
nout

A2
in

nin cos ϑin
· cos ϑout |R|2 (139.22)

nin / nout is the refractive index of the medium in which the incident wave / outgoing order propagates (with an

angle ϑin / ϑout). Ain is the amplitude of the incident plane wave. |R|2 = R2
x + R2

y + R2
z = R2

TE + R2
TM.

139.7 Paraxial Imaging with a Lens

Two equations are important for calculating distances and sizes for paraxial imaging.

The imaging equation describes the relation between the focal length f , the object distance so, and the image

distance si:
1
f
=

1
si
− 1

so
, (139.23)

while the magnification yi/yo (i. e. the ratio of the image size yi to the object size yo) is related to the object

and image distance as follows:

yi/yo =
si
so

. (139.24)
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A Annotations for Catalog Entries

A.1 Boundary Responses Catalog

A.1.1 LightTrans Defined: Axicon

For a given lateral position (x, y) and the vacuum wavelength λ this boundary response defines an axicon

function c(x, y, λ) for a given angle Angle using the following formula:

c(x, y, λ) = exp (−ikxr) = cos kxr + i sin kxr

where

kx = sign(Angle) · 2 π| tanAngle|
λ
√

1 + tan2 Angle

and

r =
√

x2 + y2

The parameter Angle is a Global Parameter and can also be varied by the parameter run document.

A.1.2 LightTrans Defined: Cylinder Lens

For a given lateral position (x, y) and the vacuum wavelength λ this boundary response defines a complex

cylindrical lens function for given angle Angle and focal length FocalLength. The amplitude of the function is

1.0 and the phase φ(x, y, λ) is defined by the following formula:

φ = sign(-FocalLength) · k ·
√

r2 + FocalLength2)

where

k =
2π

λ
and

r = (x sinAngle+ y cosAngle).

The parameters Angle and FocalLength are Global Parameters and can also be varied by the parameter run

document.

A.1.3 LightTrans Defined: Double Pinhole

For a given lateral position (x, y), this boundary response defines a double pinhole function f (x, y) with two pin-
holes with a given radiusRadius. The pinholes are placed on the x-axis in a distanceDistance to each other cen-

tered at the origin. So the pinholes are placed at positions P1 := (−Distance/2, 0) and P2 := (Distance/2, 0).
The function f (x, y) is real (imaginary part equals to zero) and is defined by

f (x, y) =

 1, if dist((x, y), P1) < Radiusor dist((x, y), P2) < Radius

0, otherwise

where dist(., .) is the distance between two points. The parametersDistance andRadius are Global Parameters
and can also be varied by the parameter run document.

A.1.4 LightTrans Defined: Double Slit

For a given lateral position (x, y), this snippet defines a double slit function f (x, y)with two slits with a given width
SlitWidth. The slits are infinite in y-direction and are placed on the x-axis in a distance SlitDistance to each other

centered at the origin. So the slits are placed at positions x1 := (−SlitDistance/2) and x2 := (SlitDistance/2).
The function f (x, y) is real (imaginary part equals to zero), independent of y and is defined by

f (x, y) =

 1, if |x− x1| < SlitWidth/2 or |x− x2| < SlitWidth/2

0, otherwise

The parameters SlitDistance and SlitWidth are Global Parameters and can also be varied by the parameter run

document.
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A.1.5 LightTrans Defined: Rotated Aperture

This boundary response describes a rotatable rectangular or elliptical aperture.

For the snippet defining this boundary response the internal VirtualLab Fusion-method “ApertureFactor” is used.

This method checks if a point of the field which is handed over is within the defined (unrotated!) aperture and

modifies its value accordingly.

The starting point is that the coordinate system of the field and the coordinate system in which the aperture is

defined are identically oriented.

It is not possible to rotate the coordinate system of the aperture itself, instead this snippet rotates the points of

the field in opposite direction before handing them over to the method.

Thus the whole process looks like the following: VirtualLab Fusion hands over all field points to the snippet

one after another. The snippet rotates these points in the direction opposite to the desired angle α. These

rotated points are handed over to the method “ApertureFactor” which compares their position with the unrotated

aperture’s area and adds a factor in the range of [0; 1] to their values. For the method there is no difference

whether the aperture is rotated counter-clockwise or the points are rotated clockwise. The method compares

two areas rotated to each other. It only depends on the overlap which is the same for both rotating options.

Finally the snippet returns all modified field values one after another.

In mathematical words: This means either the coordinate system in which the aperture is described has to

be rotated (using the transposed rotational matrix) or the points of the complex field are rotated in opposite

direction (using the rotational matrix with negative angle, i. e. the transposed rotational matrix again). Because

the first option is not available the latter remains.

Thus the rotational matrix

Rij =

 cos (−α) − sin (−α)

sin (−α) cos (−α)

 (A.1)

is used according

arotated = Rij · aunrotated (A.2)

with α as the desired rotation angle in counter-clockwise direction and a as the position vector to any point of

the field. Fig. 802 illustrates the snippet’s approach.

Figure 802. Illustration of rotating approach. Red denotes the coordinate system for describing the aperture, black de-

notes the coordinate system of the field. The little circle denotes a point in the field plane which is only within the area of

an unrotated aperture. Left: Identically oriented coordinate systems; Middle: Illustration of desired result; Right: Snip-

pet’s approach.

The snippet defining this boundary response has the following Global Parameters (which can also be varied by

the parameter run document):
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GLOBAL PARAMETER VARIABLE NAME PRESET VALUE

Angle AngleCounterClockwise 0°

Rectangular or elliptical IsRectangular 1 (TRUE)

x-extension of aperture InitialDiameterX 250 µm

y-extension of aperture InitialDiameterY 250 µm

Absolute edge width AbsoluteEdgeWidth 0m

Shift of the harmonic field in x-direction OffsetX 0m

Shift of the harmonic field in y-direction OffsetY 0m

Fig. 803 shows some apertures created with this boundary response.

Figure 803. Example results of this snippet. Upper left: Rectangular aperture with 250 µm× 250 µm; Upper right: Circu-
lar aperture with same dimensions as left; Lower left: 250 µm× 500 µm, edge width is set to 50%, the offsets for x and y
are 300 µm and 200 µm and α = 30◦; Lower right: Circular aperture with same parameters as left but with α = −30◦.
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A.1.6 LightTrans Defined: Multiple Slits

This boundary response allows you to define an arbitrary number of equidistant slits with an arbitrary width and

distance. The resulting function is invariant in y-direction.

The snippet defining this boundary response has the following Global Parameters defined (which can also be

varied by the parameter run document):

GLOBAL PARAMETER DESCRIPTION

NumberOfSlits The number of slits.

SlitWidth The width of one slit. Within one slit, the amplitude of the function is 1, i. e.

light passes unchanged. Outside, the amplitude is zero, which means that

the light is blocked.

SlitDistance The distance between two consecutive slits (measured from slit center to slit

center).

A.1.7 LightTrans Defined: SLM/DMD Function

This boundary response enables the user to simulate a so-called “Digital Micromirror Device” (DMD) which is

a type of “Spatial Light Modulator” (SLM).

The snippet defining this boundary response provides the following Global Parameters (which can also be

varied by the Parameter Run):

CONFIGURABLE PARAMETER VARIABLE NAME PRESET VALUE

Values of desired amplitude for each DMD-

pixel

AmplitudeValues Example array with ascending

and descending values

Values of desired phase for each DMD-pixel PhaseValues Example array with arbitrary

values

Distance in x-direction from the center of one

DMD-pixel to the next

PixelPitchX 8 µm

Distance in y-direction from the center of one

DMD-pixel to the next

PixelPitchY 12 µm

Active size of DMD-pixel in x-direction ActivePixelAreaX 7 µm

Active size of DMD-pixel in y-direction ActivePixelAreaY 11 µm

Shift of the whole DMD-field in x-direction ShiftX 50 nm

Shift of the whole DMD-field in y-direction ShiftY 50 nm

Fig. 804 shows the resulting field distribution of an example DMD simulation.
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Figure 804. Example of a small DMD simulation

This boundary responseworks best if the parametersPixelPitchX,PixelPitchY,ActivePixelAreaX andActivePix-

elAreaY are an integer multiple of the sampling distance of the incoming field. And for the parameter ShiftX

and ShiftY a good choice is the negligible value of half of the sampling distance if an unshifted result is de-

sired. In order to ensure a suitable sampling distance it is recommended to use the component “Field Size and

Sampling” within the Optical Setup.

A.2 Components Catalog

A.2.1 LightTrans Defined: Set Spherical Phase Radius

This programmable component allows you to set the Spherical Phase Radius (↪→Sec. 12.1.1). If the Global

Parameter DetectSphericalPhaseRadius is set to 1, the spherical phase radius is determined automatically.

Otherwise it is set to the SphericalPhaseRadius set by the user.

A.2.2 LightTrans Defined: Mirror Field in x/y Plane

This component does a mirror operation along the field’s x- or y-axis as described in Sec. 22.6. So it does not

have to be confused with a component that represents a plane mirror. The operation is only a horizontal or

vertical mirroring of the lateral field values but does not change the direction of propagation!

The value of the Global Parameter mirror_horizontally determines whether to mirror in horizontal or vertical di-

rection. If its value equals zero, the mirror operation is done horizontally (xmin ↔ xmax), otherwise the operation

is a vertical one (ymin ↔ ymax).
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Figure 805. Example for the effect of the Mirror x/y Component. The parameter was: mirror_horizontally = 1.

A.2.3 LightTrans Defined: Rotate and Shift Field in x-y-Plane

This component does a rotation in the x-y-plane (i. e. about the z axis) by an arbitrary angle (↪→Sec. 22.6.1) as

well as a lateral shift by a vector (dx, dy) .

The rotation angle is determined by the Global Parameter RotationAngle_Zeta, while the lateral shift is given

by the parameters ShiftX and ShiftY. The Global Parameter EmbeddingFactor determines a factor by which

the field data are embedded into a larger coordinate range in order to avoid that rotation or shift yield to a result

outside the field boundaries.

Figure 806. Example for the effect of the Rotate and Shift Component. The parameters were: RotationAngle_Zeta = 45°;

(ShiftX, ShiftY) = 30mm, -30mm; EmbeddingFactor = 2.
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A.2.4 LightTrans Defined: Radial Birefringent Element

This component represents a birefringent element where the thickness and thus the phase shift depends on

the radius r. Therefore the following Jones matrix J is applied on the InputField:

J =

1 0

0 exp (i (δ2(r)− δ1(r)))

 (A.3)

with the phase shift

δi(r) =
2π

λ
ni

(
d +

r2

2R

)
, i = 1, 2 (A.4)

and

r =
√

x2 + y2 (A.5)

R is the RadiusOfCurvature and d is the CenterThickness of the element. n1 and n2 are the refractive indices

along the crystal axes.

This formula is taken from [HW97].

A.2.5 LightTrans Defined: Azimuthal Birefringent Element

This component represents a birefringent element where the refractive indices differ for radially and azimuthally

polarized light. This can be described by the following Jones matrix J :

J =

 eiδ cos2 θ + sin2 θ
(
eiδ − 1

)
cos θ sin θ(

eiδ − 1
)

cos θ sin θ eiδ sin2 θ + cos2 θ

 (A.6)

with the phase shift

δi(r) =
2π

λ
(nr − nθ)l (A.7)

and

r =
√

x2 + y2; θ = arctan
y
x

(A.8)

l is the Length of the element. nr is the refractive index for radially polarized light and nθ is the refractive index

for azimuthally polarized light.

This formula is taken from [HW97].

A.3 Surfaces Catalog

A.3.1 LightTrans Defined: Axicon Surfaces

In the surface catalog axicon surfaces are available. These surfaces are programmable surfaces with a special

snippet. For a given lateral position (x, y) this snippet defines the height h(x, y) of an axicon surface with a

given angle Angle using the following formula:

h(x, y) = −(rmax − r) · tanAngle . (A.9)

The minus sign indicates that the apex is orientated in negative z-direction, i. e. towards the light source. If you

enter a negative angle the apex is orientated in positive z-direction.

rmax is the maximum of ApertureDiameterX and ApertureDiameterY, i. e. the largest diameter of the current

definition area. The radius r is calculated as r =
√

x2 + y2. The parameter Angle is a global parameter and

can be varied by the parameter run document.
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A.4 Materials Catalog

A.4.1 Template: Abbe Number νd Material

This material calculates the dispersion n(λ) from the Abbe number νd and the refractive index nd.

νd =
nd − 1

nF − nC
. (A.10)

nF is the refractive index at the Fraunhofer line F (λF = 486.134 nm), nd is the refractive index at the Fraunhofer
line d (λd = 587.5618 nm) and nC is the refractive index at the Fraunhofer line C (λC = 656.281 nm).

This material uses the reduced Cauchy formula

n(λ) = A +
B
λ2 (A.11)

to calculate the actual dispersion with

B =
nd − 1

νd

(
λ−2
F
− λ−2

C

) (A.12)

A = nd −
B
λ2
d

(A.13)

A.4.2 Template: Fused_Silica

This template is identical to that Fused_Silica material which can be found in the LightTrans Defined Catalog

“Miscellaneous”. It can be used as a base for defining other materials which use a dispersion formula like

Sellmeier, Herzberger and so on.

A.4.3 Template: Sampled n-α-Data Material

This is a template for defining the optical data in form of sampled values for the real refractive index n and the

absorption coefficient α. These data can be set via loading from a text file or via entering single data pairs for

λ and n or for λ and α resp.

A.4.4 Template: Vacuum

This template represents vacuum and can be used to define other materials with a constant refractive index or

constant absorption coefficient.

A.4.5 Sources for the Optical Material’s Data in the LightTrans Defined Catalog

The information for the glass catalogs CDGM, Corning, Dow, Heraeus, Hikari, Hoya, Isuzu, LZOS, NHG, Ohara,

Schott, Sumita, and Tecnottica were given by the manufacturers. The sources of the materials in the remaining

categories are listed below.

A.4.5.1 Carbon+Compounds

MATERIAL DATA SOURCE

Acrylic [BS94]

Carbon(amorphous)-a-C_(1975) [HGK74], [HGK75]

Carbon(amorphous)-a-C_(1991+1988) Concatenation of Carbon(sputtered)-a-C_(1991)

[13.3Å–304Å] and Carbon(amorphous_evap_thin-

Film)-a-C_(1988) [327Å–1216Å]
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Carbon(amorphous)-a-C_(1997+1988+1991) Concatenation of Carbon(amorphous)-a-C_2.2gcm-

3_(1997) [0.124Å–413Å] and Carbon(amor-

phous_evap_thinFilm)-a-C_(1988) [448Å–1216Å] and

Carbon(evap_thinFilm)-a-C_(1991) [1240Å–10663Å]

Carbon(amorphous)-a-C_2.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Carbon(amorphous_evap_thinFilm)-a-

C_(1988)

[Win+88a]

Carbon(diamond)-C_(1997+1985) Concatenation of Carbon(diamond)-C_3.51gcm-

3_(1997) [0.124Å–413Å] and Carbon(diamond_cu-

bic)-C_(1985) [413Å–6563Å]

Carbon(diamond)-C_3.51gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Carbon(diamond_cubic)-C_(1985) [Pal85]

Carbon(diamond_thinFilm)-C_(1988) [Win+88a]

Carbon(evap_thinFilm)-a-C_(1991) [Pal91]

Carbon(graphit)-g-C_2.25gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Carbon(sputtered)-a-C_(1991) [Win91]

COC-(Celanese) Celanese Spec Sheet

Mylar-(C10O4H8)n_1.38gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

PMMA-(C5O2H8)n_1.19gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Polycarbonate [BS94]

PolyMethylMethAcrylate-PMMA [BS94]

Polypropylene-C3H6_0.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Polystyrene [BS94]

Saran-(CH2=CCl2)n_1.2129gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

StyreneAcryloNitrile-SAN [BS94]

TOPAS-COC_5013L-10 Topas Spec Sheet

TOPAS-COC_6013L-17 Topas Spec Sheet

A.4.5.2 Coating_Materials

Thesematerial’s data have beenmeasured using thin film specimen. The data sources are listed in the category

which represents the composition of the material respectively (e.g. in Metals+Compounds or in Silicon+Com-

pounds_(Non-Glass)).

WARNING: As well-known from thin film physics (see e. g. Handbook of Optical Constants of Solids

Vol. II, p. 71), the optical constants of thin layers not only differ from that of bulk material, but depend

strongly on the technique of their fabrication. So please use the data provided by VirtualLab Fusion only

for an orientation! The best way to get the optical properties of a specific layer is measurement on it.
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A.4.5.3 Infrared

Each Infrared material is contained in one of the other categories at least. So the data sources for the non-

glasses are listed in that category which represents the composition of the material respectively (e. g. in Met-

als+Compounds or in Silicon+Compounds_(Non-Glass)).

A.4.5.4 Metals+Compounds

MATERIAL DATA SOURCE

Actinium-Ac_10.07gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Aluminium_antimonide(cubic)-AlSb_(1991) [Pal91]

Aluminium_arsenide(cubic)-AlAs_(1991) [Pal91]

Aluminium_gallium_arsenide(cu-

bic)-Al0.3Ga0.7As_(1991)

[Pal91]

Aluminium_oxide(amorphous)-a-

Al2O3_(1975)

[HGK74], [HGK75]

Aluminium_oxide(amorphous)-a-

Al2O3_(1997+1991)

Concatenation of Aluminium_oxide(amor-

phous)-a-Al2O3_(1997) [0.124Å–413Å] and Alu-

minium_oxide(amorphous/polyxtal)-a-Al2O3_(1991)

[413Å–249960Å]

Aluminium_oxide(amorphous)-a-

Al2O3_3.965gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Aluminium_oxide(amorphous/polyxtal)-a-

Al2O3_(1991)

[Pal91]

Aluminium_oxide(trigonal_extraordi-

naryRay)-Al2O3-e_(1991)

[Pal91]

Aluminium_oxide(trigonal_ordi-

naryRay)-Al2O3-o_(1991)

[Pal91]

Aluminium_Oxide-Al2O3-ThinFilm [ESA93]

Aluminium_oxynitride-ALON [BS94]

Aluminium-Al_(1980) [Shi+80]

Aluminium-Al_(1985) [Pal85]

Aluminium-Al_(1988) [Win+88a]

Aluminum-Al_(1994) [BS94]

Aluminium-Al_(1997+1985) Concatenation of Aluminium-Al_2.699gcm-3_(1997)

[0.124Å–413Å] and Aluminium-Al_(1985)

[413Å–12398Å]

Aluminium-Al_2.699gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Aluminum_nitride-AlN [BS94]

Aluminum-Al-ThinFilm [Pal85]

Barium_fluoride-BaF2 [BS94]
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Barium_titanate(tetragonal_extraordi-

naryRay)-BaTiO3-e_(1991)

[Pal91]

Barium_titanate(tetragonal_ordi-

naryRay)-BaTiO3-o_(1991)

[Pal91]

Beryllium(polyxtal)-Be_(1991) [Pal91]

Beryllium_oxide(ceramic)-BeO_(1991) [Pal91]

Beryllium_oxide(ordinaryRay)-BeO [BS94]

Beryllium_oxide-BeO_3.02gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Beryllium-Be_(1997+1991) Concatenation of Beryllium-Be_1.848gcm-3_(1997)

[0.124Å–413Å] and Beryllium(polyxtal)-Be_(1991)

[413Å–619900Å]

Beryllium-Be_1.848gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cadmium_selenide(ordinaryRay)-CdSe [BS94]

Cadmium_sulfide-CdS_(1994) [BS94]

Cadmium_Sulphide-CdS-ThinFilm [Pal91, p. 595]

Cadmium_telluride-CdTe [BS94]

Caesium_iodide(cubic)-CsI_(1991) [Pal91]

Caesium_iodide-CsI_6.68gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Calcite(ordinaryRay)-CaCO3 [BS94]

Calcium_fluoride(cubic)-CaF2_(1991) [Pal91]

Calcium_fluoride-CaF2_(1994) [BS94]

Calcium_fluoride-CaF2_(1997+1991) Concatenation of Calcium_fluoride-

CaF2_3.18gcm-3_(1997) [0.124Å–413Å] and Cal-

cium_fluoride(cubic)-CaF2_(1991) [500Å–5793458Å]

Calcium_fluoride-CaF2_3.18gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cerium_Fluoride-CeF3-ThinFilm [SB79]

Cerium_Oxide-CeO2-ThinFilm [SB79]

Cesium_bromide-CsBr [BS94]

Chromium(III)_oxide-

Cr2O3_5.21gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Chromium(poyxtal)-Cr_(1991) [Pal91]

Chromium_carbide(sputtered)-Cr3C2_(1991) [Win91]

Chromium_carbide-Cr3C2_(1997+1991) Concatenation of Chromium_carbide-

Cr3C2_6.68gcm-3_(1997) [0.124Å–413Å] and

Chromium_carbide(sputtered)-Cr3C2_(1991)

[430Å–1302Å]

Chromium_carbide-Cr3C2_6.68gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Chromium-Cr_(1994) [BS94]
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Chromium-Cr_(1997+1991) Concatenation of Chromium-Cr_7.2gcm-3_(1997)

[0.124Å–413Å] and Chromium(poyxtal)-Cr_(1991)

[421Å–309950Å]

Chromium-Cr_7.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

CLEARTRAN-ZnS Spec Sheet (Rohm and Haas)

CLEARTRAN-ZnS_old Spec Sheet (Morton International)

Cobalt(hcp_bulk+polyxtalThin-

Film)-Co_(1991)

[Pal91]

Cobalt(II)_oxide-CoO_6.45gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cobalt(II,III)_oxide-Co3O4_6.07gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cobalt(III)_oxide-Co2O3_5.18gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cobalt_silicide-CoSi2_5.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Cobalt-Co_(1997+1991) Concatenation of Cobalt-Co_8.9gcm-3_(1997)

[0.124Å–413Å] and Cobalt(hcp_bulk+polyxtalTh-

inFilm)-Co_(1991) [500Å–169999Å]

Cobalt-Co_8.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Copper(I)_oxide-Cu2O_(1991) [Pal91]

Copper(I)_oxide-Cu2O_6.0gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Copper(II)_oxide(polyxtal)-CuO_(1991) [Pal91]

Copper(II)_oxide-CuO_6.4gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Copper_silicide-Cu4Si_7.53gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Copper-Cu_(1985) [Pal85]

Copper-Cu_(1994) [BS94]

Copper-Cu_(1997+1985) Concatenation of Copper-Cu_8.92gcm-3_(1997)

[0.124Å–413Å] and Copper-Cu_(1985)

[413Å–95368Å]

Copper-Cu_8.92gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Gallium_antimonide-GaSb_(1991) [Pal91]

Gallium_antimonide-

GaSb_5.612gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Gallium_arsenide(singleXtal)-GaAs_(1991) [Win91]

Gallium_arsenide-GaAs [BS94]

Gallium_arsenide-GaAs_(1985) [Pal85]

Gallium_arsenide-GaAs_(1997+1991+1985) Concatenation of Gallium_arsenide-

GaAs_5.3gcm-3_(1997) [0.124Å–413Å] and

Gallium_arsenide(singleXtal)-GaAs_(1991)

[430Å–1302Å] and Gallium_arsenide-GaAs_(1985)

[1378Å–9998390ÅÅ]

Gallium_arsenide-GaAs_5.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Gallium_phosphide-GaP_(1985) [Pal85]
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Gallium_phosphide-GaP_(1997+1985) Concatenation of Gallium_phosphide-

GaP_4.129gcm-3_(1997) [0.124Å–413Å] and Gal-

lium_phosphide-GaP_(1985) [775Å–9998390Å]

Gallium_phosphide-GaP_4.129gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Gold(evap_thinFilm)-Au_(1988) [Win+88b]

Gold(polyxtal)-Au_(1985) [Pal85]

Gold-Au_(1964) [CHH64]

Gold-Au_(1970+1980) [Nil70], [ZAT80]

Gold-Au_(1975) [HGK74], [HGK75]

Gold-Au_(1981) [Wea+81]

Gold-Au_(1994) [BS94]

Gold-Au_(1997+1985) Concatenation of Gold-Au_19.32gcm-3_(1997)

[0.124Å–413Å] and Gold(polyxtal)-Au_(1985)

[413Å–99184ÅÅ]

Gold-Au_19.32gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Hafnium(evap_thinFilm)-Hf_(1988) [Win+88b]

Hafnium(IV)_oxide-HfO2_9.68gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Hafnium(singleXtal_TE)-Hf-te_(1981) [Wea+81, p. 253]

Hafnium(singleXtal_TM)-Hf-tm_(1981) [Wea+81, p. 253]

Hafnium_Dioxide-HfO2-ThinFilm [BLP82]

Hafnium-Hf_(1997+1988) Concatenation of Hafnium-Hf_13.31gcm-3_(1997)

[0.124Å–413Å] and Hafnium(evapThin-

Film)-Hf_(1988) [448Å–1216Å]

Hafnium-Hf_13.31gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Indium_antimonide-InSb_(1985) [Pal85]

Indium_arsenide-InAs_(1985) [Pal85]

Indium_phosphide-InP_(1985) [Pal85]

Iridium(evap_thinFilm)-Ir_(1988) [Win+88b]

Iridium-Ir_(1985) [Pal85]

Iridium-Ir_(1997+1985) Concatenation of Iridium-Ir_22.421gcm-3_(1997)

[0.124Å–413Å] and Iridium-Ir_(1985)

[413Å–123980Å]

Iridium-Ir_22.421gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Iron(II)_oxide-FeO_5.7gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Iron(II,III)_oxide-Fe3O4_5.18gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Iron(III)_oxide-Fe2O3_5.24gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Iron-Fe_(1991) [Pal91]

Iron-Fe_(1994) [BS94]
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Iron-Fe_(1997+1991) Concatenation of Iron-Fe_7.86gcm-3_(1997)

[0.124Å–413Å] and Iron-Fe_(1991)

[477Å–2857340Å]

Iron-Fe_7.86gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

KRS-5 [BS94]

Lanthanum_Fluoride-LaF3-ThinFilm [SB79]

Lanthanum_Oxide-La2O3-ThinFilm [SB79]

Lanthanum_trifluoride-LaF3_(1994) [BS94]

Lead(II)_fluoride-PbF2 [BS94]

Lead(II)_selenide-PbSe_(1985) [Pal85]

Lead(II)_sulfide(cubic)-PbS_(1985) [Pal85]

Lead_Fluoride-PbF2-ThinFilm [Pal97, pp. 771–773]

Lead_telluride(cubic)-PbTe_(1985) [Pal85]

Lithium_fluoride-LiF [BS94]

Lithium_fluoride-LiF_(1991) [Pal91]

Lithium_niobate(extraordinaryRay)-LiNbO3-

e_(1985)

[Pal85]

Lithium_niobate(ordinaryRay)-LiNbO3-

o_(1985)

[Pal85]

Lithium-Li_(1991) [Pal91]

Magnesium_fluoride(extraordinaryRay)-MgF2 [BS94]

Magnesium_fluoride(extraordinaryRay)-Mg-

e_(1991)

[Pal91]

Magnesium_fluoride(ordinaryRay)-MgF2 [BS94]

Magnesium_fluoride(ordinaryRay)-Mg-

o_(1991)

[Pal91]

Magnesium_Fluoride-MgF2-ThinFilm [BLP82]

Magnesium_oxide-MgO [BS94]

Magnesium_oxide-MgO_(1991) [Pal91]

Magnesium_oxide-MgO_(1997+1991) Concatenation of Magnesium_oxide-

MgO_3.58gcm-3_(1997) [0.124Å–413Å] and Magne-

sium_oxide-MgO_(1991) [413Å–6261620Å]

Magnesium_oxide-MgO_3.58gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Magnesium-Mg_1.74gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Manganese(II,III)_oxide-

Mn3O4_4.856gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Manganese(IV)_oxide-

MnO2_5.026gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Manganese-Mn_7.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Mercury_telluride-HgTe_(1991) [Pal91]
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Mercury-Hg_(1991) [Pal91]

Mercury-Hg_(1997+1991) Concatenation of Mercury-Hg_13.5939gcm-3_(1997)

[0.124Å–413Å] and Mercury(liquid)-Hg_(1991)

[636Å–61990Å]

Mercury-Hg_13.5939gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Molybdenum(evap_thinFilm)-Mo_(1988) [Win+88b]

Molybdenum(IV)_oxide-

MoO2_6.47gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum(sputtered)-Mo_(1991) [Win91]

Molybdenum(sputtered)-Mo_(1992) � (↪→Sec. A.4.5.9)

Molybdenum_dicarbide-

Mo2C_8.9gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum_disilicide-MoSi2_(1992) � (↪→Sec. A.4.5.9)

Molybdenum_disilicide-

MoSi2_6.31gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum_disulfide-

MoS2_4.8gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum_monocarbide-

MoC_8.2gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum_trioxide-

MoO3_4.692gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Molybdenum-Mo_(1985) [Pal85]

Molybdenum-Mo_(1997+1985) Concatenation of Molybdenum-Mo_10.2gcm-3_(1997)

[0.124Å–413Å] and Molybdenum-Mo_(1985)

[413Å–123980Å]

Molybdenum-Mo_10.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Neodymium_Fluoride-NdF3-ThinFilm [SB79]

Nickel(II)_oxide-NiO_6.67gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Nickel-Ni_(1985) [Pal85]

Nickel-Ni_(1997+1985) Concatenation of Nickel-Ni_8.9gcm-3_(1997)

[0.124Å–413Å] and Nickel-Ni_(1985)

[413Å–123980Å]

Nickel-Ni_8.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Niobium(evap_thinFilm)-Nb_(1988) [Win+88b]

Niobium(II)_oxide-NbO_7.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Niobium(IV)_oxide-NbO2_5.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Niobium(V)_oxide-Nb2O5_4.47gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Niobium-Nb_(1981) [Wea+81]

Niobium-Nb_(1991) [Pal91]
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Niobium-Nb_(1997+1991) Concatenation of Niobium-Nb_8.57gcm-3_(1997)

[0.124Å–413Å] and Niobium-Nb_(1991)

[413Å–103317Å]

Niobium-Nb_8.57gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Osmium(evap_thinFilm)-Os_(1988) [Win+88b]

Osmium_dioxide-OsO2_11.37gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Osmium-Os_(1981) [Wea+81, p. 253]

Osmium-Os_(1985) [Pal85]

Osmium-Os_(1997+1988+1985) Concatenation of Osmium-Os_22.48gcm-3_(1997)

[0.124Å–413Å] and Osmium(evap_thin-

Film)-Os_(1988) [448Å–1216Å] and Osmium-

Os_(1985) [1250Å–2000Å]

Osmium-Os_22.48gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Palladium(evap_thinFilm)_(1988) [Win+88b]

Palladium(II)_oxide-PdO_8.70gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Palladium-Pd_(1981) [Wea+81]

Palladium-Pd_(1991) [Pal91]

Palladium-Pd_(1997+1991) Concatenation of Palladium-Pd_12.02gcm-3_(1997)

[0.124Å–413Å] and Palladium-Pd_(1991)

[448Å–123980Å]

Palladium-Pd_12.02gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Platinum(evap_thinFilm)-Pt_(1988) [Win+88b]

Platinum(II)_oxide-PtO_14.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Platinum(IV)_oxide-PtO2_10.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Platinum-Pt_(1981) [Wea+81]

Platinum-Pt_(1985) [Pal85]

Platinum-Pt_(1997+1985) Concatenation of Platinum-Pt_21.45gcm-3_(1997)

[0.124Å–413Å] and Platinum-Pt_(1985)

[420Å–123980Å]

Platinum-Pt_21.45gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Potassium(polyxtal)-K_(1991) [Pal91]

Potassium_bromide(cubic)-KBr_(1991) [Pal91]

Potassium_chloride-KCl_(1985) [Pal85]

Rhenium(evap_thinFilm)-Re_(1988) [Win+88b]

Rhenium(IV)_oxide-ReO2_11.4gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Rhenium(singleXtal_TE)-Re-te_(1981) [Wea+81, p. 253]

Rhenium(singleXtal_TM)-Re-tm_(1981) [Wea+81, p. 253]

Rhenium(VI)_oxide-ReO3_7.0gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Rhenium(VII)_oxide-

Re2O7_6.103gcm-3_(1997)

./ (↪→Sec. A.4.5.9)
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Rhenium-Re_(1997+1988) Concatenation of Rhenium-Re_20.53gcm-3_(1997)

[0.124Å–413Å] and Rhenium(evap_thin-

Film)-Re_(1988) [448Å–1216Å]

Rhenium-Re_20.53gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Rhodium(evap_thinFilm)-Rh_(1988) [Win+88b]

Rhodium(III)_oxide-Rh2O3_8.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Rhodium-Rh_(1981) [Wea+81]

Rhodium-Rh_(1985) [Pal85]

Rhodium-Rh_(1997+1985) Concatenation of Rhodium-Rh_12.4gcm-3_(1997)

[0.124Å–413Å] and Rhodium-Rh_(1985)

[420Å–123980Å]

Rhodium-Rh_12.4gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Ruthenium(evap_thinFilm)-Ru_(1988) [Win+88b]

Ruthenium(IV)_oxide-

RuO2_6.97gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Ruthenium(singleXtal_avg)-Ru_(1981) Average of Ruthenium(singleXtal_TM)-Ru-tm_(1981)

and Ruthenium(singleXtal_TE)-Ru-te_(1981)

Ruthenium(singleXtal_TE)-Ru-te_(1981) [Wea+81]

Ruthenium(singleXtal_TM)-Ru-tm_(1981) [Wea+81]

Ruthenium(sputtered)-Ru_(1992) � (↪→Sec. A.4.5.9)

Ruthenium(VIII)_oxide-

RuO4_3.29gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Ruthenium_silicon-RuSi_5.4gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Ruthenium-Ru_(1974) [Cox+74]

Ruthenium-Ru_(1997+1974) Concatenation of Ruthenium-Ru_12.3gcm-3_(1997)

[0.124Å–413Å] and Ruthenium-Ru_(1974)

[450Å–2000Å]

Ruthenium-Ru_12.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Sapphire(ordinaryRay)-Al2O3 [BS94]

Silver(evap_thinFilm)-Ag_(1988) [Win+88b]

Silver_chloride_AgCl [BS94]

Silver_Oxide-Ag2O_7.143gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silver-Ag_(1975) [HGK74], [HGK75]

Silver-Ag_(1983) [LOL83]

Silver-Ag_(1985) [Pal85]

Silver-Ag_(1994) [BS94]

Silver-Ag_(1997+1985) Concatenation of Silver-Ag_10.50gcm-3_(1997)

[0.124Å–413Å] and Silver-Ag_(1985)

[428Å–99190Å]

Silver-Ag_10.50gcm-3_(1997) ./ (↪→Sec. A.4.5.9)
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Sodium_chloride-NaCl [Rog93]

Sodium_chloride-NaCl_(1985) [Pal85]

Sodium_fluoride-NaF_(1991) [Pal91]

Sodium_Fluoride-NaF-ThinFilm [Pal91, pp. 1028–1031]

Sodium-Na_(1991) [Pal91]

Spinel-MgAl2O4 [BS94]

Strontium_fluoride-SrF2 [BS94]

Strontium_titanate-SrTiO3 [BS94]

Strontium_titanate-SrTiO3_(1991) [Pal91]

Ta2O5-ThinFilm_MSO-measured [Jen10]

Tantalum(evap_thinFilm)-Ta_(1988) [Win+88b]

Tantalum_carbide-TaC_13.9gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tantalum_nitride-TaN_16.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tantalum_pentoxide-Ta2O5_8.2gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tantalum_Pentoxide-Ta2O5-ThinFilm [SB79]

Tantalum-Ta_(1981) [Wea+81]

Tantalum-Ta_(1991) [Pal91]

Tantalum-Ta_(1997+1991) Concatenation of Tantalum-Ta_16.6gcm-3_(1997)

[0.124Å–413Å] and Tantalum-Ta_(1991)

[413Å–1249920Å]

Tantalum-Ta_16.6gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Thorium(IV)_fluoride(polyxtal)-ThF4_(1991) [Pal91]

Thorium_Fluoride-ThF4-BulkMaterial [Pal91, pp. 1056–1057]

Thorium_Fluoride-ThF4-ThinFilm [Pal91, pp. 1056–1057]

Tin(II)_oxide-SnO_6.446gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tin(IV)_oxide-SnO2_6.95gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tin_telluride-SnTe_(1991) [Pal91]

Tin-Sn_7.28gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Titanium(evap_thinFilm)-Ti_(1988) [Win+88b]

Titanium(IV)_oxide(tetragonal_extraordi-

naryRay)-TiO2-e_(1985)

[Pal85]

Titanium(IV)_oxide(tetragonal_ordi-

naryRay)-TiO2-o_(1985)

[Pal85]

Titanium(IV)_oxide-TiO2_4.26gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Titanium(sputtered_thinFilm)-Ti_(1989) [Kih+89]

Titanium_carbide(polyxtal)-TiC_(1991) [Pal91]

Titanium_carbide-TiC_(1997+1991) Concatenation of Titanium_carbide-

TiC_4.93gcm-3_(1997) [0.124Å–413Å] and Tita-

nium_carbide(polyxtal)-TiC_(1991) [413Å–24796Å]
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Titanium_carbide-TiC_4.93gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Titanium_Dioxide-TiO2-ThinFilm [BLP82]

Titanium_nitride-TiN_(1991) [Pal91]

Titanium_nitride-TiN_(1997+1991) Concatenation of Titanium_nitride-

TiN_5.22gcm-3_(1997) [0.124Å–413Å] and Tita-

nium_nitride-TiN_(1991) [413Å–24796Å]

Titanium_nitride-TiN_5.22gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Titanium-Ti_(1981) [Wea+81]

Titanium-Ti_(1997+1988) Concatenation of Titanium-Ti_4.5gcm-3_(1997)

[0.124Å–413Å] and Titanium(evap_thin-

Film)-Ti_(1988) [448Å–1216Å]

Titanium-Ti_4.5gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tungsten(evap_thinFilm)-W_(1988) [Win+88b]

Tungsten(IV)_oxide-WO2_12.11gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tungsten(polyxtal)-W_(1985) [Pal85]

Tungsten(sputtered)-W_(1991) [Win91]

Tungsten(VI)_oxide-WO3_7.16gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tungsten_disilicide-WSi2_9.3gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Tungsten-W_(1981) [Wea+81]

Tungsten-W_(1997+1985) Concatenation of Tungsten-W_19.35gcm-3_(1997)

[0.124Å–413Å] and Tungsten(polyxtal)-W_(1985)

[413Å–247960Å]

Tungsten-W_19.35gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium(II)_oxide-VO_5.758gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium(III)_nitride-VN_(1991) [Pal91]

Vanadium(III)_nitride-VN_(1997+1991) Concatenation of Vanadium(III)_nitride-

VN_6.13gcm-3_(1997) [0.124Å–413Å] and Vana-

dium(III)_nitride-VN_(1991) [413Å–24796Å]

Vanadium(III)_nitride-VN_6.13gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium(III)_oxide_4.87gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium(IV)_oxide-VO2_4.339gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium(sputtered_thinFilm)-V_(1989) [Kih+89]

Vanadium(V)_oxide-

V2O5_3.357gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

Vanadium_carbide-VC_(1991) [Pal91]

Vanadium_carbide-VC_(1997+1991) Concatenation of Vanadium_carbide-

VC_5.77gcm-3_(1997) [0.124Å–413Å] and Vana-

dium_carbide-VC_(1991) [428Å–24796Å]

Vanadium_carbide-VC_5.77gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Vanadium-V_(1981) [Wea+81]
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Vanadium-V_(1991) [Pal91]

Vanadium-V_(1997+1991) Concatenation of Vanadium-V_5.96gcm-3_(1997)

[0.124Å–413Å] and Vanadium-V_(1991)

[413Å–123980Å]

Vanadium-V_5.96gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Yttrium(III)_oxide(cubic)-Y2O3_(1991) [Pal91]

Yttrium(III)_oxide-Y2O3_(1997+1991) Concatenation of Yttrium(III)_oxide-

Y2O3_5.01gcm-3_(1997) [0.124Å–413Å]

and Yttrium(III)_oxide(cubic)-Y2O3_(1991)

[413Å–1.999E7Å]

Yttrium(III)_oxide-Y2O3_5.01gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Yttrium(sputtered)-Y_(1992) � (↪→Sec. A.4.5.9)

Yttrium_Oxide-Y2O3-ThinFilm [SB79]

Yttrium-Y_4.4689gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

ZBLA [BS94]

ZBLAN [BS94]

Zinc_oxide-ZnO_5.606gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Zinc_selenide(cubic)-ZnSe_(1991) [Pal91]

Zinc_selenide(irtran-4)-ZnSe_(1991) [Pal91]

Zinc_selenide-ZnSe [BS94]

Zinc_sulfide(cubic)-ZnS_(1991) [Pal91]

Zinc_sulfide(hexagonal_extraordi-

naryRay)-ZnS-e_(1985)

[Pal85]

Zinc_sulfide(hexagonal_ordinaryRay)-ZnS-

o_(1985)

[Pal85]

Zinc_sulfide(irtran-2)-ZnS_(1985) [Pal85]

Zinc_sulfide-ZnS_0.42-1.1µm [Rog93]

Zinc_sulfide-ZnS_0.42-18.2µm [Rog93]

Zinc_sulfide-ZnS_4-18µm [Rog93]

Zinc_Sulfide-ZnS-ThinFilm [BLP82] The curve in Fig.1 of the publication was used

to sample the dispersion.

Zinc_telluride(cubic)-ZnTe_(1991) [Pal91]

Zinc-Zn_7.14gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Zirconium(evap_thinFilm)-Zr_(1988) [Win+88b]

Zirconium(IV)_oxide-ZrO2_5.89gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Zirconium(polyxtal)-Zr_(1981) [Wea+81, p. 253]

Zirconium(singleXtal_TE)-Zr-te_(1981) [Wea+81, p. 253]

Zirconium_Dioxide-ZrO2-ThinFilm [SB79]
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Zirconium-Zr_(1997+1988) Concatenation of Zirconium-Zr_6.49gcm-3_(1997)

[0.124Å–413Å] and Zirconium(evap_thin-

Film)-Zr_(1988) [448Å–1216Å]

Zirconium-Zr_6.49gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

A.4.5.5 Miscellaneous

MATERIAL DATA SOURCE

Acrylic [BS94]

Air [BD94]; air without any water vapor (humidity 0%).

Air (X-ray spectral region) Calculated from ñ2 = ∑i (Vi/V · ε̃i) with Vi/V being the

volume fraction of the ith gas compound of air. These

percentage values are taken from [Lid08]. ε̃i is the di-

electric function of compound i as could be found at the
source called CXRO, as described in Sec. A.4.5.9.

Air (ZemaxOS) The dispersion equation for air as used by Zemax Op-

ticStudio®. It is identical to that in [Edl53].

AMTIR-1_AMI Spec Sheet (Amorphous Materials Inc.)

AMTIR-1/TI-20 [BS94]

AMTIR-3/TI-1173_3-14µm [BS94]

AMTIR-3/TI-1173_0.9-14µm [BS94]

BK7_MSO-measured [Jen10]

Boron_carbide-B4C_2.52gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Boron_nitride-BN_2.25gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Boron_trioxide-B2O3_2.46gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Boron-B_2.37gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Fused_Silica [BS94]

Germanium_dioxide-GeO2 [BS94]

Germanium-Ge_(1957) [SV57]

Germanium-Ge_(1985) [Pal85]

Germanium-Ge_(1985)_2-12µm [Pal85]

Germanium-Ge_5.323gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Ideal High Absorption Material This is just an “ideal” material with extreme high absorp-

tion.

Ideal High Reflectance Material This is just an “ideal” mirror material with extreme high

absorption, which leads to a nearly perfect reflectance.

KDP(ordinaryRay)-KH2PO4 [BS94]

Seawater-H2O_3.5pct_Salinity Dispersion parameters from [Lai06], absorption coeffi-

cients from [Ame94].

Selenium(extraordinaryRay)-Se-e_(1991) [Pal91]
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Selenium(ordinaryRay)-Se-o_(1991) [Pal91]

Tellurium(trigonal_extraordinaryRay)-Te-

e_(1991)

[Pal91]

Tellurium(trigonal_ordinaryRay)-Te-o_(1991) [Pal91]

Tellurium_dioxide-TeO2_(1994) [BS94]

Water-H2O_(1991) [Pal91]

Water-H2O_(1997+1991) Concatenation of Water-H2O_1.0gcm-3_(1997)

[0.124Å–413Å] and Water-H2O_(1991)

[460Å–1.E11Å]

Water-H2O_(pure) Dispersion parameters from [Lai06], absorption coeffi-

cients from [Ame94].

Water-H2O_1.0gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

A.4.5.6 Radiation_Hardened

This category contains glasses which are labeled as radiation hardened by the manufacturers.

A.4.5.7 Silicon+Compounds_(Non-Glass)

This category contains the element silicon as well as compounds of silicon which are no glasses.

MATERIAL DATA SOURCE

Hydrogenated_Silicon(amorphous)-a-

Si:H_(1985)

[Pal85]

Silicon(amorphous)-a-Si_(1997+1985) Concatenation of Silicon(amorphous)-a-Si_2.189gcm-

3_(1997) [0.124Å–413Å] and Silicon(amor-

phous_evap)-a-Si_(1985) [413Å–355142Å]

Silicon(amorphous)-a-Si_2.189gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silicon(amorphous)-a-Si_sopra https://web.archive.org/web/20070101013854/
http://www.sopra-sa.com/index2.htm

Silicon(amorphous_evap)-a-Si_(1985) [Pal85]

Silicon(crystalline)-Si_(1985) [Pal85]

Silicon(evap_thinFilm)-a-Si_(1988) [Win+88a]

Silicon(oxidized_(100)_Si_wafer)-Si_(1992) � (↪→Sec. A.4.5.9)

Silicon(sputtered)-a-Si_(1991) [Win91]

Silicon(sputtered)-a-Si_(1992) � (↪→Sec. A.4.5.9)

Silicon_carbide(6H)-SiC_(1989) [Yan+89]

Silicon_carbide(amorphous)-a-

Sic_(1997+1988)

Concatenation of Silicon_carbide(amorphous)-a-

SiC_3.112gcm-3_(1997) [0.124Å–413Å] and Sili-

con_carbide(sputtered)-a-SiC_(1988) [448Å–1216Å]

Silicon_carbide(amorphous)-a-

SiC_3.112gcm-3_(1997)

./ (↪→Sec. A.4.5.9)

https://web.archive.org/web/20070101013854/http://www.sopra-sa.com/index2.htm
https://web.archive.org/web/20070101013854/http://www.sopra-sa.com/index2.htm
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Silicon_carbide(CVD)-SiC_(1985) [Osa85]

Silicon_carbide(CVD)-SiC_(1988) [Win+88a]

Silicon_carbide(hex_xtal_ordinaryRay)-SiC-

o_(1985)

[Pal85]

Silicon_carbide(sputtered)-a-SiC_(1988) [KW88]

Silicon_carbide-SiC_(1997+1985) Concatenation of Silicon_carbide-

SiC_3.208gcm-3_(1997) [0.124Å–413Å] and Sil-

icon_carbide(hex_xtal_ordinaryRay)-SiC-o_(1985)

[413Å–250010Å]

Silicon_carbide-SiC_3.208gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silicon_dioxide(amor-

phous)-SiO2_(1997+1991)

Concatenation of Silicon_diox-

ide(amorphous)-SiO2_2.19gcm-3_(1997)

[0.124Å–413Å] and Silicon_dioxide(amor-

phous_fused_quartz)-SiO2_(1991) [420Å–4999190Å]

Silicon_dioxide(amorphous)-SiO2_2.19gcm-

3_(1997)

./ (↪→Sec. A.4.5.9)

Silicon_dioxide(amor-

phous_fused_quartz)-SiO2_(1991)

[Pal91]

Silicon_dioxide(trigonal_quartz_extraordi-

naryRay)

[BS94]

Silicon_dioxide(trigonal_quartz_extraordi-

naryRay)-SiO2-e_(1985)

[Pal85]

Silicon_dioxide(trigonal_quartz_extraordi-

naryRay)-SiO2-e_(1999)

[Gho99]

Silicon_dioxide(trigonal_quartz_ordi-

naryRay)

[BS94]

Silicon_dioxide(trigonal_quartz_ordi-

naryRay)-SiO2-o_(1985)

[Pal85]

Silicon_dioxide(trigonal_quartz_ordi-

naryRay)-SiO2-o_(1999)

[Gho99]

Silicon_dioxide-SiO2_(1997+1985) Concatenation of Silicon_dioxide-

SiO2_2.65gcm-3_(1997) [0.124Å–413Å] and Sil-

icon_dioxide(trigonal_quartz_ordinaryRay)-SiO2-

o_(1985) [420Å–4999190Å]

Silicon_dioxide-SiO2_2.65gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silicon_Dioxide-SiO2-ThinFilm [BLP82] The curve in Fig.22 of the publication was

used to sample the dispersion instead of the bad fitting

Cauchy parameters given.

Silicon_monoxide-SiO_(1985) [Pal85]

Silicon_monoxide-SiO_(1997+1985) Concatenation of Silicon_monoxide-

SiO_2.13gcm-3_(1997) [0.124Å–413Å] and Sili-

con_monoxide-SiO_(1985) [496Å–139995Å]
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Silicon_monoxide-SiO_2.13gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silicon_Monoxide-SiO-ThinFilm [Pal85, p. 768]

Silicon_nitride(polyxtal)-Si3N4_(1985) [Pal85]

Silicon_nitride-Si3N4_(1992) � (↪→Sec. A.4.5.9)

Silicon_nitride-Si3N4_(1997+1985) Concatenation of Silicon_nitride-

Si3N4_3.44gcm-3_(1997) [0.124Å–413Å] and Sil-

icon_nitride(polyxtal)-Si3N4_(1985) [517Å–12398Å]

Silicon_nitride-Si3N4_3.44gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

Silicon-germanium(cu-

bic)-Si0.25Ge0.75_(1991a)

[Pal91]

Silicon-germanium(cu-

bic)-Si0.25Ge0.75_(1991b)

[Pal91]

Silicon-germanium(cu-

bic)-Si0.5Ge0.5_(1991a)

[Pal91]

Silicon-germanium(cu-

bic)-Si0.5Ge0.5_(1991b)

[Pal91]

Silicon-germanium(cu-

bic)-Si0.8Ge0.2_(1991a)

[Pal91]

Silicon-germanium(cu-

bic)-Si0.8Ge0.2_(1991b)

[Pal91]

Silicon-Si_(1997+1985) Concatenation of Silicon-Si_2.329gcm-3_(1997)

[0.124Å–413Å] and Silicon(crystalline)-Si_(1985)

[420Å–3332800Å]

Silicon-Si_1.36-11µm [BS94]

Silicon-Si_2.329gcm-3_(1997) ./ (↪→Sec. A.4.5.9)

SiO2-ThinFilm_MSO-measured [Jen10]

A.4.5.8 Birefringent

This category contains birefringent materials, namely uniaxial and biaxial crystals.

MATERIAL DATA SOURCE

Calcite_(extraordinaryRay)-CaCO3-e/o_(1999) [Gho99]

CaMoO4(tetragonal_extraordinaryRay)-CaMoO4-e/o_(1965) [Bon65]

CaWO4(tetragonal_extraordinaryRay)-CaWO4-e/o_(1965) [Bon65]1

LYSO:Ce(monoclinic_Index_α/β/γ)-Lu(x)Y(2-x)SiO5-α/β/γ_(2012) [Erd+12]

Rutile(tetragonal_extraordinaryRay)-TiO2-e/o_(1965) [Bon65]2

1 The value for the extraordinary ray at 1.8 µm is obviously wrong. Since there is a good chance that there were transposed digits, the

table value of 1.9848 has been replaced by 1.8948.
2 The outlier for the ordinary ray at 500 nm of 2.4058 has been replaced by 2.7058. The outlier for the extraordinary ray at 1.6 µm of

2.6002 has been replaced by 2.6902.
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SrMoO4(tetragonal_extraordinaryRay)-SrMoO4-e/o_(1965) [Bon65]

YAlO3(1.14%Nd_orthorhombic_Index_α/β/γ)-YAlO3-α/β/γ_(1973) [MD73]

YAlO3(undoped_orthorhombic_Index_α/β/γ)-YAlO3-α/β/γ_(1973) [MD73]

ZnWO4(monoclinic_Index_α/β/γ)-ZnWO4-α/β/γ_(1965) [Bon65]

α-BismuthMolybdate(monoclinic_Index_α/β/γ)-Bi2(MoO4)3-α/β/γ_(2002) [MV02]

A.4.5.9 X-ray

Each X-raymaterial is contained in one of the other categories at least. So the data sources for the non-glasses

are listed in that category which represents the composition of the material respectively (e. g. in Metals+Com-

pounds or in Silicon+Compounds_(Non-Glass)).

For all entries marked with ./ or � in the table above, the optical data are taken from David Windt’s IMD software

package (http://www.rxollc.com/imd).

• �: For the materials marked with �, only the source “D. L. Windt, unpublished (1992)” is given.

• ./: For thematerials marked with ./, the user’s manual ([Win13], p. 37) of this software states: “The atomic

scattering factors f1 & f2 can be used to compute optical constants n & k for elemental or compound ma-

terials of known density, as described in [[HGD93]]. [...] Each file is a concatenation of high-energy X-ray

data obtained from LLNL extending from 30 keV to 100 keV, and low-energy data from CXRO extend-

ing from 30 keV to 10 eV.” The abbreviations LLNL and CXRO refer to data bases, formerly provided by

websites of the following institutions:

– LLNL: Lawrence Livermore National Laboratory (https://web.archive.org/web/20001030001803/
http://www-phys.llnl.gov/V_Div/scattering/asf.html)

– CXRO: Center for X-Ray Optics (CXRO), Lawrence Berkeley Laboratory (https://web.archive.
org/web/20051117074606fw_/http://www.cxro.lbl.gov/optical_constants/asf.html)

Note: A currently available data base for atomic scattering factors (if someone wants to calculate n-k-data

for herself) can be found at https://physics.nist.gov/PhysRefData/FFast/html/form.html.

http://www.rxollc.com/imd
https://web.archive.org/web/20001030001803/http://www-phys.llnl.gov/V_Div/scattering/asf.html
https://web.archive.org/web/20001030001803/http://www-phys.llnl.gov/V_Div/scattering/asf.html
https://web.archive.org/web/20051117074606fw_/http://www.cxro.lbl.gov/optical_constants/asf.html
https://web.archive.org/web/20051117074606fw_/http://www.cxro.lbl.gov/optical_constants/asf.html
https://physics.nist.gov/PhysRefData/FFast/html/form.html
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1f-Setup, 262

2D Propagation, 779

2f-Setup, 262

3D Propagation, 779

3D View, 63

Abbe Number Material, 997

ABCD Law Calculator, 851

ABCD Matrices, 69

ABCD Matrix Setup, 671

ABCD Matrix Simulation, 781

Add Point Cloud, 264

Add Polarization Ellipses, 265, 732

Add Region, 264

Additional Information in the Table, 842

Amplitude / Real Part Manipulations, 206

Analysis Panel, 807

Analyzer Table, 414

Analyzers, 735

Anamorphic Asphere Surface, 287

Angular Spectrum Visualizer, 688

Animated GIF, 902

Animation View, 192

Aperture, 377, 651

Aperture Medium, 325

Apply Detector Add-on, 732

Arithmetic Operations, 203

Array - Array Operations, 203

Array Size Manipulations, 209, 239

ASCII Format, 887

Aspect Ratio, 136

Aspherical Surface, 288

Automatic Propagation Operator, 773

Average, 724

Axicon Surfaces, 996

Batch Mode, 111

Beam Parameters, 696

Beam Shaper Design, 815

Biaxial Crystal, 325

Black Body Spectrum, 582

Boundary Responses, 373

Brightness, 125

Calculators, 851

Camera Detector, 688

Cartesian Angles Convention, 984

Catalogs, 268

Cells Array Design, 819

Cells Array Propagation, 778

Channel Configuration, 494

Chromatic Fields Set View, 174

Classic Field Tracing, 456

Coating Analyzer, 735

Coating View, 314

Coherence Time & Length Calculator, 852

Collins Integral by ABCD Matrix, 793

Color Mode, 175

Color System, 80

Color Table, 120

Combine Components, 472

Combined Outputs, 510

Combined SPW / Fresnel Operator, 777

Combined Surface, 289

Command Line Arguments, 111

Complex Histogram, 725, 729

Component Tools, 471

Conical Surface, 290

Constraint Specification Page, 835, 846

Context Menu, 31

Control for Defining Used Orders, 60

Conversion Between Components, 598

Conversion Efficiency, 971

Conversions, 251

Convert to General Optical Setup, 470

Coordinate Break, 664

Coordinate System, 481

Copy View to Clipboard, 137

Create Animation, 253

Crystal Plate, 599

Curved Surface, 608

Custom Fourier Modal Method, 792
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Customized Mode Planar Source, 567

Cylindrical Surface, 291

Data Array View, 155

Data Point Average, 729

Data Restricted Zoom, 135

Data View, 147

Databased Pulse Spectrum, 590

Databased Spectrum, 586

Debye-Wolf Integral Calculator, 853

Defining and Editing Materials, 347

Definition Area, 280

Definition Area Control, 281

Delete All Linkages, 470

Design Panel, 802

Detecting Device Specifications Page, 835

Detector Add-ons, 684

Detector Menu, 675

Detector Results Panel, 41

Detector Table, 412

Detector Window (k-Domain), 682

Detector Window (x-Domain), 681

Diagram Panel, 155

Dialog for Applying a Detector Add-on on a Data Array,

732

Diffraction Angle Calculator, 855

Diffraction Orders Diagrams, 190

Diffractive Lens, 620

Diffractive Optical Element, 618

Diffractive Optics Merit Functions, 698

Dimension Separation, 258

Direction Angles Convention, 983

Direction Converter, 856

Direction Vector Convention, 986

Directions and Orientations, 981

Discrete Height Levels, 284

Distortion Analyzer, 740

Distributed Computing, 106

Docking Tabs, 41

document windows, 30

Documents and Document Windows, 31

DOE, 618

Double Surface Component, 643

Edit Dialog of Ideal Components, 646

Edit List, 265

Eigenmode Analyzer, 758

Electric Field Detector, 722

Electromagnetic Field Quantities, 686

Element Internal Definition of Axes, Coordinate Sys-

tems, and Reference Points, 482

Ellipsometry Analyzer, 752

Envelope to Real Function Converter, 264

equidistant sampling, 933

Euler Angles Convention, 986

Evaluation Region, 978

Evanescent Field Filter, 672

Exchange Elements in Optical Setup, 467

Excimer, 936

Exclude Element from Optical Setup, 466

Export, 878

Export Dialog (for Standard Surfaces), 915

Export Dialog for Diffractive Structures, 920

Extract Profile Line, 211

Extrapolation, 155

Far Field Operator, 776

Far Field Source, 568

Fiber Coupling Efficiency, 701, 708

Fiber Element, 600

Fiber Medium, 326

Fiber Mode Calculator, 857

Field Component, 184

Field Components, 722

Field Curvature Analyzer, 743

Field Decomposition, 672

Field Deviation, 726

Field Information Format, 885

Field Information Format for Chromatic Fields Sets,

898

Field Inside Component Analyzer: FMM, 753

Field Inside Component Analyzer: Split Step, 744

Field Properties, 184

Field Quantities, 680

Field Quantity, 118

Field Quantity Operations, 205

Field Visualization, 688

File Menu, 37

Find Focus Position, 475

Fit Smooth Surface, 302

Floyd-Steinberg Quantization, 221

Focal Length Analyzer, 746

Footprint and Grating Analysis, 822

Footprint Diagrams, 829

Fourier Modal Method, 786

Fourier transform, 962

Fourier Transform (Space), 261
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Fourier Transform (Temporal), 263

Free Space Operators, 767

Free Space Propagation Parameters (Modeling Pro-

files), 444

Fresnel Effects Calculator, 858

Fresnel Propagation Operator, 777

Fresnel Zones, 285

Full Width at Half Maximum, 730

Functional Grating, 613

Functional Meta Lens, 615

Functional Modulated Metasurface, 616

Gaussian Pulse Spectrum, 589

Gaussian Spectrum, 583

Gaussian Type Planar Source, 572

Gaussian Wave, 558

General Anisotropic Medium, 327

General Profile: Modeling Analyzer, 454

General Settings Page, 838, 847

Generate Sequence, 463

Geometrical Optics Beam Shaping, 806

Geometrical Optics Operator, 782

Global Options, 73

Global Parameters, 99

Graphics Add-Ons, 138, 264

Grating, 622

Grating Cells Array, 363

Grating Channel Analyzer, 762

Grating Components, 641

Grating Optical Setup, 499

Grating Order Analyzer, 750

Grating Regions, 391

Grid Gaussian Planar Source, 573

Gridless Data, 683

GRIN Lens, 600

GRIN Medium, 327

Hard Quantization, 220

Harmonic Field Selection, 148

Height Discontinuities, 283

Help Ribbon Tab, 40

Holographic Optical Element, 624

Homogeneous Medium, 324

Homogeneous Spectrum, 583

Ideal Beam Splitter, 662

Ideal Lens, 382, 652

Ideal Plane Mirror, 666

Ideal Plane Wave, 564

Ideal Spherical Mirror, 667

Ideal Stored Mirror Function, 669

Identity Operator, 664

Identity Operator / Coordinate Break, 664

IFTA Optimization, 798

Image Light Sources, 577

Import, 878

Import / Export Elements, 475

Import of Data Arrays, 893

Import of Obsolete VirtualLab Fusion Files, 927

Index Modulated & Crystal Components, 599

Index Modulated Components, 600

Inhomogeneous Medium Component, 600

Insert Array, 204

Insert Element into Optical Setup, 464

Interpolation, 212

Interpolation Methods, 153

Interpolation Methods for Equidistant Data, 931

Inverse Temporal Fourier Transform, 263

Isolated Positioning of Optical Setup Elements, 491

Iteration Document, 525

Iterative Fourier Transform Algorithm, 798, 803

JCMsuite export, 906

Jones Matrix, 657

Jones Matrix Multiplication, 217, 657

k-Layout Visualization, 861

Laser Beam Calculator, 862

Laser Resonator Optical Setup, 500

Lateral Displacement, 209, 239

Lateral Shift, 665

Layout Design Calculator, 864

LED, 936

Lens System, 602

License Model, 114

License Update, 114

Light Guide, 604

Light Guide Grating Design, 827

Light Guide Optical Setup, 500

Light Path Finder, 417

Light Shaper, 639

Light Shaping Optical Setup, 500

Light View, 146

Linear Phase, 383, 656

LLGA Results Generator, 526

Local Linear Grating Approximation Analyzer, 762

Logging, 415, 804
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Lorentzian Spectrum, 584

Macleod Coatings, 924

Magnetic Field Detector, 723

Manipulations of Data Arrays, 228

Manipulations of Harmonic Fields Sets, 222

Manipulations of Regions, 251

Manipulations Ribbon Tab, 203

Material Data, 347

Material Data Sources, 356

Material View, 352

Materials, 347

Maximum (Position and Value), 730

Maximum Lightness, 175

Maximum Relative Intensity of Stray Light, 972

Maximum Value, 726

Medium View, 319

Medium with Inclusions, 329

Memory Calculator, 866

Merit Functions, 696

Messages Panel, 41

Microlens Array, 625

Microstructure, 618

Minimum (Position and Value), 730

Minimum / Maximum (Position and Value), 730

Minimum Value, 726

Mirrors, 666

Miscellaneous, 220

Modify Phase, 207

Modulation Depth Calculator, 867

Momentum, 727

MTF, 690

Multimode Fiber Coupling Efficiency, 701

Multimode Gaussian Source, 573

Multiple Light Source, 553

Multiple Surfaces Components, 602

Notifications, 43

Numerical Detectors, 724

Off-Axis Parabolic Mirror (Wedge Type), 609

Operations with Constant, 204, 236

Optical Axis, 482

Optical Coatings, 309

Optical Media, 318

Optical Path Length Analyzer, 747

Optical Path Length Evaluation, 706

Optical Setup, 406

Optical Setup Editor, 410

Optical Setup Ribbon, 416

Optical Setup Tools, 462

Optical Setup View, 406

Optical Stacks, 356

Optical Surfaces, 278

Optimal Scale Factor, 978

Optimization Region, 978

Optimization Results Page, 840

Optimize Detector Positions, 476

optiSLang export, 905, 906

optiSLang Optimization Document, 843

optiSLang Package, 843

Order Collection View, 188

Orientations of Optical Setup Elements, 488

Overview Image, 902

Panel Type Source, 579

Parameter Coupling, 495

Parameter Extraction, 459

Parameter Overview, 461

Parameter Overview Tree, 481

Parameter Run, 501

Parameter Selection and Simulation Engine Selection

Page, 845

Parameter Selection Page, 834

Parameter Variation Analyzer, 749

Parametric Optimization, 831

Parametric Optimization Document, 832

Partially Coherent Source Models, 566

Path Table, 411

Periodization, 282

Periodization of Surfaces, 280

Phase Dislocation, 385, 657

Phase Freedom, 978

Phase Manipulations, 207

Phase Shift, 658

Physical Detectors, 722

Pillar Medium (General), 331

Pillar Medium (z-Independent), 334

Pixelation, 284

Plane Surface, 296, 611

Plane Wave, 559

Point Evaluation, 713

Point Profile Extraction, 224

Polarization, 148, 930

Polarization Analyzer, 755

Polarization Beam Splitter, 663

Polarization Change, 215
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Polarizer, 659

Polynomial Aberrations Fit, 716

Polynomial Surface, 296

Positioning a Programmable Component, 635

Positioning Control, 488

Positioning of Optical Setup Elements, 485

Positions, 481

Power Detector, 703

Poynting Vector, 723

Prism Cells Array, 363

Profile Editing Tool: Paraxial Assumptions, 421

Profile Editing Tool: Pointwise vs. Integral, 423

Profile Editing Tool: Speed vs. Accuracy , 422

Profile Editing Tools, 418

Profile Editor, 426

Programmable Component, 630

Programmable Detector, 677

Programmable Function, 385, 651

Programmable Grating Analyzer, 758

Programmable Light Source, 565

Programmable Medium, 336

Programmable Mode Planar Source, 575

Programmable Pulse Spectrum, 592

Programmable Spectrum, 587

Programmable Surface, 298

Programming, 91

Propagating Through an Optical Setup, 425

Propagation in Positive Z-Direction?, 931

Propagation Ribbon Tab, 764

Propagation Tab for Components, 596

Property Browser, 41

Property Browser for Classic Field Tracing, 457

PSF, 690

Pulse and Field Component, 177

Pulse Evaluation, 704

Q-Type Asphere Surface, 299

Quadratic Wave, 560

Quantization, 284

Quick Access Toolbar, 35

Radial / Azimuthal Polarization, 693

Random Cells Diffuser, 654

Random Phase, 656

Raw Data Detector, 694

Ray Distribution View, 179

Ray Quantities, 185

Ray Results Profile: 3D System, 453

Ray Results Profile: Detectors, 451

Rayleigh Expansion Propagation, 778

Rayleigh Sommerfeld Operator, 777

Real Components, 595

Rectangular Grating, 380

Rectangular Grating Surface, 294

Rectangular Grating Transmission, 653

Reference Point, 482

Region View, 201

Regions, 195

Relative Zeroth Order Intensity, 972

Replicate Periodically, 210, 240

Resample to Angular Coordinates, 220

Resizing of Document Windows, 33

Restrictions of Ray Results Profile, 450

Result Document, 31

Result Window, 31

Results Page, 847

Retarder, 659

RGB Working Space, 80

Ribbon, 34

Rigorous Analysis of Slanted Gratings, 868

Rigorous Coupled-Wave Analysis, 786

RMS of Phase, 718

Rotation in x-y-plane, 209

Rotation Matrix Convention, 986

Rotator, 660

Sample Spherical Phase, 666

Sampled Medium, 337

Sampled Surface, 301

sampling distance, 933

Sampling Manipulations, 212, 223, 242

Sawtooth Grating, 380

Sawtooth Grating Surface, 294

Sawtooth Grating Transmission, 653

Scale Errors, 808

Scale Freedom, 978

Scaling Mode, 124

Scaling of Surfaces, 283

Scanning Source, 580

Selection Mode, 126

Selection Related Operations, 214, 243

Selection Tools, 132

Sequence of Axis Rotations Convention, 985

Set of Objects, 178

Show Simulation Report, 477

Single Phase Dislocation, 385, 657

Single Surface & Coating Components, 608
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Single Surface & Function Components, 613

Single Surface & Stack Components, 617

Singlemode Fiber Coupling Efficiency, 708

Sinusoidal Grating, 381

Sinusoidal Grating Surface, 295

Sinusoidal Grating Transmission, 653

Slanted Grating Medium, 339

Soft Quantization, 221

Sort Table Entries, 470

Sources, 537

Special Components, 670

Specification Panel, 798

Speckle Type Diffuser, 654

Spectrum of Plane Waves Operator, 777

Spherical Angles Convention, 982

Spherical Lens, 607

Spherical Lens Calculator, 870

Spherical Phase, 386, 652

Spherical Phase Radius, 144, 930

Spherical Wave, 561

Split Component, 471

Split Step (BPM) Propagation, 794

Spot Size, 710

SPW Operator, 777

Standard Deviation, 727, 730

Start Ribbon Tab, 37

Status Bar, 43

Stop, 387, 652

Stored Function, 389, 657

Stored Lateral Field, 563

Stratified Media, 612

Structure Design, 811

Subset Selection, 157

Subsystem, 638

Sum within Selection, 732

Summed Norm, 728

Super-Gaussian Wave, 562

Suppressing Numerical Phase Artifacts, 142

Surface Layouts, 363

Surface Regions, 391

Surface Tools, 286

Surface Types, 287

Surface View, 309

Synchronize Detector Sampling, 469

Table Panel, 171

Temporal Fourier Transform, 264

Thin Element Approximation, 786

Toggle Light Source, 464

Tools, 460

Toroidal Asphere Surface, 304

Transition Point List Surface, 306

Transmission Functions, 648

Triangular Grating, 381

Triangular Grating Surface, 295

Triangular Grating Transmission, 654

Turn Component, 474

Two Point Contrast, 713

Types of Data Arrays, 152

Types of Optical Coatings, 309

Uniaxial Crystal, 340

Uniformity Detector, 711

Uniformity Error, 731, 971

Universal Detector, 679

User Interface, 30

Using Materials, 347

Validity Indicator, 59

Value at (x,y) Panel, 173

Value Monitoring, 714

Value Scaling, 118

Vector & Coordinate System Viewer, 873

Vectorial Component, 148

View Ribbon Tab, 118

View Settings, 34

View Settings Dialog, 186

VirtualLab Explorer, 42

VirtualLab Fusion Packages, 27

Volume Grating Medium, 341

Wavefront Detectors, 715

Wavefront Error, 718

Wavelength Selection, 174

Waveplate Calculator, 875

Window Efficiency, 971

Windows Ribbon Tab, 39

XML export, 903

ZemaxOpticStudio® import, 906

Zernike & Seidel Aberrations (Boundary Operator),

388

Zernike & Seidel Aberrations (Detector), 720

Zernike & Seidel Aberrations (Function), 652

Zernike & Seidel Surface, 307

Zeroth Order Efficiency, 972

Zoom, 134
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